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NTP-A44 Provision Path Protection Nodes 5-32

NTP-A177 Path Protection Acceptance Test 5-33

NTP-A216 Provision a Traditional Path Protection Dual Ring Interconnect 5-36

NTP-A217 Provision an Integrated Path Protection Dual Ring Interconnect 5-38

NTP-A46 Subtend a Path Protection from a BLSR 5-40

NTP-A47 Subtend a BLSR from a Path Protection 5-41

NTP-A48 Subtend a BLSR from a BLSR 5-42

C H A P T E R  6 Create Circuits and VT Tunnels 6-1

NTP-A127 Verify Network Turn Up 6-4

NTP-A181 Create an Automatically Routed DS-1 Circuit 6-6

NTP-A182 Create a Manually Routed DS-1 Circuit 6-10

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops 6-13

NTP-A184 Create an Automatically Routed DS-3 Circuit 6-20
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NTP-A185 Create a Manually Routed DS-3 Circuit 6-24

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops 6-26

NTP-A133 Create an Automatically Routed VT Tunnel 6-32

NTP-A134 Create a Manually Routed VT Tunnel 6-35

NTP-A187 Create a VT Aggregation Point 6-38

NTP-A135 Test Electrical Circuits 6-41

NTP-A188 Create an Automatically Routed Optical Circuit 6-43

NTP-A189 Create a Manually Routed Optical Circuit 6-47

NTP-A190 Create a Unidirectional Optical Circuit with Multiple Drops 6-49

NTP-A62 Test Optical Circuits 6-55

NTP-A139 Create a Half Circuit on a BLSR or 1+1 Node 6-57

NTP-A140 Create a Half Circuit on a Path Protection configuration Node 6-59

NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card Mode) 6-63

NTP-A192 Create a Circuit for an E-Series Card in Port-Mapped Mode 6-65

NTP-A142 Create an E-Series Shared Packet Ring Ethernet Circuit 6-67

NTP-A143 Create an E-Series Hub and Spoke Ethernet Configuration 6-70

NTP-A144 Create an E-Series Single-Card EtherSwitch Manual Cross-Connect 6-72

NTP-A145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect 6-75

NTP-A146 Test E-Series Circuits 6-82

NTP-A147 Create a G-Series Circuit 6-83

NTP-A148 Create a Manual Cross-Connect for a G-Series or an E-Series in Port-Mapped Mode  6-85

NTP-A149 Test G-Series or ML-Series Circuits 6-88

NTP-A193 Create an ML-Series Circuit 6-89

NTP-A194 Create Overhead Circuits 6-91

C H A P T E R  7 Manage Alarms 7-1

NTP-A195 Document Existing Provisioning 7-2

NTP-A196 View Alarms, History, Events, and Conditions 7-5

NTP-A68 Delete Cleared Alarms from Display 7-13

NTP-A69 View Alarm-Affected Circuits 7-14

NTP-A70 View Alarm Counts on the LCD for a Slot or Port 7-16

NTP-A71 Create, Download, and Assign Alarm Severity Profiles 7-17

NTP-A168 Enable, Modify, or Disable Alarm Severity Filtering 7-26

NTP-A72 Suppress and Discontinue Alarm Suppression 7-30
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NTP-A123 Provision External Alarms and Controls on the Alarm Interface Controller-International 7-35
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C H A P T E R  8 Monitor Performance 8-1

NTP-AA73 Enable Performance Monitoring 8-2

NTP-AA197 Monitor Electrical or Optical Performance 8-7

NTP-AA198 Monitor Ethernet Performance 8-19

C H A P T E R  9 Manage Circuits 9-1

NTP-A199 Locate and View Circuits 9-4

NTP-A200 View Cross-Connect Card Resource Usage 9-8

NTP-A151 Modify Circuit Characteristics 9-9

NTP-A416 Convert a CTC Circuit to TL1 Cross-Connects 9-14

NTP-A417 Upgrade TL1 Cross-Connects to CTC Circuits 9-15

NTP-A152 Delete Circuits 9-16

NTP-A78 Create a Monitor Circuit 9-17

NTP-A79 Create a J1 Path Trace 9-18

C H A P T E R  10 Change Node Settings 10-1

NTP-A81 Change Node Management Information 10-2

NTP-A201 Change CTC Network Access 10-4

NTP-A202 Customize the CTC Network View 10-8

NTP-A203 Modify or Delete Card Protection Settings 10-13

NTP-A204 Delete a SONET DCC Termination 10-18

NTP-A85 Change Node Timing 10-19

NTP-AA205 Modify Users and Change Security 10-21

NTP-A87 Change SNMP Settings 10-27

C H A P T E R  11 Change Card Settings 11-1

NTP-A88 Modify Line Settings and PM Parameter Thresholds for Electrical Cards 11-2

NTP-A89 Modify Line Settings and PM Parameter Thresholds for Optical Cards 11-19

NTP-A206 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G Cards 11-25

NTP-A207 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G Cards 11-36

NTP-A90 Modify Alarm Interface Controller Settings 11-46

NTP-A118 Modify Alarm Interface Controller-International Settings 11-49

NTP-A91 Upgrade DS-1 and DS-3 Protect Cards from 1:1 Protection to 1:N Protection 11-53

C H A P T E R  12 Upgrade Cards and Spans 12-1

NTP-A219 Prevent an Optical Protection Switch During Cross-Connect Card Upgrades 12-2

NTP-A92 Upgrade the XC Card to the XCVT Card 12-5
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NTP-A220 Upgrade the XC or XCVT Card to the XC10G Card 12-6

NTP-A418 Upgrade the TCC+ Card to the TCC2 Card 12-8

NTP-A419 Upgrade the TCC Card to the TCC2 Card 12-10

NTP-A93 Upgrade DS3-12 Cards to DS3-12E 12-12

NTP-A153 Upgrade the AIC Card to AIC-I 12-17

NTP-A94 Upgrade Optical Spans Automatically 12-17

NTP-A95 Upgrade Optical Spans Manually 12-21

C H A P T E R  13 Convert Network Configurations 13-1

NTP-A154 Convert a Point-to-Point to a Linear ADM 13-2

NTP-A155 Convert a Point-to-Point or a Linear ADM to a Two-Fiber BLSR 13-4

NTP-A156 Convert a Point-to-Point or Linear ADM to a Path Protection Configuration 13-7

NTP-A210 Convert a Path Protection Configuration to a Two-Fiber BLSR 13-8

NTP-A211 Convert a Two-Fiber BLSR to a Four-Fiber BLSR 13-10

NTP-A159 Modify a BLSR 13-11

C H A P T E R  14 Add and Remove Nodes 14-1

NTP-A102 Add a BLSR Node 14-2

NTP-A213 Remove a BLSR Node 14-10

NTP-A105 Add a Path Protection Configuration Node 14-14

NTP-A106 Remove a Path Protection Configuration Node 14-16

C H A P T E R  15 Maintain the Node 15-1

NTP-AA107 Inspect and Maintain the Air Filter 15-2

NTP-AA108 Back Up the Database 15-8

NTP-AA109 Restore the Database 15-9

NTP-AA163 Restore the Node to Factory Configuration 15-12

NTP-AA214 Offload the Security Audit Trail Log 15-17

NTP-AA110 Inhibit Protection Switching 15-18

NTP-AA111 Revert to an Earlier Software Load 15-21

NTP-AA112 Clean Fiber Connectors 15-23

NTP-AA113 Reset the TCC+/TCC2 Card Using CTC 15-26

NTP-AA215 View Ethernet Maintenance Information 15-27

NTP-AA218 Change the Node Timing Reference 15-30

C H A P T E R  16 Power Down the Node 16-1

NTP-A114 Power Down the ONS 15454 16-1
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appendix A-1 CTC Information and Shortcuts A-1

appendix B-1 Shelf Assembly Specifications B-1

appendix C-1 Network Element Defaults C-1

NTP-A164 Edit Network Element Defaults C-2

NTP-A165 Import Network Element Defaults C-3

NTP-A166 Export Network Element Defaults C-4
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C H A P T E R  1 Install the Shelf and Backplane Cable 1-1

DLP-A1 Unpack and Verify the Shelf Assembly 1-4

DLP-A2 Inspect the Shelf Assembly 1-5

DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack 1-6

DLP-A4 Install the External Brackets and Air Filter 1-8

DLP-A5 Mount the Shelf Assembly in a Rack (One Person) 1-9

DLP-A6 Mount the Shelf Assembly in a Rack (Two People) 1-10

DLP-A7 Mount Multiple Shelf Assemblies in a Rack 1-11

DLP-A8 Open the Front Cabinet Compartment (Door) 1-12

DLP-A9 Remove the Front Door 1-13

DLP-A10 Remove the Lower Backplane Cover 1-15

DLP-A11 Remove the Backplane Sheet Metal Cover 1-16

DLP-A12 Install a BNC or High-Density BNC EIA 1-17

DLP-A13 Install an SMB EIA 1-19

DLP-A14 Install the AMP Champ EIA 1-21

DLP-A15 Verify that the Correct Fuse and Alarm Panel is Installed in the Equipment Rack 1-24

DLP-A16 Connect the Office Ground to the ONS 15454 1-25

DLP-A17 Connect Office Power to the ONS 15454 Shelf 1-26

DLP-A18 Turn On and Verify Office Power 1-28

DLP-A19 Install Alarm Wires on the Backplane  1-35

DLP-A20 Install Timing Wires on the Backplane 1-37

DLP-A21 Install LAN Wires on the Backplane  1-38

DLP-A22 Install the TL1 Craft Interface 1-39

DLP-A23 Install DS-1 Cables Using Electrical Interface Adapters (Balun) 1-46

DLP-A24 Install DS-1 AMP Champ Cables on the AMP Champ EIA 1-47

DLP-A25 Install Coaxial Cable With BNC Connectors 1-50

DLP-A26 Install Coaxial Cable With High-Density BNC Connectors 1-51

DLP-A27 Install Coaxial Cable with SMB Connectors 1-52

DLP-A28 Route Coaxial Cables 1-53

DLP-A29 Route DS-1 Twisted-Pair Cables 1-55

DLP-A30 Install Ferrites to Power Cabling 1-58
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DLP-A31 Attach Ferrites to Wire-Wrap Pin Fields 1-59

DLP-A32 Inspect the Shelf Installation and Connections 1-61

DLP-A33 Measure Voltage 1-61

C H A P T E R  2 Install Cards and Fiber-Optic Cable 2-1

DLP-A36 Install the TCC+/TCC2 Cards 2-7

DLP-A37 Install the XC, XCVT, or XC10G Cards 2-10

DLP-A38 Install the Alarm Interface Controller or Alarm Interface Controller–International Card 2-11

DLP-A39 Install Ethernet Cards 2-17

DLP-A469 Install GBIC or SFP Connectors 2-18

DLP-A470 Remove GBIC or SFP Connectors 2-20

DLP-A191 Delete a Card 2-22

DLP-A247 Change an Optical Card 2-22

DLP-A207 Install Fiber-Optic Cables on the LGX Interface 2-26

DLP-A42 Install Fiber-Optic Cables on OC-N Cards 2-27

DLP-A43 Install Fiber-Optic Cables for Path Protection Configurations 2-28

DLP-A44 Install Fiber-Optic Cables for BLSR Configurations 2-32

DLP-A45 Install the Fiber Boot  2-34

DLP-A46 Route Fiber-Optic Cables  2-35

C H A P T E R  3 Connect the PC and Log into the GUI 3-1

DLP-A47 Run the CTC Installation Wizard for Windows 3-2

DLP-A48 Run the CTC Installation Wizard for UNIX 3-5

DLP-A49 Set Up the Java Runtime Environment for UNIX 3-7

DLP-A50 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static 
IP Addresses 3-11

DLP-A51 Set Up a Windows PC for Craft Connection to an ONS 15454 Using DHCP 3-13

DLP-A52 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection 
3-15

DLP-A53 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454 3-17

DLP-A55 Set Up a Computer for a Corporate LAN Connection 3-19

DLP-A56 Disable Proxy Service Using Internet Explorer (Windows) 3-20

DLP-A57 Disable Proxy Service Using Netscape (Windows and UNIX) 3-20

DLP-A58 Provision Remote Access to the ONS 15454 3-21

DLP-A59 Connect Computer to the ONS 15454 3-22

DLP-A60 Log into CTC 3-23

DLP-A61 Create Login Node Groups 3-25
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DLP-A62 Add a Node to the Current Session or Login Group 3-26

C H A P T E R  4 Turn Up Node 4-1

DLP-A74 Create a New User - Single Node 4-4

DLP-A75 Create a New User - Multiple Nodes 4-5

DLP-A249 Provision IP Settings 4-9

DLP-A64 Set the IP Address, Default Router, and Network Mask Using the LCD 4-12

DLP-A65 Create a Static Route 4-14

DLP-A250 Set Up or Change Open Shortest Path First Protocol 4-15

DLP-A251 Set Up or Change Routing Information Protocol 4-17

DLP-A67 Provision the IIOP Listener Port on the ONS 15454 4-19

DLP-A68 Provision the IIOP Listener Port on the CTC Computer 4-21

DLP-A69 Set Up External or Line Timing 4-22

DLP-A70 Set Up Internal Timing 4-24

DLP-A71 Create a 1:1 Protection Group 4-27

DLP-A72 Create a 1:N Protection Group 4-28

DLP-A73 Create a 1+1 Protection Group 4-29

DLP-A252 Create a Y Cable Protection Group 4-31

C H A P T E R  5 Turn Up Network 5-1

DLP-A253 Provision SONET DCC Terminations 5-5

DLP-A214 Change the Service State for a Port 5-6

DLP-A254 TCC+/TCC2 Active/Standby Switch Test 5-9

DLP-A255 Cross-Connect Card Side Switch Test 5-10

DLP-A88 Optical 1+1 Protection Test 5-11

DLP-A89 Remap the K3 Byte 5-17

DLP-A217 BLSR Exercise Ring Test 5-22

DLP-A91 BLSR Switch Test 5-23

DLP-A92 Four-Fiber BLSR Exercise Span Test 5-28

DLP-A93 Four-Fiber BLSR Span Switching Test 5-30

DLP-A94 Path Protection Protection Switching Test 5-35

C H A P T E R  6 Create Circuits and VT Tunnels 6-1

DLP-A314 Assign a Name to a Port 6-17

DLP-A95 Provision a DS-1 Circuit Source and Destination 6-18

DLP-A218 Provision Path Protection configuration Selectors During Circuit Creation 6-29
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DLP-A208 Provision a DS-3 Circuit Source and Destination 6-30

DLP-A96 Provision a DS-1 or DS-3 Circuit Route 6-31

DLP-A219 Provision a VT Tunnel Route 6-36

DLP-A97 Provision an Optical Circuit Source and Destination 6-52

DLP-A98 Provision an Optical Circuit Route 6-53

DLP-A311 Provision a Half Circuit Source and Destination - BLSR and 1+1 6-61

DLP-A312 Provision a Half Circuit Source and Destination - Path Protection configuration 6-62

DLP-A99 Determine Available VLANs 6-78

DLP-A246 Provision E-Series Ethernet Card Mode 6-79

DLP-A220 Provision E-Series Ethernet Ports 6-79

DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership 6-80

DLP-A222 Provision G-Series Ethernet Ports 6-87

DLP-A313 Create a DCC Tunnel 6-92

DLP-A83 Provision Orderwire 6-93

DLP-A212 Create a User Data Channel Circuit 6-94

C H A P T E R  7 Manage Alarms 7-1

DLP-A138 Print CTC Data 7-2

DLP-A139 Export CTC Data  7-4

DLP-A110 View Alarm History 7-8

DLP-A111 Changing the Maximum Number of Session Entries for Alarm History 7-9

DLP-A112 Display Alarms and Conditions Using Time Zone 7-11

DLP-A113 Synchronize Alarms 7-11

DLP-A114 View Conditions 7-12

DLP-A115 Create Alarm Severity Profiles 7-18

DLP-A223 Download an Alarm Severity Profile 7-21

DLP-A116 Apply Alarm Profiles to Ports 7-22

DLP-A117 Apply Alarm Profiles to Cards and Nodes  7-24

DLP-A118 Delete Alarm Severity Profiles 7-25

DLP-A225 Enable Alarm Filtering 7-27

DLP-A226 Modify Alarm and Condition Filtering Parameters 7-28

DLP-A227 Disable Alarm Filtering 7-30

DLP-A119 Suppress Alarm Reporting 7-31

DLP-A120 Discontinue Alarm Suppression 7-32
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C H A P T E R  8 Monitor Performance 8-1

DLP-AA121 Enable Pointer Justification Count Performance Monitoring 8-2

DLP-AA122 Enable Intermediate Path Performance Monitoring 8-5

DLP-AA123 View Electrical or Optical OC-N PM Parameters 8-8

DLP-AA317 View TXP_MR_10G or MXP_2.5G_10G Optics PM Parameters 8-9

DLP-AA318 View TXP_MR_10G or MXP_2.5G_10G Payload PM Parameters 8-10

DLP-AA319 View TXP_MR_10G or MXP_2.5G_10G OTN PM Parameters 8-11

DLP-AA261 Refresh PM Counts for a Different Port 8-12

DLP-AA124 Refresh Electrical or Optical PM Counts at 15-Minute Intervals 8-13

DLP-AA125 Refresh Electrical or Optical PM Counts at One-Day Intervals 8-14

DLP-AA126 Monitor Near-End PM Counts 8-14

DLP-AA127 Monitor Far-End PM Counts 8-15

DLP-AA128 Monitor PM Counts for Selected Signal Types 8-16

DLP-AA129 Reset Current PM Counts 8-17

DLP-AA130 Clear Selected PM Counts 8-18

DLP-AA256 View Ethernet Statistics PM Parameters 8-20

DLP-AA260 Set Auto-Refresh Interval for Displayed PM Counts 8-21

DLP-AA257 View Ethernet Utilization PM Parameters 8-22

DLP-AA259 Refresh Ethernet PM Counts at a Different Time Interval 8-23

DLP-AA258 View Ethernet History PM Parameters 8-23

DLP-AA320 View ML-Series Ether Ports PM Parameters 8-24

DLP-AA321 View ML-Series POS Ports PM Parameters 8-25

C H A P T E R  9 Manage Circuits 9-1

DLP-A131 Search for Circuits 9-5

DLP-A262 Filter the Display of Circuits 9-6

DLP-A229 View Circuits on a Span 9-7

DLP-A230 Change a Circuit State 9-9

DLP-A231 Edit a Circuit Name 9-10

DLP-A232 Change Active and Standby Span Color 9-11

DLP-A233 Edit Path Protection configuration Circuit Path Selectors 9-12

DLP-A263 Edit Path Protection configuration Dual Ring Interconnect Circuit Hold-Off Timer 9-13

DLP-A264 Provision Path Trace on Circuit Source and Destination Ports 9-19

DLP-A137 Provision Path Trace on OC-N Ports 9-23
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C H A P T E R  10 Change Node Settings 10-1

DLP-A140 Change the Node Name, Date, Time, and Contact Information 10-2

DLP-A265 Change the Login Legal Disclaimer 10-3

DLP-A266 Change IP Settings 10-5

DLP-A142 Modify a Static Route 10-6

DLP-A143 Delete a Static Route 10-6

DLP-A144 Disable OSPF 10-7

DLP-A145 Change the Network View Background Color 10-8

DLP-A267 Change the Default Network View Background Map 10-9

DLP-A268 Apply a Custom Network View Background Map 10-10

DLP-A148 Create Domain Icons 10-11

DLP-A149 Manage Domain Icons 10-11

DLP-A269 Enable Dialog Box Do-Not-Display Option 10-12

DLP-A150 Modify a 1:1 Protection Group 10-14

DLP-A152 Modify a 1:N Protection Group 10-15

DLP-A154 Modify a 1+1 Protection Group 10-16

DLP-A270 Modify a Y Cable Protection Group 10-17

DLP-A155 Delete a Protection Group 10-18

DLP-A157 Change the Node Timing Source 10-19

DLP-A271 Change Security Policy - Single Node 10-21

DLP-A272 Change Security Policy - Multiple Nodes 10-22

DLP-A158 Change User Password and Security Level - Single Node 10-23

DLP-A160 Change User Password and Security Level - Multiple Nodes 10-24

DLP-A315 Log Out a User - Single Node 10-25

DLP-A316 Log Out a User - Multiple Nodes 10-25

DLP-A159 Delete User - Single Node 10-26

DLP-A161 Delete User - Multiple Nodes 10-27

DLP-A273 Modify SNMP Trap Destinations 10-28

DLP-A163 Delete SNMP Trap Destinations 10-30

DLP-A164 Delete Ethernet RMON Alarm Thresholds 10-30

C H A P T E R  11 Change Card Settings 11-1

DLP-A165 Change Line and Threshold Settings for the DS1-14 or DS1N-14 Cards 11-2

DLP-A166 Change Line and Threshold Settings for the DS3-12 or DS3N-12 Cards 11-6

DLP-A167 Change Line and Threshold Settings for the DS3E-12 or DS3N-12E Cards 11-9

DLP-A168 Change Line and Threshold Settings for the DS3XM-6 Card 11-12
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DLP-A169 Change Line and Threshold Settings for the EC1-12 Card 11-16

DLP-A170 Change Line Transmission Settings for OC-N Cards 11-19

DLP-A171 Change Threshold Settings for OC-N Cards 11-21

DLP-A172 Change an Optical Port to SDH 11-24

DLP-A274 Change Card Settings for TXP_MR_10G Cards 11-26

DLP-A275 Change Line Settings for TXP_MR_10G Cards 11-28

DLP-A276 Change Line Threshold Settings for TXP_MR_10G Cards 11-30

DLP-A277 Change Optical Thresholds Settings for TXP_MR_10G Cards 11-31

DLP-A278 Change Section Trace Settings for TXP_MR_10G Cards 11-32

DLP-A279 Change Optical Transport Network Settings for TXP_MR_10G Cards 11-33

DLP-A280 Change Card Settings for MXP_2.5G_10G Cards 11-36

DLP-A281 Change Line Settings for MXP_2.5G_10G Cards 11-37

DLP-A282 Change Line Thresholds Settings for MXP_2.5G_10G Cards 11-40

DLP-A283 Change Optical Thresholds Settings for MXP_2.5G_10G Cards 11-41

DLP-A284 Change Section Trace Settings for MXP_2.5G_10G Cards 11-42

DLP-A285 Change Optical Transport Network Settings for MXP_2.5G_10G Cards 11-43

DLP-A173 Change External Alarms Using the AIC Card 11-46

DLP-A174 Change External Controls Using the AIC Card 11-48

DLP-A175 Change Orderwire Settings Using the AIC Card 11-48

DLP-A208 Change External Alarms Using the AIC-I Card 11-50

DLP-A209 Change External Controls Using the AIC-I Card 11-51

DLP-A210 Change AIC-I Card Orderwire Settings 11-52

DLP-A176 Convert DS1-14 Cards From 1:1 to 1:N Protection 11-54

DLP-A177 Convert DS3-12 Cards From 1:1 to 1:N Protection 11-55

DLP-A178 Convert DS3-12E Cards From 1:1 to 1:N Protection 11-57

C H A P T E R  12 Upgrade Cards and Spans 12-1

DLP-A299 Initiate a BLSR Span Lockout 12-3

DLP-A300 Clear a BLSR Span Lockout 12-4

DLP-A291 Upgrade the TCC Card to the TCC+ Card 12-10

DLP-A182 Upgrade the DS3-12/DS3N-12 Card to the DS3-12E/DS3N-12E Card 12-13

DLP-A287 Switch 1+1 Traffic 12-14

DLP-A288 Clear a 1+1 Traffic Switch 12-15

DLP-A183 Downgrade a DS3-12E/DS3NE Card to a DS3-12/DS3N-12 Card 12-16

DLP-A293 Perform a Manual Span Upgrade on a Two-Fiber BLSR 12-23

DLP-A294 Perform a Manual Span Upgrade on a Four-Fiber BLSR 12-24
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DLP-A295 Perform a Manual Span Upgrade on a Path Protection Configuration 12-26

DLP-A296 Perform a Manual Span Upgrade on a 1+1 Protection Group 12-27

DLP-A297 Perform a Manual Span Upgrade on an Unprotected Span 12-28

C H A P T E R  13 Convert Network Configurations 13-1

DLP-A298 Check the Network for Alarms and Conditions 13-3

DLP-A189 Verify that a 1+1 Working Slot is Active 13-6

DLP-A301 Initiate a BLSR Manual Ring Switch 13-12

DLP-A241 Clear a BLSR Manual Ring Switch 13-13

C H A P T E R  14 Add and Remove Nodes 14-1

DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions 14-6

DLP-A242 Create a BLSR on a Single Node 14-6

DLP-A303 Initiate a BLSR Force Switch - Ring 14-7

DLP-A194 Clear a BLSR Force Switch - Ring 14-9

DLP-A304 Verify Pass-Through Circuits 14-12

DLP-A195 Verify Timing in a Reduced Ring 14-13

DLP-A196 Delete a BLSR from a Single Node 14-14

DLP-A197 Initiate a Path Protection Configuration Force Switch 14-18

DLP-A198 Clear a Path Protection Configuration Force Switch 14-19

C H A P T E R  15 Maintain the Node 15-1

DLP-AA199 Inspect, Clean, and Replace the Reusable Air Filter 15-2

DLP-AA200 Inspect and Replace the Disposable Air Filter 15-5

DLP-AA244 Use the Reinitialization Tool to Clear the Database and Upload Software (Windows) 15-13

DLP-AA245 Use the Reinitialization Tool to Clear the Database and Upload Software (UNIX) 15-15

DLP-AA201 Apply a Lock On 15-19

DLP-AA202 Apply a Lock Out 15-20

DLP-AA203 Clear a Lock On or Lock Out 15-21

DLP-AA204 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry Wipes 15-24

DLP-AA205 Clean Fiber Connectors with Cletop 15-25

DLP-AA206 Clean the Fiber Adapters 15-25

DLP-AA305 View J1 Path Trace Information 15-27

DLP-AA306 View Loopback Status 15-28

DLP-AA307 View Ethernet Bandwidth Utilization 15-28

DLP-AA308 View Ethernet Spanning Tree Parameters 15-29
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DLP-AA309 View the Ethernet MAC Address Table 15-29

DLP-AA310 View Ethernet Trunk Utilization 15-30

DLP-AA322 Manual or Force Switch the Node Timing Reference 15-31

DLP-AA323 Clear a Manual or Force Switch on a Node Timing Reference 15-31

C H A P T E R  16 Power Down the Node 16-1
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About this Manual

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This guide explains how to install, turn up, provision, and maintain a Cisco ONS 15454 node and 
network.

For trouble clearing, alarm troubleshooting, and hardware replacement procedures, refer to the Cisco 
ONS 15454 Troubleshooting Guide, Release 4.0.For detailed reference information, refer to the Cisco 
ONS 15454 Reference Manual, Release 4.0.

Revision History

Document Organization
This guide provides procedures for installation, turn up, provisioning and acceptance of ONS 15454 
nodes and ONS 15454 designed networks. It is organized in a Cisco recommended work flow sequence 
for new installations, in addition to allowing easy access to procedures and tasks associated with adds, 
moves, and changes for existing installations. 

Verification procedures are provided, where necessary, to allow contract vendors to complete the 
physical installation and then turn the site over to craft personnel for verification, provisioning, turn up 
and acceptance. The front matter of the book is present in the following sequence:

1. Title Page

2. Table of Contents

3. List of Figures

4. List of Tables

Date Notes

04/06/2007 Revision History Table added for the first time.

08/29/2007 Updated About this Manual chapter
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About this Manual
Chapter (Director Level)
5. List of Procedures

6. List of Tasks

The information in the book follows a task oriented hierarchy using the elements described below.

Chapter (Director Level)
The guide is divided into logical work groups (chapters) that serve as director entry into the procedures. 
For example, if you are arriving on site after a contractor has installed the shelf hardware, proceed to 
Chapter 2, “Install Cards and Fiber-Optic Cable” and begin verifying installation and installing cards. 
You may proceed sequentially (recommended), or locate the work you want to perform from the list of 
procedures on the first page of every chapter (or turn to the front matter or index).

Non-Trouble Procedure (NTP)
Each NTP is a list of steps designed to accomplish a specific procedure. Follow the steps until the 
procedure is complete. If you need more detailed instructions, refer to the Detailed Level Procedure 
(DLP) specified in the procedure steps.

Note Throughout this guide, NTPs are referred to as “procedures” and DLPs are termed “tasks.” Every 
reference to a procedure includes its NTP number, and every reference to a task includes its DLP number.

Detailed Level Procedure (DLP)
The DLP (task) supplies additional task details to support the NTP. The DLP lists numbered steps that 
lead you through completion of a task. Some steps require that equipment indications be checked for 
verification. When the proper response is not obtained, a trouble clearing reference is provided.

Document Conventions
This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.

[ ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.
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About this Manual
Where to Find Safety and Warning Information
Warning Means danger. The user is in a situation that could cause bodily injury. Before working on any 
equipment, be aware of the hazards involved with electrical circuitry and optical lasers and be 
familiar with standard practices for preventing accidents.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in 
the document.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco ONS 15454 Installation Handbook that 
accompanied the product. This publication describes the international agency compliance and safety 
information for the Cisco ONS 15454. It also includes translations of the safety warnings that appear in 
the ONS 15454 product documentation.

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and other technical 
resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

Convention Application
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About this Manual
Obtaining Documentation
Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and other technical 
resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Optical networking-related documentation is available in a CD-ROM package that ships with your 
product. The Optical Networking Product Documentation CD-ROM is updated monthly and may be 
more current than printed documentation. 

Ordering Documentation
Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco product documentation from the Networking 
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, elsewhere in North 
America, by calling 800 553-NETS (6387).

Documentation Feedback
If you are reading Cisco product documentation on Cisco.com, you can submit technical comments 
electronically. Click Leave Feedback at the bottom of the Cisco Documentation home page. After you 
complete the form, print it out and fax it to Cisco at 408 527-0730.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your document, or 
write to the following address:

Cisco Systems
Attn: Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883
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About this Manual
Obtaining Technical Assistance
We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center (TAC) Website, as a 
starting point for all technical assistance. Customers and partners can obtain online documentation, 
troubleshooting tips, and sample configurations from the Cisco TAC website. Cisco.com registered users 
have complete access to the technical support resources on the Cisco TAC website, including TAC tools 
and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access Cisco information, 
networking solutions, services, programs, and resources at any time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com at this URL:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product, 
technology, or solution. Two levels of support are available: the Cisco TAC website and the Cisco TAC 
Escalation Center. The avenue of support that you choose depends on the priority of the problem and the 
conditions stated in service contracts, when applicable.

We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabilities, 
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticeably 
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspects 
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operations 
will occur if service is not restored quickly. No workaround is available.
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Obtaining Additional Publications and Information
Cisco TAC Website

You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving both cost and time. The 
site provides around-the-clock access to online tools, knowledge bases, and software. To access the 
Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract have complete access to 
the technical support resources on the Cisco TAC website. Some services on the Cisco TAC website 
require a Cisco.com login ID and password. If you have a valid service contract but do not have a login 
ID or password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical issues by using the Cisco 
TAC website, you can open a case online at this URL:

http://www.cisco.com/en/US/support/index.html

If you have Internet access, we recommend that you open P3 and P4 cases through the Cisco TAC 
website so that you can describe the situation in your own words and attach any necessary files.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 issues. These 
classifications are assigned when severe network degradation significantly impacts business operations. 
When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisco TAC engineer 
automatically opens a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the level of Cisco support 
services to which your company is entitled: for example, SMARTnet, SMARTnet Onsite, or Network 
Supported Accounts (NSA). When you call the center, please have available your service agreement 
number and your product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• The Cisco Product Catalog describes the networking products offered by Cisco Systems as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco suggests these titles for new 
and experienced users: Internetworking Terms and Acronyms Dictionary, Internetworking 
Technology Handbook, Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco monthly periodical that provides industry professionals with the latest 
information about the field of networking. You can access Packet magazine at this URL:
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Obtaining Additional Publications and Information
http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_magazine.html

• iQ Magazine is the Cisco monthly periodical that provides business leaders and decision makers 
with the latest information about the networking industry. You can access iQ Magazine at this URL:

http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=true&kbns=1.html

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in the design, development, and operation of public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_protocol_journal.html

• Training—Cisco offers world-class networking training, with current offerings in network training 
listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training_list.html
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C H A P T E R 1

Install the Shelf and Backplane Cable

This chapter provides procedures for installing the Cisco ONS 15454. To view a summary of the tools 
and equipment required for installation, see the “Required Tools and Equipment” section on page 1-2.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A1 Unpack and Inspect the ONS 15454 Shelf Assembly, page 1-4—Complete this procedure 
before continuing with the “NTP-A2 Install the Shelf Assembly” procedure on page 1-5.

2. NTP-A2 Install the Shelf Assembly, page 1-5—Complete this procedure to install the shelf 
assembly in a rack.

3. NTP-A3 Open and Remove the Front Door, page 1-12—Complete this procedure to access the 
equipment before continuing with other procedures in this chapter.

4. NTP-A4 Remove the Backplane Covers, page 1-15—Complete this procedure to access the 
backplane before continuing with other procedures in this chapter.

5. NTP-A5 Install the Electrical Interface Assemblies, page 1-16—Complete this procedure if you plan 
to install electrical cards. This procedure is a prerequisite to the “NTP-A9 Install the Electrical Card 
Cables on the Backplane” procedure on page 1-45. 

6. NTP-A6 Install the Power and Ground, page 1-23—Complete this procedure before continuing with 
the “NTP-A7 Install the Fan-Tray Assembly” procedure on page 1-29.

7. NTP-A7 Install the Fan-Tray Assembly, page 1-29—Complete this procedure to install the fan-tray 
assembly in the shelf.

8. NTP-A119 Install the Alarm Expansion Panel, page 1-31—Complete this procedure if you are 
planning to install the Alarm Interface Controller–International (AIC-I) card and want to increase 
the number of alarm contacts provided by the AIC-I. 

9. NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-34—Complete 
this procedure to set up wire-wrap pin connections.

10. NTP-A120 Install an External Wire-Wrap Panel to the AEP, page 1-40—Complete this procedure to 
connect an external wire-wrap panel to the Alarm Expansion Panel (AEP).

11. NTP-A9 Install the Electrical Card Cables on the Backplane, page 1-45—Complete this procedure 
if you plan to install electrical cards.

12. NTP-A10 Route Electrical Cables, page 1-53—Complete this procedure before continuing with the 
“NTP-A11 Install the Rear Cover” procedure on page 1-55.
1-1
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Chapter 1      Install the Shelf and Backplane Cable
Required Tools and Equipment
13. NTP-A11 Install the Rear Cover, page 1-55—Complete this procedure to install the rear cover.

14. NTP-A12 Install Ferrites, page 1-57—Complete this procedure to attach ferrites to power cables.

15. NTP-A13 Perform the Shelf Installation Acceptance Test, page 1-60—Complete this procedure to 
determine if you have correctly completed all other procedures in the chapter.

Warning Only trained and qualified personnel should be allowed to install, replace, or service this equipment.

Warning The ONS 15454 is intended for installation in restricted access areas. A restricted access area is 
where access can only be gained by service personnel through the use of a special tool, lock, key, or 
other means of security. A restricted access area is controlled by the authority responsible for the 
location.

Warning The ONS 15454 is suitable for mounting on concrete or other noncombustible surfaces only.

Required Tools and Equipment 
You need the following tools and equipment to install and test the ONS 15454.

Included Materials
The following materials are required and are shipped with the ONS 15454 shelf (wrapped in plastic). 
The number in parentheses gives the quantity of the item included in the package.

• #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX) (8)

• #12 -24 x 3/4 socket set screws (48-1003-XX) (2)

• T-handle #12-24 hex tool for set screws (1)

• ESD wrist strap with 1.8 m (6 ft) coil cable (1)

• Tie wraps (10)

• Pinned hex (Allen) key for front door (1)

• Spacers (50-1193-XX) (4)

• Spacer mounting brackets (2)

• Clear plastic rear cover (1)

• External (bottom) brackets for the fan-tray air filter

• Standoff kit (53-0795-XX):

– Plastic fiber management guides (2)

– Fan filter bracket screws (53-48-0003) (6)
1-2
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Required Tools and Equipment
User-Supplied Materials
The following materials and tools are required but are not supplied with the ONS 15454:

• One or more of the following equipment racks: 

– 19-inch (482.6 mm) rack; total width 22 inches (558.8 mm)

– 23-inch (584.2 mm) rack; total width 26 inches (660.4 mm)

• Fuse panel

• Power cable (from fuse and alarm panel to assembly), #10 AWG, copper conductors, 194°F [90°C])

Note If you are installing power on a 15454-SA-NEBS3E, 15454-SA-NEBS3, or 15454-SA-R1, 
P/N: 800-07149 shelf assembly, a #12 to #14 AWG power cable is required.

• Ground cable #6 AWG stranded

Note If you are installing power on a 15454-SA-NEBS3E, 15454-SA-NEBS3 or 15454-SA-R1, 
P/N: 800-07149 shelf assembly, the #14 AWG ground cable is required.

• Alarm cable pairs for all alarm connections, #22 or #24 AWG (0.51 mm² or 0.64 mm²), solid tinned

• 100-ohm shielded Building Integrated Timing Supply (BITS) clock cable pair #22 or #24 AWG 
(0.51 mm² or 0.64 mm²), twisted-pair T1-type

• Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical (OC-N) cards

• Shielded coaxial cable terminated with SMB or BNC connectors for DS-3 cards

• Shielded ABAM cable terminated with AMP Champ connectors or unterminated for DS1N-14 cards 
with #22 or #24 AWG (0.51 mm² or 0.64 mm²) ground wire (typically about two feet in length)

• 6-pair #29 AWG double-shielded cable

• Tie wraps and/or lacing cord 

• Labels

• Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for 
#10 AWG copper conductors

Tools Needed

• #2 Phillips screwdriver

• Medium slot-head screwdriver 

• Small slot-head screwdriver 

• Wire wrapper

• Wire cutters

• Wire strippers

• Crimp tool

• BNC insertion tool
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NTP-A1 Unpack and Inspect the ONS 15454 Shelf Assembly
Test Equipment

• Voltmeter

• Optical power meter (for use with fiber optics only)

• Bit error rate (BER) tester, DS-1 and DS-3

NTP-A 1 Unpack and Inspect the ONS 15454 Shelf Assembly 

Step 1 Complete the “DLP-A1 Unpack and Verify the Shelf Assembly” task on page 1-4.

Step 2 Complete the “DLP-A2 Inspect the Shelf Assembly” task on page 1-5.

Step 3 Continue with the “NTP-A2 Install the Shelf Assembly” procedure on page 1-5.

Stop. You have completed this procedure. 

DLP-A1 Unpack and Verify the Shelf Assembly 

Step 1 When you receive the ONS 15454 system equipment at the installation site, open the top of the box. The 
Cisco Systems logo designates the top of the box.

Step 2 Remove the foam inserts from the box. The box contains the 15454 shelf (wrapped in plastic) and a 
smaller box of items needed for installation.

Step 3 To remove the shelf, grasp both rings of the shelf removal strap and slowly lift the shelf out of the box. 

Step 4 Open the smaller box of installation materials, and verify that you have all items listed in the “Included 
Materials” section on page 1-2. 

Purpose This procedure describes how to unpack the ONS 15454 and verify the 
contents.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the shelf assembly from the package.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Backplane Cable
NTP-A2 Install the Shelf Assembly
Note The fan-tray assembly is shipped separately.

Step 5 Return to your originating procedure (NTP).

DLP-A2 Inspect the Shelf Assembly 

Step 1 Open the shelf using the pinned hex key. For more information, see the “DLP-A8 Open the Front Cabinet 
Compartment (Door)” task on page 1-12.

Step 2 Verify the following:

• Pins are not bent or broken.

• Frame is not bent.

Step 3 If the pins are bent or broken, or the frame is bent, call your Cisco sales engineer for a replacement.

Step 4 Close the front door before installing.

Step 5 Return to your originating procedure (NTP).

NTP-A2 Install the Shelf Assembly 
 

Purpose This task verifies that all parts of the shelf assembly are in good condition.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures DLP-A1 Unpack and Verify the Shelf Assembly, page 1-4

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This procedure describes how to reverse the mounting bracket and mount 
shelf assemblies in a rack.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Pinned hex key

Two set screws (48-1003-XX)

Prerequisite Procedures NTP-A1 Unpack and Inspect the ONS 15454 Shelf Assembly, page 1-4

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-A2 Install the Shelf Assembly
Warning To prevent the equipment from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of 131°F (55°C). To prevent airflow restriction, allow at least 
1 inch (25.4 mm) of clearance around the ventilation openings.

Warning The ONS 15454 should be installed in the lower rack position or mounted above another ONS 15454 
shelf assembly.

Warning The ONS 15454 must have 1 inch of airspace below the installed shelf assembly to allow air flow to 
the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) provides 
this spacing and should not be modified in any way. 

Note The 10 Gbps compatible shelf assembly (15454-SA-10G) and fan-tray assembly (15454-FTA3) are 
required with the ONS 15454 XC10G, OC-192, and OC-48 any slot (AS) cards. 

Step 1 Complete the “DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack” task on 
page 1-6 if you need to convert from a 23-inch (584.2 mm) to a 19-inch (482.6 mm) rack.

Step 2 To install the air filter in an alternative location, complete the “DLP-A4 Install the External Brackets and 
Air Filter” task on page 1-8.

Step 3 Complete the necessary rack mount task:

• DLP-A5 Mount the Shelf Assembly in a Rack (One Person), page 1-9

• DLP-A6 Mount the Shelf Assembly in a Rack (Two People), page 1-10

• DLP-A7 Mount Multiple Shelf Assemblies in a Rack, page 1-11

Step 4 Continue with the “NTP-A3 Open and Remove the Front Door” procedure on page 1-12.

Stop. You have completed this procedure. 

DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack 

Purpose This task installs the mounting bracket to convert a 23-inch (584.2 mm) 
rack to a 19-inch (482.6 mm) rack.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-A2 Install the Shelf Assembly
Caution Use only the fastening hardware provided with the ONS 15454 to prevent loosening, deterioration, and 
electromechanical corrosion of the hardware and joined material.

Caution When mounting the ONS 15454 in a frame with a nonconductive coating (such as paint, lacquer, or 
enamel) either use the thread-forming screws provided with the ONS 15454 shipping kit, or remove the 
coating from the threads to ensure electrical continuity.

Step 1 Remove the screws that attach the mounting bracket to the side of the shelf assembly.

Step 2 Flip the detached mounting bracket upside down. 

Text imprinted on the mounting bracket will now also be upside down.

Step 3 Place the widest side of the mounting bracket flush against the shelf assembly (see Figure 1-1).

The narrow side of the mounting bracket should be towards the front of the shelf assembly. Text 
imprinted on the mounting bracket should be visible and upside down.

Step 4 Align the mounting bracket screw holes against the shelf assembly screw holes.

Step 5 Insert the screws that were removed in Step 1 and tighten them.

Step 6 Repeat the task for the mounting bracket on the opposite side.

Figure 1-1 Reversing the Mounting Brackets (23-inch (584.2 mm) Position to 19-inch (482.6 mm) Position)

Step 7 Return to your originating procedure (NTP).

Top of unit Side of unit

Top of unit

19 in. (482.6 mm) position 23 in. (584.2 mm)
mounting holes

23 in. (584.2 mm) position

47
86

9

Mounting
L brackets

Front

Mounting
L brackets

Rear

Front

Rear

Rear Front

19 in. (482.6 mm)
mounting holes
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NTP-A2 Install the Shelf Assembly
DLP-A4 Install the External Brackets and Air Filter 

Note The shelf assembly ships with external (bottom) brackets that you can use to install the air filter on the 
bottom of the shelf rather than beneath the fan-tray assembly. When you use the brackets to install the 
fan-tray air filter, you do not need to remove the fan-tray assembly to access the air filter. Attach the 
brackets to the bottom of the shelf assembly before installing the rack.

Note If you choose not to install the brackets, install the air filter by sliding it into the compartment at the 
bottom of the shelf assembly. Each time you remove and reinstall the air filter in the future, you must 
first remove the fan-tray assembly. Do not install an air filter in both filter locations on any shelf 
assembly.

Step 1 With the fan-tray assembly removed, place the ONS 15454 face down on a flat surface. 

Note Although the filter will work if it is installed with either side facing up, Cisco recommends that you 
install it with the metal bracing facing up to preserve the surface of the filter. 

Step 2 Locate the three screw holes that run along the left and right sides of the bottom of the shelf assembly. 

Step 3 Secure each bracket to the bottom of the shelf assembly using the screws (48-0003) provided in the 
backplane standoff kit (53-0795-XX).

Each bracket has a filter stopper and a flange on one end. Make sure to attach the brackets with the 
stoppers and flanges facing the rear of the shelf assembly (the top, if the ONS 15454 is face-down during 
installation). 

Figure 1-2 illustrates bottom bracket installation. If you do not use the brackets, in the future you must 
remove the fan-tray assembly before removing the air filter. The brackets enable you to clean and replace 
the air filter without removing the fan-tray assembly. 

Purpose This task installs the external brackets and air filter.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack, 
page 1-6, if applicable

Required/As Needed As needed; perform this task if you want to access the air filter without 
removing the fan-tray assembly.

Onsite/Remote Onsite

Security Level None
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NTP-A2 Install the Shelf Assembly
Figure 1-2 Installing the External Brackets

Step 4 Slide the air filter into the shelf assembly.

Step 5 Return to your originating procedure (NTP).

DLP-A5 Mount the Shelf Assembly in a Rack (One Person) 

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel has not been installed, you must install one according to manufacturer’s instructions.

• If installing the 15454-SA-ANSI shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) 
is required. 

• If installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf 
minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]).

Purpose This task allows one person to mount the shelf assembly in a rack.

Tools/Equipment Pinned hex key

Two set screws (48-1003-XX)

# 2 Phillips screwdriver

Prerequisite Procedures DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack, 
page 1-6, if applicable

DLP-A4 Install the External Brackets and Air Filter, page 1-8, if applicable

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Backplane Cable
NTP-A2 Install the Shelf Assembly
Step 3 Using the hex key that shipped with the assembly, install the two set screws into the screw holes that will 
not be used to mount the shelf.

Step 4 Lift the shelf assembly to the desired rack position and set it on the set screws.

Step 5 Align the screw holes on the mounting ears with the mounting holes in the rack.

Step 6 Using the Phillips screwdriver, install one mounting screw in each side of the assembly.

Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws.

Note Use at least one set of the horizontal screw slots on the ONS 15454 to prevent slippage.

Step 8 Remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).

DLP-A6 Mount the Shelf Assembly in a Rack (Two People) 

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions. 

• If installing the 15454-SA-ANSI shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) 
is required. 

• If installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf 
minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]).

Step 3 Using the hex key that shipped with the shelf assembly, install the two set screws (48-1003-XX) into the 
screw holes that will not be used to mount the shelf.

Step 4 Lift the shelf assembly to the desired position in the rack.

Step 5 Align the screw holes on the mounting ears with the mounting holes in the rack.

Step 6 While one person holds the shelf assembly in place, the other person can install one mounting screw in 
each side of the assembly using the Phillips screwdriver.

Purpose This task allows two people to mount the shelf assembly in a rack.

Tools/Equipment • Pinned hex key 

• Two set screws (48-1003-XX)

• # 2 Phillips screwdriver

Prerequisite Procedures DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack, 
page 1-6, if applicable

DLP-A4 Install the External Brackets and Air Filter, page 1-8, if applicable

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Backplane Cable
NTP-A2 Install the Shelf Assembly
Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws.

Note Use at least one set of the horizontal screw slots on the ONS 15454 to prevent slippage.

Step 8 Remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).

DLP-A7 Mount Multiple Shelf Assemblies in a Rack 

Note The ONS 15454 must have one inch (25.4 mm) of airspace below the installed shelf assembly to allow 
air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air ramp 
on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is installed 
above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) between the 
third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment must not vent 
heat upward into the ONS 15454.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions. 

• If installing the 15454-SA-ANSI shelf assembly, a 100-A fuse panel (30-A fuse per shelf minimum) 
is required. 

• If installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel (20-A fuse per shelf 
minimum) is required.

Step 2 Mount the first ONS 15454 directly below the fuse and alarm panel using the “DLP-A5 Mount the Shelf 
Assembly in a Rack (One Person)” task on page 1-9 or the “DLP-A6 Mount the Shelf Assembly in a 
Rack (Two People)” task on page 1-10.

Step 3 Repeat the task with the second and third (fourth if applicable) ONS 15454s.

Step 4 Return to your originating procedure (NTP).

Purpose This task allows multiple shelves to be assembled in a rack.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-A3 Reverse the Mounting Bracket to Fit a 19-inch (482.6 mm) Rack, 
page 1-6, if applicable

DLP-A4 Install the External Brackets and Air Filter, page 1-8, if applicable

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-A3 Open and Remove the Front Door
NTP-A3 Open and Remove the Front Door 

Step 1 Complete the “DLP-A8 Open the Front Cabinet Compartment (Door)” task on page 1-12.

Step 2 Complete the “DLP-A9 Remove the Front Door” task on page 1-13.

Step 3 Continue with the “NTP-A4 Remove the Backplane Covers” procedure on page 1-15.

Stop. You have completed this procedure. 

DLP-A8 Open the Front Cabinet Compartment (Door) 

Note The ONS 15454 has an ESD plug input and is shipped with an ESD wrist strap. The ESD plug input is 
located on the outside edge of the shelf assembly on the right-hand side. It is labeled “ESD” on the top 
and bottom. Always wear an ESD wrist strap and connect the strap to the ESD plug when working on 
the ONS 15454.

Step 1 Open the front door lock (Figure 1-3 on page 1-13).

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

Step 2 Press the door button to release the latch. 

Step 3 Swing the door open. 

Purpose This procedure describes how to open and remove the front door to access 
the equipment.

Tools/Equipment Open-end wrench

Pinned hex key 

Prerequisite Procedures NTP-A2 Install the Shelf Assembly, page 1-5

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task describes how to open the front cabinet compartment door.

Tools/Equipment Pinned hex key 

Prerequisite Procedures NTP-A2 Install the Shelf Assembly, page 1-5

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-A3 Open and Remove the Front Door
Figure 1-3 Cisco ONS 15454 Front Door

Step 4 Return to your originating procedure (NTP).

DLP-A9 Remove the Front Door 

Step 1 Open the door.

Step 2 To remove the door ground strap (available in Release 3.3 and later), perform the following:

a. To detach the ground strap from the front door, loosen the #6 kep nut (49-0600-01) using the 
open-end wrench. Detach the end of the ground strap terminal lug (72-3622-01) from the male stud 
on the inside of the door. 

Purpose Use this task to remove the front cabinet compartment door.

Tools/Equipment Open-end wrench

Prerequisite Procedures DLP-A8 Open the Front Cabinet Compartment (Door), page 1-12

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Door lock Door button

Viewholes for Critical, Major and Minor alarm LEDs

33
92

3

CISCO ONS 15454
Opt ica l  Ne twork  Sys t em
1-13
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 1      Install the Shelf and Backplane Cable
NTP-A3 Open and Remove the Front Door
b. To detach the other end of the ground strap from the longer screw on the fiber guide, loosen the 
#4 kep nut (49-0337-01) on the terminal lug using the open-end wrench. Remove the terminal lug 
and lock washer. 

Step 3 Lift the door from its hinges at the top left corner of the door (Figure 1-4).

Figure 1-4 Removing the ONS 15454 Front Door

Step 4 Return to your originating procedure (NTP).
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NTP-A4 Remove the Backplane Covers
NTP-A4 Remove the Backplane Covers

Step 1 Complete the “DLP-A10 Remove the Lower Backplane Cover” task on page 1-15.

Step 2 Complete the “DLP-A11 Remove the Backplane Sheet Metal Cover” task on page 1-16.

Step 3 If you plan to install electrical interface assemblies (EIAs), continue with the “NTP-A5 Install the 
Electrical Interface Assemblies” procedure on page 1-16. If not, continue with the “NTP-A6 Install the 
Power and Ground” procedure on page 1-23.

Stop. You have completed this procedure. 

DLP-A10 Remove the Lower Backplane Cover 

Step 1 Unscrew the five retaining screws that hold the clear plastic cover in place.

Step 2 Grasp the clear plastic cover on each side.

Step 3 Gently pull the cover away from the backplane.

Step 4 Return to your originating procedure (NTP).

Purpose This procedure describes how to access the backplane by removing the 
covers. The backplane has two sheet metal covers (one on either side) and 
a lower backplane cover at the bottom. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-A2 Install the Shelf Assembly, page 1-5

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the lower backplane cover.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-A3 Open and Remove the Front Door, page 1-12

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-A5 Install the Electrical Interface Assemblies
DLP-A11 Remove the Backplane Sheet Metal Cover 

Step 1 To remove the lower clear plastic backplane cover, loosen the five screws that secure it to the ONS 15454 
and pull it away from the shelf assembly.

Step 2 Loosen the nine perimeter screws that hold the backplane sheet metal cover(s) in place.

Step 3 Lift the panel by the bottom to remove it from the shelf assembly.

Step 4 Store the panel for later use. Attach the backplane cover(s) whenever EIA(s) are not installed.

Step 5 Return to your originating procedure (NTP).

NTP-A5 Install the Electrical Interface Assemblies 

Purpose This task removes the backplane sheet cover that is installed on the 
backplane when EIAs are not installed.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-A3 Open and Remove the Front Door, page 1-12, 

DLP-A10 Remove the Lower Backplane Cover, page 1-15

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This procedure describes how to install electrical interface assemblies 
(EIAs). Typically, an EIA panel is already installed on the backplane when 
the node is received, but EIA panels can be ordered separately. Refer to the 
Cisco ONS 15454 Reference Manual for descriptions of the EIAs.

Tools/Equipment #2 Phillips screwdriver 

Medium slot-head screwdriver 

Small slot-head screwdriver

perimeter screws (9) 

inner screws (12) 

backplane cover screws (5) 

EIA card (SMB, BNC, AMP Champ) 

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if the node will use electrical signals

Onsite/Remote Onsite

Security Level None
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NTP-A5 Install the Electrical Interface Assemblies
Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note EIAs are normally factory installed. Verify that the correct EIA is installed on the shelf assembly. If not, 
install the correct EIA.

Step 1 Complete the “DLP-A12 Install a BNC or High-Density BNC EIA” task on page 1-17 as needed. BNCs 
are locking connectors; the high-density BNC also allows you to access every port on every card.

Step 2 Complete the “DLP-A13 Install an SMB EIA” task on page 1-19 as needed. SMBs allow you to access 
every port on every card using more space and efficient cabling.

Step 3 Complete the “DLP-A14 Install the AMP Champ EIA” task on page 1-21 as needed. AMP Champs are 
exclusive to DS-1 cables. 

Note To attach cables to the EIAs, see the “NTP-A9 Install the Electrical Card Cables on the 
Backplane” procedure on page 1-45.

Step 4 Continue with the “NTP-A6 Install the Power and Ground” procedure on page 1-23.

Stop. You have completed this procedure. 

DLP-A12 Install a BNC or High-Density BNC EIA 

Step 1 Remove the BNC or high-density BNC card from the packaging. Line up the connectors on the card with 
the mating connectors on the backplane. Gently push the card until both sets of connectors fit together 
snugly. 

Purpose This task installs a BNC or high-density BNC EIA.

Tools/Equipment #2 Phillips screwdriver 

Medium slot-head screwdriver 

Small slot-head screwdriver 

Perimeter screws (9) 

Inner screws (12) 

Backplane cover screws (5) 

BNC or high-density BNC card

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if you are using DS3-12, DS3XM-6, or EC-1 card and prefer a 
BNC interface to an SMB interface

Onsite/Remote Onsite

Security Level None
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NTP-A5 Install the Electrical Interface Assemblies
Step 2 Place the metal EIA panel over the card. 

Step 3 Insert and tighten the nine perimeter screws (P/N 48-0358) at 8 to 10 lb. (3.6 to 4.5 kg) to secure the 
cover panel to the backplane.

Step 4 Insert and tighten the twelve (BNC) or nine (high-density BNC) inner screws (P/N 48-0004) at 8 to 10 
lb. (3.6 to 4.5 kg) to secure the cover panel to the card and backplane. 

Figure 1-5 shows a BNC EIA installation. Figure 1-6 on page 1-19 shows high-density BNC EIA 
installation. 

Figure 1-5 Installing the BNC EIA 
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NTP-A5 Install the Electrical Interface Assemblies
Figure 1-6 Installing the High-Density BNC EIA 

Step 5 Return to your originating procedure (NTP).

DLP-A13 Install an SMB EIA

Purpose This task installs an SMB EIA.

Tools/Equipment #2 Phillips screwdriver
Medium slot-head screwdriver 
Small slot-head screwdriver 
9 perimeter screws
12 inner screws
5 backplane cover screws
SMB card
EIA panel

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if you are using DS1-14 cards and prefer an SMB interface to an 
AMP interface, or if you are using DS3-12, DS3XM-6, or EC-1 cards and 
prefer an SMB interface to a BNC interface

Onsite/Remote Onsite

Security Level None
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NTP-A5 Install the Electrical Interface Assemblies
Step 1 Remove the SMB card from the packaging. Line up the connectors on the card with the mating 
connectors on the backplane. Gently push the card until both sets of connectors fit together snugly. 

Step 2 Place the EIA panel over the card. 

Step 3 Insert and tighten the nine perimeter screws (P/N 48-0358) at 8 to 10 lb. (3.6 to 4.5 kg) to secure the 
cover panel to the backplane.

Step 4 Insert and tighten the twelve inner screws (P/N 48-0004) at 8 to 10 lb. (3.6 to 4.5 kg) to secure the cover 
panel to the card and backplane. 

If you are using SMB EIAs to make DS-1 connections, you need the DS-1 electrical interface adapter, 
commonly referred to as a balun (P/N 15454-WW-14=). 

Figure 1-7 on page 1-20 shows an SMB EIA installation. 

Figure 1-7 Installing the SMB EIA (Use a Balun for DS-1 Connections)

Step 5 Return to your originating procedure (NTP).
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DLP-A14 Install the AMP Champ EIA 

Step 1 Align the AMP Champ panel with the backplane and insert and tighten the nine perimeter screws 
(P/N 48-0358) at 8 to 10 lb. (3.6 to 4.5 kg).

Step 2 Align an AMP Champ card with the backplane connector and push until it fits snugly. Repeat until you 
have installed all six AMP Champ cards.

Step 3 To secure each AMP Champ card to the cover panel, insert and tighten a screw (P/N 48-0003) at the top 
of each card at 8 to 10 lb. (3.6 to 4.5 kg).

Step 4 Place the AMP Champ fastening plate along the bottom of the cover panel, and hand-tighten the two 
thumbscrews.

Figure 1-8 shows an AMP Champ EIA installation.

Purpose This task installs an AMP Champ EIA.

Tools/Equipment #2 Phillips screwdriver
Medium slot-head screwdriver 
Small slot-head screwdriver 
9 perimeter screws
12 inner screws
5 backplane cover screws
6 AMP Champ cards
EIA panel

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if you are using DS1-14 cards and prefer an AMP interface to an 
SMB interface

Onsite/Remote Onsite

Security Level None
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NTP-A5 Install the Electrical Interface Assemblies
Figure 1-8 Installing the AMP Champ EIA 

Step 5 Return to your originating procedure (NTP).
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NTP-A6 Install the Power and Ground
NTP-A6 Install the Power and Ground 

Warning Shut off the power from the power source or turn off the breakers before beginning work.

Warning This equipment is intended to be grounded. Ensure that the host is connected to earth ground during 
normal use.

Warning Do not mix conductors of dissimilar metals in a terminal or splicing connector where physical contact 
occurs (such as copper and aluminum, or copper and copper-clad aluminum), unless the device is 
suited for the purpose and conditions of use. 

Warning Connect the ONS 15454 only to a DC power source that complies with the safety extra-low voltage 
(SELV) requirements in IEC 60950-based safety standards.

Warning The ONS 15454 relies on the protective devices in the building installation to protect against short 
circuit, overcurrent, and grounding faults. Ensure that the protective devices are properly rated to 
protect the system, and that they comply with national and local codes. 

Purpose This procedure describes how to install power feeds and ground the 
ONS 15454.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194°F [90°C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Warning A readily accessible two-poled disconnect device must be incorporated in the fixed wiring.

Warning When installing redundant power feeds, do not use aluminum conductors.

Warning If you use redundant power leads to power the ONS 15454, disconnecting one lead will not remove 
power from the node.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Step 1 Complete the “DLP-A15 Verify that the Correct Fuse and Alarm Panel is Installed in the Equipment 
Rack” task on page 1-24.

Step 2 Complete the “DLP-A16 Connect the Office Ground to the ONS 15454” task on page 1-25.

Step 3 Complete the “DLP-A17 Connect Office Power to the ONS 15454 Shelf” task on page 1-26.

Step 4 Complete the “DLP-A18 Turn On and Verify Office Power” task on page 1-28.

Step 5 Continue with the “NTP-A7 Install the Fan-Tray Assembly” procedure on page 1-29.

Stop. You have completed this procedure. 

DLP-A15 Verify that the Correct Fuse and Alarm Panel is Installed in the 
Equipment Rack 

Step 1 Verify the following:

• If using the 15454-SA-ANSI shelf, a 100-A fuse panel (30-A fuse per shelf minimum) is installed. 
If not, install one according to manufacturer’s instructions.

• If using the 15454-SA-NEBS3 shelf, a standard 80-A fuse panel (20-A fuse per shelf minimum) is 
installed. If not, install one according to manufacturer’s instructions.

Step 2 Return to your originating procedure (NTP).

Purpose This task verifies that the proper fuse and alarm panel is installed in the 
equipment rack.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
1-24
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 1      Install the Shelf and Backplane Cable
NTP-A6 Install the Power and Ground
DLP-A16 Connect the Office Ground to the ONS 15454

Step 1 Verify that the office ground cable (#6 AWG stranded) is connected to the top of the bay according to 
local site practice.

Step 2 Attach one end of the shelf ground cable (#10 AWG) to the right side of the backplane ground nut. See 
Figure 1-9 for the location of the ground on the backplane.

Note When terminating a frame ground, use the kep nut provided with the ONS 15454 and tighten it 
to a torque specification of 31 in-lb. The kep nut provides a frame ground connection that 
minimizes the possibility of loosening caused by rotation during installation and maintenance 
activity. The type of prevention the kep nut provides for the frame ground connection is 
inherently provided by the terminal block for battery and battery return connections.

Figure 1-9 Ground Location on the Backplane

Step 3 Attach the other end of the shelf ground cable to the bay. 

Step 4 Return to your originating procedure (NTP).

Purpose This task connects ground to the ONS 15454 shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194°F [90°C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-A10 Remove the Lower Backplane Cover, page 1-15

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

FRAME GROUND 61
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NTP-A6 Install the Power and Ground
DLP-A17 Connect Office Power to the ONS 15454 Shelf 

Warning Do not apply power to the ONS 15454 until you complete all installation steps and check the continuity 
of the -48 VDC and return. 

Note If the system loses power or both TCC+ cards are reset and the system is not provisioned to get the time 
from a Network Time Protocol/Simple Network Time Protocol (NTP/SNTP) server, you must reset the 
ONS 15454 clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the 
clock, see the “NTP-A25 Set Up Name, Date, Time, and Contact Information” procedure on page 4-6.
If you are using the TCC2 cards, the system clock will be kept running for up to three hours. In this case, 
no action would be required. 

Note If you encounter problems with the power supply, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 1 Connect the office power according to the fuse panel engineering specifications.

Step 2 Measure and cut the cables as needed to reach the ONS 15454 from the fuse panel. Figure 1-10 on 
page 1-27 shows the ONS 15454 power terminals.

Step 3 Dress the power according to local site practice. 

Purpose This task connects power to the ONS 15454 shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194°F [90°C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-A15 Verify that the Correct Fuse and Alarm Panel is Installed in the 
Equipment Rack, page 1-24

DLP-A16 Connect the Office Ground to the ONS 15454, page 1-25

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Warning When installing the ONS 15454, the ground connection must always be made first and disconnected 
last.

Figure 1-10 Cisco ONS 15454 Power Terminals

Step 4 Remove or loosen the #8 power terminal screws on the ONS 15454. To avoid confusion, label the cables 
connected to the BAT1/RET1 (A) power terminals as 1, and the cables connected to the BAT2/RET2 (B) 
power terminals as 2. 

Note Use only pressure terminal connectors, such as ring and fork types, when terminating the battery, 
battery return, and frame ground conductors.

Caution Before you make any crimp connections, coat all bare conductors (battery, battery return, and 
frame ground) with an appropriate antioxidant compound. Bring all unplated connectors, 
braided strap, and bus bars to a bright finish, then coat with an antioxidant before you connect 
them. You do not need to prepare tinned, solder-plated, or silver-plated connectors and other 
plated connection surfaces, but always keep them clean and free of contaminants.

Caution When terminating power, return, and frame ground, do not use soldering lug, screwless 
(push-in) connectors, quick-connect, or other friction-fit connectors.

Step 5 Strip 1/2 inch (12.7 mm) of insulation from all power cables that you will use.

Step 6 Crimp the lugs onto the ends of all power leads. 

33
92

1

RET  1

CAUTION: Remove power from both
the BAT1 and terminal blocks
prior to servicing

SUITABLE FOR MOUNTING ON
A NON-COMBUSTIBLE SURFACE.
PLEASE REFER TO INSTALLATION
INSTRUCTIONS.

-42 V      24 A

BAT  1 RET  2 BAT  2

Battery leads (red)
Return leads (black)
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Note When terminating battery and battery return connections as shown in Figure 1-10, follow a 
torque specification of 10 in-lb. 

Step 7 Terminate the return 1 lead to the RET1 backplane terminal. Use oxidation-prevention grease to keep 
connections noncorrosive.

Warning Do not secure multiple connectors with the same bolt assembly.

Step 8 Terminate the negative 1 lead to the negative BAT1 backplane power terminal. Use oxidation prevention 
grease to keep connections noncorrosive.

Step 9 If you use redundant power leads, terminate the return 2 lead to the positive RET2 terminal on the 
ONS 15454. Terminate the negative 2 lead to the negative BAT2 terminal on the ONS 15454. Use 
oxidation-preventative grease to keep connections noncorrosive.

Step 10 Route the cables out below the power terminals using the plastic cable clamp, as shown in Figure 1-10 
on page 1-27.

Step 11 Return to your originating procedure (NTP).

DLP-A18 Turn On and Verify Office Power 

Step 1 Using a voltmeter, verify the office battery and ground at the following points on the fuse and alarm 
panel:

a. To verify the power, place the black test lead of the voltmeter to the frame ground. Place the red test 
lead on the A-side connection and verify that it is between –42 VDC and –57 VDC. Place the red 
test lead on the B-side connection and verify that it is between –42 VDC and –57 VDC. 

Note The voltages –42 VDC and –57 VDC are, respectively, the minimum and maximum voltages 
required to power the chassis. 

b. To verify the ground, place the black test lead of the voltmeter to the frame ground. Place the red 
test lead on the A-side return ground and verify that no voltage is present. Place the red test lead on 
the B-side return ground and verify that no voltage is present. 

Purpose This task measures the power to verify correct power and returns.

Tools/Equipment Voltmeter

Prerequisite Procedures DLP-A15 Verify that the Correct Fuse and Alarm Panel is Installed in the 
Equipment Rack, page 1-24

DLP-A16 Connect the Office Ground to the ONS 15454, page 1-25

DLP-A17 Connect Office Power to the ONS 15454 Shelf, page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Step 2 Complete one of the following to power up the node:

• If you are using a 80-A fuse panel, insert a 20-A fuse into the fuse position according to site practice.

• If you are using a 100-A fuse panel, insert a 30-A fuse into the fuse position according to site 
practice.

Step 3 Using a voltmeter, verify the shelf for –48 VDC battery and ground:

a. To verify the A-side of the shelf, place the black lead of the voltmeter to the frame ground. Place the 
red test lead to the BAT1 (A-side battery connection) red cable. Verify that it reads between 
–42 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET1 (A-side return 
ground) black cable and verify that no voltage is present.

Note The voltages –42 VDC and –57 VDC are, respectively, the minimum and maximum voltages 
required to power the chassis. 

b. To verify the B-side of the shelf, place the black test lead of the voltmeter to the frame ground. Place 
the red test lead to the BAT2 (B-side battery connection) red cable. Verify that it reads between 
–42 VDC and –57 VDC. Then, place the red test lead of the voltmeter to the RET2 (B-side return 
ground) black cable and verify that no voltage is present.

Step 4 Return to your originating procedure (NTP).

NTP-A7 Install the Fan-Tray Assembly 

Caution Do not operate an ONS 15454 without a fan-tray air filter. A fan-tray air filter is mandatory.

Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 Release 3.1 or later shelf 
assemblies (15454-SA-ANSI, 800-19857). It includes a pin that does not allow it to be installed in 
ONS 15454 shelf assemblies released earlier than ONS 15454 Release 3.1 (15454-SA-NEBS3E, 
15454-SA-NEBS3, and 15454-SA-R1, P/N 800-0714915454). Installing the 15454-FTA3 in a 
noncompliant shelf assembly might result in failure of the alarm interface panel (AIP), which in turn, 
will result in power loss to the fan-tray assembly. 

Purpose This procedure installs the fan-tray assembly.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-A3 Open and Remove the Front Door, page 1-12

NTP-A6 Install the Power and Ground, page 1-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Caution You must place the edge of the air filter flush against the front of the fan-tray assembly compartment 
when installing the fan tray on top of the filter. Failure to do so could result in damage to the filter, the 
fan tray, or both.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the back panel of the shelf assembly. 

Note To install the fan-tray assembly, it is not necessary to move any of the cable-management facilities. 

Step 1 Slide the fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into the 
corresponding receptacle on the backplane.

Step 2 To verify that the tray has plugged into the backplane, ensure that the LCD on the front of the fan tray 
is activated and displays data.

Figure 1-11 shows the location of the fan tray.

Figure 1-11 Installing the Fan-Tray Assembly

Step 3 Continue with the “NTP-A119 Install the Alarm Expansion Panel” procedure on page 1-31 if you plan 
to install an Alarm Expansion Panel (AEP). If not, continue with the “NTP-A8 Install Wires to Alarm, 
Timing, LAN, and Craft Pin Connections” procedure on page 1-34.

Stop. You have completed this procedure. 
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NTP-A119 Install the Alarm Expansion Panel

Note The AIC-I card provides direct alarm contacts (external alarm inputs and external control outputs). In 
the ANSI shelf, these AIC-I alarm contacts are routed through the backplane to wire-wrap pins 
accessible from the back of the shelf. When you install an AEP, the direct AIC-I alarm contacts cannot 
be used. Only the AEP alarm contacts can be used. 

Step 1 Remove the two backplane screws. Replace the two screws with standoffs. Insert the longer standoff on 
the left, and the shorter standoff on the right (Figure 1-12 on page 1-32). 

Purpose This procedure installs an Alarm Expansion Panel (AEP) onto the 
15454-SA-ANSI shelf backplane. The AEP provides alarm contacts in 
addition to the 16 provided by the AIC-I card. Typically, the AEP is 
pre-installed when ordered with the ONS 15454; however, the AEP can be 
ordered separately. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

6-pair #29 AWG double-shielded cable

Standoffs (4)

Prerequisite Procedures DLP-A10 Remove the Lower Backplane Cover, page 1-15

Required/As Needed Required if you are terminating more than 16 alarm contacts (16 inputs + 
0 outputs or 12 inputs or 4 outputs); the AIC-I card must be installed before 
you can provision the alarm contacts enabled by the AEP. 

Onsite/Remote Onsite

Security Level None
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Figure 1-12 Replace Backplane Screws with Standoffs

Step 2 Attach the remaining two standoffs on either side of the backplane (Figure 1-13). 

Step 3 Position the AEP board over the standoffs (Figure 1-13).
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Figure 1-13 Installing Standoffs and the AEP

Step 4 Insert and tighten three screws to secure the AEP to the backplane.

Step 5 Attach the open ends of the wires from the AEP board to the wire-wrap pins on the backplane of the shelf 
(Figure 1-14). Table 1-1 lists the AEP pin assignments.

Figure 1-14 AEP Wire-Wrap Connections to Backplane Pins
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3

AEP cable
Connector

Wires

Table 1-1 Pin Assignments for the AEP

Wire Pin AEP Signal AIC-I Signal 

Tip 1 7 AEP_GND GND

Tip 2 8 AEP_+5 AE_+5

Tip 3 9 VBAT- VBAT-

Tip 4 10 VB+ VB+

BITS LAN IN IN/OUT IN IN MODEM CFT LOCAL IN

TIP RNG TIP RNG TIP RNG TIP RNG TIP RNG TIP RNG TIP RNG

1

2

3

4

1

2

3

4

5

6

7

8

9

10

11

12

13

used for connection of AIC-I and AEP 78
47

2
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Step 6 Attach the connector on the opposite end of the cable assembly to the EIA/TIA-485 connector port on 
the AEP (Figure 1-13 on page 1-33). 

Step 7 Continue with the “NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin Connections” 
procedure on page 1-34.

Stop. You have completed this procedure. 

NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin 
Connections 

Step 1 Complete the “DLP-A19 Install Alarm Wires on the Backplane” task on page 1-35 if you are using an 
AIC or AIC-I card and not using an AEP. 

Step 2 Complete the “DLP-A20 Install Timing Wires on the Backplane” task on page 1-37 as needed. Timing 
wires are necessary to provision external timing.

Step 3 Complete the “DLP-A21 Install LAN Wires on the Backplane” task on page 1-38 as needed. LAN wires 
(or the LAN port on the TCC+/TCC2) are necessary to create an external LAN connection.

Step 4 Complete the “DLP-A22 Install the TL1 Craft Interface” task on page 1-39 as needed. Craft wires (or 
the EIA/TIA-232 port on the TCC+/TCC2) are required to access TL1 using the craft interface.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the 
wristband cable into the ESD jack located on the lower-right outside edge of the shelf 
assembly.

Tip 6 6 AE_CLK_P AE_CLK_P

Tip 7 5 AE_CLK_N AE_CLK_N

Tip 8 4 AE_DOUT_P AE_DIN_P

Tip 9 3 AE_DOUT_N AE_DIN_N

Tip 10 2 AE_DIN_P AE_DOUT_P

Tip 11 1 AE_DIN_N AE_DOUT_N

Table 1-1 Pin Assignments for the AEP (continued)

Wire Pin AEP Signal AIC-I Signal 

Purpose This procedure describes how to install alarm, timing, LAN, and craft 
wires.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) alarm wires

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None
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Step 5 Complete one of the following:

• If you installed an Alarm Expansion Panel (AEP), continue with the“NTP-A120 Install an External 
Wire-Wrap Panel to the AEP” procedure on page 1-40. 

• If you did not install an AEP and you plan to install electrical cards, continue with the “NTP-A9 
Install the Electrical Card Cables on the Backplane” procedure on page 1-45. 

• If you did not install an AEP and do not plan to install electrical cards, continue with the “NTP-A11 
Install the Rear Cover” procedure on page 1-55.

Step 6 Complete one of the following:

• If you plan to install an external wire-wrap panel to the AEP, continue with the “NTP-A120 Install 
an External Wire-Wrap Panel to the AEP” procedure on page 1-40. 

• If you plan to install electrical cards, continue with the “NTP-A9 Install the Electrical Card Cables 
on the Backplane” procedure on page 1-45. 

• If you do not plan to install electrical cards, continue with the “NTP-A11 Install the Rear Cover” 
procedure on page 1-55.

Stop. You have completed this procedure. 

DLP-A19 Install Alarm Wires on the Backplane 

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wires, wrap the alarm wires on the appropriate 
wire-wrap pins according to local site practice. Figure 1-15 shows alarm pin assignments for the AIC-I 
in the Release 3.4 or higher ONS 15454 backplane. Figure 1-16 on page 1-36 shows alarm pin 
assignments for the AIC in a shelf for Release 3.3 and earlier.

Note The AIC-I requires a shelf assembly running Software Release 3.4.0 or later. The backplane of the ANSI 
shelf contains a wire-wrap field with pin assignment according to the layout in Figure 1-15. The shelf 
assembly may be an existing shelf that has been upgraded to 3.4. In this case the backplane pin labeling 
will appear as indicated in Figure 1-16 on page 1-36. But you must use the pin assignments provided by 
the AIC-I as shown in Figure 1-15.

Purpose This task installs alarm wires on the backplane so that you can provision 
external (environmental) alarms and controls with the AIC or AIC-I card. 
If you are using the AEP, do not perform this task.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) wires

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required to create external alarms and controls without the AEP

Onsite/Remote Onsite

Security Level None
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For information about attaching ferrites to wire-wrap pin fields, see the “NTP-A12 Install Ferrites” 
section on page 1-57.

Figure 1-15 Cisco ONS 15454 Backplane Pinouts (Release 3.4 or Higher)

Figure 1-16 Cisco ONS 15454 Backplane Pinouts (Release 3.3 and Earlier)

B1 CRAFT A1 Receive (PC pin #2)

A2 A2  Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)
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Note The X.25, Modem, and TBOS pin fields are not active.

Step 2 Return to your originating procedure (NTP).

DLP-A20 Install Timing Wires on the Backplane 

Step 1 Using 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair 
T1-type, wrap the clock wires on the appropriate wire-wrap pins according to local site practice. 

The BITS pin field (FG1) has a frame ground pin beneath it. Wrap the ground shield of the BITS cable 
to the frame ground pin. Table 1-2 lists the pin assignments for the BITS timing pin fields.

Note For more detailed information about timing, refer to the Cisco ONS 15454 Reference Manual. 
To set up system timing, see the “NTP-A28 Set Up Timing” procedure on page 4-21.

Step 2 Return to your originating procedure (NTP).

Purpose This task installs the timing wires on the backplane.

Tools/Equipment Wire wrapper

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if the node is using external BITS timing

Onsite/Remote Onsite

Security Level None

Table 1-2 External Timing Pin Assignments for BITS

External Device Contact Tip & Ring Function

First external device A3 (BITS 1 Out) Primary ring (-) Output to external device

B3 (BITS 1 Out) Primary tip (+) Output to external device

A4 (BITS 1 In) Secondary ring (-) Input from external device

B4 (BITS 1 In) Secondary tip (+) Input from external device

Second external device A1 (BITS 2 Out) Primary ring (-) Output to external device

B1 (BITS 2 Out) Primary tip (+) Output to external device

A2 (BITS 2 In) Secondary ring (-) Input from external device

B2 (BITS 2 In Secondary tip (+) Input from external device
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DLP-A21 Install LAN Wires on the Backplane 

Note Rather than using the LAN wires, you can use the LAN connection port on the TCC+/TCC2 if preferred. 
Use either the backplane connection or the TCC+/TCC2 front connection. You cannot use the LAN 
backplane pins and the LAN connection port on the TCC+/TCC2 simultaneously; however, it is possible 
for you to make a direct connection from a computer to the LAN connection port on the TCC+/TCC2 
while the LAN backplane pins are in use as long as the computer that is connected directly to the 
TCC+/TCC2 is not connected to a LAN.

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire or CAT5 UTP Ethernet cable, wrap the wires on 
the appropriate wire-wrap pins according to local site practice. 

Caution Cross talk may result if both receive (Rx) and transmit (Tx) pins connect on the same twisted 
pair of wires from the CAT5 cable. The two Tx pins need to be on one twisted pair, and the 
two Rx pins need to be on another twisted pair.

A frame ground pin is located beneath each pin field (FG2 for the LAN pin field). Wrap the ground shield 
of the LAN interface cable to the frame ground pin. Table 1-3 shows the LAN pin assignments.

Purpose This task installs the LAN wires on the backplane.

Tools/Equipment Wire wrapper
#22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, preferably CAT5 UTP

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required if the node is using an external LAN connection

Onsite/Remote Onsite

Security Level None

Table 1-3 LAN Pin Assignments

Pin Field Backplane Pins RJ-45 Pins Function/Color

LAN 1 
Connecting to data 
circuit-terminating 
equipment (DCE*) (a hub 
or switch); the ONS 15454 
is a DCE

B2 1 TX+ white/green

A2 2 TX- green

B1 3 RX+ white/orange

A1 6 RX- orange

LAN 1
Connecting to data terminal 
equipment (DTE) (a 
PC/workstation or router)

B1 1 RX+ white/green

A1 2 RX- green

B2 3 TX+ white/orange

A2 6 TX- orange
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Note The TCC2 does not support Ethernet polarity detection. The TCC+ and TCC-I both support this feature. 
If your Ethernet connection has the incorrect polarity (this can only occur with cables that have the 
receive wire pairs flipped), the TCC+ or TCC-I will work, but the TCC2 will not. In this event, a standing 
condition, “Lan Connection Polarity Reversed”, will be raised. This issue will most likely be seen during 
an upgrade or initial node deployment. To correct the situation, ensure that your Ethernet cable has the 
correct mapping of the wire wrap pins. 

Step 2 Return to your originating procedure (NTP).

DLP-A22 Install the TL1 Craft Interface 

Note Rather than using the craft pins, you can use a LAN cable connected to the TCC+/TCC2 EIA/TIA-232 
port to access a TL1 craft interface. 

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, wrap the craft interface wires on the appropriate 
wire-wrap pins according to local site practice. 

Note For information about attaching ferrites to wire-wrap pin fields, see the “DLP-A31 Attach 
Ferrites to Wire-Wrap Pin Fields” task on page 1-59.

Step 2 Wrap the ground shield of the craft interface cable to the frame-ground pin. 

Wrap the ground wire of your computer cable to pin A3 on the craft pin field. Table 1-4 shows the pin 
assignments for the CRAFT pin field.

Note You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC+/TCC2 card 
simultaneously. Using a combination prevents access to the node or causes a loss in connectivity.

Purpose This task installs the TL1 craft interface.

Tools/Equipment Wire wrapper
#22 or #24 AWG (0.51 mm² or 0.64 mm²) alarm wires

Prerequisite Procedures NTP-A4 Remove the Backplane Covers, page 1-15

Required/As Needed Required to access TL1 using the craft backplane pins

Onsite/Remote Onsite

Security Level None
1-39
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 1      Install the Shelf and Backplane Cable
NTP-A120 Install an External Wire-Wrap Panel to the AEP
Step 3 Return to your originating procedure (NTP).

NTP-A120 Install an External Wire-Wrap Panel to the AEP

Step 1 Position the lower cover over the AEP. Make sure that the AEP AMP Champ connectors protrude 
through the cutouts in the lower cover (Figure 1-17). 

Table 1-4 Craft Interface Pin Assignments

Pin Field Contact Function

Craft A1 Receive

A2 Transmit

A3 Ground

A4 DTR

Purpose This procedure connects an external wire-wrap panel to the AEP to provide 
the physical alarm contacts for the AEP. 

Tools/Equipment External wire-wrap panel

Prerequisite Procedures NTP-A119 Install the Alarm Expansion Panel, page 1-31

Required/As Needed Required if you installed an AEP

Onsite/Remote Onsite

Security Level None
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Figure 1-17 Installing the AEP Cover

Step 2 Insert and tighten the eight screws to secure the AEP cover to the AEP. 

Step 3 Connect the cables from the external wire-wrap panel to the AMP Champ connectors on the AEP. 
Table 1-5 on page 1-41 lists the alarm input pin assignments. Table 1-6 on page 1-42 lists the alarm 
output pin assignments. Figure 1-18 on page 1-43 and Figure 1-19 on page 1-44 illustrate the alarm 
input and output connectors, respectively.

Table 1-5 Alarm Input Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 ALARM_IN_1- 27 GND

2 GND 28 ALARM_IN_2-

3 ALARM_IN_3- 29 ALARM_IN_4-

4 ALARM_IN_5- 30 GND

5 GND 31 ALARM_IN_6-

6 ALARM_IN_7- 32 ALARM_IN_8-

7 ALARM_IN_9- 33 GND

8 GND 34 ALARM_IN_10-

9 ALARM_IN_11- 35 ALARM_IN_12-

10 ALARM_IN_13- 36 GND

11 GND 37 ALARM_IN_14-

7
8

4
0

4
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12 ALARM_IN_15- 38 ALARM_IN_16-

13 ALARM_IN_17- 39 GND

14 GND 40 ALARM_IN_18-

15 ALARM_IN_19- 41 ALARM_IN_20-

16 ALARM_IN_21- 42 GND

17 GND 43 ALARM_IN_22-

18 ALARM_IN_23- 44 ALARM_IN_24-

19 ALARM_IN_25- 45 GND

20 GND 46 ALARM_IN_26-

21 ALARM_IN_27- 47 ALARM_IN_28-

22 ALARM_IN_29- 48 GND

23 GND 49 ALARM_IN_30-

24 ALARM_IN_31- 50 —

25 ALARM_IN_+ 51 GND1

26 ALARM_IN_0- 52 GND2

Table 1-6 Alarm Output Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 — 27 COM_0

2 COM_1 28 —

3 NO_1 29 NO_2

4 — 30 COM_2

5 COM_3 31 —

6 NO_3 32 NO_4

7 — 33 COM_4

8 COM_5 34 —

9 NO_5 35 NO_6

10 — 36 COM_6

11 COM_7 37 —

12 NO_7 38 NO_8

13 — 39 COM_8

14 COM_9 40 —

15 NO_9 41 NO_10

16 — 42 COM_10

17 COM_11 43 —

Table 1-5 Alarm Input Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name
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Figure 1-18 Alarm Input Connector

18 NO_11 44 NO_12

19 — 45 COM_12

20 COM_13 46 —

21 NO_13 47 NO_14

22 — 48 COM_14

23 COM_15 49 —

24 NO_15 50 —

25 — 51 GND1

26 NO_0 52 GND2

Table 1-6 Alarm Output Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

ALARM_IN_8-
XREF=5

Connector
Alarm Input

GND

ALARM_IN_0-XREF=5

XREF=5 ALARM_IN_2-XREF=5ALARM_IN_3-
XREF=5 ALARM_IN_4-XREF=5

ALARM_IN_5-

ALARM_IN_6-
XREF=5

ALARM_IN_7-
XREF=5
XREF=5ALARM_IN_9-

XREF=5
ALARM_IN_10-

XREF=5ALARM_IN_11-
XREF=5

ALARM_IN_12-
XREF=5ALARM_IN_13-

XREF=5
ALARM_IN_14-

XREF=5ALARM_IN_15-
XREF=6

ALARM_IN_16-
XREF=6

ALARM_IN_17-

XREF=6
ALARM_IN_18-

XREF=6
ALARM_IN_19- XREF=6 ALARM_IN_20-ALARM_IN_21- XREF=6

XREF=6 ALARM_IN_22-
XREF=6

ALARM_IN_24-
XREF=6

ALARM_IN_25-

XREF=6
ALARM_IN_26-

XREF=6
ALARM_IN_27- XREF=6 ALARM_IN_28-XREF=6
ALARM_IN_29-

XREF=6
ALARM_IN_30-

XREF=6ALARM_IN_31-
XREF=5ALARM_IN_+

GND

GND1

GND252

51

9
8
7
6

50

5

49
48
47
46
45
44
43
42
41
40

4

39
38
37
36
35
34
33
32
31
30

3
29
28
27
26

25
24
23
22
21
20

2

19
18
17
16
15
14
13
12
11
10

1

P3

XREF=6ALARM_IN_23-

ALARM_IN_1- XREF=5
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Figure 1-19 Alarm Output Connector

Step 4 Complete one of the following:

• If you plan to install electrical cards, continue with the “NTP-A9 Install the Electrical Card Cables 
on the Backplane” procedure on page 1-45. 

• If you do not plan to install electrical cards, continue with the “NTP-A11 Install the Rear Cover” 
procedure on page 1-55.

Stop. You have completed this procedure. 

NO_5 XREF=7
COM_5 XREF=7

NO_3 XREF=7
COM_3 XREF=7

COM_14XREF=7
NO_14XREF=7

XREF=7 COM_12
NO_12XREF=7

COM_10XREF=7
NO_10XREF=7

COM_8XREF=7
NO_8XREF=7

COM_6XREF=7
NO_6XREF=7

COM_4XREF=7
NO_4XREF=7

COM_2XREF=7

NO_1 XREF=7

NO_2XREF=7

COM_0XREF=7
NO_0XREF=7

NO_15 XREF=7
COM_15

XREF=7

NO_13 XREF=7
COM_13 XREF=7

COM_1 XREF=7

NO_11 XREF=7
COM_11

XREF=7

NO_9 XREF=7
COM_9 XREF=7

NO_7 XREF=7
COM_7 XREF=7

Connector
Alarm Output

GND1

GND2

1

10
11
12
13
14
15
16
17
18
19

2

20
21
22
23
24
25

26
27
28
29

3

30
31
32
33
34
35
36
37
38
39

4

40
41
42
43
44
45
46
47
48
49

5

50

6
7
8
9

51

52

P4
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NTP-A9 Install the Electrical Card Cables on the Backplane 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note Refer to the Cisco ONS 15454 Reference Manual for more information about EIAs.

Step 1 Complete the “DLP-A23 Install DS-1 Cables Using Electrical Interface Adapters (Balun)” task on 
page 1-46 as needed. Baluns are used on SMB EIAs to properly terminate DS-1 signals.

Step 2 To install DS-1 cables using AMP Champ cables, complete the “DLP-A24 Install DS-1 AMP Champ 
Cables on the AMP Champ EIA” task on page 1-47.

Step 3 Complete the “DLP-A25 Install Coaxial Cable With BNC Connectors” task on page 1-50 as needed.

Step 4 Complete the “DLP-A26 Install Coaxial Cable With High-Density BNC Connectors” task on page 1-51 
as needed.

Step 5 Complete the “DLP-A27 Install Coaxial Cable with SMB Connectors” task on page 1-52 as needed.

Step 6 Continue with the “NTP-A10 Route Electrical Cables” procedure on page 1-53. 

Stop. You have completed this procedure. 

Purpose Optional EIA backplane covers are typically pre-installed when ordered 
with the ONS 15454. The following procedure describes how to install the 
electrical card cables to the backplane. If the shelf was not shipped with the 
correct EIA interface, you must order and install the correct EIA.

Tools/Equipment Wire wrapper

Twisted-pair cables

BNC insertion tool

SMB cable connector

Prerequisite Procedures NTP-A5 Install the Electrical Interface Assemblies, page 1-16

Required/As Needed Required if you are using electrical cards

Onsite/Remote Onsite

Security Level None
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DLP-A23 Install DS-1 Cables Using Electrical Interface Adapters (Balun) 

Note All DS-1 cables connected to the ONS 15454 DS-1 ports must terminate with twisted-pair cables to 
connect to the DS-1 electrical interface adapter. The DS-1 electrical interface adapters project 1.72 
inches (43.7 mm) beyond the SMB EIA. 

Step 1 Attach the SMB connector on an adapter to the SMB connector for the port’s transmit pair on the 
backplane.

Step 2 Attach the SMB connector on an adapter to the SMB connector for the port’s receive pair on the 
backplane.

Step 3 Terminate the DS-1 transmit and receive cables for the port to the wire-wrap posts on the adapter:

a. Using a wire-wrap tool, connect the receive cables to the receive adapter pins on the backplane 
connector for the desired port.

b. Connect the transmit cables to the transmit adapter pins on the backplane connector for the desired 
port.

c. Terminate the shield ground wire on the DS-1 cable to ground according to local site practice.

Note If you put DS1N-14 cards in Slots 3 and 15 to form 1:N protection groups, do not wire Slots 3 
and 15 for DS-1 electrical interface adapters.

Figure 1-20 shows a ONS 15454 backplane with an SMB EIA. DS-1 electrical interface adapters are 
attached on both sides of the shelf assembly to create DS-1 twisted-pair termination points.

Purpose This task installs the DS-1 cables using the electrical interface adapters.

Tools/Equipment Wire wrapper

Twisted-pair cables

Prerequisite Procedures DLP-A13 Install an SMB EIA, page 1-19 

Required/As Needed Required if you are using an SMB EIA for DS1N-14 cards

Onsite/Remote Onsite

Security Level None
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Figure 1-20 Backplane with an SMB EIA for DS-1 Cables

Step 4 Return to your originating procedure (NTP).

DLP-A24 Install DS-1 AMP Champ Cables on the AMP Champ EIA 

Step 1 Prepare a 56-wire cable for each DS1N-14 card you will install in the shelf assembly. 

Step 2 Connect the male AMP Champ connector on the cable to the female AMP Champ connector on the 
ONS 15454 backplane.

Step 3 Use the clips on the male AMP Champ connector to secure the connection.

The female connector has grooves on the outside edge for snapping the clips into place.

Table 1-7 shows the pin assignments for the AMP Champ connectors on the ONS 15454 AMP Champ 
EIA. 

Note In Table 1-7, the shaded area corresponds to the white/orange binder group. A binder group is a set of 
25 pairs of wires coded with an industry-standard color scheme.

Purpose This task installs the DS-1 AMP Champ cables on the AMP Champ EIA.

Tools/Equipment Wire wrapper

Twisted-pair cables

Prerequisite Procedures DLP-A14 Install the AMP Champ EIA, page 1-21

Required/As Needed Required if you are using an AMP Champ EIA for DS1N-14 cards

Onsite/Remote Onsite

Security Level None

32
08

5

DS-1 Electrical Interface 
Adapter or balun 
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Table 1-8 on page 1-49 shows the pin assignments for the AMP Champ connectors on the ONS 15454 
AMP Champ EIA for a shielded DS-1 cable.

Table 1-7 Pin Assignments for AMP Champ Connectors

Signal/Wire Pin Pin Signal/Wire Signal/Wire Pin Pin Signal/Wire

Tx Tip 1
white/blue

1 33 Tx Ring 1 
blue/white

Rx Tip 1 
yellow/orange

17 49 Rx Ring 1 
orange/yellow

Tx Tip 2 
white/orange

2 34 Tx Ring 2 
orange/white

Rx Tip 2 
yellow/green

18 50 Rx Ring 2 
green/yellow

Tx Tip 3 
white/green

3 35 Tx Ring 3 
green/white

Rx Tip 3 
yellow/brown

19 51 Rx Ring 3 
brown/yellow

Tx Tip 4 
white/brown

4 36 Tx Ring 4 
brown/white

Rx Tip 4 
yellow/slate

20 52 Rx Ring 4 
slate/yellow

Tx Tip 5 
white/slate

5 37 Tx Ring 5 
slate/white

Rx Tip 5 
violet/blue

21 53 Rx Ring 5 
blue/violet

Tx Tip 6 
red/blue

6 38 Tx Ring 6 
blue/red

Rx Tip 6 
violet/orange

22 54 Rx Ring 6 
orange/violet

Tx Tip 7 
red/orange

7 39 Tx Ring 7 
orange/red

Rx Tip 7 
violet/green

23 55 Rx Ring 7 
green/violet

Tx Tip 8 
red/green

8 40 Tx Ring 8 
green/red

Rx Tip 8 
violet/brown

24 56 Rx Ring 8 
brown/violet

Tx Tip 9 
red/brown

9 41 Tx Ring 9 
brown/red

Rx Tip 9 
violet/slate

25 57 Rx Ring 9 
slate/violet

Tx Tip 10 
red/slate

10 42 Tx Ring 10 
slate/red

Rx Tip 10 1

white/blue

1. Shaded areas correspond to the white/orange binder group. A binder group is a set of 25 pairs of wires coded with an 
industry-standard color scheme.

26 58 Rx Ring 10 
blue/white

Tx Tip 11 
black/blue

11 43 Tx Ring 11 
blue/black

Rx Tip 11 
white/orange

27 59 Rx Ring 11 
orange/white

Tx Tip 12 
black/orange

12 44 Tx Ring 12 
orange/black

Rx Tip 12 
white/green

28 60 Rx Ring 12 
green/white

Tx Tip 13 
black/green

13 45 Tx Ring 13 
green/black

Rx Tip 13 
white/brown

29 61 Rx Ring 13 
brown/white

Tx Tip 14 
black/brown

14 46 Tx Ring 14 
brown/black

Rx Tip 14 
white/slate

30 62 Rx Ring 14 
slate/white

Tx Spare0+ Not 
applicable

15 47 Tx Spare0- Not 
applicable

Rx Spare0+ Not 
applicable

31 63 Rx Spare0- Not 
applicable

Tx Spare1+ Not 
applicable

16 48 Tx Spare1- Not 
applicable

Rx Spare1+ Not 
applicable

32 64 Rx Spare1- Not 
applicable
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Step 4 Return to your originating procedure (NTP).

Table 1-8 Pin Assignments for AMP Champ Connectors (Shielded DS1 Cable)

64-Pin Blue Bundle 64-Pin Orange Bundle

Signal/Wire Pin Pin Signal/Wire Signal/Wire Pin Pin Signal/Wire

Tx Tip 1
white/blue

1 33 Tx Ring 1 
blue/white

Rx Tip 1 
white/blue

17 49 Rx Ring 1 
blue/white

Tx Tip 2 
white/orange

2 34 Tx Ring 2 
orange/white

Rx Tip 2 
white/orange

18 50 Rx Ring 2 
orange/white

Tx Tip 3 
white/green

3 35 Tx Ring 3 
green/white

Rx Tip 3 
white/green

19 51 Rx Ring 3 
green/white

Tx Tip 4 
white/brown

4 36 Tx Ring 4 
brown/white

Rx Tip 4 
white/brown

20 52 Rx Ring 4 
brown/white

Tx Tip 5 
white/slate

5 37 Tx Ring 5 
slate/white

Rx Tip 5 
white/slate

21 53 Rx Ring 5 
slate/white

Tx Tip 6 
red/blue

6 38 Tx Ring 6 
blue/red

Rx Tip 6 
red/blue

22 54 Rx Ring 6 
blue/red

Tx Tip 7 
red/orange

7 39 Tx Ring 7 
orange/red

Rx Tip 7 
red/orange

23 55 Rx Ring 7 
orange/red

Tx Tip 8 
red/green

8 40 Tx Ring 8 
green/red

Rx Tip 8 
red/green

24 56 Rx Ring 8 
green/red

Tx Tip 9 
red/brown

9 41 Tx Ring 9 
brown/red

Rx Tip 9 
red/brown

25 57 Rx Ring 9 
brown/red

Tx Tip 10 
red/slate

10 42 Tx Ring 10 
slate/red

Rx Tip 10 
red/slate

26 58 Rx Ring 10 
slate/red

Tx Tip 11 
black/blue

11 43 Tx Ring 11 
blue/black

Rx Tip 11 
black/blue

27 59 Rx Ring 11 
blue/black

Tx Tip 12 
black/orange

12 44 Tx Ring 12 
orange/black

Rx Tip 12 
black/orange

28 60 Rx Ring 12 
orange/black

Tx Tip 13 
black/green

13 45 Tx Ring 13 
green/black

Rx Tip 13 
black/green

29 61 Rx Ring 13 
green/black

Tx Tip 14 
black/brown

14 46 Tx Ring 14 
brown/black

Rx Tip 14 
black/brown

30 62 Rx Ring 14 
brown/black

Tx Tip 15
black/slate

15 47 Tx Tip 15
slate/black

Rx Tip 15
black/slate

31 63 Rx Tip 15
slate/black

Tx Tip 16
yellow/blue

16 48 Tx Tip 16
blue/yellow

Rx Tip 16
yellow/blue

32 64 Rx Tip 16
blue/yellow
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DLP-A25 Install Coaxial Cable With BNC Connectors 

Step 1 Place the BNC cable connector over the desired connection point on the backplane. 

Figure 1-21 on page 1-50 shows how to connect a coaxial cable to the BNC EIA using a right-angle BNC 
cable connector.

Figure 1-21 Using a Right-Angle Connector to Install Coaxial Cable with BNC Connectors

Step 2 Position the cable connector so that the slot in the connector is over the corresponding notch at the 
backplane connection point.

Step 3 Gently push the connector down until the notch backplane connector slides into the slot on the cable 
connector.

Step 4 Turn the cable connector clockwise to lock it into place.

Step 5 Tie wrap or lace the cables to the EIA according to Telcordia standards (GR-1275-CORE) or local site 
practice.

Step 6 Route the cables to the nearest side of the shelf assembly through the side cutouts according to local site 
practice. The rubber-coated edges of the side cutouts prevent the cables from chafing.

Purpose This task installs the coaxial cable with BNC connectors.

Tools/Equipment None

Prerequisite Procedures DLP-A12 Install a BNC or High-Density BNC EIA, page 1-17

Required/As Needed Required if you are using DS3-12, DS3XM-6, or EC-1 cards and are using 
a non-high-density BNC interface

Onsite/Remote Onsite

Security Level None
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Warning Metallic interfaces for connection to outside plant lines (such as T1/E1/T3/E3, etc.) must be connected 
through a registered or approved device such as CSU/DSU or NT1.

Step 7 Label all cables at each end of the connection to avoid confusion with cables that are similar in 
appearance.

Step 8 Return to your originating procedure (NTP).

DLP-A26 Install Coaxial Cable With High-Density BNC Connectors 

Step 1 Place the cable connector over the desired connection point on the backplane. 

Step 2 Using the BNC insertion tool, position the cable connector so that the slot in the connector is over the 
corresponding notch at the backplane connection point.

Step 3 Gently push the connector down until the notch backplane connector slides into the slot on the cable 
connector.

Step 4 Turn the cable connector clockwise to lock it into place.

Step 5 Tie wrap or lace the cables to the EIA according to Telcordia standards (GR-1275-CORE) or local site 
practice.

Step 6 Route the cables to the nearest side of the shelf assembly through the side cutouts according to local site 
practice. 

Warning Metallic interfaces for connection to outside plant lines (such as T1/E1/T3/E3, etc.) must be connected 
through a registered or approved device such as CSU/DSU or NT1.

The rubber-coated edges of the side cutouts prevent the cables from chafing.

Step 7 Return to your originating procedure (NTP).

Purpose This task installs the coaxial cable with high-density BNC connectors.

Tools/Equipment BNC insertion tool

Prerequisite Procedures DLP-A12 Install a BNC or High-Density BNC EIA, page 1-17

Required/As Needed Required if you are using DS3-12, DS3XM-6, or EC-1 cards and are using 
a high-density BNC interface

Onsite/Remote Onsite

Security Level None
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DLP-A27 Install Coaxial Cable with SMB Connectors 

Step 1 Place the SMB cable connector over the desired connection point on the backplane.

Step 2 Gently push the connector until it clicks into place.

Step 3 Tie wrap or lace the cables to the EIA according to Telcordia standards (GR-1275-CORE) or local site 
practice.

Step 4 Route the cables to the nearest side of the shelf assembly into rack runs according to local site practice.

Figure 1-22 Installing Coaxial Cable with SMB Connectors

Warning Metallic interfaces for connection to outside plant lines (such as T1/E1/T3/E3, etc.) must be connected 
through a registered or approved device such as CSU/DSU or NT1.

Purpose This task installs the coaxial cable with SMB connectors. Refer to 
Figure 1-22 on page 1-52 when performing task.

Tools/Equipment SMB cable connector

Prerequisite Procedures DLP-A13 Install an SMB EIA, page 1-19

Required/As Needed Required if you are using DS3-12, DS3XM-6, or EC-1 cards and are using 
an SMB interface rather than a BNC interface

Onsite/Remote Onsite

Security Level None
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Step 5 Label the transmit, receive, working, and protect cables at each end of the connection to avoid confusion 
with cables that are similar in appearance.

Step 6 Return to your originating procedure (NTP).

NTP-A10 Route Electrical Cables

Step 1 To route coaxial cables, complete the “DLP-A28 Route Coaxial Cables” task on page 1-53.

Step 2 To route DS-1 twisted pair cables, complete the “DLP-A29 Route DS-1 Twisted-Pair Cables” task on 
page 1-55.

Step 3 Continue with the “NTP-A11 Install the Rear Cover” procedure on page 1-55.

Stop. You have completed this procedure. 

DLP-A28 Route Coaxial Cables

Step 1 Tie wrap or lace the coaxial cables according to local site practice and route the cables through the side 
cutouts on either side of the ONS 15454. The rubber coated edges of the side cutouts prevent the cables 
from chafing.

Step 2 Use short lengths of pigtail RG179 to terminate the shelf assembly.

Purpose The following procedure explains how to route and manage electrical 
(backplane) cables.

Tools/Equipment RG179, RG59 (735A) # 26 AWG cable, or RG59 (734A) # 20 AWG cable

Prerequisite Procedures NTP-A9 Install the Electrical Card Cables on the Backplane, page 1-45

Required/As Needed Required if using electrical cards

Onsite/Remote Onsite

Security Level None

Purpose This task routes the coaxial cables.

Tools/Equipment RG179, RG59 (735A) # 26 AWG cable, or RG59 (734A) # 20 AWG cable

Prerequisite Procedures One or more of the following tasks, as needed:

• DLP-A25 Install Coaxial Cable With BNC Connectors, page 1-50

• DLP-A26 Install Coaxial Cable With High-Density BNC Connectors, 
page 1-51

• DLP-A27 Install Coaxial Cable with SMB Connectors, page 1-52

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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Step 3 Use standard RG59 (735A) cable connected to the RG179 for the remainder of the cable run. When using 
a 10-foot (3.05 m) section of the RG179, you can attach a maximum length of 437 feet (133 m) of RG59 
(735A). When using a 30-foot (9.1 m) section of RG179, you can attach a maximum length of 311 feet 
(94.8 m) of RG59 (735A). 

When using the RG179 cable, the maximum distance available (122 feet, 37.2 m) is less than the 
maximum distance available with standard RG59 (735A) cable (306 feet, 93.3 m). The maximum 
distance when using the RG59 (734A) cable is 450 feet (137.2 m). The shorter maximum distance 
available with the RG179 is due to a higher attenuation rate for the thinner cable. Attenuation rates are 
calculated using a DS-3 signal:

• For RG179, the attenuation rate is 59 dB/kft (dB per kilo-foot) at 22 MHz. 

• For RG59 (735A), the attenuation rate is 23 dB/kft at 22 MHz. 

Use a figure of 5.0 for total cable loss when making calculations. Figure 1-23 on page 1-54 shows an 
example of proper coaxial cable routing.

Figure 1-23 Routing Coaxial Cable (SMB EIA Backplane)

Step 4 Return to your originating procedure (NTP).

B A

Connector ends

Tie-wrap
posts
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DLP-A29 Route DS-1 Twisted-Pair Cables 

Step 1 Verify the following:

• DS-1 electrical interface adapters are installed on every transmit and receive connector for DS-1 
ports. 

• Wire-wrap posts on the DS-1 electrical interface adapters are used to connect the terminated 
incoming cables. 

Step 2 Tie-wrap or lace the twisted-pair cables according to local site practice and route the cables into the side 
cutouts on either side of the ONS 15454. 

Note SMB EIAs feature cable-management eyelets for tie wrapping or lacing cables to the cover 
panel.

Step 3 Return to your originating procedure (NTP).

NTP-A11 Install the Rear Cover 

Purpose This task routes the DS-1 twisted-pair cables.

Tools/Equipment None

Prerequisite Procedures DLP-A23 Install DS-1 Cables Using Electrical Interface Adapters (Balun), 
page 1-46

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None

Purpose The following procedure explains how to install the rear cover.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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NTP-A11 Install the Rear Cover
Step 1 Locate the three screws that run vertically along both edges of the backplane (Figure 1-24). 

Figure 1-24 Backplane Attachment for the Rear Cover

Tip Only six screws (three on each side) line up with the screw slots on the mounting brackets, 
making the screws easy to locate.

Step 2 Loosen the top and bottom screws on one edge of the backplane to provide room to slide the mounting 
brackets into place using the u-shaped screw slots on each end.

Step 3 Slide one of the mounting brackets into place and tighten the screws. 

Step 4 Repeat Steps 2 and 3 for the second mounting bracket.

Step 5 Attach the cover by hanging it from the mounting screws on the back of the mounting brackets and 
pulling it down until it fits snugly into place.

Figure 1-25 shows rear cover installation using spacers.

32
07

3

Screw locations
for attaching the

rear cover
1-56
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 1      Install the Shelf and Backplane Cable
NTP-A12 Install Ferrites
Figure 1-25 Installing the Rear Cover with Spacers

Step 6 Continue with the “NTP-A12 Install Ferrites” procedure on page 1-57.

Stop. You have completed this procedure. 

NTP-A12 Install Ferrites 

Step 1 To attach ferrites to power cabling, complete the “DLP-A30 Install Ferrites to Power Cabling” task on 
page 1-58.

Step 2 To attach ferrites to wire-wrap pin fields, complete the “DLP-A31 Attach Ferrites to Wire-Wrap Pin 
Fields” task on page 1-59.

Step 3 Continue with the “NTP-A13 Perform the Shelf Installation Acceptance Test” procedure on page 1-60.

Stop. You have completed this procedure. 
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Purpose This procedure describes how to attach ferrites.

Tools/Equipment Oval and/or block ferrites

Prerequisite Procedures NTP-A6 Install the Power and Ground, page 1-23

NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin Connections, 
page 1-34

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None
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DLP-A30 Install Ferrites to Power Cabling 

Step 1 If you are using block ferrites, wrap the cables once around and through the block ferrites.

Step 2 If you are using oval ferrites, pull the cable straight through the oval ferrites. 

Note If you are using both block and oval ferrites, place the oval ferrite between the ONS 15454 and 
the block ferrite as shown in Figure 1-26 on page 1-58. 

Note Place the oval ferrite as close to the power terminals as possible and place the block ferrite within 
5 to 6 inches (127 to 152 mm) of the power terminals.

Figure 1-26 Attaching Block and Oval Ferrites to Power Cabling

Step 3 Return to your originating procedure (NTP).

Purpose This task attaches ferrites to power cabling. Use a single oval ferrite 
(TDK ZCAT2035-0930) and/or one block ferrite (Fair Rite 0443164151) 
for each pair of cables, depending on the EIA.

Tools/Equipment Oval and/or block ferrites

Prerequisite Procedures None

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None

Power terminals
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NTP-A12 Install Ferrites
DLP-A31 Attach Ferrites to Wire-Wrap Pin Fields 

Step 1 Wrap the cables once around and through the block ferrites and pull the cables straight through the oval 
ferrites. 

Step 2 Place the oval ferrite as close to the wire-wrap pin field as possible and between the ONS 15454 and the 
block ferrite, as shown in Figure 1-27. The block ferrite should be within 5 to 6 inches (127 to 152 mm) 
of the wire-wrap pin field. 

Figure 1-27 Attaching Ferrites to Wire-Wrap Pin Fields

Step 3 Return to your originating procedure (NTP).

Purpose This task attaches ferrites to wire-wrap pin fields. Use an oval ferrite 
(TDK ZCAT1730-0730) and block ferrite (Fair Rite 0443164151) for each 
pair of cables. Figure 1-27 on page 1-59 shows the suggested method for 
attaching ferrites to wire-wrap pin fields.

Tools/Equipment Oval and block ferrites

Prerequisite Procedures NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin Connections, 
page 1-34

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None
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NTP-A13 Perform the Shelf Installation Acceptance Test 

Step 1 Complete Table 1-9 by verifying that each applicable procedure was completed. 

Step 2 Complete the “DLP-A32 Inspect the Shelf Installation and Connections” task on page 1-61.

Step 3 Complete the “DLP-A33 Measure Voltage” task on page 1-61.

Step 4 Continue with the “NTP-A15 Install the Common Control Cards” procedure on page 2-2.

Stop. You have completed this procedure. 

Purpose Use this procedure to perform a shelf installation acceptance test.

Tools/Equipment Voltmeter

Tools/Equipment Oval and/or block ferrites

Prerequisite Procedures Applicable procedures in Chapter 1

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Table 1-9 Shelf Installation Task Summary

Description Completed

NTP-A1 Unpack and Inspect the ONS 15454 Shelf Assembly, page 1-4

NTP-A2 Install the Shelf Assembly, page 1-5

NTP-A3 Open and Remove the Front Door, page 1-12

NTP-A4 Remove the Backplane Covers, page 1-15

NTP-A5 Install the Electrical Interface Assemblies, page 1-16

NTP-A6 Install the Power and Ground, page 1-23

NTP-A7 Install the Fan-Tray Assembly, page 1-29

NTP-A119 Install the Alarm Expansion Panel, page 1-31

NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-34

NTP-A120 Install an External Wire-Wrap Panel to the AEP, page 1-40

NTP-A9 Install the Electrical Card Cables on the Backplane, page 1-45

NTP-A10 Route Electrical Cables, page 1-53

NTP-A11 Install the Rear Cover, page 1-55

NTP-A12 Install Ferrites, page 1-57
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NTP-A13 Perform the Shelf Installation Acceptance Test
DLP-A32 Inspect the Shelf Installation and Connections 

Step 1 Check each wire and cable connection to make sure all cables are locked securely. If a wire or cable is 
loose, return to the appropriate procedure in this chapter to correct it.

Step 2 To check that the backplane is seated correctly, verify that the screw holes and the backplane interface 
card holes align properly and that the A and B connectors interlock.

Step 3 Return to your originating procedure (NTP).

DLP-A33 Measure Voltage 

Step 1 Using a voltmeter, verify the office ground and power. (Figure 1-10 on page 1-27 shows the power 
terminals.)

a. Place the black lead (positive) on the frame ground on the bay. Hold it there while completing Step b.

b. Place the red lead (negative) on the fuse power points and alarm panel to verify that they read 
between –42 VDC and –57 VDC (power) or 0 (return ground).

Step 2 Using a voltmeter, verify the shelf ground and power wiring:

a. Place the black lead (positive) on the RET1 and the red lead on the BAT1 point. Verify a reading 
between –42 VDC and –57 VDC. If there is no voltage, check the following and correct if necessary:

• Battery and ground are reversed to the shelf.

• Battery is open or missing.

• Return is open or missing.

b. Repeat Step 2 for the RET2 and BAT2 if the B power feed is provided

Step 3 Return to your originating procedure (NTP).

Purpose Use this task to inspect the shelf installation and connections and to verify 
that everything is installed and connected properly.

Tools/Equipment None

Prerequisite Procedures Complete Table 1-9 on page 1-60.

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task measures the power to verify correct power and returns.

Tools/Equipment Voltmeter

Prerequisite Procedures Complete Table 1-9 on page 1-60.

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
1-61
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 1      Install the Shelf and Backplane Cable
NTP-A13 Perform the Shelf Installation Acceptance Test
1-62
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

September 2003
C H A P T E R 2

Install Cards and Fiber-Optic Cable

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to install the Cisco ONS 15454 cards and fiber-optic cable (fiber). 

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A15 Install the Common Control Cards, page 2-2—Complete this procedure before installing 
any other cards.

2. NTP-A16 Install the Optical Cards, page 2-13—Complete this procedure as needed.

3. NTP-A17 Install the Electrical Cards, page 2-15—Complete this procedure as needed.

4. NTP-A18 Install the Ethernet Cards, page 2-16—Complete this procedure as needed.

5. NTP-A116 Remove and Replace a Card, page 2-21—Complete this procedure as needed to remove 
and replace a card, including deleting the card from Cisco Transport Controller (CTC) and changing 
an optical card without losing the card’s provisioning.

6. NTP-A115 Preprovision a Slot, page 2-23—Complete this procedure as needed to provision an 
empty card slot with a card that will be installed later.

7. NTP-A19 Install the Fiber-Optic Cables, page 2-24—Complete this procedure to install fiber on the 
optical cards or Ethernet Gigabit Interface Converters (GBICs) and to route the fiber through the 
bottom of the shelf. 

8. NTP-A20 Replace the Front Door, page 2-36—If the front door was removed, complete this 
procedure to replace the front door and ground strap after installing cards and fiber.

Warning Only trained and qualified personnel should be allowed to install, replace, or service this equipment.
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NTP-A15 Install the Common Control Cards
Caution Unused card slots should be filled with a blank faceplate (Cisco P/N 15454-BLANK). The blank 
faceplate ensures proper airflow when operating the ONS 15454 without the front door attached, 
although Cisco recommends that the front door remain attached.

NTP-A15 Install the Common Control Cards

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 If you plan to install XC/XCVT cards, review Table 2-1 to determine card/slot compatibility. If you plan 
to install XC10G cards, review Table 2-2 on page 2-5 to determine card/slot compatibility.

Step 2 Complete the “DLP-A36 Install the TCC+/TCC2 Cards” task on page 2-7.

Step 3 Complete the “DLP-A37 Install the XC, XCVT, or XC10G Cards” task on page 2-10.

Step 4 Complete the “DLP-A38 Install the Alarm Interface Controller or Alarm Interface 
Controller–International Card” task on page 2-11, if necessary.

Step 5 If you discover that you installed the wrong card in a slot, see the “NTP-A116 Remove and Replace a 
Card” procedure on page 2-21.

Step 6 Proceed to the “NTP-A16 Install the Optical Cards” procedure on page 2-13, the “NTP-A17 Install the 
Electrical Cards” procedure on page 2-15, or the “NTP-A18 Install the Ethernet Cards” procedure on 
page 2-16, as applicable for your site.

Purpose This procedure describes how to install the common control cards. 

Tools/Equipment TCC+/TCC2 cards

XC/XCVT/XC10G (cross-connect) cards

AIC/AIC-I card

Prerequisite Procedures NTP-A13 Perform the Shelf Installation Acceptance Test, page 1-60

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Chapter 2      Install Cards and Fiber-Optic Cable
NTP-A15 Install the Common Control Cards
Note X indicates that a card is supported in the slot.

 
Table 2-1 Card and Slot Compatibility for the XC and XCVT Cards

Slot 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Type MS1 MS1 MS1 MS1 HS2 HS TCC XC AIC XC TCC HS HS MS1 MS1 MS1 MS1

TCC+/TCC2 X X

XC/XCVT X X

AIC X

AIC-I X

DS1-14 X X X X X X X X X X X X

DS1N-14 X3 X3 X X3 X3 X3 X3 X3 X3 X X3 X3

DS3-12 X X X X X X X X X X X X

DS3-12E X X X X X X X X X X X X

DS3N-12 X3 X3 X X3 X3* X3 X3 X3 X3 X X3 X3

DS3N-12E X3 X3 X X3 X3 X3 X3 X3 X3 X X3 X3

DS3XM-6 X X X X X X X X X X X X

EC1-12 X X X X X X X X X X X X

E100T-12 X X X X X X X X X X X X

E1000-2 X X X X X X X X X X X X

E100T-G X X X X X X X X X X X X

E1000-2-G X X X X X X X X X X X X

G1000-4 Not supported with XC/XCVT cards. Requires XC10G cards.

G1K-4 X X X X

ML100-12 X X X X

ML1000-2 X X X X

OC3 IR 4/STM1 
SH 1310

X X X X X X X X X X X X

OC3IR/STM1SH 
1310-8

Not supported with XC/XCVT cards. Requires XC10G cards.

OC12 IR STM4 
SH 1310

X X X X X X X X X X X X

OC12 LR/STM4 
LH 1310

X X X X X X X X X X X X

OC12 IR/STM4 
SH 1310-4

Not supported with XC/XCVT cards. Requires XC10G cards.

OC12 LR/STM4 
LH 1550

X X X X X X X X X X X X

OC48 IR 1310 X X X X

OC48 LR 1550 X X X X
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NTP-A15 Install the Common Control Cards
OC48 IR/STM16 
SH AS 1310

X X X X

OC48 
LR/STM16 LH 
AS 1550

X X X X

OC48-ELR/STM
16 EH 100 GHz

X X X X

OC48 ELR 200 
GHz

X X X X

OC192 
SR/STM64 IO 
1310

Not supported with XC/XCVT cards. Requires XC10G cards.

OC192 
IR/STM64 SH 
1550

Not supported with XC/XCVT cards. Requires XC10G cards.

OC192 
LR/STM64 LH 
1550

Not supported with XC/XCVT cards. Requires XC10G cards.

OC192 
LR/STM64 LH 
ITU 15xx.xx

Not supported with XC/XCVT cards. Requires XC10G cards.

TXP_MR_10G X X X X X X X X X X X X

MXP_2.5G_10G X X X X X X X X X X X X

1. MS identifies slots 1 to 4 and 14 to 17 (“multispeed” slot).

2. HS identifies slots 5, 6, 12, and 13 (“high-speed” slot).

3. This identifies 1:N cards that operate as normal DS1 or DS3 cards when installed in certain slots.

Table 2-1 Card and Slot Compatibility for the XC and XCVT Cards (continued)

Slot 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Type MS1 MS1 MS1 MS1 HS2 HS TCC XC AIC XC TCC HS HS MS1 MS1 MS1 MS1
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NTP-A15 Install the Common Control Cards
Note X indicates that a card is supported in the slot.

Note The XC10G card requires the ANSI shelf with high-speed fans.

Table 2-2 Card and Slot Compatibility for the XC10G Card

Slot 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Type MS1 MS1 MS1 MS1 HS2 HS2 TCC XC AIC XC TCC HS2 HS2 MS1 MS1 MS1 MS1

TCC+/TCC2 X X

XC10G X X

AIC X

AIC-I X

DS1-14 X X X X X X X X X X X X

DS1N-14 X3 X3 X X3 X3 X3 X3 X3 X3 X X3 X3

DS3-12 X X X X X X X X X X X X

DS3-12E X X X X X X X X X X X X

DS3N-12 X3 X3 X X3 X3 X3 X3 X3 X3 X X3 X3

DS3N-12E X3 X3 X X3 X3 X3 X3 X3 X3 X X3 X3

DS3XM-6 X X X X X X X X X X X X

EC1-12 X X X X X X X X X X X X

E100T-12 Not supported with the XC10G card.

E1000-2 Not supported with the XC10G card.

E100T-G X X X X X X X X X X X X

E1000-2-G X X X X X X X X X X X X

G1000-4 X X X X X X X X X X X X

G1K-4 X X X X X X X X X X X X

ML100-12 X X X X X X X X X X X X

ML1000-2 X X X X X X X X X X X X

OC3 IR 4/STM1 
SH 1310

X X X X X X X X X X X X

OC3IR/STM1SH 
1310-8

X X X X X X X X

OC12 IR STM4 
SH 1310

X X X X X X X X X X X X

OC12 LR/STM4 
LH 1310

X X X X X X X X X X X X

OC12 IR/STM4 
SH 1310-4

X X X X X X X X
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Step 7 If you are installing optical cards, continue with the “NTP-A16 Install the Optical Cards” procedure on 
page 2-13. 

Stop. You have completed this procedure. 

OC12 LR/STM4 
LH 1550

X X X X X X X X X X X X

OC48 IR 1310 X X X X

OC48 LR 1550 X X X X

OC48 IR/STM16 
SH AS 1310

X X X X X X X X X X X X

OC48 LR/STM16 
LH AS 1550

X X X X X X X X X X X X

OC48-ELR/STM1
6 EH 100 GHz

X X X X

OC48 ELR 200 
GHz

X X X X

OC192 
SR/STM64 IO 
1310

X X X X

OC192 IR/STM64 
SH 1550

X X X X

OC192 
LR/STM64 LH 
1550

X X X X

OC192 
LR/STM64 LH 
ITU 15xx.xx

X X X X

TXP_MR_10G X X X X X X X X X X X X

MXP_2.5G_10G X X X X X X X X X X X X

1. MS identifies slots 1 to 4 and 14 to 17 (“multispeed” slot).

2. HS identifies slots 5, 6, 12, and 13 (“high-speed” slot).

3. This identifies 1:N cards that operate as normal DS1 or DS3 cards when installed in certain slots.

Table 2-2 Card and Slot Compatibility for the XC10G Card (continued)

Slot 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Type MS1 MS1 MS1 MS1 HS2 HS2 TCC XC AIC XC TCC HS2 HS2 MS1 MS1 MS1 MS1
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DLP-A36 Install the TCC+/TCC2 Cards 

Note When installing cards, let each card completely boot before installing the next card.

Step 1 Open the latches/ejectors of the first TCC+/TCC2 card that you will install. 

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

If you insert a card into a slot provisioned for a different card, all LEDS turn off. 

Step 4 If you are using the TCC2, proceed to Step 5. If you are using the TCC+, verify the LED activity:

• The red FAIL LED turns on and remains illuminated for 20 to 30 seconds. 

• The red FAIL LED blinks for 35 to 45 seconds.

• The red FAIL LED remains illuminated for 5 to 10 seconds.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for 5 to 10 seconds.

• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to illuminate 
while the data communication channel (DCC) processor boots.) 

• Proceed to Step 6. 

Step 5 Verify the LED activity of the TCC2:

• All LEDs turn on briefly. 

• The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the 
green ACO LED turn on and remain illuminated for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on and remain illuminated for about 
40 seconds. 

• The red FAIL LED blinks for about 10 seconds.

• The red FAIL LED remains illuminated for about 5 seconds.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for about 10 seconds.

Purpose This task installs redundant TCC+/TCC2 cards. The first card you install in 
the ONS 15454 must be a TCC+/TCC2, and it must initialize before you 
install any cross-connect or traffic cards.

Tools/Equipment Two TCC+/TCC2 cards

Prerequisite Procedures None

Required/As Needed Redundant TCC+/TCC2 cards are required.

Onsite/Remote Onsite

Security Level Provisioning or higher
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• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to illuminate 
while the DCC processor boots.) 

Note If the FAIL LED is illuminated continuously on the TCC+/TCC2 card, see the tip below about 
the TCC+/TCC2 automatic upload.

Note Alarm LEDs might be illuminated; disregard alarm LEDs until you are logged into CTC and can 
view the Alarms tab.

Tip When a newly installed TCC+/TCC2 card has a different version of the ONS 15454 software installed 
than the version running on the active TCC+/TCC2, the newly installed TCC+/TCC2 card automatically 
copies the software version running on the active TCC+/TCC2. You do not need to do anything in this 
situation. However, the loading TCC+/TCC2 card does not boot up in the normal manner. When the card 
is first inserted, the red FAIL LED stays on for a short period. The FAIL LED then blinks normally and 
all LEDs go dark. The FAIL LED and the ACT/STBY LED flash alternately every 30 to 45 seconds as 
the new software loads onto the new TCC+/TCC2 card. After loading the new software for 
approximately 30 minutes, the TCC+/TCC2 card becomes the standby card and the amber LED is 
illuminated.

Step 6 Verify that the ACT/STBY LED is green for active. The IP address for the node, the temperature of the 
ONS 15454, and the time of day should be displayed on the LCD. The default time and date is 12:00 AM, 
January 1, 1970. 

Step 7 The LCD cycles through the IP address, node name, and software version. Verify that the correct 
software version displays on the LCD. 

Step 8 If the LCD shows the correct software version, continue with Step 9. If the LCD does not show the 
correct software version, upgrade the software or remove the TCC+/TCC2 card and install a replacement 
card. 

Refer to the Cisco ONS 15454 Software Upgrade Guide or the “NTP-A163 Restore the Node to Factory 
Configuration” procedure on page 15-12 to replace the software. To swap the TCC+/TCC2, see the 
“NTP-A116 Remove and Replace a Card” procedure on page 2-21.

Step 9 Open the latches/ejectors of the redundant TCC+/TCC2 card. 

Step 10 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Step 11 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further. 

Step 12 If you are using the TCC2, proceed to Step 13. If you are using the TCC+, verify the LED activity:

• The red FAIL LED turns on and remains illuminated for 20 to 30 seconds. 

• The red FAIL LED blinks for 35 to 45 seconds.

• The red FAIL LED remains illuminated for 5 to 10 seconds.
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NTP-A15 Install the Common Control Cards
• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for 5 to 10 seconds.

• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to illuminate 
while the DCC processor boots.) 

• Proceed to Step 14. 

Step 13 Verify the LED activity of the TCC2:

• All LEDs turn on for a short moment. 

• The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the 
green ACO LED turn on and remain illuminated for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on and remain illuminated for about 
40 seconds. 

• The red FAIL LED blinks for about 10 seconds.

• The red FAIL LED remains illuminated for about 5 seconds.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for about 10 seconds.

• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to illuminate 
while the DCC processor boots.) 

Note If the FAIL LED is illuminated continuously on the TCC+/TCC2 card, see the tip in Step 4 about 
the TCC+/TCC2 automatic upload.

Note If you insert a card into a slot provisioned for a different card, all LEDS turn off. 

Note Alarm LEDs might be illuminated; disregard alarm LEDs until you are logged into CTC and can 
view the Alarms tab.

Step 14 Verify that the ACT/STBY LED is amber for standby. 

Step 15 Return to your originating procedure (NTP).
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DLP-A37 Install the XC, XCVT, or XC10G Cards 

Note This is not the procedure to use when upgrading from XC to XCVT cards or from XCVT to XC10G 
cards. If you are performing an XC to XCVT upgrade or an XCVT to a XC10G upgrade, see Chapter 12, 
“Upgrade Cards and Spans.”

Note When installing cards, let each card completely boot before installing the next card.

Step 1 Open the latches/ejectors of the first XC, XCVT, or XC10G card that you will install. 

Step 2 Open the card latches/ejectors. 

Step 3 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 8 or 10). 

Step 4 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 5 Verify the LED activity:

• The red LED turns on and remains illuminated for 20 to 30 seconds. 

• The red LED blinks for 35 to 45 seconds.

• The red LED remains illuminated for 5 to 10 seconds.

• All LEDs blink once and turn on.

• The ACT/STBY LED turns on. 

Note If you insert a card into a slot provisioned for a different card, all LEDS turn off. 

Note If the red FAIL LED does not illuminate, check the power. 

Note If the red FAIL LED is illuminated continuously or the LEDs act erratically, the card is not 
installed properly. Remove the card and repeat Steps 1 to 5. 

Step 6 Verify that the ACT/STBY LED is green for active. 

Purpose This task installs the XC/XCVT/XC10G cards.

Tools/Equipment XC/XCVT/XC10G (cross-connect) cards

Prerequisite Procedures DLP-A36 Install the TCC+/TCC2 Cards, page 2-7

Required/As Needed Redundant cross-connect cards are required.

Onsite/Remote Onsite

Security Level None
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Step 7 Use the latches/ejectors to firmly slide the second cross-connect card along the guide rails until the card 
plugs into the receptacle at the back of the slot (Slot 8 or 10). 

Step 8 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 9 Verify the LED activity:

• The red LED turns on and remains illuminated for 20 to 30 seconds. 

• The red LED blinks for 35 to 45 seconds.

• The red LED remains illuminated for 5 to 10 seconds.

• All LEDs blink once and turn on.

• The ACT/STBY LED turns on. 

Note If you insert a card into a slot provisioned for a different card, all LEDS turn off. 

Note If the red FAIL LED does not illuminate, check the power. 

Note If the red FAIL LED is illuminated continuously or the LEDs act erratically, the card is not 
installed properly. Remove the card and repeat Steps 7 to 9. 

Step 10 Verify that the ACT/STBY LED is amber for standby. 

Step 11 Return to your originating procedure (NTP).

DLP-A38 Install the Alarm Interface Controller or Alarm Interface 
Controller–International Card 

Note When installing cards, let each card completely boot before installing the next card.

Purpose This task installs the AIC or AIC-I card. 

Tools/Equipment AIC or AIC-I card

Prerequisite Procedures DLP-A36 Install the TCC+/TCC2 Cards, page 2-7

DLP-A37 Install the XC, XCVT, or XC10G Cards, page 2-10

Required/As Needed Required to use the ENVIR ALARMS (external alarms and controls) or 
orderwire functions. The AIC-I card can be used in both the ANSI and 
ETSI markets, while the AIC card is only used for the ANSI market.

Onsite/Remote Onsite

Security Level None
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Step 1 Open the latches/ejectors on the card. 

Step 2 Open the card latches/ejectors. 

Step 3 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 9). 

Step 4 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 5 If you have installed the AIC card, verify the following:

• The red FAIL LED remains illuminated for 1 second, then blinks for 1 to 5 seconds.

• After 1 to 5 seconds, all LEDs blink once and turn off.

• The ACT LED turns on. 

Step 6 If you have installed the AIC-I card, verify the following:

• The red FAIL LED remains illuminated for 1 second, then blinks for 1 to 5 seconds.

• The PWR A and PWR B LEDs illuminate red and the two INPUT/OUTPUT LEDs illuminate green 
for approximately 3 seconds.

• The PWR A LED turns green, the INPUT/OUTPUT LEDs turn off, and the ACT LED illuminates.

Note If the red FAIL LED does not illuminate, check the power. 

Note Before you insert a card into a slot provisioned for a different card, complete the “DLP-A191 
Delete a Card” task on page 2-22 for the previously provisioned card. 

Note If you do insert a card into a slot provisioned for a different card, no LEDs turn on. 

Note If the red FAIL LED is illuminated continuously or the LEDs act erratically, the card is not 
installed properly. Remove the card and repeat Steps 1 to 5. 

Step 7 Return to your originating procedure (NTP).
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NTP-A16 Install the Optical Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Warning Class I (21 CFR 1040.10 and 1040.11) and Class 1M (IEC 60825-1 2001-01) laser products. 

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure. 

Warning On all optical cards except the OC192 LR/STM64 LH 1550 card, the laser is on even when the optical 
port is not in service. On the OC192 LR/STM64 LH 1550 card, the laser is active when the card is booted 
and the safety key is in the on position (labeled 1). The laser is off when the safety key is off 
(labeled 0). 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note To simplify path protection to bidirectional line switch ring (BLSR) conversion and node addition, equip 
optical cards according to a high-speed east (Slots 12 and 13) and west (Slots 5 and 6) configuration. 
This configuration is not mandatory.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 If you installed XC or XCVT cards, review Table 2-1 on page 2-3 to determine card/slot compatibility. 
If you installed XC10G cards, review Table 2-2 on page 2-5 to determine card/slot compatibility.

Purpose This procedure describes how to install the optical cards (OC-3, OC-12, 
OC-48, OC-192, TXP, and MXP). 

Tools/Equipment OC-3, OC-12, OC-48, OC-192, TXP, and MXP cards (as applicable)

Prerequisite Procedures NTP-A15 Install the Common Control Cards, page 2-2

Required/As Needed Required if the node will carry optical traffic. Install according to site plan, 
if available.

Onsite/Remote Onsite

Security Level Provisioning or higher
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Install higher-capacity cards first; for example, install an OC-192 card before installing an OC-48 card. 
Let each card completely boot before installing the next card.

Step 2 Open the card latches/ejectors. 

Warning Before installing an OC192 LR/STM64 LH 1550 card, make sure the safety key on the faceplate is in off 
position (labeled 0). When in the on position (labeled 1), the laser is activated.

Step 3 Use the latches/ejectors to firmly slide the optical card along the guide rails until the card plugs into the 
receptacle at the back of the slot. 

Step 4 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 5 Verify the LED activity:

• The red FAIL LED turns on and remains illuminated for 20 to 30 seconds. 

• The red FAIL LED blinks for 35 to 45 seconds.

• All LEDs blink once and turn off for 5 to 10 seconds.

• The ACT or ACT/STBY LED turns on. The signal fail (SF) LED can persist until all card ports 
connect to their far end counterparts and a signal is present. 

Step 6 If the card does not boot up properly, or the LED activity does not mirror Step 5, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If an optical card does not boot, open CTC and ensure that the slot is not provisioned 
for a different card type before assuming the card is faulty.

• If the red FAIL LED does not illuminate, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDS turn off. 

• If the red FAIL LED is illuminated continuously or the LEDs behave erratically, the card is not 
installed properly. Remove the card and repeat Steps 2 to 5. 

Step 7 Complete the “NTP-A19 Install the Fiber-Optic Cables” procedure on page 2-24.

Step 8 If you discover that you installed the wrong card in a slot, complete the “NTP-A116 Remove and Replace 
a Card” procedure on page 2-21. 

Step 9 Continue with the “NTP-A17 Install the Electrical Cards” procedure on page 2-15.

Stop. You have completed this procedure. 
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NTP-A17 Install the Electrical Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note Install higher-capacity cards first; for example, install a DS-3 card before installing a DS-1 card. Let 
each card completely boot before installing the next card.

Step 1 If you installed XC or XCVT cards, review Table 2-1 on page 2-3 to determine card/slot compatibility. 
If you installed XC10G cards, review Table 2-2 on page 2-5 to determine card/slot compatibility.

Step 2 Open the card latches/ejectors. 

Step 3 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot. 

Step 4 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 5 Verify the LED activity:

• The red FAIL LED turns on and remains illuminated for 10 to 15 seconds. 

• If the red FAIL LED does not illuminate, check the power.

• The red FAIL LED blinks for 30 to 40 seconds.

• All LEDs blink once and turn off for 1 to 5 seconds.

• The ACT or ACT/STBY LED turns on. The SF LED can persist until all card ports connect to their 
far end counterparts and a signal is present.

Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Purpose This procedure describes how to install the electrical cards (DS-1, DS-3, 
and EC1).

Tools/Equipment Electrical cards

Prerequisite Procedures NTP-A15 Install the Common Control Cards, page 2-2

NTP-A16 Install the Optical Cards, page 2-13 (if applicable)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note If the red FAIL LED is illuminated continuously or the LEDs behave erratically, the card is not 
installed properly. Remove the card and repeat Steps 2 to 5. 

Step 6 If you discover that you installed the wrong card in a slot, complete the “NTP-A116 Remove and Replace 
a Card” procedure on page 2-21.

Stop. You have completed this procedure.

NTP-A18 Install the Ethernet Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Warning Class I (21 CFR 1040.10 and 1040.11) and Class 1M (IEC 60825-1 2001-01) laser products. 

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure. 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Step 1 If you installed XC or XCVT cards review Table 2-1 on page 2-3 to determine card/slot compatibility. 
If you installed XC10G cards, review Table 2-2 on page 2-5 to determine card/slot compatibility.

Step 2 Complete the “DLP-A39 Install Ethernet Cards” task on page 2-17. Allow each card to boot completely 
before installing the next card.

Purpose This procedure describes how to install the Ethernet cards.

Tools/Equipment Ethernet cards

Prerequisite Procedures NTP-A15 Install the Common Control Cards, page 2-2

NTP-A16 Install the Optical Cards, page 2-13 (if applicable)

NTP-A17 Install the Electrical Cards, page 2-15 (if applicable)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note If you discover that you installed the wrong card in a slot, complete the “NTP-A116 Remove and 
Replace a Card” procedure on page 2-21 and install the correct card.

Step 3 Complete the “DLP-A469 Install GBIC or SFP Connectors” task on page 2-18 if you are using E1000-2, 
E1000-2-G, G-Series, or ML-Series cards.

Note If you need to remove a GBIC or SFP, complete the “DLP-A470 Remove GBIC or SFP 
Connectors” task on page 2-20.

Step 4 If required, continue with the “NTP-A116 Remove and Replace a Card” procedure on page 2-21.

Step 5 Continue with the “NTP-A19 Install the Fiber-Optic Cables” procedure on page 2-24.

Stop. You have completed this procedure. 

DLP-A39 Install Ethernet Cards

Step 1 Open the card latches/ejectors. 

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot. 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 4 Verify the LED activity:

• The red FAIL LED turns on and remains illuminated for 20 to 30 seconds. 

• The red FAIL LED blinks for 35 to 45 seconds.

• All LEDs blink once and turn off for 1 to 5 seconds.

• The ACT or ACT/STBY LED turns on. The SF LED can persist until all card ports connect to their 
far end counterparts and a signal is present.

Note If the red FAIL LED does not illuminate, check the power. 

Purpose This task installs the Ethernet cards.

Tools/Equipment Ethernet cards

Prerequisite Procedures DLP-A36 Install the TCC+/TCC2 Cards, page 2-7

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Step 5 Return to your originating procedure (NTP).

DLP-A469 Install GBIC or SFP Connectors

Note GBICs and SFPs must be matched on either end by type: SX to SX, LX to LX, or ZX to ZX.

Note GBICs and SFPs are hot-swappable and can therefore be installed/removed while the card/shelf 
assembly is powered and running.

Step 1 Remove the GBIC/SFP from its protective packaging.

Step 2 Check the label to verify that the GBIC/SFP is the correct type for your network. 

Step 3 Verify that you are installing compatible GBICs/SFPs; for example, SX to SX, LX to LX, or ZX to ZX.

Step 4 If you are using a GBIC with clips:

a. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot on the 
E1000-2-G, G1000-4, or G1K-4 card (shown in Figure 2-1).

Note GBICs are keyed to prevent incorrect installation.

Purpose This task installs the Gigabit Interface Converters (GBICs) or small 
form-factor pluggables (SFPs) and attaches the fiber.

Tools/Equipment • GBICs (15454-GBIC-SX= for short-reach applications; 
15454-GBIC-LX= for long-reach applications; or 15454-GBIC-ZX= 
for extra long-reach applications)

• SFPs (15454-SFP-LC-SX= for short-reach applications; 
15454-SFP-LC-LX= for long-reach applications.)

Refer to the Cisco ONS 15454 Reference Guide for more information.

Prerequisite Procedures DLP-A39 Install Ethernet Cards, page 2-17

Required/As Needed Required if you are using E1000-2, E1002-G, G-Series, or ML1000-2 
cards. (SFP connectors should be used with ML1000-2 cards.)

Onsite/Remote Onsite

Security Level None
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Figure 2-1 Installing a GBIC on an E1000-2 Card

b. Slide the GBIC through the flap that covers the opening until you hear a click. The click indicates 
the GBIC is locked into the slot.

c. When you are ready to attach the network fiber-optic cable, remove the protective plug from the 
GBIC and save the plug for future use.

Step 5 If you are using a GBIC with a handle:

a. Remove the protective plug from the SC-type connector.

b. Grip the sides of the GBIC with your thumb and forefinger and insert the GBIC into the slot on the 
E1000-2-G, G1000-4, or G1K-4 card.

c. Lock the GBIC into place by closing the handle down. The handle is in the correct closed position 
when it does not obstruct access to SC-type connector.

d. Slide the GBIC through the cover flap until you hear a click. 

The click indicates the GBIC is locked into the slot.

Warning GBICs are Class I laser products. These products have been tested and comply with Class I limits.

E1000
2

FAIL

ACT

1

SF

33678 12931

2

RX

TX

RX

TX

ACT/LINK

ACT/LINK

44
73

4

Plug
2-19
Cisco ONS 15454 Procedure Guide, R4.0

September 2003



 

Chapter 2      Install Cards and Fiber-Optic Cable
NTP-A18 Install the Ethernet Cards
Warning Invisible laser radiation may be emitted from the aperture ports of the single-mode fiber optic 
modules when no cable is connected. Avoid exposure and do not stare into open apertures.

Step 6 If you are installing an SFP:

a. Plug the LC duplex connector of the fiber into a Cisco-supported SFP connector.

b. If the new SFP connector has a latch, close the latch over the cable to secure it.

c. Plug the cabled SFP connector into the ML-series Ethernet, transponder, or muxponder card port 
until it clicks.

Step 7 Return to your originating procedure (NTP).

DLP-A470 Remove GBIC or SFP Connectors

Step 1 Disconnect the network fiber cable from the GBIC SC connector or SFP LC duplex connector. If the SFP 
connector has a latch securing the fiber cable, pull it upward to release the cable. 

Warning Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into 
beams or view directly with optical instruments.

Step 2 If you are using a GBIC with clips:

a. Release the GBIC from the slot by simultaneously squeezing the two plastic tabs on each side of it.

b. Slide the GBIC or SFP out of the Gigabit Ethernet module slot. A flap closes over the GBIC or SFP 
slot to protect the connector on the Gigabit Ethernet card.

Step 3 If you are using a GBIC with a handle:

a. Release the GBIC by opening the handle.

b. Pull the handle of the GBIC.

c. Slide the GBIC out of the Gigabit Ethernet card slot. A flap closes over the GBIC slot to protect the 
connector on the Gigabit Ethernet card.

Step 4 If you are using an SFP: 

a. If the SFP connector has a latch securing the fiber cable, pull it upward to release the cable.

b. Pull the fiber cable straight out of the connector.

c. Unplug the SFP connector and fiber from the ML-series Ethernet card.

Purpose Use this task to remove the gigabit interface converters (GBIC) or small 
form-factor pluggables (SFP) from your Ethernet cards.

Tools/Equipment None

Prerequisite Procedures DLP-A469 Install GBIC or SFP Connectors, page 2-18

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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d. Slide the SFP out of the Gigabit Ethernet card slot. A flap closes over the SFP slot to protect the 
connector on the Gigabit Ethernet card.

Step 5 Return to your originating procedure (NTP).

NTP-A116 Remove and Replace a Card 

Step 1 If you are not logged into CTC and you need to remove a card, remove the card as described in Step 3. 
When you log into CTC, troubleshoot the mismatched equipment alarm (MEA) with the 
Cisco ONS 15454 Troubleshooting Guide. 

Step 2 If you are logged into CTC, complete one of the following:

• Complete the “DLP-A191 Delete a Card” task on page 2-22 and continue with Step 3.

• Complete the “DLP-A247 Change an Optical Card” task on page 2-22 to delete a card and replace 
it with a different optical card while maintaining existing provisioning.

Step 3 Physically remove the card:

a. Open the card latches/ejectors. 

b. Use the latches/ejectors to pull the card forward and away from the shelf.

Step 4 Insert the new card using one of the following procedures as applicable:

• NTP-A15 Install the Common Control Cards, page 2-2

• NTP-A16 Install the Optical Cards, page 2-13

• NTP-A17 Install the Electrical Cards, page 2-15

• NTP-A18 Install the Ethernet Cards, page 2-16 

Step 5 Continue with the “NTP-A19 Install the Fiber-Optic Cables” procedure on page 2-24.

Stop. You have completed this procedure. 

Purpose This procedure describes how to remove and replace cards in the 
ONS 15454 shelf.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Connect the PC and Log into the GUI”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-A191 Delete a Card

Step 1 On the shelf graphic in CTC, right-click the card that you want to remove and choose Delete Card.

You cannot delete a card if any of the following conditions apply:

• The card is a TCC+/TCC2 card.

• The card is part of a protection group; see the “DLP-A155 Delete a Protection Group” task on 
page 10-18.

• The card has circuits; see “NTP-A152 Delete Circuits” task on page 9-16.

• The card is part of a BLSR; see the “NTP-A213 Remove a BLSR Node” procedure on page 14-10.

• The card is being used for timing; see the “DLP-A157 Change the Node Timing Source” task on 
page 10-19.

• The card has a SONET DCC/GCC termination; see the “NTP-A204 Delete a SONET DCC 
Termination” procedure on page 10-18.

Note If the card that was deleted is not removed from the shelf, it will reboot and re-appear in CTC. 

Step 2 Return to your originating procedure (NTP).

DLP-A247 Change an Optical Card

Caution Physically removing an optical card can cause a loss of working traffic or a protection switch. See 
Chapter 12, “Upgrade Cards and Spans” for information on upgrading traffic to a higher speed.

Purpose This task deletes a card from CTC.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None

Purpose This task describes how to change an optical card while maintaining 
existing provisioning, including DCCs/GCCs (generic communication 
channels), circuits, protection, timing, and rings. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note You cannot change a multiport card to a card with a smaller number of ports. Do not use this procedure 
to replace a card with an identical card.Instead, use “DLP-A191 Delete a Card” task on page 2-22.

Step 1 If the card the active card in a 1+1 protection group, switch traffic away from the card:

a. Log into a node on the network. If you are already logged in, go to Step b.

b. Display the CTC node (login) view.

c. Click the Maintenance > Protection tabs.

d. Double-click the protection group that contains the reporting card.

e. Click the active card of the selected group.

f. Click Switch and Yes in the Confirmation dialog box.

Step 2 In CTC, right-click the card that you want to remove and choose Change Card.

Step 3 From the Change Card drop-down menu, choose the desired card type and click OK. An MEA appears 
until you replace the card. 

Step 4 Physically remove the card:

a. Open the card latches/ejectors. 

b. Use the latches/ejectors to pull the card forward and away from the shelf.

Step 5 Complete the “NTP-A16 Install the Optical Cards” procedure on page 2-13.

Step 6 Return to your originating procedure (NTP).

NTP-A115 Preprovision a Slot

Step 1 Log into the ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. The node 
(default) view displays. If you are already logged in, continue with Step 2.

Step 2 Right-click the empty slot where you will later install a card.

Step 3 From the Add Card popup menu, choose the card type that will be installed. 

Note When you preprovision a slot, the card appears purple in the CTC shelf display, rather than white 
when a card is physically in the slot.

Purpose This procedure describes how to preprovision a slot in the software before 
physical card installation. 

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Connect the PC and Log into the GUI”

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Provisioning or higher
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Step 4 Continue with the “NTP-A19 Install the Fiber-Optic Cables” procedure on page 2-24.

Stop. You have completed this procedure. 

NTP-A19 Install the Fiber-Optic Cables

Warning Class I (21 CFR 1040.10 and 1040.11) and Class 1M (IEC 60825-1 2001-01) laser products. 

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure.

Warning On all optical cards except the OC192 LR/STM64 LH 1550 card, the laser is on even when the optical 
port is not in service. On the OC192 LR/STM64 LH 1550 card, the laser is active when the card is booted 
and the safety key is in the on position (labeled 1). The laser is off when the safety key is off 
(labeled 0). 

Warning Follow all directions and warning labels when working with optical fibers. To prevent eye damage, 
never look directly into a fiber or connector.

Caution Do not use fiber loopbacks with the OC192 LR/STM64 LH 1550 or OC192 LR/STM64 LH ITU 15xx.xx 
card unless you are using a 20-dB attentuator. Never connect a direct fiber loopback. Using fiber 
loopbacks causes irreparable damage to the OC192 LR/STM64 LH 1550 or 
OC192 LR/STM64 LH ITU 15xx.xx card.

Purpose This procedure describes how to install fiber-optic cables on optical cards 
and Ethernet gigabit interface converters (GBIC).

Tools/Equipment Fiber-optic cables

Fiber boot

Prerequisite Procedures NTP-A16 Install the Optical Cards, page 2-13

NTP-A18 Install the Ethernet Cards, page 2-16

NTP-A112 Clean Fiber Connectors, page 15-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Caution Do not use fiber loopbacks with the OC192 IR/STM64 SH 1550 card unless you are using a 5-dB 
attentuator. Never connect a direct fiber loopback. Using fiber loopbacks causes irreparable damage to 
the OC192 IR/STM64 SH 1550 card.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note Fiber boots are not recommended for the OC192 or the OC48AS because of the downward angle of the 
optical ports.

Note You can install the fiber immediately after installing the cards, or wait until you are ready to turn up the 
network. See Chapter 5, “Turn Up Network.”

Step 1 Test the optical receive levels for the cards installed and attenuate accordingly. See Table 2-3 for the 
minimum and maximum levels.

Table 2-3 Optical Transmit and Receive Levels

Card

Transmit Receive

Minimum Maximum Minimum Maximum

OC3 IR 4/STM1 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC3IR/STM1SH 1310-8 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310 –15 dBm –8 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1310 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 LR/STM4 LH 1550 –3 dBm +2 dBm –28 dBm –8 dBm

OC12 IR/STM4 SH 1310-4 –15 dBm –8 dBm –30 dBm –8 dBm

OC48 IR 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 IR/STM16 SH AS 1310 –5 dBm 0 dBm –18 dBm 0 dBm

OC48 LR/STM16 LH AS 1550 –2 dBm +3 dBm –28 dBm –8 dBm

OC48 ELR/STM16 EH 100 GHz –2 dBm 0 dBm –27 dBm at 

1E-12 BER

–9 dBm

OC48 ELR/STM16 EH 200 GHz –2 dBm 0 dBm –28 dBm –8 dBm

OC192 SR/STM64 IO 1310 –6 dBm –1 dBm –11 dBm –1 dBm

OC192 IR/STM64 SH 1550 –1 dBm +2 dBm –14 dBm –1 dBm

OC192 LR/STM64 LH 1550 +7 dBm +10 dBm –19 dBm –10 dBm

OC192 LR/STM64 LH ITU 15xx.xx +3 dBm +6 dBm –22 dBm –9 dBm

TXP_MR_10G (trunk side) –16 dBm1 +3 dBm1 –24 dBm –8 dBm
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Step 2 As needed, complete the “DLP-A207 Install Fiber-Optic Cables on the LGX Interface” task on 
page 2-26.

Note Inspect and clean all fiber connectors thoroughly. See the “NTP-A112 Clean Fiber Connectors” 
procedure on page 15-23 for instructions. Dust particles can degrade performance. Put caps on 
any fiber connectors that are not used. 

Step 3 Complete the “DLP-A42 Install Fiber-Optic Cables on OC-N Cards” task on page 2-27.

Note To install fiber-optic cables on an Ethernet card GBIC, see the “DLP-A469 Install GBIC or SFP 
Connectors” task on page 2-18.

Step 4 As needed, complete the “DLP-A43 Install Fiber-Optic Cables for Path Protection Configurations” task 
on page 2-28.

Step 5 As needed, complete the “DLP-A44 Install Fiber-Optic Cables for BLSR Configurations” task on 
page 2-32.

Step 6 Complete the “DLP-A45 Install the Fiber Boot” task on page 2-34.

Step 7 Complete the “DLP-A46 Route Fiber-Optic Cables” task on page 2-35.

Step 8 Continue with the “NTP-A20 Replace the Front Door” procedure on page 2-36.

Stop. You have completed this procedure. 

DLP-A207 Install Fiber-Optic Cables on the LGX Interface

TXP_MR_10G (client side) –6 dBm –1 dBm –14 dBm –1 dBm

MXP_2.5G_10G (trunk side) –16 dBm1 +3 dBm1 –24 dBm –8 dBm

MXP_2.5G_10G (client side) –5 dBm 0 dBm depends on 
SFP 

depends on SFP 

1. On transponder and muxponder cards, the optical output power on the trunk side can be configured from —16 to 
+3 dBm with an accuracy of +/–0.5 dB.

Table 2-3 Optical Transmit and Receive Levels (continued)

Card

Transmit Receive

Minimum Maximum Minimum Maximum

Purpose This task installs fiber-optic cables on the Lightguide Cross Connect (LGX) 
interface in the Central Office.

Tools/Equipment Fiber-optic cables

Prerequisite Procedures NTP-A112 Clean Fiber Connectors, page 15-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note Inspect and clean all fiber connectors thoroughly. See the “NTP-A112 Clean Fiber Connectors” 
procedure on page 15-23 for instructions. Dust particles can degrade performance. Put caps on any fiber 
connectors that are not used. 

Step 1 Align the keyed ridge of the cable connector with the receiving SC connector on the LGX faceplate 
connection point. Each module supports at least one transmit and one receive connector to create an 
optical carrier port. 

Step 2 Gently insert the cable connector into the faceplate connection point until the connector snaps into place. 

Step 3 Connect the fiber optic cable to the OC-N card. See the “DLP-A42 Install Fiber-Optic Cables on OC-N 
Cards” task on page 2-27.

Step 4 Return to your originating procedure (NTP).

DLP-A42 Install Fiber-Optic Cables on OC-N Cards 

Note Inspect and clean all fiber connectors thoroughly. See the “NTP-A112 Clean Fiber Connectors” 
procedure on page 15-23 for instructions. Dust particles can degrade performance. Put caps on any fiber 
connectors that are not used. 

Note The Cisco OC-3 IR/STM-1 SH, OC-12 IR/STM-4 SH, and OC-48 IR/STM-16 SH interface optics, all 
working at 1310 nm, are optimized for the most widely used SMF-28 fiber, available from many 
suppliers. 

Note Corning MetroCor fiber is optimized for optical interfaces that transmit at 1550 nm or in the C and L 
DWDM windows. This fiber targets interfaces with higher dispersion tolerances than those found in 
OC-3 IR/STM-1 SH, OC-12 IR/STM-4 SH, and OC-48 IR/STM-16 SH interface optics. If you are using 
Corning MetroCor fiber, OC-3 IR/STM-1 SH, OC- 12 IR/STM-4 SH, and OC-48 IR/STM-16 SH 
interface optics will become dispersion limited before they will become attenuation limited. In this case, 
consider using OC-3 LR/STM-1 LH, OC-12 LR/STM-4 LH, and OC-48 LR/STM-16 LH cards instead 
of OC-3 IR/STM-1 SH, OC-12 IR/STM-4 SH, and OC-48 IR/STM-16 SH cards. 

Purpose This task installs fiber-optic cables on optical (OC-N) cards.

Tools/Equipment Fiber-optic cables

Prerequisite Procedures NTP-A16 Install the Optical Cards, page 2-13

NTP-A112 Clean Fiber Connectors, page 15-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note With all fiber types, network planners/engineers should review the relative fiber type and optics 
specifications to determine attenuation, dispersion, and other characteristics to ensure appropriate 
deployment. 

Step 1 Align the keyed ridge of the cable connector with the receiving SC connector on the faceplate connection 
point. Each card supports at least one transmit and one receive connector to create an optical carrier port. 
Figure 2-2 on page 2-28 shows the cable location. 

Figure 2-2 Installing Fiber-Optic Cables

Note The OC12 IR/STM4 SH 1310-4 card faceplate has four ports.

Step 2 Gently insert the cable connector into the faceplate connection point until the connector snaps into place. 

Step 3 If you are installing fiber-optic cables on a OC12 IR/STM4 SH 1310-4 card, repeat Steps 1 and 2 until 
all SC connectors are in place.

Step 4 Return to your originating procedure (NTP).

DLP-A43 Install Fiber-Optic Cables for Path Protection Configurations 

Tx

Rx

FAIL
ACT

SF

32
08

2Front edge of card

SC cable connector

SC faceplate connector

Purpose This task installs the fiber-optic cables to the east and west path protection 
ports at each node. See Chapter 5, “Turn Up Network” to provision and test 
path protection configurations.

Tools/Equipment Fiber-optic cables

Prerequisite Procedures NTP-A16 Install the Optical Cards, page 2-13

NTP-A112 Clean Fiber Connectors, page 15-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note To avoid error, connect fiber-optic cable so that the farthest slot to the right represents the east port, and 
the farthest slot to the left represents the west port. Fiber connected to an east port at one node must plug 
into the west port on an adjacent node. 

Note Inspect and clean all fiber connectors thoroughly. See the “NTP-A112 Clean Fiber Connectors” 
procedure on page 15-23 for instructions. Dust particles can degrade performance. Put caps on any fiber 
connectors that are not used. 

Step 1 Plan your fiber connections. Use the same plan for all path protection nodes. 

Step 2 Plug the fiber into the transmit (Tx) connector of an OC-N card at one node and plug the other end of 
the fiber into the receive (Rx) connector of an OC-N card at the adjacent node. The card displays a 
SF LED if the transmit and receive fibers are mismatched (one fiber connects a receive port on one card 
to a receive port on another card, or the same situation with transmit ports).

Step 3 Repeat Step 2 until you have configured the ring.

Figure 2-3 shows fiber connections for a four-node path protection with trunk (span) cards in Slot 5 
(west) and Slot 12 (east). If you are creating a path protection dual ring interconnect, Figure 2-4 on 
page 2-30 shows a traditional dual ring interconnect example. Figure 2-5 on page 2-31 shows an 
integrated dual ring interconnect example.

Figure 2-3 Connecting Fiber to a Four-Node Path Protection
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Figure 2-4 Connecting Fiber to an Eight-Node Traditional Path Protection Dual-Ring Interconnect
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Figure 2-5 Connecting Fiber to a Six-Node Integrated Path Protection Dual-Ring Interconnect

Step 4 Return to your originating procedure (NTP).
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DLP-A44 Install Fiber-Optic Cables for BLSR Configurations 

Note To avoid error, connect fiber-optic cable so that the farthest slot to the right represents the east port, and 
the farthest slot to the left represents the west port. Fiber connected to an east port at one node must plug 
into the west port on an adjacent node. 

Note Inspect and clean all fiber connectors thoroughly. See the “NTP-A112 Clean Fiber Connectors” 
procedure on page 15-23 for instructions. Dust particles can degrade performance. Put caps on any fiber 
connectors that are not used. 

Step 1 Plan your fiber connections. Use the same plan for all BLSR nodes. 

Step 2 Plug the fiber into the transmit (Tx) connector of an OC-N card at one node and plug the other end into 
the receive (Rx) connector of an OC-N card at the adjacent node. The card displays a SF LED if the 
transmit and receive fibers are mismatched.

Note Do not mix working and protect card connections when connecting a four-fiber BLSR. The 
BLSR does not function if working and protect cards are interconnected. See Figure 2-7 on 
page 2-34 for an example of correct four-fiber BLSR cabling.

Step 3 Repeat Step 2 until you have configured the ring.

Figure 2-6 shows fiber connections for a two-fiber BLSR with trunk cards in Slot 5 (west) and Slot 12 
(east). 

Purpose This task installs the fiber-optics to the east and west BLSR ports at each 
node. See Chapter 5, “Turn Up Network” to provision and test BLSR 
configurations.

Tools/Equipment Fiber-optic cables

Prerequisite Procedures NTP-A16 Install the Optical Cards, page 2-13

NTP-A112 Clean Fiber Connectors, page 15-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 2-6 Connecting Fiber to a Four-Node, Two-Fiber BLSR

Figure 2-7 on page 2-34 shows fiber connections for a four-fiber BLSR. Slot 5 (west) and Slot 12 (east) 
carry the working traffic. Slot 6 (west) and Slot 13 (east) carry the protect traffic.
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Figure 2-7 Connecting Fiber to a Four-Node, Four-Fiber BLSR

Step 4 Return to your originating procedure (NTP).

DLP-A45 Install the Fiber Boot 

Note You can install the fiber boots on the fiber-optic cables before or after the fibers are attached to the 
optical card.

Note The fiber boot does not support the OC-48 IR/STM-16 SH AS 1310, OC-48 LR/STM-16 LH AS 1550, 
and OC-192 LR/STM64 LH 1550 cards. The boots are not necessary for these cards because of the 
angled SC connectors on the cards.

Purpose This task installs the fiber boot.

Tools/Equipment Fiber boot

Prerequisite Procedures NTP-A16 Install the Optical Cards, page 2-13

NTP-A19 Install the Fiber-Optic Cables, page 2-24

Required/As Needed Required for all optical cards except the OC-192 and the OC-48 AS

Onsite/Remote Onsite

Security Level None
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Note If you are installing an OC3IR/STM1SH 1310-8 card, you must use a fiber clip instead of a fiber boot 
on the port 8 Rx fiber connector. 

Step 1 Position the open slot of the fiber boot underneath the fiber cable.

Step 2 Push the fiber cable down into the fiber boot. Figure 2-8 shows the fiber boot attachment.

Step 3 Twist the fiber boot to lock the fiber cable into the tail end of the fiber boot.

Step 4 Slide the fiber boot forward along the fiber cable until the fiber boot fits snugly onto the end of the 
SC cable connector.

Figure 2-8 Attaching a Fiber Boot

Step 5 Return to your originating procedure (NTP).

DLP-A46 Route Fiber-Optic Cables 

Purpose This task describes how to route fiber-optic cables.

Tools/Equipment None

Prerequisite Procedures Any of the following:

DLP-A207 Install Fiber-Optic Cables on the LGX Interface, page 2-26

DLP-A42 Install Fiber-Optic Cables on OC-N Cards, page 2-27

DLP-A43 Install Fiber-Optic Cables for Path Protection Configurations, 
page 2-28

DLP-A44 Install Fiber-Optic Cables for BLSR Configurations, page 2-32

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Step 1 Open the fold-down front door on the cable-management tray.

Step 2 Route the fiber cable on the card faceplate through the fiber clip on the faceplate. Fiber clips are 
factory-attached to the faceplate of the optical card. 

GBICs do not have fiber clips; therefore, if you are routing optical cable from an E1000-2-G, E1000-2, 
or G-Series cards, skip to Step 3.

Step 3 Route the fiber cables into the cable-management tray. 

Step 4 Route the fiber cables out either side of the cable-management tray through the cutouts on each side of 
the shelf assembly. Use the reversible fiber guides to route cables out the desired side.

Step 5 Close the fold-down front door when all fiber cables in the front compartment are properly routed.

Step 6 Return to your originating procedure (NTP).

NTP-A20 Replace the Front Door 

Note Watch to make sure that you do not crimp any fiber cables that are connected to the optical cards. Some 
might not have the fiber boot attached. 

Step 1 Insert the front door into the hinges on the shelf assembly.

Step 2 Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside of the door. 
Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench. See Figure 2-9.

Purpose This procedure explains how to replace the front door and door ground 
strap after installing cards and fiber-optic cables.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-A3 Open and Remove the Front Door, page 1-12

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 2-9 Installing the Door Ground Strap Retrofit Kit

Step 3 Attach the other end of the ground strap to the longer screw on the fiber guide.

a. Attach the lock washer.

b. Attach the terminal lug.

c. Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug. 

Note To avoid interference with the traffic (line) card, make sure the ground strap is in a flat position 
when the door is open. To move the ground strap into a flat position, rotate the terminal lug 
counterclockwise before tightening the Kepnut.

Step 4 Replace the left cable-routing channel.

Step 5 Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.

Figure 2-10 shows the shelf assembly with the front door and ground strap installed.
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Figure 2-10 Shelf Assembly with Door Ground Strap Retrofit Kit Installed

Step 6 Swing the door closed. 

Note The ONS 15454 comes with a pinned hex key tool for locking and unlocking the front door. Turn 
the key counterclockwise to unlock the door and clockwise to lock it. 

Stop. You have completed this procedure. 
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C H A P T E R 3

Connect the PC and Log into the GUI

This chapter explains how to connect PCs and workstations to the Cisco ONS 15454 and how to log into 
Cisco Transport Controller (CTC) software, the Cisco ONS 15454 Operation, Administration, 
Maintenance and Provisioning (OAM&P) user interface. 

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A21 Set Up Computer for CTC, page 3-1—Complete this procedure if your PC or workstation 
has never been connected to an ONS 15454.

2. NTP-A22 Set Up CTC Computer to Connect to the ONS 15454, page 3-8—After your PC or 
workstation is set up for CTC, complete this procedure to set up your computer to connect to the 
ONS 15454.

3. NTP-A23 Log into the ONS 15454 GUI, page 3-22—Complete this procedure to log into CTC.

NTP-A21 Set Up Computer for CTC

Step 1 If your computer is a Windows PC, complete the “DLP-A47 Run the CTC Installation Wizard for 
Windows” task on page 3-2, then go to Step 4.

Step 2 If your computer is a UNIX workstation, complete the “DLP-A48 Run the CTC Installation Wizard for 
UNIX” task on page 3-5.

Step 3 If your computer is a UNIX workstation and you installed the Java Runtime Environment (JRE) in 
Step 2, complete the “DLP-A49 Set Up the Java Runtime Environment for UNIX” task on page 3-7.

Purpose This procedure explains how to configure your PC or UNIX workstation to 
run Cisco Transport Controller (CTC). 

Tools/Equipment Cisco ONS 15454 Release 4.0 software or documentation CD

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level None
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Step 4 When your PC or workstation is set up, complete the “NTP-A22 Set Up CTC Computer to Connect to 
the ONS 15454” procedure on page 3-8.

Stop. You have completed this procedure.

DLP-A47 Run the CTC Installation Wizard for Windows

Step 1 Verify that your computer has the following:

• Processor—Pentium II, 300 Mhz or faster.

• RAM—128 MB.

• Hard drive—2 GB is recommended. 50 MB of space must be available. 

• Operating System—Windows 95, Windows 98, Windows NT 4.0, Windows 2000, or Windows XP. 

If your operating system is Windows NT 4.0, verify that Service Pack 5 or later is installed. From 
the Start menu, choose Programs > Administrative Tools > Windows NT Diagnostics and check 
the service pack on the Version tab of the Windows NT Diagnostics dialog box. If Service Pack 5 or 
later is not installed, do not continue. Install Service Pack 5 following the computer upgrade 
procedures for your site.

Note Processor and RAM requirements are guidelines. CTC performance is faster if your computer 
has a faster processor and more RAM. Refer to the Cisco ONS 15454 Reference Manual for 
computer requirements needed for small, medium, and large ONS 15454 networks. 

Step 2 Insert the Cisco ONS 15454 Release 4.0 software or documentation CD into your computer CD drive. 
The installation program begins running automatically. If it does not start, navigate to your computer’s 
CD directory and double-click setup.exe.

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer (Figure 3-1).

Purpose This task installs CTC online help as well as programs required to run CTC 
on Windows PCs: Netscape 4.73 and JRE 1.3.1_02. It also modifies the 
JRE policy file so CTC files can be downloaded to your computer when 
you connect to an ONS 15454.

Tools/Equipment Cisco ONS 15454 Release 4.0 software or documentation CD

Prerequisite Procedures None

Required/As Needed This task is required if any one of the following is true: 

• Netscape Release 4.73 or later or Internet Explorer Release 4.0 
(service pack 2) or later is not installed

• JRE 1.3.1_02 is not installed

• CTC online help is not installed and is needed

• The JRE java.policy file has not been modified for CTC 

Onsite/Remote Onsite or remote

Security Level None
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Figure 3-1 Cisco Transport Controller Installation Wizard

Step 3 Click Next.

Step 4 Choose Typical to install all the components shown in Figure 3-1, or choose Custom if you only want 
to install some of the components. 

Step 5 Click Next. 

Step 6 If you selected Custom in Step 4, select the CTC components you want to install and click Next. If you 
selected Typical, skip this step and proceed to Step 7.

Step 7 The directory where the installation wizard will install CTC online help is displayed. The default is 
C:\Program Files\Cisco\CTC\Documentation. 

a. If you do not want to change the directory, skip this step and proceed to Step 8. 

b. If you want to change the CTC online help directory, type the new directory path in the Directory 
Name field, or click Browse to navigate to the directory. 

Step 8 Click Next.

Step 9 Review the components that will be installed. If you want to change them, click Back. If you have an 
active CTC session (for example, you are monitoring alarms or conditions), close CTC before going to 
Step 10.

Step 10 Click Next. 

An Installation Issues dialog box is displayed.

Step 11 Review the issues, then click OK. The InstallShield program begins the Netscape Communicator 4.73 
Setup program.

Step 12 Complete the Netscape installation:

a. In the Netscape Communicator 4.73 Setup dialog box, click Next.

b. In the Software License Agreement dialog box, click Yes.

c. In the Setup Type dialog box, click Typical, then click Next.
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Note If the Netscape installation hangs when installing RealPlayer G2, restart the CTC installation by 
pressing Ctrl-Alt-Del. In the Windows Security dialog box, click Task Manager. In the 
Windows Task Manager dialog box, click Cisco Transport Controller Installation Wizard, 
then click the End Task button. Click Yes in the confirmation dialog box. Navigate to the drive 
containing the CTC CD and double-click CTC.exe. Repeat Steps 1 to 11. At Step 12, Step c, 
click Custom, then click Next. At the next panel, deselect RealPlayer. Continue with Step d.

d. In the Netscape Desktop Preferences Options dialog box, check the boxes that apply according to 
your site requirements (these options do not affect CTC operation), then click Next.

e. In the Select Program Folder dialog box, click Next.

f. In the Start Copying Files dialog box, click Install. The program begins the Netscape installation.

g. In the Question dialog box, click No.

h. In the Information dialog box, click OK.

i. In the Restarting Windows dialog box, click No, I will restart later, then click OK. 

Step 13 Close the Netscape Communicator directory window to display the Cisco Transport Controller 
Installation Wizard dialog box.

Step 14 In the CTC Installation Wizard dialog box, click Next. The Java 2 runtime environment installation 
begins. 

Step 15 Complete the JRE installation:

a. In the Software License Agreement dialog box, click Yes.

b. In the Choose Destination Location dialog box, click Next.

c. In the Select Browser dialog box, click the Microsoft Internet Explorer and Netscape 6 check 
boxes, then click Next. 

When JRE installation is complete, the Cisco Transport Controller Installation Wizard dialog box is 
displayed.

Step 16 Click Next. The CTC online help is installed. When installed, the policy file selection is displayed.

Step 17 Choose the JRE policy file to modify:

• Choose User Policy File (default) to modify the policy file that applies only to your user profile. 
This file is not overwritten if you upgrade or reinstall the JRE. If you are the only user who will 
access an ONS 15454 from the PC you are setting up, choose this option.

• Choose System Policy File to modify the system JRE policy file. This policy file applies to all 
computer users. If more than one individual will use this computer to access the ONS 15454, choose 
this option. However, if you reinstall or upgrade the JRE, the system policy file is overwritten and 
you must run the CTC Installation Setup program again to modify it.

Step 18 Click Next. 

Step 19 If you selected System Policy File in Step 17, complete the following steps. If you selected User Policy 
File, go to Step 20.

a. The System Policy File Update dialog box displays the default policy file location (C:\Program 
Files\JavaSoft\jre). If you installed the JRE in a different location, enter the new path in the 
Directory Name field. After entering the path, or if the default path is correct, click OK.

b. Click OK in the confirmation dialog box.
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Step 20 Click Finish.

Step 21 Return to your originating procedure (NTP).

DLP-A48 Run the CTC Installation Wizard for UNIX

Step 1 Verify that your computer has the following:

• RAM—128 MB.

• Hard drive—Verify that 50 MB of space is available. 

• Operating System—Solaris 2.5.x or 2.6.x.

Note These requirements are guidelines. CTC performance is faster if your computer has a faster 
processor and more RAM. Refer to the Cisco ONS 15454 Reference Manual for computer 
requirements needed for small, medium, and large ONS 15454 networks. 

Step 2 Change the directory, type:

cd /cdrom/cdrom0/

Step 3 From the techdoc454 CD directory, type:

./setup.bat

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer (Figure 3-1 on page 3-3):

• Netscape Communicator 4.76.

• Java Runtime Environment 1.3.1_02.

• CTC Online Help.

• Modify Policy File—The JRE java.policy file is modified to enable CTC to download files needed 
to run the Cisco Transport Controller when you connect to an ONS 15454. 

Purpose This task installs CTC online help and programs required to run CTC on 
Solaris workstations: Netscape 4.76 and JRE 1.3.1_02. It also modifies the 
JRE policy file to allow CTC files to be downloaded to your computer after 
you connect to an ONS 15454.

Tools/Equipment Cisco ONS 15454 Release 4.0 software or documentation CD

Prerequisite Procedures None

Required/As Needed Required if any of the following are true: 

• Netscape Release 4.76 is not installed.

• JRE 1.3.1_02 is not installed.

• CTC online help is not installed and is needed.

• The JRE java.policy file has not been modified for CTC.

Onsite/Remote Onsite or remote

Security Level None
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Step 4 Click Next.

Step 5 Choose Typical to install all components, or choose Custom if you want to choose particular 
components to install. 

Step 6 Click Next. 

Step 7 If you selected Custom in Step 5, choose the CTC components you want to install and click Next. If you 
selected Typical, proceed to Step 8.

Step 8 The directory where the installation wizard will install CTC online help is displayed. The default is 
C:\Program Files\Cisco\CTC\Documentation. If you want to change the CTC online help directory, type 
the new directory path in the Directory Name field, or click Browse to navigate to the directory.

Step 9 Click Next.

Step 10 Review the components that will be installed. If you want to change them, click Back. If CTC is running 
(for example, you are reinstalling components) close CTC before going to the next step.

Step 11 Click Next. The InstallShield program begins the Netscape Communicator 4.76 Setup program.

Step 12 Complete the Netscape installation:

a. In the Netscape Communicator 4.76 Setup dialog box, click Next.

b. In the Software License Agreement dialog box, click Yes.

c. In the Setup Type dialog box, click Typical.

d. In the Netscape Desktop Preferences dialog box, check the boxes that apply, then click Next.

e. In the Program Folder dialog box, click Next.

f. In the Start Copying Files dialog box, click Install. The program begins the Netscape installation.

g. In the Question dialog box, click No.

Step 13 In the Cisco Transport Controller Installation Wizard dialog box, click Next. The Java 2 runtime 
environment installation begins. 

Step 14 Complete the JRE installation:

a. In the Software License Agreement dialog box, click Yes.

b. In the Choose Destination Location dialog box, click Next.

c. In the Select Browser dialog box, click the Netscape 6 check box, then click Next. 

When JRE installation is complete, the Cisco Transport Controller Installation Wizard dialog box is 
displayed.

Step 15 Click Next. The CTC online help is installed. When installed, the policy file selection is displayed.

Step 16 Choose the JRE policy file to modify:

• Choose User Policy File (default) to modify a policy file that applies only to your user profile. This 
file is not overwritten if you upgrade or reinstall the JRE. If you are the only computer user who will 
access an ONS 15454, choose this option.

• Choose System Policy File to modify the system JRE policy file. This policy file applies to all 
computer users. If more than one individual will use this computer to access the ONS 15454, choose 
this option. However, if you reinstall or upgrade the JRE, the system policy file is overwritten and 
you must run the CTC Installation Setup program again to modify it.
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Step 17 Click Next, then click Finish.

Note Be sure to record the names of the directories you choose for Netscape, JRE, and the online 
documentation.

Step 18 Return to your originating procedure (NTP).

DLP-A49 Set Up the Java Runtime Environment for UNIX

Note The JRE might require certain patches to run properly. The patch tar file can be found in the JRE/Solaris 
directory on the CD. Please read the JRE/Solaris/Solaris.txt file for more information. In addition to 
installing any needed patches, set up the JRE for use with Cisco Transport Controller on your UNIX 
system. 

Note CTC requires that the location of xterm is also in your path. If you have moved xterm from its default 
location, /usr/openwin/bin, you must change all occurrences of /usr/openwin/bin in the following 
procedures to reflect the actual path where xterm exists on your system.

Step 1 Set up the environment variable:

a. If you are using the csh shell, edit the .cshrc file in your home directory by appending the file with 
the lines:

setenv JRE JRE-path
setenv NETSCAPE Netscape-path
setenv NPX_PLUGIN_PATH $JRE/j2re1_3_1_02/plugin/sparc/ns4
set path = ( /usr/openwin/bin $NETSCAPE $path )

b. If you are using the ksh or bash shell, edit the .profile file in your home directory by appending the 
file with the lines:

JRE=JRE-path
NETSCAPE=Netscape-path
NPX_PLUGIN_PATH=$JRE/j2re1_3_1_02/plugin/sparc/ns4 
PATH=/usr/openwin/bin:$NETSCAPE:$PATH 
export JRE NPX_PLUGIN_PATH PATH

Step 2 Set the JRE reference:

a. Run the Control Panel by typing: 

JRE-path/j2re1_3_0_02/bin/ControlPanel

Purpose This task sets up the JRE for UNIX workstations. 

Tools/Equipment None

Prerequisite Procedures DLP-A48 Run the CTC Installation Wizard for UNIX, page 3-5

Required/As Needed Required if you installed the JRE during the CTC installation 

Onsite/Remote Onsite or remote

Security Level None
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b. Click the Advanced tab.

c. From the combo box, select JRE-path/j2re1_3_1_02. If the JRE is not found, select other and enter 
the following in the Path text box:

JRE-path/j2re1_3_1_02

d. Click Apply. 

Note If you are running multiple shells, before your new environment variable is set you might need 
to invoke the same shell for which you changed the initialization file. For example, if you added 
the environment variable to the .cshrc file, you must run your browser under the csh shell.

Step 3 Return to your originating procedure (NTP).

NTP-A22 Set Up CTC Computer to Connect to the ONS 15454

Step 1 From Table 3-1, select the ONS 15454 connection type that you want to set up for your computer. 

Note For initial shelf turn up, you should connect your PC directly to the LAN port on the 
TCC+/TCC2 card of the ONS 15454. 

Purpose This procedure explains how to set up a PC running Windows or a Solaris 
workstation to connect to the ONS 15454.

Tools/Equipment Depends on connection type

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None
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Step 2 If you need to set up your computer for corporate LAN access, complete the “DLP-A55 Set Up a 
Computer for a Corporate LAN Connection” task on page 3-19. If not, proceed to the next step.

Step 3 If you need to set up the computer for remote access, complete the “DLP-A58 Provision Remote Access 
to the ONS 15454” task on page 3-21. If not, proceed to the next step.

Step 4 If you need to set up your computer for TL1 access, refer to the Cisco ONS 15454 and Cisco ONS 15327 
TL1 Command Guide. If not, proceed to the next step.

Step 5 If you need to set up your computer for local craft connections, choose a task from Table 3-2.

Table 3-1 ONS 15454 Connection Methods

Method Description Requirements

Local craft Refers to onsite network connections 
between the CTC computer and the 
ONS 15454 using one of the following:

• The RJ-45 (LAN) port on the 
TCC+/TCC2 card

• The LAN pins on the ONS 15454 
backplane

• A hub or switch to which the ONS 15454 
is connected

• If you do not use Dynamic Host 
Configuration Protocol (DHCP), you 
must change the computer IP address, 
subnet mask, and default router, or use 
automatic host detection. 

Corporate 
LAN

Refers to a connection to the ONS 15454 
through a corporate or network operations 
center (NOC) LAN.

• The ONS 15454 must be provisioned 
for LAN connectivity, including IP 
address, subnet mask, default gateway.

• The ONS 15454 must be physically 
connected to the corporate LAN.

• The CTC computer must be connected 
to the corporate LAN that has 
connectivity to the ONS 15454.

TL1 Refers to a connection to the ONS 15454 
using TL1 rather than CTC. TL1 sessions can 
be started from CTC, or you can use a TL1 
terminal. The physical connection can be a 
craft connection, corporate LAN, or a TL1 
terminal. Refer to the Cisco ONS 15454 and 
Cisco ONS 15327 TL1 Command Guide.

Remote Refers to a connection made to the 
ONS 15454 using a modem.

• A modem must be connected to the 
ONS 15454.

• The modem must be provisioned for 
ONS 15454. To run CTC, the modem 
must be provisioned for Ethernet 
access.
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Stop. You have completed this procedure.

Table 3-2 ONS 15454 Craft Connection Options

Local Craft Connection Task Description

• DLP-A52 Set Up a Windows PC for 
Craft Connection to an ONS 15454 
Using Automatic Host Detection, page 
3-15

Complete this task if: 

• All nodes that you will access run software Release 
3.3 or later.

• You will connect to ONS 15454s at different 
locations and times and do not wish to reconfigure 
your PC’s IP settings each time.

• You do not need to access or use non-ONS 15454 
applications such as ping and trace route.

• You will connect to the ONS 15454’s TCC+/TCC2 
Ethernet port or backplane LAN pins either directly 
or through a hub.

• DLP-A50 Set Up a Windows PC for 
Craft Connection to an ONS 15454 on 
the Same Subnet Using Static IP 
Addresses, page 3-11

Complete one of these tasks if: 

• You are connecting from a Windows PC.

• You will connect to one ONS 15454; if you will 
connect to multiple ONS 15454s, you might need to 
configure your computer’s IP settings each time you 
connect to an ONS 15454.

• You need to access non-ONS 15454 applications 
such as ping and trace route.

• DLP-A53 Set Up a Solaris Workstation 
for a Craft Connection to an 
ONS 15454, page 3-17

Complete one of these tasks if: 

• You are connecting from a Solaris Workstation.

• You will connect to one ONS 15454; if you will 
connect to multiple ONS 15454s, you might need to 
configure your computer’s IP settings each time you 
connect to an ONS 15454.

• You need to access non-ONS 15454 applications 
such as ping and trace route.

• DLP-A51 Set Up a Windows PC for 
Craft Connection to an ONS 15454 
Using DHCP, page 3-13

Complete this task if: 

• The CTC computer is provisioned for DHCP.

• The ONS 15454 has DHCP forwarding enabled and 
is connected to a DHCP server.
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DLP-A50 Set Up a Windows PC for Craft Connection to an ONS 15454 on the 
Same Subnet Using Static IP Addresses

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 95, Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 If you have Windows 95 or 98 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your PC Ethernet card, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

h. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address except for 
the last three digits. The last three digits must be between 1 and 254. This IP address can be 
displayed on the LCD. Software R4.0 allows suppressing the LCD IP address display. 

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the ONS 15454 IP address. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

Purpose This task sets up your computer for a local craft connection to the ONS 
15454 when: 

• You will access nodes running software releases earlier than 
Release 3.3.

• You will connect to one ONS 15454; if you will connect to multiple 
ONS 15454s, you might need to reconfigure your computer’s IP 
settings each time you connect to an ONS 15454.

• You need to use non-ONS 15454 applications such as ping and trace 
route.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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n. When the prompt to restart your PC appears, click Yes.

Step 3 If you have Windows NT 4.0 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last three digits. The last three digits must be between 1 and 254.

g. In the Subnet Mask field, type 255.255.255.0.

h. Click the Advanced button.

i. Under the Gateways List, click Add. The TCP/IP Gateway Address dialog box is displayed.

j. Type the ONS 15454 IP address in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.

n. In some cases, Windows NT 4.0 prompts you to reboot your PC. If you receive this prompt, click 
Yes.

Step 4 If you have Windows 2000 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > Local 
Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last three digits. The last three digits must be between 1 and 254.

f. In the Subnet Mask field, type 255.255.255.0.

g. In the Default Gateway field, type the ONS 15454 IP address. 

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.

Step 5 If you have Windows XP installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon.

c. From the Local Area Connection Properties dialog box, choose Internet Protocol (TCP/IP), then 
click Properties.
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d. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last three digits. The last three digits must be between 1 and 254.

e. In the Subnet Mask field, type 255.255.255.0.

f. In the Default Gateway field, type the ONS 15454 IP address. 

g. Click OK.

h. In the Local Area Connection Properties dialog box, click OK.

i. In the Local Area Connection Status dialog box, click Close.

Step 6 Return to your originating procedure (NTP).

DLP-A51 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
DHCP 

Caution You cannot connect to the ONS 15454 if DHCP forwarding is not enabled on the ONS 15454 or if the 
ONS 15454 is not connected to a DHCP server. By default, DHCP forwarding is not enabled. If you are 
connecting to an ONS 15454 to perform initial shelf turnup, complete the “DLP-A50 Set Up a Windows 
PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses” task on 
page 3-11 or the “DLP-A52 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Automatic Host Detection” task on page 3-15.

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 95, Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 If you have Windows 95 or 98 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your PC Ethernet card, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

Purpose This task sets up your computer for craft connection to the ONS 15454 
using DHCP. 

Tools/Equipment Straight-through (Category 5) LAN cable

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

NTP-A169 Set Up CTC Network Access, page 4-8

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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f. Click the IP Address tab.

g. In the IP Address window, click Obtain an IP address from a DHCP Server. 

h. Click OK.

i. When the prompt to restart your PC appears, click Yes.

Step 3 If you have Windows NT 4.0 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Obtain an IP address from a DHCP Server.

f. Click OK.

g. Click Apply.

h. If Windows prompts you to restart your PC, click Yes.

Step 4 If you have Windows 2000 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > Local 
Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Obtain an IP address from a DHCP Server.

e. Click OK.

f. In the Local Area Connection Properties dialog box, click OK.

g. In the Local Area Connection Status dialog box, click Close.

Step 5 If you have Windows XP installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. In the Network Connections dialog box, click Local Area Connection.

c. In the Local Area Connection Status dialog box, click Properties.

d. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

e. Click Obtain an IP address automatically.

f. Click OK.

g. In the Local Area Connection Properties dialog box, click OK.

h. In the Local Area Connection Status dialog box, click Close.

Step 6 Return to your originating procedure (NTP).
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DLP-A52 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Automatic Host Detection 

Note If you are using automatic host detection and you disconnect a straight-through (Category 5) LAN cable 
from one node and connect it to another node, you must close CTC and relaunch it to reconnect to the 
proxy server and communicate with the new node.

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel. 

Note In Windows XP, you can select Control Panel directly from the Start menu. Make sure you 
are in Classic View before continuing with this procedure.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 95, Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 If you have Windows 95 or 98 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your PC Ethernet card, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

Purpose This task sets up your computer for local craft connection to the 
ONS 15454 when:

• You will connect to the ONS 15454’s Ethernet port or backplane LAN 
pins either directly or through a hub.

• All nodes that you will access are running software Release 3.3 or 
later.

• You will connect to multiple ONS 15454s and do not want to 
reconfigure your IP address each time.

• You do not need to access non-ONS 15454 applications such as ping 
and trace route.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
3-15
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 3      Connect the PC and Log into the GUI
NTP-A22 Set Up CTC Computer to Connect to the ONS 15454
h. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. 

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the address entered in Step f. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

n. When the prompt to restart your PC appears, click Yes.

Step 3 If you have Windows NT 4.0 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. 

g. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

h. Click the Advanced button.

i. Under the Gateways List, click Add. The TCP/IP Gateway Address dialog box is displayed.

j. Type the IP address entered in Step f in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.

n. Reboot your PC. 

Step 4 If you have Windows 2000 installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. 

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

g. Type the IP address entered in Step e in the Gateway Address field.

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.
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Step 5 If you have Windows XP installed on your PC, complete the following steps:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon.

c. From the Local Area Connection Properties dialog box, choose Internet Protocol (TCP/IP), then 
click Properties.

d. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. 

e. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

f. Type the IP address entered in Step d in the Gateway Address field.

g. Click OK.

h. In the Local Area Connection Properties dialog box, click OK.

i. In the Local Area Connection Status dialog box, click Close.

Step 6 Return to your originating procedure (NTP).

DLP-A53 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454

Step 1 Log into the workstation as the root user.

Step 2 Check to see if the interface is plumbed by typing:

# ifconfig device

For example:

# ifconfig hme1

a. If the interface is plumbed, a message similar to the following appears:

hme1:flags=1000842<BROADCAST,RUNNING,MULTICAST,IPv4>mtu 1500 index 2 inet 0.0.0.0 netmask 0

Go to Step 4.

b. If the interface is not plumbed, a message similar to the following appears: 

ifconfig: status: SIOCGLIFFLAGS: hme1: no such interface. 

Purpose This task sets up a Solaris workstation for a craft connection to the ONS 
15454.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Plumb the interface by typing:

# if config device plumb

For example:

# ifconfig hme1 plumb

Step 3 Configure the IP address on the interface by typing:

# ifconfig interface ip-address netmask netmask up

For example: 

# ifconfig hme0 10.20.30.40 netmask 255.255.255.0 up

Note Enter an IP address that is identical to the ONS 15454 IP address except for the last three digits. 
The last three digits must be between 1 and 254. 

Step 4 In the Subnet Mask field, type 255.255.255.0. Skip this step if you checked Craft Access Only at 
Provisioning > Network > General > Gateway Settings.

Step 5 Test the connection:

a. Start Netscape Navigator.

b. Enter the Cisco ONS 15454 IP address in the web address (URL) field. If the connection is 
established, a Java Console window, CTC caching messages, and the Cisco Transport Controller 
Login dialog box appear. If this occurs, go to Step 2 of the “DLP-A60 Log into CTC” task on 
page 3-23 to complete the login. If the Login dialog box does not appear, complete Steps c to d.

c. At the prompt, type: 

ping ONS-15454-IP-address

For example, to connect to an ONS 15454 with a default IP address of 192.168.1.1, type:

ping 192.168.1.1

If your workstation is connected to the ONS 15454, the following message appears:

IP-address is alive

Note Skip this step if you checked the Craft Access Only check box at Provisioning > Network 
> General > Gateway Settings. 

d. If CTC is not responding, a “Request timed out” message appears. Verify the IP and subnet mask 
information. Check that the cables connecting the workstation to the ONS 15454 are securely 
attached. Check the link status by typing:

# ndd -set /dev/device instance 0
# ndd -get /dev/device link_status

For example:

# ndd -set /dev/hme instance 0
# ndd -get /dev/hme link_status
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A result of “1” means the link is up. A result of “0” means the link is down.

Note Check the man page for ndd. For example: # man ndd.

Step 6 Return to your originating procedure (NTP).

DLP-A55 Set Up a Computer for a Corporate LAN Connection 

Step 1 If your computer is connected to the corporate LAN, go to Step 2. If you changed your computer’s 
network settings for craft access to the ONS 15454, change the settings back to the corporate LAN access 
settings. This generally means:

• Set the IP Address on the TCP/IP dialog box back to “Obtain an IP address automatically” (Windows 
95 or 98) or “Obtain an IP address from a DHCP server” (Windows NT 4.0, 2000, or XP). 

• If your LAN requires that DNS or WINS be enabled, change the setting on the DNS Configuration 
or WINS Configuration tab of the TCP/IP dialog box. 

Step 2 If your computer is connected to a proxy server, disable proxy service or add the ONS 15454 nodes as 
exceptions. To disable proxy service, complete one of the following tasks, depending on the web browser 
that you use:

• DLP-A56 Disable Proxy Service Using Internet Explorer (Windows), page 3-20

• DLP-A57 Disable Proxy Service Using Netscape (Windows and UNIX), page 3-20

Step 3 Return to your originating procedure (NTP).

Purpose This task sets up your computer to access the ONS 15454 through a 
corporate LAN.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None
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DLP-A56 Disable Proxy Service Using Internet Explorer (Windows) 

Step 1 From the Start menu, select Settings > Control Panel.

Note If your computer is running Windows XP, you can select Control Panel directly from the Start 
menu. Make sure that you are in Classic View before continuing with this procedure.

Step 2 In the Control Panel window, choose Internet Options.

Step 3 From the Internet Properties dialog box, click Connections > LAN Settings.

Step 4 In the LAN Settings dialog box, complete one of the following tasks:

• Deselect Use a proxy server to disable the service.

• Leave Use a proxy server selected and click Advanced. In the Proxy Setting dialog box under 
Exceptions, enter the IP addresses of ONS 15454 nodes that you will access. Separate each address 
with a semicolon. You can insert an asterisk for the host number to include all the ONS 15454s on 
your network. Click OK to close each open dialog box.

Step 5 Return to your originating procedure (NTP).

DLP-A57 Disable Proxy Service Using Netscape (Windows and UNIX) 

Step 1 Open Netscape.

Step 2 From the Edit menu, choose Preferences.

Step 3 In the Preferences dialog box under Category, choose Advanced > Proxies.

Step 4 On the right side of the Preferences dialog box under Proxies, perform one of the following options:

Purpose This task disables proxy service for PCs running Internet Explorer. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required if your computer is connected to a network computer proxy 
server and your browser is Internet Explorer. 

Onsite/Remote Onsite or remote

Security Level None

Purpose This task disables proxy service for PCs and UNIX workstations running 
Netscape. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required if your computer is connected to a network computer proxy server 
and your browser is Netscape. 

Onsite/Remote Onsite or remote

Security Level None
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• Choose Direct connection to the Internet to bypass the proxy server.

• Choose Manual proxy configuration to add exceptions to the proxy server, then click View. In the 
Manual Proxy Configuration dialog box under Exceptions, enter the IP addresses of the ONS 15454 
nodes that you will access. Separate each address with a comma. Click OK to close each open dialog 
box.

Step 5 Return to your originating procedure (NTP).

DLP-A58 Provision Remote Access to the ONS 15454

Step 1 Connect the modem to the RJ-45 (LAN) port on the TCC+/TCC2 card or to the LAN pins on the 
ONS 15454 backplane.

Step 2 While referring to the modem documentation, complete the following tasks to provision the modem for 
the ONS 15454: 

• For CTC access, set the modem for Ethernet access.

• Assign an IP address to the modem that is on the same subnet as the ONS 15454.

• The IP address the modem assigns to the CTC computer must be on the same subnet as the modem 
and the ONS 15454.

Note For assistance on provisioning specific modems, contact the Cisco Technical Assistance Center.

Step 3 Return to your originating procedure (NTP).

Purpose This task connects an ONS 15454 using a LAN modem.

Tools/Equipment Modem and modem documentation

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

Required/As Needed Required to access the Cisco Transport Controller

Onsite/Remote Onsite or remote

Security Level None
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Step 1 If the computer is not connected to the ONS 15454, complete the“DLP-A59 Connect Computer to the 
ONS 15454” task on page 3-22.

Step 2 Complete the “DLP-A60 Log into CTC” task on page 3-23.

Note For information about navigating in CTC, see Appendix A, “CTC Information and Shortcuts.”

Step 3 As needed, complete the “DLP-A61 Create Login Node Groups” task on page 3-25. Login node groups 
display nodes that are not connected to the login node via DCC.

Step 4 As needed, complete the “DLP-A62 Add a Node to the Current Session or Login Group” task on 
page 3-26.

Stop. You have completed this procedure.

DLP-A59 Connect Computer to the ONS 15454

Step 1 If your computer is set up for a local craft connection, connect a straight-through (Category 5) LAN 
cable from the PC or Solaris workstation network interface card (NIC) to one of the following:

• RJ-45 (LAN) port on the TCC+/TCC2 card

• RJ-45 (LAN) port on a hub or switch to which the ONS 15454 is physically connected

Purpose This procedure logs into the Cisco Transport Controller, the graphical user 
interface software used to manage the ONS 15454. This procedure includes 
optional node login tasks.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

NTP-A22 Set Up CTC Computer to Connect to the ONS 15454, page 3-8

Required/As Needed Required to access the Cisco Transport Controller

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task connects a CTC computer to the ONS 15454.

Tools/Equipment Straight-through (Category 5) LAN cable

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

NTP-A22 Set Up CTC Computer to Connect to the ONS 15454, page 3-8

Required/As Needed Required to access the Cisco Transport Controller

Onsite/Remote Onsite or remote

Security Level None
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Note For instructions on crimping your own straight-through (Category 5) LAN cables, refer to the 
Cisco ONS 15454 Troubleshooting Guide.

Step 2 If your computer is set up for a corporate LAN connection, connect a straight-through (Category 5) LAN 
cable from the PC or Solaris workstation NIC card to a LAN port.

Step 3 Return to your originating procedure (NTP).

DLP-A60 Log into CTC

Note For information about CTC views and navigation, see Appendix A, “CTC Information and Shortcuts.”

Step 1 From the PC connected to the ONS 15454, start Netscape or Internet Explorer.

Step 2 In the Netscape or Internet Explorer web address (URL) field, enter the ONS 15454 IP address. For 
initial setup, this is the default address, 192.1.0.2. (This IP address can be displayed on the LCD. 
Software R4.0 allows suppressing the LCD IP address display.) Press Enter.

Note If you are logging into ONS 15454 nodes running different releases of CTC software, log into 
the node running the most recent release. If you log into a node with an older release, you receive 
an INCOMPATIBLE-SW alarm and the IP address of the login node is displayed instead of the 
node name. To check the software version of a node, select About CTC from the CTC Help 
menu. To resolve an alarm, refer to the Cisco ONS 15454 Troubleshooting Guide.

A Java Console window displays the CTC file download status. The web browser displays information 
about your Java and system environments. If this is the first login, CTC caching messages appear while 
CTC files are downloaded to your computer. The first time you connect to an ONS 15454, this process 
can take several minutes. After the download, the CTC Login dialog box appears (Figure 3-2).

Purpose This task logs into the Cisco Transport Controller, the graphical user 
interface software used to manage the ONS 15454. 

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

NTP-A22 Set Up CTC Computer to Connect to the ONS 15454, page 3-8

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 3-2 Logging into CTC

Step 3 In the Login dialog box, type a user name and password (both are case sensitive). For initial setup, type 
the user name “CISCO15.”

Note The CISCO15 user is provided with every ONS 15454. CISCO15 has superuser privileges, so 
you can create other users. You must create another superuser before you can delete the 
CISCO15 user. CISCO15 is delivered without a password. To create a password for CISCO15, 
click the Provisioning > Security tabs after you log in and change the password. To set up 
ONS 15454 users and assign security, go to the “NTP-A30 Create Users and Assign Security” 
procedure on page 4-4. Additional information is provided in the Cisco ONS 15454 Reference 
Guide.

Step 4 Each time you log into an ONS 15454, you can make selections on the following login options:

• Node Name—Displays the IP address entered in the web browser and a pull-down menu of 
previously entered ONS 15454 IP addresses. You can select any ONS 15454 on the list for the login, 
or you can enter the IP address (or node name) of any new node where you want to log in.

• Additional Nodes—Displays a list of login node groups that are created. To create a login node 
group or add additional groups, see the “DLP-A61 Create Login Node Groups” task on page 3-25.)

Note Topology hosts that were created in previous ONS 15454 releases by modifying the ctc.ini 
(Windows) or .ctcrc (UNIX) files are displayed as a Topology Host group under Additional 
Nodes.

• Disable Network Discovery—Check this box to view only the ONS 15454 (and login node group 
members, if any) entered in the Node Name field. Nodes linked to the node name “ONS 15454” 
through the DCC are not displayed. Using this option can decrease the CTC startup time in networks 
with many DCC-connected nodes. 
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• Disable Circuit Management—Check this box to disable discovery of existing circuits. Using this 
option can decrease the CTC initialization time in networks with many existing circuits. This option 
does not prevent the creation and management of new circuits.

Step 5 Click Login.

If login is successful, the CTC window appears. From here, you can navigate to other CTC views to 
provision and manage the ONS 15454. If you need to perform the initial shelf turn up, see Chapter 4, 
“Turn Up Node.” If login problems occur, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).

DLP-A61 Create Login Node Groups

Step 1 From the Edit menu, choose Preferences.

Step 2 Click Login Node Group and Create Group.

Step 3 Enter a name for the group in the Create Login Group Name dialog box. Click OK.

Step 4 Under Members, type the IP address (or node name) of a node you want to add to the group. Click Add. 
Repeat this step for each node you want to add to the group.

Step 5 Click OK. 

The next time you log into an ONS 15454, the login node group will be available in the Additional Nodes 
list of the Login dialog box. For example, in Figure 3-3, a login node group, “Test Group,” is created 
that contains the IP addresses for Nodes 1, 4, and 5. During login, if you select the Test Group group 
under Additional Nodes and Disable Network Discovery is not selected, all nodes in the figure are 
displayed. If Test Group and Disable Network Discovery are both selected, Nodes 1, 4, and 5 are 
displayed. You can create as many login groups as you need. The groups are stored in the CTC 
preferences file and are not visible to other users.

Purpose This task creates a login node group to display ONS 15454s that have an IP 
connection but not a DCC connection to the login node.

Tools/Equipment None

Prerequisite Procedures NTP-A21 Set Up Computer for CTC, page 3-1

NTP-A22 Set Up CTC Computer to Connect to the ONS 15454, page 3-8

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 3-3 Login Node Group 

Step 6 Return to your originating procedure (NTP).

DLP-A62 Add a Node to the Current Session or Login Group 

Step 1 Log into an ONS 15454 on the network. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions. If you are already logged in, go to Step 2.

Step 2 From the CTC File menu, click Add Node (or click the Add Node button on the toolbar).

Step 3 In the Add Node dialog box, enter the node name (or IP address).

Step 4 If you want to add the node to the current login group, click Add Node to Current Login Group. 
Otherwise, leave it unchecked.

Note The Add Node to Current Login Group check box is active only if you selected a login group 
when you logged into CTC. 

Purpose This task adds a node to the current CTC session or login node group.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

LAN/WAN (Ethernet)

Three node ring Single

Laptop PC

Node 1
IP Address

192.168.106.143

Node 4
IP Address

192.168.105.119

Node 5
IP Address

192.168.104.109

Node 6
IP Address

192.168.103.199

Node 3Node 2

IP Address
192.168.106.100

55
02

9

Two node ring
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Step 5 Click OK. 

After a few seconds, the new node is displayed on the network view map.

Step 6 Return to your originating procedure (NTP).
3-27
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 3      Connect the PC and Log into the GUI
NTP-A23 Log into the ONS 15454 GUI
3-28
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

March 2003
C H A P T E R 4

Turn Up Node

This chapter explains how to provision a single Cisco ONS 15454 node and turn it up for service, 
including node name, date and time, SONET timing references, network attributes such as IP address 
and default router, users and user security, and card protection groups.

Before You Begin
Complete the procedures applicable to your site plan from the following chapters:

• Chapter 1, “Install the Shelf and Backplane Cable”

• Chapter 2, “Install Cards and Fiber-Optic Cable” 

• Chapter 3, “Connect the PC and Log into the GUI”

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A24 Verify Card Installation, page 4-2—Complete this procedure first.

2. NTP-A30 Create Users and Assign Security, page 4-4—Complete this procedure to create CTC 
users and assign their security levels.

3. NTP-A25 Set Up Name, Date, Time, and Contact Information, page 4-6—Continue with this 
procedure to set the node name, date, time, location, and contact information.

4. NTP-A169 Set Up CTC Network Access, page 4-8—Continue with this procedure to provision the 
IP address, default router, subnet mask, and network configuration settings.

5. NTP-A27 Set Up the ONS 15454 for Firewall Access, page 4-18—Continue with this procedure if 
the ONS 15454 will be accessed behind firewalls.

6. NTP-A28 Set Up Timing, page 4-21—Continue with this procedure to set up the node’s SONET 
timing references.

7. NTP-A170 Create Protection Groups, page 4-25—Complete this procedure, as needed, to set up 1:1, 
1:N, 1+1, or Y Cable protection groups for ONS 15454 electrical and optical cards.

8. NTP-A171 Set Up SNMP, page 4-32—Complete this procedure if SNMP will be used for network 
monitoring.
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Step 1 Verify that two TCC+ cards or two TCC2 cards are installed in Slots 7 and 11. 

Step 2 Verify that the green ACT (active) LED is illuminated on one TCC+/TCC2 and the amber STBY 
(standby) LED is illuminated on the second TCC+/TCC2. 

Note If the TCC+/TCC2s are not installed, or their LEDs are not illuminated as described, do not 
proceed. Repeat the “DLP-A36 Install the TCC+/TCC2 Cards” task on page 2-7, or refer to the 
Cisco ONS 15454 Troubleshooting Guide to resolve installation problems before proceeding to 
Step 3.

Step 3 Verify that cross-connect cards (XC, XCVT, or XC10G) are installed in Slots 8 and 10. The 
cross-connect cards must be the same type.

Step 4 Verify that the green ACT (active) LED is illuminated on one cross-connect card and the amber STBY 
(standby) LED is illuminated on the second cross-connect card. 

Note If the cross-connect cards are not installed, or their LEDs are not illuminated as described, do 
not proceed. Repeat the “DLP-A37 Install the XC, XCVT, or XC10G Cards” task on page 2-10, 
or refer to the Cisco ONS 15454 Troubleshooting Manual to resolve installation problems before 
proceeding to Step 5.

Step 5 If your site plan requires an AIC or AIC-I card, verify that the AIC/AIC-I card is installed in Slot 9 and 
its ACT (active) LED displays a solid green light.

Step 6 Verify that electrical cards (DS-1, DS-3, EC-1, and DS3XM-6) are installed in Slots 1 to 4 or 14 to 17 
(multispeed slots) as designated by your installation plan.

Step 7 If your site plan requires an Ethernet card, verify that the Ethernet card is installed in the specified slot 
and its ACT (active) LED displays a solid green light: 

• The E100T-12, E1000-2, and G1000-4 are installed in Slots 1 to 4 or 14 to 17. 

• The G1K-4, ML1000-2 and ML100T-12 cards can be installed in Slots 1 to 6 or 12 to 17 if an 
XC10G cross-connect is installed. However, they must be installed in Slots 5, 6, 12, or 13 
(high-speed slots) if XC or XCVT cards are installed.

Step 8 If Ethernet cards are installed, verify that the correct cross-connect cards are installed in Slots 8 and 10: 

• G1000-4 cards require XC10G cards. 

Purpose This procedure verifies that the ONS 15454 node is ready for turn up.

Tools/Equipment An engineering work order, site plan, or other document specifying the 
ONS 15454 card installation.

Prerequisite Procedures Chapter 1, “Install the Shelf and Backplane Cable”

Chapter 2, “Install Cards and Fiber-Optic Cable”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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• G1K-4, ML1000-2 and ML100T-12 cards require XC10G cards if they are installed in Slots 1 to 4 
or 14 to 17.

Step 9 If a E1000-2, E1000-2-G, G1000-4, or ML1000-2 Ethernet card is installed, verify that it has a gigabit 
interface converter (GBIC) installed. If not, see the “DLP-A469 Install GBIC or SFP Connectors” task 
on page 2-18.

Step 10 Verify that OC-N cards (OC-3, OC-3-8, OC-12, OC-12-4, OC-48, OC-48 any slot (AS), and OC-192) 
are installed in the slots designated by your site plan. 

• OC-3, OC-12, and OC-48 AS cards can be installed in Slots 1 to 6 or 12 to 17. 

• OC-3-8 and OC-12-4 can only be installed in Slots 1 to 4 and 14 to 17.

• OC-48 and OC-192 can only be installed in Slots 5, 6, 12, or 13.

Step 11 If OC-N cards are installed, verify that the correct cross-connect cards are installed in Slots 8 and 10: 

• If an OC-192 or a OC-12-4 card is installed, an XC10G card must be installed.

• If an OC-48 AS card is installed in Slots 1-4 or 14-17, an XC10G card must be installed. If XC or 
XCVT cards are installed, the OC-48 AS can be installed only in Slots 5, 6, 12, or 13.

Step 12 Verify that all installed OC-N cards display a solid amber STBY LED.

Step 13 Verify that fiber-optic cables are installed and connected to the locations indicated in the site plan. If the 
fiber-optic cables are not installed, complete the “NTP-A19 Install the Fiber-Optic Cables” procedure 
on page 2-24.

Step 14 Verify that fiber is routed correctly in the shelf assembly and fiber boots are installed properly. If the 
fiber is not routed on the shelf assembly, complete the “DLP-A46 Route Fiber-Optic Cables” task on 
page 2-35. If the fiber boots are not installed, complete the “DLP-A45 Install the Fiber Boot” task on 
page 2-34.

Step 15 Verify that the software release shown on the LCD matches the software release indicated in your site 
plan. If the release does not match, perform one of the following procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD. Refer to the Cisco ONS 15454 
Software Upgrade Guide for instructions.

• Replace the TCC+/TCC2 cards with cards containing the correct release (see the “NTP-A116 
Remove and Replace a Card” procedure on page 2-21).

Step 16 Continue with the “NTP-A25 Set Up Name, Date, Time, and Contact Information” procedure on 
page 4-6.

Stop. You have completed this procedure.
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NTP-A30 Create Users and Assign Security

Step 1 Log into the ONS 15454 node where you need to create users. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions.

Note You must log in as a Superuser to create additional users. The CISCO15 user provided with each 
ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one 
ONS 15454.

Step 2 Complete the “DLP-A74 Create a New User - Single Node” task on page 4-4 or the “DLP-A75 Create a 
New User - Multiple Nodes” task on page 4-5 as needed.

Note You must add the same user name and password to each node a user will access.

Step 3 If you want to modify the security policy settings, complete the “NTP-A205 Modify Users and Change 
Security” procedure on page 10-21.

Stop. You have completed this procedure.

DLP-A74 Create a New User - Single Node

Step 1 Click the Provisioning > Security > Users tabs.

Step 2 In the Security window, click Create.

Purpose Use this procedure to create ONS 15454 users and assign their security 
levels.

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose Use this task to create a new user for one ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required to add users to a node, although users can be added using TL1.

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 3 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 6-10 
characters, and the first character must be an alpha character.

• Password—Type the user password. The password must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) and special characters (+, #, %), where at least two characters are 
non-alphabetic and at least one character is a special character. For TL1 compatibility, the password 
must be 6 to 10 characters, and the first character must be an alpha character. The password must 
not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. Refer to the Cisco ONS 15454 Reference Manual for 
information about the capabilities provided with each level.

Note The idle time is the length of time that CTC can remain idle before it locks up and the password 
must be reentered. Each security level has a different idle time: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-A75 Create a New User - Multiple Nodes

Note All nodes where you want to add users must be accessible in network view.

Step 1 In node view, choose Go to Network View.

Step 2 Click the Provisioning > Security > users tabs.

Step 3 In the Security window, click Create.

Step 4 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must have no more 
than 10 characters, and the first character must be an alpha character.

Purpose Add a new user to multiple ONS 15454s.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Password—Type the user password. The password must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) and special characters (+, #, %), where at least two characters are 
non-alphabetic and at least one character is a special character. For TL1 compatibility, the password 
must be 6 to 10 characters, and the first character must be an alpha character. The password must 
not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. Refer to the Cisco ONS 15454 Reference Manual for 
information about the capabilities provided with each level.

Note The idle time is the length of time that CTC can remain idle before it locks up and the password 
must be reentered. Each security level has a different idle time: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes.

Step 5 Under “Select applicable nodes,” deselect any nodes where you do not want to add the user (all network 
nodes are selected by default).

Step 6 Click OK.

Step 7 In the User Creation Results dialog box, click OK.

Step 8 Return to your originating procedure (NTP).

NTP-A25 Set Up Name, Date, Time, and Contact Information

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23 for the node you will turn up.

Step 2 Click the Provisioning > General tabs.

Step 3 Enter the following information in the fields listed:

• Node Name—Type a name for the node. For TL1 compliance, names must begin with an alpha 
character and have no more than 20 alphanumeric characters.

• Contact—Type the name of the node contact person and the phone number, up to 255 characters 
(optional).

• Latitude—Enter the node latitude: N (North) or S (South), degrees, and minutes (optional).

• Longitude—Enter the node longitude: E (East) or W (West), degrees, and minutes (optional).

Purpose This procedure provisions identification information for the node, 
including the node name, a contact name and phone number, the location 
of the node, and the date, time, and time zone. 

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Tip You can also position nodes manually on the network view map. Press Ctrl while you drag and drop the 
node icon. To create the same network map visible for all ONS 15454 users, complete the “NTP-A172 
Create a Logical Network Map” procedure on page 5-3.

CTC uses the latitude and longitude to position ONS 15454 icons on the network view map. To 
convert a coordinate in degrees to degrees and minutes, multiply the number after the decimal by 
60. For example, the latitude 38.250739 converts to 38 degrees, 15 minutes (.250739 x 60 = 15.0443, 
rounded to the nearest whole number).

• Description—Type a description of the node. The description can be a maximum of 255 characters. 

• Use NTP/SNTP Server—When checked, CTC uses a Network Time Protocol (NTP) or Simple 
Network Time Protocol (SNTP) server to set the date and time of the node. 

If you do not use an SNTP or NTP server, complete the Date and Time fields. The ONS 15454 will 
use these fields for alarm dates and times. (CTC displays all alarms in the login node’s time zone 
for cross network consistency.)

Note Using an NTP or SNTP server ensures that all ONS 15454 network nodes use the same date and 
time reference. The server synchronizes the node’s time after power outages or software 
upgrades.

If you select the Use NTP/SNTP Server check box, type the IP address of either:

– An NTP/SNTP server, or 

– The IP address of another ONS 15454 with NTP/SNTP Server enabled. 

If you check Enable Firewall for the ONS 15454 proxy server (see “DLP-A249 Provision IP 
Settings” task on page 4-9), external ONS 15454s must reference the gateway ONS 15454 for 
NTP/SNTP timing. For more information about the ONS 15454 gateway settings, refer to the Cisco 
ONS 15454 Reference Manual.

Caution If you reference another ONS 15454 for the NTP/SNTP server, make sure the second ONS 15454 
references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing 
loop by having two ONS 15454s reference each other).

• Date—If the Use NTP/SNTP Server check box is not selected, type the current date in the format 
mm/dd/yyyy, for example, September 24, 2002 is 09/24/2002.

• Time—If Use NTP/SNTP Server is not selected, type the current time in the format hh:mm:ss, for 
example, 11:24:58. The ONS 15454 uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.

• Time Zone—Click the field and choose a city within your time zone from the popup menu. The 
menu displays the 80 World Time Zones from -11 through 0 (GMT) to +14. Continental United 
States time zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07 (Mountain), and 
GMT-08 (Pacific).

Step 4 Click Apply.

Step 5 On the confirmation dialog box, click Yes.
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Step 6 Review the node information. If you need to make corrections, repeat Steps 3 through 5 to enter the 
corrections. If the information is correct, continue with the “NTP-A169 Set Up CTC Network Access” 
procedure on page 4-8.

Stop. You have completed this procedure.

NTP-A169 Set Up CTC Network Access

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-A249 Provision IP Settings” task on page 4-9 to provision the ONS 15454 IP 
address, subnet mask, default router, Dynamic Host Configuration Protocol (DHCP) server, IIOP listener 
port, and proxy server settings.

Tip If you cannot log into the node, you may be able to change its IP address, default router and network 
mask by using the LCD on the ONS 15454 fan-tray assembly. See the “DLP-A64 Set the IP Address, 
Default Router, and Network Mask Using the LCD” task on page 4-12 for instructions. However, you 
cannot use the LCD to provision any other network settings.

Step 3 If static routes are needed, complete the “DLP-A65 Create a Static Route” task on page 4-14. Refer to 
the Cisco ONS 15454 Reference Manual for further information about static routes.

Step 4 If the ONS 15454 is connected to a LAN or WAN that uses OSPF, complete the “DLP-A250 Set Up or 
Change Open Shortest Path First Protocol” task on page 4-15.

Step 5 If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-A251 Set Up or 
Change Routing Information Protocol” task on page 4-17.

Stop. You have completed this procedure.

Purpose Use this procedure to provision network access for a node, including its 
subnet mask, default router, Dynamic Host Configuration Protocol 
(DHCP) server, IIOP listener port, proxy server settings, static routes, open 
shorted path first (OSPF) protocol, and routing information protocol (RIP).

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A249 Provision IP Settings

Caution All network changes should be approved by your network (or LAN) administrator.

Step 1 If you are in network view, switch to node view by double-clicking the node you want to turn up on the 
network map. 

Step 2 Click the Provisioning > Network tabs.

Step 3 Complete the following information in the fields listed:

• IP Address—Type the IP address assigned to the ONS 15454 node.

• Suppress CTC IP Display—Select this check box if you want to prevent the node IP address from 
being displayed in CTC to users with Provisioner, Maintenance, or Retrieve security levels. (The IP 
address suppression will not be applied to users with Superuser security level.)

• LCD IP Display—Choose one of the following:

– Allow Configuration—Displays the node IP on the LCD and allows users to change the IP 
address using the LCD, that is, this option enables the “DLP-A64 Set the IP Address, Default 
Router, and Network Mask Using the LCD” task on page 4-12.

– Display Only—Displays the node IP address on the LCD but does not allow users to change the 
IP address using the LCD.

– Suppress Display—Suppresses the node IP address display on the LCD.

• Default Router—If the ONS 15454 must communicate with a device on a network that the ONS 
15454 is not connected to, the ONS 15454 may forward the packets to the default router. Type the 
IP address of the router in this field. 

Note This field is ignored if the node is not connected to a LAN, or if you enable any of the Gateway 
Settings to implement the ONS 15454 proxy server feature.

• Forward DHCP Request To—Select this check box to enable Dynamic Host Configuration Protocol 
(DHCP). Also, enter the DHCP server IP address in the Request To field. Unchecked is the default. 
If you will enable any of the gateway settings to implement the ONS 15454 proxy server features, 
leave this field blank.

Note If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP 
addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it 
does not act as a DHCP server.

Purpose This task provisions IP settings, which includes the IP address, default 
router, DHCP access, firewall access, and proxy server settings for an ONS 
15454 node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• MAC Address—(read only) Displays the ONS 15454 IEEE 802 Media Access Control (MAC) 
address.

• Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet 
mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is 
the same for all ONS 15454s in the same subnet.

• TCC CORBA (IIOP) Listener Port—Provisions the ONS 15454 IIOP listener port. This listener port 
enables communication with the ONS 15454 through firewalls. See the 
“NTP-A27 Set Up the ONS 15454 for Firewall Access” procedure on page 4-18 for more 
information.

• Gateway Settings—Provides three check boxes that enable the ONS 15454 proxy server features. 
Do not enable any of the check boxes until you review the proxy server scenario in the Cisco ONS 
15454 Reference Manual. In proxy server networks, the ONS 15454 will be either a gateway 
network element (GNE) or external network element (ENE). Provisioning must be consistent for 
each NE type.

– Craft Access Only— If checked, the CTC computer is only visible to the ONS 15454 that the 
CTC computer is connected to. The computer is not visible to other DCC-connected nodes. This 
box is normally checked for external NEs and not checked for gateway NEs. If Craft Access 
Only is checked, Enable Proxy must be selected in order for the directly connected PC to have 
visibility to DCC-connected nodes. 

– Enable Proxy—If checked, the ONS 15454 responds to CTC requests with a list of 
DCC-connected nodes for which the node serves as a proxy. Gateway and external NEs within 
a proxy server network should have this box checked.

– Enable Firewall—If checked, the node prevents IP traffic from being routed between the DCC 
and the LAN port. Gateway and external NEs within a proxy server network should have this 
box checked. If Enable Firewall is checked, Enable Proxy must be selected in order for the 
directly connected PC to have visibility to DCC-connected nodes.

Step 4 Click Apply.

Step 5 Click Yes on the confirmation dialog box.

Both TCC+/TCC2 cards will reboot, one at a time. During this time (approximately 10 to 15 minutes), 
the active and standby TCC+/TCC2 card LEDs will go through the cycle shown in Table 4-1. Eventually, 
a “Lost node connection, switching to network view” message is displayed.
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Step 6 Click OK. CTC displays the network view. The node icon is displayed in grey, during which time you 
cannot access the node.

Step 7 Double-click the node icon when it becomes green. 

Step 8 Return to your originating procedure (NTP). 

Table 4-1 LED Behavior During TCC+/TCC2 Reboot

Active TCC+/TCC2 LEDs Standby TCC+/TCC2 LEDs Reboot Activity

ACT/STBY: flashing green 1. ACT/STBY: flashing yellow

2. FAIL LED: solid red 

3. FAIL LED: flashing red 

4. Alarm LEDs: flash once

5. ACT/STBY: flashing yellow

6. All LEDs: turn off (1-2 minutes)

7. ACT/STBY: solid yellow

8. ACT/STBY: Solid green

Standby TCC+/TCC2 card updated 
with new network information

1. FAIL LED: solid red 

2. FAIL LED: flashing red 

3. Alarm LEDs: flash once

4. ACT/STBY: flashing yellow

5. All LEDs: turn off (1-2 minutes) CTC 
displays “Lost node connection, 
switching to network view” message

6. ACT/STBY: solid yellow

ACT/STBY: solid green Active TCC+/TCC2 updated with new 
network information 

If an AIC or AIC-I card is installed, 
AIC FAIL and alarm LEDS light up 
briefly when the AIC is updated 

ACT/STBY: solid yellow ACT/STBY: solid green The backup TCC+/TCC2 becomes the 
active TCC+/TCC2
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DLP-A64 Set the IP Address, Default Router, and Network Mask Using the LCD

Note You cannot perform this task if the LCD IP Display on the node view Provisioning > Network tab is set 
to Display Only or Suppress Display. See “DLP-A249 Provision IP Settings” task on page 4-9 to view 
or change the LCD IP Display field.

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until Node appears on the LCD.

Step 2 Repeatedly press the Port button until the following displays:

• To change the node IP address, Status=IpAddress (Figure 4-1)

• To change the node network mask, Status=Net Mask

• To change the default router IP address, Status=Default Rtr

Figure 4-1 Selecting the IP Address Option

Step 3 Press the Status button to display the node IP address (Figure 4-2), the node subnet mask length, or the 
default router IP address.

Figure 4-2 Changing the IP Address

Step 4 Push the Slot button to move to the IP address or subnet mask digit you need to change. The selected 
digit flashes.

Purpose Use this task to change the ONS 15454 IP address, default router, and 
network mask using the LCD on the fan-tray assembly. Use this task if you 
cannot log into CTC.

Tools/Equipment None

Prerequisite Procedures DLP-A36 Install the TCC+/TCC2 Cards, page 2-7

Required/As Needed Optional

Onsite/Remote Onsite

Security Level None

FAN FAIL

Slot

Slot-0
Status=IpAddress

44
08

9CRIT MAJ MIN

Status Port

FAN FAIL

Slot

172.020.214.107
<Next   Done      Mod>

44
09

0CRIT MAJ MIN

Status Port
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Tip The Slot, Status, and Port button positions correspond to the command position on the LCD. For 
example, in Figure 4-2, you press the Slot button to invoke the Next command and the Port button to 
invoke the Done command.

Step 5 Press the Port button to cycle the IP address or subnet mask to the correct digit.

Step 6 When the change is complete, press the Status button to return to the Node menu.

Step 7 Repeatedly press the Port button until the Save Configuration option appears (Figure 4-3).

Figure 4-3 Selecting the Save Configuration Option 

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 4-4).

Figure 4-4 Saving and Rebooting the TCC+/TCC2

Step 9 Press the Slot button to apply the new IP address configuration or press Port to cancel the configuration.

Saving the new configuration causes the TCC+/TCC2 cards to reboot. During the reboot, a “Saving 
Changes - TCC Reset” message displays on the LCD. The LCD returns to the normal alternating display 
after the TCC+/TCC2 reboot is complete (see Table 4-1 on page 4-11 for reboot behavior).

Note The IP address and default router must be on the same subnet. If not, you cannot apply the 
configuration. 

Step 10 Return to your originating procedure (NTP).

FAN FAIL

Slot

Slot-0
Status=Save Cfg.

44
09

1CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Save and REBOOT?
<Apply            Revert>

44
09

2CRIT MAJ MIN

Status Port
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DLP-A65 Create a Static Route

Step 1 From the View menu in node view click Go to Network View.

Step 2 Click the Provisioning > Network tabs.

Step 3 Click the Static Routing tab. Click Create.

Step 4 In the Create Static Route dialog box enter the following: 

• Destination—Enter the IP address of the computer running CTC. To limit access to one computer, 
enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on 
the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a 
destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

• Mask—Enter a subnet mask. If the destination is a host route (i.e., one CTC computer), enter a 32-bit 
subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask accordingly, 
for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a subnet mask 
of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

• Next Hop—Enter the IP address of the router port or the node IP address if the CTC computer is 
connected to the node directly.

• Cost—Enter the number of hops between the ONS 15454 and the computer. 

Step 5 Click OK. Verify that the static route displays in the Static Route window.

Note Static route networking examples are provided in the IP networking section of the Cisco ONS 
15454 Reference Manual.

Step 6 Return to your originating procedure (NTP).

Purpose Use this task to create a static route to establish CTC connectivity to a 
computer on another network.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required if either of the following is true: 

You need to connect ONS 15454s to CTC sessions on one subnet connected 
by a router to ONS 15454s residing on another subnet when OSPF is not 
enabled, and the Enable Proxy box is not checked, or

You need to enable multiple CTC sessions among ONS 15454s residing on 
the same subnet and the Craft Access Only feature is not enabled.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A250 Set Up or Change Open Shortest Path First Protocol

Step 1 In node view, click the Provisioning > Network > OSPF tabs.

Step 2 On the top left side of the OSPF pane, complete the following:

• DCC/GCC OSPF Area ID Table—In dotted decimal format, enter the number that identifies the 
ONS 15454s as a unique OSPF area ID. The Area ID can be any number between 000.000.000.000 
and 255.255.255.255, but must be unique to the LAN OSPF area.

• DCC Metric—This value is normally unchanged. It sets a “cost” for sending packets across the 
DCC, which is used by OSPF routers to calculate the shortest path. This value should always be 
higher than the LAN metric. The default DCC metric is 10. The metric changes to 100 if you check 
the OSPF Active on LAN check box in Step 3.

Step 3 Under OSPF on LAN, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to 
OSPF routers on the LAN. Enable this field on ONS 15454s that directly connect to OSPF routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the 
ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the 
following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. On the Edit Authentication Key dialog box, complete the following:

– Type—choose Simple Password.

– Enter Authentication Key—Enter the password.

– Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings:

The OSPF priority and intervals default to values most commonly used by OSPF routers. In the Priority 
and Intervals area, verify that these default values match those used by the OSPF router where the ONS 
15454 is connected.

• Router Priority—Selects the designated router for a subnet.

Purpose Use this task to enable the Open Shortest Path First (OSPF) routing 
protocol on the ONS 15454. Perform this task if you want to include the 
ONS 15454 in OSPF-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

You will need the OSPF Area ID, Hello and Dead intervals, and 
authentication key (if OSPF authentication is enabled) provisioned on the 
router to which the ONS 15454 is connected.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Hello Interval (sec)—Sets the number of seconds between OSPF “hello” packet advertisements sent 
by OSPF routers. Ten seconds is the default.

• Dead Interval—Sets the number of seconds that will pass while an OSPF router’s packets are not 
visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Indicates the service speed. One second is the default.

• Retransmit Interval (sec)—Sets the time that will elapse before a packet is resent. Five seconds is 
the default.

• LAN Metric—Sets a “cost” for sending packets across the LAN. This value should always be lower 
than the DCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note Area range tables consolidate the information that is outside an OSPF Area border. One 
ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table 
on this node points the router to the other nodes that reside within the ONS 15454 OSPF area. 

a. Under OSPF Area Range Table, click Create.

b. In the Create Area Range dialog box, enter the following:

– Range Address—Enter the area IP address for the ONS 15454s that reside within the OSPF area. 
For example, if the ONS 15454 OSPF area includes nodes with IP addresses 10.10.20.100, 
10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 10.10.0.0.

– Range Area ID—Enter the OSPF area ID for the ONS 15454s. This is either the ID in the DCC 
OSPF Area ID field or the ID in the Area ID for LAN Port field.

– Mask Length—Enter the subnet mask length. In the Range Address example, this is 16. 

– Advertise—Check if you want to advertise the OSPF range table.

c. Click OK.

Step 7 All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected 
to Area 0, use the following steps to create a virtual link table that will provide the disconnected area 
with a logical path to Area 0:

a. Under OSPF Virtual Link Table, click Create.

b. In the Create Virtual Link dialog box, complete the following fields (OSPF settings must match 
OSPF settings for the ONS 15454 OSPF area):

– Neighbor—The router ID of the Area 0 router.

– Transit Delay (sec)—The service speed. One second is the default.

– Hello Int (sec)—The number of seconds between OSPF “hello” packet advertisements sent by 
OSPF routers. Ten seconds is the default.

– Auth Type—If the router where the ONS 15454 is connected uses authentication, choose 
Simple Password. Otherwise, choose No Authentication.

– Retransmit Int (sec)—Sets the time that will elapse before a packet is resent. Five seconds is the 
default.

– Dead Int (sec)—Sets the number of seconds that will pass while an OSPF router’s packets are 
not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click OK.
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Step 8 After entering ONS 15454 OSPF area data, click Apply.

If you changed the Area ID, the TCC+/TCC2 cards will reset, one at a time. The reset will take 
approximately 10-15 minutes. Table 4-1 on page 4-11 shows the LED behavior during the TCC+/TCC2 
reset. 

Step 9 Return to your originating procedure (NTP).

DLP-A251 Set Up or Change Routing Information Protocol

Step 1 In node view, click the Provisioning > Network > RIP tabs. 

Step 2 Check the RIP Active check box if you are activating RIP. 

Step 3 Choose either RIP Version 1 or RIP Version 2 from the pull-down menu, depending on which version is 
supported in your network. 

Step 4 Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number 
of hops. 

Step 5 By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires 
authentication, complete the following steps. If not, continue with Step 6.

a. Click the No Authentication button.

b. On the Edit Authentication Key dialog box, complete the following:

– Type—Choose Simple Password.

– Enter Authentication Key—Enter the password, 

– Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 6 If you want to complete an address summary, complete the following steps. If not, the task is complete. 
Continue with Step 7. Complete the address summary only if the ONS 15454 is a gateway NE with 
multiple external ONS 15454 NEs attached with IP addresses in different subnets.

a. Under RIP Address Summary, click Create.

b. On the Create Address Summary dialog box, complete the following:

Purpose Use this task to enable routing information protocol (RIP) on the 
ONS 15454. Perform this task if you want to include the ONS 15454 in 
RIP-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

You need to create a static route to the router adjacent to the ONS 15454 
for the ONS 15454 to communicate its routing information to non 
DCC-connected nodes.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– Summary Address—Enter the summary IP address.

– Mask Length—Enter the subnet mask length using the up/down arrows.

– Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.

c. Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-A27 Set Up the ONS 15454 for Firewall Access
If an ONS 15454 or CTC computer resides behind a firewall that uses port filtering, you must enable an 
Internet Inter-ORB Protocol (IIOP) port on the ONS 15454 and/or CTC computer, depending on whether 
one or both devices reside behind a firewall. 

Figure 4-5 shows ONS 15454s in a protected network and the CTC computer in an external network. For 
the computer to access the ONS 15454s, you must provision the IIOP listener port specified by your 
firewall administrator on the ONS 15454. The ONS 15454 sends the port number to the CTC computer 
during the initial contact between the devices using Hyper-Text Transfer Protocol (HTTP). After the 
CTC computer obtains the ONS 15454 IIOP port, the computer opens a direct session with the node 
using the specified IIOP port. 

Figure 4-5 ONS 15454s Residing Behind a Firewall

Figure 4-6 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the ONS 
15454, you must provision the IIOP port on the CTC computer and on the ONS 15454. Each firewall can 
use a different IIOP port. For example, if the CTC computer firewall uses IIOP port 4000, and the ONS 
15454 firewall uses IIOP port 5000, 4000 is the IIOP port you provision for the CTC computer and 5000 
is the IIOP port you provision for the ONS 15454.
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Figure 4-6 A CTC Computer and ONS 15454s Residing Behind Firewalls

Step 1 Log into a node that is behind the firewall. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions.

Step 2 If the ONS 15454 resides behind a firewall, complete the “DLP-A67 Provision the IIOP Listener Port on 
the ONS 15454” task on page 4-19.

Step 3 If the CTC computer resides behind a firewall, complete the “DLP-A68 Provision the IIOP Listener Port 
on the CTC Computer” task on page 4-21.

Stop. You have completed this procedure.

DLP-A67 Provision the IIOP Listener Port on the ONS 15454

Step 1 Click the Provisioning > Network tabs.

Purpose This procedure provisions ONS 15454s and CTC computers for access 
through firewalls.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Purpose Use this task to set the IIOP listener port on the ONS 15454, which enables 
you to access ONS 15454s that reside behind a firewall.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 On the General subtab under TCC CORBA (IIOP) Listener Port, choose a listener port option:

• Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454s on the same side of the firewall 
or if no firewall is used (default). This option can be used for access through a firewall if Port 57790 
is open.

• Standard Constant—Uses Port 683, the CORBA default port number

• Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall administrator. 
The port cannot use any of the ports shown in Table 4-2.

Step 3 Click Apply.

Step 4 When the Change Network Configuration message appears, click Yes. 

Both ONS 15454 TCC+/TCC2s will reboot, one at a time. The reboot will take approximately 15 
minutes. See Table 4-1 on page 4-11.

Step 5 Return to your originating procedure (NTP).

Table 4-2 Ports Used by the TCC+/TCC2 Cards

Port Function

0 Never used

21 FTP control

23 TELNET

80 HTTP

111 rpc (not used; but port is in use)

513 rlogin (not used; but port is in use)

=<1023 Default CTC listener ports

1080 Proxy server

2001-2017 I/O card telnet

2018 DCC processor on active TCC+/TCC2

2361 TL1

3082 TL1

3083 TL1

5001 BLSR server port

5002 BLSR client port

7200, 7209, 
7210

SNMP input port

9100 EQM port

9101 EQM port 2

9401 TCC+/TCC2 boot port

9999 Flash manager

57790 Default TCC+/TCC2 listener port
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DLP-A68 Provision the IIOP Listener Port on the CTC Computer

Step 1 In node view, from the Edit menu, choose Preferences.

Step 2 On the Preferences dialog box, click the Firewall tab.

Step 3 Under CTC CORBA (IIOP) Listener Port, choose a listener port option:

• Default - Variable—Used to connect to ONS 15454s from within a firewall or if no firewall is used 
(default)

• Standard Constant—Uses Port 683, the CORBA default port number

• Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator

Step 4 Click Apply. A warning is displayed telling you that the port change will apply during the next CTC 
login.

Step 5 Click OK. 

Step 6 On the Preferences dialog box, click OK.

Step 7 To access the ONS 15454 using the IIOP port, log out of CTC (from the File menu, select Exit) then log 
back in.

Step 8 Return to your originating procedure (NTP).

NTP-A28 Set Up Timing

Step 1 Log into the ONS 15454 node where you want to set up timing. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the“DLP-A69 Set Up External or Line Timing” task on page 4-22 if an external BITS source 
is available. This is the common SONET timing setup procedure. 

Purpose Use this task to select the IIOP listener port on CTC.

Tools/Equipment IIOP listener port number from LAN or firewall administrator.

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-23 

Required/As Needed Required only if the computer running CTC resides behind a firewall.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this procedure to provision the ONS 15454 timing.

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Complete the“DLP-A70 Set Up Internal Timing” task on page 4-24 if you cannot complete Step 2 (an 
external BITS source is not available). This task can only provide Stratum 3 timing. 

Note For information about SONET timing, refer to the Cisco ONS 15454 Reference Manual or to 
Telcordia GR-253-CORE.

Stop. You have completed this procedure.

DLP-A69 Set Up External or Line Timing

Step 1 On the node view, click the Provisioning > Timing tabs.

Step 2 Under General Timing, complete the following information:

• Timing Mode—Choose External if the ONS 15454 derives its timing from a BITS source wired to 
the backplane pins; choose Line if timing is derived from an OC-N card that is optically connected 
to the timing node. A third option, Mixed, allows you to set external and line timing references.

Note Because Mixed timing may cause timing loops, Cisco does not recommend its use. Use this 
mode with care.

• SSM Message Set—Choose the message set level supported by your network. If a Generation 1 node 
receives a Generation 2 message, the message will be mapped down to the next available 
Generation 1. For example, an ST3E message becomes an ST3.

• Quality of RES—If your timing source supports the reserved S1 byte, set the timing quality here. 
(Most timing sources do not use RES.) Qualities are displayed in descending quality order as ranges. 
For example, ST3<RES<ST2 means the timing reference is higher than a Stratum 3 and lower than 
a Stratum 2. Refer to the Cisco ONS 15454 Reference Manual for more information about SSM, 
including definitions of the SONET timing levels.

• Revertive—Select this check box if you want the ONS 15454 to revert to a primary reference source 
after the conditions that caused it to switch to a secondary timing reference are corrected. 

• Revertive Time—If Revertive is checked, choose the amount of time the ONS 15454 will wait before 
reverting to its primary timing source. Five minutes is the default.

Purpose Use this task to define the SONET timing source (external or line) for the 
ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Under BITS Facilities, complete the following information:

Note The BITS Facilities section sets the parameters for your BITS1 and BITS2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• State—For line-timed nodes with no equipment timed through BITS Out, set State to OOS (Out of 
Service). For nodes using external timing or line timing with equipment timed through BITS Out, 
set State to IS (In Service).

Step 4 If the state is set to OOS, continue with Step 5. If the state is set to IS, complete the following 
information:

• Coding—Set to the coding used by your BITS reference, either B8ZS or AMI.

• Framing—Set to the framing used by your BITS reference, either ESF (Extended Super Frame, or 
SF (D4) (Super Frame). 

• Sync Messaging—Check to enable SSM. SSM is not available if Framing is set to Super Frame.

• AIS Threshold—If SSM is disabled or Super Frame is used, set the quality level where a node sends 
an alarm indication signal (AIS) from the BITS 1 Out and BITS 2 Out backplane pins. An AIS is 
raised when the optical source for the BITS reference falls to or below the SSM quality level defined 
in this field.

• LBO—If you are timing an external device connected to the BITS Out pins, set the distance between 
the deviceand the ONS 15454. Options are: 0-133 ft. (default), 124-266 ft., 267-399 ft., 400-533 ft., 
and 534-655 ft.

Step 5 Under Reference Lists, complete the following information:

Note Reference Lists defines up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane. If you attach equipment to BITS Out 
pins, you normally attach it to a node with Line mode because equipment near the external 
timing reference can be directly wired to the reference. 

• NE Reference—Allows you to define three timing references (Ref 1, Ref 2, Ref 3). The node uses 
Reference 1 unless a failure occurs to that reference, in which case the node uses Reference 2. If 
Reference 2 fails the node uses Reference 3, which is typically set to Internal Clock. Reference 3 is 
the Stratum 3 clock provided on the TCC+/TCC2. The options displayed depend on the Timing 
Mode setting. 

– If the Timing Mode is set to External, your options are BITS1, BITS2, and Internal Clock.

– If the Timing Mode is set to Line, your options are the node’s working OC-N cards and Internal 
Clock. Choose the cards/ports that are directly or indirectly connected to the node wired to the 
BITS source, that is, the node’s trunk (span) cards. Set Reference 1 to the trunk card that is 
closest to the BITS source. For example, if Slot 5 is connected to the node wired to the BITS 
source, choose Slot 5 as Reference 1.

– If the Timing Mode is set to Mixed, both BITS and OC-N cards are available, allowing you to 
set a mixture of external BITS and OC-N trunk cards as timing references.
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• BITS 1 Out/BITS 2 Out—Define the timing references for equipment wired to the BITS Out 
backplane pins. Normally, BITS Out is used with line-timed nodes, so the options displayed are the 
working OC-N cards. BITS 1 and BITS 2 Out are enabled when BITS-1 and BITS-2 facilities are 
placed in service.

Step 6 Click Apply.

Note Refer to the Cisco ONS 15454 Troubleshooting Guide for timing-related alarms. 

Step 7 Return to your originating procedure (NTP).

DLP-A70 Set Up Internal Timing

Caution Internal timing is Stratum 3 and not intended for permanent use. All ONS 15454s should be timed to a 
Stratum 2 or better primary reference source. 

Step 1 Click the Provisioning > Timing tabs.

Step 2 Under General Timing, enter the following:

• Timing Mode—Set to External

• SSM Message Set—Set to Generation 1

• Quality of RES—Not applicable to internal timing; ignore

• Revertive—Not applicable to internal timing; ignore

• Revertive Time—Not applicable to internal timing; ignore

Step 3 Under BITS Facilities, change State to OOS (Out of Service). Disregard the other BITS Facitlities 
settings; they are not relevant to internal timing.

Step 4 Under Reference Lists, enter the following information:

• NE Reference 

– Ref 1—Set to Internal Clock

– Ref 2—Set to Internal Clock

– Ref 3—Set to Internal Clock

• BITS 1 Out/BITS 2 Out—Set to None

Step 5 Click Apply.

Step 6 Log into a node that will be timed from the node set up in Steps 1 to 5. 

Purpose Use this task to set up internal timing (Stratum 3) for an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed (use only if a BITS source is not available) 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Click the Provisioning > Timing tabs.

Step 8 In the General Timing section, enter the same information as entered in Step 2 with the following 
exceptions:

• Timing Mode—Set to Line

Reference Lists

• NE Reference 

– Ref1—Set to the OC-N trunk (span) card with the closest connection to the node in Step 3

– Ref 2—Set to the OC-N trunk (span) card with the next closest connection to the node in Step 3

– Ref 3—Set to Internal Clock

Step 9 Click Apply.

Step 10 Repeat Steps 6 to 9 at each node that will be timed by the node in Step 3.

Step 11 Return to your originating procedure (NTP).

NTP-A170 Create Protection Groups

Step 1 Log into the ONS 15454 node where you want to create the protection group. See the “DLP-A60 Log 
into CTC” task on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Complete one or more of the following tasks depending on the protection group(s) you want to create:

• DLP-A71 Create a 1:1 Protection Group, page 4-27

• DLP-A72 Create a 1:N Protection Group, page 4-28

• DLP-A73 Create a 1+1 Protection Group, page 4-29

• DLP-A252 Create a Y Cable Protection Group, page 4-31

Note Table 4-3 describes the protection types available on the ONS 15454. 

Purpose Use this procedure to create ONS 15454 card protection groups.

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed Required; some network information is optional, depending on your site 
plan

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Stop. You have completed this procedure.

Table 4-3 Card Protection Types

Type Cards Description and Installation Requirements

1:1 DS1-14 

DS3-12

DS3-12E

EC1-12

DS3XM-6

Pairs one working card with one protect card. The protect card 
should be installed in an odd-numbered slot and the working card in 
an even-numbered slot next to the protect slot towards the 
TCC+/TCC2, for example: protect in Slot 1, working in Slot 2; 
protect in Slot 3, working in Slot 4; protect in Slot 15, working in 
Slot 14.

1:N DS1N-14 

DS3N-12

DS3N-12E

Assigns one protect card for several working cards. The maximum 
is 1:5. Protect cards (DS1N-14, DS3N-12, DS3N-12E) must be 
installed in Slots 3 or 15 and the cards they protect must be on the 
same side of the shelf. Protect cards must match the cards they 
protect. For example, a DS1N-14 can only protect DS1-14 or 
DS1N-14 cards. If a failure clears, traffic reverts to the working card 
after the reversion time has elapsed. 

1+1 Any OC-N Pairs a working OC-N card/port with a protect OC-N card/port. For 
multiport OC-N cards, the protect port must match the working port 
on the working card. For example, Port 1 of an OC-3 card can only 
be protected by Port 1 of another OC-3 card. The ports on multiport 
cards must be either working or protect. You cannot mix working 
and protect ports on the same card. Cards do not need to be in 
adjoining slots.

Y Cable MXP_2.5_10G

TXP_MR_10G

Pairs a working transponder or muxponder card/port with a protect 
transponder or muxponder card/port. The protect port must be on a 
different card than the working port and it must be the same card 
type as the working port. The working and protect port numbers 
must be the same, that is, Port 1 can only protect Port 1, Port 2 can 
only protect Port 2, etc.

Unprotected Any Unprotected cards can cause signal loss if a card fails or incurs a 
signal error. However, because no card slots are reserved for 
protection, unprotected schemes maximize the service available for 
use on the ONS 15454. Unprotected is the default protection type.
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DLP-A71 Create a 1:1 Protection Group

Step 1 Verify that the cards required for 1:1 protection are installed according to requirements specified in 
Table 4-3. 

Step 2 Click the Provisioning > Protection tabs.

Step 3 Under Protection Groups, click Create.

Step 4 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric characters.

• Type—Choose 1:1 from the pull-down menu.

• Protect Card—Choose the protect card from the pull-down menu. The menu displays cards available 
for 1:1 protection. If no cards are available, no cards are displayed.

After you choose the protect card, the card available for protection is displayed under Available Cards, 
as shown in Figure 4-7. If no cards are available, no cards are displayed. If this occurs, you can not 
complete this task until you install the physical cards or preprovision the ONS 15454 slots using the 
“NTP-A115 Preprovision a Slot” procedure on page 2-23.

Figure 4-7 Creating a 1:1 Protection Group

Step 5 From the Available Cards list, choose the card that will be protected by the card selected in the Protect 
Card pull-down menu. Click the top arrow button to move each card to the Working Cards list.

Purpose Use this task to create a 1:1 electrical card protection group.

Tools/Equipment Redundant DS-1, DS-3, EC-1, or DS3XM-6 cards should be installed in 
the shelf, or the ONS 15454 slots must be provisioned for two of these 
cards.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Complete the remaining fields:

• Bidirectional switching—Not available for 1:1 protection

• Revertive—Select this check box if you want traffic to revert to the working card after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, choose the reversion time from the pull-down menu. The 
range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the amount of time that will elapse 
before the traffic reverts to the working card after conditions causing the switch are cleared.

Step 7 Click OK, then click Yes on the confirmation dialog box.

Step 8 Return to your originating procedure (NTP).

DLP-A72 Create a 1:N Protection Group

Step 1 Verify that the cards are installed according to the 1:N requirements specified in Table 4-3 on page 4-26.

Step 2 Click the Provisioning > Protection tabs.

Step 3 Under Protection Groups, click Create.

Step 4 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric characters.

• Type—Choose 1:N from the pull-down menu.

• Protect Card—Choose the protect card from the pull-down menu. The menu displays DS1N-14, 
DS3N-12, or DS3N-12E cards installed in Slots 3 or 15. If these cards are not installed, no cards 
display in the pull-down menu.

After you choose the protect card, a list of cards available for protection is displayed under Available 
Cards, as shown in Figure 4-8. If no cards are available, no cards are displayed. If this occurs, you can 
not complete this task until you install the physical cards or preprovision the ONS 15454 slots using the 
“NTP-A115 Preprovision a Slot” procedure on page 2-23. 

Purpose This task creates a DS-1 or DS-3 1:N protection group.

Tools/Equipment DS1N-14, DS3N-12, or DS3N-12E (protect cards) in Slot 3 or Slot 15; 
DS1-14, DS3-12, or DS3-12E (working cards) installed on either side of a 
corresponding protect card.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 4-8 Creating a 1:N Protection Group

Step 5 From the Available Cards list, choose the cards that will be protected by the card selected in the Protect 
Card pull-down menu. Click the top arrow button to move each card to the Working Cards list.

Step 6 Complete the remaining fields:

• Bidirectional switching—Not available for 1:N protection.

• Revertive—Always enabled for 1:N protection groups.

• Reversion time—Click Reversion time and select a reversion time from the pull-down menu. The 
range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the amount of time that will elapse 
before the traffic reverts to the working card after conditions causing the switch are cleared.

Step 7 Click OK, then click Yes on the confirmation dialog box.

Step 8 Return to your originating procedure (NTP).

DLP-A73 Create a 1+1 Protection Group

Step 1 Verify that the cards are installed according to 1+1 requirements specified in Table 4-3 on page 4-26.

Step 2 In node view, click the Provisioning > Protection tabs.

Step 3 Under Protection Groups, click Create.

Step 4 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric characters.

Purpose Use this task to create a 1+1 protection group for any OC-N card/port 
(OC-3, OC-3-8, OC-12, OC-12-4, OC-48, OC-48 AS, and OC-192).

Tools/Equipment Installed OC-N cards or preprovisioned slots

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Type—Choose 1+1 from the pull-down menu.

• Protect Port—Choose the protect port from the pull-down menu. The menu displays the available 
OC-N ports, as shown in Figure 4-9. If OC-N cards are not installed, no ports display in the 
pull-down menu.

• After you choose the protect port, a list of ports available for protection is displayed under Available 
Ports, as shown in Figure 4-9. If no cards are available, no ports are displayed. If this occurs, you 
can not complete this task until you install the physical cards or preprovision the ONS 15454 slots 
using the “NTP-A115 Preprovision a Slot” procedure on page 2-23.

Figure 4-9 Creating a 1+1 Protection Group

Step 5 From the Available Ports list, choose the port that will be protected by the port you selected in Protect 
Ports. Click the top arrow button to move each port to the Working Ports list.

Step 6 Complete the remaining fields:

• Bidirectional switching—Select this box if you want both Tx and Rx signals to switch to the protect 
port when a failure occurs to one signal. Leave unchecked if you want only the failed signal to switch 
to the protect port.

• Revertive—Select this check box if you want traffic to revert to the working card after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, choose a reversion time from the pull-down menu. The 
range is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that 
will elapse before the traffic reverts to the working card after conditions causing the switch are 
cleared.

Step 7 Click OK.

Step 8 Return to your originating procedure (NTP).
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DLP-A252 Create a Y Cable Protection Group

Step 1 Verify that the transponder or muxponder cards are installed according to Y Cable requirements 
specified in Table 4-3 on page 4-26.

Step 2 In node view, click the Provisioning > Protection tabs.

Step 3 Under Protection Groups, click Create.

Step 4 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric characters.

• Type—Choose Y Cable from the pull-down menu.

• Protect Port—Choose the protect port from the pull-down menu. The menu displays the available 
transponder or muxponder ports, as shown in Figure 4-9. If transponder or muxponder cards are not 
installed, no ports display in the pull-down menu. 

• After you choose the protect port, a list of ports available for protection is displayed under Available 
Ports, as shown in Figure 4-9. If no cards are available, no ports are displayed. If this occurs, you 
can not complete this task until you install the physical cards or preprovision the ONS 15454 slots 
using the “NTP-A115 Preprovision a Slot” procedure on page 2-23.

Figure 4-10 Creating a Y Cable Protection Group

Purpose Use this task to create a Y Cable protection group between the client ports 
of two transponder (TXP_MR_10Gs) or two muxponder 
(MXP_2.5G_10G) cards.

Tools/Equipment Installed transponder or muxponder cards or preprovisioned slots.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 From the Available Ports list, choose the port that will be protected by the port you selected in Protect 
Ports. Click the top arrow button to move each port to the Working Ports list.

Step 6 Complete the remaining fields:

• Revertive—Select this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the pull-down menu. The 
range is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that 
will elapse before the traffic reverts to the working card. Traffic can revert when conditions causing 
the switch are cleared.

Step 7 Click OK.

Step 8 Return to your originating procedure (NTP).

NTP-A171 Set Up SNMP

Step 1 Log into the ONS 15454 node where you want to set up SNMP. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions.

Step 2 Click the Provisioning > SNMP tabs.

Step 3 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 4 Click the Create button.

Step 5 In SNMP Traps Destination dialog box (Figure 4-11 on page 4-33), complete the following:

• IP Address—Type the IP address of your network management system. If the node you are logged 
into is an ENE, set the destination address to the GNE. 

• Community Name—Type the SNMP community name. For a description of SNMP community 
names, refer to the SNMP information in the Cisco ONS 15454 Reference Manual.

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the NMS.

• UDP Port—The default UDP port for SNMP is 162. If the node is an ENE in a proxy server network, 
the UDP port must be set to the GNE’s SNMP relay port which is 391. 

• Trap Version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine 
whether to use SNMP v1 or v2.

Purpose Use this task to provision the SNMP parameters so that you can use SNMP 
management software with the ONS 15454. 

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed Required if SNMP is used at your installation.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Max Traps per Second—Type the maximum traps per second. The default is 0.

Note The Max Traps per Second is the maximum number of traps per second that will be sent to the 
SNMP manager. If the field is set to 0, there is no maximum and all traps are sent. 

Figure 4-11 Setting SNMP

Step 6 Click OK. Figure 4-12 appears.

Step 7 Click the node IP address under Trap Destinations. Verify the SNMP information that displays under 
Selected Destination.

Figure 4-12 SNMP Trap Destinations

Stop. You have completed this procedure.
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NTP-A34 Create Ethernet RMON Alarm Thresholds

Note The ONS 15454 ML-Series card uses the Cisco IOS CLI for managing RMON.

Step 1 Log into the ONS 15454 node where you want to set up SNMP. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Click the Provisioning > Ether Bridge > Thresholds tabs.

Step 3 Click Create.

The Create Ether Threshold dialog box opens (Figure 4-13).

Figure 4-13 Creating RMON Thresholds 

Step 4 From the Slot menu, choose the appropriate Ethernet card.

Step 5 From the Port pull-down menu, choose the applicable port on the Ethernet card you selected.

Step 6 From the Variable pull-down menu, choose the variable. See Table 4-4 on page 4-35 for a list of the 
Ethernet threshold variables available in this field.

Step 7 From the Alarm Type pull-down menu, indicate whether the event will be triggered by the rising 
threshold, falling threshold, or both the rising and falling thresholds.

Step 8 From the Sample Type pull-down menu, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Purpose This procedure sets up remote monitoring (RMON) to allow network 
management systems to monitor Ethernet ports.

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 Type in an appropriate number of seconds for the Sample Period.

Step 10 Type in the appropriate number of occurrences for the Rising Threshold. 

Note For a rising type of alarm, the measured value must move from below the falling threshold to 
above the rising threshold. For example, if a network is running below a falling threshold of 400 
collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess 
occurrences trigger an alarm. 

Step 11 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases a falling 
threshold is set lower than the rising threshold. 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences is above the 
rising threshold and then drops below a falling threshold, it resets the rising threshold. For example, 
when the network problem that caused 1001 collisions in 15 minutes subsides and creates only 799 
collisions in 15 minutes, occurrences fall below a falling threshold of 800 collisions. This resets the 
rising threshold so that if network collisions again spike over a 1000 per 15 minute period, an event again 
triggers when the rising threshold is crossed. An event is triggered only the first time a rising threshold 
is exceeded (otherwise a single network problem might cause a rising threshold to be exceeded multiple 
times and cause a flood of events). 

Step 12 Click OK to complete the procedure.

Table 4-4 Ethernet Threshold Variables (MIBs)

Variable Definition

iflnOctets Total number of octets received on the interface, including 
framing octets

iflnUcastPkts Total number of unicast packets delivered to an appropriate 
protocol

ifInMulticastPkts Number of multicast frames received error free

ifInBroadcastPkts The number of packets, delivered by this sub-layer to a higher 
(sub-)layer, which were addressed to a broadcast address at this 
sub-layer

 ifInDiscards The number of inbound packets which were chosen to be 
discarded even though no errors had been detected to prevent 
their being deliverable to a higher-layer protocol

iflnErrors Number of inbound packets discarded because they contain 
errors

ifOutOctets Total number of transmitted octets, including framing packets

ifOutUcastPkts Total number of unicast packets requested to transmit to a single 
address

ifOutMulticastPkts Number of multicast frames transmitted error free

ifOutBroadcastPkts The total number of packets that higher-level protocols requested 
be transmitted, and which were addressed to a broadcast address 
at this sub-layer, including those that were discarded or not sent

ifOutDiscards The number of outbound packets that were chosen to be 
discarded even though no errors had been detected to prevent 
their being transmitted
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dot3statsAlignmentErrors Number of frames with an alignment error, i.e., the length is not 
an integral number of octets and the frame cannot pass the Frame 
Check Sequence (FCS) test

dot3StatsFCSErrors Number of frames with framecheck errors, i.e., there is an 
integral number of octets, but an incorrect Frame Check 
Sequence (FCS)

dot3StatsSingleCollisionFrames Number of successfully transmitted frames that had exactly one 
collision

dot3StatsMutlipleCollisionFrame Number of successfully transmitted frames that had multiple 
collisions

dot3StatsDeferredTransmissions Number of times the first transmission was delayed because the 
medium was busy

dot3StatsLateCollision Number of times that a collision was detected later than 64 octets 
into the transmission (also added into collision count)

dot3StatsExcessiveCollision Number of frames where transmissions failed because of 
excessive collisions

dot3StatsCarrierSenseErrors The number of transmission errors on a particular interface that 
are not otherwise counted

dot3StatsSQETestErrors A count of times that the SQE TEST ERROR message is 
generated by the PLS sublayer for a particular interface

etherStatsJabbers Total number of Octets of data (including bad packets) received 
on the network

etherStatsUndersizePkts Number of packets received with a length less than 64 octets

etherStatsFragments Total number of packets that are not an integral number of octets 
or have a bad FCS, and that are less than 64 octets long

etherStatsPkts64Octets Total number of packets received (including error packets) that 
were 64 octets in length

etherStatsPkts65to127Octets Total number of packets received (including error packets) that 
were 65 – 172 octets in length

etherStatsPkts128to255Octets Total number of packets received (including error packets) that 
were 128 – 255 octets in length

etherStatsPkts256to511Octets Total number of packets received (including error packets) that 
were 256 – 511 octets in length

etherStatsPkts512to1023Octets Total number of packets received (including error packets) that 
were 512 – 1023 octets in length

etherStatsPkts1024to1518Octets Total number of packets received (including error packets) that 
were 1024 – 1518 octets in length

etherStatsJabbers Total number of packets longer than 1518 octets that were not an 
integral number of octets or had a bad FCS

etherStatsCollisions Best estimate of the total number of collisions on this segment

etherStatsCollisionFrames Best estimate of the total number of frame collisions on this 
segment

Table 4-4 Ethernet Threshold Variables (MIBs) (continued)

Variable Definition
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Stop. You have completed this procedure.

etherStatsCRCAlignErrors Total number of packets with a length between 64 and 1518 
octets, inclusive, that had a bad FCS or were not an integral 
number of octets in length

receivePauseFrames (G series only) The number of received 802.x pause frames

transmitPauseFrames (G series 
only)

The number of transmitted 802.x pause frames

receivePktsDroppedInternalCongest
ion (G series only)

The number of received framed dropped due to frame buffer 
overflow as well as other reasons 

transmitPktsDroppedInternalConge
stion (G series only)

The number of frames dropped in the transmit direction due to 
frame buffer overflow as well as other reasons

txTotalPkts Total number of transmit packets

rxTotalPkts Total number of receive packets

Table 4-4 Ethernet Threshold Variables (MIBs) (continued)

Variable Definition
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C H A P T E R 5

Turn Up Network

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to turn up and test Cisco ONS 15454s network, including point-to-point 
networks, linear add drop multiplexers (ADMs), path protection configurations, and bidirectional line 
switched rings (BLSRs).

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-A35 Verify Node Turn Up, page 5-2—Complete this procedure before beginning network turn 
up.

2. NTP-A172 Create a Logical Network Map, page 5-3—Complete as needed.

3. NTP-A124 Provision a Point-to-Point Network, page 5-4—Complete as needed.

4. NTP-A173 Point-to-Point Network Acceptance Test, page 5-7—Complete this procedure after you 
provision a point-to-point network.

5. NTP-A38 Provision a Linear ADM Network, page 5-12—Complete as needed.

6. NTP-A174 Linear ADM Network Acceptance Test, page 5-13—Complete this procedure after you 
provision a linear ADM. 

7. NTP-A40 Provision BLSR Nodes, page 5-15—Complete this procedure to provision ONS 15454s 
in a two-fiber or four-fiber BLSR.

8. NTP-A126 Create a BLSR, page 5-18—Complete this procedure after provisioning the BLSR 
nodes.

9. NTP-A175 Two-Fiber BLSR Acceptance Test, page 5-20—Complete this procedure after you 
provision a two-fiber BLSR.

10. NTP-A176 Four-Fiber BLSR Acceptance Test, page 5-26—Complete this procedure after you 
provision a four-fiber BLSR.

11. NTP-A44 Provision Path Protection Nodes, page 5-32—Complete as needed.
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12. NTP-A177 Path Protection Acceptance Test, page 5-33—Complete this procedure after you 
provision a path protection.

13. NTP-A216 Provision a Traditional Path Protection Dual Ring Interconnect, page 5-36—As needed, 
complete this procedure after you provision a path protection.

14. NTP-A217 Provision an Integrated Path Protection Dual Ring Interconnect, page 5-38—As needed, 
complete this procedure after you provision a path protection.

15. NTP-A46 Subtend a Path Protection from a BLSR, page 5-40—Complete as needed.

16. NTP-A47 Subtend a BLSR from a Path Protection, page 5-41—Complete as needed.

17. NTP-A48 Subtend a BLSR from a BLSR, page 5-42—Complete as needed.

NTP-A35 Verify Node Turn Up

Step 1 Log into an ONS 15454 on the network you will test. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If alarms are displayed, investigate 
and resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide for 
procedures.

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 3 Verify that the SW Version and Defaults displayed in the node view status area match the software 
version and NE defaults shown in your site plan. If either are not correct, complete the following 
procedures as needed:

• If the software is not the correct version, install the correct version from the ONS 15454 software 
CD. Upgrade procedures are located on the CD. Follow the upgrade procedures appropriate to the 
software currently installed on the node.

• If the node defaults are not correct, complete the “NTP-A165 Import Network Element Defaults” 
procedure on page C-3. 

Step 4 Click the Provisioning > General tabs. Verify that all general node information settings match the 
settings of your site plan. If not, see the “NTP-A81 Change Node Management Information” procedure 
on page 10-2.

Step 5 Click the Provisioning > Timing tabs. Verify that timing settings match the settings of your site plan. 
If not, see the “NTP-A85 Change Node Timing” procedure on page 10-19.

Purpose Use this procedure to verify that each ONS 15454 is ready for network 
turn up before adding nodes to a network.

Tools/Equipment None

Prerequisite Procedures Chapter 4, “Turn Up Node”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 6 Click the Provisioning > Network tabs. Ensure that the IP settings and other CTC network access 
information is correct. If not, see the “NTP-A201 Change CTC Network Access” procedure on 
page 10-4.

Step 7 Click the Provisioning > Protection tabs. Verify that all protection groups have been created according 
to your site plan. If not, see the “NTP-A203 Modify or Delete Card Protection Settings” procedure on 
page 10-13.

Step 8 Click the Provisioning > Security tabs. Verify that all users have been created and their security levels 
match the settings indicated by your site plan. If not, see the “NTP-A205 Modify Users and Change 
Security” procedure on page 10-21.

Step 9 If SNMP is provisioned on the node, click the Provisioning > SNMP tabs. Verify that all SNMP settings 
match the settings of your site plan. If not, see the “NTP-A87 Change SNMP Settings” procedure on 
page 10-27.

Step 10 Provision the network using the applicable procedure shown in the “Before You Begin” section on 
page 5-1.

Stop. You have completed this procedure.

NTP-A172 Create a Logical Network Map

Step 1 Log into an ONS 15454 on the network. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions. If you are already logged in, go to Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Change the position of the nodes in the network view according to your site plan.

a. Press the Ctrl key while you drag and drop a node icon to a new location. 

b. Deselect the previously selected node.

c. Repeat Step a for each node you need to position.

Step 4 On the network view map, right-click and choose Save Node Position.

Step 5 Click Yes on the Save Node Position dialog box.

CTC displays a progress bar and saves the new node positions.

Purpose Use this procedure to position nodes in the network view. This procedure 
allows a superuser to create a consistent network view for all nodes on the 
network.

Tools None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note Nodes on the network map can be moved by users with retrieve, provisioning, and maintenance security 
levels, but new network views can only be saved by a superuser. To restore the view to a previously saved 
version of the network map, right-click on the network view map and choose Reset Node Position.

Stop. You have completed this procedure.

NTP-A124 Provision a Point-to-Point Network

Step 1 Log into an ONS 15454 on the network where you want to provision a point-to-point configuration. See 
the “DLP-A60 Log into CTC” task on page 3-23 for instructions. 

Step 2 Click the Provisioning > Protection tabs. Verify that 1+1 protection is created for the OC-N cards. 
Complete the “DLP-A73 Create a 1+1 Protection Group” task on page 4-29 if protection has not been 
created. 

Step 3 Repeat Steps 1 and 2 for the second point-to-point node.

Step 4 Verify that the working and protect cards in the 1+1 protection groups correspond to the physical fiber 
connections between the nodes, that is, verify that the working card in one node connects to the working 
card in the other node, and that the protect card in one node connects to the protect card in the other node.

Step 5 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for the working 
OC-N port on both point-to-point nodes. 

Note DCC terminations are not provisioned on the protect /ports. 

Note If the point-to-point nodes are not connected to a LAN, you will need to create the DCC 
terminations using a direct (craft) connection to the node. Remote provisioning is possible only 
after all nodes in the network have DCC terminations provisioned to in-service OC-N ports.

Step 6 Verify that timing is set up at both point-to-point nodes. If not, complete the “NTP-A28 Set Up Timing” 
procedure on page 4-21 for one or both of the nodes. If a node uses line timing, make its working OC-N 
the timing source.

Step 7 Complete the “NTP-A173 Point-to-Point Network Acceptance Test” procedure on page 5-7.

Purpose Use this procedure to provision two ONS 15454s in a point-to-point 
(terminal) network.

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Stop. You have completed this procedure.

DLP-A253 Provision SONET DCC Terminations

Step 1 Display the node (login) view. 

Step 2 Click the Provisioning > DCC/GCC tabs.

Step 3 Click Create.

Step 4 In the Create SDCC Terminations dialog box click the ports where you want to create the DCC 
termination. To select more than one port, press the Shift key or the Ctrl key.

Note SDCC refers to the Section DCC, which is used for ONS 15454 DCC terminations. The SONET 
Line DCCs and the Section DCC (when not used as a DCC termination by the ONS 15454) can 
be provisioned as DCC tunnels. See the “DLP-A313 Create a DCC Tunnel” procedure on 
page 6-92. 

Step 5 Under Port State, click the Set to IS radio button.

Step 6 Verify that the Disable OSPF on DCC Link check box is unchecked.

Step 7 Click OK. 

Note EOC (DCC Termination Failure) and LOS (Loss of Signal) alarms are displayed until you create 
all network DCC terminations and put the DCC termination OC-N ports in service.

Step 8 Return to your originating procedure (NTP).

Purpose This task creates the SONET Data Communications Channel terminations 
required for alarms, administration data, signal control information and 
messages.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A214 Change the Service State for a Port

Note To provision Ethernet ports, see the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79 
or the “DLP-A222 Provision G-Series Ethernet Ports” task on page 6-87.

Step 1 Display the node (login) view.

Step 2 On the shelf graphic, double-click the card with the port(s) you want to put in or out of service. The card 
view appears.

Step 3 Click the Provisioning > Line tabs.

Step 4 Under State, choose one of the following:

• IS—The port is in-service.

• OOS—The port is out-of-service. Traffic is not passed on the port until the service state is changed 
to IS, OOS_MT, or OOS_AINS.

• OOS_MT—The port is in a maintenance state. The maintenance state does not interrupt traffic flow, 
alarm reporting is suppressed, but traffic is carried and loopbacks are allowed. Raised fault 
conditions, whether their alarms are reported or not, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command. Use OOS_MT for testing or to suppress alarms 
temporarily. Change the state to IS, OOS, or OOS_AINS when testing is complete.

• OOS_AINS—The port is in an auto-inservice state; alarm reporting is suppressed, but traffic is 
carried and loopbacks are allowed. Raised fault conditions, whether their alarms are reported or not, 
can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND command.

Step 5 If you set State to OOS-AINS, set the soak period time in the AINS Soak field. This is the amount of 
time that the state will stay in OOS-AINS state after the signal is continuously received.

Step 6 Click Apply.

Step 7 As needed, repeat this task for each port.

Step 8 Return to your originating procedure (NTP).

Purpose Use this task to put a port in service or to remove a port from service.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A173 Point-to-Point Network Acceptance Test

Step 1 Log into one of the point-to-point nodes. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions. The node (default) view appears.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 4 Export the alarm data to a file by choosing Export from the File menu. Select an export format and save 
the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 5 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 6 Export the conditions data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 7 On the network map, double-click one point-to-point node to display it in node view.

Step 8 Create a test circuit from the login node to the other point-to-point node:

• For DS-1 circuits, complete the “NTP-A181 Create an Automatically Routed DS-1 Circuit” 
procedure on page 6-6. When you set the circuit state, choose IS and check the Apply to drop ports 
check box.

• For DS-3 circuits, complete the “NTP-A184 Create an Automatically Routed DS-3 Circuit” 
procedure on page 6-20. When you set the circuit state, choose IS and check the Apply to drop 
ports check box.

Step 9 Configure the test set for the test circuit type you created: 

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15454. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

Purpose Use this procedure to test a point-to-point network. 

Tools/Equipment Test set/cables appropriate to the test circuit you will create

Prerequisite Procedures NTP-A124 Provision a Point-to-Point Network, page 5-4

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

Step 10 Verify the integrity of all patch cables that will be used in this test by connecting one end to the test set 
transmit (Tx) connector the other to the test set receive (Rx) connector. If the test set does not run 
error-free, check the cable for damage and check the test set to make sure it is set up correctly before 
going to Step 11.

Step 11 Create a physical loopback at the circuit destination card. To do so, attach one end of a patch cable to 
the destination port’s transmit (Tx) connector; attach the other end to the port’s receive (Rx) connector. 

Step 12 At the circuit source card:

a. Connect the transmit (Tx) connector of the test set to the receive (Rx) connector on the circuit source 
card. 

b. Connect the test set receive (Rx) connector to the circuit transmit (Tx) connector on the circuit 
source card. 

Step 13 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 8 through 
12 to make sure the test set and cabling are configured correctly. 

Step 14 Inject BIT errors from the test set. Verify that the errors display at the test set, indicating a complete 
end-to-end circuit. 

Step 15 Complete the “DLP-A254 TCC+/TCC2 Active/Standby Switch Test” task on page 5-9.

Step 16 Complete the “DLP-A255 Cross-Connect Card Side Switch Test” task on page 5-10. 

Step 17 Complete the “DLP-A88 Optical 1+1 Protection Test” task on page 5-11.

Step 18 Set up and complete a BER Test. Use the existing configuration and follow your site requirements for 
the specified length of time. Record the test results and configuration.

Step 19 Remove any loopbacks, switches, or test sets from the nodes after all testing is complete.

Step 20 From the View menu, choose Go to Network View.

Step 21 Click the Alarms tab. Verify that no unexplained alarms are displayed on the network. If unexplained 
alarms are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 22 Export the Alarms data to a file. See the “DLP-A139 Export CTC Data” task on page 7-4 for more 
information.

Step 23 Repeat Steps 11 through 22 for the other point-to-point node.

Step 24 If a node fails any test, repeat the test while verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

Step 25 Delete the test circuit. See the “NTP-A152 Delete Circuits” procedure on page 9-16 for instructions.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service application. 

Stop. You have completed this procedure.
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DLP-A254 TCC+/TCC2 Active/Standby Switch Test

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide.

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 3 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 4 Display the node containing the TCC+/TCC2 cards you are testing in node view.

Step 5 Make a note of which TCC+/TCC2 is active and which is standby by examining the LEDs on the shelf 
graphic. TCC+/TCC2 cards are installed in Slot 7 and Slot 11. The active TCC+/TCC2 has a green ACT 
LED, and the standby TCC+/TCC2 has an amber SBY LED.

Step 6 On the shelf graphic, right-click the active TCC+/TCC2 and choose Reset from the shortcut menu.

Step 7 On the Resetting Card dialog box, click Yes. After 20-40 seconds, a “lost node connection, changing to 
network view” message is displayed.

Step 8 Click OK. On the network view map, the node where you reset the TCC+/TCC2 will be grey. 

Step 9 After the node icon turns green (within 1-2 minutes), double-click it. On the shelf graphic, observe the 
following:

• The previous standby TCC+/TCC2 displays a green ACT LED.

• The previous active TCC+/TCC2 LEDs go through the following LED sequence: NP (card not 
present), Ldg (software is loading), amber SBY LED (TCC+/TCC2 is in standby mode). The LEDs 
should complete this sequence within 5-10 minutes.

Step 10 Verify that traffic on the test set connected to the node is still running. If a traffic interruption occurs, do 
not continue, refer to your next level of support.

Step 11 Repeat Steps 2 through 10 to return the active/standby TCC+/TCC2 cards to their configuration at the 
start of the procedure. 

Step 12 Verify that the TCC+/TCC2 cards display as noted in Step 5.

Step 13 Return to your originating procedure (NTP).

Purpose This task verifies that the TCC+/TCC2 cards can effectively switch from 
one to another.

Tools/Equipment The test set specified by the acceptance test procedure, connected and 
configured as specified in the acceptance test procedure.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
5-9
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 5      Turn Up Network
NTP-A173 Point-to-Point Network Acceptance Test
DLP-A255 Cross-Connect Card Side Switch Test

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide.

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 3 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 4 Display the node containing the cross-connect cards you are testing in node view.

Step 5 Click the Maintenance > Cross-Connect tabs.

Step 6 Under Cross-Connect Cards, make a note of the active and standby slots. 

Step 7 On the shelf graphic, verify that the active cross-connect card displays a green ACT LED and the standby 
cross-connect card displays an amber SBY LED. If these conditions are not present, review the 
“DLP-A37 Install the XC, XCVT, or XC10G Cards” task on page 2-10 or contact your next level of 
support.

Step 8 Click the Switch button.

Step 9 On the Confirm Switch dialog box, click Yes.

Step 10 Verify that the active slot noted in Step 6 becomes the standby slot, and that the standby slot becomes 
the active slot. The switch should display within 1 to 2 seconds.

Step 11 Verify that traffic on the test set connected to the node is still running. Some bit errors are normal, but 
traffic flow should not be interrupted. If a traffic interruption occurs, do not continue. Refer to your next 
level of support.

Step 12 Repeat Steps 7 through 9 to return the active/standby slots to their configuration at the start of the 
procedure. 

Step 13 Verify that the cross-connect card display is the same as you noted in Step 6.

Step 14 Return to your originating procedure (NTP).

Purpose This task verifies that the XC, XCVT, and XC10G cards can effectively 
switch service (active to standby and standby to active).

Tools/Equipment The test set specified by the acceptance test procedure, connected and 
configured as specified in the acceptance test procedure.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
5-10
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 5      Turn Up Network
NTP-A173 Point-to-Point Network Acceptance Test
DLP-A88 Optical 1+1 Protection Test

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 3 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 4 Display the node containing the 1+1 protection group you are testing in node view.

Step 5 Click the Maintenance > Protection tabs.

Step 6 Under Protection Groups, click the 1+1 protection group.

Step 7 Click the working port. Next to Switch Commands, click the Force button.

Step 8 At the Confirm Manual Operation dialog, click Yes.

Step 9 Under Selected Group, verify that the following is displayed:

Protect port - Protect/Active [FORCE_SWITCH_TO_PROTECT] [PORT STATE]

Working port - Working/Standby [FORCE_SWITCH_TO_PROTECT], [PORT STATE]

Step 10 Verify that traffic on the test set connected to the node is still running. Some bit errors are normal, but 
traffic flow should not be interrupted. If a traffic interruption occurs, complete Steps 11 and 12, then 
refer to your next level of support.

Step 11 Next to Switch Commands, click the Clear button.

Step 12 At the Confirm Clear Operation confirmation, click Yes.

Step 13 Under Selected Group, click the protect port. Next to Switch Commands, click the Force button.

Step 14 At the “Confirm Force Operation” popup window, click Yes.

Step 15 Under Selected Group, verify that the following is displayed:

Protect port - Protect/Active [FORCE_SWITCH_TO_WORKING], [PORT STATE]

Working port - Working/Standby [FORCE_SWITCH_TO_WORKING], [PORT STATE]

Step 16 Verify that the traffic on the test set connected to the node is still running. If a traffic interruption occurs, 
complete Steps 17 and 18, then refer to your next level of support.

Step 17 Next to Switch Commands, click the Clear button.

Purpose This task verifies a 1+1 protection group will switch traffic properly.

Tools/Equipment The test set specified by the acceptance test procedure.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23; a test circuit created as part of the 
topology acceptance test.

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 18 At the Confirm Clear Operation dialog, click Yes.

Step 19 Under Selected Group, verify the following states:

• Protect port - Protect/Standby

• Working port - Working/Active

Step 20 Return to your originating procedure (NTP).

NTP-A38 Provision a Linear ADM Network

Step 1 Log into an ONS 15454 that you want to provision in a linear ADM network. The node (default) view 
appears. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. 

Figure 5-1 shows three ONS 15454s in a linear ADM configuration. In this example, working traffic 
flows from Slot 5/Node 1 to Slot 5/Node 2, and from Slot 12/Node 2 to Slot 12/Node 3. Slots 6 and 13 
contain the protect OC-N cards. Slots 5 and 6 and Slots 12 and 13 are in 1+1 protection. 

Figure 5-1 Linear ADM Configuration 

Step 2 Click the Provisioning > Protection tabs. Verify that 1+1 protection is created for the OC-N cards at 
the node. If the protection group has not been created, go to the “DLP-A73 Create a 1+1 Protection 
Group” task on page 4-29 to create them. 

Step 3 Repeat Steps 1 and 2 for all other nodes you will include in the linear ADM.

Step 4 Verify that the working and protect cards in the 1+1 protection groups correspond to the physical fiber 
connections between the nodes, i.e. working cards are fibered to working cards and protect cards are 
fibered to protect cards.

Step 5 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for the working 
OC-N ports on each linear ADM node. 

Purpose This procedure provisions three or more ONS 15454s in a linear add-drop 
multiplexer (ADM) configuration.

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Node 1 Node 3Node 2

Slot 5 to Slot 5

Slot 6 to Slot 6

Slot 12 to Slot 12

Slot 13 to Slot 13

Working Path
Protect Path

34
28

4
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Note If linear ADM nodes are not connected to a LAN, you will need to create the DCC terminations 
using a direct (craft) connection to the node. Remote provisioning is possible only after all nodes 
without LAN connections have DCC terminations provisioned to in-service OC-N ports.

Note Terminating nodes (Nodes 1 and 3 in Figure 5-1) will have one DCC termination, and 
intermediate nodes (Node 2 in Figure 5-1) will have two DCC terminations (Slots 5 and 12 in 
the example).

Step 6 Verify that the timing has been set up at each linear node. If not, complete the “NTP-A28 Set Up Timing” 
task on page 4-21. If a node is using line timing, use its working OC-N card as the timing source.

Step 7 Complete the “NTP-A174 Linear ADM Network Acceptance Test” procedure on page 5-13.

Stop. You have completed this procedure.

NTP-A174 Linear ADM Network Acceptance Test

Step 1 Log into an ONS 15454 on the linear ADM network you are testing. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. The node (default) view appears. If you are already logged in, 
continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 4 Export the alarm data to a file by choosing Export from the File menu. Select an export format and save 
the file to your hard drive. Complete the “DLP-A139 Export CTC Data” task on page 7-4.

Step 5 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 6 Export the conditions data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Purpose Use this procedure to test a linear ADM network.

Tools/Equipment Test set/cables appropriate to the test circuit you will create.

Prerequisite Procedures NTP-A38 Provision a Linear ADM Network, page 5-12

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 Display a linear ADM node in node view.

Step 8 Create a test circuit from that node to an adjacent linear ADM node.

• For DS-1 circuits, complete the “NTP-A181 Create an Automatically Routed DS-1 Circuit” 
procedure on page 6-6. When you set the circuit state, choose IS and check the Apply to drop ports 
check box.

• For DS-3 circuits, complete the “NTP-A184 Create an Automatically Routed DS-3 Circuit” 
procedure on page 6-20. When you set the circuit state, choose IS and check the Apply to drop 
ports check box.

Step 9 Configure the test set for the test circuit type you created: 

• DS-1 card—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 
interface into the ONS 15454. Set the test set for DS-1. For information about configuring your test 
set, consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

Step 10 Verify the integrity of all patch cables that will be used in this test by connecting one end to the test set 
transmit (Tx) connector and the other end to the test set receive (Rx) connector. If the test set does not 
run error-free, check the cable for damage and check the test set to make sure it is set up correctly before 
going to the next step. 

Step 11 Create a physical loopback at the circuit destination card. To do so, attach one end of a patch cable to 
the destination port’s transmit (Tx) connector; attach the other end to the destination port’s receive (Rx) 
connector. 

Step 12 At the circuit source card:

a. Connect the transmit (Tx) connector of the test set to the circuit receive (Rx) connector. 

b. Connect the test set receive (Rx) connector to the circuit transmit (Tx) connector. 

Step 13 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 8 through 
12 to make sure the test set and cabling are configured correctly. 

Step 14 Inject BIT errors from the test set. Verify that the errors display at the test set, indicating a complete 
end-to-end circuit. 

Step 15 Complete the “DLP-A254 TCC+/TCC2 Active/Standby Switch Test” task on page 5-9.

Step 16 Complete the “DLP-A255 Cross-Connect Card Side Switch Test” task on page 5-10. 

Step 17 Complete the “DLP-A88 Optical 1+1 Protection Test” task on page 5-11 to test the OC-N port protection 
group switching.

Step 18 Set up and complete a BER test. Use the existing configuration and follow your site requirements for 
length of time. Record the test results and configuration.

Step 19 Remove any loopbacks, switches, or test sets from the nodes after all testing is complete.

Step 20 Click the Alarms tab. Verify that no unexplained alarms are displayed on the network. If unexplained 
alarms are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 21 Delete the test circuit. See the “NTP-A152 Delete Circuits” procedure on page 9-16 for instructions.
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Step 22 Display the next linear ADM node in node view and repeat Steps 8 through 21.

Step 23 If a node fails any test, repeat the test while verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service application.

Stop. You have completed this procedure.

NTP-A40 Provision BLSR Nodes

Step 1 Complete the “DLP-A44 Install Fiber-Optic Cables for BLSR Configurations” task on page 2-32, 
verifying that the following rules are observed: 

• Verify that the east port at one node is connected to the west port on an adjacent node, and this east 
to west port connection is used at all BLSR nodes, similar to Figure 5-2. In the figure, the OC-N 
drop card on the left side of the shelf is the west port, and the drop card on the right side of the shelf 
is considered the east port. 

• For four-fiber BLSRs, verify that the same east port to west port connection is used for the working 
and protect fibers, similar to Figure 5-3. Verify that the working and protect card connections are 
not mixed. The working cards are the cards where you will provision the DCC terminations.

Purpose This procedure provisions ONS 15454 nodes for a bidirectional line 
switched ring (BLSR).

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 5-2 Four-Node, Two-Fiber BLSR Fiber Connection Example

Figure 5-3 Four-Node, Four-Fiber BLSR Fiber Connection Example

Step 2 Log into an ONS 15454 that you want to configure in a BLSR. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 3.
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Step 3 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5. Provision the two 
ports/cards that will serve as the BLSR ports at the node. For four-fiber BLSRs, provision the DCC 
terminations on the OC-N cards that will carry the working traffic, but do not provision DCCs on the 
protect cards.

Note If an ONS 15454 is not connected to a corporate LAN, DCC provisioning must be performed 
through a direct (craft) connection to the node. Remote provisioning is possible only after all 
nodes in the network have DCC provisioned to in-service OC-N ports.

Step 4 For four-fiber BLSRs, complete the “DLP-A214 Change the Service State for a Port” task on page 5-6 
to put the protect OC-N cards/ports in service.

Step 5 If a BLSR span passes through third-party equipment that cannot transparently transport the K3 byte, 
complete the “DLP-A89 Remap the K3 Byte” task on page 5-17. This task is not necessary for most 
users. 

Step 6 Repeat Steps 2 through 4 at each node that will be in the BLSR. Verify that the EOC (DCC Termination 
Failure) and LOS (Loss of Signal) are cleared after DCCs are provisioned on all nodes in the ring.

Step 7 Complete the “NTP-A126 Create a BLSR” procedure on page 5-18.

Stop. You have completed this procedure.

DLP-A89 Remap the K3 Byte

Caution If you remap the K3 byte, remap to the same extended byte (Z2, E2, or F1) on either side of the span.

Step 1 At the node view, double-click the OC48AS card that connects to the third-party equipment. 

Step 2 Click the Provisioning > Line tabs.

Step 3 Click BLSR Ext Byte and choose the alternate byte: Z2, E2, or F1.

Step 4 Click Apply.

Step 5 (Four-fiber BLSR only) Repeat Steps 2 through 4 for each protect card.

Step 6 Repeat Steps 2 through 4 at the node and card on the other end of the BLSR span.

Purpose Use this task to provision the K3 byte. Do not remap the K3 byte unless 
specifically required to run an ONS 15454 BLSR through third-party 
equipment. This task is unnecessary for most users.

Tools/Equipment OC48AS cards must be installed on the BLSR span that you will remap.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note The extension byte chosen in Step 3, should match at both ends of the span.

Step 7 Return to your originating procedure (NTP).

NTP-A126 Create a BLSR

Step 1 Log into an ONS 15454 node on the network where you will create the BLSR. See the “DLP-A60 Log 
into CTC” task on page 3-23 for instructions.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Provisioning > BLSR tabs.

Step 4 Click Create BLSR.

Step 5 On the BLSR Creation dialog box, set the BLSR properties:

• Ring Type—Choose the BLSR ring type, either two-fiber or four-fiber.

• Speed—Choose the BLSR ring speed: OC-12 (two-fiber BLSR only), OC-48, or OC-192. The speed 
must match the OC-N speed of the BLSR trunk cards.

Note If you are creating an OC-12 BLSR and will eventually upgrade it to OC-48 or OC-192, use the 
single-port OC-12 cards (OC12 IR/STM4 SH 1310, OC12 IR/STM4 SH 1310, or 
OC12 IR/STM4 SH 1310). You cannot upgrade a BLSR on a four-port OC-12 (OC12/STM4-4) 
because OC-48 and OC-192 cards are single-port.

• Ring ID—Assign a ring ID (a number between 0 and 9999).

• Reversion time—Set the amount of time that will pass before the traffic reverts to the original 
working path following a ring switch. The default is 5 minutes. Ring reversions can be set to Never. 

For four-fiber BLSRs only, complete the following:

• Span Reversion—Set the amount of time that will pass before the traffic reverts to the original 
working path following a span switch. The default is 5 minutes. Span reversions can be set to Never. 

Step 6 Click Next. If CTC displays a network graphic, go Step 7. If CTC determines that a BLSR cannot be 
created, for example, not enough optical cards are installed or it finds circuits with path protection 
selectors, a “Cannot Create BLSR” message is displayed. If this occurs, complete the following steps:

a. Click OK.

Purpose This procedure creates a BLSR at each BLSR-provisioned node.

Tools/Equipment None

Prerequisite Procedures NTP-A40 Provision BLSR Nodes, page 5-15

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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b. On the Create BLSR window, click Excluded Nodes. Review the information explaining why the 
BLSR could not be created, then click OK.

c. Depending on the problem, click Back to start over or click Cancel to cancel the operation.

d. Complete the “NTP-A40 Provision BLSR Nodes” procedure on page 5-15, making sure all steps are 
completed accurately, then start this procedure again.

Step 7 In the network graphic, double-click a BLSR span line. If the span line is DCC connected to other BLSR 
cards comprising a complete ring, the lines turn blue and the Finish button is displayed. If the lines do 
not form a complete ring, double-click span lines until a complete ring is formed. When the ring is DCC 
connected, go to Step 8 if you are completing a four-fiber BLSR or go to Step 9 if you are completing a 
two-fiber BLSR). 

Step 8 (Four-fiber BLSRs only) Click Next. In the Protect Port Selection section, choose the protect ports from 
the West Protect and East Protect columns. Go to the next step.

Step 9 Click Finish. If CTC displays the BLSR window with the BLSR you created, go to Step 10. If CTC 
displays a “Cannot Create BLSR” or “Error While Creating BLSR” message:

a. Click OK.

b. On the Create BLSR window, click Excluded Nodes. Review the information explaining why the 
BLSR could not be created, then click OK.

c. Depending on the problem, click Back to start over or click Cancel to cancel the operation.

d. Complete the “NTP-A40 Provision BLSR Nodes” procedure on page 5-15, making sure all steps are 
completed accurately, then start this procedure again.

Note Some or all of the following alarms may briefly display during BLSR setup: E-W MISMATCH, 
RING MISMATCH, APSCIMP, APSDFLTK, or BLSROSYNC. 

Step 10 Verify the following:

• On the network view graphic, a green span line appears between all BLSR nodes.

• All E-W MISMATCH, RING MISMATCH, APSCIMP, DFLTK, and BLSROSYNC alarms are 
cleared. See the Cisco ONS 15454 Troubleshooting Guide for alarm troubleshooting.

Step 11 Complete the “NTP-A175 Two-Fiber BLSR Acceptance Test” procedure on page 5-20 or the 
“NTP-A176 Four-Fiber BLSR Acceptance Test” procedure on page 5-26.

Stop. You have completed this procedure.
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NTP-A175 Two-Fiber BLSR Acceptance Test

Note This procedure requires that you create test circuits and perform span switches around the ring. For 
clarity, “Node 1” refers to the login node where you begin the procedure. “Node 2” refers to the node 
connected to the East OC-N trunk (span) card of Node 1, “Node 3” refers to the node connected to the 
East OC-N trunk card of Node 2, and so on. 

Step 1 Log into one of the ONS 15454s on the BLSR you are testing. (This node will be called Node 1.) See 
the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you are already logged in, continue 
with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide.

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 4 Export the alarms data to a file by choosing Export from the File menu. Select an export format and save 
the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 5 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 6 Export the conditions data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 7 On the network view, double-click Node 1. 

Step 8 Complete the “DLP-A217 BLSR Exercise Ring Test” task on page 5-22.

Step 9 Create a test circuit from Node 1 to the node connected to the East OC-N trunk card of Node 1. (This 
node will be called Node 2.)

• For DS-1 circuits, complete the “NTP-A181 Create an Automatically Routed DS-1 Circuit” 
procedure on page 6-6. When you set the circuit state, choose IS and check the Apply to drop ports 
check box.

• For DS-3 circuits, complete the “NTP-A184 Create an Automatically Routed DS-3 Circuit” 
procedure on page 6-20. When you set the circuit state, choose IS and check the Apply to drop 
ports check box.

Purpose This procedure tests a two-fiber BLSR.

Tools/Equipment Test set and cables appropriate for the test circuit

Prerequisite Procedures NTP-A40 Provision BLSR Nodes, page 5-15

NTP-A126 Create a BLSR, page 5-18

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 10 Configure the test set for the test circuit type you created: 

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15454. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS-3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

Step 11 Verify the integrity of all patch cables that will be used in this test by connecting the test set transmit 
(Tx) connector to the test set receive (Rx) connector. If the test set does not run error-free, check the 
cable for damage and check the test set to make sure it is set up correctly before going to the next step.

Step 12 Create a physical loopback at the circuit destination card: attach one end of a patch cable to the 
destination port’s transmit (Tx) connector; attach the other end to the port’s receive (Rx) connector. 

Step 13 At the circuit source card:

a. Connect the transmit (Tx) connector of the test set to the circuit receive (Rx) connector. 

b. Connect the test set receive (Rx) connector to the circuit transmit (Tx) connector. 

Step 14 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 1 through 
9 to make sure the test set and cabling are configured correctly. 

Step 15 Inject BIT errors from the test set. Verify that the errors display at the test set, verifying a complete 
end-to-end circuit. 

Step 16 Complete the “DLP-A254 TCC+/TCC2 Active/Standby Switch Test” task on page 5-9.

Step 17 Complete the “DLP-A255 Cross-Connect Card Side Switch Test” task on page 5-10. 

Although a service interruption under 60 ms may occur, the test circuit should continue to work before, 
during, and after the switches. If the circuit stops working, do not continue. Contact your next level of 
support.

Step 18 Complete the “DLP-A91 BLSR Switch Test” task on page 5-23 at Node 1.

Step 19 Set up and complete a BER test on the test circuit. Use the existing configuration and follow your site 
requirements for length of time. Record the test results and configuration.

Step 20 Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 for the test circuit.

Step 21 Repeating Steps 7 through 20 for Nodes 2 and higher, work your way around the BLSR, testing each 
node and span in the ring. Work your way around the BLSR creating test circuits between every two 
consecutive nodes.

Step 22 After you test the entire ring, remove any loopbacks and test sets from the nodes.

Step 23 If a node fails any test, repeat the test while verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service application. Continue with Chapter 6, “Create Circuits and VT Tunnels.”

Stop. You have completed this procedure.
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DLP-A217 BLSR Exercise Ring Test

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Click the row of the BLSR you will exercise, then click Edit. 

Step 4 Right-click the west port of any BLSR node and choose Set West Protection Operation. Figure 5-4 
shows an example. (To move a graphic icon, press Ctrl while you drag and drop it to a new location.)

Note For two fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent ports. 
Right-click either working or protect ports.

Figure 5-4 Protection Operation on a Three-Node BLSR

Step 5 On the Set West Protection Operation dialog box, choose EXERCISE RING from the pull-down menu. 
Click OK.

Step 6 On the Confirm BLSR Operation dialog box, click Yes.

On the network view graphic, an E is displayed on the working BLSR channel where you invoked the 
protection switch. The E will display for 10-15 seconds, then disappear.

Step 7 On the Cisco Transport Controller window, click the History tab. Verify that an EXERCISE-RING 
(Exercising Ring Successfully) condition is displayed for the node where you exercised the ring. Other 
conditions displayed include EXERCISE-RING-REQ, KB-PASSTHR, and FE-EXERCISING-RING.

Purpose This task tests the BLSR ring functionality without switching traffic. Ring 
exercise conditions (including the K-byte pass-through) are reported and 
cleared within 10-15 seconds.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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If you do not see any BLSR exercise conditions, click the Filter button and verify that filtering is not 
turned on. Also, check that alarms and conditions are not suppressed for a node or BLSR drop cards. See 
the “NTP-A72 Suppress and Discontinue Alarm Suppression” procedure on page 7-30 for more 
information.

Step 8 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 9 From the File menu choose Close to close the BLSR window.

Step 10 Return to your originating procedure (NTP).

DLP-A91 BLSR Switch Test

Step 1 In network view, click the Provisioning > BLSR tabs.

Step 2 Click the row of the BLSR you will switch, then click Edit. 

Step 3 Right-click any BLSR node west port and choose Set West Protection Operation. Figure 5-4 on 
page 5-22 shows an example. (To move a graphic icon, click it, then press Ctrl while you drag and drop 
it to a new location.)

Note For two fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent ports. 
Right-click either working or protect port.

Step 4 On the Set West Protection Operation dialog box, choose FORCE RING from the pull-down menu. 
Click OK.

Step 5 Click Yes on the two Confirm BLSR Operation dialog boxes that display.

On the network view graphic, an F is displayed on the BLSR channel where you invoked the Force Ring 
switch. The BLSR span lines turn purple where the switch was invoked, and all span lines between other 
BLSR nodes turn green.

Step 6 Click the Conditions tab, then click Retrieve.

Purpose Use this task to verify that protection switching is working correctly in a 
BLSR.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 Verify that the following conditions are reported on the node where you invoked the Force Ring switch 
on the West port:

• FORCE-REQ-RING—A Force Switch Request On Ring condition is reported against the span’s 
working slot on the west side of the node.

• RING-SW-EAST—A Ring Switch Active on the east side condition is reported against the working 
span on the east side of the node.

Note Make sure the Filter button in the lower right corner of the window is off. Click the Node column 
to sort conditions by node.

Step 8 Verify that the following conditions are reported on the node that is connected to the West line of the 
node where you performed the switch:

• FE-FRCDWKSWPR-RING—A Far-End Working Facility Forced to Switch to Protection condition 
is reported against the working span on the east side of the node.

• RING-SW-WEST—A Ring Switch Active on the west side condition is reported against the working 
span on the west side of the node.

Step 9 (Optional) If you remapped the K3 byte to run an ONS 15454 BLSR through third-party equipment, 
check the following condition. Verify a KBYTE-PASSTHRU condition reported on other nodes that are 
not connected to the west side of the node where you invoked the Force Ring switch.

Step 10 Verify the BLSR line status on each node:

a. From node view, click Maintenance > BLSR. 

b. Verify the following:

• The line states are shown as Stby/Stby on the west side of the node and Act/Act on the east side 
of the node where you invoked the Force Ring switch.

• The line states are shown as Stby/Stby on the east side of the node and Act/Act on the west side 
of the node that is connected to the west line of the node where you invoked the Force Ring 
switch.

• The line states are shown as Act/Act on both East and west sides of the remaining nodes in the 
ring.

Step 11 From network view, click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 12 Display the BLSR window where you invoked the Force Ring switch (the window may be hidden by the 
CTC window).

Step 13 Right-click the west port of the BLSR node where you invoked the Force Ring switch and choose Set 
West Protection Operation. 

Step 14 On the Set West Protection Operation dialog box, choose CLEAR from the pull-down menu. Click OK.

Step 15 Click Yes on the Confirm BLSR Operation dialog box.

On the network view graphic, the Force Ring switch is removed, the F indicating the switch is removed, 
and the span lines between BLSR nodes will be purple and green. The span lines may take a few 
moments to change color. 
5-24
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 5      Turn Up Network
NTP-A175 Two-Fiber BLSR Acceptance Test
Step 16 From network view, click the Conditions tab. Verify that all conditions raised in this procedure are 
cleared from the network. If unexplained conditions are displayed, resolve them before continuing. 

Step 17 Verify the BLSR line status on each node:

a. From node view, click Maintenance > BLSR. 

b. Verify that the line states are shown as Act/Stby on both the East and west sides of each node in the 
ring.

Step 18 Right-click the east port of BLSR node and choose Set East Protection Operation.

Step 19 On the Set East Protection Operation dialog box, choose FORCE RING from the pull-down menu. 
Click OK.

Step 20 Click Yes on the two Confirm BLSR Operation dialog boxes that display.

On the network view graphic, an F is displayed on the working BLSR channel where you invoked the 
Force Ring switch. The BLSR span lines are purple where the Force Ring switch was invoked, and all 
span lines between other BLSR nodes are green. The span lines may take a few moments to change color.

Step 21 Click the Conditions tab, then click Retrieve.

Step 22 Verify that the following conditions are reported on the node where you invoked the Force Ring switch 
on the East port:

• FORCE-REQ-RING—A Force Switch Request On Ring condition is reported against the span’s 
working slot on the east side of the node.

• RING-SW-WEST—A Ring Switch Active on the west side condition is reported against the working 
span on the east side of the node.

Note Make sure the Filter button in the lower right corner of the window is off. Click the Node column 
to sort conditions by node.

Step 23 Verify that the following conditions are reported on the node that is connected to the East line of the 
node where you performed the switch:

• FE-FRCDWKSWPR-RING—A Far-End Working Facility Forced to Switch to Protection condition 
is reported against the working span on the west side of the node.

• RING-SW-EAST—A Ring Switch Active on the east side condition is reported against the working 
span on the west side of the node.

Step 24 (Optional) If you remapped the K3 byte to run an ONS 15454 BLSR through third-party equipment, 
check the following condition. Verify a KBYTE-PASSTHRU condition reported on other nodes that are 
not connected to the west side of the node where you invoked the Force Ring switch.

Step 25 Verify the BLSR line status on each node:

a. From node view, click Maintenance > BLSR. 

b. Verify the following:

• The line states are shown as Stby/Stby on the east side of the node and Act/Act on the west side 
of the node where you invoked the Force Ring switch.

• The line states are shown as Stby/Stby on the west side of the node and Act/Act on the east side 
of the node that is connected to the east line of the node where you invoked the Force Ring 
switch.

• The line states are shown as Act/Act on both East and West sides of the remaining nodes in the 
ring.
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Step 26 From network view, click the Alarms tab. Verify that no unexplained alarms are displayed on the 
network. If unexplained alarms are displayed, resolve them before continuing. Refer to the Cisco ONS 
15454 Troubleshooting Guide. 

Step 27 Display the BLSR window where you invoked the Force Ring switch (the window may be hidden by the 
CTC window).

Step 28 Right-click the west port of the BLSR node where you invoked the Force Ring switch and choose Set 
East Protection Operation. 

Step 29 On the Set East Protection Operation dialog box, choose CLEAR from the pull-down menu. Click OK.

Step 30 Click Yes on the Confirm BLSR Operation dialog box.

On the network view graphic, the Force Ring switch is removed, the F indicating the switch is removed, 
and the span lines between BLSR nodes will be purple and green. The span lines may take a few 
moments to change color. 

Step 31 From network view, click the Conditions tab. Verify that all conditions raised in this procedure are 
cleared from the network. If unexplained conditions are displayed, resolve them before continuing. 

Step 32 Verify the BLSR line status on each node:

a. From node view, click Maintenance > BLSR. 

b. Verify that the line states are shown as Act/Stby on both the East and west sides of each node in the 
ring.

Step 33 From the File menu choose Close to close the BLSR window.

Step 34 Return to your originating procedure (NTP).

NTP-A176 Four-Fiber BLSR Acceptance Test

Note This procedure requires that you create test circuits and perform span switches around the ring. For 
clarity, “Node 1” refers to the login node where you begin the procedure. “Node 2” refers to the node 
connected to the East OC-N trunk (span) card of Node 1, “Node 3” refers to the node connected to the 
East OC-N trunk card of Node 2, and so on. 

Step 1 Log into one of the ONS 15454s on the BLSR you are testing. (This node will be called Node 1.) See 
the “DLP-A60 Log into CTC” task on page 3-23 for instructions. The node (default) view appears.

Step 2 From the View menu, choose Go to Network View.

Purpose This procedure tests a four-fiber BLSR.

Tools/Equipment Test set and cables appropriate to the test circuit you will create

Prerequisite Procedures NTP-A40 Provision BLSR Nodes, page 5-15

NTP-A126 Create a BLSR, page 5-18

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 3 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 4 Export the alarms data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 5 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide. 

Step 6 Export the conditions data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 7 On the network map, double-click Node 1. 

Step 8 Complete the “DLP-A92 Four-Fiber BLSR Exercise Span Test” task on page 5-28.

Step 9 Complete the “DLP-A217 BLSR Exercise Ring Test” task on page 5-22.

Step 10 Create a test circuit between Node 1 and Node 2.

• For DS-1 circuits, complete the “NTP-A181 Create an Automatically Routed DS-1 Circuit” 
procedure on page 6-6. When you set the circuit state, choose IS and check the Apply to drop ports 
check box.

• For DS-3 circuits, complete the “NTP-A184 Create an Automatically Routed DS-3 Circuit” 
procedure on page 6-20. When you set the circuit state, choose IS and check the Apply to drop 
ports check box.

Step 11 Configure the test set for the test circuit type you created: 

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15454. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

Step 12 Verify the integrity of all patch cables that will be used in this test by connecting one end of the cable 
to the test set transmit (Tx) connector and the other end of the cable to the test set receive (Rx) connector. 
If the test set does not run error-free, check the cable for damage and check the test set to make sure it 
is set up correctly before continuing.

Step 13 Create a physical loopback at the circuit destination card. To do so, attach one end of a patch cable to 
the destination port’s transmit (Tx) connector; attach the other end to the port’s receive (Rx) connector. 

Step 14 At the circuit source card:

a. Connect the transmit (Tx) connector of the test set to the circuit receive (Rx) connector.

b. Connect the test set receive (Rx) connector to the circuit transmit (Tx) connector. 
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Step 15 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 8 through 
14 to make sure the test set and cabling are configured correctly. 

Step 16 Inject global BIT errors from the test set. Verify that the errors display at the test set, verifying a 
complete end-to-end circuit. 

Step 17 This step will lockout both of the spans on the node where you perform this task. Complete the 
“DLP-A254 TCC+/TCC2 Active/Standby Switch Test” task on page 5-9.

Step 18 This step will lockout both of the spans on the node where you perform this task. Complete the 
“DLP-A255 Cross-Connect Card Side Switch Test” task on page 5-10. 

Step 19 Complete the “DLP-A91 BLSR Switch Test” task on page 5-23 to test the BLSR protection switching at 
Node 1. 

Step 20 Complete the “DLP-A93 Four-Fiber BLSR Span Switching Test” task on page 5-30 at Node 1.

Step 21 Set up and complete a BER test on the test circuit between Node 1 and 2. Use the existing configuration 
and follow your site requirements for length of time. Record the test results and configuration.

Step 22 Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 for the test circuit.

Step 23 At Node 2, repeat Steps 7 through 23, creating a test circuit between Node 2 and the node connected to 
the east OC-N trunk card of Node 2 (Node 3). Work your way around the BLSR creating test circuits 
between every two consecutive nodes.

Step 24 After you test the entire ring, remove any loopbacks and test sets from the nodes.

Step 25 View Alarms and conditions on each node and record the results by exporting them to a file. See the 
“DLP-A139 Export CTC Data” task on page 7-4 for instructions.

Step 26 If a node fails any test, repeat the test while verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service application. Continue with Chapter 6, “Create Circuits and VT Tunnels.”

Stop. You have completed this procedure.

DLP-A92 Four-Fiber BLSR Exercise Span Test

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Click the BLSR you will exercise, then click Edit. 

Purpose This task exercises a four-fiber BLSR span. Ring exercise conditions 
(including the K-byte pass-through) are reported and cleared within 10-15 
seconds.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 4 Exercise the west span:

a. Right-click the west port of the four-fiber BLSR node that you want to exercise and choose Set West 
Protection Operation. (To move a graphic icon, press Ctrl while you drag and drop it to a new 
location.)

Note For four-fiber BLSRs, the squares on the network map represent ports. Right-click a working 
port.

b. On the Set West Protection Operation dialog box, choose EXERCISE SPAN from the pull-down 
menu. Click OK.

c. On the Confirm BLSR Operation dialog box, click Yes.

On the network view graphic, an E is displayed on the BLSR channel where you invoked the 
exercise. The E will display for 10-15 seconds, then disappear.

Step 5 Click the Conditions tab, then click Retrieve.

Step 6 Verify the following conditions:

• EXERCISING-SPAN—An Exercise Ring Successful condition is reported on the node where the 
span was exercised.

• FE-EX-SPAN—A Far-End Exercise Span Request condition is reported against the East span of the 
node connected to the west side of the node where you exercised the span.

• KB-PASSTHR—If applicable, a K Byte Pass Though Active condition is reported.

Note Make sure the Filter button in the lower right corner of the window is off. Click the Node 
column to sort conditions by node.

Step 7 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are 
displayed, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 8 Exercise the east span:

a. Right-click the east port of the four-fiber BLSR node that you want to exercise and choose Set East 
Protection Operation.

b. On the Set East Protection Operation dialog box, choose EXERCISE SPAN from the pull-down 
menu. Click OK.

c. On the Confirm BLSR Operation dialog box, click Yes.

On the network view graphic, an E is displayed on the BLSR channel where you invoked the 
exercise. The E will display for 10-15 seconds, then disappear.

Step 9 From the File menu, choose Close.

Step 10 Click the Conditions tab, then click Retrieve.

Step 11 Verify the following conditions:

• EXERCISING-SPAN—An Exercise Ring Successful condition is reported on the node where the 
span was exercised.
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• FE-EX-SPAN—A Far-End Exercise Span Request condition is reported against the East span of the 
node connected to the west side of the node where you exercised the span.

• KB-PASSTHR—If applicable, a K Byte Pass Though Active condition is reported.

Note Make sure the Filter button in the lower right corner of the window is off. Click the Node column 
to sort conditions by node.

Step 12 Click the Alarms tab. Verify that no unexplained alarms are displayed on the network. If unexplained 
alarms are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting 
Guide. 

Step 13 From the File menu choose Close to close the BLSR window.

Step 14 Return to your originating procedure (NTP).

DLP-A93 Four-Fiber BLSR Span Switching Test

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Click Edit. A BLSR window is displayed containing a graphic of the BLSR.

Step 4 If the node icons are stacked on the BLSR graphic, press Ctrl while you drag and drop each one to a new 
location so you can see the BLSR port information clearly.

Step 5 Switch the west span: 

a. Right-click the west port of the four-fiber BLSR node that you want to exercise and choose Set West 
Protection Operation. Figure 5-4 on page 5-22 shows an example. 

Note For four-fiber BLSRs, the squares on the network map represent ports. Right-click a working 
port.

b. On the Set West Protection Operation dialog box, choose FORCE SPAN from the pull-down menu. 
Click OK.

c. Click Yes on the two Confirm BLSR Operation dialog boxes that display.

On the network view graphic, an F is displayed on the BLSR channel where you invoked the 
protection switch. The BLSR span lines turn purple where the Force Span switch was invoked, and 
all span lines between other BLSR nodes turn green.

Purpose This task verifies that traffic will switch from working to protect fibers on 
a four-fiber BLSR span.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 6 Click the Conditions tab, then click Retrieve.

Step 7 Verify that a SPAN-SW-WEST (Span Switch West) condition is reported on the node where you invoked 
the Force Span switch, and a SPAN-SW-EAST (Span Switch East) condition is reported on the node 
connected to the west line of the node where you performed the switch. Make sure the Filter button in 
the lower right corner of window is off. Click the Node column to sort conditions by node.

Step 8 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 9 Display the BLSR window where you invoked the Force Span switch (the window may be hidden by the 
CTC window).

Step 10 Clear the west switch:

a. Right-click the west port of the BLSR node where you invoked the Force Span switch and choose 
Set West Protection Operation. 

b. On the Set West Protection Operation dialog box, choose CLEAR from the pull-down menu. Click 
OK.

c. Click Yes on the Confirm BLSR Operation dialog box.

On the network view graphic, the Force Span switch is removed, the F disappears, and the span lines 
between BLSR nodes will be purple and green. The span lines may take a few moments to change 
color.

Step 11 Switch the east span:

a. Right-click the east port of BLSR node and choose Set East Protection Operation.

b. On the Set East Protection Operation dialog box, choose FORCE SPAN from the pull-down menu. 
Click OK.

c. Click Yes on the two Confirm BLSR Operation dialog boxes that display.

On the network view graphic, an F is displayed on the BLSR channel where you invoked the Force 
Span switch. The BLSR span lines are purple where the Force Span switch was invoked, and all span 
lines between other BLSR nodes are green. The span lines may take a few moments to change color.

Step 12 Click the Conditions tab, then click Retrieve.

Step 13 Verify that a SPAN-SW-EAST (Span Switch East) condition is reported on the node where you invoked 
the Force Span switch, and a SPAN-SW-WEST (Span Switch West) condition is reported on the node 
connected to the west line of the node where you performed the switch. Make sure the Filter button in 
the lower right corner of window is off. Click the Node column to sort conditions by node.

Step 14 Click the Alarms tab. Verify that no unexplained alarms are displayed on the network. If unexplained 
alarms are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting 
Guide. 

Step 15 Display the BLSR window where you invoked the Force Span switch (the window may be hidden by the 
CTC window).

Step 16 Clear the east switch:

a. Right-click the east port of the BLSR node where you invoked the Force Span switch and choose 
Set East Protection Operation. 

b. On the Set East Protection Operation dialog box, choose CLEAR from the pull-down menu. Click 
OK.
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c. Click Yes on the Confirm BLSR Operation dialog box.

On the network view graphic, the Force Span switch is removed, the F indicating the switch is 
removed, and the span lines between BLSR nodes will be purple and green. The span lines may take 
a few moments to change color.

Step 17 From the File menu, choose Close to close the BLSR window.

Step 18 Return to your originating procedure (NTP).

NTP-A44 Provision Path Protection Nodes

Step 1 Verify that the fiber is correctly connected to the path protection trunk (span) OC-N cards similar to 
Figure 5-5.

Figure 5-5 Path Protection Fiber Connection Example

Step 2 Log into an ONS 15454 in the path protection you are turning up. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, continue with Step 3.

Purpose Use this procedure to provision nodes for inclusion in a path protection.

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 3 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for the two 
cards/ports that will serve as the path protection ports on the node, for example, Slot 5 (OC-48)/Node 1 
and Slot 12 (OC-48)/Node 1.

Note If an ONS 15454 is not connected to a corporate LAN, DCC provisioning must be performed 
through a direct (craft) connection. Remote provisioning is possible only after all nodes in the 
network have DCC terminations provisioned to in-service OC-N ports.

Step 4 Repeat Steps 2 and 3 for each node in the path protection.

Step 5 Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33.

Stop. You have completed this procedure.

NTP-A177 Path Protection Acceptance Test

Step 1 Log into one of the ONS 15454s on the path protection you are testing. See the “DLP-A60 Log into 
CTC” task on page 3-23 for instructions. The node (default) view appears.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that no unexplained alarms are displayed on the network. If unexplained alarms are displayed, 
resolve them before continuing. Refer to the Cisco ONS 15454 Troubleshooting Guide. 

b. Verify that the alarm filter is not on. See the “DLP-A227 Disable Alarm Filtering” task on page 7-30 
for instructions.

Step 4 Export the alarms data to a file by choosing Export from the File menu. Select an export format and save 
the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 5 Click the Conditions tab. Verify that no unexplained conditions are displayed on the network. If 
unexplained conditions are displayed, resolve them before continuing. Refer to the Cisco ONS 15454 
Troubleshooting Guide.

Step 6 Export the conditions data to a file by choosing Export from the File menu. Select an export format and 
save the file to your hard drive. See the “DLP-A139 Export CTC Data” task on page 7-4 for additional 
information.

Step 7 On the network map, double-click the node that you logged into in Step 1. 

Step 8 Create a test circuit from that node to the next adjacent path protection node.

Purpose Use this procedure to test a path protection.

Tools/Equipment Test set and cables appropriate to the test circuit you will create.

Prerequisite Procedures NTP-A44 Provision Path Protection Nodes, page 5-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• For DS-1 circuits, complete the “NTP-A181 Create an Automatically Routed DS-1 Circuit” 
procedure on page 6-6. When you set the circuit state, choose IS and check the Apply to drop ports 
check box.

• For DS-3 circuits, complete the “NTP-A184 Create an Automatically Routed DS-3 Circuit” 
procedure on page 6-20. When you set the circuit state, choose IS and check the Apply to drop 
ports check box.

Step 9 Configure the test set for the test circuit type you created: 

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15454. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

Step 10 Verify the integrity of all patch cables that will be used in this test by connecting one end to the test set 
transmit (Tx) connector and the other end to the test set receive (Rx) connector. If the test set does not 
run error-free, check the cable for damage and check the test set to make sure it is set up correctly before 
continuing.

Step 11 Create a physical loopback at the circuit destination card: 

a. Attach one end of a patch cable to the destination port’s transmit (Tx) connector.

b. Attach the other end to the port’s receive (Rx) connector. 

Step 12 At the circuit source card:

a. Connect the transmit (Tx) connector of the test set to the circuit receive (Rx) connector.

b. Connect the test set receive (Rx) connector to the circuit transmit (Tx) connector. 

Step 13 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 1 through 
10 to make sure the test set and cabling are configured correctly. 

Step 14 Inject BIT errors from the test set. To verify that you have a complete end-to-end circuit, verify that the 
errors display at the test set. 

Step 15 Complete the “DLP-A254 TCC+/TCC2 Active/Standby Switch Test” task on page 5-9.

Step 16 Complete the “DLP-A255 Cross-Connect Card Side Switch Test” task on page 5-10. 

Although a service interruption under 60 ms may occur, the test circuit should continue to work before, 
during, and after the switches. If the circuit stops working, do not continue. Contact your next level of 
support.

Step 17 From the View menu, choose Go to Network View.

Step 18 Click one of the two spans leaving the circuit source node. 

Step 19 Test the path protection switching function on this span. Go to the “DLP-A94 Path Protection Protection 
Switching Test” task on page 5-35 for instructions.

Although a service interruption under 60 ms may occur, the test circuit should continue to work before, 
during, and after the switches. If the circuit stops working, do not continue. Contact your next level of 
support.

Step 20 In network view, click the other circuit source span.
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Step 21 Test the path protection switching function on this span. Go to the “DLP-A94 Path Protection Protection 
Switching Test” task on page 5-35 for instructions.

Although a service interruption under 60 ms may occur, the test circuit should continue to work before, 
during, and after the switches. If the circuit stops working, do not continue. Contact your next level of 
support.

Step 22 Set up and complete a BER Test. Use the existing configuration and follow your site requirements for 
the length of time. Record the test results and configuration.

Step 23 Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 for the test circuit.

Step 24 Remove any loopbacks, switches, or test sets from the nodes after all testing is complete.

Step 25 View the alarms and conditions on each node and record results by exporting them to a file. See the 
“DLP-A60 Log into CTC” task on page 3-23 for instructions. 

Step 26 Repeat Steps 8 through 23 for each node on the network.

Step 27 If a node fails any test, repeat the test while verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service application. Continue with Chapter 6, “Create Circuits and VT Tunnels.”

DLP-A94 Path Protection Protection Switching Test

Step 1 From the View menu, choose Go to the Network View. 

Step 2 Right-click a network span and choose Circuits.

The Circuits on Span dialog box displays the path protection configuration circuits, including circuit 
names, locations, and a color code showing which circuits are active on the span.

Step 3 Click the Perform UPSR span switching field and choose FORCE SWITCH AWAY from the 
pull-down menu. Click Apply. 

Step 4 In the Confirm UPSR Switch dialog box, click Yes.

Step 5 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span dialog box, the Switch State for all circuits is FORCE. Unprotected circuits will 
not switch.

Step 6 Click the Perform UPSR span switching field and choose CLEAR from the pull-down menu. Click 
Apply. Click Yes to confirm. 

Step 7 In the Confirm UPSR Switch dialog box, click Yes.

Purpose Use this task to verify that a path protection span is switching correctly.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 8 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span window, the Switch State for all path protection configuration circuits is CLEAR.

Step 9 Return to your originating procedure (NTP).

NTP-A216 Provision a Traditional Path Protection Dual Ring 
Interconnect

Step 1 Log into an ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you 
are already logged in, continue with Step 2.

Step 2 Complete the following steps if you have not provisioned the path protection configurations that you will 
interconnect in a Path Protection DRI. If the path protection are created, go to Step 3. 

a. Complete the “NTP-A44 Provision Path Protection Nodes” procedure on page 5-32 to provision the 
path protection.

b. Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33 to test the path 
protection.

Note All path protection configurations that will be interconnected must be at the same OC-N rate. 

Step 3 Verify that the Path Protection DRI interconnect nodes have OC-N cards installed and have fiber 
connections to the other interconnect node:

• The OC-N cards that will connect the path protection must be installed at the interconnect nodes. 
The OC-N cards in the path protection nodes and the interconnect nodes must be the same type.

• The interconnect nodes must have fiber connections. An example is shown in Figure 5-6. This 
example shows a Path Protection DRI with two rings, Nodes 1–4 and 5–8. In the example, an 
additional OC-N is installed in Slot 13 at Node 4 and connected to an OC-N in Slot 6 at Node 6. 
Nodes 3 and 5 are interconnected with OC-N cards in Slot 6 (Node 3) and Slot 13 (Node 5). 

Purpose Use this procedure to provision path protection in a traditional dual ring 
interconnect (DRI) topology. DRIs interconnect two or more path 
protection configurations to provide an additional level of protection.

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 5-6 Traditional Path Protection DRI Fiber Connection Example

Note To route circuits on the DRI, you must check the Dual Ring Interconnect check box during 
circuit creation. 
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NTP-A217 Provision an Integrated Path Protection Dual Ring 
Interconnect

Step 1 Log into an ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you 
are already logged in, continue with Step 2.

Step 2 Complete the following steps if you have not provisioned the path protection configurations that you will 
interconnect in a Path Protection DRI. If the path protection configurations are created, go to Step 3.

a. Complete the “NTP-A44 Provision Path Protection Nodes” procedure on page 5-32 to provision the 
path protection configurations.

b. Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33 to test the path 
protection configurations.

Note All path protection configurations that will be interconnected must be at the same OC-N rate. 

Step 3 Verify that the Path Protection DRI interconnect nodes have OC-N cards installed and have fiber 
connections to the other interconnect node:

• The OC-N cards that will connect the path protection configurations must be installed at the 
interconnect nodes. The OC-N cards in the path protection configuration nodes and the interconnect 
nodes must be the same type.

• The interconnect nodes must have the correct fiber connections. An example is shown in Figure 5-6. 
This example shows a Path Protection DRI with two rings, Nodes 1–4 and 5–8. In the example, an 
additional OC-N is installed in Slot 13 at Node 4 and connected to an OC-N in Slot 6 at Node 6. 
Nodes 3 and 5 are interconnected with OC-N cards in Slot 6 (Node 3) and Slot 13 (Node 5). 

Purpose Use this procedure to provision path protection in an integrated dual ring 
interconnect (DRI) topology.

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 5-7 Integrated Path Protection DRI Example

Stop. You have completed this procedure.

Node 1

Node 3

Node 2

Node 4

Slot
5

Slot
12

Tx
Rx

Slot
5

Slot
12

Tx
Rx

Slot
6

Slot
13

Slot
5

Slot
12

Tx
Rx

Slot
5

Slot
12

Tx
Rx

Slot
6

Slot
13

Node 5 Node 6

Slot
5

Slot
12

Tx
Rx

Slot
5

Slot
12

Tx
Rx

83
50

0

5-39
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 5      Turn Up Network
NTP-A46 Subtend a Path Protection from a BLSR
NTP-A46 Subtend a Path Protection from a BLSR

Step 1 In the node that will subtend the path protection configuration (Node 3 in Figure 5-8), install the two 
(east/west) OC-N cards that will serve as the path protection configuration trunk (span) cards (Node 3, 
Slots 6 and 13). See the “NTP-A16 Install the Optical Cards” procedure on page 2-13. If they are already 
installed, go to Step 2.

Step 2 Attach fibers from these cards to the path protection configuration trunk cards on the neighbor path 
protection configuration node or nodes. In Figure 5-8, Slot 6/Node 3 connects to Slot 13/Node 4, and 
Slot 13/Node 3 connects to Slot 6/Node 4.

Step 3 Log into the ONS 15454 that will subtend the path protection configuration. See the “DLP-A60 Log into 
CTC” task on page 3-23 for instructions. 

Step 4 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for each OC-N card 
that will carry the path protection configuration.

Step 5 Log into the path protection configuration node that connects to the node in Step 3.

Step 6 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for each OC-N card 
that will carry the path protection configuration.

Step 7 Repeat Step 6 for each node in the path protection configuration.

Step 8 From the View menu, choose Go To Network View.

Purpose Use this procedure to subtend a path protection configuration from an 
existing BLSR.

Tools/Equipment One BLSR node must have OC-N cards and fibers to carry the path 
protection configuration.

Prerequisite Procedures NTP-A175 Two-Fiber BLSR Acceptance Test, page 5-20 or 
NTP-A176 Four-Fiber BLSR Acceptance Test, page 5-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 5-8 Path Protection Subtended from a BLSR

Step 9 Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33.

Stop. You have completed this procedure.

NTP-A47 Subtend a BLSR from a Path Protection

Step 1 In the path protection configuration node that will subtend the BLSR, install the two (east and west) 
OC-N cards that will serve as the BLSR trunk (span) cards (in Figure 5-8 on page 5-41, Node 3, Slots 5 
and 12). See the “NTP-A16 Install the Optical Cards” procedure on page 2-13.

Step 2 Attach fibers from the cards in Step 1 to the BLSR trunk cards on another BLSR node or nodes. In 
Figure 5-8, Slot 5/Node 3 connects to Slot 12/Node 2, and Slot 12/Node 3 connects to Slot 5/Node 1.

Step 3 Log into the ONS 15454 that will subtend the BLSR (the node in Step 1). See the “DLP-A60 Log into 
CTC” task on page 3-23 for instructions. If you are already logged in, continue with Step 4.

Step 4 Create the DCCs on both OC-N trunk cards (east and west) that will carry the BLSR. See the “DLP-A253 
Provision SONET DCC Terminations” task on page 5-5 for instructions.
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Purpose Use this procedure to subtend a BLSR from an existing path protection 
configuration.

Tools/Equipment One path protection configuration node must have OC-N cards and fibers 
to carry the BLSR.

Prerequisite Procedures NTP-A177 Path Protection Acceptance Test, page 5-33

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 5 Create the subtending BLSR:

a. Complete the “NTP-A40 Provision BLSR Nodes” procedure on page 5-15 for each node that will 
be in the BLSR. If you have already provisioned the BLSR, perform this procedure for the 
subtending node only.

b. Complete the “NTP-A126 Create a BLSR” procedure on page 5-18. Include the node in Step 3 (the 
node that will subtend the BLSR) in the BLSR.

Step 6 From the View menu, choose Go to the Network View to see the subtending ring.

Stop. You have completed this procedure.

NTP-A48 Subtend a BLSR from a BLSR

Note This procedure assumes that all nodes are configured for the BLSR. If you need to add a node to a BLSR, 
see the “NTP-A102 Add a BLSR Node” procedure on page 14-2.

Step 1 Log into the node that will subtend the BLSR. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions. If you are already logged in, continue with Step 2.

Step 2 Install the OC-N cards that will serve as the BLSR trunk (span) cards if they are not already installed. 
See the “NTP-A16 Install the Optical Cards” procedure on page 2-13.

Figure 5-9 shows two BLSRs shared by one ONS 15454. Ring 1 runs on Nodes 1, 2, 3, and 4. Ring 2 
runs on Nodes 4, 5, 6, and 7 and represents the subtending ring added by this procedure. Two BLSR 
rings, Ring 1 and Ring 2, are provisioned on Node 4. Ring 1 uses cards in Slots 5 and 12, and Ring 2 
uses cards in Slots 6 and 13.

Purpose Use this procedure to subtend a BLSR from an existing BLSR.

Tools/Equipment One BLSR node must have OC-N cards and fibers needed to carry the 
second BLSR.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 5-9 BLSR Subtended from a BLSR

Step 3 Attach fibers from the trunk cards in the subtending node to the BLSR trunk cards on its two neighboring 
BLSR nodes. In Figure 5-9, Node 4/Slot 6 connects to Node 7/Slot 13, and Node 4/Slot 13 connects to 
Node 5/Slot 6.

Step 4 Create the DCCs on the first OC-N card that will carry the BLSR. See the “DLP-A253 Provision SONET 
DCC Terminations” task on page 5-5 for instructions.

Step 5 Repeat Step 4 for the second OC-N trunk card that will carry the BLSR.

Step 6 Complete the “NTP-A40 Provision BLSR Nodes” procedure on page 5-15 for each node that will be in 
the BLSR. If you have already provisioned the BLSR, perform this procedure for the subtending node 
only.

Step 7 If the subtending BLSR is not already created, complete the “NTP-A126 Create a BLSR” procedure on 
page 5-18 to provision the new BLSR. The subtending BLSR must have a ring ID that differs from the 
ring ID of the first BLSR. The subtending node can have one Node ID that is used in both BLSRs, or a 
different Node ID for each BLSR. For example, the same node can be Node #4 in BLSR #1 and Node 
#2 in BLSR #2.

Step 8 Display the network view to see the subtending ring.

Figure 5-10 shows an example of two subtending BLSRs. 

Figure 5-10 Subtended BLSRs on the Network Map
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Step 9 Complete the “NTP-A175 Two-Fiber BLSR Acceptance Test” procedure on page 5-20 or the 
“NTP-A176 Four-Fiber BLSR Acceptance Test” procedure on page 5-26 depending on the type of 
BLSR.

Stop. You have completed this procedure.
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Create Circuits and VT Tunnels

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to create Cisco ONS 15454 electrical circuits, VT tunnels, optical circuits, 
and Ethernet circuits. For additional information about ONS 15454 circuits, refer to the Circuits and 
Tunnels chapter in the Cisco ONS 15454 Reference Manual.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A127 Verify Network Turn Up, page 6-4—Complete this procedure before you create any 
circuits.

2. NTP-A181 Create an Automatically Routed DS-1 Circuit, page 6-6—Complete as needed.

3. NTP-A182 Create a Manually Routed DS-1 Circuit, page 6-10—Complete as needed.

4. NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, page 6-13—Complete as 
needed.

5. NTP-A184 Create an Automatically Routed DS-3 Circuit, page 6-20—Complete as needed.

6. NTP-A185 Create a Manually Routed DS-3 Circuit, page 6-24—Complete as needed.

7. NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, page 6-26—Complete as 
needed.

8. NTP-A133 Create an Automatically Routed VT Tunnel, page 6-32—Complete as needed.

9. NTP-A134 Create a Manually Routed VT Tunnel, page 6-35—Complete as needed.

10. NTP-A187 Create a VT Aggregation Point, page 6-38—Complete as needed.

11. NTP-A135 Test Electrical Circuits, page 6-41—Complete this procedure after you create an 
electrical circuit.
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12. NTP-A188 Create an Automatically Routed Optical Circuit, page 6-43—Complete as needed.

13. NTP-A189 Create a Manually Routed Optical Circuit, page 6-47—Complete as needed.

14. NTP-A190 Create a Unidirectional Optical Circuit with Multiple Drops, page 6-49—Complete as 
needed.

15. NTP-A62 Test Optical Circuits, page 6-55—Complete this procedure after you create an optical 
circuit.

16. NTP-A139 Create a Half Circuit on a BLSR or 1+1 Node, page 6-57—Complete this procedure as 
needed to create a half circuit using an OC-N as a destination in a BLSR or 1+1 topology.

17. NTP-A140 Create a Half Circuit on a Path Protection configuration Node, page 6-59—Complete as 
needed to create a half circuit using an OC-N as a destination in a path protection configuration.

18. NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or Single-Card Mode), page 
6-63—Complete as needed.

19. NTP-A192 Create a Circuit for an E-Series Card in Port-Mapped Mode, page 6-65—Complete as 
needed to create a circuit for an E-Series in port-mapped mode.

20. NTP-A142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 6-67—Complete as 
needed.

21. NTP-A143 Create an E-Series Hub and Spoke Ethernet Configuration, page 6-70—Complete as 
needed.

22. NTP-A144 Create an E-Series Single-Card EtherSwitch Manual Cross-Connect, page 
6-72—Complete as needed.

23. NTP-A145 Create an E-Series Multicard EtherSwitch Manual Cross-Connect, page 
6-75—Complete as needed.

24. NTP-A146 Test E-Series Circuits, page 6-82—Complete after creating E-Series SONET circuits.

25. NTP-A147 Create a G-Series Circuit, page 6-83—Complete as needed.

26. NTP-A148 Create a Manual Cross-Connect for a G-Series or an E-Series in Port-Mapped Mode, 
page 6-85—Complete as needed.

27. NTP-A149 Test G-Series or ML-Series Circuits, page 6-88—Complete after creating G-Series 
SONET circuits.

28. NTP-A193 Create an ML-Series Circuit, page 6-89—Complete as needed.

Table 6-1 defines ONS 15454 circuit creation terms and options.

Table 6-1 ONS 15454 Circuit Options

Circuit Option Description

Source The circuit source is where the circuit enters the ONS 15454 network.

Destination The circuit destination is where the circuit exits an ONS 15454 network.

Automatic 
circuit routing

CTC routes the circuit automatically on the shortest available path based on routing 
parameters and bandwidth availability.

Manual circuit 
routing

Manual routing allows you to choose a specific path, not just the shortest path chosen 
by automatic routing. You can choose a specific STS or VT for each circuit segment 
and create circuits from work orders prepared by an operations support system (OSS) 
like the Telcordia TIRKS system.
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ONS 15454 circuits are either VT or STS circuits. Table 6-2 shows the circuit source and destination 
options that display for VT circuits. 

Table 6-3 shows the options that display for STS circuits.

VT tunnel VT tunnels allow VT1.5 circuits to pass through an ONS 15454 without utilizing 
cross-connect card (XC, XCVT, XC10G) resources. VT circuits using VT tunnels 
will use cross-connect capacity only at the source and destination nodes. One VT 
tunnel can carry 28 VT1.5 circuits.

VT 
Aggregation 
Point

VT aggregation points (VAPs) allow VT circuits to be aggregated into an STS to 
reduce VT matrix resource utilization. The STS grooming end of the VAP requires an 
OC-N, EC-1, or DS3XM-6 card. VT aggregation points can be created BLSR, 1+1, 
or unprotected nodes, but cannot be created on path protection configuration nodes.

Table 6-1 ONS 15454 Circuit Options

Circuit Option Description

Table 6-2 CTC Circuit Source and Destination Options for VT Circuits

Card Ports STSs VTs DS1s

DS1-14, DS1N-14 – – – 14 

DS3-12, DS3N-12, 
DS3-12E, DS3N-12E

– – – –

DS3XM-6 6 – – 28 per port

EC1-12 12 – 28 per port –

OC3 IR 4/STM1 4 3 per port 28 per STS –

OC3-8 8 3 per port 28 per STS –

OC12 IR/STM4 
OC12 LR/STM4

– 12 28 per STS –

OC12 IR 4/STM4 
OC12 LR 4/STM4

4 12 per port 28 per STS –

All OC-48 cards – 48 28 per STS –

OC-192 – 192 28 per STS –

Table 6-3 CTC Circuit Source and Destination Options for STS Circuits

Card Ports STSs

DS1-14, DS1N-141 – –

DS3-12, DS3N-12, 
DS3-12E, DS3N-12E

12 –

DS3XM-6 6 –

EC1-12 12 –

OC3 IR 4/STM1 4 3 per port

OC3-8 8 3 per port
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NTP-A127 Verify Network Turn Up

Step 1 Log into an ONS 15454 on the network where you will create circuits. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. Wait for all the nodes that are part of the network 
to display on the network map. (Large networks may take several minutes to display all the nodes.) 

Note If this is the first time your computer has connected to this ONS 15454 network, the node icons 
will be stacked on the left side of the graphic area, possibly out of view. Use the scroll bar under 
the network map to display the icons. To separate the icons press Ctrl and drag and drop the icon 
to the new location. Repeat until all the nodes are visible on the graphic area.

Step 3 Verify node accessibility. In the network view, all node icons must be either green, yellow, orange, or red.

If all network nodes do not display after a few minutes, or if a node icon is grey with an IP address under 
it, do not continue. Look at the Net box in the lower right corner of the window. If it is grey, log in again, 
making sure not to check the Disable Network check box on the CTC Login dialog box. If problems 
persist, see Chapter 5, “Turn Up Network” to review the network turn-up procedure appropriate for your 
network topology, or refer to the Cisco ONS 15454 Troubleshooting Guide for troubleshooting 
procedures.

Step 4 Verify DCC connectivity. All nodes must be connected by green lines. If lines are missing or grey in 
color, do not continue. See Chapter 5, “Turn Up Network” and follow the network turn-up procedure 
appropriate for your network topology. Verify that all nodes have DCC connectivity before continuing.

OC12 IR/STM4 
OC12 LR/STM4

– 12

OC12 IR 4/STM4 
OC12 LR 4/STM4

4 12 per port

All OC-48 cards – 48

OC-192 – 192

1. You can route one STS circuit on a DS-1 card to carry all 14 
ports within the STS. However, 14 VT1.5s are not utilized.

Purpose This procedure verifies that the ONS 15454 network is ready for circuit 
provisioning.

Tools/Equipment None

Prerequisite Procedures Chapter 5, “Turn Up Network”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 6-3 CTC Circuit Source and Destination Options for STS Circuits

Card Ports STSs
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Step 5 Click the Alarms tab to view alarm descriptions. Investigate and resolve, if necessary, all critical (red 
node icon) or major (orange node icon) alarms. Refer to the Cisco ONS 15454 Troubleshooting Guide to 
resolve alarms before continuing.

Step 6 From the View menu, choose Go to Home View. Verify that the node is provisioned according to your 
site or engineering plan:

a. View the cards displayed in the shelf map. Verify that the ONS 15454 cards appear in the specified 
slots.

b. Click the Provisioning > General tabs. Verify that the node name, contacts, date, time, and 
NTP/SNTP server IP address (if used) are correctly provisioned. If needed, make corrections using 
the “NTP-A25 Set Up Name, Date, Time, and Contact Information” procedure on page 4-6.

c. Click the Network tab. Verify that the IP address, Subnet Mask, Default Router, Prevent LCD IP 
Config, and Gateway Settings are correctly provisioned. If not, make corrections using the 
“NTP-A169 Set Up CTC Network Access” procedure on page 4-8.

d. Click the Protection tab. Verify that protection groups are created as specified in your site plan. If 
the protection groups are not created, complete the “NTP-A170 Create Protection Groups” 
procedure on page 4-25.

e. If the node is in a BLSR, click the BLSR tab. (If the node is not in a BLSR, continue with Step f.) 
Verify that the following items are provisioned as specified in your site plan: 

• BLSR type (2-Fiber or 4-Fiber) 

• BLSR ring ID and node IDs

• Ring reversion time

• East and west card assignments 

• 4-fiber BLSRs: span reversion and east/west protect card assignments

If you need to make corrections, see the “NTP-A40 Provision BLSR Nodes” procedure on page 5-15 
for instructions.

f. Click the Security tab. Verify that the users and access levels are provisioned as specified. If not, 
see the “NTP-A30 Create Users and Assign Security” procedure on page 4-4 to correct the 
information.

g. If SNMP is used, click the SNMP tab and verify the trap and destination information. If the 
information is not correct, see the “NTP-A87 Change SNMP Settings” procedure on page 10-27 to 
correct the information. 

h. Click the DCC/GCC tab. Verify that DCCs were created to the applicable OC-N slots and ports. If 
DCCs were not created for the appropriate OC-N slots and ports, see Chapter 5, “Turn Up Network” 
and complete the turn-up procedure appropriate for your network topology.

i. Click the Timing tab. Verify that timing is provisioned as specified. If not, use the “NTP-A85 
Change Node Timing” procedure on page 10-19 to make the changes.

j. Click the Alarm Behavior tab. If you provisioned optional alarm profiles, verify that the alarms are 
provisioned as specified. If not, see the “NTP-A71 Create, Download, and Assign Alarm Severity 
Profiles” procedure on page 7-17 to change the information.

k. Verify that the network element defaults listed in the status area of the node view window is correct.

Step 7 Repeat Step 6 for each node in the network.

Step 8 As appropriate, complete the circuit creation procedure listed on page 6-1.
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Stop. You have completed this procedure.

NTP-A181 Create an Automatically Routed DS-1 Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-1), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters, 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15454 network.

• Size—VT1.5 is the default. You cannot change it. 

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of DS-1 circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same slot and sequential port numbers, you can use 
Auto-ranged to create the circuits automatically. 

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
circuits field. Auto-ranging creates identical (same source and destination) sequential circuits 
automatically. Deselect the box if you do not want CTC to create sequential circuits automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

Purpose This procedure creates an automatically routed DS-1 circuit, meaning CTC 
chooses the circuit route based on the parameters you specify and on the 
software version.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Select if you want to apply the state chosen in the State field to the circuit 
source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms are generated if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed on protected drops only, that 
is, to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards and ports as source and destination choices.

Figure 6-1 Setting Circuit Attributes For a DS-1 Circuit

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29. Otherwise, continue with 
the next step.

Step 7 Click Next. 
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Step 8 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 6-18.

Step 9 Under Circuit Routing Preferences (Figure 6-2 on page 6-8), choose Route Automatically. Two options 
are available; choose either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Select this check box if you want to specify nodes and spans to 
include or exclude in the CTC-generated circuit route.

• Review Route Before Creation—Select this check box if you want to review and edit the circuit 
route before the circuit is created.

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection configuration path segments (with 
primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected. They are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path in Step 10, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
configuration portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Figure 6-2 Setting Circuit Routing Preferences for a DS-1 Circuit
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Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 16.

a. Click Next.

b. Under Circuit Route Constraints, click a node or span on the circuit map.

c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit will be routed. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node under the Required 
Nodes/Lines or Excluded Notes Links lists and click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 14 Click Next. On the VT Circuit panel under Create, choose one of the following:

• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit to an EC-1, 
DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. A VT aggregation point (VAP) 
allows VT1.5 circuits to be routed through a node using one STS connection on the cross-connect 
card matrix rather than multiple connections on the VT1.5 matrix. If available, choose one of the 
following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 15 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 16 If you selected Review Route Before Creation in Step 9, complete the following substeps. If not, 
continue with Step 17. 

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A182 Create a Manually Routed DS-1 Circuit” procedure on page 6-10.
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Step 17 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box is displayed. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box is displayed so you can create the remaining circuits. Repeat this 
procedure for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 18 On the Circuits window, verify that the new circuit(s) appear in the circuits list.

Step 19 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

NTP-A182 Create a Manually Routed DS-1 Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (see Figure 6-1 on page 6-7), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 15454 network.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of DS-1 circuits you want to create. The default is 1. 

Purpose This procedure creates a DS-1 circuit and allows you to provision the 
circuit route.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in the 
Number of Circuits field, deselect this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC displays 
only protected cards and ports as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29. Otherwise, continue with 
the next step.

Step 7 Click Next. 

Step 8 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 6-18.

Step 9 Under Circuit Routing Preferences (see Figure 6-2 on page 6-8), deselect Route Automatically. 

Step 10 Set the circuit path protection:
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• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection configuration path segments 
(with primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 15.

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose a Node-Diverse Path option: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired— Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 Click Next. On the VT Circuit panel under Create, choose one of the following:

• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit to an EC-1, 
DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. A VT aggregation point (VAP) 
allows VT1.5 circuits to be routed through a node using one STS connection on the cross-connect 
card matrix rather than multiple connections on the VT1.5 matrix. If available, choose one of the 
following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 14 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.
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Step 15 Click Next. Under Route Review and Edit, node icons are displayed to route the circuit. The circuit 
source node is selected. Green arrows pointing from the source node to other network nodes indicate 
spans that are available for routing the circuit. 

Step 16 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 6-31 for the DS-1 circuit 
you are creating. 

Step 17 Click Finish. CTC will compare your manually-provisioned circuit route with the specified path 
diversity option you chose in Step 11. If the path does not meet the specified path diversity requirement, 
CTC displays an error message and allows you to change the circuit path. If you entered more than 1 in 
the Number of Circuits field, the Circuit Creation dialog box is displayed so you can create the remaining 
circuits. Repeat this procedure for each additional circuit.

Step 18 When all the circuits are created, CTC displays the main Circuits window. Verify that the circuit(s) you 
created are correct.

Step 19 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple 
Drops

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-3 on page 6-15), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose VT.

• Size—VT1.5 is the default. You cannot change it.

• Bidirectional—Deselect for this circuit.

Purpose This procedure creates a unidirectional DS-1 circuit with multiple drops 
(destinations).

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

Note If VT circuit source and destination ports are in an OOS_AINS, OOS_MT, or IS state, VT 
circuits in OOS_AINS will change to IS even if a physical signal is not present. Refer to the 
Cisco ONS 15454 Reference Manual for more information.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed to protect drops only, that is, to ONS 
15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC displays only 
protected cards as source and destination choices.
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Figure 6-3 Setting Circuit Attributes for a Unidirectional DS-1 Circuit

Step 6 Click Next. 

Step 7 Complete the “DLP-A95 Provision a DS-1 Circuit Source and Destination” task on page 6-18.

Step 8 Under Circuit Routing Preferences, deselect Route Automatically. When Route Automatically is not 
selected, Using Required Nodes/Spans and Review Route Before Circuit Creation are unavailable.

Step 9 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection configuration path segments 
(with primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 15.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 15. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 10 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Step 11 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 12 Click Next. On the VT Circuit panel under Create, choose one of the following:
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• VT Tunnel on Transit Nodes—This option is available if the DS-1 circuit passes through a node that 
does not have a VT tunnel, or if an existing VT tunnel is full. VT tunnels allow VT circuits to pass 
through ONS 15454s without consuming cross-connect card resources. VT tunnels can carry 28 
VT1.5 circuits. In general, creating VT tunnels is a good idea if you are creating many VT circuits 
from the same source and destination. Refer to the Cisco ONS 15454 Reference Manual for more 
information.

• VT Aggregation Point—This option is available if you are creating a DS-1 circuit to an EC-1, 
DS3XM-6, or OC-N port on a BLSR, 1+1, or unprotected node. A VT aggregation point (VAP) 
allows VT1.5 circuits to be routed through a node using one STS connection on the cross-connect 
card matrix rather than multiple connections on the VT1.5 matrix. If available, choose one of the 
following:

– Use source as the STS grooming end—Creates the VAP on the DS-1 circuit source node. This 
option is available only if the DS-1 circuit originates on an EC-1, DS3XM-6, or OC-N card.

– Use destination as the STS grooming end—Creates the VAP on the DS-1 circuit destination 
node. This option is available only if the DS-1 circuit terminates on an EC-1, DS3XM-6, or 
OC-N card.

• None—Choose this option if you do not want to create a VT tunnel or a VAP. This will be the only 
available option if CTC cannot create a VT tunnel or VAP.

Step 13 If you chose VT Aggregation Point, complete the following substeps. If not, continue with Step 16.

a. Click Next.

b. On the VT Aggregation Point Destination panel, click the node that you want to be the VAP 
destination, then click Add Destination.

Step 14 Click Next. Under Route Review and Edit, node icons are displayed so you can route the circuit 
manually. The circuit source node is selected. Green arrows pointing from the source node to other 
network nodes indicate spans that are available for routing the circuit. 

Step 15 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 6-31 for the DS-1 circuit 
you are creating. 

Step 16 Click Finish. CTC completes the circuit and displays the Circuits window.

Step 17 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 18 Click Edit (or double-click the circuit row). The Edit Circuit window is displayed with the General tab 
selected. 

All nodes in the DCC network are displayed on the network. Circuit source and destination information 
appears under the source and destination nodes. To display a detailed view of the circuit, click Show 
Detailed Map. To rearrange a node icon, select the node, press Ctrl, then drag and drop the icon to the 
new location.

Step 19 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops is displayed.

Step 20 Click Create.

Step 21 On the Define New Drop dialog box, create the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS, VT, or DS1—Choose the port, STS, VT, or DS1 from the Port, STS, VT or DS1 
pull-down menus. The card selected in Step b determines the fields that display. See Table 6-2 on 
page 6-3 for a list of options.
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d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

• If the original circuit was routed on a protected path, you can change the nodal diversity options: 
Required, Desired, Don’t Care; Link Diverse only. See Step 10 for options descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 10 for a description of the PCA option.

e. Click OK. The new drop appears in the Drops list.

Step 22 If you need to create additional drops for the circuit, repeat Steps 20 and 21 to create the additional drops.

Step 23 Click Close. The Circuits window is displayed.

Step 24 Verify that the new drops are displayed under the Destination column for the circuit you edited. If they 
do not appear repeat Steps 5 through 22, making sure all options are provisioned correctly.

Step 25 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-A314 Assign a Name to a Port

Step 1 Log into the node where you want to assign a port name for a card or cards. See the “DLP-A60 Log into 
CTC” task on page 3-23 for instructions.

Step 2 Double-click the card that has the port you want to provision.

Step 3 Click the Provisioning tab.

Step 4 Click the Port Name column for the port number you are assigning a name to and enter the desired port 
name. 

The port name can be up to 32 alphanumeric/special characters and is blank by default.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose Use this task to assign a name to a port on any ONS 15454 card.

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A95 Provision a DS-1 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node pull-down menu, choose the node where the source will originate.

Step 2 From the Slot pull-down menu, choose the slot containing the DS1-14, DS1N-14 (Figure 6-4), or 
DS3XM-6 card (Figure 6-5) where the circuit will originate. 

Figure 6-4 Defining the Circuit Source on a DS-1 Card

Purpose This task provisions an electrical circuit source and destination for a DS-1 
circuit.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures: 

NTP-A181 Create an Automatically Routed DS-1 Circuit, page 6-6, or

NTP-A182 Create a Manually Routed DS-1 Circuit, page 6-10, or

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, 
page 6-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 6-5 Defining the Circuit Source on a DS3XM-6 Card

Step 3 Only if you chose DS3XM-6 as the card, choose the port from the Port pull-down menu.

Step 4 From the DS-1 pull-down menu, choose the source DS-1.

Step 5 If you need to create a secondary source, for example, a path protection configuration bridge/selector 
circuit entry point in a multivendor path protection configuration, click Use Secondary Source and 
repeat Steps 1 through 4 to define the secondary source. If you do not need to create a secondary source, 
continue with Step 6. 

Step 6 Click Next. 

Step 7 From the Node pull-down menu, choose the destination (termination) node.

Step 8 From the Slot pull-down menu, choose the slot containing the destination card. The destination is 
typically a DS-1 card. You can also choose an OC-N card to map the DS-1 to a VT1.5 for optical 
transport.

Step 9 Depending on the destination card, choose the destination port, STS, VT, or DS1 from the sub-menus 
that display based on the card selected in Step 8. See Table 6-2 on page 6-3 for a list of valid options. 
CTC does not display ports, STSs, VTs, or DS1s already used by other circuits. If you and a user working 
on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one of you will receive 
a Path in Use error and be unable to complete the circuit. The user with the incomplete circuit needs to 
choose new destination parameters.

Step 10 If you need to create a secondary destination, for example, a path protection configuration 
bridge/selector circuit exit point in a multivendor path protection configuration, click Use Secondary 
Destination and repeat Steps 7 through 9 to define the secondary destination. 

Step 11 Click Next. 

Step 12 Return to your originating procedure (NTP).
6-19
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 6      Create Circuits and VT Tunnels
NTP-A184 Create an Automatically Routed DS-3 Circuit
NTP-A184 Create an Automatically Routed DS-3 Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-6 on page 6-21), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15454 network.

• Size—Choose STS-1.

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of DS-3 circuits you want to create. The default is 1. If you 
are creating multiple circuits with sequential source and destination ports, you can use Auto-ranged 
to create the circuits automatically. 

• Auto-ranged—This box is automatically selected if you enter more than 1 in the Number of circuits 
field. Leave selected if you are creating multiple DS-3 circuits with the same source and destination 
and you want CTC to create the circuits automatically. Deselect the box if you do not want CTC to 
create sequential circuits automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

Purpose This procedure creates an automatically routed DS-3 circuit. CTC routes 
the circuit automatically based on circuit creation parameters and the 
software version.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Check this box if you want the circuit routed on protected drops only, that is, to 
ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you check this box, CTC displays only 
protected cards and ports as source and destination choices.

Figure 6-6 Setting Circuit Attributes for a DS-3 Circuit

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 6-30.

Step 9 Under Circuit Routing Preferences (Figure 6-7 on page 6-22), choose Route Automatically. Two 
options are available; choose either, both, or none based on your preferences:

• Using Required Nodes/Spans—Select this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Select this check box to review and edit the circuit route before the 
circuit is created.

Step 10 Set the circuit path protection:
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• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 14. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection configuration path segments (with 
primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path in Step 10, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Figure 6-7 Setting Circuit Routing Preferences for a DS-3 Circuit

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps; otherwise, 
continue with Step 14:

a. Click Next. 

b. Under Circuit Route Constraints, click a node or span on the circuit map.
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c. Click Include to include the node or span in the circuit. Click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans determines the circuit 
sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node from the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Note If a node or span stays grey, that node or span is required.

Step 14 If you selected Review Route Before Creation, complete the following substeps; otherwise, continue 
with Step 15.

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A185 Create a Manually Routed DS-3 Circuit” procedure on page 6-24.

Step 15 Click Finish. One of the following actions occurs based on the circuit properties you selected:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in the Number of Circuits field. If auto ranging 
cannot complete all the circuits, for example, because sequential ports are unavailable at the source 
or destination, a dialog box is displayed. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box is displayed so you can create the remaining circuits. Repeat Steps 8 
through 15 for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 16 On the Circuits window, verify that the circuit(s) you just created appear in the circuits list.

Step 17 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-A185 Create a Manually Routed DS-3 Circuit

Step 1 Log into the node where you will create the circuit. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, continue with Step 3.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 4.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-3 on page 6-15), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave this field blank, CTC will assign a default name to the circuit.

• Type—Choose STS. STS cross-connects will carry the DS-3 circuit across the ONS 15454 network.

• Size—Choose STS-1.

• Bidirectional—Leave this field checked (default).

• Number of circuits—Type the number of DS-3 circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in The 
number Of Circuits field, deselect this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Purpose This procedure creates a DS-3 circuit and allows you to provision the 
circuit route.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, set the path protection configuration path 
selectors. See the “DLP-A218 Provision Path Protection configuration Selectors During Circuit 
Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 6-30.

Step 9 Under Circuit Routing Preferences (Figure 6-7 on page 6-22), deselect Route Automatically. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection configuration path segments 
(with primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13.

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 Click Next. Under Route Review and Edit, node icons are displayed so you can route the circuit 
manually. The green arrows pointing from the selected node to other network nodes indicate spans that 
are available for routing the circuit. 
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Step 14 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 6-31 for the DS-3 you 
are creating.

Step 15 Click Finish. If you entered more than 1 in the Number of Circuits field, the Circuit Creation dialog box 
is displayed so you can create the remaining circuits. Repeat this procedure for each additional circuit.

Step 16 When all the circuits are created, CTC displays the main Circuits window. Verify that the circuit(s) you 
created appear in the window.

Step 17 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple 
Drops

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-8 on page 6-27), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

• Size—Choose STS-1.

• Bidirectional—Deselect for this circuit.

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure creates a unidirectional DS-3 circuit with multiple drops.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards as source and destination choices.

Figure 6-8 Setting Circuit Attributes for a Unidirectional DS-3 Circuit

Step 6 If the circuit will be routed on a path protection configuration, set the path protection configuration path 
selectors. See the “DLP-A218 Provision Path Protection configuration Selectors During Circuit 
Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A208 Provision a DS-3 Circuit Source and Destination” task on page 6-30.
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Step 9 Deselect Route Automatically. When Route Automatically is not selected, Using Required 
Nodes/Spans and Review Route Before Circuit Creation are unavailable. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection configuration path segments 
(with primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 Click Next. Under Route Review and Edit, node icons are displayed so you can route the circuit 
manually. The circuit source node is selected. Green arrows pointing from the source node to other 
network nodes indicate spans that are available for routing the circuit.

Step 14 Complete the “DLP-A96 Provision a DS-1 or DS-3 Circuit Route” task on page 6-31 for the DS-3 you 
are creating.

Step 15 Click Finish. After completing the circuit, CTC displays the Circuits window.

Step 16 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search radio buttons become active.

Step 17 Click Edit. The Edit Circuit window is displayed with the General tab selected. All nodes in the DCC 
network are displayed on the network map. Circuit source and destination information appears under the 
source and destination nodes. To display a detailed view of the circuit, click Show Detailed Map. You 
can rearrange the node icons by selecting the node with the left mouse button while simultaneously 
pressing Ctrl, then dragging the icon to the new location.

Step 18 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops is displayed.

Step 19 Click Create.

Step 20 On the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot
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c. Port, STS—Choose the port and/or STS from the Port and STS pull-down menus. The card selected 
in Step b determines whether port, STS, or both display. See Table 6-2 on page 6-3 for a list of 
options.

d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

• If the original circuit was routed on a protected path, you can change the nodal diversity options: 
Required, Desired, Don’t Care; Link Diverse only. See Step 11 for options descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 10 for a description of the PCA option.

e. Click OK. The new drop appears in the Drops list.

Step 21 If you need to create additional drops for the circuit, repeat Steps 19 and 20 to create the additional drops.

Step 22 Click Close. The Circuits window displays.

Step 23 Verify that the new drops are displayed under the Destination column for the circuit you edited. If they 
do not appear, repeat this procedure, making sure all options are provisioned correctly.

Step 24 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.

DLP-A218 Provision Path Protection configuration Selectors During Circuit 
Creation

Step 1 On the Circuit Attributes panel of the Circuit Creation wizard, set the path protection configuration path 
selectors:

• Revertive—Check this box if you want traffic to revert to the working path when the conditions that 
diverted it to the protect path are repaired. If you do not choose Revertive, traffic remains on the 
protect path after the switch.

• Reversion time—If Revertive is checked, click the Reversion time field and choose a reversion time 
from the pull-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is the 
amount of time that will elapse before the traffic reverts to the working path. Traffic can revert when 
conditions causing the switch are cleared.

• SF threshold—For STS circuits, set the path protection configuration path-level signal failure bit 
error rate (BER) thresholds. Unavailable for VT circuits.

Purpose This task provisions path protection configuration selectors during circuit 
creation. Use this task only if the circuit will be routed on a path protection 
configuration.

Tools/Equipment None

Prerequisite Procedures You must have the Circuit Creation wizard displayed.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• SD threshold—For STS circuits, set the path protection configuration path-level signal degrade BER 
thresholds. Unavailable for VT circuits.

• Switch on PDI-P—For STS circuits, check this box if you want traffic to switch when an STS 
payload defect indicator is received. Unavailable for VT circuits.

Step 2 Return to your originating procedure (NTP).

DLP-A208 Provision a DS-3 Circuit Source and Destination

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node pull-down menu, choose the node where the source will originate.

Step 2 From the Slot pull-down menu, choose the slot containing the DS-3 card where the circuit will originate 
If you are configuring a DS-3 circuit with a transmux card, choose the DS3XM-6 card.

Step 3 From the Port pull-down menu, choose the source DS-3 or DS3XM-6 card as appropriate.

Step 4 If you need to create a secondary source, for example, a path protection configuration bridge/selector 
circuit entry point in a multivendor path protection configuration, click Use Secondary Source and 
repeat Steps 1 through 3 to define the secondary source. If you do not need to create a secondary source, 
continue with Step 6. 

Step 5 Click Next. 

Step 6 From the Node pull-down menu, choose the destination (termination) node.

Step 7 From the Slot pull-down menu, choose the slot containing the destination card. The destination is 
typically a DS3XM-6 or DS-3 card. You can also choose an OC-N card to the map DS-3 circuit to an 
STS.

Step 8 Depending on the destination card, choose the destination port or STS from the sub-menus that display 
based on the card selected in Step 2. See Table 6-2 on page 6-3 for a list of valid options. CTC does not 
display ports, STSs, VTs, or DS1s if they are already in use by other circuits. If you and a user working 

Purpose This task provisions an electrical circuit source and destination for a DS-3 
circuit.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures:

NTP-A184 Create an Automatically Routed DS-3 Circuit, page 6-20, or

NTP-A185 Create a Manually Routed DS-3 Circuit, page 6-24, or

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, 
page 6-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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on the same network choose the same port, STS, VT, port, or DS1 simultaneously, one of you will receive 
a Path in Use error and be unable to complete the circuit. The user with the incomplete circuit needs to 
choose new destination parameters.

Step 9 If you need to create a secondary destination, for example, a path protection configuration 
bridge/selector circuit exit point in a multivendor path protection configuration, click Use Secondary 
Destination and repeat Steps 7 and 8 to define the secondary destination. 

Step 10 Click Next. 

Step 11 Return to your originating procedure (NTP).

DLP-A96 Provision a DS-1 or DS-3 Circuit Route

Step 1 On the Circuit Creation wizard under Route Review and Edit, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. Under Selected Span, the From and To fields display span information. The source 
STS and VT (DS-1 circuit only) are displayed. Figure 6-9 shows a DS-1 circuit example.

Purpose This task provisions the circuit route for manually-routed DS-1 or DS-3 
circuits.

Tools/Equipment None

Prerequisite Procedures You perform this task during one of the following procedures:

NTP-A182 Create a Manually Routed DS-1 Circuit, page 6-10, or

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, 
page 6-13, or

NTP-A185 Create a Manually Routed DS-3 Circuit, page 6-24, or

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, 
page 6-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 6-9 Manually Routing a DS-1 Circuit

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with Step 4.

Step 4 If you want to change the source VT for DS-1 circuits, adjust the Source VT field; otherwise, continue 
with Step 5.

Note VT is grey (unavailable) for DS-3 circuits.

Step 5 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 6 Repeat Steps 2 through 5 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. If the Fully Protect Path check box is checked on the Circuit Routing Preferences 
panel, you must:

• Add two spans for all path protection configuration or unprotected portions of the circuit route from 
the source to the destination

• Add one span for all BLSR or 1+1 portions of route from the source to the destination

Step 7 Return to your originating procedure (NTP).

NTP-A133 Create an Automatically Routed VT Tunnel

Purpose This procedure creates an automatically routed VT tunnel from source to 
destination nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4
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Note VT tunnels allow VT circuits to pass through intermediary ONS 15454s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the Circuits and Tunnels chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-10 on page 6-34), complete the following fields: 

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Type—Choose VT Tunnel. The Bidirectional, Number of Circuits, Field Size, and Create 
cross-connects fields in the dialog box become unavailable.

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• Number of circuits—Unavailable for VT tunnels.

• Auto-ranged—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the tunnel 
is out of service.

– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and allows loopbacks to be performed on the 
tunnel. Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the 
state to IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit 
State” task on page 9-9.

• Apply to drop ports—Uncheck this box.

• Inter-domain (UCP) SLA—If the tunnel will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 6-10 Setting Attributes for a VT Tunnel

Step 6 Click Next. 

Step 7 Under Circuit Source, choose the node where the VT tunnel will originate from the Node pull-down 
menu. 

Step 8 Click Next.

Step 9 Under Circuit Destination, choose the node where the VT tunnel will terminate from the Node pull-down 
menu.

Step 10 Click Next.

Step 11 Under Circuit Routing Preferences, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Select this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.

• Review Route Before Creation—Select this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 12 If you selected Using Required Nodes/Spans:

a. Click Next.

b. Under Circuit Route Constraints, click a span on the VT tunnel map.

c. Click Include to include the node or span in the VT tunnel. Click Exclude to exclude the node or 
span from the VT tunnel. The order in which you choose included nodes and spans sets the VT 
tunnel sequence. Click spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the VT tunnel route. To change the tunnel routing order, choose a node under the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 13 If you selected Review Route Before Creation:

a. Click Next.

b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.
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c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.

Step 14 Click Finish. The Circuits window displays.

Step 15 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Stop. You have completed this procedure.

NTP-A134 Create a Manually Routed VT Tunnel

Note VT tunnels allow VT circuits to pass through intermediary ONS 15454s without consuming VT matrix 
resources on the cross-connect card. VT tunnels can carry 28 VT1.5 circuits. In general, creating VT 
tunnels is a good idea if you are creating many VT circuits from the same source and destination. Refer 
to the Circuits and Tunnels chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-10 on page 6-34), complete the following fields: 

• Name—Assign a name to the VT tunnel. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the tunnel.

• Type—Choose VT Tunnel. The Bidirectional, Number of Circuits, Field Size, and Create 
cross-connects fields in the dialog box become unavailable (greyed out).

• Size—Unavailable for VT tunnels.

• Bidirectional—Unavailable for VT tunnels.

• Number of circuits—Unavailable for VT tunnels.

• Auto-ranged—Unavailable for VT tunnels.

• State—Choose a service state to apply to the VT tunnel:

– IS—The VT tunnel is in service.

Purpose This procedure creates a manually routed VT tunnel from source to 
destination nodes.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS—The VT tunnel is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The VT tunnel is in service when it receives a valid signal; until then, the circuit 
is out of service.

– OOS-MT—The VT tunnel is in a maintenance state. The maintenance state does not interrupt 
traffic flow; it suppresses alarms and conditions and allows loopbacks to be performed. Use 
OOS-MT for testing or to suppress circuit alarms temporarily. Change the state to IS, OOS, or 
OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” task on 
page 9-9.

• Apply to drop ports—Uncheck this box.

– Inter-domain (UCP) SLA—If the tunnel will travel on a unified control plane (UCP) channel, 
enter the service level agreement number. Otherwise, leave the field set to zero. 

Step 6 Click Next. 

Step 7 Under Circuit Source, choose the node where the VT tunnel will originate from the Node pull-down 
menu. 

Step 8 Click Next.

Step 9 Under Circuit Destination, choose the node where the VT tunnel will terminate from the Node pull-down 
menu. 

Step 10 Click Next.

Step 11 Under Circuit Routing Preferences, deselect Route Automatically.

Step 12 Click Next. Under Route Review and Edit, node icons are displayed to route the tunnel. The circuit 
source node is selected. Green arrows pointing from the source node to other network nodes indicate 
spans that are available for routing the tunnel. 

Step 13 Complete the “DLP-A219 Provision a VT Tunnel Route” task on page 6-36 for the tunnel you are 
creating. The Circuits window displays.

Step 14 Verify that the tunnel you just created appears in the circuits list. VT tunnels are identified by VTT in 
the Type column.

Step 15 Return to your originating procedure.

DLP-A219 Provision a VT Tunnel Route

Step 1 On the Circuit Creation wizard under Route Review and Edit, click the source node icon if it is not 
already selected. Arrows indicate the available spans for routing the tunnel from the source node.

Purpose This task provisions the route for a manually-routed VT tunnel.

Tools/Equipment None

Prerequisite Procedures Perform this task as part of the “NTP-A134 Create a Manually Routed VT 
Tunnel” procedure on page 6-35.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the arrow of the span you want the VT tunnel to travel. The arrow turns white. Under Selected 
Span, the From and To fields display the slot and port that will carry the tunnel. The source STS is 
displayed. Figure 6-11 shows an example.

Figure 6-11 Manually Routing a VT Tunnel

Step 3 If you want to change the source STS, change it in the Source STS field; otherwise, continue with the 
next step.

Step 4 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 3 and 4 until the tunnel is provisioned from the source to the destination node through all 
intermediary nodes.

Step 6 Return to the “NTP-A134 Create a Manually Routed VT Tunnel” procedure on page 6-35.

Stop. You have completed this procedure.
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NTP-A187 Create a VT Aggregation Point

Note VT aggregation points can be created for circuits on BLSR, 1+1, or unprotected nodes. They cannot be 
created for circuits on path protection configuration nodes.

Note The maximum number of VAPs that you can create depends on the node protection topology and number 
of VT1.5 circuits that terminate on the node. Assuming no other VT1.5 circuits terminate at the node, 
the maximum number of VAPs that you can terminate at one node is 8 for 1+1 and path protection 
configuration and 12 for BLSR protection. 

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-12 on page 6-39), complete the following fields: 

• Name—Assign a name to the VT aggregation point. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the VAP.

• Type—Choose VT Aggregation Point. The Size, Bidirectional, Number of Circuits, and Create 
cross-connects fields in the dialog box become unavailable.

• Size—Unavailable for VAPs.

• Bidirectional—Unavailable for VAPs.

• Number of circuits—Unavailable for VAPs.

• Auto-ranged—Unavailable for VAPs.

• State—Choose a service state to apply to the VAP:

• IS—The VAP is in service.

• OOS—The VAP is out of service. Traffic is not passed on the circuit.

Purpose This procedure creates a VT aggregation point (VAP). VAPs allow multiple 
DS-1 (VT1.5) circuits to be aggregated on a single STS on an OC-N, EC-1, 
or DS3XM-6 card. VAPs allow multiple VT1.5 circuits to pass through 
cross-connect cards without utilizing resources on the cross-connect card 
VT matrix.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OOS-AINS—The VAP is in service when it receives a valid signal; until then, the tunnel is out 
of service.

• OOS-MT—The VAP is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the VAP. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Uncheck this box.

• Inter-domain (UCP) SLA—If the VAP will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Figure 6-12 Setting Attributes for a VT Aggregation Point

Step 6 Click Next. 

Step 7 Under Circuit Source, choose the source node, slot, port, and STS for the VAP. The VAP source is where 
the DS-1 (VT1.5) circuits will be aggregated into a single STS. The VAP destination is where the DS-1 
circuits originate.

a. From the Node pull-down menu, choose the node where the VAP will originate.

b. From the Slot pull-down menu, choose the slot containing the OC-N, EC-1 or DS3XM-6 card where 
the VAP will originate. 

c. Choose either the port or STS:

• If you choose an EC-1 or DS3XM-6 card, from the Port pull-down menu, choose the source 
port.

• If you choose an OC-N card, from the STS pull-down menu, choose the source STS.

Step 8 Click Next.

Step 9 Under Circuit Destination, choose the node where the VT circuits aggregated by the VAP will terminate 
from the Node pull-down menu.

Step 10 Click Next.

Step 11 Under Circuit Routing Preferences, choose Route Automatically. Two options are available; choose 
either, both, or none based on your preferences. 

• Using Required Nodes/Spans—Select this check box to specify nodes and spans to include or 
exclude in the CTC-generated tunnel route.
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• Review Route Before Creation—Select this check box to review and edit the VT tunnel route before 
the circuit is created.

Step 12 If you selected Using Required Nodes/Spans:

a. Click Next.

b. Under Circuit Route Constraints, click a span on the VAP map.

c. Click Include to include the node or span in the VAP. Click Exclude to exclude the node or span 
from the VAP. The sequence in which you choose the nodes and spans sets the VAP sequence. Click 
spans twice to change the circuit direction. 

d. Repeat Step c for each node or span you wish to include or exclude.

e. Review the VAP route. To change the tunnel routing order, choose a node under the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the tunnel 
routing order. Click Remove to remove a node or span.

Step 13 If you selected Review Route Before Creation:

a. Click Next.

b. Review the tunnel route. To add or delete a tunnel span, choose a node on the tunnel route. Blue 
arrows show the tunnel route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned tunnel does not reflect the routing and configuration you want, click Back to 
verify and change tunnel information.

Step 14 Click Finish. The Circuits window displays.

Step 15 Verify that the VAP you just created appears in the circuits list. VAPs are identified in the Type column.

Stop. You have completed this procedure.
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NTP-A135 Test Electrical Circuits

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuit tab. 

Step 4 Set the circuit and circuit ports to the maintenance state (OOS-MT). Take note of the original state 
because you will return the circuit to that state later.

a. Click the circuit you want to test then choose Circuits > Set Circuit State from the Tools menu.

b. On the Set Circuit State dialog box, choose OOS-MT from the Target State pull-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 5 Set the source and destination DS-1 card line length:

a. In network view, double-click the source node.

b. Double-click the circuit source card and click the Provisioning > Line tabs.

c. From the circuit source port Line Length pull-down menu, choose the line length for the distance 
(in feet) between the DSX (if used) or circuit termination point and the source ONS 15454.

d. Click Apply.

e. From the View menu, choose Go to Network View.

f. Repeat Steps a. through  e. for the destination port line length.

Purpose This procedures tests DS-1 and DS-3 circuits.

Tools/Equipment A test set and all appropriate cables

Prerequisite Procedures This procedure assumes you completed a facility loopback tests on the 
fibers and cables from the source and destination ONS 15454s to the DSX, 
and that you created a circuit using one of the following procedures:

NTP-A181 Create an Automatically Routed DS-1 Circuit, page 6-6

NTP-A182 Create a Manually Routed DS-1 Circuit, page 6-10

NTP-A183 Create a Unidirectional DS-1 Circuit with Multiple Drops, 
page 6-13

NTP-A184 Create an Automatically Routed DS-3 Circuit, page 6-20

NTP-A185 Create a Manually Routed DS-3 Circuit, page 6-24

NTP-A186 Create a Unidirectional DS-3 Circuit with Multiple Drops, 
page 6-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
6-41
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 6      Create Circuits and VT Tunnels
NTP-A135 Test Electrical Circuits
Step 6 Attach loopback cables to the circuit destination card. 

a. Verify the integrity of the loopback cable by looping the test set transmit (Tx) connector to the test 
set receive (Rx) connector. If the test set does not run error-free, check the cable for damage and 
check the test set to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the transmit the (Tx) connector to the 
receive (Rx) connector of the port. 

Step 7 Attach loopback cables to the circuit source node.

a. Verify the integrity of loopback cable by looping the test set transmit (Tx) connector to the test set 
receive (Rx) connector. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly before going to Step b.

b. Attach the loopback cable to the port you are testing. Connect the test set to the circuit source port: 
(transmit (Tx) port of the test set to the circuit receive (Rx) port; test set receive (Rx) port to the 
circuit transmit (Tx) port. 

Step 8 Configure the test set for the ONS 15454 card that is the source of the circuit you are testing:

• DS-1—If you are testing an unmuxed DS-1, you must have a DSX-1 panel or a direct DS-1 interface 
into the ONS 15454. Set the test set for DS-1. For information about configuring your test set, 
consult your test set user guide.

• DS-3—If you are testing a clear channel DS-3, you must have a DSX-3 panel or a direct DS-3 
interface into the ONS 15454. Set the test set for clear channel DS-3. For information about 
configuring your test set, consult your test set user guide.

• DS3XM-6—If you are testing a DS-1 circuit on a DS3XM-6 card you must have a DSX-3 panel or 
a direct DS-3 interface to the ONS 15454. Set the test set for a muxed DS3. After you choose muxed 
DS-3, choose the DS-1 to test on the muxed DS-3. For information about configuring your test set, 
consult your test set user guide.

• EC-1—If you are testing a DS-1 on an EC1 card, you must have a DSX-3 panel or a direct DS-3 
interface to the ONS 15454. Set the test set for an STS-1. After you choose STS-1, choose the DS1 
to test the STS-1. For information about configuring your test set, consult your test set user guide.

Step 9 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 1 through 
8 to make sure the test set and cabling is configured correctly. 

Step 10 Inject errors from the test set. Verify that the errors display at the source and destination nodes. 

Step 11 Clear the PMs for the ports that you tested. See the “DLP-A130 Clear Selected PM Counts” task on 
page 8-18 for instructions.

Step 12 Put the circuit and circuit ports back to the state they were in at the beginning of the test:

a. Click the circuit you want to test then choose Circuits > Set Circuit State from the Tools menu.

b. On the Set Circuit State dialog box, choose IS (in service), OOS (out of service) or OOS-AINS 
(auto in service) from the Target State pull-down menu.

c. Check the Apply to drop ports check box.

d. Click Apply.

Step 13 Perform the protection switch test appropriate to the SONET topology:

• For path protection configurations, complete the “DLP-A94 Path Protection Protection Switching 
Test” task on page 5-35

• For BLSRs complete the “DLP-A91 BLSR Switch Test” task on page 5-23.

Step 14 Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time. For 
information about configuring your test set for BERT, see your test set user guide.
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Step 15 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results see your test set user guide. 

Stop. You have completed this procedure.

NTP-A188 Create an Automatically Routed Optical Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box (Figure 6-13 on page 6-44), complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

• Size—Choose the optical circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, 
STS-48c, or STS-192c.

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of optical circuits you want to create. The default is 1. If you 
are creating multiple circuits with the same source and destination, you can use auto-ranging to 
create the circuits automatically. 

• Auto-ranged—This check box is automatically selected when you enter more than 1 in the Number 
of circuits field. Leave this check box selected if you are creating multiple optical circuits with the 
same source and destination and you want CTC to create the circuits automatically. Deselect the box 
if you do not want CTC to create the circuits automatically.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

Purpose This procedure creates an automatically-routed bidirectional or 
unidirectional optical circuit, including STS-1 and concatenated STS-3c, 
STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, or STS-192c speeds.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed to protected drops only, that 
is, to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards as source and destination choices.

Figure 6-13 Setting Circuit Attributes for an Optical Circuit

Step 6 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A97 Provision an Optical Circuit Source and Destination” task on page 6-52 for the 
optical circuit you are creating.

Step 9 Under Circuit Routing Preferences (Figure 6-14 on page 6-45), choose Route Automatically. Two 
options are available; choose either, both, or none based on your preferences. 
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• Using Required Nodes/Spans—Choose this check box to specify nodes and spans to include or 
exclude in the CTC-generated circuit route.

• Review Route Before Creation—Choose this check box to review and edit the circuit route before 
the circuit is created.

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. CTC creates a fully-protected circuit route based on the path diversity option you choose. 
Fully-protected paths may or may not have path protection configuration path segments (with 
primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13. 

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Figure 6-14 Setting Circuit Routing Preferences for an Optical Circuit
.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 If you selected Using Required Nodes/Spans in Step 9, complete the following substeps. If not, continue 
with Step 14:

a. Click Next.

b. Under Circuit Route Constraints, click a node or span on the circuit map.
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c. Click Include to include the node or span in the circuit, or click Exclude to exclude the node or span 
from the circuit. The order in which you choose included nodes and spans is the order in which the 
circuit will be routed. Click spans twice to change the circuit direction. 

d. Repeat Step c. for each node or span you wish to include or exclude.

e. Review the circuit route. To change the circuit routing order, choose a node under the Required 
Nodes/Lines or Excluded Notes Links lists, then click the Up or Down buttons to change the circuit 
routing order. Click Remove to remove a node or span.

Step 14 If you selected Review Route Before Creation in Step 9, complete the following substeps; otherwise, 
continue with Step 15:

a. Click Next.

b. Review the circuit route. To add or delete a circuit span, choose a node on the circuit route. Blue 
arrows show the circuit route. Green arrows indicate spans that you can add. Click a span arrowhead, 
then click Include to include the span or Remove to remove the span.

c. If the provisioned circuit does not reflect the routing and configuration you want, click Back to 
verify and change circuit information. If the circuit needs to be routed to a different path, see the 
“NTP-A189 Create a Manually Routed Optical Circuit” procedure on page 6-47 to assign the circuit 
route yourself.

Step 15 Click Finish. One of the following occurs, based on the circuit properties you provisioned in the Circuit 
Creation dialog box:

• If you entered more than 1 in the number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of circuits. If auto ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable on the source or 
destination, a dialog box is displayed. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box is displayed so you can create the remaining circuits. Repeat Steps 
Step 5 through 15 for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 16 On the Circuits window, verify that the circuit(s) you created appear in the circuits list.

Step 17 Complete the “NTP-A62 Test Optical Circuits” procedure on page 6-55. Skip this step if you built a test 
circuit.

Stop. You have completed this procedure.
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NTP-A189 Create a Manually Routed Optical Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the optical circuit size. Choices are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, 
STS-24c, STS-48c, or STS-192c.

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of optical circuits you want to create. The default is 1. 

• Auto-ranged—Applies to automatically-routed circuits only. If you entered more than 1 in the 
number Of Circuits field, deselect this box. (The box is unavailable if only one circuit is entered in 
Number of Circuits.)

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 

Purpose This procedure creates a manually routed, bidirectional or unidirectional 
optical circuit, including STS-1 and concatenated STS-3c, STS-6c, 
STS-9c, STS-12c, STS-24c, STS-48c, or STS-192c speeds.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards as source and destination choices.

Step 5 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 6 Click Next.

Step 7 Complete the “DLP-A97 Provision an Optical Circuit Source and Destination” task on page 6-52 for the 
optical circuit you are creating.

Step 8 Under Circuit Routing Preferences (Figure 6-14 on page 6-45), deselect Route Automatically. 

Step 9 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 10. 

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 12.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 12. 

Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 10 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse. 

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Step 11 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 12 Click Next. Under Route Review and Edit, node icons are displayed so you can route the circuit 
manually. 
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Step 13 Complete the “DLP-A98 Provision an Optical Circuit Route” task on page 6-53.

Step 14 Click Finish. If the path does not meet the specified path diversity requirement, CTC displays an error 
message and allows you to change the circuit path. If you entered more than 1 in the number of Circuits 
field, the Circuit Creation dialog box is displayed after the circuit is created so you can create the 
remaining circuits. Repeat Steps 4 through 14 for each additional circuit.

Step 15 When all the circuits are created, CTC displays the main Circuits window. Verify that the circuit(s) you 
created appear in the window.

Step 16 Complete the “NTP-A62 Test Optical Circuits” procedure on page 6-55.

Stop. You have completed this procedure.

NTP-A190 Create a Unidirectional Optical Circuit with Multiple 
Drops

Step 1 Log into the node where you will create the circuit. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the tunnel source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View.

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS. 

• Size—Choose the circuit size: STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, or 
STS-192c.

• Bidirectional—Deselect this check box for this circuit.

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable when the Number of Circuits field is 1.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

Purpose This procedure creates a unidirectional OC-N circuit with multiple traffic 
drops (circuit destinations).

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Select this check box if you want the circuit routed to protect drops only, that is, 
to ONS 15454 cards that are in 1:1, 1:N, or 1+1 protection. If you select this check box, CTC 
displays only protected cards as source and destination choices.

Step 6 If the circuit will be routed on a path protection configuration, set the path protection configuration path 
selectors. See the “DLP-A218 Provision Path Protection configuration Selectors During Circuit 
Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A97 Provision an Optical Circuit Source and Destination” task on page 6-52 for the 
circuit you are creating.

Step 9 Deselect Route Automatically. When Route Automatically is not selected, Using Required 
Nodes/Spans and Review Route Before Circuit Creation are unavailable. 

Step 10 Set the circuit path protection:

• To route the circuit on a protected path, leave Fully Protected Path checked and continue with 
Step 11. Fully-protected paths may or may not have path protection configuration path segments 
(with primary and alternate paths), and the path diversity options apply only to path protection 
configuration path segments, if any exist.

• To create an unprotected circuit, uncheck Fully Protected Path and continue with Step 13.

• To route the circuit on a BLSR protection channel, if available, uncheck Fully Protected Path, 
check Protection Channel Access, click Yes on the Warning dialog box, then continue with 
Step 13. 
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Caution Circuits routed on BLSR protection channels are not protected and are preempted during BLSR 
switches.

Step 11 If you selected Fully Protected Path, choose one of the following: 

• Nodal Diversity Required—Ensures that the primary and alternate paths within the path protection 
configuration portions of the complete circuit path are nodally diverse.

• Nodal Diversity Desired—Specifies that node diversity is preferred, but if node diversity is not 
possible, CTC creates fiber-diverse paths for the path protection configuration portion of the 
complete circuit path.

• Link Diversity Only—Specifies that only fiber-diverse primary and alternate paths for path 
protection configuration portions of the complete circuit path are needed. The paths may be 
node-diverse, but CTC does not check for node diversity.

Note For manually-routed circuits, CTC checks your manually-provisioned path against the path 
diversity option you choose. If the path does not meet the path diversity requirement that is 
specified, CTC displays an error message.

Step 12 If you selected Fully Protected Path and the circuit will be routed on a path protection configuration dual 
ring interconnect (DRI), click the Dual Ring Interconnect check box.

Step 13 Click Next. Under Route Review and Edit, node icons are displayed so you can route the circuit 
manually. The green arrows pointing from the selected node to other network nodes indicate spans that 
are available for routing the circuit. 

Step 14 Complete the “DLP-A98 Provision an Optical Circuit Route” task on page 6-53.

Step 15 Click Finish. After completing the circuit, CTC displays the Circuits window.

Step 16 On the Circuits window, click the circuit that you want to route to multiple drops. The Delete, Edit, and 
Search buttons become active.

Step 17 Click Edit. The Edit Circuit window is displayed with the General tab selected. All nodes in the DCC 
network are displayed. Circuit source and destination information appears under the source and 
destination nodes. To display a detailed view of the circuit, click Show Detailed Map. You can rearrange 
the node icons by pressing Ctrl while you drag and drop the icon to the new location.

Step 18 On the Edit Circuit dialog box, click the Drops tab. A list of existing drops is displayed.

Step 19 Click Create.

Step 20 On the Define New Drop dialog box, define the new drop:

a. Node—Choose the target node for the circuit drop.

b. Slot—Choose the target card and slot.

c. Port, STS—Choose the port and/or STS from the Port and STS pull-down menus. The choice in 
these menus depends on the card selected in Step b. See Table 6-2 on page 6-3 for a list of options.

d. The routing preferences for the new drop will match those of the original circuit. However, you can 
modify the following: 

• If the original circuit was routed on a protected path, you can change the nodal diversity options: 
Required, Desired, Don’t Care; Link Diverse only. See Step 11 for options descriptions. 

• If the original circuit was not routed on a protected path, the Protection Channel Access options 
is available. See Step 10 for a description of the PCA option.
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e. Click OK. The new drop appears in the Drops list.

Step 21 If you need to create additional drops on the circuit, repeat Steps 18 through 20.

Step 22 Click Close. The Circuits window appears.

Step 23 Verify that the new drops are displayed under the Destination column for the circuit you edited. If they 
do not appear, repeat Steps 19 through 22 making sure all options are provisioned correctly.

Step 24 Complete the “NTP-A62 Test Optical Circuits” procedure on page 6-55.

Stop. You have completed this procedure.

DLP-A97 Provision an Optical Circuit Source and Destination

Step 1 From the Node pull-down menu, choose the node where the circuit will originate.

Step 2 From the Slot pull-down menu, choose the slot containing the optical card where the circuit originates. 
(If a card’s capacity is fully utilized, it does not appear in the menu.)

Step 3 Depending on the circuit origination card, choose the source port and/or STS from the Port and STS 
menus. The Port menu is only available if the card has multiple ports. STSs are not displayed if they are 
already in use by other circuits.

Note The STSs that display depend on the card, circuit size, and protection scheme. For example, if 
you create an STS-3c circuit on an OC-12 card in a path protection configuration, only four STSs 
are available. If you create an STS-3c circuit on an OC-12 card in a BLSR, two STSs are 
available because of the BLSR protection characteristics.

Step 4 If you need to create a secondary source, for example, a path protection configuration bridge/selector 
circuit entry point in a multivendor path protection configuration, click Use Secondary Source and 
repeat Steps 1 through 3 to define the secondary source.

Step 5 Click Next.

Step 6 From the Node pull-down menu, choose the destination node.

Step 7 From the Slot pull-down menu, choose the slot containing the optical card where the circuit will 
terminate (destination card). (If a card’s capacity is fully utilized, the card does not appear in the menu.)

Purpose This task provisions an optical circuit source and destination.

Tools/Equipment None

Prerequisite Procedures Perform this task during one of the following procedures:

NTP-A188 Create an Automatically Routed Optical Circuit, page 6-43

NTP-A189 Create a Manually Routed Optical Circuit, page 6-47

NTP-A190 Create a Unidirectional Optical Circuit with Multiple Drops, 
page 6-49

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Depending on the card selected in Step 2, choose the destination port and/or STS from the Port and STS 
sub-menus. The Port menu is available only if the card has multiple ports. The STSs that display depend 
on the card, circuit size, and protection scheme. 

Step 9 If you need to create a secondary destination, for example, a path protection configuration 
bridge/selector circuit entry point in a multivendor path protection configuration, click Use Secondary 
Destination and repeat Steps 6 through 8 to define the secondary destination. 

Step 10 Click Next.

Step 11 Return to your originating procedure (NTP).

DLP-A98 Provision an Optical Circuit Route

Step 1 On the Circuit Creation wizard under Route Review and Edit, click the source node icon if it is not 
already selected.

Step 2 Starting with a span on the source node, click the arrow of the span you want the circuit to travel. The 
arrow turns white. Under Selected Span, the From and To fields display span information. The source 
STS is displayed. Figure 6-15 shows an example.

Purpose This task provisions the circuit route for manually-routed optical circuits.

Tools/Equipment None

Prerequisite Procedures Perform this task during one of the following procedures:

NTP-A188 Create an Automatically Routed Optical Circuit, page 6-43

NTP-A189 Create a Manually Routed Optical Circuit, page 6-47

NTP-A190 Create a Unidirectional Optical Circuit with Multiple Drops, 
page 6-49

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 6-15 Manually Routing an OC-N Circuit

Step 3 If you want to change the source STS, adjust the Source STS field; otherwise, continue with Step 4.

Note VT is grey for OC-N circuits.

Step 4 Click Add Span.The span is added to the Included Spans list and the span arrow turns blue. 

Step 5 Repeat Steps 2 through 4 until the circuit is provisioned from the source to the destination node through 
all intermediary nodes. If Fully Protect Path is checked on the Circuit Routing Preferences panel, you 
must:

• Add two spans for all path protection configuration or unprotected portions of the circuit route from 
the source to the destination

• Add one span for all BLSR or 1+1 portions of route from the source to the destination

Step 6 Return to your originating procedure (NTP).
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NTP-A62 Test Optical Circuits

Step 1 Log into the node where you will create the circuit. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. 

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab. 

Step 4 Set the circuit and circuit ports to Out of Service-Maintenance (OOS_MT):

a. Click the circuit you want to test.

b. From the Tools menu, choose Circuits > Set Circuit State. 

c. On the Set Circuit State dialog box, choose OOS-MT from the Target State pull-down menu.

d. If unchecked, check the Apply to drop ports check box.

e. Click Apply.

Step 5 Set up the patch cable at the destination node: 

a. Test the patch cable by connecting one end to the test set transmit (Tx) port and the other end to the 
test receive (Rx) port. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly.

b. Install the loopback cable on the port you are testing. Connect the transmit (Tx) connector to the 
receive (Rx) connector of the port being tested.

Step 6 Set up the loopback cable at the source node:

a. Test the loopback cable by connecting one end to the test set transmit (Tx) port and the other end to 
the test receive (Rx) port. If the test set does not run error-free, check the cable for damage and check 
the test set to make sure it is set up correctly.

b. At the source node attach the loopback cable to the port you are testing. Connect the test set to the 
circuit source port: transmit (Tx) port of the test set to the circuit receive (Rx) port; test set receive 
(Rx) port to the circuit transmit (Tx) port. 

Step 7 Configure the test set for the source ONS 15454 card:

• OC-3 cards—You will test either an OC-3c (the “c” denotes concatenated) or a muxed OC-3. If you 
are testing an OC-3c, configure the test set for an OC-3c. If you are testing a muxed OC-3, configure 
the test set for a muxed OC-3 and choose the DS-3 and/or DS-1 you will test. For information about 
configuring your test set, consult your test set user guide.

Purpose This procedure tests an optical circuit.

Tools/Equipment Test set capable of optical speeds, appropriate fibers, and attenuators

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX and one of following circuit procedures:

NTP-A188 Create an Automatically Routed Optical Circuit, page 6-43

NTP-A189 Create a Manually Routed Optical Circuit, page 6-47

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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• OC-12 cards—You will test either an OC-12c or a muxed OC-12. If you are testing an OC-12c, 
configure the test set for an OC-12c. If you are testing a muxed OC-12, configure the test set for a 
muxed OC12 and choose the DS-3 and/or DS-1 you will test. For information about configuring 
your test set, consult your test set user guide.

• OC-48 cards—You will test either an OC-48c or a muxed OC-48. If you are testing an OC-48c 
configure the test set for an OC-48c. If you are testing a muxed OC-48, configure the test set for a 
muxed OC-48 and choose the DS-3 and/or DS-1 you will test. For information about configuring 
your test set, consult your test set user guide.

• OC-192 cards—You will test an OC-192c or a muxed OC-192. If you are testing an OC-192c 
configure the test set for an OC-192c. If you are testing a muxed OC-192, configure the test set for 
a muxed OC-192 and choose the DS-3 and/or DS-1 you will test. For information about configuring 
your test set, consult your test set user guide.

Step 8 Verify that the test set displays a clean signal. If a clean signal is not displayed, repeat Steps 1 through 
7 to make sure you have configured the test set and cabling correctly. 

Step 9 Inject errors from the test set. Verify that the errors display at the source and destination nodes. 

Step 10 Clear the PMs for the ports that you tested. See the “DLP-A130 Clear Selected PM Counts” task on 
page 8-18 for instructions.

Step 11 Perform protection switch testing appropriate to SONET topology:

• For path protection configurations, see the “DLP-A94 Path Protection Protection Switching Test” 
task on page 5-35.

• For BLSRs see the “DLP-A91 BLSR Switch Test” task on page 5-23.

Step 12 Perform a bit error rate test (BERT) for 12 hours or follow your site requirements for length of time. For 
information about configuring your test set for BERT, see your test set user guide.

Step 13 After the BERT is complete, print the results or save them to a disk for future reference. For information 
about printing or saving test results see your test set user guide. 

Step 14 Change the circuit and circuit ports from OOS_MT to their previous service states:

a. Click the circuit you want to test, then from the Tools menu choose Circuits > Set Circuit State. 

b. On the Set Circuit State dialog box, choose IS (in service), OOS (out of service), or OOS-AINS 
(auto inservice) from the Target State pull-down menu.

c. If unchecked, check the Apply to drop ports check box.

d. Click Apply.

Stop. You have completed this procedure.
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NTP-A139 Create a Half Circuit on a BLSR or 1+1 Node

Step 1 Log into a node on the network where you will create the half circuit. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—For DS1 circuits, choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 
15454 network. For DS-3 or OC-N circuits, choose STS. STS cross-connects will carry the DS-3 
circuit across the ONS 15454 network. 

• Size—For DS-3 or OC-N circuits, choose STS-1. For DS-1 circuits, VT1.5 is the default. You cannot 
change it.

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of circuits you want to create. The default is 1.

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
circuits field. Deselect the box.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Select this check box if you want to apply the state chosen in the State field 
to the circuit source and destination ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 

Purpose This procedure creates a DS-1, DS-3, or OC-N circuit from a drop card to 
an OC-N trunk card on the same node in a BLSR or 1+1 topology.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays 
the ports where the circuit state could not be applied. If the box is unchecked, CTC will not change 
the state of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Deselect this box.

Step 6 Click Next. 

Step 7 Complete the “DLP-A311 Provision a Half Circuit Source and Destination - BLSR and 1+1” task on 
page 6-61.

Step 8 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of circuits. If auto ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable at the source or 
destination, a dialog box is displayed. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box is displayed so you can create the remaining circuits. Repeat this 
procedure for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 9 On the Circuits window, verify that the new circuits appear in the circuits list.

Step 10 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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NTP-A140 Create a Half Circuit on a Path Protection 
configuration Node

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 From the View menu, choose Go to Network View. 

Step 4 Click the Circuits tab, then click Create.

Step 5 In the Circuit Creation dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—For DS1 circuits, choose VT. VT cross-connects will carry the DS-1 circuit across the ONS 
15454 network. For DS-3 or OC-N circuits, choose STS. STS cross-connects will carry the DS-3 
circuit across the ONS 15454 network. 

• Size—For DS-1 circuits, VT1.5 is the default. You cannot change it. For DS-3 or OC-N circuits, 
choose STS-1. 

• Bidirectional—Leave checked for this circuit (default).

• Number of circuits—Type the number of circuits you want to create. The default is 1. I

• Auto-ranged—This check box is automatically selected if you enter more than 1 in the Number of 
circuits field. Deselect the box.

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

Purpose This procedure creates a DS1, DS3, or OC-N circuit from a drop to an 
OC-N line card on the same path protection configuration node.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Apply to drop ports—Check this box if you want to apply the state chosen in the State field to the 
circuit source and destination ports. CTC will apply the circuit state to the ports only if the circuit 
bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the circuit, the 
circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays the ports 
where the circuit state could not be applied. If the box is unchecked, CTC will not change the state 
of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Check this box if you want to create one or more 
cross-connects to complete a signal path for TL1-generated circuits. If this box is checked, you 
cannot assign a name to the circuit. Also, VT tunnels and Ethergroup sources and destinations are 
unavailable.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave this box unchecked.

Step 6 Set the path protection configuration path selectors. See the “DLP-A218 Provision Path Protection 
configuration Selectors During Circuit Creation” task on page 6-29.

Step 7 Click Next. 

Step 8 Complete the “DLP-A312 Provision a Half Circuit Source and Destination - Path Protection 
configuration” task on page 6-62.

Step 9 Click Use Secondary Destination and repeat Steps 7 through 9 to define the secondary destination. 

Step 10 Click Finish. One of the following results occurs, depending on the circuit properties you chose in the 
Circuit Creation dialog box:

• If you entered more than 1 in the Number of Circuits field and selected Auto-ranged, CTC 
automatically creates the number of circuits entered in Number of circuits. If auto ranging cannot 
complete all the circuits, for example, because sequential ports are unavailable at the source or 
destination, a dialog box is displayed. Set the new source or destination for the remaining circuits, 
then click Finish to continue auto ranging.

• If you entered more than 1 in the Number of Circuits field and did not choose Auto-ranged, the 
Circuit Creation dialog box is displayed so you can create the remaining circuits. Repeat this 
procedure for each additional circuit.

• After completing the circuit(s), CTC displays the Circuits window.

Step 11 On the Circuits window, verify that the new circuits appear in the circuits list.

Step 12 Complete the “NTP-A135 Test Electrical Circuits” procedure on page 6-41. Skip this step if you built a 
test circuit.

Stop. You have completed this procedure.
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DLP-A311 Provision a Half Circuit Source and Destination - BLSR and 1+1

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node pull-down menu, choose the node that will contain the half circuit.

Step 2 From the Node pull-down menu, choose the node that will contain the circuit.

Step 3 From the Slot pull-down menu, choose the slot containing the card where the circuit will originate.

Step 4 From the Port pull-down menu, choose the port where the circuit will originate. This field will not be 
available if a DS-1 card is chosen in Step 3.

Step 5 If the circuit is a DS-1 circuit and you choose a DS-1 card as the source, choose the DS-1 where the 
traffic will originate From the DS1 pull-down menu. 

Step 6 Click Next. 

Step 7 From the Node pull-down menu, choose the node chosen in Step 1.

Step 8 From the Slot pull-down menu, choose the OC-N card to map the DS-1 to a VT1.5 for optical transport 
or to map the DS-3 or OC-N STS circuit to an STS. 

Step 9 Choose the destination STS or VT from the sub-menus that display.

Step 10 Return to your originating procedure (NTP).

Purpose This task provisions a half circuit source and destination.

Tools/Equipment None

Prerequisite Procedures You perform this task during the NTP-A139 Create a Half Circuit on a 
BLSR or 1+1 Node, page 6-57 procedure.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
6-61
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 6      Create Circuits and VT Tunnels
NTP-A140 Create a Half Circuit on a Path Protection configuration Node
DLP-A312 Provision a Half Circuit Source and Destination - Path Protection 
configuration

Note After you have selected the circuit properties in the Circuit Source dialog box according to the specific 
circuit creation procedure, you are ready to provision the circuit source. 

Step 1 From the Node pull-down menu, choose the node that will contain the half circuit.

Step 2 From the Node pull-down menu, choose the node that will contain the circuit.

Step 3 From the Slot pull-down menu, choose the slot containing the card where the circuit will originate.

Step 4 From the Port pull-down menu, choose the port where the circuit will originate. This field will not be 
available if a DS-1 card is chosen in Step 3

Step 5 If the circuit is a DS-1 circuit and you choose a DS-1 card as the source, choose the DS-1 where the 
traffic will originate From the DS1 pull-down menu. 

Step 6 Click Next. 

Step 7 From the Node pull-down menu, choose the node chosen in Step 1.

Step 8 From the Slot pull-down menu, choose the OC-N card to map the DS-1 to a VT1.5 for optical transport 
or to map the DS-3 or OC-N STS circuit to an STS. 

Step 9 Choose the destination STS or VT from the sub-menus that display.

Step 10 Click Use Secondary Destination and repeat Steps 1 through 9

Step 11 Return to your originating procedure (NTP).

Purpose This task provisions a half circuit source and destination.

Tools/Equipment None

Prerequisite Procedures You perform this task during the NTP-A140 Create a Half Circuit on a Path 
Protection configuration Node, page 6-59 procedure.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode)

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 6-78 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 3 Verify that the circuit source and destination Ethernet cards are provisioned for the mode of the circuit 
you will create, either multicard or single-card. See the “DLP-A246 Provision E-Series Ethernet Card 
Mode” task on page 6-79.

Step 4 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 6-79.

Step 5 From the View menu, choose Go to Network View. 

Step 6 Click the Circuits tab, then click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an Ethernet Multicard circuit are STS-1, 
STS-3c, and STS6c. Valid circuit sizes for an Ethernet Single-card circuit are STS-1, STS-3c, 
STS6c, and STS12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1).

• Auto-ranged—Unavailable.

• State—Choose IS (in service). Ethergroup circuits are stateless, and always in service.

• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series Ethernet card ports.

• Create cross-connects only (TL1-like)—Uncheck this box; it does not apply to Ethernet circuits. 

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

Purpose This procedure creates a multicard or single-card EtherSwitch circuit. It 
does not apply to E-Series cards in port-mapped mode. To create a 
port-mapped mode circuit, see NTP-A192 Create a Circuit for an E-Series 
Card in Port-Mapped Mode, page 6-65.

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at each end of the Ethernet circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 9 Click Next.

Step 10 Provision the circuit source:

a. From the Node pull-down menu, choose one of the EtherSwitch circuit endpoint nodes. (Either end 
node can be the EtherSwitch circuit source.)

b. From the Slot pull-down menu, choose one of the following:

• If you are building a Multicard EtherSwitch circuit, choose Ethergroup.

• If you are building a Single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 11 Click Next.

Step 12 Provision the circuit destination:

a. From the Node pull-down menu, choose the second EtherSwitch circuit endpoint node.

b. From the Slot pull-down menu, choose one of the following:

• If you are building a Multicard EtherSwitch circuit, choose Ethergroup.

• If you are building a Single-card EtherSwitch circuit, choose the Ethernet card where you 
enabled the single-card EtherSwitch.

Step 13 Click Next.

Step 14 Under Circuit VLAN Selection, click New VLAN. If the desired VLAN already exists, continue with 
Step 17.

Step 15 In the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 and 
4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports a 
maximum of 509 user-provisionable VLANs.

Step 16 Click OK.

Step 17 Under Circuit VLAN Selection, highlight the VLAN name and click the arrow button (>>) to move the 
available VLAN(s) to the Circuit VLANs column. 

Step 18 If you are building a single-card EtherSwitch circuit and want to disable spanning tree protection on this 
circuit, uncheck the Enable Spanning Tree check box and click OK on the Disabling Spanning Tree 
dialog box. The Enable Spanning Tree box will remain checked or unchecked for the creation of the next 
single-card, point-to-point Ethernet circuit.

Caution Disabling spanning tree protection increases the likelihood of logic loops on an Ethernet network.

Caution Turning off spanning tree on a circuit-by-circuit basis means that the ONS 15454 is no longer protecting 
the Ethernet circuit and that the circuit must be protected by another mechanism in the Ethernet network.
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Caution Multiple circuits with spanning tree protection enabled will incur blocking if the circuits traverse the 
same E-series card and use the same VLAN.

Note You can disable or enable spanning tree protection on a circuit-by-circuit basis only for single-card, 
point-to-point Ethernet circuits. Other E-series Ethernet configurations disable or enable spanning tree 
on a port-by-port basis.

Step 19 Click Next.

Step 20 Confirm that the following information about the circuit is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15454 circuit nodes

Step 21 Click Finish.

Step 22 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79. 

Step 23 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80.

Stop. You have completed this procedure.

NTP-A192 Create a Circuit for an E-Series Card in Port-Mapped 
Mode

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 4.

Step 2 Provision the Ethernet cards that will carry the circuit for port-mapped mode. See the “DLP-A246 
Provision E-Series Ethernet Card Mode” task on page 6-79.

Step 3 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 6-79.

Step 4 From the View menu, choose Go to Network View. 

Purpose This procedure creates an E-Series point-to-point SONET circuit with an 
E-Series card in port-mapped mode.

Tools/Equipment An E-Series Ethernet card must be installed at each end of the circuit and 
configured in port-mapped mode.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click the Circuits tab and click Create.

Step 6 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an E-Series circuit are STS-1, STS-3c, STS6c, 
and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• State—Choose a service state to apply to the circuit:

– IS—The circuit is in service.

– OOS—The circuit is out of service. Traffic is not passed on the circuit.

– OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

– OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Select this checkbox if you want to apply the state chosen in the State field 
(IS or OOS-MT only) to the Ethernet circuit source and destination ports. You cannot apply 
OOS-AINS to E-Series Ethernet card ports. CTC will apply the circuit state to the ports only if the 
circuit bandwidth is the same as the port bandwidth or, if the port bandwidth is larger than the 
circuit, the circuit must be the first circuit to use the drop port. If not, a Warning dialog box displays 
the ports where the circuit state could not be applied. If the box is unchecked, CTC will not change 
the state of the source and destination ports.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 7 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 8 Click Next.

Step 9 Provision the circuit source:

a. From the Node pull-down menu, choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot pull-down menu, choose the slot containing the E-Series card that you will use for one 
end of the point-to-point circuit.
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c. From the Port pull-down menu, choose a port.

Step 10 Click Next.

Step 11 Provision the circuit destination:

a. From the Node pull-down menu, choose the circuit destination node.

b. From the Slot pull-down menu, choose the slot containing the E-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port pull-down menu, choose a port.

Step 12 Click Next. The Circuits window appears.

Step 13 Confirm that the following circuit information is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15454 circuit nodes

Step 14 Click Finish.

Step 15 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 6-82.

Stop. You have completed this procedure.

NTP-A142 Create an E-Series Shared Packet Ring Ethernet 
Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 6-78 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 3 Verify that the Ethernet cards that will carry the circuit are provisioned for Multi-card EtherSwitch 
Group. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 6-79.

Step 4 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 6-79.

Purpose This procedure creates a shared packet ring Ethernet circuit. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at both Ethernet circuit endpoint nodes.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 From the View menu, choose Go to Network View. 

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid shared packet ring circuit sizes are STS-1, STS-3c, and STS6c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose IS (in service). Ethergroup circuits are always in service.

• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series ports.

• Create cross-connects only (TL1-like)—Uncheck this box; it does not apply to Ethernet circuits. 

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 9 Click Next.

Step 10 Provision the circuit source:

a. From the Node pull-down menu, choose one of the shared packet ring circuit endpoint nodes. (Either 
end node can be the shared packet ring circuit source.)

b. From the Slot pull-down menu, choose Ethergroup.

Step 11 Click Next.

Step 12 Provision the circuit destination:

a. From the Node pull-down menu, choose the second shared packet ring circuit endpoint node.

b. From the Slot pull-down menu, choose Ethergroup.

Step 13 Click Next.

Step 14 Review the VLANs listed under Available VLANs. If the VLAN you want to use is displayed, continue 
with Step 15. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 15 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 
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Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 16 Click Next.

Step 17 Under Circuit Routing Preferences, uncheck the Route Automatically check box and click Next.

Step 18 Under Route Review and Edit, click the source node, then click a span (green arrow) leading away from 
the source node. 

The span turns white.

Step 19 Click Add Span.

The span turns blue. CTC adds the span to the Included Spans list.

Step 20 Click the node at the end of the blue span.

Step 21 Click the green span joining the node selected in Step 20. 

The span turns white.

Step 22 Click Add Span.

The span turns blue.

Step 23 Repeat Steps 19 through 22 for every node in the ring. 

Step 24 Under Route Review and Edit, verify that the new circuit is correctly configured. If the circuit 
information is not correct, click the Back button and repeat the procedure with the correct information. 

Note If the circuit is incorrect, you can also click Finish, delete the completed circuit, and begin the 
procedure again.

Step 25 Click Finish.

Step 26 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79 for each node that 
carries the circuit.

Step 27 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80 
for each node that carries the circuit.

Step 28 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 6-82.

Stop. You have completed this procedure.
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NTP-A143 Create an E-Series Hub and Spoke Ethernet 
Configuration

Step 1 Log into the hub node (the common endpoint). See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-A99 Determine Available VLANs” task on page 6-78 to verify that sufficient VLAN 
capacity is available (you will create a VLAN during each circuit creation task).

Step 3 Display the node view. 

Step 4 Verify that the Ethernet card that will carry the hub and spoke circuit is provisioned for Singlecard 
EtherSwitch Group. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 6-79.

Step 5 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 6-79.

Step 6 Log into a spoke endpoint node and repeat Steps 3 and 4 for the destination Ethernet card. (You only 
need to verify that the hub node is provisioned for Singlecard EtherSwitch once.) 

Step 7 Click the Circuits tab and click Create.

Step 8 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit:

– IS—Ethergroup circuits are always in service.

• Apply to drop ports—Uncheck this box; states cannot be applied to E-Series ports. 

• Create cross-connects only (TL1-like)—uncheck this box; it does not apply to Ethernet circuits.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Purpose This procedure creates a hub and spoke Ethernet configuration, which is 
made up of multiple circuits that share a common endpoint. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at all Ethernet circuit endpoint nodes.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 10 Click Next.

Step 11 Provision the circuit source:

a. From the Node pull-down menu, choose the hub node.

b. From the Slot pull-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 12 Click Next.

Step 13 Provision the circuit destination:

a. From the Node pull-down menu, choose an EtherSwitch circuit endpoint node.

b. From the Slot pull-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch.

Step 14 Click Next.

Step 15 Review the VLANs listed under Available VLANs. If the VLAN you want to use is displayed, continue 
with Step 17. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 16 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Note Moving the VLAN from Available VLANs to Circuit VLANs forces all the VLAN traffic to use 
the shared packet ring you are creating.

Step 17 Click Next.

Step 18 Confirm that the following information about the hub and spoke circuit is correct:

• Circuit name

• Circuit type

• Circuit size

• VLAN names

• ONS 15454 circuit nodes

If the circuit information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Note You can also click Finish, delete the completed circuit, and start the procedure from the 
beginning.
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Step 19 Click Finish. 

Step 20 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79. 

Step 21 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80.

Step 22 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 6-82.

Step 23 To create additional circuits (“spokes”):

a. Complete the “DLP-A99 Determine Available VLANs” task on page 6-78 to verify that sufficient 
VLAN capacity is available for the circuit destination node.

b. Repeat Steps 3 through 22.

Stop. You have completed this procedure.

NTP-A144 Create an E-Series Single-Card EtherSwitch Manual 
Cross-Connect

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the circuit source and destination ports before you create the circuit, 
complete the “DLP-A314 Assign a Name to a Port” task on page 6-17. If not, continue with Step 3.

Step 3 If a high number of VLANs is already used by the network, complete the “DLP-A99 Determine 
Available VLANs” task on page 6-78 to verify that sufficient VLAN capacity is available (you will 
create a VLAN during each circuit creation task).

Step 4 On the node view, double-click the Ethernet card that will carry the cross-connect.

Step 5 Verify that the Ethernet cards that will carry the circuit are provisioned for Singlecard EtherSwitch . See 
the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 6-79.

Step 6 From the View menu, choose Go to Network View.

Step 7 Click the Circuits tab and click Create.

Purpose This procedure manually creates a Single-Card EtherSwitch cross-connect 
between E-Series Ethernet cards and OC-N cards connected to non-ONS 
equipment. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the cross-connect. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the cross-connect.

• Type—Choose STS.

• Size—Choose the cross-connect size. For single-card EtherSwitch, the available sizes are STS-1, 
STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit:

• IS—The circuit is in service.

• OOS—The circuit is out of service. Traffic is not passed on the circuit.

• OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

• OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 9 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 10 Click Next.

Step 11 Provision the circuit source:

a. From the Node pull-down menu, choose the cross-connect source node. 

b. From the Slot pull-down menu, choose the Ethernet card where you enabled the single-card 
EtherSwitch in Step 5.

Step 12 Click Next.

Step 13 Provision the circuit destination:

a. From the Node pull-down menu, choose the cross-connect circuit source node selected in Step 11. 
(For Ethernet cross-connects, the source and destination nodes are the same.)

b. From the Slot pull-down menu, choose the OC-N card that is connected to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and/or STS from the Port and STS pull-down menus.

Step 14 Click Next.
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Step 15 Review the VLANs listed under Available VLANs. If the VLAN you want to use is displayed, continue 
with Step 16. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 16 Click the VLAN you want to use on the Available VLANs column, then click the arrow >> button to 
move the VLAN to the Circuit VLANs column. 

Step 17 Click Next. The Circuit Creation (Circuit Routing Preferences) dialog box opens.

Step 18 Confirm that the following information about the single-card EtherSwitch manual cross-connect is 
correct (in this task, “circuit” refers to the Ethernet cross-connect):

• Circuit name

• Circuit type

• Circuit size

• VLAN names

• ONS 15454 nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 19 Click Finish.

Step 20 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79. 

Step 21 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80.

Stop. You have completed this procedure.
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NTP-A145 Create an E-Series Multicard EtherSwitch Manual 
Cross-Connect

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Log into a circuit endpoint. See “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you are 
already logged in, continue with Step 2.

Step 2 Complete the “DLP-A99 Determine Available VLANs” task on page 6-78 to verify that sufficient VLAN 
capacity is available (you will create a VLAN during each circuit creation task).

Step 3 Verify that the Ethernet card that will carry the circuit is provisioned for Multicard EtherSwitch Group. 
See the “DLP-A246 Provision E-Series Ethernet Card Mode” task on page 6-79.

Step 4 Provision and enable the Ethernet ports. See “DLP-A220 Provision E-Series Ethernet Ports” task on 
page 6-79.

Step 5 From the View menu, choose Go to Network View.

Step 6 Click the Circuits tab and click Create.

Step 7 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—Choose STS.

• Size—Choose the size of the circuit that will be carried by the cross-connect. For Multicard 
EtherSwitch circuits, the available sizes are STS-1, STS-3c, and STS-6c.

• Bidirectional—Leave checked (default).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit:

• IS—The circuit is in service.

• OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure manually creates Multicard EtherSwitch cross-connects 
between E-Series Ethernet cards and an OC-N cards connected to 
non-ONS equipment. 

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

• OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 8 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 9 Click Next.

Step 10 Provision the cross-connect source:

a. From the Node pull-down menu, choose the cross-connect source node.

b. From the Slot pull-down menu, choose Ethergroup.

Step 11 Click Next.

Step 12 From the Node pull-down menu under Destination, choose the circuit source node selected in Step 10. 
For Ethernet cross-connects, the source and destination nodes are the same.

The Slot field is provisioned automatically for Ethergroup.

Step 13 Click Next.

Step 14 Review the VLANs listed under Available VLANs. If the VLAN you want to use is displayed, continue 
with Step 16. If you need to create a new VLAN, complete the following steps: 

a. Click the New VLAN button.

b. On the New VLAN dialog box, complete the following:

• VLAN Name—Assign an easily-identifiable name to your VLAN.

• VLAN ID—Assign a VLAN ID. The VLAN ID should be the next available number between 2 
and 4093 that is not already assigned to an existing VLAN. Each ONS 15454 network supports 
a maximum of 509 user-provisionable VLANs.

c. Click OK.

Step 15 In the Available VLANs column, click the VLAN you want to use and click the arrow button (>>) to 
move the VLAN to the Circuit VLANs column. 

Step 16 Click Next.

The Circuit Creation (Circuit Routing Preferences) dialog box opens.

Step 17 Verify the cross-connect information (in this step, “circuit” refers to the Ethernet cross-connect):

• Circuit name

• Circuit type

• Circuit size

• VLANs
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• ONS 15454 nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 18 Click Finish.

Step 19 Complete the “DLP-A220 Provision E-Series Ethernet Ports” task on page 6-79. 

Step 20 Complete the “DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80.

Step 21 From the View menu, choose Go to Home View.

Step 22 Click the Circuits tab.

Step 23 Highlight the circuit and click Edit.

The Edit Circuit dialog box opens.

Step 24 Click Drops and click Create.

The Define New Drop dialog box opens.

Step 25 From the Slot menu, choose the OC-N card that links the ONS 15454 to the non-ONS 15454 equipment.

Step 26 From the Port menu, choose the appropriate port.

Step 27 From the STS menu, choose the STS that matches the STS of the connecting non-ONS 15454 equipment.

Step 28 Click OK.

Step 29 Confirm the circuit information that displays in the Edit Circuit dialog box and click Close.

Step 30 Repeat Steps 2 through 29 at the second Ethernet manual cross-connect endpoint. 

The first and second Ethernet manual cross-connect endpoints will be bridged by the OC-N STS 
cross-connect circuit.

Note The appropriate STS circuit must exist in the non-ONS equipment to connect the two Ethernet manual 
cross-connect endpoints.

Caution If a CARLOSS alarm repeatedly appears and clears on an Ethernet manual cross-connect, the two 
Ethernet circuits might have a circuit-size mismatch. For example, a circuit size of STS-3c was 
configured on the first ONS 15454 and circuit size of STS-12c was configured on the second ONS 
15454. Refer to the Cisco ONS 15454 Troubleshooting Guide if the alarm persists.

Step 31 Complete the “NTP-A146 Test E-Series Circuits” procedure on page 6-82.

Stop. You have completed this procedure.
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DLP-A99 Determine Available VLANs

Step 1 At any CTC view, click the Circuits tab.

Step 2 Click any existing Ethernet circuit to highlight that row.

Step 3 Click Edit, then click the VLANs tab.

The Edit Circuit dialog displays the number of VLANs used by circuits and the total number of VLANs 
available for use. 

Step 4 Determine that number of available VLANs listed is sufficient for the number of E-series Ethernet 
circuits that you will create.

Caution Multiple E-series Ethernet circuits with spanning tree enabled will block each other if the circuits 
traverse the same E-series Ethernet card and use the same VLAN.

Step 5 Return to the originating procedure (NTP). 

Purpose This task verifies that the network has the capacity to support the additional 
new VLANs required for the creation E-Series circuits. It does not apply 
to E-Series cards in port-mapped mode.

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed at each end of the Ethernet circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A246 Provision E-Series Ethernet Card Mode

Caution You cannot change the mode while the Ethernet card is carrying circuits. If you want change the card 
mode, delete any circuits that it carries first. See the “NTP-A152 Delete Circuits” procedure on 
page 9-16.

Step 1 In the network view, double-click the node containing the E-Series Ethernet card you want to provision, 
then double-click the Ethernet card.

Step 2 Click the Provisioning > Ether Card tabs.

Step 3 Under Card Mode, choose one of the following: 

• For multicard EtherSwitch circuit groups, choose Multicard EtherSwitch Group. Click Apply. 

• For single-card EtherSwitch circuits, choose Single-card EtherSwitch. Click Apply.

• For port-mapped circuits, choose Port-mapped. Click Apply.

Step 4 Multicard EtherSwitch circuits only: repeat Steps 2 and 3 for all other Ethernet cards in the node that 
will carry the multicard EtherSwitch circuits.

Step 5 Repeat Steps 1 through 4 for other nodes as necesarry. 

Step 6 Return to your originating procedure (NTP).

DLP-A220 Provision E-Series Ethernet Ports

Step 1 Display the node view.

Step 2 Double-click the Ethernet card that you want to provision.

Purpose This task provisions an E-Series Ethernet card for multicard EtherSwitch 
Group, single-card EtherSwitch, or port-mapped mode.

Tools/Equipment E-Series Ethernet cards (E100T-12/E100T-G, E1000-2/E1000-2-G) must 
be installed.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables ports for the E100T-12, E100T-G, E1000-2, and 
E1000-2-G cards.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required to enable E-Series Ethernet traffic

Onsite/Remote Onsite or remote

Security Provisioning or higher
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Step 3 Click the Provisioning > Ether Port tabs.

Step 4 For each Ethernet port, provision the following parameters:

• Port Name—If you want to label the port, type a port name.

• Mode—Choose the appropriate mode for the Ethernet port:

• Valid choices for the E100T-12/E100T-G card are Auto, 10 Half, 10 Full, 100 Half, or 100 Full. 

• Valid choices for the E1000-2/E1000-2-G card are 1000 Full or Auto.

Note Both 1000 Full and Auto mode set the E1000-2 port to the 1000 Mbps and Full duplex 
operating mode; however, flow control is disabled when 1000 Full is selected. Choosing 
Auto mode enables the E1000-2 card to auto-negotiate flow control. Flow control is a 
mechanism that prevents network congestion by ensuring that transmitting devices do not 
overwhelm receiving devices with data. The E1000-2 port handshakes with the connected 
network device to determine if that device supports flow control.

• Enabled—Click this check box to activate the corresponding Ethernet port.

• Priority—Choose a queuing priority for the port. Options range from 0 (Low) to 7 (High). Priority 
queuing (IEEE 802.1Q) reduces the impact of network congestion by mapping Ethernet traffic to 
different priority levels. Refer to the priority queuing information in the Cisco ONS 15454 Reference 
Manual. This parameter does not apply to an E-Series card in port-mapped mode.

• Stp Enabled—Click this check box to enable the spanning tree protocol (STP) on the port. This 
parameter does not apply to an E-Series card in port-mapped mode. Refer to the spanning tree 
information in the Cisco ONS 15454 Reference Manual.

Step 5 Click Apply.

Step 6 Repeat Steps 1 through 5 for all other cards in the VLAN, or if the E-Series card is in port-mapped mode, 
repeat Steps 1 through 5 for the other card in a point-to-point circuit.

Step 7 Your Ethernet ports are provisioned and ready to be configured for VLAN membership. See the 
“DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership” task on page 6-80 for 
instructions.

Step 8 Return to your originating procedure (NTP).

DLP-A221 Provision E-Series Ethernet Ports for VLAN Membership

Step 1 Display the node view.

Purpose This task provisions E-Series card ports for VLAN membership. It does not 
apply to E-Series cards in port-mapped mode.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required to enable Ethernet traffic on E-Series Ethernet cards

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Double-click the E-Series card graphic to open the card.

Step 3 Click the Provisioning > Ether VLAN tabs.

Step 4 To put a port in a VLAN:

a. Click the port and choose either Tagged or Untag. 

b. If a port is a member of only one VLAN, choose Untag from the Port column in the VLAN’s row. 
Choose -- for all the other VLAN rows in that Port column. 

Note The VLAN with Untag selected can connect to the port, but other VLANs cannot access that 
port.

c. Choose Tagged at all VLAN rows that need to be trunked. Choose Untag at VLAN rows that do not 
need to be trunked, for example, the default VLAN. 

Note Each Ethernet port must be attached to at least one untagged VLAN. A trunk port connects 
multiple VLANs to an external device, such as a switch, which also supports trunking. A 
trunk port must have tagging (802.1Q) enabled for all the VLANs that connect to that 
external device. 

Step 5 After each port is in the appropriate VLAN, click Apply.

. 

Note If Tagged is chosen, the attached external Ethernet devices must recognize IEEE 802.1Q 
VLANs.

Note Both ports on an E1000-2/E1000-2-G card cannot be members of the same VLAN.

Step 6 Return to your originating procedure (NTP).

Table 6-4 VLAN Settings

Setting Description

-- A port marked with this symbol does not belong to the VLAN.

Untag The ONS 15454 will tag ingress frames and strip tags from egress frames.

Tagged The ONS 15454 will process ingress frames according to the VLAN ID; egress 
frames will not have their tags removed.
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NTP-A146 Test E-Series Circuits

Step 1 Log into the ONS 15454 source Ethernet node. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions.

Step 2 On the shelf graphic, double-click the circuit source card. 

Step 3 Click the Provisioning > Ether Port tabs.

Step 4 Verify the following settings:

• Mode— Auto, 10 Half, 10 Full, 100 Half, or 100 Full.

• Enabled—Checked

• Priority—Set to the priority level indicated by the circuit or site plan. Priority does not apply to 
E-Series cards in port-mapped mode.

• Stp—Checked if Spanning Tree Protocol is enabled for the circuit. STP does not apply to E-Series 
cards in port-mapped mode.

Step 5 Click the Ether VLAN tab. If the E-Series cards is not in port-mapped mode, verify that the source port 
is on the same VLAN as the destination port.

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node connect the Ethernet test set to the destination port and configure the test set to 
send and receive the appropriate Ethernet traffic. 

Note At this point, you will not be able to send and receive Ethernet traffic.

Step 8 At the source node connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 8 to make sure you configured the Ethernet ports and test set 
correctly.

Purpose This procedure tests circuits created on E-Series Ethernet cards 
provisioned for multicard EtherSwitch, single-card EtherSwitch, or 
port-mapped mode.

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX, and one of the following: 

NTP-A191 Create an E-Series EtherSwitch Circuit (Multicard or 
Single-Card Mode), page 6-63

NTP-A142 Create an E-Series Shared Packet Ring Ethernet Circuit, page 
6-67

NTP-A143 Create an E-Series Hub and Spoke Ethernet Configuration, 
page 6-70

Required/As Needed As needed

Onsite/Remote Onsite

Security Provisioning or higher
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Step 10 Perform protection switch testing appropriate to the SONET topology:

• For path protection configurations, see the “DLP-A94 Path Protection Protection Switching Test” 
task on page 5-35

• For BLSRs see the “DLP-A91 BLSR Switch Test” task on page 5-23.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 After the Ethernet test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results see your test set user guide.

Stop. You have completed this procedure.

NTP-A147 Create a G-Series Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for a G-Series circuit are STS-1, STS-3c, STS6c, 
STS-9c, STS-12c, STS-24c, and STS-48c. 

Note Restrictions apply to provisioning multiple circuits on a G-Series card when one of the circuit 
sizes provisioned is STS-24c. Refer to the Cisco ONS 15454 Reference Manual for complete 
information.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• State—Choose a service state to apply to the circuit:

• IS—The circuit is in service.

• OOS—The circuit is out of service. Traffic is not passed on the circuit.

Purpose This procedure creates a G-Series circuit.

Tools/Equipment A G-Series Ethernet card must be installed at each end of the circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

• OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Leave this box at the default (unchecked).

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 5 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 6 Click Next.

Step 7 Provision the circuit source:

a. From the Node pull-down menu, choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot pull-down menu, choose the slot containing the G-Series card that you will use for 
one end of the point-to-point circuit.

c. From the Port pull-down menu, choose a port.

Step 8 Click Next.

Step 9 Provision the circuit destination:

a. From the Node pull-down menu, choose the circuit destination node.

b. From the Slot pull-down menu, choose the slot containing the G-Series card that you will use for 
other end of the point-to-point circuit.

c. From the Port pull-down menu, choose a port.

Step 10 Click Next. The Circuits window appears.

Step 11 Confirm that the following circuit information is correct:

• Circuit name

• Circuit type

• Circuit size

• ONS 15454 circuit nodes

Step 12 Click Finish.

Note To change the capacity of a G-Series circuit, you must delete the original circuit and reprovision 
a new larger circuit.
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Step 13 Complete the “NTP-A149 Test G-Series or ML-Series Circuits” procedure on page 6-88.

Stop. You have completed this procedure.

NTP-A148 Create a Manual Cross-Connect for a G-Series or an 
E-Series in Port-Mapped Mode 

Note In this procedure, cross-connect refers to a circuit connection created within the same node between the 
Ethernet card and an OC-N card connected to third-party equipment. You create cross-connects at the 
source and destination nodes so an Ethernet circuit can be routed from source to destination across 
third-party equipment.

Step 1 Log into a node where you will create the cross-connect. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 If you are provisioning an E-Series card, verify that the Ethernet card that will carry the circuit is 
provisioned for port-mapped mode. See the “DLP-A246 Provision E-Series Ethernet Card Mode” task 
on page 6-79.

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields:

• Name—Assign a name to the source cross-connect. The name can be alphanumeric and up to 48 
characters (including spaces). Circuit names should be 44 characters or less if you want the ability 
to create monitor circuits. If you leave the field blank, CTC assigns a default name to the source 
cross-connect.

• Type—Choose STS.

• Size—Choose the size of the circuit that will be carried by the cross-connect. Valid sizes for a 
G-Series circuit are STS-1, STS-3c, STS-6c, STS-9c, STS-12c, STS-24c, and STS-48c. For an 
E-Series in port-mapped mode, valid sizes are STS-1, STS-3c, STS-6c, and STS-12c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• Auto-ranged—Unavailable.

• State—Choose a service state to apply to the circuit after it is created:

• IS—The circuit is in service.

Purpose This procedure creates a manual cross-connect between a G-Series 
Ethernet card or an E-Series in port-mapped mode and an OC-N card 
connected to non-ONS equipment. 

Tools/Equipment A G-Series or E-Series card must be installed at the circuit source node.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• OOS—The circuit is out of service. Traffic is not passed on the circuit.

• OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

• OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Uncheck this box.

• Create cross-connects only (TL1-like)—Uncheck this box

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Protected Drops—Leave the default unchanged (unchecked).

Step 5 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 6 Click Next.

Step 7 Provision the circuit source:

a. From the Node pull-down menu, choose the circuit source node. 

b. From the Slot pull-down menu, choose the Ethernet card that will be the cross-connect source.

c. From the Port pull-down menu, choose the cross-connect source port.

Step 8 Click Next.

Step 9 Provision the circuit destination:

a. From the Node pull-down menu, choose the cross-connect source node selected in Step 9. (For 
Ethernet cross-connects, the source and destination nodes are the same.)

b. From the Slot pull-down menu, choose the OC-N card that connects to the non-ONS equipment.

c. Depending on the OC-N card, choose the port and STS from the Port and STS pull-down menus.

Step 10 Click Next.

Step 11 Verify the cross-connect information (in this step, “circuit” refers to the cross-connect): 

• Circuit name

• Circuit type

• Circuit size

• ONS 15454 circuit nodes

If the information is not correct, click the Back button and repeat the procedure with the correct 
information. 

Step 12 Click Finish.

Stop. You have completed this procedure.
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DLP-A222 Provision G-Series Ethernet Ports

Step 1 In the node view, double-click the G-Series card graphic to open the card.

Step 2 Click the Provisioning > Port tabs.

Step 3 For each G-Series port, provision the following parameters:

• Port Name—If you want to label the port, type the port name.

• State—Choose IS to put the port in service.

• Flow Control Neg—Click this check box to enable flow control negotiation on the port (default). If 
you do not want to enable flow control, uncheck the box.

Note To activate flow control, the Ethernet device attached to the G-Series card must be set to 
auto-negotiation. If flow control is enabled but the negotiation status indicates no flow control, 
check the auto-negotiation settings on the attached Ethernet device.

• Max Size—To permit the acceptance of jumbo size Ethernet frames, choose Jumbo (default). If you 
do not want to permit jumbo size Ethernet frames, choose 1548.

Note The maximum frame size of 1548 bytes enables the port to accept valid Ethernet frames that use 
protocols, such as ISL. ISL adds 30 bytes of overhead and may cause the frame size to exceed 
the traditional 1518 byte maximum.

Step 4 Click Apply.

Step 5 Refresh the Ethernet statistics:

a. Click the Performance > Statistics tabs.

b. Click the Refresh button.

Note Reprovisioning an Ethernet port on the G-Series card does not reset the Ethernet statistics for 
that port. 

Step 6 Return to your originating procedure (NTP). 

Purpose This task provisions G-Series Ethernet ports.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed Required to enable Ethernet traffic on the G-Series

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A149 Test G-Series or ML-Series Circuits

Step 1 Log into the ONS 15454 source Ethernet node. See the “DLP-A60 Log into CTC” task on page 3-23 for 
instructions.

Step 2 Change the circuit and circuit ports to an OOS-MT service state:

a. Click the Circuits tab.

b. Click the circuit you want to test.

c. From the Tools menu, choose Circuits > Change Circuit State.

d. On the Change Circuit State dialog box, choose OOS_MT from the Target Circuit State pull-down 
menu. 

e. Check the Apply to circuit drops check box.

f. Click OK.

Step 3 On the shelf graphic, double-click the circuit source card. 

Step 4 Click the Provisioning > Port tabs.

Step 5 Verify the following settings:

• State—OOS_MT

• Flow Control Neg—Checked or unchecked as indicated by the circuit or site plan

• Max Size—Check or unchecked as indicated by the circuit or site plan

• Media Type— SX, LX, or ZX on G-Series or SX or LX on ML-Series

Step 6 Repeat Steps 1 through 5 for the destination node. 

Step 7 At the destination node connect the Ethernet test to the destination port and configure the test set to send 
and receive the appropriate Ethernet traffic. 

Note At this point, you will not be able to send and receive Ethernet traffic.

Step 8 At the source node connect an Ethernet test set to the source port and configure the test set to send and 
receive the appropriate Ethernet traffic.

Purpose This procedure tests circuits created on G-Series or ML-Series cards.

Tools/Equipment Ethernet test set and appropriate fibers

Prerequisite Procedures This procedure assumes you completed facility loopback tests to test the 
fibers and cables from the source and destination ONS 15454s to the fiber 
distribution panel or the DSX. 

NTP-A147 Create a G-Series Circuit, page 6-83 or

NTP-A148 Create a Manual Cross-Connect for a G-Series or an E-Series 
in Port-Mapped Mode, page 6-85

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 Transmit Ethernet frames between both test sets. If you cannot transmit and receive Ethernet traffic 
between the nodes, repeat Steps 1 through 6 to make sure you configured the Ethernet ports and test set 
correctly.

Step 10 Perform protection switch testing appropriate to the SONET topology:

• For path protection configurations, see the “DLP-A94 Path Protection Protection Switching Test” 
task on page 5-35.

• For BLSRs see the “DLP-A91 BLSR Switch Test” task on page 5-23.

Configure your test set according to local site practice. For information about configuring your test set, 
see your test set user guide.

Step 11 Change the circuit and circuit ports to the IS service state:

a. Click the Circuits tab.

b. Choose the circuit you want to test. 

c. From the Tools menu, choose Circuits > Change Circuit State.

d. On the Change Circuit State dialog box, choose IS from the Target Circuit State pull-down menu. 

e. Check the Apply to circuit drops check box.

f. Click OK.

Step 12 After the circuit test is complete, print the results or save them to a disk for future reference. For 
information about printing or saving test results see your test set user guide. 

Stop. You have completed this procedure.

NTP-A193 Create an ML-Series Circuit

Step 1 Log into a node on the network where you will create the circuit. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab and click Create.

Step 4 In the Create Circuits dialog box, complete the following fields: 

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

Purpose This procedure creates an ML-Series point-to-point SONET circuit. Refer 
to the Cisco ONS 15454 ML-Series Multilayer Ethernet Card Software 
Feature and Configuration Guide for more ML-Series information.

Tools/Equipment An ML-Series Ethernet card must be installed at each end of the circuit.

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Type—Choose STS.

• Size—Choose the circuit size. Valid circuit sizes for an ML-Series circuit are STS-1, STS-3c, 
STS6c, STS-9c, STS-12c and STS-24c.

• Bidirectional—Leave the default unchanged (checked).

• Number of circuits—Leave the default unchanged (1). 

• State—Choose a service state to apply to the circuit:

• IS—The circuit is in service.

• OOS—The circuit is out of service. Traffic is not passed on the circuit.

• OOS-AINS—The circuit is out of service until it receives a valid signal, at which time the 
circuit state automatically changes to in service (IS).

• OOS-MT—The circuit is in a maintenance state. The maintenance state does not interrupt traffic 
flow; it suppresses alarms and conditions and allows loopbacks to be performed on the circuit. 
Use OOS-MT for circuit testing or to suppress circuit alarms temporarily. Change the state to 
IS, OOS, or OOS-AINS when testing is complete. See the “DLP-A230 Change a Circuit State” 
task on page 9-9.

• Apply to drop ports—Uncheck this box.

Note Loss of Signal alarms display if in service (IS) ports are not receiving signals.

• Create cross-connects only (TL1-like)—Uncheck this box.

• Inter-domain (UCP) SLA—If the circuit will travel on a unified control plane (UCP) channel, enter 
the service level agreement number. Otherwise, leave the field set to zero. 

• Auto-ranged—Unavailable.

• Protected Drops—Leave the default unchanged (unchecked).

Step 5 If the circuit will be routed on a path protection configuration, complete the “DLP-A218 Provision Path 
Protection configuration Selectors During Circuit Creation” task on page 6-29.

Step 6 Click Next.

Step 7 Provision the circuit source:

a. From the Node pull-down menu, choose the circuit source node. Either end node can be the 
point-to-point circuit source.

b. From the Slot pull-down menu, choose the slot containing the ML-Series card that you will use for 
one end of the point-to-point circuit.

c. From the Port pull-down menu, choose a port.

Step 8 Click Next.

Step 9 Provision the circuit destination:

a. From the Node pull-down menu, choose the circuit destination node.

b. From the Slot pull-down menu, choose the slot containing the ML-Series card that you will use for 
the other end of the point-to-point circuit.

c. From the Port pull-down menu, choose a port.

Step 10 Click Next. The Circuits window appears.

Step 11 Confirm that the following circuit information is correct:
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• Circuit name

• Circuit type

• Circuit size

• ONS 15454 circuit nodes

Step 12 Click Finish.

Note To change the capacity of a ML-Series circuit, you must delete the original circuit and 
reprovision a new larger circuit.

Step 13 Complete the “NTP-A149 Test G-Series or ML-Series Circuits” task on page 6-88

Stop. You have completed this procedure.

NTP-A194 Create Overhead Circuits

Step 1 Log into a node on the network where you will create the overhead circuit. See the “DLP-A60 Log into 
CTC” task on page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 As needed, complete the “DLP-A313 Create a DCC Tunnel” task on page 6-92.

Step 4 As needed, complete the “DLP-A83 Provision Orderwire” task on page 6-93.

Step 5 As needed, complete the “DLP-A212 Create a User Data Channel Circuit” task on page 6-94.

Stop. You have completed this procedure.

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include DCC tunnels, the AIC and AIC-I card orderwire, 
and the AIC-I card user data channel.

Tools/Equipment None

Prerequisite Procedures NTP-A127 Verify Network Turn Up, page 6-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A313 Create a DCC Tunnel

Note Each ONS 15454 can have up to 32 DCC tunnel connections. Terminated Section DCCs used by the 
ONS 15454 cannot be used as a DCC tunnel endpoint, and a Section DCC that is used as an DCC tunnel 
endpoint cannot be terminated. All DCC tunnel connections are bidirectional. 

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Circuit Creation dialog box (Figure 6-16), provision the DCC tunnel:

• Name—Type the tunnel name.

• Type—Choose one:

• DCC Tunnel-D1-D3—Allows you to choose either the Section DCC (D1-D3) or a Line DCC 
(D4-D6, D7-D9, or D10-D12) as the source or destination endpoints.

• DCC Tunnel-D4-D12—Provisions the full Line DCC as a tunnel.

• Source Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, select the source port.

• Channel—Displayed if you chose DCC Tunnel-D1-D3 as the tunnel type. Choose one of the 
following:

• DCC1 (D1-D3)—is the Section DCC

• DCC2 (D4-D6)—is Line DCC 1

• DCC3 (D7-D9)—is Line DCC 2

• DCC4 (D10-D12)—is Line DCC 3

DCC options are not displayed if they are used by the ONS 15454 (DCC1) or other tunnels.

Purpose This task creates a DCC tunnel to transport traffic from third-party SONET 
equipment across ONS 15454 networks. Tunnels can be created on the 
Section DCC channel (D1-D3) (if not used by the ONS 15454 as a 
terminated DCC), or any Line DCC channel (D4-D6, D7-D9, or D10-D12).

Tools/Equipment None

Prerequisite Procedures NTP-A35 Verify Node Turn Up, page 5-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 6-16 Provisioning a DCC Tunnel

Step 4 Click OK.

Step 5 Put the ports that are hosting the DCC tunnel in service. See the “DLP-A214 Change the Service State 
for a Port” task on page 5-6 for instructions.

Step 6 Return to your originating procedure (NTP).

DLP-A83 Provision Orderwire

Step 1 In the network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create. 

Step 3 In the Circuit Creation dialog box, complete the following fields:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either LOW (local orderwire) or EOW (express orderwire) appropriate to the 
orderwire path that you want to create. If regenerators are not used between ONS 15454 nodes, you 
can use either local or express orderwire channels. If regenerators exist, use the express orderwire 
channel. You can provision up to four ONS 15454 OC-N ports for each orderwire path.

• PCM—Choose either MU_LAW or A_LAW.

Figure 6-17 shows the Local Orderwire subtab.The provisioning procedures are the same for both types 
of orderwire.

Purpose This task provisions orderwire on the AIC or the AIC-I card.

Tools/Equipment An AIC or AIC-I card must be installed in Slot 9.

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Figure 6-17 Provisioning Local Orderwire

Step 4 Under Endpoints, choose the source and destination nodes and source and destination optical ports and 
slots from the pull-down menus. 

Step 5 Click Finish.

Step 6 Return to your originating procedure (NTP).

DLP-A212 Create a User Data Channel Circuit

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Circuit Creation dialog box, complete the following fields:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the pull-down menu. 

Purpose This task creates a user data channel (UDC) circuit on the ONS 15454. A 
UDC circuit allows you to create a dedicated data channel between nodes. 

Tools/Equipment None

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Under Endpoints, choose the source and destination nodes and source and destination optical ports and 
slots from the pull-down menus. 

Step 5 Click Finish.

Step 6 Return to your originating procedure (NTP). 
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C H A P T E R 7

Manage Alarms

This chapter explains how to view and manage the alarms and conditions on a Cisco ONS 15454.

Cisco Transport Controller (CTC) detects and reports SONET alarms generated by the Cisco ONS 15454 
and the larger SONET network. You can use CTC to monitor and manage alarms at a card, node (default 
login), or network level. You can also view alarm counts on the LCD front panel.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A195 Document Existing Provisioning, page 7-2—Complete this procedure as needed to 
record node information or to troubleshoot rings and spans.

2. NTP-A196 View Alarms, History, Events, and Conditions, page 7-5—Complete this procedure as 
needed to see alarms and conditions occurring on the node and a complete history of alarm and 
condition messages.

3. NTP-A68 Delete Cleared Alarms from Display, page 7-13—Complete this procedure as needed to 
delete cleared alarm information that is no longer needed.

4. NTP-A69 View Alarm-Affected Circuits, page 7-14—Complete this procedure as needed to find 
circuits that are affected by a particular alarm or condition.

5. NTP-A70 View Alarm Counts on the LCD for a Slot or Port, page 7-16—Complete this procedure 
as needed to see a statistical count of alarms that have occurred for a slot or port.

6. NTP-A71 Create, Download, and Assign Alarm Severity Profiles, page 7-17—Complete this 
procedure as needed to change the default severity for certain alarms, assign the new severities to a 
port, card, or node, and delete alarm profiles.

7. NTP-A168 Enable, Modify, or Disable Alarm Severity Filtering, page 7-26—Complete this 
procedure as needed to enable, disable, or modify alarm severity filtering in the Conditions, Alarms, 
or History screens; you can enable, modify, and disable alarm severity filtering at the node or 
network level.

8. NTP-A72 Suppress and Discontinue Alarm Suppression, page 7-30—As needed, use these tasks to 
suppress reported alarms at the port, card, or node level and disable the suppress command to resume 
normal alarm reporting.
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NTP-A195 Document Existing Provisioning

Step 1 Log into the ONS 15454 that has the information you want to record or save. See the “DLP-A60 Log 
into CTC” task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 If you need to document information that you cannot write down, or need to preserve, you can do so by: 

• Printing information with the “DLP-A138 Print CTC Data” task on page 7-2.

• Exporting information as a delineated text file to be viewed or edited by web, text editing, word 
processing, spreadsheet, or database management applications with the “DLP-A139 Export CTC 
Data” task on page 7-4.

Stop. You have completed this procedure.

DLP-A138 Print CTC Data

Step 1 Click the CTC tab (and subtab, if present) containing the information you want to print. For example, 
click the Alarms tab to print Alarms window data.

The print operation is available for all network, node (default login), and card view windows. But if the 
window does not contain data, the printout does not contain any data.

Step 2 Click File > Print.

Step 3 In the Print dialog box, click a a printing option (Figure 7-1).

• Entire Frame—Prints the entire CTC window including the graphical view of the card, node, or 
network. This option is available for all windows.

Purpose Use this procedure to print card, node, or network CTC information in 
graphical or tabular form on a Windows-provisioned printer, or to export 
card, node, or network information as editable delineated text files to 
other applications. This procedure is useful for network record keeping 
and troubleshooting.

Tools/Equipment Printer connected to the CTC computer by a direct or network connection

Prerequisite Procedures Chapter 4, “Turn Up Node”

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve

Purpose Use this task to print CTC card, node, or network data in graphical or 
tabular form on a Windows-provisioned printer.

Tools/Equipment Printer connected to the CTC computer by a direct or network connection

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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• Tabbed View—Prints the lower half of the CTC window containing tabs and data. The printout 
includes the selected tab (on top) and the data shown in the tab window. For example, if you print 
the History window Tabbed View, you print only history items appearing in the window. This option 
is available for all windows.

• Table Contents—Prints CTC data in table format without graphical representations of shelves, 
cards, or tabs. This option is available only for CTC table data, so it does not apply to:

– Provisioning > Protection, SNMP, Timing, or UCP windows

– Maintenance > Database, Protection, Cross-Connect, Diagnostic, or Timing windows

The Table Contents option prints all the data contained in a table with the same column headings. 
For example, if you print the History window Table Contents view, you print all data included in the 
table whether or not items appear in the window.

Tip When you print using the Tabbed View option, it can be difficult to distinguish whether the 
printout applies to the network, node, or card view. To do this, compare the tabs on the printout: 
network, node, and card views are identical except that network view does not contain an 
Inventory tab; node, and card view contains a Performance tab.

Figure 7-1 Selecting CTC Data For Print

Step 4 Click the OK button.

Step 5 In the Windows Print dialog box, click a printer and click the OK button.

Step 6 Repeat this task for each window that you want to print.

Step 7 Return to your originating procedure (NTP).
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DLP-A139 Export CTC Data 

Step 1 Click the CTC tab containing the information you want to export (for example, the Alarms tab or the 
Circuits tab).

Step 2 Click File > Export.

Step 3 In the Export dialog box (Figure 7-2), click a data format:

• As HTML—Saves data as a simple HTML table file without graphics. The file must be viewed or 
edited with applications such as Netscape Navigator, Microsoft Internet Explorer, or other 
applications capable of opening HTML files.

• As CSV—Saves the CTC table as comma-separated values (CSV).

• As TSV—Saves the CTC table as tab-separated values (TSV).

Step 4 If you want to open a file in a text editor or word processor application, procedures may vary; but 
typically you can use the File > Open command to display the CTC data, or you can double-click the file 
name and choose an application such as Notepad. 

Text editor and word processor applications display the data exactly as it is exported, including comma 
or tab separators. All applications that open the data files allow you to format the data.

Step 5 If you want to open the file in spreadsheet and database management applications, procedures may vary; 
but typically you need to open the application and choose File > Import, then choose a delimited file to 
display the data in cells.

Spreadsheet and database management programs also allow you to manage it.

Note An exported file cannot be opened in CTC. 

The export operation only applies to tabular data, so it is not available for the following CTC tabs and 
subtabs:

• Provisioning > General, Protection, SNMP, Timing, or UCP windows

• Maintenance > Database, Protection, Cross-Connect, Diagnostic, or Timing windows

Purpose Use this task to export CTC table data as delineated text to view or edit in 
text editor, word processing, spreadsheet, database management, or web 
browser applications.

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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Figure 7-2 Selecting CTC Data For Export

Step 6 Click the OK button.

Step 7 In the Save dialog box, enter a name in the File name field using one of the following formats:

• [filename].html—for HTML files

• [filename].csv—for CSV files

• [filename].tsv—for TSV files

Step 8 Navigate to a directory where you want to store the file.

Step 9 Click the OK button.

Step 10 Repeat the task for each window that you want to export.

Step 11 Return to your originating procedure (NTP).

NTP-A196 View Alarms, History, Events, and Conditions

Step 1 Log into the node that contains the alarms you want to view. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 In the card, node (default login), or network-level CTC view, click the Alarms tab to display the alarms 
for that card, node, or network (Figure 7-3).

Purpose Use this procedure to view current or historical alarms and conditions for 
a card, a node, or network. This information is useful for monitoring and 
troubleshooting hardware and software events.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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Figure 7-3 CTC Node View

Table 7-1 lists the columns found in the Alarms window and their descriptions.

Table 7-1 Alarm Column Descriptions

Column Information Recorded

New Indicates a new alarm; to change this status, click either the Synchronize button or 
the Delete Cleared Alarms button

Date Date and time of the alarm

Node Node where the alarm occurred (appears only in network view)

Object TL1 access identifier (AID) for the alarmed object. For an STSmon or VTmon, the 
object.

Eqpt Type Card type in this slot

Slot Slot where the alarm occurred (appears only in network and node view)

Port Port where the alarm is raised. For STSTerm and VTTerm, the port refers to the 
upstream card it is partnered with.

Sev Severity level: CR (critical), MJ (major), MN (minor), NA (not-alarmed), NR 
(not-reported)

ST Status: R (raised), C (clear)

SA When checked, indicates a service-affecting alarm
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Table 7-2 lists the color codes for alarm and condition severities.

Release 4.0 has more specifically-numbered STS and VT alarm object identifiers based upon the object 
TL1 access identifiers (AIDs). The pre-Software R 4.0 numbering scheme is compared in Table 7-3 to 
the previously-used numbering scheme.

Step 3 If alarms are present, refer to the Cisco ONS 15454 Troubleshooting Guide for information and 
troubleshooting procedures.

Cond The error message/alarm name; these names are alphabetically defined in the “Alarm 
Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide.

Description Description of the alarm.

Num An incrementing count of alarm messages. 

Ref The reference number assigned to the alarm.

Table 7-1 Alarm Column Descriptions (continued)

Column Information Recorded

Table 7-2 Color Codes for Alarms and Conditions

Color Description

Red Raised Critical (CR) alarm

Orange Raised Major (MJ) alarm

Yellow Raised Minor (MN) alarm

Magenta Raised Not-Alarmed (NA) condition

Blue Raised Not-Reported (NR) condition

White Cleared (C) alarm or condition

Table 7-3 Release 4.0 Port-Based Alarm Numbering Scheme Comparison

Previous Release STS and VT Alarm Numbering Release 4.0 STS and VT Alarm Numbering1

1. In Release 4.0 STSTerm and VtTerm alarms, the Object and Port columns apply to the paired MON object within the upstream 
card. So the STSMon and STSTerm and VTMon or VtTerm objects will be identical.

MON
object

STS (or VT)-6-6
(Slot-STS or VT within card)

Port=1 MON
object

STS-<Slot>-<Port>-<STS>

For example, STS-6-1-6

VT1-<Slot>-<Port>-<STS>-
<VT Group>-<VT>

For example, VT1-6-1-6-1-1

Port=1

TERM
object

STS-2-3
(Local slot-STS or VT within 
local terminating card)

Port=3 TERM
object

<Upstream Slot>-<Port>-<STS>

For example, STS-6-3-6 

<Upstream 
Slot>-<Port>-<STS>-
<VT Group>-<VT>

For example, VT1-6-3-6-1-1 

Port=1
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Step 4 Complete the “DLP-A110 View Alarm History” task on page 7-8, the “DLP-A113 Synchronize Alarms” 
task on page 7-11, or the “DLP-A114 View Conditions” task on page 7-12 as needed.

Stop. You have completed this procedure.

DLP-A110 View Alarm History

Step 1 Decide whether you want to view the alarm message history at the node, network, or card level.

Step 2 The node view is the default view after you log into CTC (Figure 7-3). If you want to view node alarm 
history, use this view.

a. Click the History > Session tabs if you want to see the alarms and conditions (events) that occurred 
since you logged into the CTC.

b. Click the History > Node tabs if you want to retrieve all available alarm messages for the node.

Tip Double-click an alarm in the alarm table or an event (condition) message in the history table to 
display the view that corresponds to the alarm message. For example, double-clicking a card 
alarm takes you to card view. In network view, double-clicking a node alarm takes you to node 
view.

Step 3 If you want to view network alarm history, from node view click View > Go to Network View.

Step 4 Click the History tab.

Alarms and conditions (events) that have occurred on the network since you logged into CTC appear.

Step 5 If you want to view card alarm history, from the network view click View > Go to Previous View.

The previous view is the node (default login) view.

Step 6 From node view, double-click a card on the shelf graphic to display the card-level view for the card.

Note TCC+/TCC2 and cross-connect cards don’t have a card view.

a. Click the History > Session tabs if you want to see the alarm messages that occurred since you 
logged into CTC.

b. Click the History > Card tabs if you want to retrieve all available alarm messages for the card.

Purpose Use this task to view past cleared and uncleared ONS 15454 alarm 
messages at the card, node, or network level. This task is useful for 
troubleshooting configuration, traffic, or connectivity issues that are 
indicated by alarms.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve
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Note The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 640 
minor alarm messages, and 640 condition messages. When any of these limits is reached, 
the ONS 15454 discards the oldest events in that category.

Step 7 In the node or card view, display Not-Alarmed (NA) and transient event (condition) history in addition 
to alarm history by clicking the Events check box in the History > Node window or 
History > Card window.

Step 8 Click the Retrieve button.

Step 9 The window displays raised and cleared alarm messages (and events, if selected).

Tip Double-click an alarm in the alarm table or a condition in the history table to display the view 
that corresponds to the alarm message. For example, double-clicking a card alarm takes you to 
card view. In network view, double-clicking a node alarm takes you to node view.

Step 10 Return to your originating procedure (NTP).

DLP-A111 Changing the Maximum Number of Session Entries for Alarm History

Step 1 At the card, node or network view, click Edit > Preferences from the CTC menu bar.

The CTC Preferences Dialog box appears (Figure 7-4).

Purpose This task changes the maximum number of session entries included in the 
alarm history. Use this task to extend the history list in order to save 
information for future reference or troubleshooting.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning
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Figure 7-4 CTC Preferences Dialog Box

Step 2 Click the up or down arrow buttons next to the Maximum History Entries field to change the entry to the 
desired number. When the value is changed, the Apply button is enabled.

Step 3 Click Apply and OK.

Note Setting the Maximum History Entries value to the high end of the range uses more CTC memory 
and could impair CTC performance.

Note This task changes the maximum history entries recorded for CTC sessions. It does not affect the 
maximum number of history entries viewable for a network, node, or card.

Step 4 Return to your originating procedure (NTP).
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DLP-A112 Display Alarms and Conditions Using Time Zone

Step 1 At the card, node, or network view, from the CTC menu bar click Edit > Preferences.

The CTC Preferences Dialog box appears (Figure 7-4).

Step 2 Click the Display Events Using Each Node’s Timezone check box. The Apply button is enabled.

Step 3 Click Apply and OK.

Step 4 Return to your originating procedure (NTP).

DLP-A113 Synchronize Alarms

Step 1 At the card, node, or network view, click the Alarms tab.

Step 2 Click the Synchronize button.

This button causes CTC to retrieve a current alarm summary for the card, node, or network. This step is 
optional because CTC updates the Alarms window automatically as raise/clear messages arrive from the 
node. 

Note Alarms that have been raised during the session will have a check mark in the Alarms window New 
column. When you click Synchronize, the check mark disappears.

Step 3 Return to your originating procedure (NTP).

Purpose Use this task to change the timestamp for events to the timezone of the 
ONS node reporting the alarm. By default, the events timestamp is set to 
the timezone for the CTC workstation.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning

Purpose Use this task to view ONS 15454 events at the card, node, or network level 
and to refresh the alarm listing while troubleshooting so that you can check 
for new and cleared alarms and conditions.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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DLP-A114 View Conditions

Step 1 From the card, node, or network view, click the Conditions tab.

Step 2 Click the Retrieve button at the bottom-left of the window (Figure 7-5).

The Retrieve button requests the current set of fault conditions from the node, card, or network. The 
window is not updated when things change on the node. You must click Retrieve to see any changes.

Figure 7-5 Node View Conditions Window

Purpose Use this task to view conditions, which are events with a Not-Reported 
(NR) severity at the card, node, or network level. Viewing conditions will 
give you a clear record of changes or events that do not result in alarms.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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Conditions include all fault conditions raised on the node, whether or not they are reported. (Alarms can 
be unreported when they are filtered out of the display. See the DLP-A225 Enable Alarm Filtering, page 
7-27, for information.) Events that are reported as Major (MJ), Minor (MN), or Critical (CR) severities 
are alarms. Events that are reported as Not-Alarmed (NA) are conditions. Conditions that are not 
reported at all are marked Not-Reported (NR) in the Conditions window severity column.

Conditions that have a default severity of Critical (CR), Major (MJ), Minor (MN), or Not-Alarmed (NA) 
but are not reported due to exclusion or suppression are shown as NR in the Conditions window. (For 
more information about alarm suppression, see the DLP-A119 Suppress Alarm Reporting, page 7-31.) 
Current conditions are shown with the severity chosen in the alarm profile, if used. For more information 
about alarm profiles, see the NTP-A71 Create, Download, and Assign Alarm Severity Profiles, page 
7-17.

Note When ports are placed in OOS state for maintenance (OOS-MT), the Alarms Suppressed for 
Maintenance (AS-MT) condition is raised on them. For information about alarm and condition 
troubleshooting, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 3 If you want to apply exclusion rules, click the Exclude Same Root Cause check box at the node (default 
login) or network view, but do not select the Exclude Same Root Cause check box in card view.

An exclusion rule eliminates all lower-level alarms or conditions that originate from the same cause. For 
example, a fiber break may cause an LOS alarm, an AIS condition, and an SF condition. If you check 
the Exclude Same Root Cause checkbox, the AIS and SF conditions will be eliminated because the LOS 
alarm supersedes them. According to Telcordia, exclusion rules apply to a query of “all conditions from 
a node.”

Step 4 Return to your originating procedure (NTP).

NTP-A68 Delete Cleared Alarms from Display

Step 1 Log into a node where you want to delete alarms. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, go to Step 2.

Step 2 If you want to delete cleared node-level alarms:

a. In the node view, click the Alarms tab.

b. Click the Delete Cleared Alarms button, referring to the rules in Step 5.

This action removes any cleared ONS 15454 alarms from the Alarms display. The rows of cleared alarms 
turn white and have a C in their status (ST) column (Figure 7-5).

Purpose Use this procedure to delete Cleared (C) status alarms from the alarms 
window when they are no longer needed. The procedure can be used to 
delete transient messages from the CTC History window.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
7-13
Cisco ONS 15454 Procedure Guide, R4.0

November 2004



Chapter 7      Manage Alarms
NTP-A69 View Alarm-Affected Circuits
Step 3 If you want to delete cleared card-level alarms:

a. In the node view, double-click the card graphic for the card you want to open.

b. Click the Alarms tab and then click the Delete Cleared Alarms button, referring to the rules in 
Step 5.

Step 4 If you want to delete cleared network-level alarms:

a. In the node view click View > Go to Network View.

b. Click the Alarms tab and then click the Delete Cleared Alarms button, referring to the rules in 
Step 5.

Step 5 Consult the following rules when deleting cleared alarms from the display:

• If the Autodelete Cleared Alarms check box is selected (checked), an alarm disappears from the 
window when it is cleared.

• If the Autodelete Cleared Alarms check box is not selected (unchecked), an alarm remains in the 
window when it is cleared. The alarm appears white in the window and has a Clear (CL) severity. 
The alarm can be removed by clicking the Delete Cleared Alarms button.

Step 6 Transient messages are single messages, not raise-and-clear pairs (i.e. they do not have companion 
messages stating they are cleared). Click the Delete Cleared Alarms button to remove the transients 
from the History window.

Stop. You have completed this procedure.

NTP-A69 View Alarm-Affected Circuits

Step 1 Log into the ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you 
are already logged in, go Step 2.

Step 2 In the network, node (default login), or card view, click the Alarms tab or Conditions tab and then 
right-click anywhere in the row of an active alarm or condition.

Note The node view is the default, but you can also navigate to the Alarms tab in the network view or 
card view to perform Step 2.

Note The card view is not available for the TCC+/TCC2 or cross-connect cards.

Purpose Use this procedure with an alarm or condition shown in the Alarms window 
or History window to view all circuits, if any, affected by the alarm or 
condition.

Tools/Equipment None

Prerequisite Procedures NTP-A196 View Alarms, History, Events, and Conditions, page 7-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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The Select Affected Circuit option appears on the shortcut menu (Figure 7-6).

Figure 7-6 Select Affected Circuits Option

Step 3 Left-click or right-click Select Affected Circuits.

The Circuits window appears with affected circuits highlighted (Figure 7-7).
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Figure 7-7 Viewing an Alarm-Affected Circuit

Step 4 If you want to search for particular circuits, refer to the “DLP-A131 Search for Circuits” procedure on 
page 9-5.

Stop. You have completed this procedure.

NTP-A70 View Alarm Counts on the LCD for a Slot or Port

Step 1 Press the Slot button on the LCD panel to toggle to the desired slot number on the ONS 15454.

Step 2 If you want a card-level alarm count, press the Status button.

Step 3 Press the Port button to toggle to a specific port.

Purpose Use this procedure when you want to find out how many alarms have 
occurred for a slot or port without using CTC.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Retrieve
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Step 4 If you want a port-level alarm count, press the Status button on the LCD panel.

Figure 7-8 shows the LCD panel.

Figure 7-8 The LCD Panel

Note A blank LCD results when the fuse on the AIP board is blown. If this occurs, call Cisco 
Technical Assistance Center (TAC) at 1-877-323-7368.

Note Use the Slot button to toggle to a node to see a summary of alarms for the entire node.

Stop. You have completed this procedure.

NTP-A71 Create, Download, and Assign Alarm Severity Profiles

Step 1 Log into a node where you want to create an alarm profile. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, go to Step 2 to clone or modify an alarm profile, 
or go to Step 3 to download an alarm profile.

Step 2 Complete the “DLP-A115 Create Alarm Severity Profiles” task on page 7-18. This task clones a current 
alarm profile, renames the profile, and customizes the new profile. Go to Step 4.

Step 3 Complete the “DLP-A223 Download an Alarm Severity Profile” task on page 7-21. This task downloads 
an alarm severity profile from a CD or a node.

FAN FAIL

Slot

12/19/02
04.00-002L-10 

24˚C

87
09

3CRIT MAJ MIN

Status Port

Purpose Use this procedure to create a customized copy of the default alarm profile 
applied to a node; to download a saved custom profile from a network 
location to another node; to individually assign the custom severities to a 
port, card, or node, and to delete alarm profiles.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 As necessary, complete the “DLP-A116 Apply Alarm Profiles to Ports” task on page 7-22 or the 
“DLP-A117 Apply Alarm Profiles to Cards and Nodes” task on page 7-24.

Stop. You have completed this procedure.

DLP-A115 Create Alarm Severity Profiles

Step 1 In the node view, click View > Go to Network View.

Step 2 Click the Provisioning > Alarm Profiles tabs (Figure 7-3).

Step 3 Click the Load button.

Step 4 In the Select Profile(s) from Node or Filename to Load dialog box, click the From Node radio button.

Step 5 Highlight the node name you are logged into in the Node Names list.

Step 6 Highlight Default in the Profile Names list.

Step 7 Click the OK button.

The Default alarm severity profile appears in the Alarm Profiles window (Figure 7-9).

Purpose Use this task to create a custom severity profile by modifying the default 
severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-9 Network View Alarm Profiles Window

Step 8 Right-click anywhere in the Default profile column to display the profile editing shortcut menu.

Step 9 Click Clone in the shortcut menu.

Tip To find out what profiles are available for loading or cloning, click the Available button. You 
can clone any profiles except Inherited profiles.

Step 10 In the Clone Profile dialog box, enter a name for the copied profile in the New Profile Name field.

Profile names must be unique. If you try to import or name a profile that has the same name as another 
profile, CTC adds a suffix to create a new name. Long file names are supported.

Step 11 Click the OK button.

A new alarm profile (named in Step 10) is created. This profile duplicates the default profile severities 
and appears to the right of the default profile in the Alarm Profiles window. You can highlight it and drag 
it to a different position.

Step 12 Modify (customize) the created alarm profile:

a. In the new alarm profile column, double-click the alarm severity you want to change.

b. Click the desired severity in the pull-down menu.

c. Repeat Steps a and b for each severity you want to customize.

Step 13 After you have customized the new alarm profile, right-click in the profile column to highlight it.

Step 14 Click Store in the profile editing shortcut menu.
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Step 15 Click the To Node(s) radio button and go to Step a or click the To File radio button and go to Step b. 
(See Figure 7-10.)

Figure 7-10 Store Profiles Dialog Box

a. Choose the node(s) where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click the Select All button.

• If you do not want to save the profile to any nodes, click the Select None button.

• If you want to update alarm profile information, click the (Synchronize) button.

b. Navigate to the profile save location by clicking the Browse button.

• Enter a name in the File name field.

• Click the Select button to choose this name and location.

Note Long file names are supported. CTC supplies a suffix of *.pfl.

c. Click the OK button to store the profile.

Note Clicking the Hide Identical Rows check box configures the Alarm Profiles window to display 
rows with dissimilar severities.

Note Clicking the Hide values matching profile Default check box configures the Alarm Profiles 
window to display severities that do not match the Default profile.

Step 16 Return to your originating procedure (NTP).
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DLP-A223 Download an Alarm Severity Profile

Step 1 In the node view, click View > Go to Network View (Figure 7-3).

Step 2 Click the Provisioning > Alarm Profiles tabs.

Step 3 Click the Load button.

Step 4 If you want to download a file from the local PC hard disk, floppy disk, CD-ROM, or a network drive 
(if connected), click the From File radio button in the Select Profile(s) from Node or Filename to Load 
dialog box.

a. Click the Browse button.

The Open dialog box appears.

b. In the Look in pull-down menu, click to navigate to the folder where the profile file is located.

c. Click the name in the window to highlight it.

The file must have the *.pfl extension.

d. Click the Open button.

Go to Step 6.

Step 5 If you want to download a file from the login node or another connected node, click the From Node radio 
button in the Select Profile(s) from Node or Filename to Load dialog box.

a. Click the node where the profile is located under the Node Names list.

b. Click the profile under the Profile Names list.

Step 6 Click the OK button in the Select Profile(s) from Node or Filename to Load dialog box.

The downloaded profile appears at the right side of the Alarm Profiles window.

Step 7 Right-click anywhere in the downloaded profile column to display the profile editing shortcut menu.

Step 8 Click Store in the shortcut menu.

Step 9 In the Store Profile(s) dialog box, click the To Node(s) radio button (Figure 7-10).

a. Choose the node(s) where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click the Select All button.

• If you do not want to save the profile to any nodes, click the Select None button.

• If you want to update alarm profile information, click the Synchronize button.

b. Click the OK button.

Purpose Use this task to download a custom alarm severity profile from a 
network-drive accessible CD-ROM, floppy disk, or hard disk location.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 10 Return to your originating procedure (NTP).

DLP-A116 Apply Alarm Profiles to Ports

Step 1 In the node (default login) view, double-click a card to display the card view.

Note You can also apply alarm profiles to cards using the “DLP-A117 Apply Alarm Profiles to Cards 
and Nodes” task on page 7-24.

Note The card view is not available for the TCC+/TCC2 or cross-connect cards.

Step 2 Depending upon what card you want to apply the profile to, click the following tabs:

• If the card is an E-Series Ethernet, G-Series Ethernet, muxponder, transponder, optical, or electrical 
traffic card, click the Provisioning > Alarm Behavior tabs.

• If the card is an ML-series Ethernet (traffic) card, click the Provisioning > Ether Alarming tabs or 
the Provisioning > POS Alarming tabs, depending upon whether you want to apply the profile to 
the front physical ports (“Ether alarming”) or packet over SONET (“POS alarming”). For more 
information about ML-Series cards ports and service, see the Cisco ONS 15454 SONET/SDH 
ML-Series Multilayer Ethernet Card Software Feature and Configuration Guide.

Figure 7-11 shows the alarm profile of Ethernet card ports. CTC shows Parent Card Profile: Inherited.

Go to Step 3 to apply profiles to a port. Go to Step 4 to apply profiles to all ports on a card.

Purpose Use this task to apply a custom or default alarm severity profile to a port 
or ports.

Tools/Equipment None

Prerequisite Procedures DLP-A115 Create Alarm Severity Profiles, page 7-18

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-11 Card View Port Alarm Profile

Step 3 To apply profiles on a port basis:

a. Click the port row under the Profile column.

b. Choose the new profile from the pull-down menu.

c. Click the Apply button.

Step 4 To apply profiles to all ports on a card:

a. Click the Force all ports to profile menu arrow at the bottom of the window.

b. Choose the new profile from the pull-down menu.

c. Click the Force (still need to “Apply”) button.

d. Click the Apply button.

Step 5 Return to your originating procedure (NTP).

Tip If you choose the wrong profile, click Reset to return to the previous profile setting.
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DLP-A117 Apply Alarm Profiles to Cards and Nodes 

Step 1 In the node view, click the Provisioning > Alarm Behavior tabs (Figure 7-12).

Figure 7-12 Node View Alarm Profile

Step 2 If you want to apply profiles to a card:

a. Click the Profile row for the card.

b. Choose the new profile from the pull-down menu.

c. Click the Apply button.

Go to Step 4.

Purpose Use this task to apply a custom or default alarm profile to cards or nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A115 Create Alarm Severity Profiles, page 7-18

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provision
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Step 3 If you want to apply the profile to an entire node:

a. Click the Node Profile menu arrow at the bottom of the window (Figure 7-12).

b. Click the new alarm profile in the pull-down menu.

c. Click the Apply button.

Step 4 Return to your originating procedure (NTP).

Tip If you choose the wrong profile, click Reset to return to the previous profile.

DLP-A118 Delete Alarm Severity Profiles

Step 1 From the node view, click View > Go to Network View (Figure 7-3 on page 7-6).

Step 2 Click the Provisioning > Alarm Profiles tabs.

Step 3 Click the column heading for the profile column you want to delete (Figure 7-9).

The selected alarm profile name is displayed in the Description field.

Step 4 Click the Delete button.

The Select Node/Profile Combination for Delete dialog box appears (Figure 7-13).

Figure 7-13 Select Node/Profile Combination For Delete Dialog Box

Step 5 Click the node name(s) in the Node Names list to highlight the profile location.

Tip If you hold the Shift key down, you can select consecutive node names. If you hold the Ctrl key 
down, you can select any combination of nodes.

Purpose Use this task to delete a custom or default alarm severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provision
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Step 6 Click the profile name(s) you want to delete in the Profile Names list.

Step 7 Click the OK button.

The Delete Alarm Profile confirmation dialog box appears.

Step 8 Click the Yes button for each Delete Alarm Profile confirmation dialog box.

Note If you delete a profile from a node, it is still displayed in the network view
Provisioning > Alarm Profiles window unless you remove it by choosing Remove.

Step 9 To remove the alarm profile from the Provisioning > Alarm Profiles window, right-click the column of 
the profile you deleted and choose Remove from the shortcut menu.

Step 10 Return to your originating procedure (NTP).

Note If a a node and profile combination is selected but does not exist, a warning appears: “One or 
more of the profile(s) selected do not exist on one or more of the node(s) selected.” For example, 
if node A has only profile 1 and the user tries to delete from node A both profile 1 and profile 2, 
which exists only on nodes other than node A, this warning appears. However, the operation still 
removes profile 1 from node A.

Note Deleting active profiles prompts the user for a confirmation.

Note The special profiles called Default and Inherited cannot be deleted and do not appear in the 
Select Node/Profile Combination for Delete Window.

NTP-A168 Enable, Modify, or Disable Alarm Severity Filtering

Step 1 Log into a node where you want to enable alarm severity filtering. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 As necessary, complete the “DLP-A225 Enable Alarm Filtering” task on page 7-27. This task enables 
alarm filtering at the card, node, and network views for all nodes in the network. Alarm filtering can be 
enabled for alarms, conditions, or events.

Purpose Use this procedure to start, change, or stop alarm filtering for one or more 
severities in the Alarms, Conditions, and History windows in all network 
nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
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Step 3 As necessary, complete the “DLP-A226 Modify Alarm and Condition Filtering Parameters” task on 
page 7-28. This task modifies the alarm filtering for network nodes to show or hide particular alarms or 
conditions.

Step 4 As necessary, complete the “DLP-A227 Disable Alarm Filtering” task on page 7-30. This task disables 
alarm profile filtering for all network nodes.

Stop. You have completed this procedure.

DLP-A225 Enable Alarm Filtering

Step 1 At the node, network, or card-level view, click the Alarms tab (Figure 7-3).

Step 2 Click the Filter tool at the lower-right side of the bottom toolbar.

Alarm filtering is enabled if the tool is depressed (selected) and disabled if the tool is raised (not 
selected).

Alarm filtering will be enabled in the card, node, and network views of the Alarms tab at the node and 
for all other nodes in the network. If, for example, the Alarm Filter tool is enabled in the Alarms tab of 
the node view at one node, the Alarms tab in the network view and card view of that node will also show 
the tool enabled. All other nodes in the network will also have the tool enabled. 

If you filter an alarm in card view, the alarm will still be displayed in node view. In this view, the card 
will display the color of the highest-level alarm. The alarm is also shown for the node in the network 
view.

Step 3 If you want alarm filtering enabled when you view conditions, repeat Steps 1 and 2 using the Conditions 
window.

Step 4 If you want alarm filtering enabled when you view alarm history, repeat Steps 1 and 2 using the History 
window.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to enable alarm filtering for alarms, conditions, or event 
history in all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve
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DLP-A226 Modify Alarm and Condition Filtering Parameters

Step 1 At the node (default login), network, or card-level view, click the Alarms tab (Figure 7-3).

Step 2 Click the Filter button at the lower-left of the bottom toolbar.

The Alarm Filter Dialog box appears, showing the General tab (Figure 7-14).

Figure 7-14 Alarm Filter Dialog Box General Tab

In the General tab Show Severity box, you can modify which alarm severities show through the alarm 
filter or the period of time to apply to the alarms. If you want to change the alarm severities shown in 
the filter, go to Step a. In the Time box, you can choose a time period for the alarms display. If you want 
to change the time period that the alarms show for, go to Step b.

a. In the Show Severity area, click the check boxes for the severities [Critical (CR), Major (MJ), Minor 
(MN), or Not-Alarmed (NA)] you want to be reported at the network level. Leave severity check 
boxes deselected (unchecked) to keep them from appearing.

When alarm filtering is disabled, all alarms show.

b. In the Time area, click the Show alarms between time limits check box to enable it. Then click the 
up and down arrows in the From Date, To Date, and Time fields to modify what period of alarms are 
shown.

Purpose Use this task to change alarm and condition reporting in all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A225 Enable Alarm Filtering, page 7-27

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve
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To modify filter parameters for conditions, proceed to Step 3. If you do not need to modify them, proceed 
to Step 4.

Step 3 Click the Conditions tab (Figure 7-15).

Figure 7-15 Alarm Filter Dialog Box Conditions Tab

When alarm filtering is enabled, conditions in the Show list are visible and conditions in the Hide list 
are invisible.

• To move conditions individually from the Show list to the Hide list, click the > button.

• To move conditions individually from the Hide list to the Show list, click the < button.

• To move conditions collectively from the Show list to the Hide list, click the >> button.

• To move conditions collectively from the Hide list to the Show list, click the << button.

Note Conditions include alarms.

Step 4 Click the Apply button and the OK button.

Alarm and condition filtering parameters are enforced when alarm filtering is enabled (see the 
“DLP-A225 Enable Alarm Filtering” task on page 7-27), and are not enforced when alarm filtering is 
disabled (see the “DLP-A227 Disable Alarm Filtering” task on page 7-30).

Step 5 Return to your originating procedure (NTP).
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DLP-A227 Disable Alarm Filtering

Step 1 At the node (default login), network, or card-level view, click the Alarms tab (Figure 7-3).

Step 2 Click the Filter tool at the lower-right side of the bottom toolbar.

Alarm filtering is enabled if the tool is depressed (selected) and disabled if the tool is raised (not 
selected).

Step 3 If you want alarm filtering disabled when you view conditions, click the Conditions tab and repeat
Step 2.

Step 4 If you want alarm filtering disabled when you view alarm history, click the History tab and repeat
Step 2.

Step 5 Return to your originating procedure (NTP).

NTP-A72 Suppress and Discontinue Alarm Suppression

Step 1 Log into the ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you 
are already logged in, go to Step 2.

Step 2 Complete the “DLP-A119 Suppress Alarm Reporting” task on page 7-31 to make the node send out 
autonomous messages that clear particular raised alarms and cause the suppressed alarms to appear in 
the Conditions window.

Purpose Use this task to turn off specialized alarm filtering in all network nodes so 
that all severities are reported in CTC.

Tools/Equipment None

Prerequisite Procedures DLP-A225 Enable Alarm Filtering, page 7-27

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve

Purpose Use this procedure to keep alarms from being reported for a port, card, or 
node in circumstances when an alarm or condition is known to exist, but 
you do not want to include it in the display, and to resume normal alarm 
reporting by discontinuing the suppression.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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Note Suppressing one or more alarms prevents them from appearing in Alarm or History windows or 
in any other clients. The suppress command causes CTC to display them in the Conditions 
window, where Not-Reported (NR) events are shown. The suppressed alarms appear there with 
the alarm severity they would have if they were reported; their severity color code, and 
service-affecting status.

Step 3 Complete the “DLP-A120 Discontinue Alarm Suppression” task on page 7-32 to remove the suppress 
command and restore the alarms to their normal state of being reported at their provisioned severity.

Stop. You have completed this procedure.

DLP-A119 Suppress Alarm Reporting

Step 1 At either the node (default login) or card view, click the Provisioning > Alarm Behavior tabs.

Step 2 At the node level, you can suppress alarms on a card basis or for the entire node. At the card level, you 
can suppress alarms on a port basis.

Step 3 If you want to suppress alarms at the node level for cards, click the Suppress Alarms column check box 
for the slot row where you want to suppress alarms (Figure 7-12).

Note In the node view, row numbers correspond to slot numbers.

Step 4 Click the Apply button (whether or not you complete the next step).

The node sends out autonomous messages to clear any raised alarms.

Step 5 If you want to suppress alarms at the card level for ports, double-click the card and then in the card view, 
click the Provisioning > Alarm Behavior tabs.

Step 6 Click the Suppress Alarms column check box for the port row where you want to suppress alarms 
(Figure 7-11).

Step 7 Click the Apply button.

Step 8 Return to your originating procedure (NTP).

Purpose Use this task to suppress the reporting of ONS 15454 alarms at the port, 
card, or node level.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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Caution If multiple CTC/TL1 sessions are open, suppressing alarms in one session suppresses the 
alarms in all other open sessions.

DLP-A120 Discontinue Alarm Suppression

Step 1 At either the node (default login) or card view, if you want to restore reporting for alarms that were 
suppressed for the entire node, click the Provisioning > Alarm Behavior tabs.

Note You must restore alarm reporting at the view where it was originally suppressed.

Step 2 If you want to discontinue alarm suppression at the node level for cards, deselect (uncheck) the Suppress 
Alarms check box at the lower-left of the Alarm Behavior window.

Step 3 Click the Apply button (whether or not you perform the next step).

Step 4 If you want to discontinue alarm suppression at the card level for ports, double-click the card to display 
the card view.

Step 5 Deselect (uncheck) the Suppress Alarms check box for the port(s) you no longer want to suppress.

Step 6 Click the Apply button.

Step 7 Return to your originating procedure 

Purpose Use this task to discontinue alarm suppression and reenable alarm 
reporting on a port, card, or node.

Tools/Equipment None

Prerequisite Procedures DLP-A119 Suppress Alarm Reporting, page 7-31

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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NTP-A32 Provision External Alarms and Controls on the Alarm 
Interface Controller

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Note For information about the AIC external controls, virtual wire and orderwire, refer to the Cisco ONS 
15454 Reference Guide.

Step 1 Verify the backplane wiring. See the “NTP-A8 Install Wires to Alarm, Timing, LAN, and Craft Pin 
Connections” procedure on page 1-34 for information about the ONS 15454 backplane pins.

a. For external alarms, verify that the external-device relays are wired to the ENVIR ALARMS IN 
backplane pins.

b. For external controls, verify the external relays are wired to the ENVIR ALARMS OUT backplane 
pins.

Step 2 In the node (default login) view, double-click the AIC card on the shelf graphic. The card view appears.

Step 3 If you are provisioning external alarms, click the Provisioning > External Alarms tabs (Figure 7-16). 
If you are not provisioning external alarms, skip Steps 4 to 6 and go to Step 7.

Purpose Use this procedure to create external (environmental) alarms and external 
controls for the Alarm Interface Controller (AIC) card.

Tools/Equipment An AIC card must be installed in Slot 9.

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-16 AIC Card External Alarms

Step 4 Complete the following fields for each external device wired to the ONS 15454 backplane:

• Enabled—Click the check box to activate the fields for the alarm input number.

• Alarm Type—Click an alarm type in the pull-down menu.

• Severity—Click a severity in the pull-down menu.

The severity determines the severity the alarm has in the Alarms and History tabs and determines 
whether the LEDs are activated. Critical (CR), Major (MJ), and Minor (MN) alarms activate the 
LEDs. Not-Alarmed (NA) and Not-Reported (NR) do not activate LEDs, but do report the 
information in CTC.

• Virtual Wire—Click the virtual wire number in the pull-down menu to assign the external device to 
a virtual wire. Otherwise, do not change the None default. For information about the AIC virtual 
wire, see the Cisco ONS 15454 Reference Guide. For information about the AIC virtual wire, see 
the Cisco ONS 15454 Reference Guide.

• Raised When—Click the contact condition (open or closed) that triggers the alarm in the pull-down 
menu.

• Description—A default description is provided; enter a different description if needed.

Step 5 To provision up to four virtual wire inputs for external devices, complete Step 4 for each additional 
device.

Step 6 Click the Apply button.

Step 7 If you are provisioning external control outputs for external devices, click the External Controls subtab 
(Figure 7-16).

Step 8 Complete the following options for each external control wired to the ONS 15454 backplane:

• Enabled—Click the check box to activate the fields for the alarm input number.

• Control Type—Click the control type in the pull-down menu: air conditioner, engine, fan, generator, 
heat, light, sprinkler, or miscellaneous.
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• Trigger Type—Click a trigger type in the pull-down menu: a local minor, major, or critical alarm; a 
remote minor, major, or critical alarm; or a virtual wire activation.

• Description—Enter a description.

Step 9 To provision additional external controls, complete Step 7 for each additional device.

Step 10 Click Apply.

Stop. You have completed this procedure.

NTP-A123 Provision External Alarms and Controls on the Alarm 
Interface Controller-International

Note The AIC-I card provides direct alarm contacts (external alarm inputs and external control outputs) for 
ONS 15454 SONET or SDH systems. In the ONS 15454 ANSI shelf, these AIC-I alarm contacts are 
routed through the backplane to wire-wrap pins accessible from the back of the shelf. When you install 
an Alarm Expansion Panel (AEP), the AIC-I alarm contacts cannot be used. Only the AEP alarm contacts 
can be used. For further information about the AEP, see “NTP-A119 Install the Alarm Expansion Panel” 
procedure on page 1-31 and the “NTP-A120 Install an External Wire-Wrap Panel to the AEP” procedure 
on page 1-40.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Note For information about the AIC-I external controls, virtual wire, and orderwire, refer to the 
Cisco ONS 15454 Reference Guide.

Step 1 Verify the backplane wiring. If you are using the AEP, see the “NTP-A119 Install the Alarm Expansion 
Panel” procedure on page 1-31. Otherwise, see the “NTP-A8 Install Wires to Alarm, Timing, LAN, and 
Craft Pin Connections” procedure on page 1-34 for information about the ONS 15454 backplane pins.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN 
backplane pins.

b. For external controls, verify the external device relays are wired to the ENVIR ALARMS OUT 
backplane pins.

Purpose Use this procedure to create external (environmental) alarms, external 
controls, orderwire tunnels, extension type, or station number for the AIC-I 
card.

Tools/Equipment An AIC-I card must be installed in Slot 9.

Prerequisite Procedures NTP-A24 Verify Card Installation, page 4-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Double-click the AIC-I card in the node (default login) view shelf graphic. The card view appears.

Step 3 Click the Provisioning > Card tabs and complete the following fields for the card:

• Add Extension—Click this check box if you are using the AEP.

• Extension Type—The AEP radio button is automatically selected if you clicked the Add Extension 
check box.

• Input/Output—Select External Alarm if you use external alarms only; select External Control if 
you use both external alarms and external controls. Selecting only External Alarm gives you 16 
external alarm ports and no external control ports. If you select External Control, four of the ports 
are converted to external control ports, leaving you with 12 external alarm ports.

• Station Number—Enter a four-digit number unique to the node. This is the orderwire “phone 
number” for this node. The station number is used to call this node over the orderwire channel. For 
information about provisioning the orderwire, see the “DLP-A175 Change Orderwire Settings Using 
the AIC Card” task on page 11-48.

• The default is 0000 and cannot be deleted. It is considered the “party line” and calls all nodes on the 
network when dialed.

Step 4 If you are provisioning external alarms, click the External Alarms tab (Figure 7-17). If you are not 
provisioning external alarms, skip Steps 5–7 and go to Step 9.

Figure 7-17 Provisioning External Alarms On The AIC-I Card

Step 5 Complete the following fields for each external device wired to the ONS 15454 backplane:

• Enabled—Click the check box to activate the fields for the alarm input number.

• Alarm Type—Click an alarm type in the pull-down menu.

• Severity—Click a severity in the pull-down menu. The severity determines how the alarm is 
displayed in the CTC Alarms and History tabs and whether the LEDs are activated. Critical, Major, 
and Minor activate the appropriate LEDs. Not Alarmed and Not Reported do not activate LEDs, but 
do report the information in CTC.
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• Virtual Wire—Click a virtual wire in the pull-down menu to assign it to the external device. 
Otherwise, do not change the None default. For information about the AIC virtual wire, see the 
Cisco ONS 15454 Reference Guide.

• Raised When—Click the contact condition (open or closed) that triggers the alarm in the pull-down 
menu.

• Description—Default descriptions are provided for each alarm type; you can enter a different 
description if needed.

Step 6 To provision additional devices, complete Step 5 for each additional device.

Step 7 Click the Apply button.

Step 8 If you are provisioning external controls, click the External Controls subtab and complete the following 
fields for each external control wired to the ONS 15454 backplane:

• Enabled—Click the check box to activate the fields for the alarm input number.

• Control Type—Click the control type in the pull-down menu: air conditioner, engine, fan, generator, 
heat, light, sprinkler, or miscellaneous.

• Trigger Type—Click a trigger type in the pull-down menu: a local minor, major, or critical alarm; a 
remote minor, major, or critical alarm; or a virtual wire activation.

• Description—Enter a description.

Step 9 To provision additional controls, complete Step 9 for each additional device.

Step 10 Click the Apply button.

Stop. You have completed this procedure.
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C H A P T E R 8

Monitor Performance

Performance monitoring (PM) parameters are used by service providers to gather, store, set thresholds, 
and report performance data for early detection of problems. For more PM information, details, and 
definitions refer to the Cisco ONS 15454 Reference Manual. This chapter explains how to enable and 
view performance monitoring statistics for the Cisco ONS 15454.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-A73 Enable Performance Monitoring, page 8-2—Complete as needed.

2. NTP-A197 Monitor Electrical or Optical Performance, page 8-7—Complete this procedure as 
needed to monitor electrical or optical performance.

3. NTP-A198 Monitor Ethernet Performance, page 8-19—Complete this procedure as needed to 
monitor Ethernet performance.

Note For additional information regarding PM parameters, refer to the Digital transmission surveillance 
section in Telcordia’s GR-1230-CORE, GR-820-CORE, GR-499-CORE, and GR-253-CORE 
documents, and in the ANSI document entitled Digital Hierarchy - Layer 1 In-Service Digital 
Transmission Performance Monitoring.
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NTP-A73 Enable Performance Monitoring

Step 1 Log into CTC at the node that you want to monitor. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, proceed to Step 2.

Step 2 Complete the “DLP-A121 Enable Pointer Justification Count Performance Monitoring” task on page 8-2 
if you need to monitor clock synchronization.

Step 3 Complete the “DLP-A122 Enable Intermediate Path Performance Monitoring” task on page 8-5 if you 
need to monitor large amounts of STS traffic through intermediate nodes.

Stop. You have completed this procedure.

DLP-A121 Enable Pointer Justification Count Performance Monitoring

Step 1 In node view, double-click the card where the line terminates (drops), called line terminating equipment 
(LTE) card. The card view appears.

See Table 8-1 for a list of Cisco ONS 15454 LTE cards.

Purpose This procedure describes how to enable performance monitoring.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As Needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables pointer justification counts, which provide a way to 
align the phase variations in STS and VT payloads and to monitor the 
clock synchronization between nodes. A consistent, large pointer 
justification count indicates clock synchronization problems between 
nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 8-1 Traffic Cards that Terminate the Line, Called LTEs

Line Terminating Equipment

EC1-12 DS1N-14

DS1-14 DS3N-12

DS3-12 DS3N-12E

DS3-12E OC3 IR4 1310
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Step 2 Click the Provisioning > Line tabs.

Step 3 Click the PJStsMon# menu and make a selection based on the following rules

Note Figure 8-1 on page 8-4 shows the PJStsMon# menu on the Provisioning window.

• The default value Off means pointer justification monitoring is disabled.

• The values 1 to n are the number of STSs on the port. One STS per port can be enabled from the 
PJStsMon# card menu.

DS3XM-6 OC12 LR 1310

OC12 IR 1310 OC12 IR/STM4 SH 1310-4

OC12 LR 1550 OC48 LR 1550

OC48 IR 1310 OC48 LR/STM16 LH AS 1550

OC48 IR/STM16 SH AS 1310 OC48 ELR 200 Ghz ITU

OC192 LR 1550 E100T-12

OC48 ELR 100 Ghz ITU E100T-G

E1000-2 G1000-4

E1000-2-G ML100T-12

G1K-4 ML1000-2

Table 8-1 Traffic Cards that Terminate the Line, Called LTEs (continued)

Line Terminating Equipment
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Figure 8-1 Line Tab for Enabling Pointer Justification Count Parameters

Step 4 In the State field, confirm that the port is in service (IS).

Step 5 If the port is IS, click Apply and go to Step 7.

Step 6 If the port is out of service (OOS, OOS_MT, OOS_AINS), Select IS in the State field and click Apply.

Step 7 Click the Performance tab to view PM parameters. Figure 8-2 on page 8-5 shows pointer justification 
count. Refer to the Cisco ONS 15454 Reference Manual for more PM information, details, and 
definitions.

Note On CTC, the count fields for PPJC and NPJC PM parameters appear white and blank unless they 
are enabled on the Provisioning > Line tabs.

Provisioning tabLine tab Card view PJStsMon#

90
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7
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Figure 8-2 Pointer Justification Counts

Step 8 Return to your originating procedure (NTP).

DLP-A122 Enable Intermediate Path Performance Monitoring

Note The monitored IPPM parameters are STS CV-P, STS ES-P, STS SES-P, STS UAS-P, and STS FC-P. For 
more information about IPPM parameters, refer to the Cisco ONS 15454 Reference Manual.

Step 1 In node view, double-click the LTE card you want to monitor. The card view appears.

See Table 8-1 on page 8-2 for a list of Cisco ONS 15454 LTE cards.

Step 2 Click the Provisioning tab. 

Purpose This task enables intermediate path performance monitoring, which 
allows you to monitor large amounts of STS traffic through intermediate 
nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Performance tab Card viewPointer justification counts

78
64

8
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Step 3 Click the SONET STS tab. Figure 8-3 shows the SONET STS tab on the Provisioning window.

Figure 8-3 SONET STS Tab for Enabling IPPM

Step 4 Click the check box in the Enable IPPM column for the STS you want to monitor.

Step 5 Click the Apply button.

Step 6 Click the Performance tab to view PM parameters. For IPPM parameter definitions, refer to the 
Cisco ONS 15454 Reference Manual.

Step 7 Return to your originating procedure (NTP).

SONET STS tab Provisioning tab Card view

78
65

2
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NTP-A197 Monitor Electrical or Optical Performance

Step 1 Log into CTC at the node that you want to monitor. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, proceed to Step 2

Step 2 Complete the “DLP-A123 View Electrical or Optical OC-N PM Parameters” task on page 8-8.

Step 3 Complete the “DLP-A317 View TXP_MR_10G or MXP_2.5G_10G Optics PM Parameters” task on 
page 8-9.

Step 4 Complete the “DLP-A318 View TXP_MR_10G or MXP_2.5G_10G Payload PM Parameters” task on 
page 8-10.

Step 5 Complete the “DLP-A319 View TXP_MR_10G or MXP_2.5G_10G OTN PM Parameters” task on 
page 8-11.

Step 6 As needed, use the following tasks to change the display of electrical, optical, and transponder or 
muxponder PM counts:

• DLP-A261 Refresh PM Counts for a Different Port, page 8-12

• DLP-A124 Refresh Electrical or Optical PM Counts at 15-Minute Intervals, page 8-13 

• DLP-A125 Refresh Electrical or Optical PM Counts at One-Day Intervals, page 8-14

• DLP-A126 Monitor Near-End PM Counts, page 8-14

• DLP-A127 Monitor Far-End PM Counts, page 8-15

• DLP-A128 Monitor PM Counts for Selected Signal Types, page 8-16

• DLP-A129 Reset Current PM Counts, page 8-17

• DLP-A130 Clear Selected PM Counts, page 8-18

Stop. You have completed this procedure.

Purpose The Performance tab window allows you to view node near-end or 
far-end performance on a selected card and port at selected time 
intervals to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 6, “Create Circuits 
and VT Tunnels” and Chapter 11, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Retrieve or higher
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DLP-A123 View Electrical or Optical OC-N PM Parameters

Step 1 In node view, double-click the electrical or optical (OC-N) card of choice. The card view appears.

Step 2 Click the Performance tab (Figure 8-4).

Figure 8-4 Viewing Performance Monitoring Information

Step 3 View the PM parameter names that appear on the left portion of the window in the Param column. The 
PM values appear on the right portion of the window in the Curr (current), and Prev-n (previous) 
columns. For PM parameter definitions, refer to the Cisco ONS 15454 Reference Manual.

Step 4 Return to your originating procedure (NTP).

Purpose This task enables you to view PM counts on a selected electrical or 
optical (OC-N) card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Auto-refresh

90
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6

Directions
radio buttons

Performance

Card View

Refresh

Port

Intervals
radio buttons

Baseline Clear
8-8
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 8      Monitor Performance
NTP-A197 Monitor Electrical or Optical Performance
DLP-A317 View TXP_MR_10G or MXP_2.5G_10G Optics PM Parameters

Step 1 In node view, double-click the TXP_MR_10G or MXP_2.5G_10G optical card of choice. The card view 
appears.

Step 2 Click the Performance tab.

Step 3 Click the Optics PM tab (Figure 8-5).

View the PM parameter names that appear on the left portion of the window in the Param column. The 
PM values appear on the right portion of the window in the Curr (current), and Prev-n (previous) 
columns. For PM parameter definitions, refer to the Cisco ONS 15454 Reference Manual.

Figure 8-5 Viewing TXP_MR_10G or MXP_2.5G_10G Optics Performance Monitoring Information

Step 4 Return to your originating procedure (NTP).

Purpose This task enables you to view the optics PM counts on a selected 
TXP_MR_10G (transponder) or MXP_2.5G_10G (muxponder) optical 
card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Refresh
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0

Directions
radio buttons

Performance

Card View

Signal type

Port/Line

Intervals
radio buttons

Baseline Clear

Auto-refresh
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DLP-A318 View TXP_MR_10G or MXP_2.5G_10G Payload PM Parameters

Step 1 In node view, double-click the TXP_MR_10G or MXP_2.5G_10G optical card of choice. The card view 
appears.

Step 2 Click the Performance tab.

Step 3 Click the Payload PM tab (Figure 8-6).

View the PM parameter names that appear on the left portion of the window in the Param column. The 
PM values appear on the right portion of the window in the Curr (current), and Prev-n (previous) 
columns. For PM parameter definitions, refer to the Cisco ONS 15454 Reference Manual.

Figure 8-6 Viewing TXP_MR_10G or MXP_2.5G_10G Payload Performance Monitoring Information

Step 4 Return to your originating procedure (NTP).

Purpose This task enables you to view the payload PM counts on a selected 
TXP_MR_10G or MXP_2.5G_10G optical card and port to detect 
possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Auto-refresh
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1
Payload PM

Directions
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Refresh

Port
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radio buttons
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Performance
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DLP-A319 View TXP_MR_10G or MXP_2.5G_10G OTN PM Parameters

Step 1 In node view, double-click the TXP_MR_10G or MXP_2.5G_10G optical card of choice. The card view 
appears.

Step 2 Click the Performance tab.

Step 3 Click the OTN PM tab.

Step 4 Click the G.709 PM tab (Figure 8-7).

View the PM parameter names that appear on the left portion of the window in the Param column. The 
PM values appear on the right portion of the window in the Curr (current), and Prev-n (previous) 
columns. For PM parameter definitions, refer to the Cisco ONS 15454 Reference Manual.

Figure 8-7 Viewing TXP_MR_10G or MXP_2.5G_10G OTN G.709 Performance Monitoring Information

Step 5 Click the FEC PM tab (Figure 8-8).

Purpose This task enables you to view the OTN PM counts on a selected 
TXP_MR_10G or MXP_2.5G_10G optical card and port to detect 
possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Auto-refresh
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0
OTN PM

Performance

Directions
radio buttons

Card View

Refresh

Port

Intervals
radio buttons

G.709 PM

Baseline Clear
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View the PM parameter names that appear on the left portion of the window in the Param column. The 
PM values appear on the right portion of the window in the Curr (current), and Prev-n (previous) 
columns. For PM parameter definitions, refer to the Cisco ONS 15454 Reference Manual.

Figure 8-8 Viewing TXP_MR_10G or MXP_2.5G_10G OTN FEC Performance Monitoring Information

Step 6 Return to your originating procedure (NTP).

DLP-A261 Refresh PM Counts for a Different Port

Step 1 In node view, double-click the electrical or optical (OC-N) card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance tab.

Step 3 For the E-Series or G-Series Ethernet cards, click the History tab.

Step 4 Click the drop-down menu in the Port field to display the port menu.

Purpose This task changes the window view to display PM counts for another 
port on a multi-port card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Auto-refresh
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OTN PM

Performance

Directions
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Step 5 Click the desired port to highlight your selection.

Step 6 Click the Refresh button. The PM counts for the newly-selected port appear.

Step 7 Return to your originating procedure (NTP).

DLP-A124 Refresh Electrical or Optical PM Counts at 15-Minute Intervals

Step 1 In node view, double-click the electrical or optical (OC-N) card of choices. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the 15 min radio button.

Step 4 Click the Refresh button. Performance monitoring parameters display in 15-minute intervals 
synchronized with the time of day.

Step 5 View the Curr column to find PM counts for the current 15-minute interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 15-minute interval, a threshold 
crossing alert (TCA) is raised. The number represents the counter value for each specific performance 
monitoring parameter.

Step 6 View the Prev-n columns to find PM counts for the previous 15-minute intervals.

Note If a complete 15-minute interval count is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 15 
minutes after the counter started, changing node timing settings, changing the time zone settings, 
replacing a card, resetting a card, or by changing port states. When the problem is corrected, the 
subsequent 15-minute interval appears with a white background.

Step 7 Return to your originating procedure (NTP).

Purpose This task changes the window view to display PM counts in 15-minute 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-A125 Refresh Electrical or Optical PM Counts at One-Day Intervals

Step 1 In node view, double-click the electrical or optical (OC-N) card of choice. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the 1 day radio button.

Step 4 Click the Refresh button. Performance monitoring appears in 1-day intervals synchronized with the time 
of day.

Step 5 View the Curr column to find PM counts for the current 1-day interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 1-day interval, a threshold crossing 
alert (TCA) is raised. The number represents the counter value for each specific performance monitoring 
parameter.

Step 6 View the Prev-n columns to find PM counts for the previous 1-day intervals.

Note If a complete count over a 1-day interval is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 24 
hours after the counter started, changing node timing settings, changing the time zone settings, 
replacing a card, resetting a card, or by changing port states. When the problem is corrected, the 
subsequent 1-day interval appears with a white background.

Step 7 Return to your originating procedure (NTP).

DLP-A126 Monitor Near-End PM Counts

Step 1 In node view, double-click the electrical or optical (OC-N) card of choice. The card view appears.

Purpose This task changes the window view to display PM parameters in 1-day 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose Use this task to view near-end PM counts for the selected card and port. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 2 Click the Performance tab.

Step 3 Click the Near End radio button.

Step 4 Click the Refresh button. All PM parameters occurring for the selected card on the incoming signal are 
displayed. For PM parameter definitions refer to the Cisco ONS 15454 Reference Manual.

Step 5 View the Curr column to find PM counts for the current time interval.

Step 6 View the Prev-n columns to find PM counts for the previous time intervals.

Step 7 Return to your originating procedure (NTP).

DLP-A127 Monitor Far-End PM Counts

Note Only cards that allow far-end monitoring have this radio button as an option.

Step 1 In node view, double-click the electrical or optical (OC-N) card of choice. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the Far End radio button.

Step 4 Click the Refresh button. All PM parameters recorded by the far-end node for the selected card on the 
outgoing signal are displayed. For PM parameter definitions refer to the Cisco ONS 15454 Reference 
Manual.

Step 5 View the Curr column to find PM counts for the current time interval.

Step 6 View the Prev-n columns to find PM counts for the previous time intervals.

Step 7 Return to your originating procedure (NTP).

Purpose Use this task to view far-end PM parameters for the selected card and 
port. Only cards that allow far-end monitoring have the Far End button 
as an option.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
8-15
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 8      Monitor Performance
NTP-A197 Monitor Electrical or Optical Performance
DLP-A128 Monitor PM Counts for Selected Signal Types

Step 1 In node view, double-click the electrical or optical (OC-N) card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance tab.

Note Different port and signal-type menus appear depending on the card type and the circuit type. The 
appropriate types (DS1, DS3, VT path, STS path, OC-N section, line) appear based on the card. 
For example, the DS3XM card lists DS3, DS1, VT path, and STS path PM parameters as 
signal-types. This enables selection of both the DS-3 port and the DS-1 within the specified 
DS-3.

Step 3 Choose Port/Line from the drop-down menu and highlight the desired port/line. The options vary 
depending on the card.

Step 4 Choose the signal type from the drop-down menu and highlight the desired signal. The options vary 
depending on the card. Figure 8-9 on page 8-17 shows the Port and Signal-type menus on the 
Performance window for a DS3XM-6 card.

Purpose Use the signal-type menus to monitor near-end or far-end PM counts for 
specific signals on a selected card and port. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Remote

Security Level Retrieve or higher
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Figure 8-9 Signal-Type Menus for a DS3XM-6 Card

Step 5 Click the Refresh button. All PM counts recorded by the near-end or far-end node for the specified 
outgoing signal type on the selected card and port are displayed. For PM parameter definitions, refer to 
the Cisco ONS 15454 Reference Manual.

Step 6 View the Curr column to find PM counts for the current time interval.

Step 7 View the Prev-n columns to find PM counts for the previous time intervals.

Step 8 Return to your originating procedure (NTP).

DLP-A129 Reset Current PM Counts

Step 1 In node view, double-click the Ethernet, electrical, or optical (OC-N) card of choice. The card view 
appears.

Step 2 Click the Performance tab.

Purpose This task clears the PM count displayed in the current time interval, but 
it does not clear the cumulative PM count. This task allows you to see 
how quickly PM counts rise.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Refresh
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Directions
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radio buttons
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Step 3 Click the Baseline button.

Note The Baseline button clears the PM counts displayed in the current time interval but does not clear 
the PM counts on the card. When the current time interval expires or the window view changes, 
the total number of PM counts on the card and on the window appear in the appropriate column. 
The baseline values are discarded if you change views to a different window and then return to 
the Performance window.

Step 4 View the current statistics column(s) to observe changes to PM counts for the current time interval.

Step 5 Return to your originating procedure (NTP).

DLP-A130 Clear Selected PM Counts

Caution Pressing the Clear button can mask problems if used incorrectly. This button is commonly used for 
testing purposes.

Step 1 In node view, double-click the Ethernet, electrical, or optical (OC-N) card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the Clear button.

Step 4 From the Clear Statistics menu, choose one of three options:

• Selected statistics: Clearing selected statistics erases from the card and the window display all PM 
counts associated with the current combination of statistics on the selected port. This means the 
selected time interval, direction, and signal type counts are erased from the card and the window 
display.

• All statistics on port x: Clearing all statistics on port x erases from the card and the window display 
all PM counts associated with all combinations of the statistics on the selected port. This means all 
time intervals, directions, and signal type counts are erased from the card and the window display.

• All statistics in current view: Clearing all statistics in the current view erases from the card and the 
window display all PM counts for all ports.

Step 5 From the Clear Statistics menu, click Yes to clear the selected statistics.

Purpose This task uses the Clear button to clear specified PM counts depending 
on the option selected.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 6 View the displayed columns to verify that the selected PM counts have been cleared.

Step 7 Return to your originating procedure (NTP).

NTP-A198 Monitor Ethernet Performance

Step 1 Log into CTC at the node that you want to monitor. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, proceed to Step 2.

Step 2 Complete the “DLP-A256 View Ethernet Statistics PM Parameters” task on page 8-20.

As needed, use the following tasks to change the display of Ethernet statistical PM counts:

• DLP-A260 Set Auto-Refresh Interval for Displayed PM Counts, page 8-21

• DLP-A129 Reset Current PM Counts, page 8-17

• DLP-A130 Clear Selected PM Counts, page 8-18

Step 3 Complete the “DLP-A257 View Ethernet Utilization PM Parameters” task on page 8-22.

As needed, use the “DLP-A259 Refresh Ethernet PM Counts at a Different Time Interval” task on 
page 8-23 to change the display of Ethernet utilization PM counts:

Step 4 Complete the “DLP-A258 View Ethernet History PM Parameters” task on page 8-23.

As needed, use the following tasks to change the display of Ethernet history PM counts:

• DLP-A261 Refresh PM Counts for a Different Port, page 8-12

• DLP-A259 Refresh Ethernet PM Counts at a Different Time Interval, page 8-23

Step 5 Complete the “DLP-A320 View ML-Series Ether Ports PM Parameters” task on page 8-24.

As needed, use the following tasks to change the display of Ether port PM counts:

• DLP-A260 Set Auto-Refresh Interval for Displayed PM Counts, page 8-21

• DLP-A129 Reset Current PM Counts, page 8-17

Purpose This procedure allows you to view node transmit and receive 
performance on a selected Ethernet card and port at selected time 
intervals to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 6, “Create Circuits 
and VT Tunnels” and Chapter 11, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Retrieve or higher
8-19
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 8      Monitor Performance
NTP-A198 Monitor Ethernet Performance
Step 6 Complete the “DLP-A321 View ML-Series POS Ports PM Parameters” task on page 8-25.

As needed, use the following tasks to change the display of POS port PM counts:

• DLP-A260 Set Auto-Refresh Interval for Displayed PM Counts, page 8-21

• DLP-A129 Reset Current PM Counts, page 8-17

Stop. You have completed this procedure.

DLP-A256 View Ethernet Statistics PM Parameters

Step 1 In node view, double-click the E-Series or G-Series Ethernet card of choice. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the Statistics subtab. Figure 8-10 shows the Statistics pane on the Performance tab.

Figure 8-10 G-Series Statistics Pane on the Card View Performance Tab

Purpose This task enables you to view current statistical PM counts on an 
Ethernet card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Refresh
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Step 4 Click the Refresh button. Performance monitoring statistics for each port on the card are displayed.

Step 5 View the PM parameter names that appear on the left portion of the window in the Param column. The 
parameter numbers appear on the right portion of the window in the Port # columns. For PM parameter 
definitions refer to the Cisco ONS 15454 Reference Manual.

Step 6 View the Port # columns to view the current PM statistics for each port.

Step 7 Return to your originating procedure (NTP).

DLP-A260 Set Auto-Refresh Interval for Displayed PM Counts

Step 1 In node view, double-click the Ethernet, electrical, or optical (OC-N) card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Choose Auto-refresh from the drop-down menu.

Step 4 From the Auto-refresh drop-down menu, choose one of six options:

• None: This option disables the auto-refresh feature.

• 15 Seconds: This option sets the window auto-refresh to 15-second time intervals.

• 30 Seconds: This option sets the window auto-refresh to 30-second time intervals.

• 1 Minute: This option sets the window auto-refresh to 1-minute time intervals.

• 3 Minutes: This option sets the window auto-refresh to 3-minute time intervals.

• 5 Minutes: This option sets the window auto-refresh to 5-minute time intervals.

Step 5 Click the Refresh button. The PM counts for the newly-selected auto-refresh time interval appear.

Depending on the selected auto-refresh interval, the displayed PM counts automatically update at 
completion of each refresh interval. If the auto-refresh interval is set to None, the displayed PM counts 
are not updated unless you click the Refresh button.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes the window auto-refresh intervals for updating the 
displayed PM counts.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-A198 Monitor Ethernet Performance
DLP-A257 View Ethernet Utilization PM Parameters

Step 1 In node view, double-click the E-Series or G-Series Ethernet card of choice. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the Utilization subtab. Figure 8-11 shows the Utilization pane on the Performance tab.

Figure 8-11 G-Series Utilization Pane on the Card View Performance Tab

Step 4 Click the Refresh button. Performance monitoring utilization values for each port on the card are 
displayed.

Step 5 View the Port # column to find the port you wish to monitor.

Step 6 View the Prev-n columns to find transmit (Tx) and receive (Rx) bandwidth utilization values for the 
previous time intervals.

Step 7 Return to your originating procedure (NTP).

Purpose This task enables you to view line utilization PM counts on an Ethernet 
card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Interval

90
16

7

Utilization

Performance

Card View

Refresh
8-22
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 8      Monitor Performance
NTP-A198 Monitor Ethernet Performance
DLP-A259 Refresh Ethernet PM Counts at a Different Time Interval

Step 1 In node view, double-click the E-Series or G-Series Ethernet card of choice. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click either the Utilization or History tab.

Step 4 Choose the Interval from the drop-down menu.

Step 5 From the Interval menu, choose one of four options:

• 1 min: This option appears the specified PM counts in one-minute time intervals.

• 15 min: This option appears the specified PM counts in 15-minute time intervals.

• 1 hour: This option appears the specified PM counts in one-hour time intervals.

• 1 day: This option appears the specified PM counts in one-day (24 hours) time intervals.

Step 6 Click the Refresh button. The PM counts refresh with values based on one-minute time intervals.

Step 7 Return to your originating procedure (NTP).

DLP-A258 View Ethernet History PM Parameters

Step 1 In node view, double-click the E-Series or G-Series Ethernet card where you want to view PM counts. 
The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the History subtab. Figure 8-12 shows the History pane on the Performance tab.

Purpose This task changes the window view to display specified PM counts in 
time intervals depending on the interval option selected.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task enables you to view historical PM counts at selected time 
intervals on an Ethernet card and port to detect possible performance 
problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 8-12 History Pane on the Card View Performance Tab

Step 4 Click the Refresh button. Performance monitoring statistics for each port on the card are displayed.

Step 5 View the PM parameter names that appear on the left portion of the window in the Param column. The 
parameter numbers appear on the right portion of the window in the Port # columns. For PM parameter 
definitions refer to the Cisco ONS 15454 Reference Manual.

Step 6 View the Port # columns to view the current PM statistics for each port.

Step 7 Return to your originating procedure (NTP).

DLP-A320 View ML-Series Ether Ports PM Parameters

Step 1 In node view, double-click the ML-series Ethernet card of choice. The card view appears.

Step 2 Click the Performance tab.

Purpose This task enables you to view Ethernet port PM counts at selected time 
intervals on an Ethernet card and port to detect possible performance 
problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Interval

90
16

5

History

Performance

Card View

Port

Refresh
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Step 3 Click the Ether Ports subtab. Figure 8-13 on page 8-25 shows the Ether Ports pane on the Performance 
tab.

Figure 8-13 Ether Ports Pane on the Card View Performance Tab

Step 4 Click the Refresh button. Performance monitoring statistics for each port on the card are displayed.

Step 5 View the PM parameter names that appear on the left portion of the window in the Param column. The 
parameter numbers appear on the right portion of the window in the Port # columns. For PM parameter 
definitions refer to the Cisco ONS 15454 Reference Manual.

Step 6 View the Port # columns to view the current PM counts for each port.

Step 7 Return to your originating procedure (NTP).

DLP-A321 View ML-Series POS Ports PM Parameters

Step 1 In node view, double-click the ML-series Ethernet card of choice. The card view appears.

Purpose This task enables you to view Packet Over SONET (POS) port PM 
counts at selected time intervals on an Ethernet card and port to detect 
possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Refresh

90
16

8

Ether Ports

Performance

Card View

Auto-refresh

Baseline
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Step 2 Click the Performance tab.

Step 3 Click the POS Ports subtab. Figure 8-14 shows the POS Ports pane on the Performance tab.

Figure 8-14 POS Ports Pane on the Card View Performance Tab

Step 4 Click the Refresh button. Performance monitoring statistics for each port on the card are displayed.

Step 5 View the PM parameter names that appear on the left portion of the window in the Param column. The 
parameter numbers appear on the right portion of the window in the Port # columns. For PM parameter 
definitions refer to the Cisco ONS 15454 Reference Manual.

Step 6 View the Port # columns to view the current PM counts for each port.

Step 7 Return to your originating procedure (NTP).

Refresh

90
16

9

POS Ports

Performance

Card View

Auto-refresh

Baseline
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C H A P T E R 9

Manage Circuits

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to manage Cisco ONS 15454 electrical, optical and Ethernet circuits. 

Before You Begin
To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

To clear any alarm or trouble conditions, refer to the Cisco ONS 15454 Troubleshooting Guide.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A199 Locate and View Circuits, page 9-4—Complete as needed.

2. NTP-A200 View Cross-Connect Card Resource Usage, page 9-8—Complete as needed.

3. NTP-A151 Modify Circuit Characteristics, page 9-9—Complete as needed to edit a circuit name, 
change the active and standby colors of spans, or change signal fail, signal degrade thresholds, 
reversion time, and PDI-P settings for path protection configuration circuits.

4. NTP-A416 Convert a CTC Circuit to TL1 Cross-Connects, page 9-14—Complete this procedure if 
you want to convert a CTC circuit into TL1 cross-connects.

5. NTP-A417 Upgrade TL1 Cross-Connects to CTC Circuits, page 9-15—Complete this procedure if 
you want to convert TL1 cross-connects or TL1-like cross-connects created in CTC into a CTC 
circuit.

6. NTP-A152 Delete Circuits, page 9-16—Complete as needed.

7. NTP-A78 Create a Monitor Circuit, page 9-17—Complete as needed to monitor traffic on primary 
bidirectional circuits.

8. NTP-A79 Create a J1 Path Trace, page 9-18—Complete as needed to monitor interruptions or 
changes to circuit traffic.
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Before You Begin
Figure 9-1 shows the Cisco Transport Controller Circuits window. This window displays information 
about circuits to help you manage the circuits, including circuit status and state. 

Figure 9-1 ONS 15454 Circuit Window In Network View

Table 9-1 lists the statuses that CTC can report for each circuit.

Table 9-1 Cisco ONS 15454 Circuit Status

Status Definition/Activity

CREATING CTC is creating a circuit.

ACTIVE CTC created a circuit. All components are in place and a 
complete path exists from the circuit source to the circuit 
destination.

DELETING CTC is deleting a circuit.
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Before You Begin
INCOMPLETE A CTC-created circuit is missing a cross-connect or network 
span; a complete path from source to destination(s) does not 
exist, or an Alarm Interface Panel (AIP) change occurred on 
one of the circuit nodes and the circuit is in need of repair. 
(AIPs store the node MAC address.)

In CTC, circuits are represented using cross-connects and 
network spans. If a network span is missing from a circuit, 
the circuit status is INCOMPLETE. However, an 
INCOMPLETE status does not necessarily mean a circuit 
traffic failure has occurred, for traffic may flow on a protect 
path. 

Network spans are in one of two states: up or down. On CTC 
circuit and network maps, up spans are displayed as green 
lines, and down spans are displayed as gray lines. If a failure 
occurs on a network span during a CTC session, the span 
remains in on the network map but its color changes to gray 
to indicate the span is down. If you restart your CTC session 
while the failure is active, the new CTC session cannot 
discover the span and its span line will not display on the 
network map. 

Subsequently, circuits routed on a network span that goes 
down will display as ACTIVE during the current CTC 
session, but they will display as INCOMPLETE to users who 
log in after the span failure. 

UPGRADABLE A TL1-created circuit or a TL1-like CTC-created circuit is 
complete and has upgradable cross-connects. A complete 
path from source to destination(s) exists. You can upgrade 
the circuit using the “NTP-A417 Upgrade TL1 
Cross-Connects to CTC Circuits” procedure on page 9-15.

INCOMPLETE_UPGRADABLE A TL1-created circuit or a TL1-like CTC-created circuit 
with upgradable cross-connects is missing a cross-connect, 
and a complete path from source to destination(s) does not 
exist. The circuit cannot be upgraded until missing 
cross-connects are in place. 

NOT_UPGRADABLE A TL1-created circuit or a TL1-like CTC-created circuit is 
complete but has at least one non-upgradable cross-connect. 
UPSR_HEAD, UPSR_EN, UPSR_DC, and UPSR_DROP 
cross-connects are not upgradable, so all unidirectional path 
protection configuration circuits created with TL1 are not 
upgradable.

INCOMPLETE_NOT_UPGRADABLE A TL1-created circuit or a TL1-like CTC-created circuit 
with one or more non-upgradable cross-connects is missing 
a connection or circuit span (network link); a complete path 
from source to destination(s) does not exist. 

Table 9-1 Cisco ONS 15454 Circuit Status (continued)

Status Definition/Activity
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NTP-A199 Locate and View Circuits
Circuit state, shown in Table 9-2, is a user-assigned, administrative status that defines whether the circuit 
is in or out of service. To carry circuit traffic, circuits must have a status of Active and a state of In 
Service (IS).

NTP-A199 Locate and View Circuits

Step 1 Log into the network where you want to view the circuits. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 As needed, complete the “DLP-A131 Search for Circuits” task on page 9-5.

Step 3 As needed, complete the “DLP-A262 Filter the Display of Circuits” task on page 9-6.

Step 4 As needed, complete the “DLP-A229 View Circuits on a Span” task on page 9-7.

 Stop. You have completed this procedure.

Table 9-2 Cisco ONS 15454 Circuit States

State Definition

IS In service; able to carry traffic

OOS Out of service; unable to carry traffic

OOS-AINS Out of service, auto in service; alarm reporting is suppressed, but traffic is carried 
and loopbacks are allowed. Raised fault conditions, whether their alarms are 
reported or not, can be retrieved on the CTC Conditions tab or by using the TL1 
RTRV-COND command. VT circuits generally switch to IS when source and 
destination ports are IS, OOS_AINS, or OOS_MT regardless of whether a physical 
signal is present. STS circuits switch to IS when a signal is received.

OOS-MT Out of service, maintenance; alarm reporting is suppressed, but traffic is carried and 
loopbacks are allowed. Raised fault conditions, whether their alarms are reported or 
not, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND 
command.

Purpose This procedure allows you to locate and view ONS 15454 circuits.

Tools/Equipment None

Prerequisite Procedures Circuit creation procedure(s) in Chapter 6, “Create Circuits and VT 
Tunnels” 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-A199 Locate and View Circuits
DLP-A131 Search for Circuits

Step 1 Navigate to the appropriate CTC view:

• To search the entire network, from the View menu, choose Go to Network View.

• To search for circuits that originate, terminate, or pass through a specific node, from the View menu, 
choose Go to Other Node, then choose the node you want to search and click OK.

• To search for circuits that originate, terminate, or pass through a specific card, double-click the card 
on the shelf graphic in node view to display the card in card view. 

Step 2 Click the Circuits tab.

Step 3 If you are in node or card view, choose the scope for the search in the Scope pull-down menu. 

Step 4 Click Search.

Step 5 In the Circuit Name Search dialog box, complete the following:

• Find What—Enter the text of the circuit name you want to find.

• Match Whole Word Only—Select this check box to instruct CTC to select circuits only if the entire 
word matches the text in the Find What field. 

• Match Case—Select this check box to instruct CTC to select circuits only when the capitalization 
matches the capitalization entered in the Find What field.

• Direction—Choose the direction for the search. Searches are conducted up or down from the 
currently selected circuit.

Step 6 Click Find Next. If a match is found, click Find Next again to find the next circuit.

Step 7 Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8 Return to your originating procedure (NTP).

Purpose This task searches for an ONS 15454 circuit at the network, node, or card 
level.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
9-5
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 9      Manage Circuits
NTP-A199 Locate and View Circuits
DLP-A262 Filter the Display of Circuits

Step 1 Navigate to the appropriate CTC view:

• To filter network circuits, from the View menu, choose Go to Network View.

• To filter circuits that originate, terminate, or pass through a specific node, from the View menu, 
choose Go to Other Node, then choose the node you want to search and click OK.

• To filter circuits that originate, terminate, or pass through a specific card, double-click the card on 
the shelf graphic in node view to display the card in card view. 

Step 2 Click the Circuits tab.

Step 3 Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. On the Filter Dialog, set the filter attributes:

• Name—Enter a complete or partial circuit name to filter circuits based on circuit name; 
otherwise leave the field blank.

• Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way 
circuits), or 2-way (display only two-way circuits).

• Status—Choose one: Any (status not used to filter circuits), Active (display only active 
circuits), Incomplete (display only incomplete circuits, that is, circuits missing a connection or 
span to form a complete path), or Upgradable (display only upgradable circuits, that is, circuits 
created in TL1 that are ready to upgrade in CTC). See Table 9-1 for more information about 
circuit statuses. (While other statuses are described in the table, filtering is only supported for 
Active, Incomplete, and Upgradable circuits.)

• State—Choose one: OOS (display only out of service circuits), IS (display only inservice 
circuits), OOS-AINS (display only out of service, auto inservice circuits), or OOS-MT (display 
only out of service, maintenance circuits.) See Table 9-2 for more information about circuit 
states.

• Slot—Enter a slot number to filter circuits based on the source or destination slot; otherwise 
leave the field blank.

• Port—Enter a port number to filter circuits based on the source or destination port; otherwise 
leave the field blank.

• Type—Choose one: Any (type not used to filter circuits), STS (displays only STS circuits), VT 
(displays only VT circuits), VT Tunnel (displays only VT tunnels), or VT Aggregation Point 
(displays only VT aggregation points).

Purpose This task filters the display of circuits in the ONS 15454 network, node, or 
card view Circuits window based on circuit name, size, type, direction, and 
other attributes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• Size—Click the appropriate check boxes to filter circuits based on size: VT1.5, STS-1, STS3c, 
STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, or STS-192c. The check boxes displayed depend 
on what you entered in the Type field. If you chose Any, all sizes are available. If you chose VT, 
only VT1.5 is available. If you chose STS, only STS sizes are available, and if you chose VT 
Tunnel or VT Aggregation Point, only STS-1 is available.

Step 4 Click OK. Circuits matching the attributes in the Filter Circuits dialog box are displayed in the Circuits 
window.

Step 5 To turn filtering off, click the Filter icon in the lower right corner of the Circuits window. Click the icon 
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 6 Return to your originating procedure (NTP).

DLP-A229 View Circuits on a Span

Step 1 From the View menu on the node view, choose Go to Network View. If you are already in network view, 
go to Step 2.

Step 2 Right-click the green line containing the circuits you want to view and choose one of the following: 

• Circuits—To view BLSR, path protection configuration, 1+1, or unprotected circuits on the span.

• PCA Circuits—To view circuits routed on a BLSR protected channel. (This option does not display 
if the span you right-clicked is not a BLSR span.)

On the Circuits on Span dialog box, you can view the following information for circuits provisioned on 
the span:

• STS—STSs used by the circuits.

• VT—VTs used by the circuits (VT circuits).

• UPSR—(UPSR span only)—If checked, path protection configuration circuits are on the span.

• Circuit—Displays the circuit name.

• Switch State—(UPSR span only) Displays the switch state of the circuit, that is, whether any span 
switches are active. For path protection configuration spans, switch types include: CLEAR (no spans 
are switched), MANUAL (a manual switch is active), FORCE (a force switch is active), and 
LOCKOUT OF PROTECTION (a span lockout is active). 

Purpose This task allows you to view circuits on an ONS 15454 span.

Tools/Equipment None

Prerequisite Procedures Circuits must be created on the span. See Chapter 6, “Create Circuits and 
VT Tunnels”

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note You can perform other procedures from the Circuits on Span dialog box. If the span is in a path 
protection configuration, you can switch the span traffic. See “DLP-A197 Initiate a Path 
Protection Configuration Force Switch” task on page 14-18 for instructions. If you want to edit 
a circuit on the span, double-click the circuit. See the “DLP-A231 Edit a Circuit Name” task on 
page 9-10 or the “DLP-A233 Edit Path Protection configuration Circuit Path Selectors” task on 
page 9-12 for instructions.

Step 3 Return to your originating procedure (NTP).

NTP-A200 View Cross-Connect Card Resource Usage

Step 1 Log into the node where you want to view the cross-connect card resource usage. See the “DLP-A60 Log 
into CTC” task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 Click the Maintenance > Cross-Connect > Resource Usage tabs.

Step 3 In the Summary section of the Resources Usage tab, view the following information:

• STS-1 Paths—(XC, XCVT, XC10G) Provides the percent of the cross-connect card STS-1path 
resources that are used. 288 STS-1 paths are available for XC or XCVT cards; 1152 STS-1 paths are 
available for XC10G cards.

• VT Matrix Ports—(XCVT and XC10G) Provides the percent of the cross-connect card VT matrix 
ports that are used. Each port is one STS in size, and each can transport 28 VT1.5s. 24 VT matrix 
ports are available for the XCVT and XV10G cards.

• VT Matrix—(XCVT and XC10G) Provides the percent of the VT matrix resources that are used. 672 
are available, which is the number of VT matrix ports (24) multiplied by the number of VT1.5s in 
an STS (28).

Step 4 In the VT Port Matrix Detail section, you can view details of the VT Matrix Port usage:

• Drop—Identifies the source slot, port, and STS.

• Tunnel Name—VT tunnels use VT matrix ports on the tunnel source and destination nodes (VT 
tunnels do not use matrix resources on pass-through nodes). If the port is used by a VT tunnel, the 
tunnel name will appear here.

• % Uses—Shows the percent of the matrix port that is used. Each matrix port can carry 28 VT1.5s, 
so for example, if one STS carries seven VT1.5 circuits, the matrix port will be 25% used.

• Usage—Shows the port usage. For example, if one STS carries seven VT1.5 circuits, the matrix port 
will show that 7 of 28 are used.

Purpose This procedure allows you to view the percentage of cross-connect card 
resources used by circuits that traverse or terminate at an ONS 15454.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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 Stop. You have completed this procedure.

NTP-A151 Modify Circuit Characteristics

Step 1 Log into the network containing the circuit you want to modify. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 As needed, complete the “DLP-A231 Edit a Circuit Name” task on page 9-10.

Step 3 As needed, complete the “DLP-A232 Change Active and Standby Span Color” task on page 9-11.

Step 4 As needed, complete the “DLP-A233 Edit Path Protection configuration Circuit Path Selectors” task on 
page 9-12.

 Stop. You have completed this procedure.

DLP-A230 Change a Circuit State

Step 1 Click the Circuits tab.

Step 2 Click the circuit with the state you want to change.

Note You cannot edit the circuit state if the circuit is routed to nodes with a CTC software release older 
than Release 3.4. These circuits will automatically be in service (IS).

Step 3 From the Tools menu, choose Circuits > Set Circuit State.

Purpose This procedure provides tasks that you can use to edit or change the 
properties of ONS 15454 circuits.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the state of a circuit.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Alternatively, you can click the Edit button, then click the State tab on the Edit Circuits window.

Step 4 On the Set Circuit State dialog box (Figure 9-2) change the circuit state by choosing one of the following 
choices from the Target Circuit State pull-down menu:

• IS—Places the circuit in service

• OOS—Places the circuit out of service

• OOS-AINS—Places the circuit out of service, auto in service

• OOS-MT—Places the circuit out of service, maintenance

See Table 9-2 on page 9-4 for additional information about circuit states.

Step 5 If you want to apply the state to the circuit source and destination ports, check the Apply to Drop Ports 
check box.

Figure 9-2 Changing Circuit State

Step 6 Click OK. 

Note CTC will not change the state of the circuit source and destination port in certain circumstances. 
For example, if the circuit size is smaller than the port, for example, a VT1.5 circuit on an STS 
port, CTC will not change the port state from IS to OOS. If CTC cannot change the port state, a 
message is displayed and you must change the port state manually.

Step 7 Return to your originating procedure (NTP).

DLP-A231 Edit a Circuit Name

Purpose This task edits a circuit name.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Click the Circuits tab.

Step 2 Click the circuit you want to rename, then click Edit.

Step 3 On the General tab, click the Name field and edit or rename the circuit. Names can be up to 48 
alphanumeric and/or special characters. However, if you will ever create a monitor circuit on this circuit, 
do not make the name longer than 44 characters because monitor circuits will add “_MON” (four 
characters) to the circuit name.

Step 4 Click the Apply button.

Step 5 From File menu, select Close. 

Step 6 On the Circuits window, verify that the circuit was correctly renamed.

Step 7 Return to your originating procedure (NTP).

DLP-A232 Change Active and Standby Span Color

Step 1 From the Edit menu, choose Preferences.

Step 2 On the Preferences dialog box, click the Circuit tab.

Step 3 Complete one or more of the following steps, as required:

• To change the color of the active (working) span, go to Step 4.

• To change the color of the standby (protect) span, go to Step 5.

• To return active and standby spans to their default colors, go to Step 6.

Step 4 Change the color of the active span:

a. Next to Active Span Color, click the Color button.

b. On the Pick a Color dialog box, click the color for the active span, or click the Reset button if you 
want the active span to display the last applied (saved) color.

c. Click OK to close the Pick a Color dialog box. If you want to change the standby span color, go to 
Step 5. If not, click OK to save the change and close the Preferences dialog box, or click Apply to 
save the change and keep the Preferences dialog box displayed.

Step 5 Change the color of the standby span: 

a. Next to Standby Span Color, click the Color button.

b. On the Pick a Color dialog box, click the color for the standby span, or click the Reset button if you 
want the standby span to display the last applied (saved) color.

Purpose This task changes the color of active (working) and standby (protect) 
circuit spans displayed on the detailed circuit map of the Edit Circuits 
window. By default, working spans are green and protect spans are purple.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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c. Click OK to save the change and close the Preferences dialog box, or click Apply to save the change 
and keep the Preferences dialog box displayed.

Step 6 Return the active and standby spans to their default colors: 

a. From the Edit menu, choose Preferences.

b. On the Preferences dialog box, click the Circuits tab.

c. Click the Reset to Defaults button.

d. Click OK to save the change and close the Preferences dialog box, or click Apply to save the change 
and keep the Preferences dialog box displayed.

Step 7 Return to your originating procedure (NTP). 

DLP-A233 Edit Path Protection configuration Circuit Path Selectors

Step 1 Click the Circuits tab.

Step 2 On the Circuits tab, click the path protection configuration circuit(s) you want to edit. To change the 
settings for multiple circuits, press the Shift key (to choose adjoining circuits) or the Ctrl key (to choose 
non-adjoining circuits) and click each circuit you want to change.

Step 3 From the Tools menu, choose Circuits > Set Path Selector Attributes.

Note Alternatively, for single circuits, you can click the Edit button, then click the UPSR Selectors 
tab on the Edit Circuits window.

Step 4 On the Path Selectors Attributes dialog box (Figure 9-3), edit the following path protection configuration 
selectors, as needed:

• Revertive—If checked, traffic reverts to the working path when conditions that diverted it to the 
protect path are repaired. If not checked, traffic does not revert.

• Reversion Time (Min)—If Revertive is checked, sets the amount of time that will elapse before 
traffic reverts to the working path. The range is 0.5 to 12 minutes in 0.5 minute increments.

• SF Ber Level—Sets the path protection configuration signal failure BER threshold (STS circuits 
only).

• SD Ber Level—Sets the path protection configuration signal degrade BER threshold (STS circuits 
only).

Purpose This task changes the path protection configuration signal fail and signal 
degrade thresholds, the reversion and reversion time, and the PDI-P 
settings for one or more path protection configuration circuits.

Tools/Equipment None

Prerequisite Procedures NTP-A44 Provision Path Protection Nodes, page 5-32

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• PDI-P—When checked, traffic switches if an STS payload defect indication is received (STS 
circuits only).

Step 5 Click OK and verify that the changed values are correct. 

Figure 9-3 Editing Path Protection configuration Path Selectors

Step 6 Return to your originating procedure (NTP).

DLP-A263 Edit Path Protection configuration Dual Ring Interconnect Circuit 
Hold-Off Timer

Note Cisco recommends that you set the DRI port HOT value to zero and the circuit path selector HOT value 
to a number equal to or greater than zero.

Step 1 Click the Circuits tab.

Step 2 Click the path protection configuration circuit you want to edit, then click the Edit button. 

Purpose This task changes the amount of time a path selector switch is delayed for 
circuits routed on path protection configuration dual ring interconnect 
(DRI) topology. In DRIs, switching contention might occur depending 
upon the relative switching speed of the path selector and the transmission 
delay on the alternative routes. The hold-off time (HOT) allows you to 
change switch times to prevent the switching contention.

Tools/Equipment None

Prerequisite Procedures NTP-A44 Provision Path Protection Nodes, page 5-32

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 On the Edit Circuit window, click the UPSR Selectors tab.

Step 4 Create a hold-off time for the circuit source and destination ports:

a. Under Holder Off Timer, double-click the cell of the circuit source port (top row), then type the new 
hold-off time. The range is 0 to 10,000 ms in increments of 100. 

b. Under Hold-Off Timer, double-click the cell of the circuit destination port (bottom row), then type 
the hold-off time entered in Step a.

Step 5 Click Apply, then close the Edit Circuit window by choosing Close from the File menu.

Step 6 Return to your originating procedure (NTP).

NTP-A416 Convert a CTC Circuit to TL1 Cross-Connects

Note You can only use this procedure with DS-1, DS-3, or OC-N circuits. You cannot use the procedure with 
Ethernet circuits, VT tunnels, or VT aggregation points.

Step 1 Log into an ONS 15454 node on the network where you want to convert the CTC circuits. See the 
“DLP-A60 Log into CTC” task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab, then choose the CTC circuit(s) that you want to convert to TL1 cross-connects. 
The circuit(s) must have an INCOMPLETE or ACTIVE status.

Step 4 From the Tools menu, choose Circuits > Convert CTC Circuit to TL1 Cross-Connects.

Step 5 On the Convert to TL1 Cross Connect dialog box, click OK.

The Convert to TL1 Cross Connect Results dialog box displays the results of the conversion. If any 
circuits could not be converted, those circuits are listed.

Step 6 On the Convert to TL1 Cross Connect Results dialog box, click OK.

If the circuit you selected had an INCOMPLETE status, its status will not change. If you selected an 
ACTIVE (complete) circuit, its status will change to UPGRADABLE.

Step 7 If you are repairing a circuit, complete the circuit creation procedure in Chapter 6, “Create Circuits and 
VT Tunnels,” appropriate to the circuit you are repairing to replace or repair the circuit cross-connects. 
On the Circuit Creation wizard, shown in Figure 9-4, check Create cross-connects only (TL1-like).

After you repair or replace all missing cross-connects, CTC automatically merges them and the circuit 
status changes to UPGRADABLE. 

Purpose This procedure converts CTC circuits to a set of TL1 cross-connects, which 
enables you to repair a missing cross-connect or change the 
cross-connect(s) using the TL1-like circuit option during circuit creation. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 9-4 Choosing the Cross-Connects Only Option

Step 8 To upgrade the repaired circuit to a CTC circuit, go to the “NTP-A417 Upgrade TL1 Cross-Connects to 
CTC Circuits” procedure on page 9-15.

 Stop. You have completed this procedure.

NTP-A417 Upgrade TL1 Cross-Connects to CTC Circuits

Step 1 Log into an ONS 15454 node on the network where you want to upgrade the TL1-created or CTC-created 
TL1-like cross-connects. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If you 
are already logged in, go to Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab, then choose one or more circuits with an UPGRADABLE status. These circuits 
contain a series of cross-connects that are linked together to form a circuit path. The cross-connects may 
have been created with TL1 or with CTC using the TL1-like cross-connects option.

Step 4 From the Tools menu, choose Circuits > Upgrade TL1 Cross-Connects to CTC Circuits.

Step 5 On the Upgrade Circuits dialog box, click OK.

The circuit status changes to ACTIVE.

90
39

4

Create cross-connects only check box

Purpose This procedure converts a series of cross-connects displayed as 
UPGRADABLE in the CTC Circuits window to an ACTIVE CTC circuit. 

Tools/Equipment None

Prerequisite Procedures TL1-created or CTC-created TL1-like cross-connects must exist on the 
network.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 On the Circuit Upgrade Results dialog box, click OK.

 Stop. You have completed this procedure.

NTP-A152 Delete Circuits

Step 1 Log into an ONS 15454 node on the network where you want to delete the circuit. See the DLP-A60 Log 
into CTC, page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Investigate all network alarms and resolve any problems that may be affected by the circuit deletion. 
Refer to the Alarm Troubleshooting chapter in the Cisco ONS 15454 Troubleshooting Guide.

Step 4 Verify that traffic is no longer carried on the circuit and that the circuit can be safely deleted.

Step 5 Click the Circuits tab.

Step 6 Choose the circuit(s) you want to delete, then click Delete.

Step 7 On the Delete Circuits confirmation dialog box, check Set drop ports to OOS if you want to put the 
circuit source and destination ports out of service. (CTC will place the ports out of service only if the 
circuit is the same size as the port or is the only circuit using the port.) Click Yes to confirm the deletion.

Step 8 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

Purpose This procedure deletes circuits.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A78 Create a Monitor Circuit

Note Monitor circuits cannot be used with EtherSwitch circuits. 

Note For unidirectional circuits, create a drop to the port where the test equipment is attached.

Step 1 Log into an ONS 15454 node on the network where you will create the monitor circuit. See the 
“DLP-A60 Log into CTC” task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab.

Step 4 Choose the bidirectional (2-way) circuit that you want to monitor and double-click it (or click Edit).

Step 5 Verify that the circuit name is no more than 44 characters. Monitor circuits append a “_MON” to the 
circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click Apply.

Step 6 On the Edit Circuit window, click the Monitors tab.

The Monitors tab displays ports that you can use to monitor the circuit. 

Note The Monitor tab is only available when the circuit has an ACTIVE status. 

Step 7 On the Monitors tab, choose the monitor source port. The monitor circuit will display traffic coming into 
the node at the port you choose. 

Note In Figure 9-5, you would choose either the DS1-14 card (to test circuit traffic entering Node 2 
on the DS1-14) or the OC-N card at Node 1 (to test circuit traffic entering Node 1 on the OC-N 
card).

Step 8 Click Create Monitor Circuit.

Step 9 In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot, port, 
STS, VT, or DS1 for the monitored circuit. 

Note In the Figure 9-5 example, the monitor circuit destination is Port 2 on the EC1-12 card. 

Step 10 Click Next.

Purpose This procedure creates a monitor circuit that monitors traffic on primary, 
bidirectional circuits.

Tools/Equipment None

Prerequisite Procedures Bidirectional (2-way) circuits must exist on the network. See Chapter 6, 
“Create Circuits and VT Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 11 On the Circuit Routing Preferences panel, review the monitor circuit information. If you want the 
monitor circuit routed on a BLSR protection channel, click Protection Channel Access. 

Step 12 Click Finish.

Step 13 On the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.

Figure 9-5 shows a sample monitor circuit setup. VT1.5 traffic is received by Port 1 of the EC1-12 card 
at Node 1. To monitor the VT1.5 traffic, test equipment is plugged into Port 2 of the EC1-12 card and a 
monitor circuit to Port 2 is provisioned in CTC. (Circuit monitors are one-way.) This example assumes 
circuits have been created.

Figure 9-5 VT1.5 Monitor Circuit Received at an EC1-12 Port

 Stop. You have completed this procedure.

NTP-A79 Create a J1 Path Trace

Step 1 Log into the node on the network where you will create the path trace. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 Complete the following tasks as needed: 

• As needed, complete the “DLP-A264 Provision Path Trace on Circuit Source and Destination Ports” 
task on page 9-19.

• As needed, complete the “DLP-A137 Provision Path Trace on OC-N Ports” task on page 9-23.

 Stop. You have completed this procedure.

EC1-12 OC-N

XC

ONS 15454
Node 1

OC-N DS1-14

XC

ONS 15454
Node 2

VT1.5 Drop

VT1.5 Monitor

Test Set

Port 1

Port 2

Class 5
Switch

45
15

7

Purpose This procedure createa a repeated, fixed-length string of characters used to 
monitor interruptions or changes to circuit traffic. 

Tools/Equipment ONS 15454 cards capable of transmitting and/or receiving path trace must 
be installed. See Table 9-3 on page 9-19 for a list of cards.

Prerequisite Procedures Path trace can only be provisioned on OC-N (STS) circuits. See Chapter 6, 
“Create Circuits and VT Tunnels” for OC-N circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A264 Provision Path Trace on Circuit Source and Destination Ports

Note This procedure assumes you are setting up path trace on a bidirectional circuit and setting up transmit 
strings at the circuit source and destination.

Step 1 Click the Circuits tab.

Step 2 For the STS circuit you want to monitor, verify that the source and destination ports are on a card that 
can transmit and receive the path trace string. See Table 9-3 for a list of cards.

If neither port is on a transmit/receive card, you will not be able to complete this procedure. If one port 
is on a transmit/receive card and the other is on a receive-only card, you can set up the transmit string at 
the transmit/receive port and the receive string at the receive-only port, but you will not be able to 
transmit in both directions.

Purpose This task creates a path trace on STS circuit source ports and destination 
ports. 

Tools/Equipment ONS 15454 cards capable of transmitting and receiving path trace must be 
installed at the circuit source and destination ports. See Table 9-3 on 
page 9-19 for a list of cards.

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 9-3 Path-Trace-Capable ONS 15454 Cards 

J1 Function Cards

Transmit and Receive DS1-14, DS1N-14, 

DS3-12E, DS3N-12E, DS3XM-6, 

G1000-4

M400T-12

M4000-2

Receive Only EC1-12

OC3 IR 4/STM1 SH 1310

OC3 IR 4/STM1 SH 1310-8

OC12/STM4-4

OC48 IR/STM16 SH AS 1310, OC48 LR/STM16 LH AS 1550

OC192 SR/STM64 IO 1310

OC192 LR/STM64 LH 1550

OC192 IR/STM SH 1550

ML100T

ML1000
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Step 3 Choose the STS circuit you want to trace, then double-click it (or click Edit).

Step 4 On the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A 
detailed map of the source and destination ports is displayed.

Step 5 Provision the circuit source transmit string:

a. On the detailed circuit map right-click the circuit source port (the square on the left or right of the 
source node icon) and choose Edit J1 Path Trace (port) from the shortcut menu. Figure 9-6 shows 
an example.

Figure 9-6 Selecting the Edit Path Trace Option 

b. In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes 
the source port easy to identify, such as the node IP address, node name, circuit name, or another 
string. If the New Transmit String field is left blank, the J1 transmits a string of null characters.

c. Click Apply, then click Close.

Step 6 Provision the circuit destination transmit string:

a. On the detailed circuit map, (Figure 9-6) right-click the circuit destination port and choose Edit 
Path Trace from the shortcut menu.

b. In the New Transmit String field, enter the string that you want the circuit destination to transmit. 
Enter a string that makes the destination port easy to identify, such as the node IP address, node 
name, circuit name, or another string. If the New Transmit String field is left blank, the J1 transmits 
a string of null characters.

c. Click Apply.
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Step 7 Provision the circuit destination expected string:

a. On the Circuit Path Trace window, enable the path trace expected string by choosing Auto or 
Manual from the Path Trace Mode pull-down menu:

• Auto—The first string received from the source port is automatically provisioned as the current 
expected string. An alarm is raised when a string that differs from the baseline is received. 

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is 
raised when a string that differs from the Current Expected String is received.

b. If you set the Path Trace Mode field to Manual, enter the string that the circuit destination should 
receive from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.

c. Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm 
indication signal (AIS) and RDI when the STS Path Trace Identifier Mismatch Path (TIM-P) alarm 
is displayed. Refer to the Cisco ONS 15454 Troubleshooting Guide for descriptions of alarms and 
conditions.

d. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the Alarm Indication Signal when a C2 mis-match occurs.

e. Click Apply, then click Close.

Step 8 Provision the circuit source expected string:

a. On the Edit Circuit window (with Show Detailed Map chosen, see Figure 9-6) right-click the circuit 
source port and choose Edit Path Trace from the shortcut menu.

b. On the Circuit Path Trace window, enable the path trace expected string by choosing Auto or 
Manual from the Path Trace Mode pull-down menu:

• Auto—Uses the first string received from the port at the other path trace end as the baseline 
string. An alarm is raised when a string that differs from the baseline is received.

• Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when 
a string that differs from the Current Expected String is received.

c. If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive 
from the circuit destination in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.

d. Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm 
indication signal (AIS) and RDI when the STS Path Trace Identifier Mismatch Path (TIM-P) alarm 
is displayed. Refer to the Cisco ONS 15454 Troubleshooting Guide for descriptions of alarms and 
conditions.

e. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the Alarm Indication Signal when a C2 mis-match occurs.

f. Click Apply.

Step 9 After you set up the path trace, the received string is displayed in the Received field on the path trace 
setup window. Figure 9-7 shows an example. The following options are available:

• Click Hex Mode to display path trace in hexadecimal display. The button name changes to ASCII 
Mode. Click it to return the path trace to ASCII display.

• Click the Reset button to reread values from the port. 

• Click Default to return to the path trace default settings (Path Trace Mode is set to Off and the New 
Transmit and New Expected Strings are null).
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Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The Expect and Receive strings are updated every few seconds if the Path Trace Mode field is set to Auto 
or Manual.

Step 10 Click Close.

Figure 9-7 Setting Up a Path Trace

When you display the detailed circuit window, path trace is indicated by an M (manual path trace) or an 
A (automatic path trace) at the circuit source and destination ports. Figure 9-8 shows an example. 

Figure 9-8 Detailed Circuit Window With Manual Expected String Enabled
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Step 11 Return to your originating procedure (NTP).

DLP-A137 Provision Path Trace on OC-N Ports

Step 1 Display the node where path trace was provisioned on the circuit source and destination ports. 

Step 2 Click Circuits.

Step 3 Choose the STS circuit that has path trace provisioned on the source and destination ports, then click 
Edit.

Step 4 On the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A 
detailed circuit graphic showing source and destination ports is displayed.

Step 5 On the detailed circuit map right-click the circuit OC-N port (the square on the left or right of the source 
node icon) and choose Edit Path Trace from the shortcut menu. 

Note The OC-N port must be on a receive-only card listed in Table 9-3 on page 9-19. If not, the Edit 
Path Trace menu item will not display.

Step 6 On the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual 
from the Path Trace Mode pull-down menu:

• Auto—Uses the first string received from the port at the other path trace end as the current expected 
string. An alarm is raised when a string that differs from the baseline is received. For OC-N ports, 
Auto is recommended because Manual mode requires you to trace the circuit on the Edit Circuit 
window to determine whether the port is the source or destination path.

• Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when a 
string that differs from the Current Expected String is received. 

Step 7 If you set the Path Trace Mode field to Manual, enter the string that the OC-N port should receive in the 
New Expected String field. To do this, trace the circuit path on the detailed circuit window to determine 
whether the port is in the circuit source or destination path, then set the New Expected String to the string 
transmitted by the circuit source or destination. If you set the Path Trace Mode field to Auto, skip this 
step.

Step 8 Click Apply, then click Close.

Purpose This task monitors a path trace on OC-N ports within the circuit path. 

Tools/Equipment The OC-N ports you want to monitor must be on OC-N cards capable of 
receiving path trace. See Table 9-3 on page 9-19.

Prerequisite Procedures DLP-A264 Provision Path Trace on Circuit Source and Destination Ports, 
page 9-19

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 9 Return to your originating procedure (NTP). 
9-24
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

March 2003
C H A P T E R 10

Change Node Settings

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to modify node provisioning for the Cisco ONS 15454. To provision a new 
node, see Chapter 4, “Turn Up Node.” To change default network element settings and to view a list of 
those settings, see Appendix C, “Network Element Defaults.”

Before You Begin
Before performing the following procedures, investigate all alarms and clear any trouble conditions. 
Refer to the Cisco ONS 15454 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-A81 Change Node Management Information, page 10-2—As needed, complete this procedure 
to change node name, contact information, latitude, longitude, date, and time.

2. NTP-A201 Change CTC Network Access, page 10-4—As needed, complete these procedures to 
change the IP address, default router, subnet mask, network configuration settings, and static routes.

3. NTP-A202 Customize the CTC Network View, page 10-8—As needed, complete this procedure to 
create domains and customize the appearance of the network map, including specifying a different 
default map, creating domains, selecting your own map or image, changing the background color.

4. NTP-A203 Modify or Delete Card Protection Settings, page 10-13—As needed, complete this 
procedure to modify and delete 1:1, 1:N, 1+1, and Y Cable protection groups.

5. NTP-A85 Change Node Timing, page 10-19—As needed, complete this procedure to make changes 
to the network timing parameters.

6. NTP-A205 Modify Users and Change Security, page 10-21—As needed, complete this procedure to 
make changes to user settings, including security level and security policies, and to delete users.

7. NTP-A87 Change SNMP Settings, page 10-27—As needed, complete this procedure to modify or 
delete SNMP.
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NTP-A81 Change Node Management Information

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Click the Provisioning > General tabs.

Step 4 Complete the “DLP-A140 Change the Node Name, Date, Time, and Contact Information” task on 
page 10-2.

Step 5 Complete the “DLP-A265 Change the Login Legal Disclaimer” task on page 10-3 if needed.

Step 6 After confirming the changes, complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

DLP-A140 Change the Node Name, Date, Time, and Contact Information

Note Changing the date, time, or time zone may invalidate the node’s performance monitoring counters.

Step 1 In node view, click the Provisioning > General tabs.

Step 2 Change any of the following:

• General: Node Name 

• General: Contact 

• Location: Latitude 

• Location: Longitude 

Purpose Use this procedure to change node name, date, time, contact information, 
or the login legal disclaimer.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this procedure to change basic information such as node name, date, 
time, and contact information.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Location: Description 

Note To see changes to longitude or latitude on the network map, you must go to network view and 
right-click the specified node, then click Reset Node Position.

• Time: Use SNTP Server

• Time: Date (M/D/Y)

• Time: Time (H:M:S)

• Time: Time Zone

• Time: Use Daylight Saving Time

See the “NTP-A25 Set Up Name, Date, Time, and Contact Information” procedure on page 4-6 for 
detailed field descriptions.

Step 3 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 4 Return to the “NTP-A81 Change Node Management Information” procedure on page 10-2.

DLP-A265 Change the Login Legal Disclaimer

Step 1 In node view, click the Provisioning > Security > Legal Disclaimer > HTML tabs.

Step 2 The existing statement is a default, non-customer-specific disclaimer. If you want to edit this statement 
with specifics for your company, you can change the text. You can also use the following HTML 
commands to format the text:

• <b> Begins boldface font

• </b> Ends boldface font

• <center> Aligns type in the center of the window

• </center> Ends the center alignment

• <font=n, where n = point size> Changes the font to the new size

• </font> Ends the font size command

• <p> Creates a line break

• <sub> Begins subscript

• </sub> Ends subscript

Purpose Use this procedure to modify the legal disclaimer statement shown in the 
CTC login dialog box so that it will display customer-specific information 
when users log into the network.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser or higher
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• <sup> Begins superscript

• </sup> Ends superscript

• <u> Starts underline

• </u> Ends underline

Step 3 If you want to preview your changed statement and formatting, click the Preview subtab.

Step 4 Click Apply.

Step 5 Return to the “NTP-A81 Change Node Management Information” procedure on page 10-2.

NTP-A201 Change CTC Network Access

Note Additional ONS 15454 networking information and procedures, including IP addressing examples, static 
route scenarios, Open Shortest Path First (OSPF) protocol, and routing information protocol options are 
provided in the IP Networking section of the Cisco ONS 15454 Reference Manual.

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8. 

Step 3 Perform any of the following tasks as needed:

• DLP-A266 Change IP Settings, page 10-5

• DLP-A142 Modify a Static Route, page 10-6

• DLP-A143 Delete a Static Route, page 10-6

• DLP-A144 Disable OSPF, page 10-7

• DLP-A250 Set Up or Change Open Shortest Path First Protocol, page 4-15.

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

Purpose Use this procedure to change essential network information, including IP 
settings, static routes, and OSPF options.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A266 Change IP Settings

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 Change any of the following:

• IP Address

• Suppress CTC IP Display

• LCD IP Setting

• Default Router

• Subnet Mask Length

• Forward DHCP Request To

• TCC CORBA (IIOP) Listener Port

• Gateway Settings

See the “DLP-A249 Provision IP Settings” task on page 4-9 for detailed field descriptions.

Step 3 Click Apply.

If you changed any network fields that will cause the node to reboot, the Change Network Configuration 
confirmation dialog box appears. If you changed a Gateway Setting, a confirmation appropriate to the 
gateway field appears.

Step 4 If a confirmation dialog box appears, click Yes.

If you changed an IP address, subnet mask length, or TCC CORBA (IIOP) Listener Port, both ONS 
15454 TCC+/TCC2 cards will reboot, one at a time. A TCC+/TCC2 reboot causes a temporary loss of 
connectivity to the node, but traffic is unaffected. 

Step 5 Confirm that the changes appear on the Provisioning > Network > General tab. If the changes do not 
appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).

Purpose Use this task to change the IP address, subnet mask, default router, DHCP 
access, firewall IIOP listener port, LCD IP display, and proxy server 
settings.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-A142 Modify a Static Route

Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Click the Static Routing tab. 

Step 3 Click the static route you want to edit. 

Step 4 Click Edit.

Step 5 In the Edit Selected Static Route dialog box, enter the following (see the “DLP-A65 Create a Static 
Route” task on page 4-14 for detailed field descriptions): 

• Mask

• Next Hop

• Cost

Step 6 Click OK.

Step 7 Return to your originating procedure (NTP).

DLP-A143 Delete a Static Route

Step 1 In node view, click the Provisioning > Network > Static Routing tabs.

Step 2 Click the static route you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. 

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to modify a static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to delete an existing static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A144 Disable OSPF

Step 1 In node view, click the Provisioning > Network > OSPF tabs (Figure 10-1). The OSPF subtab has 
several options.

Figure 10-1 Disabling OSPF on the ONS 15454

Step 2 In the OSPF on LAN area, uncheck the OSPF active on LAN check box.

Step 3 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 4 Return to your originating procedure (NTP).

Purpose Use this task to disable the Open Shortest Path First (OSPF) routing 
protocol process for an ONS 15454 LAN.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A202 Customize the CTC Network View

Step 1 Log into an ONS 15454. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions.

Step 2 Complete the following tasks, as needed: 

• DLP-A145 Change the Network View Background Color, page 10-8

• DLP-A267 Change the Default Network View Background Map, page 10-9

• DLP-A268 Apply a Custom Network View Background Map, page 10-10

• DLP-A148 Create Domain Icons, page 10-11

• DLP-A149 Manage Domain Icons, page 10-11

• DLP-A269 Enable Dialog Box Do-Not-Display Option, page 10-12

 Stop. You have completed this procedure.

DLP-A145 Change the Network View Background Color

Note If you modify background colors, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the View menu choose Go to Network View.

Step 2 Right-click the network view or domain map area and choose Set Background Color from the shortcut 
menu. 

Step 3 On the Choose Color dialog box, select a background color.

Purpose Use this procedure to modify the CTC network view, including grouping 
nodes into domains for a less-cluttered display, changing the network view 
background color, and using a custom image for the network view 
background.

Tools/Equipment None

Prerequisite Procedures None

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to change the network view background color and the domain 
view background color (the area displayed when you open a domain). 

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-A267 Change the Default Network View Background Map

Note If you modify the background image, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the View menu choose Go to Network View.

Step 2 From the Edit menu, choose Preferences.

Step 3 On the Preferences dialog box, click the Map tab, then check the Use Default Map check box if it is not 
already selected.

Step 4 Click the Default Maps field and choose a default map from the pull-down menu. Map choices are: 
Germany, Japan, Netherlands, South Korea, United Kingdom, and the United States (default).

Step 5 Click Apply. The new network map is displayed.

Step 6 Click OK.

Step 7 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat until 
all the ONS 15454 icons are visible.

Step 8 If you need to reposition the node icons, drag and drop them one at a time to a new location on the map.

Step 9 If you want to change the magnification of the icons, right-click the network view and choose Zoom In. 
Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 10 Return to your originating procedure (NTP).

Purpose Use this task to change the default map of the CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A268 Apply a Custom Network View Background Map

Note You can replace the network view background image with any JPEG or GIF image that is accessible on 
a local or network drive. If you apply a custom background image, the change is stored in your CTC user 
profile on the computer. The change does not affect other CTC users.

Step 1 From the View menu choose Go to Network View.

Step 2 Right-click the network or domain map and select Set Background Image.

Step 3 Click Browse. Navigate to the graphic file you want to use as a background.

Step 4 Select the file. Click Open.

Step 5 Click Apply and then click OK.

Step 6 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat this 
step until all the ONS 15454 icons are visible.

Step 7 If you need to reposition the node icons, drag and drop them one at a time to a new location on the map.

Step 8 If you want to change the magnification of the icons, right-click the network view and choose Zoom In. 
Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 9 At the network view, use the CTC toolbar Zoom buttons (or right-click the graphic area and select a 
Zoom command from the shortcut menu) to set the area of the image you want to view.

Step 10 Return to your originating procedure (NTP).

Purpose Use this task to change the background image or map of the CTC network 
view.

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-A148 Create Domain Icons 

Note Domains that you create are visible to all users who log into the network.

Step 1 From the View menu choose Go to Network View.

Step 2 Right-click the network map and choose Create New Domain from the shortcut menu. 

Step 3 When the domain icon appears on the map, click the map name and type the domain name.

Step 4 Press Enter.

Step 5 Return to your originating procedure (NTP).

DLP-A149 Manage Domain Icons 

Note All domain changes, such as added or removed nodes, are visible to all users who log into the network.

Step 1 From the View menu choose Go to Network View.

Step 2 Locate the domain action you want in Table 10-1 and complete the appropriate steps.

Purpose Use this task to create a domain icon, which can be used to group 
ONS 15454 icons in CTC network view. 

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to manage CTC network view domain icons.

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

DLP-A148 Create Domain Icons, page 10-11

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Return to your originating procedure (NTP).

DLP-A269 Enable Dialog Box Do-Not-Display Option

Note If any user who has rights to perform an operation (for example, creating a circuit) selects the “Do not 
show this dialog again” check box on a dialog box, the dialog box is not displayed for any other users 
who perform that operation on the network unless the command is overridden using the following task.

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the General tab.

Table 10-1 Managing Domains

Domain action Steps

Move a domain Drag and drop the domain icon to the new location.

Rename a domain Right-click the domain icon and choose Rename Domain from the shortcut 
menu. Type the new name in the domain name field.

Add a node to a 
domain

Drag and drop the node icon to the domain icon.

Move a node from a 
domain to the 
network map

Open the domain and right-click a node. Select Move Node Back to Parent 
View.

Open a domain • Double-click the domain icon.

• Right-click the domain and choose Open Domain.

Return to network 
view

Right-click the domain view area and choose Go to Parent View from the 
shortcut menu.

Preview domain 
contents

Right-click the domain icon and choose Show Domain Overview. The domain 
icon shows a small preview of the nodes in the domain. To turn off the domain 
overview, right-click the overview and select Show Domain Overview.

Remove domain Right-click the domain icon and choose Remove Domain. Any nodes residing in 
the domain are returned to the network map.

Purpose Use this task to ensure that a user-selected “Do not display” dialog box 
preference is enabled for subsequent sessions or to disable the do not 
display option. 

Tools/Equipment None

Prerequisite procedures DLP-A60 Log into CTC, page 3-23

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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The Preferences Management area field lists all dialog boxes where “Do not show this dialog again.” 
was checked. 

Step 3 Choose one of the following:

• Don’t Show Any—Hides all do-not-display check boxes.

• Show All—Overrides do-not-display check box selections and displays all dialog boxes.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

NTP-A203 Modify or Delete Card Protection Settings

Caution Modifying and deleting protection groups can be service affecting.

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8. 

Step 3 Perform any of the following tasks as needed:

• DLP-A150 Modify a 1:1 Protection Group, page 10-14

• DLP-A152 Modify a 1:N Protection Group, page 10-15

• DLP-A154 Modify a 1+1 Protection Group, page 10-16

• DLP-A270 Modify a Y Cable Protection Group, page 10-17

• DLP-A155 Delete a Protection Group, page 10-18

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

Purpose Use this procedure to modify or delete card protection settings.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A150 Modify a 1:1 Protection Group 

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 Under Protection Groups, click the 1:1 protection group you want to modify.

Step 3 Under Selected Group, you can modify the following, as needed:

• Name—As needed, type the changes to the protection group name. The name can have up to 32 
alphanumeric characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time menu. Uncheck if you do not 
want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time pull-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This 
is the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

Step 4 Click Apply. Confirm that the changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 5 Return to your originating procedure (NTP).

Note To convert electrical protection groups, see the “NTP-A91 Upgrade DS-1 and DS-3 Protect 
Cards from 1:1 Protection to 1:N Protection” procedure on page 11-53.

Purpose Use this task to modify a 1:1 protection group for electrical (DS-1, DS-3, 
EC-1, and DS3XM-6) cards.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A152 Modify a 1:N Protection Group 

Step 1 Verify that the DS-1 and DS-3 cards are installed according to the 1:N specifications in the “DLP-A72 
Create a 1:N Protection Group” task on page 4-28.

Step 2 In node view, click the Provisioning > Protection tabs.

Step 3 Under Protection Groups, click the 1:N protection group you want to modify.

Step 4 Under Selected Group, change any of the following, as needed:

• Name—As needed, type the changes to the protection group name. The name can have up to 32 
alphanumeric characters.

• Available Cards—If cards are available, they will appear here. Use the arrow buttons to move them 
into the Working Cards column.

• Working Cards—Use the arrow buttons to move cards out of the Working Cards column.

• Reversion Time—Choose a reversion time from the pull-down menu. The range is 0.5 to 12.0 
minutes. The default is 5.0 minutes. This is the amount of time that will elapse before the traffic 
reverts to the working card. Traffic can revert when conditions causing the switch are cleared.

See the “DLP-A72 Create a 1:N Protection Group” task on page 4-28 for field descriptions.

Step 5 Click Apply. The changes are applied. Confirm that the changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 6 Return to your originating procedure (NTP).

Note To convert electrical protection groups, see the “NTP-A91 Upgrade DS-1 and DS-3 Protect 
Cards from 1:1 Protection to 1:N Protection” procedure on page 11-53.

Purpose Use this task to modify a 1:N protection group for DS-1 and DS-3 cards.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A154 Modify a 1+1 Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 Under Protection Groups, click the 1+1 protection group you want to modify.

Step 3 Under Selected Group, you can modify the following:

• Name—As needed, type the changes to the protection group name. The name can have up to 32 
alphanumeric characters.

• Bidirectional switching—As needed, check or uncheck

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time menu. Uncheck if you do not 
want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time pull-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This 
is the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

See the “DLP-A73 Create a 1+1 Protection Group” task on page 4-29 for field descriptions.

Step 4 Click Apply. Confirm that the changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to modify a 1+1 protection group for any optical port (OC-3, 
OC-12, OC-12 IR, OC-48, OC-48AS, and OC-192). 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A270 Modify a Y Cable Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 Under Protection Groups, click the Y Cable protection group you want to modify.

Step 3 Under Selected Group, you can modify the following:

• Name—As needed, type the changes to the protection group name. The name can have up to 32 
alphanumeric characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time menu. Uncheck if you do not 
want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time pull-down menu. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This 
is the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

See the “DLP-A252 Create a Y Cable Protection Group” task on page 4-31 for field descriptions.

Step 4 Click Apply. Confirm that the changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to modify a Y Cable protection group for any client port on a 
MXP_2.5G_10G or TXP_MR_10G card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
10-17
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 10      Change Node Settings
NTP-A204 Delete a SONET DCC Termination
DLP-A155 Delete a Protection Group 

Step 1 In the node view, click the Provisioning > Protection tabs.

Step 2 Under Protection Groups, click the protection group you want to delete.

Step 3 Click Delete.

Step 4 Click Yes in the Delete Protection Group dialog box to confirm deletion. Confirm that the changes 
appear; if they do not, repeat Steps 1- 3. 

Step 5 Return to your originating procedure (NTP).

NTP-A204 Delete a SONET DCC Termination

Note Deleting a DCC termination may cause you to lose visibility of nodes that do not have other DCCs or 
network connections to the CTC computer.

Step 1 Log into the ONS 15454 node where you want to delete the DCC termination. See the “DLP-A60 Log 
into CTC” task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > DCC/GCC tabs.

Step 3 Click the DCC termination to be deleted and click Delete. The Delete SDCC Termination dialog box 
opens.

Step 4 Check the Set Port Out of Service check box if you want to change the port state to out of service (this 
may be service affecting).

Step 5 Click Yes to confirm. Confirm that the changes appear.

 Stop. You have completed this procedure.

Purpose Use this task to delete any 1:1, 1:N, 1+1, or Y Cable protection group.

Tools/Equipment None

Prerequisite Procedures DLP-A253 Provision SONET DCC Terminations, page 5-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to delete a SONET DCC termination on the ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
10-18
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 10      Change Node Settings
NTP-A85 Change Node Timing
NTP-A85 Change Node Timing 

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 As needed, complete the “DLP-A157 Change the Node Timing Source” task on page 10-19.

Step 4 If you need to change any internal timing settings, follow the “DLP-A70 Set Up Internal Timing” task 
on page 4-24 for the settings you need to modify.

Caution Internal timing is Stratum 3 and not intended for permanent use. All ONS 15454s should be timed to a 
Stratum 2 or better primary reference source. 

Step 5 If you need to verify timing after removing a node from a BLSR or path protection configuration, see 
the “DLP-A195 Verify Timing in a Reduced Ring” task on page 14-13.

Step 6 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

DLP-A157 Change the Node Timing Source 

Caution The following procedure may be service affecting and should be performed during a scheduled 
maintenance window.

Step 1 In node view, click the Provisioning > Timing tabs.

Purpose Use this procedure to change the SONET timing settings for the ONS 
15454.

Tools/Equipment None

Prerequisite Procedures NTP-A28 Set Up Timing, page 4-21

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to change the SONET timing source for the ONS 15454

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 In the General Timing section, change any of the following information:

• Timing Mode

Note Because mixed timing can cause timing loops, Cisco does not recommend using the Mixed 
Timing option. Use this mode with care.

• SSM Message Set

• Quality of RES

• Revertive

• Revertive Time

See the “DLP-A69 Set Up External or Line Timing” task on page 4-22 for field descriptions.

Step 3 In the BITS Facilities section, you can change the following information:

Note The BITS Facilities section sets the parameters for your BITS1 and BITS2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• State

• Coding

• Framing

• Sync Messaging

• AIS Threshold

• LBO

Step 4 Under Reference Lists, you can change the following information:

Note Reference lists define up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane. If you attach equipment to BITS Out 
pins, you normally attach it to a node with Line mode because equipment near the external 
timing reference can be directly wired to the reference. 

• NE Reference

• BITS 1 Out/BITS 2 Out

Step 5 Click Apply. Confirm that the changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 6 Return to your originating procedure (NTP).
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NTP-A205 Modify Users and Change Security

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A271 Change Security Policy - Single Node, page 10-21

• DLP-A272 Change Security Policy - Multiple Nodes, page 10-22

• DLP-A158 Change User Password and Security Level - Single Node, page 10-23

• DLP-A160 Change User Password and Security Level - Multiple Nodes, page 10-24

• DLP-A159 Delete User - Single Node, page 10-26

• DLP-A161 Delete User - Multiple Nodes, page 10-27

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

DLP-A271 Change Security Policy - Single Node

Step 1 In node view, click the Provisioning > Security > Policy tabs.

Step 2 Under Idle User Timeout, you can modify the timeout times by clicking the hour (H) and minute (M) 
arrows. You can choose values between 0 and 16 hours, and 0 and 59 minutes. 

Step 3 Under User Lockout, you can modify the following:

Purpose Use this procedure to modify user and security properties for the ONS 
15454.

Tools/Equipment None

Prerequisite Procedures NTP-A30 Create Users and Assign Security, page 4-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose Use this task to change the security policy for a single node, including idle 
user timeouts, user lockouts, password changes, and concurrent login 
policies. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Failed Logins Before Lockout—The number of failed login attempts a user can make before the user 
is locked out from the node. You can choose a value between 0 and 10.

• Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user 
who has been locked out from a node.

• Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can 
choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Step 4 Under Concurrent Logins, click Single Session Per User if you want to limit users to a single login 
session.

Step 5 Under Password Change, you can modify the following:

• Require [nn] different passwords...—Choose a value between 0 and 10 to determine how many 
different passwords have to be created before a password can be reused.

• ...or a waiting period of [nn] days before password reuse—Choose a value between 0 and 30 days 
to set the amount of time (in days) before a password can be reused.

Note Note that “Require [nn] different passwords or a waiting period of [nn] days before 
password reuse” is an OR statement, meaning that either one of the two conditions you set 
can be satisfied for a password to be reused.

Step 6 Click Apply. Confirm that the changes appear.

Step 7 Return to your originating procedure (NTP).

DLP-A272 Change Security Policy - Multiple Nodes

Step 1 From the View menu choose Go to Network View.

Step 2 Click the Provisioning > Security > Policy tabs. A read-only table of nodes and their policies is 
displayed.

Step 3 Click a node on the table that you want to modify, then click the Change button.

Step 4 Under Idle User Timeout, you can modify the timeout times by clicking the hour (H) and minute (M) 
arrows. You can choose values between 0 and 16 hours, and 0 and 59 minutes. 

Step 5 Under User Lockout, you can modify the following:

• Failed Logins Before Lockout—Choose the number failed login attempts a user can make before the 
user is locked out from the node. You can choose a value between 0 and 10.

Purpose Use this task to change the security policy for multiple nodes including idle 
user timeouts, user lockouts, password change, and concurrent login 
policies. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• Manual Unlock by Superuser—Select this check box if you want to allow a user with Superuser 
privileges to manually unlock a user who has been locked out from a node.

• Lockout Duration—Choose the amount of time the user will be locked out after a failed login. You 
can choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Step 6 Under Single Session, click Single Session Per User if you want to limit users to a single login session.

Step 7 Under Password Change, you can modify the following:

• Require [nn] different passwords...—Choose the number of different passwords that have to be 
created before a password can be reused. You can choose a value between 0 and 10 days.

• ...or a waiting period of [nn] days before password reuse—Choose the number of days the user must 
wait before reusing a password. You can choose a value between 0 and 30 days.

Note Note that “Require [nn] different passwords or a waiting period of [nn] days before 
password reuse” is an OR statement, meaning that either one of the two conditions you set 
can be satisfied for a password to be reused.

Step 8 Click OK. 

Step 9 On the Security Policy Change Results dialog box, confirm that the changes succeeded, then click OK.

Step 10 Return to your originating procedure (NTP).

DLP-A158 Change User Password and Security Level - Single Node

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 Click the user whose settings you want to modify, then click Change.

Step 3 In the Change User dialog box, you can:

• Change a user’s password

• Modify the user’s security level

• Lock out the user

See the“NTP-A30 Create Users and Assign Security” procedure on page 4-4 for field descriptions.

Step 4 Click OK.

Note User settings that you changed during this task will not appear until that user logs off and logs 
back in again.

Purpose Use this task to change settings for an existing user at one node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 5 Return to your originating procedure (NTP).

DLP-A160 Change User Password and Security Level - Multiple Nodes

Note You must add the same user name and password to each node the user will access.

Step 1 From the View menu, choose Go to Network View. Verify that all the nodes where you want to add 
users are accessible.

Step 2 Click the Provisioning > Security > Users tabs. Highlight the user’s name whose settings you want to 
change.

Step 3 Click Change. The Change User dialog box appears.

Step 4 In the Change User dialog box, you can:

• Change a user’s password

• Modify the user’s security level

• Lock out the user

See the “DLP-A75 Create a New User - Multiple Nodes” task on page 4-5 for field descriptions.

Step 5 Under “Select applicable nodes,” deselect any nodes where you do not want to change the user’s settings 
(all network nodes are selected by default).

Step 6 Click OK. A Change Results confirmation dialog box appears. 

Step 7 Click OK to acknowledge the changes. Confirm that the changes appear; if not, repeat the task.

Step 8 Return to your originating procedure (NTP).

Purpose Use this task to modify an existing user’s settings for multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed; use this procedure to add users to multiple nodes at one time

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-A315 Log Out a User - Single Node

Step 1 In node view, click the Provisioning > Security > Active Logins tabs.

Step 2 Choose the user you want to log out and click Logout.

Step 3 On the Logout User dialog box, check Lockout before Logout if you want to lock the user out prior to 
logout. This prevents the user from logging in after logout. This prevents the user from logging in after 
logout based on parameters set under User Lockouts in the Policy tab. Either a manual unlock by a 
Superuser is required, or the user is locked out for the amount of time specified in the Lockout Duration 
field. See the “DLP-A271 Change Security Policy - Single Node” task on page 10-21 for more 
information.

Step 4 Click OK.

Step 5 Click Yes to confirm the logout.

Step 6 Return to your originating procedure (NTP).

DLP-A316 Log Out a User - Multiple Nodes

Step 1 From the view menu, chose Go to Network View. 

Step 2 Click the Provisioning > Security > Active Logins tabs.

Step 3 Choose the user you want to log out.

Step 4 Click Logout.

Step 5 On the Logout User dialog box, check the nodes where you want to log out the user.

Step 6 Check Lockout before Logout if you want to lock the user out prior to logout. This prevents the user 
from logging in after logout based on parameters set under User Lockouts in the Policy tab. Either a 
manual unlock by a Superuser is required, or the user is locked out for the amount of time specified in 
the Lockout Duration field. See the “DLP-A271 Change Security Policy - Single Node” task on 
page 10-21 for more information.

Purpose Use this task to log out a user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose Use this task to log out a user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
10-25
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 10      Change Node Settings
NTP-A205 Modify Users and Change Security
Step 7 Click OK.

Step 8 Click Yes to confirm the logout.

Step 9 Return to your originating procedure (NTP).

DLP-A159 Delete User - Single Node

Note Users who are logged in when you delete them will not be logged out. The delete user action will take 
effect after the user logs out. To log out a user while they are logged in, complete the “DLP-A315 Log 
Out a User - Single Node” task on page 10-25.

Note CTC will allow you to delete other Superusers as long as one Superuser remains. For example, you can 
delete the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 In node view, select the Provisioning > Security > Users tabs.

Step 2 Choose the user you want to delete.

Step 3 Click Delete.

Step 4 Click OK. Confirm that the changes appear; if not, repeat the task.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to delete an existing user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-A161 Delete User - Multiple Nodes

Note Users who are logged in when you delete them will not be logged out. The delete user action will take 
effect after the user logs out. To log out a user while they are logged in, complete the “DLP-A316 Log 
Out a User - Multiple Nodes” task on page 10-25.

Note CTC will allow you to delete other Superusers as long as one Superuser remains. For example, you can 
delete the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > Security tabs. Highlight the name of the user you want to delete.

Step 3 Click Delete. The Delete User dialog box appears.

Step 4 Under Select Applicable Nodes, deselect any nodes where you do not want to delete this user.

Step 5 Click OK. A User Deletion Results confirmation dialog box appears. 

Step 6 Click OK to acknowledge the changes. Confirm that the changes appear; if not, repeat the task.

Step 7 Return to your originating procedure (NTP).

NTP-A87 Change SNMP Settings

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A273 Modify SNMP Trap Destinations, page 10-28

Purpose Use this task to delete an existing user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose Use this procedure to modify SNMP settings for the ONS 15454.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• DLP-A163 Delete SNMP Trap Destinations, page 10-30

• DLP-A164 Delete Ethernet RMON Alarm Thresholds, page 10-30

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

 Stop. You have completed this procedure.

DLP-A273 Modify SNMP Trap Destinations

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 Select a trap from Trap Destinations dialog box.

For a description of SNMP traps, see the Cisco ONS 15454 Reference Manual.

Step 3 Type the SNMP community name in the Community Name field.

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the network 
management system.

Note The default UDP port for SNMP is 162. 

Step 4 Set the Trap Version field for either SNMPv1 or SNMPv2. 

Refer to your NMS documentation to determine whether to use SNMP v1 or v2.

Step 5 Set your maximum traps per second in the Max Traps per Second field.

Note The Max Traps per Second is the maximum number of traps per second that will be sent to the 
SNMP manager. If the field is set to 0, there is no maximum and all traps are sent. 

Step 6 If you want to allow the ONS 15454 SNMP agent to accept SNMP SET requests on certain MIBs, check 
the Allow SNMP Sets check box. If the box is not checked, SET requests are rejected.

Step 7 Click Apply.

Purpose Use this task to modify the SNMP trap destinations on an ONS 15454 
including community name, default UDP port, SNMP trap version, and 
maximum traps per second.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 SNMP settings are now configured. To view SNMP information for each node, highlight the node IP 
address in the Trap Destinations area of the Trap Destinations screen (Figure 10-2). Confirm that the 
changes appear.

Note If the changes do not appear, repeat the task. Refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Figure 10-2 Viewing Trap Destinations

Step 9 Return to your originating procedure (NTP).
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DLP-A163 Delete SNMP Trap Destinations 
 

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 Under Trap Destinations, click the trap you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. Confirm that the changes appear; if not, repeat the task.

Step 5 Return to your originating procedure (NTP).

DLP-A164 Delete Ethernet RMON Alarm Thresholds

Note The ONS 15454 ML-Series card uses the Cisco IOS CLI for managing RMON.

Step 1 In node view, click the Provisioning > Ether Bridge > Thresholds tabs.

Step 2 Click the RMON alarm threshold you want to delete.

Step 3 Click Delete. The Delete Threshold dialog box opens. 

Step 4 Click Yes to delete that threshold.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to delete SNMP trap destinations on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure deletes remote monitoring (RMON) threshold crossing 
alarms for Ethernet ports.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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C H A P T E R 11

Change Card Settings 

This chapter explains how to change transmission settings on cards in a Cisco ONS 15454. 

Before You Begin
Before performing any of the following procedures, complete the “NTP-A195 Document Existing 
Provisioning” procedure on page 7-2. Also, investigate all alarms and clear any trouble conditions. Refer 
to the Cisco ONS 15454 Troubleshooting Guide as necessary.

Caution Changing card settings can be service affecting. You should make all changes during a scheduled 
maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A88 Modify Line Settings and PM Parameter Thresholds for Electrical Cards, page 11-2—As 
needed, complete this procedure to change transmission settings, including line and threshold 
settings, for all electrical cards (EC-1, DS-1, DS-3, and DS3MX-6). 

2. NTP-A89 Modify Line Settings and PM Parameter Thresholds for Optical Cards, page 11-19—As 
needed, complete this procedure to change transmission settings, including line and threshold 
settings, for all optical (OC-N) cards. 

3. NTP-A206 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G Cards, page 
11-25—As needed, complete this procedure to change transmission settings, including line and 
threshold settings, for TXP_MR_10G (transponder) cards.

4. NTP-A207 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G Cards, page 
11-36—As needed, complete this procedure to change transmission settings, including line and 
threshold settings, for MXP_2.5G_10G (muxponder) cards.

5. NTP-A90 Modify Alarm Interface Controller Settings, page 11-46—As needed, complete this 
procedure to change external alarms and controls (environmental alarms) and/or orderwire settings.

6. NTP-A118 Modify Alarm Interface Controller-International Settings, page 11-49—As needed, 
complete this procedure to change external alarms and controls and/or orderwire settings.

7. NTP-A91 Upgrade DS-1 and DS-3 Protect Cards from 1:1 Protection to 1:N Protection, page 
11-53—As needed, complete this procedure to change the protection type on DS-1 or DS-3 cards.
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NTP-A88 Modify Line Settings and PM Parameter Thresholds for 
Electrical Cards

Step 1 Log into the ONS 15454 node where you want to change the card settings. See the “DLP-A60 Log into 
CTC” task on page 3-23. 

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8 to preserve the existing 
database.

Step 3 Perform any of the following tasks as needed:

• DLP-A165 Change Line and Threshold Settings for the DS1-14 or DS1N-14 Cards, page 11-2

• DLP-A166 Change Line and Threshold Settings for the DS3-12 or DS3N-12 Cards, page 11-6

• DLP-A167 Change Line and Threshold Settings for the DS3E-12 or DS3N-12E Cards, page 11-9

• DLP-A168 Change Line and Threshold Settings for the DS3XM-6 Card, page 11-12

• DLP-A169 Change Line and Threshold Settings for the EC1-12 Card, page 11-16

Step 4 When you are finished changing the card settings, complete the “NTP-A108 Back Up the Database” 
procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A165 Change Line and Threshold Settings for the DS1-14 or DS1N-14 Cards 

Step 1 In the node view, double-click the DS1-14 or DS1N-14 card where you want to change the line or 
threshold settings. 

Purpose This procedure changes the line and threshold settings for electrical cards; 
the default values are listed in the “Card Default Settings” section on 
page C-4.

Tools/Equipment None

Prerequisite Procedures “NTP-A17 Install the Electrical Cards” procedure on page 2-15 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the line and threshold settings for the DS1-14 or 
DS1N-14 (DS-1) cards. Table C-1 on page C-5 lists the default DS-1 card 
settings.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning tab (Figure 11-1). 

Figure 11-1 Provisioning Line Parameters on the DS1-14 Card
 

Step 3 Depending on the setting you need to modify, click the Line, Line Thrshld, Elect Path Thrshld, or 
Sonet Thrshld tab. 

Note See Chapter 7, “Manage Alarms” for information about the Alarm Behavior tab.

Step 4 Modify any of the settings found under these subtabs. For definitions of the Line settings, see Table 11-1. 
For definitions of the Line Threshold settings, see Table 11-2. For definitions of the Electrical Path 
settings, see Table 11-3. 

For the factory default settings for the DS1-14 and DS1N-14 cards, see Table C-1 on page C-5.

Step 5 Click Apply. 

Step 6 Repeat Steps 3 to 5 for each subtab that has parameters you want to provision.

Table 11-1 describes the values on the Provisioning > Line tabs for the DS-1 cards. 

Table 11-1 Line Options for DS1-14 and DS1N-14 Cards 

Parameter Description Options

Port # Port number 1 - 14 (read-only)

Port Port name User-defined, up to 32 alphanumeric/special 
characters. Blank by default. 

See the “DLP-A314 Assign a Name to a Port” 
procedure on page 6-17.
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Table 11-2 describes the values on the Provisioning > Line Thresholds tabs for the DS-1 cards. 

Table 11-3 describes the values on the Provisioning > Elect Path Thresholds tabs for the DS-1 cards. 

Line Type Defines the line framing type • D4 

• ESF - Extended Super Frame

• Unframed

Line Coding Defines the DS-1 
transmission coding type

• AMI - Alternate Mark Inversion (default)

• B8ZS - Bipolar 8 Zero Substitution

Line Length Defines the distance (in feet) 
from the backplane 
connection to the next 
termination point

• 0 - 131

• 132 - 262

• 263 - 393

• 394 - 524

• 525 - 655

State Places port in or out of 
service

See the “DLP-A214 Change the Service State for a 
Port” task on page 5-6. 

AINS Soak Automatic in-service soak • Duration of valid input signal in hh.mm after 
which the card becomes in service (IS) 
automatically. 

• 0 to 48 hours, 15 minutes increments. 

Table 11-1 Line Options for DS1-14 and DS1N-14 Cards  (continued)

Parameter Description Options

Table 11-2 Line Thresholds Options for DS1-14 and DS1N-14 Cards

Parameter Description Options

Port Port number 1 - 14 (read-only)

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

LOSS Number of one-second intervals 
containing one or more loss of signal 
(LOS) defects

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.
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Table 11-4 describes the values on the Provisioning > SONET Thresholds tabs for the DS-1 cards. 

Table 11-3 Electrical Path Threshold Options for DS1-14 and DS1N-14 Cards

Parameter Description Options

Port Port number 1 - 14 (read-only)

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

SAS Severely errored frame/alarm indication 
signal

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

AISS Alarm indication signal seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

Table 11-4 SONET Threshold Options for DS1-14 and DS1N-14 Cards

Parameter Description Options

Port # DS-1 ports partitioned for STS Read-only

Line 1, STS 1, Line 2, STS 1 

Line 3, STS 1, Line 4 STS 1

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near End, STS 
termination).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near End, STS 
termination).

FC Failure count Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near End, STS 
termination).
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Note The threshold value displays after the circuit is created. 

Step 7 Return to your originating procedure (NTP).

DLP-A166 Change Line and Threshold Settings for the DS3-12 or DS3N-12 Cards

Step 1 Double-click the DS3-12 or DS3N-12 card where you want to change the line or threshold settings.

Step 2 Click the Provisioning tab. 

Step 3 Depending on the setting you need to modify, click the Line, Line Thrshld, Elec Path Thrshld, or 
Sonet Thrshld subtab. 

Note See Chapter 7, “Manage Alarms” for information about the Alarm Behavior tab.

Step 4 Modify any of the settings found under these subtabs. For definitions of the Line settings, see Table 11-5. 
For definitions of the Line Threshold settings, see Table 11-6. For definitions of the SONET Threshold 
settings, see Table 11-7. 

For the factory default settings for the DS3-12 and DS3N-12 Cards, see Table C-2 on page C-7. 

Step 5 Click Apply.

Step 6 Repeat Steps 4 and 5 for each subtab that has parameters you want to provision.

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near End, STS 
termination).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near End, STS 
termination).

Purpose This task changes the line and threshold settings for the DS3-12 or 
DS3N-12 (DS-3) cards. Table C-2 on page C-7 lists the default values for 
the DS-3 cards.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-4 SONET Threshold Options for DS1-14 and DS1N-14 Cards (continued)

Parameter Description Options
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Table 11-5 describes the values on the Provisioning > Line tabs for the DS-3 cards. 

Table 11-6 describes the values on the Provisioning > Line Thresholds tabs for the DS-3 cards. 

Table 11-7 describes the values on the Provisioning > SONET Thresholds tabs for the DS-3 cards. 

Table 11-5 Line Options for DS3-12 or DS3N-12 Cards

Parameter Description Options

Port # Port number 1 - 12

Port Port name User-defined, up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.

Line Length Defines the distance (in feet) from 
backplane connection to the next 
termination point

• 0 - 225 (default)

• 226 - 450

State Places port in or out of service See the “DLP-A214 Change the Service 
State for a Port” task on page 5-6.

AINS Soak Automatic in-service soak Duration of valid input signal in hh.mm 
after which the card becomes in service 
(IS) automatically. 0 to 48 hours, 15 
minutes increments. 

Table 11-6 Line Threshold Options for DS3-12 or DS3N-12 Cards 

Parameter Description Options

Port # Port number 1 - 12

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.

LOSS Loss of signal; number of one-second 
intervals containing one or more LOS 
defects

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button.
11-7
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 11      Change Card Settings
NTP-A88 Modify Line Settings and PM Parameter Thresholds for Electrical Cards
Note The threshold value displays after the circuit is created. 

Step 7 Return to your originating procedure (NTP).

Table 11-7 SONET Threshold Options for DS3-12 or DS3N-12 Cards

Parameter Description Options

Port # DS-3 ports partitioned for STS Read-only

Line 1, STS 1, Line 2, STS 1 

Line 3, STS 1, Line 4 STS 1

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

FC Failure count Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).
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DLP-A167 Change Line and Threshold Settings for the DS3E-12 or DS3N-12E 
Cards

Note If the DS3E is installed in an ONS 15454 slot that is provisioned for a DS-3 card, the DS3E enhanced 
performance monitoring parameters are unavailable. If this occurs, remove the DS3E from the 
ONS 15454, delete the DS-3 card in CTC using the “DLP-A191 Delete a Card” task on page 2-22, and 
provision the slot for the DS3E using the “NTP-A115 Preprovision a Slot” task on page 2-23.

Step 1 Double-click the DS3E-12 or DS3N-12E card where you want to change the line or threshold settings.

Step 2 Click the Provisioning tab.

Step 3 Depending on the setting you need to modify, click the Line, Line Thrshld, Elect Path Thrshld, or 
Sonet Thrshld subtab.

Note See Chapter 7, “Manage Alarms” for information about the Alarm Behavior tab.

Step 4 Modify any of the settings found under these subtabs. For definitions of the Line settings, see Table 11-8. 
For definitions of the Line Threshold settings, see Table 11-9. For definitions of the Electrical Path 
Thresholds, see Table 11-10. For definitions of the SONET Threshold settings, see Table 11-11. 

For the factory default settings for the DS3-12E and DS3N-12E cards, see Table C-3 on page C-8. 

Step 5 Click Apply.

Step 6 Repeat Steps 4 and 5 for each subtab that has parameters you want to provision.

Table 11-8 describes the values on the Provisioning > Line tabs for the DS3E cards. 

Purpose This task changes the line and threshold settings for the DS3E-12 or 
DS3N-12E (DS3E) cards. Table C-3 on page C-8 lists the default values 
for the DS3E cards.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-8 Line Options for the DS3-12E and DS3N-12E Cards

Parameter Description Options

Port # Port number 1 - 12 (Read-only)

Port Port name User-defined, up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.
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Table 11-9 describes the values on the Provisioning > Line Thresholds tabs for the DS3E cards. 

Table 11-10 describes the values on the Provisioning > Elect Path Thresholds tabs for the DS3E cards. 

Line Type Defines the line framing type • M13

• C Bit

• Auto Provisioned

Detected 
Line Type 

Displays the detected line type Read-only

Line 
Coding

Defines the DS3E transmission coding 
type

B3ZS

Line 
Length

Defines the distance (in feet) from 
backplane connection to the next 
termination point

• 0 - 225 (default)

• 226 - 450

State Places port in or out of service See the “DLP-A214 Change the Service 
State for a Port” task on page 5-6.

AINS Soak Automatic in-service soak • Duration of valid input signal in 
hh.mm after which the card becomes 
in service (IS) automatically. 

• 0 to 48 hours, 15-minute increments. 

Table 11-8 Line Options for the DS3-12E and DS3N-12E Cards (continued)

Parameter Description Options

Table 11-9 Line Threshold Options for the DS3-12E and DS3N-12E Cards 

Subtab Parameter Description Options

Port # Port 
number

1 - 12 (Read-only) Port #

Line 
Thrshold

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

LOSS Loss of signal; number of 
one-second intervals containing 
one or more LOS defects

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 
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Table 11-11 describes the values on the Provisioning > SONET Thresholds tabs for the DS3E cards. 

Table 11-10 Electrical Path Options for the DS3-12E and DS3N-12E Cards 

Subtab Parameter Description Options

Port # Port 
number

1 - 12 (Read-only) Port #

Elect Path 
Thrshld

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

SAS Severely errored frame/alarm 
indication signal

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

AIS Alarm indication signal Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3 Pbit: 
Near End only; DS3 CPbit: Near and 
Far End).

Table 11-11 SONET Threshold Options for DS3-12E and DS3N-12E Cards

Parameter Description Options

Port # DS-3 ports partitioned for STS Read-only

Line 1, STS 1, Line 2, STS 1 

Line 3, STS 1, Line 4 STS 1

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).
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Note The threshold value displays after the circuit is created. 

Step 7 Return to your originating procedure (NTP).

DLP-A168 Change Line and Threshold Settings for the DS3XM-6 Card

Note The DS3XM-6 (transmux) card can accept up to six channelized DS-3 signals and convert each signal 
to 28 VT1.5 signals. Conversely, the card can take 28 T-1s and multiplex them into a channeled C-bit or 
M13 framed DS-3. 

Step 1 Double-click the DS3XM-6 card where you want to change the line or threshold settings.

Step 2 Click the Provisioning tab. 

Step 3 Depending on the setting you need to modify, click the Line, Line Thrshld, Elect Path Thrshld, or 
Sonet Thrshld subtab. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

FC Failure count Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (Near and Far 
End, STS termination only).

Table 11-11 SONET Threshold Options for DS3-12E and DS3N-12E Cards (continued)

Parameter Description Options

Purpose This task changes the line and threshold settings for the DS3XM-6 card. 
Table C-4 on page C-10 lists the default settings for the DS3XM-6 card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note See Chapter 7, “Manage Alarms” for information about the Alarm Behavior tab.

Step 4 Modify any of the settings found under these subtabs. For definitions of the Line settings, see 
Table 11-12. For definitions of the Line Threshold settings, see Table 11-13. For definitions of the 
Electrical Path Thresholds, see Table 11-14. For definitions of the SONET Threshold settings, see 
Table 11-15. 

For the factory default settings for the DS3XM-6 card, see Table C-4 on page C-10. 

Step 5 Click Apply. 

Step 6 Repeat Steps 3 to 5 for each subtab that has parameters you want to provision.

Table 11-12 describes the values on the Provisioning > Line tabs for the DS3XM-6 cards. 

Table 11-13 lists the line threshold options for DS3XM-6 cards.

Table 11-12 Line Options for the DS3XM-6 Parameters

Parameter Description Options

Port # Port number 1 - 6 (read-only)

Port Port name User-defined, up to 32 alphanumeric/ 
special characters. Blank by default

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.

Line Type Defines the line framing type • M13 - default

• C BIT

Line Coding Defines the DS-1 transmission coding 
type that is used

B3ZS

Line Length Defines the distance (in feet) from 
backplane connection to the next 
termination point

• 0 - 225 (default)

• 226 - 450

State Places port in or out of service See the “DLP-A214 Change the Service 
State for a Port” task on page 5-6

AINS Soak Automatic in-service soak • Duration of valid input signal in 
hh.mm after which the card becomes 
in service (IS) automatically. 

• 0 to 48 hours, 15 minutes increments. 

Table 11-13 Line Threshold Options for the DS3XM-6 Card

Parameter Description Options

Port # Port number 1 - 6 (read-only)

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 
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Table 11-14 describes the values on the Provisioning > Elect Path Thresholds tabs for the DS3XM-6 
cards. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

LOSS Loss of signal Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button. 

Table 11-13 Line Threshold Options for the DS3XM-6 Card (continued)

Parameter Description Options

Table 11-14 Electrical Path Threshold Options for the DS3XM-6 Card

Parameter Description Options

Port # Port number 1 - 6 (read-only)

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).

SAS Severely errored frame/alarm indication 
signal

Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).
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Table 11-15 describes the values on the Provisioning > SONET Thresholds tabs for the DS3XM-6 cards. 

Note The threshold value displays after the circuit is created. 

Step 7 Return to your originating procedure (NTP).

AISS Alarm indication signal seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (DS3, Pbit Near 
End only; DS3 CPbit, Near and Far End; 
DS1, only if there is a VT circuit dropped 
on the port).

Table 11-14 Electrical Path Threshold Options for the DS3XM-6 Card (continued)

Parameter Description Options

Table 11-15 SONET Threshold Options for the DS3XM-6 Card

Parameter Description Options

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (STS and VT 
Term).

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (STS and VT 
Term).

FC Failure count Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (STS and VT 
Term).

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (STS and VT 
Term).

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals. Select the bullet and 
click the Refresh button (STS and VT 
Term).
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DLP-A169 Change Line and Threshold Settings for the EC1-12 Card

Step 1 Double-click the EC-1 card where you want to change the line or threshold settings.

Step 2 Click the Provisioning tab.

Step 3 Depending on the setting you need to modify, click the Line, Thresholds, or STS subtab. 

Note See Chapter 7, “Manage Alarms” for information about the Alarm Behavior tab.

Step 4 Modify any of the settings found under these subtabs. For definitions of the Line settings, see 
Table 11-16. For definitions of the threshold settings, see Table 11-17. 

For the factory default settings for the EC-1 card, see Table C-5 on page C-13. 

Step 5 Click Apply. 

Step 6 Repeat Steps 4 and 5 for each subtab that has parameters you want to provision.

Note The STS subtab is used to provision intermediate path performance monitoring (IPPM). To 
provision IPPM, circuits must be provisioned on the EC1-12 card. For circuit creation 
procedures, go to Chapter 6, “Create Circuits and VT Tunnels.” To provision IPPM, go to the 
“DLP-A121 Enable Pointer Justification Count Performance Monitoring” task on page 8-2.

Purpose This task changes the line and threshold settings for the EC1-12 (EC-1) 
card. The default EC-1 settings are listed in Table C-5 on page C-13.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-16 Line Options for the EC1-12 card

Parameter Description Options

Port # EC-1 card port # 1 - 12 (read-only)

Port Name Name assigned to the port (optional) User-defined, up to 32 alphanumeric/ 
special characters. Blank by default. 

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.

PJStsMon# Sets the STS that will be used for pointer 
justification. If set to zero, no STS is 
used. 

• 0 (default)

• 1 

Line Length 
(feet)

Defines the distance (in feet) from 
backplane to next termination point

• 0 - 225 (default)

• 226 - 450
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Table 11-17 lists the threshold options for EC-12 cards.

Rx 
Equalization

For early EC1-12 card versions, 
equalization can be turned off if the line 
length is short or the environment is 
extremely cold; Rx Equalization should 
normally be set to On

• On (checked, default)

• Off (unchecked)

State Places the port in or out of service See the “DLP-A214 Change the Service 
State for a Port” task on page 5-6.

Table 11-16 Line Options for the EC1-12 card (continued)

Parameter Description Options

Table 11-17 Threshold Options for the EC1-12 Card

SONET Layer Parameter Description Options

Port # EC-1 card port # 1 - 12 (read-only)

Line CV Coding violations Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

ES Errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

FC Failure count Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

UAS Unavailable seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

PPJC-PDET Positive Pointer Justification 
Count, STS Path Detected

Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

NPJC-PDET Negative Pointer Justification 
Count, STS Path Detected 

Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

PPJC-PGEN Positive Pointer Justification 
Count, STS Path Generated

Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

NPJC-PGEN Negative Pointer Justification 
Count, STS Path Generated 

Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

PSC Protection Switching Count Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 
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Step 7 Return to your originating procedure (NTP).

PSD Protection Switching Duration Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

Section CV Coding violations Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button 
(Near End only).

ES Errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

SEFS Severely errored framing 
seconds

Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

Path CV Coding violations Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button 
(Near and Far End).

ES Errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

FC Failure count Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

UAS Unavailable seconds Numeric. Can be set for 15-minute 
or one-day intervals. Select the 
bullet and click the Refresh button. 

Table 11-17 Threshold Options for the EC1-12 Card (continued)

SONET Layer Parameter Description Options
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NTP-A89 Modify Line Settings and PM Parameter Thresholds for 
Optical Cards

Note To change optical settings for transponder cards, see “DLP-A277 Change Optical Thresholds Settings 
for TXP_MR_10G Cards” task on page 11-31. To change optical settings for muxponder cards, see 
“DLP-A283 Change Optical Thresholds Settings for MXP_2.5G_10G Cards” task on page 11-41.

Step 1 Log into the ONS 15454 node where you want to change the card settings. See the “DLP-A60 Log into 
CTC” task on page 3-23.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A170 Change Line Transmission Settings for OC-N Cards, page 11-19

• DLP-A171 Change Threshold Settings for OC-N Cards, page 11-21

• DLP-A172 Change an Optical Port to SDH, page 11-24

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A170 Change Line Transmission Settings for OC-N Cards

Step 1 Double-click the OC-N card where you want to change the line settings.

Step 2 Click the Provisioning > Line tabs. 

Purpose This procedure changes the line and threshold settings for optical cards. 
The default OC-N card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the line transmission settings for OC-N cards. The 
default OC-N card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Modify any of the settings described in Table 11-18. 

To view the factory default settings for the OC-N Cards, see Table C-7 on page C-20 for the OC-3 card, 
Table C-8 on page C-22 for the OC-12 card, Table C-9 on page C-24 for the OC-48 card, or Table C-10 
on page C-26 for the OC-192 card. 

Note The STS subtab is used to provision intermediate path performance monitoring (IPPM). To 
provision IPPM, circuits must be provisioned on the EC1-12 card.

Step 4 Click Apply. 

Table 11-18 OC-N Card Line Settings

Parameter Description Options

Port # Port number (read-only) • 1 (OC-12, OC-48, OC-192)

• 1-4 (OC-3, OC12-4)

Port Name Provides the ability to assign the 
specified port a name

User-defined. Name can be up to 32 
alphanumeric/special characters. Blank 
by default. 

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.

SF BER Level Sets the signal fail bit error rate • 1E-3

• 1E-4 

• 1E-5

SD BER Level Sets the signal degrade bit error rate • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Provides 
Synch

If checked, the card is provisioned as a 
network element timing reference

• Yes 

• No

(Read-only)

Enable Synch 
Messages

Enables synchronization status messages 
(S1 byte), which allow the node to choose 
the best timing source

• Yes

• No

Send Do Not 
Use

When checked, sends a DUS (do not use) 
message on the S1 byte

• Yes

• No 

PJSTSMon # Sets the STS that will be used for pointer 
justification. If set to 0, no STS is 
monitored. Only one STS can be 
monitored on each OC-N port. 

• 0 - 3 (OC-3, per port)

• 0 - 12 (OC-12)

• 0 - 48 (OC-48)

• 0 - 192 (OC-192)
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Step 5 Return to your originating procedure (NTP).

DLP-A171 Change Threshold Settings for OC-N Cards

Step 1 In node view, double-click the OC-N card where you want to change the threshold settings (Figure 11-2). 

Step 2 Click the Provisioning > Thresholds tabs. 

State Places port in or out of service • In Service

• Out of Service 

• Out of Service MT

• Out of Service AINS

AINS Soak Automatic in-service soak • Duration of valid input signal in 
hh.mm after which the card becomes 
in service (IS) automatically.

• 0 to 48 hours, 15 minutes increments. 

Type Defines the port as SONET or SDH. The 
Enable Sync Msg field and the Send Do 
Not Use field must be disabled before the 
port can be set to SDH.

• Sonet 

• SDH

Purpose This task changes threshold settings for OC-N cards. The default OC-N 
card settings are provided in the “Card Default Settings” section on 
page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-18 OC-N Card Line Settings (continued)

Parameter Description Options
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Figure 11-2 Provisioning Thresholds on the OC48 IR 1310 Card

Step 3 Modify any of the settings found in Table 11-19. 

To view the factory default settings for the OC-N cards, see Table C-7 on page C-20 for the OC-3 card, 
Table C-8 on page C-22 for the OC-12 card, Table C-9 on page C-24 for the OC-48 card, or Table C-10 
on page C-26 for the OC-192 card.

Step 4 Click Apply. 

Table 11-19 OC-N Threshold Options

Parameter Description Options

Port Port number • 1 (OC-12, OC-48, OC-192)

• 1-4 (OC-3, OC12-4)

CV Coding violations Numeric. Can be set for 15-minute or 
one-day intervals for Line, Section, or 
Path (Near and Far End). Select the bullet 
and click the Refresh button. 

ES Errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line, Section, or 
Path (Near and Far End). Select the bullet 
and click the Refresh button. 

SES Severely errored seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line, Section, or 
Path (Near and Far End). Select the bullet 
and click the Refresh button. 

SEFS Severely errored framing seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line, Section, or 
Path (Near and Far End). Select the bullet 
and click the Refresh button. 
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FC Failure count Numeric. Can be set for 15-minute or 
one-day intervals for Line . Select the 
bullet and click the Refresh button. or Path 
(Near and Far End)

UAS Unavailable seconds Numeric. Can be set for 15-minute or 
one-day intervals for Line or Path (Near 
and Far End). Select the bullet and click 
the Refresh button. 

PPJC-PDET Positive Pointer Justification Count, STS 
Path detected. 

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

NPJC-PDET Negative Pointer Justification Count, STS 
Path detected. 

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PPJC-PGEN Positive Pointer Justification Count, STS 
Path generated. 

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

NPJC-PGEN Negative Pointer Justification Count, STS 
Path generated. 

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSC Protection Switching Count (Line) Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSD Protection Switch Duration (Line) Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSC-W Protection Switching Count - Working line

BLSR is not supported on the OC-3 card; 
therefore, the PSC-W, PSC-S, and PSC-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSD-W Protection Switching Duration - Working 
line

BLSR is not supported on the OC-3 card; 
therefore, the PSD-W, PSD-S, and PSD-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

Table 11-19 OC-N Threshold Options (continued)

Parameter Description Options
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Step 5 Return to your originating procedure (NTP).

DLP-A172 Change an Optical Port to SDH

Step 1 Double-click the OC-N card where you want to provision a port for SDH.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Type field, specify the port and choose SDH.

Note Before you can change the port type to SDH, ensure the following: the EnableSyncMsg and 
SendDoNotUse fields are unchecked, the card is not part of a BLSR or 1+1 protection group, the 
card is not part of an orderwire channel, and the card is not a SONET DCC/GCC termination 
point.

Step 4 Click Apply.

PSC-S Protection Switching Duration - Span 

BLSR is not supported on the OC-3 card; 
therefore, the PSC-W, PSC-S, and PSC-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSD-S Protection Switching Duration - Span

BLSR is not supported on the OC-3 card; 
therefore, the PSD-W, PSD-S, and PSD-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSC-R Protection Switching Duration - Ring

BLSR is not supported on the OC-3 card; 
therefore, the PSC-W, PSC-S, and PSC-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

PSD-R Protection Switching Duration - Ring

BLSR is not supported on the OC-3 card; 
therefore, the PSD-W, PSD-S, and PSD-R 
PMs do not increment.

Numeric. Can be set for 15-minute or 
one-day intervals for Line (Near and Far 
End). Select the bullet and click the 
Refresh button. 

Purpose This task provisions a port on an OC-N card for SDH.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-19 OC-N Threshold Options (continued)

Parameter Description Options
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Step 5 If the card is a multiport OC-N card, such as an OC12-4, you can repeat Steps 3 and 4 for any other ports 
on that card.

Step 6 Return to your originating procedure (NTP).

NTP-A206 Modify Line Settings and PM Parameter Thresholds 
for TXP_MR_10G Cards

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Purpose This procedure changes the line and threshold settings for TXP_MR_10G 
(transponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Perform any of the following tasks as needed:

• DLP-A274 Change Card Settings for TXP_MR_10G Cards, page 11-26

• DLP-A275 Change Line Settings for TXP_MR_10G Cards, page 11-28

• DLP-A276 Change Line Threshold Settings for TXP_MR_10G Cards, page 11-30

• DLP-A277 Change Optical Thresholds Settings for TXP_MR_10G Cards, page 11-31

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A274 Change Card Settings for TXP_MR_10G Cards

Step 1 Double-click the TXP_MR_10G card where you want to change the line settings.

Step 2 Click the Provisioning > Card tabs (Figure 11-1). 

Purpose This task changes the card settings for TXP_MR_10G (transponder) cards. 
The default card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 11-3 Provisioning Card Parameters on the TXP_MR_10G Card
 

Step 3 Modify any of the settings described in Table 11-20. 

Step 4 Click Apply. 

Table 11-20 TXP_MR_10G (Transponder) Card Settings

Parameter Description Options

Payload Type Sets the type of payload • SONET/10 GigE WAN Phy

• SDH

• 10 GigE LAN Phy

Termination 
Mode

Sets the mode of operation • Transparent

• Line
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Step 5 Return to your originating procedure (NTP).

DLP-A275 Change Line Settings for TXP_MR_10G Cards

Step 1 Double-click the TXP_MR_10G card where you want to change the line settings.

Step 2 Click the Provisioning > Line tab. 

Step 3 Modify any of the settings described in Table 11-21. 

For the factory default settings for the TXP_MR_10G cards, see Table C-11 on page C-28. 

Step 4 Click Apply. 

Wavelength Sets the wavelength of the DWDM side 
optical transmitter

• First Tunable Wavelength

• (Further wavelengths in 100 GHz 
ITU spacing)

Regeneration 
Peer Slot

Sets the regeneration peer slot • None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Purpose This task changes the line settings for TXP_MR_10G (transponder) cards. 
The default card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-20 TXP_MR_10G (Transponder) Card Settings (continued)

Parameter Description Options
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Step 5 Return to your originating procedure (NTP).

Table 11-21 TXP_MR_10G (Transponder) Card Line Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2 

Port Name Provides the ability to assign the 
specified port a name

User-defined. Name can be up to 32 
alphanumeric/special characters. Blank 
by default.

See the “DLP-A314 Assign a Name to a 
Port” procedure on page 6-17.

SF BER Level Sets the signal fail bit error rate • 1E-3

• 1E-4 

• 1E-5

SD BER Level Sets the signal degrade bit error rate • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

State Places port in service, out of service, out 
of service-maintenance, or out of 
service-auto in service. 

• IS

• OOS

• OOS_MT

• OOS_AINS

AINS Soak Automatic in-service soak • Duration of valid input signal in 
hh.mm after which the card becomes 
in service (IS) automatically.

• 0 to 48 hours, 15 minutes increments. 

ALS Mode Sets the automatic laser shutdown 
function

• Disabled

• Auto Restart

• Manual Restart

• Manual Restart for Test
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DLP-A276 Change Line Threshold Settings for TXP_MR_10G Cards

Step 1 Double-click the TXP_MR_10G card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-22. 

For the factory default settings for the TXP_MR_10G cards, see Table C-11 on page C-28.

Step 4 Click Apply. 

Purpose This task changes the line threshold settings for TXP_MR_10G 
(transponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-22 TXP_MR_10G (Transponder) Card Line Thresholds Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

SEFS Severely errored framing seconds Numeric. Can be set for Far End, for 
15-minute or one-day intervals, for 
Section only. Select bullet and click 
Refresh button. 
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Step 5 Return to your originating procedure (NTP).

DLP-A277 Change Optical Thresholds Settings for TXP_MR_10G Cards

Step 1 Double-click the OC-N card where you want to change the optical threshold settings.

Step 2 Click the Provisioning > Optical Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-23. 

For the factory default settings for the TXP_MR_10G cards, see Table C-11 on page C-28.

Step 4 Click Apply. 

FC Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select bullet and click 
Refresh button. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select bullet and click 
Refresh button.

Purpose This task changes the optical threshold settings for 
TXP_MR_10G(Transponder) cards. The default card settings are provided 
in the “Card Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-22 TXP_MR_10G (Transponder) Card Line Thresholds Settings (continued)

Parameter Description Options

Table 11-23 TXP_MR_10G (Transponder) Card Optical Thresholds Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power

Numeric, in dBm
range -16.5 to +30.0 (client side)
range -21.0 to 30.0 (trunk side)

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power

Numeric, in dBm
range -40.0 to +1.5 (client side)
range -40.0 to -2.3 (trunk side)
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Step 5 Return to your originating procedure (NTP).

DLP-A278 Change Section Trace Settings for TXP_MR_10G Cards

Step 1 Double-click the TXP_MR_10G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Section Trace tab. 

RX Temp High 
(C)

Sets the warning threshold for high 
receiver temperature

Numeric, in degrees Celsius
125 (client side, read only)
range -3.75 to 125.0 (trunk side)

RX Temp Low 
(C)

Sets the warning threshold for low 
receiver temperature

Numeric, in degrees Celsius
-40 (client side, read only)
range -40.0 to 67.5 (trunk side)

Laser Bias 
High (%)

Sets the warning threshold for high laser 
bias current

Numeric, in percent
range 37.5 to 100.0 (client side)
range 37.5 to 100.0 (trunk side)

Laser Bias 
Low (%)

Sets the warning threshold for low laser 
bias current

Numeric, in percent
range 0 to 37.5 (client side)
range 0 to 37.5 (trunk side)

Laser Temp 
High (C)

Sets the warning threshold for high laser 
temperature

Numeric, in degrees Celsius
range -7.5 to 125.0 (client side)
range 3.75 to 125.0 (trunk side)

Laser Temp 
Low (C)

Sets the warning threshold for low laser 
temperature

Numeric, in degrees Celsius
range -40.0 to 56.25 (client side)
range -40.0 to 33.75 (trunk side)

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power

Numeric, in dBm
range -17.0 to 30.0 (client side)
range -18.8 to 30.0 (trunk side)

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power

Numeric, in dBm
range -40.0 to 1.5 (client side)
range -40.0 to 2.6 (trunk side)

Purpose This task changes the section trace settings for TXP_MR_10G 
(transponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-23 TXP_MR_10G (Transponder) Card Optical Thresholds Settings (continued)

Parameter Description Options
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Step 3 Modify any of the settings described in Table 11-24. 

For the factory default settings for the TXP_MR_10G cards, see Table C-11 on page C-28. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-A279 Change Optical Transport Network Settings for TXP_MR_10G Cards

Step 1 Double-click the TXP_MR_10G card where you want to change the OTN settings.

Step 2 Click the Provisioning > OTN tabs. 

Step 3 Modify any of the settings described in Table 11-25. 

For the factory default settings for the TXP_MR_10G cards, see Table C-11 on page C-28.

Step 4 Click Apply. 

Table 11-24 TXP_MR_10G (Transponder) Card Section Trace Settings

Parameter Description Options

Port # Port number • 1

• 2

Trace Mode Sets the trace mode • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size • 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string

String of trace string size

Expected Displays the current expected string; 
sets a new expected string

String of trace string size

Received Displays the current received string (read 
only)

String of trace string size

Purpose This task changes the line optical transport network (OTN) settings for 
TXP_MR_10G (transponder) cards. The default card settings are provided 
in the “Card Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 11-25 TXP_MR_10G (Transponder) Card OTN Settings

Parameter Description Options

OTN Lines

Port #

Port number (read-only) 2

OTN Lines

G.709 OTN

Sets the OTN lines according to ITU-T 
G.709

• enabled

• disabled

OTN Lines

FEC

Sets the OTN lines to forward error 
correction (FEC)

• enabled

• disabled

OTN Lines

SF BER

Sets the signal fail bit error rate • 1E-3

• 1E-4

• 1E-5

OTN Lines

SD BER

Sets the signal degrade bit error rate • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

OTN Lines

TxPower 
(dBm)

Sets the laser transmit power on the trunk 
side using variable optical attenuator 
(VOA) 

—24.0 to +2 dBm
in 0.1 dB steps

G.709 
Thresholds

Port

Port number (read-only) 2

G.709 
Thresholds

ES

Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

SES

Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

UAS

Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

BBE

Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

FC

Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 
11-34
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Chapter 11      Change Card Settings
NTP-A206 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G Cards
Step 5 Return to your originating procedure (NTP).

FEC 
Thresholds

Port

Port number (read-only) 2

FEC 
Thresholds

Bit Errors Corrected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Byte Errors Corrected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Zero Bit Errors Detected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

One Bit Errors Detected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Uncorrectable Words Numeric. Can be set for 15-minute or 
one-day intervals. 

Trail Trace 
Identifier

Level • Section

• Path

Trail Trace 
Identifier

Trace Mode

Sets the trace mode • Off/None

• Manual

Trail Trace 
Identifier

Transmit

Displays the current transmit string;
sets a new transmit string

String of trace string size;
trail trace identifier is 64 bytes in length.

Trail Trace 
Identifier

Expected

Displays the current expected string;
sets a new expected string

String of trace string size

Trail Trace 
Identifier

Received

Displays the current received string (read 
only)

String of trace string size

Table 11-25 TXP_MR_10G (Transponder) Card OTN Settings (continued)

Parameter Description Options
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NTP-A207 Modify Line Settings and PM Parameter Thresholds 
for MXP_2.5G_10G Cards

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A280 Change Card Settings for MXP_2.5G_10G Cards, page 11-36

• DLP-A281 Change Line Settings for MXP_2.5G_10G Cards, page 11-37

• DLP-A282 Change Line Thresholds Settings for MXP_2.5G_10G Cards, page 11-40

• DLP-A283 Change Optical Thresholds Settings for MXP_2.5G_10G Cards, page 11-41

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A280 Change Card Settings for MXP_2.5G_10G Cards

Step 1 Double-click the MXP_2.5G_10G card where you want to change the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 11-26. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15.

Purpose This procedure changes the line and threshold settings for 
MXP_2.5G_10G (muxponder) cards. The default card settings are 
provided in the “Card Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the card settings for MXP_2.5G_10G (muxponder) 
cards, including payload type, termination mode, and wavelength. The 
default card settings are provided in the “Card Default Settings” section on 
page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-A281 Change Line Settings for MXP_2.5G_10G Cards

Step 1 Double-click the MXP_2.5G_10G card where you want to change the line settings.

Step 2 Click the Provisioning > Line tab (Figure 11-1). 

Table 11-26 MXP_2.5G_10G (Muxponder) Card Settings

Parameter Description Options

Payload Type Sets the type of payload • SONET

• SDH

Termination 
Mode

Sets the mode of operation • Transparent

• Line

Wavelength Sets the wavelength of the DWDM side 
optical transmitter

• First Tunable Wavelength

• (Further wavelengths in 100 GHz 
ITU spacing)

Purpose This task changes the line settings for MXP_2.5G_10G (muxponder) 
cards. The default card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 11-4 Provisioning Line Parameters on the MXP_2.5G_10G Card
 

Step 3 Modify any of the settings described in Table 11-27. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15.

Step 4 Click Apply. 

Table 11-27 MXP_2.5G_10G (Muxponder) Card Line Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2

• 3

• 4

• 5

Port Name Provides the ability to assign the 
specified port a name

User-defined. Name can be up to 32 
alphanumeric/special characters. Blank 
by default.

See the “DLP-A314 Assign a Name to a 
Port” task on page 6-17.

SF BER Level Sets the signal fail bit error rate • 1E-3

• 1E-4

• 1E-5
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Step 5 Return to your originating procedure (NTP).

SD BER Level Sets the signal degrade bit error rate • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

State Places port in service, out of service, out 
of service-maintenace, or out of 
service-auto in service

• IS

• OOS

• OOS_MT

• OOS_AINS

AINS Soak Automatic in-service soak • Duration of valid input signal in 
hh.mm after which the card becomes 
in service (IS) automatically.

• 0 to 48 hours, 15 minutes increments

ALS Mode Sets the automatic laser shutdown 
function

• Disabled

• Auto Restart

• Manual Restart

• Manual Restart for Test

Provides Sync If checked, the card is provisioned as a 
network element timing reference

• Yes 

• No

(Read-only)

Enable Sync 
Msg

Enables synchronization status messages 
(S1 byte), which allow the node to choose 
the best timing source

• Yes

• No

Send 
DoNotUse

When checked, sends a DUS (do not use) 
message on the S1 byte

• Yes

• No 

Table 11-27 MXP_2.5G_10G (Muxponder) Card Line Settings (continued)

Parameter Description Options
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DLP-A282 Change Line Thresholds Settings for MXP_2.5G_10G Cards

Step 1 Double-click the MXP_2.5G_10G card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-28. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15. 

Step 4 Click Apply. 

Purpose This task changes the line threshold settings for MXP_2.5G_10G 
(Muxponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-28 MXP_2.5G_10G (Muxponder) Card Line Threshold Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2

• 3

• 4

• 5

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section or 
Line. Select bullet and click Refresh 
button. 

SEFS Severely errored framing seconds Numeric. Can be set for Far End, for 
15-minute or one-day intervals, for 
Section only. Select bullet and click 
Refresh button. 
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Step 5 Return to your originating procedure (NTP).

DLP-A283 Change Optical Thresholds Settings for MXP_2.5G_10G Cards

Step 1 Double-click the MXP_2.5G_10G card where you want to change the optical threshold settings.

Step 2 Click the Provisioning > Optical Thresholds tabs. 

Step 3 Modify any of the settings described in Table 11-29. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15.

Step 4 Click Apply. 

FC Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select bullet and click 
Refresh button. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select bullet and click 
Refresh button.

Purpose This task changes the optical threshold settings for MXP_2.5G_10G 
(muxponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-28 MXP_2.5G_10G (Muxponder) Card Line Threshold Settings (continued)

Parameter Description Options

Table 11-29 MXP_2.5G_10G (Muxponder) Card Optical Threshold Settings

Parameter Description Options

Port # Port number (read-only) • 1

• 2

• 3

• 4

• 5

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power

Numeric, in dBm
range -16.5 to +30.0 (client side)
range -21.0 to 30.0 (trunk side)
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Step 5 Return to your originating procedure (NTP).

DLP-A284 Change Section Trace Settings for MXP_2.5G_10G Cards

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power

Numeric, in dBm
range -40.0 to +1.5 (client side)
range -40.0 to -2.3 (trunk side)

RX Temp High 
(C)

Sets the warning threshold for high 
receiver temperature

Numeric, in degrees Celsius
125 (client side, read only)
range -3.75 to 125.0 (trunk side)

RX Temp Low 
(C)

Sets the warning threshold for low 
receiver temperature

Numeric, in degrees Celsius
-40 (client side, read only)
range -40.0 to 67.5 (trunk side)

Laser Bias 
High (%)

Sets the warning threshold for high laser 
bias current

Numeric, in percent
range 37.5 to 100.0 (client side)
range 37.5 to 100.0 (trunk side)

Laser Bias 
Low (%)

Sets the warning threshold for low laser 
bias current

Numeric, in percent
range 0 to 37.5 (client side)
range 0 to 37.5 (trunk side)

Laser Temp 
High (C)

Sets the warning threshold for high laser 
temperature

Numeric, in degrees Celsius
range -7.5 to 125.0 (client side)
range 3.75 to 125.0 (trunk side)

Laser Temp 
Low (C)

Sets the warning threshold for low laser 
temperature

Numeric, in degrees Celsius
range -40.0 to 56.25 (client side)
range -40.0 to 33.75 (trunk side)

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power

Numeric, in dBm
range -17.0 to 30.0 (client side)
range -18.8 to 30.0 (trunk side)

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power

Numeric, in dBm
range -40.0 to 1.5 (client side)
range -40.0 to 2.6 (trunk side)

Purpose This task changes the section trace settings for MXP_2.5G_10G 
(muxponder) cards. The default card settings are provided in the “Card 
Default Settings” section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 11-29 MXP_2.5G_10G (Muxponder) Card Optical Threshold Settings (continued)

Parameter Description Options
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Step 1 Double-click the MXP_2.5G_10G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Section Trace tabs. 

Step 3 Modify any of the settings described in Table 11-30. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-A285 Change Optical Transport Network Settings for MXP_2.5G_10G Cards

Step 1 Double-click the MXP_2.5G_10G card where you want to change the OTN settings.

Table 11-30 MXP_2.5G_10G (Muxponder) Card Section Trace Settings

Parameter Description Options

Port # Port number • 1

• 2

• 3

• 4

• 5

Trace Mode Sets the trace mode • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size • 1 byte

• 16 byte

Transmit Displays the current transmit string;
sets a new transmit string

String of trace string size

Expected Displays the current expected string;
sets a new expected string

String of trace string size

Received Displays the current received string (read 
only)

String of trace string size

Purpose This task changes the line OTN settings for MXP_2.5G_10G (muxponder) 
cards. The default card settings are provided in the “Card Default Settings” 
section on page C-4.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning > OTN tabs. 

Step 3 Modify any of the settings described in Table 11-31. 

For the factory default settings for the MXP_2.5G_10G cards, see Table C-6 on page C-15. 

Step 4 Click Apply. 

Table 11-31 MXP_2.5G_10G (Muxponder) Card OTN Settings

Parameter Description Options

OTN Lines

Port #

Port number (read-only) 5

OTN Lines

G.709 OTN

Sets the OTN lines according to ITU-T 
G.709

• Enabled

• Disabled

OTN Lines

FEC

Sets the OTN lines to forward error 
correction (FEC)

• Enabled

• Disabled

OTN Lines

SF BER

Sets the signal fail bit error rate • 1E-3

• 1E-4

• 1E-5

OTN Lines

SD BER

Sets the signal degrade bit error rate • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

OTN Lines

TxPower 
(dBm)

Sets the laser transmit power on the trunk 
side using variable optical attenuator 
(VOA) 

—24.0 to +2 dBm
in 0.1 dB steps

G.709 
Thresholds

Port

Port number (read-only) 5

G.709 
Thresholds

ES

Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

SES

Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

UAS

Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 
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Step 5 Return to your originating procedure (NTP).

G.709 
Thresholds

BBE

Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

G.709 
Thresholds

FC

Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for SM (OTUk) or PM (ODUk). Select 
bullet and click Refresh button. 

FEC 
Thresholds

Port

Port number (read-only) 5

FEC 
Thresholds

Bit Errors Corrected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Byte Errors Corrected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Zero Bit Errors Detected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

One Bit Errors Detected Numeric. Can be set for 15-minute or 
one-day intervals. 

FEC 
Thresholds

Uncorrectable Words Numeric. Can be set for 15-minute or 
one-day intervals. 

Trail Trace 
Identifier

Level

Level • Section

• Path

Trail Trace 
Identifier

Trace Mode

Sets the trace mode • Off/None

• Manual

Trail Trace 
Identifier

Transmit

Displays the current transmit string;
sets a new transmit string

String of trace string size;
trail trace identifier is 64 bytes in length.

Trail Trace 
Identifier

Expected

Displays the current expected string;
sets a new expected string

String of trace string size

Trail Trace 
Identifier

Received

Displays the current received string (read 
only)

String of trace string size

Table 11-31 MXP_2.5G_10G (Muxponder) Card OTN Settings (continued)

Parameter Description Options
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NTP-A90 Modify Alarm Interface Controller Settings

Note If you are provisioning the AIC card for the first time, see the “NTP-A32 Provision External Alarms and 
Controls on the Alarm Interface Controller” task on page 7-33.

Step 1 Log into the ONS 15454 node where you want to change the AIC card settings. See the “DLP-A60 Log 
into CTC” task on page 3-23.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A173 Change External Alarms Using the AIC Card, page 11-46

• DLP-A174 Change External Controls Using the AIC Card, page 11-48

• DLP-A175 Change Orderwire Settings Using the AIC Card, page 11-48

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A173 Change External Alarms Using the AIC Card

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN backplane pins. See the 
“DLP-A19 Install Alarm Wires on the Backplane” task on page 1-35 for more information.

Step 2 Double-click the AIC card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs (Figure 11-5 on page 11-47).

Purpose This procedure provisions the AIC card to receive input from, or send 
output to, external devices wired to the backplane (called external alarms 
and controls or environmental alarms).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes external alarm settings on the AIC card. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-A32 Provision External Alarms and Controls on the Alarm 
Interface Controller” procedure on page 7-33.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Figure 11-5 Provisioning External Alarms on the AIC Card

Step 5 To provision additional devices, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).
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DLP-A174 Change External Controls Using the AIC Card

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-A19 
Install Alarm Wires on the Backplane” task on page 1-35 for more information. 

Step 2 Double-click the AIC card to display it in card view.

Step 3 On the External Controls subtab, modify any of the following fields for each external control wired to 
the ONS 15454 backplane. For definitions of these fields, see the “NTP-A32 Provision External Alarms 
and Controls on the Alarm Interface Controller” task on page 7-33.

• Enabled 

• Trigger Type

• Control Type

• Description

Step 4 To provision additional controls, complete Step 3 for each additional device.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-A175 Change Orderwire Settings Using the AIC Card

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Purpose This task changes external control settings on the AIC card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes orderwire settings on the AIC card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Double-click the AIC to display it in card view.

Step 2 Select the Provisioning > Local Orderwire tabs or Provisioning > Express Orderwire tabs, depending 
on the orderwire path that you want to create. 

The Local Orderwire subtab is shown in Figure 11-7 on page 11-53. The example shows the subtab for 
the AIC-I card. The screen for the AIC card is similar. Provisioning steps are the same for both types of 
orderwire.

Step 3 If needed, adjust the Tx and Rx dBm by moving the slider to the right or left for the headset type 
(four-wire or two-wire) that you will use. In general, you should not need to adjust the dBm.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

NTP-A118 Modify Alarm Interface Controller-International 
Settings

Note If you are provisioning the AIC-I card for the first time, see the “NTP-A123 Provision External Alarms 
and Controls on the Alarm Interface Controller-International” procedure on page 7-35.

Step 1 Log into the ONS 15454 node where you want to change the AIC-I card settings. See the “DLP-A60 Log 
into CTC” task on page 3-23.

Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A208 Change External Alarms Using the AIC-I Card, page 11-50

• DLP-A209 Change External Controls Using the AIC-I Card, page 11-51

• DLP-A210 Change AIC-I Card Orderwire Settings, page 11-52

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

Purpose This procedure provisions the AIC-I card to receive input from, or send 
output to, external devices wired to the backplane (called external alarms 
and controls or environmental alarms), or to change orderwire settings.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-A208 Change External Alarms Using the AIC-I Card

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN backplane pins. See the 
“DLP-A19 Install Alarm Wires on the Backplane” task on page 1-35 for more information.

Step 2 Double-click the AIC-I card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs (Figure 11-6 on page 11-51).

Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-A32 Provision External Alarms and Controls on the Alarm 
Interface Controller” task on page 7-33.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Purpose This task changes external alarm settings on the AIC-I card. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 11-6 Provisioning External Alarms on the AIC-I Card

Step 5 To provision additional devices, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

Note The procedure is the same if you are using the Alarm Expansion panel (AEP). In this case, the number 
of contacts that are shown on the screen is changed accordingly. 

DLP-A209 Change External Controls Using the AIC-I Card

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-A19 
Install Alarm Wires on the Backplane” task on page 1-35 for more information. 

Step 2 Double-click the AIC-I card to display it in card view.

Purpose This task changes external control settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 On the External Controls subtab, modify any of the following fields for each external control wired to 
the ONS 15454 backplane. For definitions of these fields, see the “NTP-A32 Provision External Alarms 
and Controls on the Alarm Interface Controller” procedure on page 7-33.

• Enabled

• Trigger Type

• Control Type

• Description

Step 4 To provision additional controls, complete Step 3 for each additional device.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Note The procedure is the same if you are using the Alarm Expansion panel (AEP). In this case, the 
number of contacts that are shown on the screen is changed accordingly. 

DLP-A210 Change AIC-I Card Orderwire Settings

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Step 1 Double-click the AIC-I card to display it in card view.

Step 2 Click the Provisioning > Local Orderwire tabs or the Provisioning > Express Orderwire tabs, 
depending on the orderwire path that you want to create.

Figure 11-7 shows the Local Orderwire subtab. Provisioning steps are the same for both types of 
orderwire.

Purpose This task changes orderwire settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 11-7 Provisioning Local Orderwire

Step 3 If needed, adjust the Tx and Rx dBm by moving the slider to the right or left for the headset type 
(four-wire or two-wire) that you will use. In general, you should not need to adjust the dBm.

Step 4 If you want to turn on the audible alert (buzzer) for the orderwire, select (check) the Buzzer On check 
box.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

NTP-A91 Upgrade DS-1 and DS-3 Protect Cards from 1:1 
Protection to 1:N Protection

Step 1 Log into the ONS 15454 node where you want to change the settings. See the “DLP-A60 Log into CTC” 
task on page 3-23. 

Purpose This task converts DS-1 and DS-3 protect cards from 1:1 to 1:N protection.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Step 3 Perform any of the following tasks as needed:

• DLP-A176 Convert DS1-14 Cards From 1:1 to 1:N Protection, page 11-54

• DLP-A177 Convert DS3-12 Cards From 1:1 to 1:N Protection, page 11-55

• DLP-A178 Convert DS3-12E Cards From 1:1 to 1:N Protection, page 11-57

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8.

Stop. You have completed this procedure. 

DLP-A176 Convert DS1-14 Cards From 1:1 to 1:N Protection

Note This procedure assumes DS1-14 cards are installed in Slots 1 through 6 and/or Slots 12 through 17. The 
DS1-14 cards in Slots 3 and 15, which are the protection slots, will be replaced with DS1N-14 cards. 
The ONS 15454 must run CTC Release 2.0 or later. The procedure also requires at least one DS1N-14 
card. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 Click the protection group that contains Slot 3 or Slot 15 (where you will install the DS1N-14 card).

Step 3 Make sure the slot you are upgrading is not carrying working traffic. In the Selected Group list, the 
protect slot must say Protect/Standby (shown in Figure 11-7 on page 11-54) and not Protect/Active. If 
the protect slot status is Protect/Active, use the following steps to switch traffic to the working card:

a. Under Selected Group, click the protect card.

b. Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to 
Protect/Standby. If they do not change, do not continue. Troubleshoot the working card and slot to 
determine why the card cannot carry working traffic.

Step 4 Repeat Steps 1 – 3 for each protection group that you need to convert. 

Step 5 Verify that no standing alarms exist for any of the DS1-14 cards that you are converting. If alarms exist 
and you have difficulty clearing them, contact your next level of support.

Step 6 Click the Provisioning > Protection tabs. 

Step 7 Click the 1:1 protection group that contains the cards that you will move into the new protection group.

Step 8 Click Delete.

Purpose This task convers DS1-14 cards in a 1:1 protection scheme to 1:N 
protection.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 When the confirmation dialog displays, click Yes. 

Note Deleting the 1:1 protection group does not disrupt service. However, no protection bandwidth 
exists for the working circuits until you complete the 1:N protection procedure. Therefore, 
complete this procedure as quickly as possible.

Step 10 If needed, repeat Steps 7 – 9 for other protection groups. 

Step 11 Physically remove the DS1-14 card from Slot 3 or Slot 15. This raises an improper removal alarm.

Step 12 In node view, right-click the slot that held the removed card and select Delete from the pull-down menu. 
Wait for the card to disappear from node view.

Step 13 Physically insert a DS1N-14 card into the same slot.

Step 14 Verify that the card boots up properly.

Step 15 Click the Inventory tab and verify that the new card appears as a DS1N-14.

Step 16 Click the Provisioning > Protection tabs.

Step 17 Click Create.

Step 18 Type a name for the protection group in the Name field (optional).

Step 19 From the Type pull-down menu, choose 1:N (card).

Step 20 From the Protect Card pull-down menu, choose the DS1N-14 card. Verify that the correct DS1N-14 card 
appears in the Protect Card field.

Step 21 Under Available Cards, highlight the cards that you want in the protection group. Click the arrow (>>) 
tab to move the cards to the Working Cards list.

Step 22 If necessary, set a new reversion time in the Reversion time pull-down menu.

Note 1:N protection groups are always revertive.

Step 23 Click OK. The protection group appears in the Protection Groups list on the Protection subtab.

Step 24 Return to your originating procedure (NTP).

DLP-A177 Convert DS3-12 Cards From 1:1 to 1:N Protection

Purpose This task converts DS3-12 cards in a 1:1 protection scheme to 1:N 
protection.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note This procedure assumes that DS3-12 cards are installed in Slots 1 - 6 and/or Slots 12 - 17. The DS3-12 
cards in Slots 3 and 15, which are the protection slots, will be replaced with DS3N-12 cards. The ONS 
15454 must run CTC Release 2.0 or later. The procedure also requires at least one DS3N-12 card and a 
protection group with DS3-12 cards. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 Click the protection group containing Slot 15 (where you will install the DS3N-12 card).

Step 3 Make sure the slot you are upgrading is not carrying working traffic. In the Selected Group list, the 
protect slot must say Protect/Standby as shown in Figure 11-7 on page 11-54, and not Protect/Active. If 
the protect slot status is Protect/Active, use the following steps to switch traffic to the working card:

a. Under Selected Group, click the protect card.

b. Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to 
Protect/Standby. If they fail to change, do not continue. Troubleshoot the working card and slot to 
determine why the card cannot carry working traffic.

Step 4 Repeat Steps 2 and 3 for each protection group that you need to convert.

Step 5 Verify that no standing alarms exist for any of the DS3-12 cards you are converting. If alarms exist and 
you have difficulty clearing them, contact your next level of support.

Step 6 Click the Provisioning > Protection tabs. 

Step 7 Click the 1:1 protection group that contains the cards that you will move into the new protection group.

Step 8 Click Delete. 

Step 9 When the confirmation dialog displays, click Yes. 

Note Deleting the 1:1 protection groups will not disrupt service. However, no protection bandwidth 
exists for the working circuits until the 1:N protection procedure is completed. Therefore, 
complete this procedure as soon as possible.

Step 10 If you are deleting more than one protection group, repeat Steps 7 – 9 for each group. 

Step 11 Physically remove the DS3-12 card from Slot 3 or Slot 15. This raises an improper removal alarm.

Step 12 In node view, right-click the slot that held the removed card and choose Delete from the pull-down menu. 
Wait for the card to disappear from the node view.

Step 13 Physically insert a DS3N-12 card into the same slot.

Step 14 Verify that the card boots up properly.

Step 15 Click the Inventory tab and verify that the new card appears as a DS3N-12 card.

Step 16 Click the Provisioning > Protection tabs.

Step 17 Click Create. 

Step 18 Type a name for the protection group in the Name field (optional).

Step 19 Click Type and choose 1:N (card) from the pull-down menu.

Step 20 Verify that the DS3N-12 card appears in the Protect Card field.
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Step 21 In the Available Cards list, highlight the cards that you want in the protection group. Click the arrow 
(>>) tab to move the cards to the Working Cards list.

Step 22 Click OK.

The protection group should appear in the Protection Groups list on the Protection subtab.

Step 23 Return to your originating procedure (NTP).

DLP-A178 Convert DS3-12E Cards From 1:1 to 1:N Protection

Note This task assumes that DS3-12E cards are installed in Slots 1 - 6 and/or Slots 12 - 17. The DS3-12E cards 
in Slots 3 and 15, which are the protection slots, will be replaced with DS3N-12E cards. The procedure 
requires at least one DS3N-12E card and a protection group with DS3-12E cards. 

Step 1 In node view, click the Maintenance > Protection tab.

Step 2 Click the protection group containing Slot 15 (where you will install the DS3N-12E card).

Step 3 Make sure the slot you are upgrading is not carrying working traffic. In the Selected Group list, the 
protect slot must say Protect/Standby as shown in Figure 11-7 on page 11-54, and not Protect/Active. If 
the protect slot status is Protect/Active, use the following steps to switch traffic to the working card:

a. Under Selected Group, click the protect card.

b. Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to 
Protect/Standby. If they fail to change, do not continue. Troubleshoot the working card and slot to 
determine why the card cannot carry working traffic.

Step 4 Repeat Steps 2 and 3 for each protection group that you need to convert.

Step 5 Verify that no standing alarms exist for any of the DS3-12E cards you are converting. If alarms exist and 
you have difficulty clearing them, contact your next level of support.

Step 6 Click the Provisioning > Protection tab. 

Step 7 Click the 1:1 protection group that contains the cards that you will move into the new protection group.

Step 8 Click Delete. 

Step 9 When the confirmation dialog displays, click Yes. 

Purpose This task converts DS3-12E cards in a 1:1 protection scheme to 1:N 
protection.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note Deleting the 1:1 protection groups will not disrupt service. However, no protection bandwidth 
exists for the working circuits until the 1:N protection procedure is completed. Do not delay 
when completing this procedure.

Step 10 If you are deleting more than one protection group, repeat Steps 7 – 9 for each group. 

Step 11 Physically remove the DS3-12E card from Slot 3 or Slot 15. This raises an improper removal alarm.

Step 12 In node view, right-click the slot that held the removed card and choose Delete from the pull-down menu. 
Wait for the card to disappear from the node view.

Step 13 Physically insert a DS3N-12E card into the same slot.

Step 14 Verify that the card boots up properly.

Step 15 Click the Inventory tab and verify that the new card appears as a DS3N-12E.

Step 16 Click the Provisioning > Protection tabs.

Step 17 Click Create. 

Step 18 Type a name for the protection group in the Name field (optional).

Step 19 Click Type and choose 1:N (card) from the pull-down menu.

Step 20 Verify that the DS3N-12E card appears in the Protect Card field.

Step 21 In the Available Cards list, highlight the cards that you want in the protection group. Click the arrow 
(>>) tab to move the cards to the Working Cards list.

Step 22 Click OK.

The protection group should appear in the Protection Groups list on the Protection subtab.

Step 23 Return to your originating procedure (NTP).
11-58
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



March 2003
C H A P T E R 12

Upgrade Cards and Spans

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to upgrade cross-connect cards, DS3-12 and DS3N-12 cards, and optical 
spans for the Cisco ONS 15454. 

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A219 Prevent an Optical Protection Switch During Cross-Connect Card Upgrades, page 
12-2—Complete this procedure before upgrading an XC or XCVT card.

1. NTP-A92 Upgrade the XC Card to the XCVT Card, page 12-5—Complete as needed.

2. NTP-A220 Upgrade the XC or XCVT Card to the XC10G Card, page 12-6

3. NTP-A418 Upgrade the TCC+ Card to the TCC2 Card, page 12-8—Complete as needed.

4. NTP-A419 Upgrade the TCC Card to the TCC2 Card, page 12-10—Complete as needed.

5. NTP-A93 Upgrade DS3-12 Cards to DS3-12E, page 12-12— Complete this procedure as needed to 
upgrade DS3-12 or DS3N-12 cards to DS3-12E or DS3N-12E cards.

6. NTP-A153 Upgrade the AIC Card to AIC-I, page 12-17—Complete as needed.

7. NTP-A94 Upgrade Optical Spans Automatically, page 12-17—Complete this procedure as needed 
to upgrade optical cards within path protection configurations, BLSRs, and 1+1 protection groups.

8. NTP-A95 Upgrade Optical Spans Manually, page 12-21—Complete this procedure as needed to 
perform error recovery for the Span Upgrade Wizard or back out of a span upgrade (downgrade).
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NTP-A219 Prevent an Optical Protection Switch During 
Cross-Connect Card Upgrades

Step 1 Log into the node where you will perform the upgrade. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Ensure that the working span is active:

a. For a BLSR protection scheme:

• In node view, click the Maintenance > BLSR tabs.

• Locate the applicable span in the West Line and East Line columns. The working/active span is 
identified by Work/Act.

b. For a 1+1 protection scheme:

• In node view, click the Maintenance > Protection tabs.

• Locate the applicable 1+1 protection group and make sure the status is Working/Active and 
Protect/Standby, rather than Working/Standby and Protect/Active.

c. For a path protection configuration scheme, no verification is necessary.

Step 3 Ensure that the working span is carrying error-free traffic (i.e. no SD or SF alarms present):

a. From the View menu, choose Go to Network View. 

b. Click the Alarms tab. Make sure the Filter button is not selected.

c. If alarms are present, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 4 Lock out or Force switch the protection span according to the specific protection scheme:

a. Lock out the protection span in a BLSR protection scheme. Complete the “DLP-A299 Initiate a 
BLSR Span Lockout” task on page 12-3.

b. Lock out the protection span in a 1+1 protection scheme. Complete the “DLP-A202 Apply a Lock 
Out” task on page 15-20.

c. Apply a Force switch to the path protection configuration span that will be upgraded. Complete the 
“DLP-A197 Initiate a Path Protection Configuration Force Switch” task on page 14-18.

Step 5 Complete the “NTP-A92 Upgrade the XC Card to the XCVT Card” procedure on page 12-5 or the 
“NTP-A220 Upgrade the XC or XCVT Card to the XC10G Card” procedure on page 12-6.

Stop. You have completed this procedure.

Purpose This procedure prevents a 1+1, path protection configuration, or BLSR 
protection switch from occurring during cross-connect card upgrades. 
You must perform this procedure before any ross-connect card upgrade.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level Maintenance or higher
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DLP-A299 Initiate a BLSR Span Lockout

Caution Traffic is not protected during a span lockout.

Step 1 Click the Provisioning > BLSR tabs.

Step 2 Choose the BLSR and click Edit. 

Tip To move an icon to a new location, for example, to see BLSR channel (port) information more clearly, 
you can drag and drop icons on the Edit BLSR network graphic. 

Step 3 To lock out a west span:

a. Right-click any BLSR node west channel (port) and choose Set West Protection Operation. 
Figure 12-1 shows an example.

Note For two-fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent 
ports. You can right-click either working port.

Figure 12-1 Protection Operation on a Three-Node BLSR

b. In the Set West Protection Operation dialog box, choose LOCKOUT SPAN from the pull-down 
menu. Click OK. 

Purpose This task allows you to perform a BLSR span lockout, which prevents 
traffic from switching to the locked out span.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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c. In the Confirm BLSR Operation dialog box, click Yes. An “L” appears on the selected channel (port) 
where you created the lock out.

Lockouts generate LKOUTPR-S and FE-LOCKOUTOFPR-SPAN conditions. 

Step 4 To lock out an east span:

a. Right-click the node’s east channel (port) and choose Set East Protection Operation.

b. In the Set East Protection Operation dialog box, choose LOCKOUT SPAN from the pull-down 
menu. Click OK.

c. In the Confirm BLSR Operation dialog box, click Yes. An “L” indicating the lockout appears on the 
selected channel (port) where you invoked the protection switch. 

Lockouts generate LKOUTPR-S and FE-LOCKOUTOFPR-SPAN conditions. 

Step 5 From the File menu, choose Close.

Step 6 Return to your originating procedure (NTP).

DLP-A300 Clear a BLSR Span Lockout

Step 1 Display the network view. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Tip To move an icon to a new location, for example, to see BLSR channel (port) information more clearly, 
you can drag and drop icons on the Edit BLSR network graphic.

Step 4 Right-click the BLSR node channel (port) where the lockout will be cleared and choose 
Set West Protection Operation or Set East Protection Operation. 

Step 5 In the dialog box, choose CLEAR from the pull-down menu. Click OK.

Step 6 In the Confirm BLSR Operation dialog box, click Yes. The “L” that indicated the lockout disppears from 
the network view map.

Step 7 From the File menu, choose Close.

Step 8 Return to your originating procedure (NTP).

Purpose This task clears a BLSR span lockout.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A92 Upgrade the XC Card to the XCVT Card

Note The UNEQ-P alarm is raised during a cross-connect card upgrade if you have E100T-12/E1000-2 cards 
installed in the node. The alarm will appear and clear within a few seconds.

Step 1 Log into the node where you will perform the upgrade. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A219 Prevent an Optical Protection Switch During Cross-Connect Card Upgrades” 
procedure on page 12-2.

Step 3 Determine the standby XC card. The ACT/STBY LED of the standby XC card is amber, while the 
ACT/STBY LED of the active XC card is green. 

Step 4 Physically replace the standby XC card on the ONS 15454 with an XCVT card:

a. Open the XC card ejectors.

b. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which will clear when the upgrade 
is complete.

c. Open the ejectors on the XCVT card.

d. Slide the XCVT card into the slot along the guide rails.

e. Close the ejectors.

On the XCVT card the fail LED above the ACT/STBY LED becomes red, blinks for several seconds, 
and turns off. The ACT/STBY LED turns amber and remains illuminated.

Step 5 In node view, click the Maintenance > Cross-Connect tabs.

Step 6 From the Cross Connect Cards menu, choose Switch.

Step 7 Click Yes on the Confirm Switch dialog box. Traffic switches to the XCVT card inserted in Step 4. The 
ACT/STBY LED on this card changes from amber to green.

Note The Interconnection Equipment Failure alarm appears, but it will clear when the upgrade 
procedure is complete and the node has matching cross-connect cards installed. 

Step 8 Physically remove the now standby XC card from the ONS 15454 and insert the second XCVT card into 
the empty XC slot:

a. Open the XC card ejectors.

b. Slide the XC card out of the slot.

c. Open the ejectors on the XCVT.

d. Slide the XCVT card into the slot along the guide rails.

Purpose This procedure upgrades the XC card to the XCVT card.

Tools/Equipment Two XCVT cards

Prerequisite Procedures None

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level Maintenance or higher
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e. Close the ejectors.

The upgrade is complete when the second XCVT card boots up and becomes the standby XCVT.

Step 9 Clear the external switching command that you applied in Step 2:

• If you applied a BLSR span lock out, complete the “DLP-A300 Clear a BLSR Span Lockout” task 
on page 12-4. 

• If you applied a 1+1 lock out, complete the “DLP-A203 Clear a Lock On or Lock Out” task on 
page 15-21. 

• If you applied a Path Protection Configuration Force switch, complete the “DLP-A198 Clear a Path 
Protection Configuration Force Switch” task on page 14-19.

Stop. You have completed this procedure. 

NTP-A220 Upgrade the XC or XCVT Card to the XC10G Card

Note This procedure only applies to the XC or XCVT cards that are installed in the 15454-SA-ANSI (Software 
Release 3.1 and later). You cannot perform this upgrade from shelves released prior to Software R3.1. 
The XC10G requires the 15454-SA-ANSI.

Note The UNEQ-P alarm is raised during a cross-connect card upgrade if you have E100T-12/E1000-2 cards 
installed in the node. The alarm will appear and clear within a few seconds.

Note Downgrade procedures from XC10G cards to XCVT or XC cards are not supported. Contact Cisco 
Technical Assistance Center (TAC) for more information.

Step 1 Log into the node where you will perform the upgrade. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the “NTP-A219 Prevent an Optical Protection Switch During Cross-Connect Card Upgrades” 
procedure on page 12-2.

Step 3 Determine the standby XC or XCVT card. The ACT/STBY LED of the standby XC or XCVT card is 
amber, while the ACT/STBY LED of the active XC or XCVT card is green. 

Step 4 Physically replace the standby XC or XCVT card on the ONS 15454 with an XC10G card:

a. Open the XC or XCVT card ejectors.

Purpose This procedure upgrades an XC or XCVT card to an XC10G card.

Tools/Equipment Two XC10G cards

Prerequisite Procedures None

Required/As Needed Software Release 3.1 and later and the 15454-SA-ANSI shelf are 
required for XC10G card operation.

Onsite/Remote Onsite

Security Level Maintenance or higher
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b. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which will clear when the upgrade 
is complete.

c. Open the ejectors on the XC10G card.

d. Slide the XC10G card into the slot along the guide rails.

e. Close the ejectors.

Note On the XC10G card the fail LED above the ACT/STBY LED becomes red, blinks for several 
seconds, and turns off. The ACT/STBY LED turns amber and remains illuminated. In node view, 
the XC10G appears as the standby XC or XCVT.

Step 5 In node view, click the Maintenance > Cross-Connect tabs.

Step 6 From the Cross Connect Cards menu, choose Switch.

Step 7 Click Yes on the Confirm Switch dialog box. Traffic switches to the XC10G card you inserted in 
Step 4. The ACT/STBY LED on this card changes from amber to green.

Note The Interconnection Equipment Failure alarm appears, but it will clear when the upgrade 
procedure is complete and the node has matching cross-connect cards installed. 

Step 8 Physically remove the now standby XC or XCVT card from the ONS 15454 and insert the second 
XC10G card into the empty XC or XCVT card slot:

a. Open the XC or XCVT card ejectors.

b. Slide the XC or XCVT card out of the slot.

c. Open the ejectors on the XC10G card.

d. Slide the XC10G card into the slot along the guide rails.

e. Close the ejectors.

The upgrade is complete when the second XC10G card boots up and becomes the standby XC10G card. 
In node view, both the active and standby cards will change to XC10G.

Step 9 Clear the external switching command you applied during Step 2:

• If you applied a BLSR span lock out, complete the “DLP-A300 Clear a BLSR Span Lockout” task 
on page 12-4. 

• If you applied a 1+1 lock out, complete the “DLP-A203 Clear a Lock On or Lock Out” task on 
page 15-21. 

• If you applied a Path Protection Configuration Force switch, complete the “DLP-A198 Clear a Path 
Protection Configuration Force Switch” task on page 14-19. 

Stop. You have completed this procedure.
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NTP-A418 Upgrade the TCC+ Card to the TCC2 Card

Note The TCC2 card does not carry any software other than Software R4.0. You will not be able to revert to 
a software release earlier than Software R4.0 with TCC2 cards installed.

Note Downgrade procedures from TCC2 cards to TCC+ cards are not supported. Contact Cisco Technical 
Assistance Center (TAC) at 1-800-553-2447 for more information.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 2.

Step 2 Verify that the LAN wires on the backplane are installed properly. The TCC2 card does not autodetect 
miswired LAN connections. If a LAN connection is miswired, a “LAN Connection Polarity Reversed” 
condition appears. See the “DLP-A21 Install LAN Wires on the Backplane” task on page 1-38 for 
instructions.

Step 3 Verify that the node you are upgrading has ONS 15454 Software R4.0 installed. The software version is 
displayed in the upper left corner of the window.

Step 4 Complete the “NTP-A108 Back Up the Database” procedure on page 15-8 before beginning the upgrade.

Step 5 Physically replace the standby TCC+ card on the ONS 15454 with a TCC2 card. 

a. Check the LED on the faceplate. The ACT/STBY LED on the faceplate of the TCC+/TCC2 card 
indicates whether the card is in active or standby mode. A green ACT/STBY LED indicates an active 
card and an amber light indicates a standby card.

b. Open the standby TCC+ card ejectors.

c. Slide the card out of the slot. This raises the IMPROPRMVL alarm which will clear when the upgrade 
is complete.

d. Open the ejectors on the TCC2 card to be installed.

e. Slide the TCC2 card into the slot along the guide rails.

f. Close the ejectors.

g. In CTC node view, Ldg (loading) appears on the recently installed TCC2 card.

Note The MEA (card mismatch) alarm appears because CTC recognizes a mismatch between TCC 
card types. Disregard this alarm; it clears by the end of the procedure.

Purpose This procedure upgrades the TCC+ card to the TCC2 card. The TCC2 
card supports ONS 15454 Software R4.0. The TCC+ card is compatible 
with ONS 15454 Software R4.0 and earlier software versions.

Tools/Equipment Two SONET TCC2 cards

Prerequisite Procedures None

Required/As Needed Software R4.0 is required for TCC2 card operation.

Onsite/Remote Onsite

Security Level Maintenance or higher
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Note It takes approximately 10 minutes for the active TCC+ card to transfer the database to the 
newly-installed TCC2 card. During this operation, the LEDs on the TCC2 flash Fail and then the 
active/standby LED flashes. When the transfer completes, the TCC2 card reboots and goes into 
standby mode after approximately three minutes. Do not remove the card from the shelf during 
a database transfer.

Caution If your active TCC+ card resets during the upgrade before the new TCC2 card has come to a 
full standby mode, remove the new TCC2 card immediately. 

Step 6 When the newly installed TCC2 card is in standby, go to the active TCC+ and right-click the card.

Note You can no longer revert to a software version prior to Software R4.0 once you switch the 
standby TCC2 card to the active TCC2 card.

Step 7 From the pull-down menu, click Reset Card.

Wait for the TCC+ card to reboot. The ONS 15454 switches the standby TCC2 card to active mode. The 
TCC+ card verifies that it has the same database as the TCC2 card and then switches to standby.

Step 8 Verify that the remaining TCC+ card is now in standby mode (the ACT/STBY LED changes to amber). 

Step 9 Physically replace the remaining TCC+ card with the second TCC2 card.

a. Open the TCC+ card ejectors.

b. Slide the card out of the slot. This raises the MEA alarm, which will clear when the upgrade is 
complete.

c. Open the ejectors on the TCC2 card.

d. Slide the TCC2 card into the slot along the guide rails.

e. Close the ejectors.

The ONS 15454 boots up the second TCC2 card. The second TCC2 card must also copy the database, 
which can take approximately 10 minutes. Do not remove the card from the shelf during a database 
transfer. 

Step 10 If power-related alarms occur after the second TCC2 card is installed, check the voltage on the 
backplane. See the “DLP-A33 Measure Voltage” task on page 1-61 for instructions. Refer to the Cisco 
ONS 15454 Troubleshooting Guide for information on clearing alarms.

Stop. You have completed this procedure.
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NTP-A419 Upgrade the TCC Card to the TCC2 Card

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 2.

Step 2 Before you begin the upgrade, complete the “NTP-A108 Back Up the Database” procedure on 
page 15-8.

Step 3 Before you install TCC+ cards, verify that the node you are upgrading has ONS 15454 Software R2.2.x. 
The TCC card to TCC+ card upgrade process requires Release 2.2.x to support the TCC/TCC+ mismatch 
that occurs briefly during the TCC card to TCC+ card upgrade process.

Step 4 Complete the “DLP-A291 Upgrade the TCC Card to the TCC+ Card” task on page 12-10.

Step 5 Before you install TCC2 cards, verify that the node you are upgrading has ONS 15454 Software R4.0 
installed. The software version is displayed in the upper left pane.

Step 6 Complete the “NTP-A418 Upgrade the TCC+ Card to the TCC2 Card” procedure on page 12-8.

Stop. You have completed this procedure.

DLP-A291 Upgrade the TCC Card to the TCC+ Card

Step 1 Physically replace the standby TCC card on the ONS 15454 with a TCC+ card.

a. Open the TCC card ejectors.

b. Slide the card out of the slot. This raises the IMPROPRMVL alarm which will clear when the upgrade 
is complete.

Purpose This procedure upgrades the TCC card to the TCC2 card. TCC+ cards 
are necessary to complete this upgrade procedure. The TCC2 card 
supports ONS 15454 Software R4.0. The TCC+ card is compatible with 
ONS 15454 Software R4.0 and earlier software versions back to 
Software R2.2.x. 

Tools/Equipment Two SONET TCC2 cards

Two TCC+ cards

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Maintenance or higher

Purpose This task upgrades the TCC card to the TCC+ card.

Tools/Equipment Two TCC+ cards

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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c. Open the ejectors on the TCC+ card.

d. Slide the TCC+ card into the slot along the guide rails.

e. Close the ejectors.

Note The MEA (card mismatch) alarm appears because CTC recognizes a mismatch between TCC 
card types. Disregard this alarm; it clears by the end of the procedure.

Note It takes approximately 20 or 30 minutes for the active TCC to transfer the system software 
to the newly-installed TCC+. Software transfer occurs in instances where different software 
versions exist on the two cards. During this operation, the LEDs on the TCC+ flash Fail and 
then the active/standby LED flashes. When the transfer completes, the TCC+ reboots and 
goes into standby mode after approximately three minutes.

Caution If your active TCC card resets during the upgrade before the new TCC+ card has come to a 
full standby mode, remove the new TCC+ card immediately. 

Step 2 Right click the active TCC card to reveal a pull-down menu.

Step 3 Click Reset Card.

Wait for the TCC card to reboot. The ONS 15454 switches the standby TCC+ card to active mode.

Step 4 Verify that the remaining TCC card is now in standby mode (the ACT/STBY LED changes to amber). 

Step 5 Physically replace the remaining TCC card with the second TCC+ card.

a. Open the TCC card ejectors.

b. Slide the card out of the slot.

c. Open the ejectors on the TCC+ card.

d. Slide the TCC+ card into the slot along the guide rails.

e. Close the ejectors.

The ONS 15454 boots up the second TCC+ card. The second TCC+ card must also copy the system 
software, which can take up to 20 or 30 minutes. The MEA alarm clears when the ONS 15454 recognizes 
the matching TCC+ cards.

Step 6 Return to your originating procedure (NTP).
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NTP-A93 Upgrade DS3-12 Cards to DS3-12E

Note Upgrading to DS3-12E or DS3N-12E cards requires that the ONS 15454 is running CTC Release 3.1 or 
later. Upgrades must be performed between two N-type cards or two non-N-type cards. You cannot 
upgrade between an N-type card and a non-N-type card. When physically replacing a card, the new card 
must be in the same slot as the old card. The DS3-12E card upgrade supports 1:1 and 1:N protection 
schemes. The procedure is non-service affecting; that is, the upgrade will cause a switch less than 50 ms 
in duration.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-A182 Upgrade the DS3-12/DS3N-12 Card to the DS3-12E/DS3N-12E Card” task 
on page 12-13 as necessary.

Note This procedure can also be used to enable the capabilities of a DS3-12E card that was installed 
in a shelf with Software R3.1 or earlier.

Step 3 Complete the “DLP-A183 Downgrade a DS3-12E/DS3NE Card to a DS3-12/DS3N-12 Card” task on 
page 12-16 as necessary. The procedure for downgrading is the same as upgrading except you choose 
DS3-12 or DS3N-12 from the Change Card pull-down menu. 

Stop. You have completed this procedure. 

Purpose This procedure upgrades DS3-12 cards to DS3-12E cards or downgrades 
DS3-12E cards to DS3-12 cards.

Tools/Equipment Replacement cards

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-A182 Upgrade the DS3-12/DS3N-12 Card to the DS3-12E/DS3N-12E Card

Caution Protect cards must be upgraded before working cards because working cards cannot have more 
capabilities than their protect card.

Note During the upgrade some minor alarms and conditions display and then clear on their own; however, 
there should be no Service-Affecting (SA, Major, or Critical) alarms. If any service-affecting alarms 
occur, Cisco recommends backing out of the procedure. See the “DLP-A183 Downgrade a 
DS3-12E/DS3NE Card to a DS3-12/DS3N-12 Card” task on page 12-16.

Step 1 Determine if the card you are upgrading is protected or unprotected:

a. A protected card will be listed under Protection Groups in the Maintenance > Protection tabs. The 
slot, port and status (i.e., Protect/Standby, Working/Active) of each card will be listed under 
Selected Group.

b. An unprotected card will not be listed under Protection Groups/Selected Group in the 
Maintenance > Protection tabs. 

Step 2 If the card you are upgrading is unprotected, skip to Step 3 and ignore references to the protect card and 
protect slot. If the card you are upgrading is protected, use the “DLP-A287 Switch 1+1 Traffic” task on 
page 12-14 to put a Force switch on the protect card.

Note Traffic will be lost during an upgrade on an unprotected card.

Step 3 Physically remove the protect DS3-12 or the protect DS3N-12 card:

a. Open the DS3-12 or DS3N-12 card ejectors.

b. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which will clear when the upgrade 
is complete.

Step 4 Right-click the protect slot and choose Change Card from the pull-down menu.

Step 5 Choose the new card (DS3-12E or DS3N-12E) from the Change to: pull-down menu.

Step 6 Click OK.

Step 7 Insert the new DS3-12E or DS3N-12E card into the protect slot:

a. Open the ejectors on the DS3-12E or DS3N-12E card.

b. Slide the DS3-12E or DS3N-12E card into the slot along the guide rails. 

Step 8 Close the ejectors.

Purpose This task upgrades the DS3-12 card to the DS3-12E card or the 
DS3N-12 card to the DS3N-12E card.

Tools/Equipment DS3-12E or DS3N-12E card

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Wait for the IMPROPRMVL alarm to clear and the card to become standby.

Step 9 If you switched traffic in Step 2, complete the “DLP-A288 Clear a 1+1 Traffic Switch” task on 
page 12-15 to remove the Force switch from the protect card.

Step 10 Repeat this task (Steps 1 through 9) for the working card.

Note After upgrading from a DS3-12 card to a DS3-12E card, verify that the DS3-12E line type is set 
to the framing type used by your particular SONET network. At the card level, click the 
Provisioning > Line tabs and check the Line Type column.

Step 11 Return to your originating procedure (NTP).

DLP-A287 Switch 1+1 Traffic

Step 1 In the node view, click the Maintenance > Protection tabs.

Step 2 Choose the affected 1+1 protection group from the Protection Groups window. In the Selected Group 
window, the working and protect spans appear.

Step 3 Under Selected Group, click the affected OC-N port. 

Step 4 In Switch Commands, choose Manual or Force:

• Manual—Switches traffic if the new span is error free.

• Force—Forces the traffic to switch, even if the path has signal degrade (SD) or signal failure (SF) 
conditions. Force switch states have a higher priority than manual switches.

Step 5 Click Yes on the confirmation dialog box. 

• MANUAL-SWITCH-TO-WORKING or MANUAL-SWITCH-TO-PROTECT appears next to a 
manually switched span.

• FORCE-SWITCH-TO-WORKING or FORCE-SWITCH-TO-PROTECT appears next to a forced 
span.

Step 6 If the protect port was selected in Step 3, verify that the working slot is carrying traffic (Working/Active). 

Note If the slot is not active, look for conditions or alarms that may be preventing the card from 
carrying working traffic. Refer to the Cisco ONS 15454 Troubleshooting Guide.

Purpose This task switches 1+1 traffic using an external switch command. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 When the working slot is carrying nonrevertive traffic, clear the manual switch:

a. In Switch Commands, choose Clear.

b. Click Yes on the confirmation dialog box.

Step 8 With nonrevertive traffic, verify that the working slot does not switch back to Standby, which might 
indicate a problem on the working span.

Note A Force switch request on a span or port) causes CTC to raise a FORCED-REQ condition. It is 
informational only; the condition will clear when the Force switch command is cleared.

Step 9 Return to your originating procedure (NTP).

DLP-A288 Clear a 1+1 Traffic Switch

Step 1 In the node view, click the Maintenance > Protection tabs.

Step 2 Under Protection Groups, click the protection group that contains the card you want to clear.

Step 3 Under Selected Group, click the card you want to clear.

Step 4 From Inhibit Switching, click Unlock.

Step 5 Click Yes on the confirmation dialog box.

The Manual or Force switch is cleared.

Step 6 Return to your originating procedure (NTP).

Purpose This task clears a 1+1 external switching command.

Tools/Equipment None

Prerequisite Procedures “DLP-A60 Log into CTC” task on page 3-23

DLP-A287 Switch 1+1 Traffic, page 12-14 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance
12-15
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 12      Upgrade Cards and Spans
NTP-A93 Upgrade DS3-12 Cards to DS3-12E
DLP-A183 Downgrade a DS3-12E/DS3NE Card to a DS3-12/DS3N-12 Card

Note All ports must be provisioned as UNFRAMED and not have the Path Trace enabled.

Note Working cards must be downgraded before protect cards.

Step 1 Determine if the card you are downgrading is protected or unprotected:

a. A protected card will be listed under Protection Groups in the Maintenance > Protection tabs. The 
slot, port and status (i.e., Protect/Standby, Working/Active) of each card will be listed under 
Selected Group.

b. An unprotected card will not be listed under Protection Groups/Selected Group in the 
Maintenance > Protection tabs. 

Step 2 If the card you are downgrading is unprotected, skip to Step 3. If the card you are downgrading is 
protected, complete the “DLP-A287 Switch 1+1 Traffic” task on page 12-14 to Force switch the working 
card.

Step 3 Physically remove the working DS3-12E card or the working DS3N-12E card:

a. Open the DS3-12E or DS3N-12E card ejectors.

b. Slide the card out of the slot. This raises the IMPROPRMVL alarm, which will clear when the 
downgrade is complete.

Step 4 Right-click the slot to be downgraded and choose Change Card from the pull-down menu. 

Step 5 Choose DS3-12 or DS3N-12 from the Change to: pull-down menu.

Tip The procedure for downgrading is the same as upgrading except you choose DS3-12 or DS3N-12 from 
the Change Card pull-down menu. 

Step 6 Click OK.

Step 7 Insert the DS3-12 or DS3N-12 card into the working slot:

a. Open the ejectors on the DS3-12 or DS3N-12 card.

b. Slide the DS3-12 or DS3N-12 card into the slot along the guide rails. 

Step 8 Close the ejectors. Wait for the IMPROPRMVL alarm to clear and the card to become active.

Purpose This task downgrades a DS3-12E or DS3NE card. Downgrading can be 
performed to back out of an upgrade.

Tools None

Prerequisite Procedures DLP-A182 Upgrade the DS3-12/DS3N-12 Card to the 
DS3-12E/DS3N-12E Card, page 12-13

DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 If you placed a Force switch on the working card in Step 2, complete the “DLP-A288 Clear a 1+1 Traffic 
Switch” task on page 12-15 to clear the switch.

Step 10 Repeat Steps 1 through 9 to downgrade the protect card if applicable.

Step 11 Return to your originating procedure (NTP).

NTP-A153 Upgrade the AIC Card to AIC-I

Step 1 Physically remove the AIC card:

a. Open the AIC card ejectors.

b. Slide the card out of the slot. After several seconds this raises the IMPROPRMVL alarm, which will 
clear when the downgrade is complete.

Step 2 Complete the “NTP-A123 Provision External Alarms and Controls on the Alarm Interface 
Controller-International” procedure on page 7-35.

Stop. You have completed this procedure.

NTP-A94 Upgrade Optical Spans Automatically 

Purpose This procedure upgrades an AIC card to an AIC-I card; the AIC-I card 
provides additional alarm contacts.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Maintenance or higher

Purpose This task upgrades two-fiber BLSR spans, four-fiber BLSR spans, path 
protection configuration spans, and 1+1 protection group spans. The 
Span Upgrade Wizard only supports OC-N span upgrades. It does not 
support electrical upgrades.

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade (For example XC10G 
cards and OC-48 any slot cards)

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

The span upgrade procedure requires at least two technicians (one at 
each end of the span) who can communicate with each other during the 
upgrade. 

Required/As Needed As needed
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Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in the Cisco ONS 15454 Reference Manual.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Note An OC-3 to eight-port OC-3 span upgrade, or an OC-12 to four-port OC-12 span upgrade can only be 
performed from multispeed slots (Slots 1 to 4 and 14 to 17) because the OC3-8 and OC12-4 card can 
only be installed in multispeed slots. Ensure that the OC-3 and OC-12 cards are in multispeed slots 
before performing a span upgrade to the OC3-8 and OC12-4. The four OC-3 ports will be mapped to 
Ports 1 to 4 on the eight-port OC-3 card. The OC-12 port will be mapped to Port 1 on the four-port OC-12 
card.

Note BLSR protection channel access (PCA) circuits, if present, will remain in their existing STSs. Therefore, 
they will be located on the working path of the upgraded span and will have full BLSR protection. To 
route PCA circuits on protection channels in the upgraded span, delete and recreate the circuits after the 
span upgrade. For example, if you upgrade an OC-48 span to an OC-192, PCA circuits on the protection 
STSs (STSs 25 to 48) in the OC-48 BLSR will remain in their existing STSs (STSs 25 to 48) which are 
working, protected STSs in the OC-192 BLSR. Deleting and recreating the OC-48 PCA circuits moves 
the circuits to STSs 96 to 192 in the OC-192 BLSR. To delete circuits, see the “NTP-A152 Delete 
Circuits” procedure on page 9-16. To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

Step 1 Determine the type of span you need to upgrade and make sure you have the necessary cards.Valid span 
upgrades include:

• Four-port OC-3 to eight-port OC-3

• Single-port OC-12 to four-port OC-12

• Single-port OC-12 to OC-48

• Single-port OC-12 to OC-192

• OC-48 to OC-192

Caution You cannot upgrade a four-port OC-12 span. If the ring contains any OC-12-4 cards and you need to 
upgrade all the spans in the ring, you will need to downgrade the OC-12-4 card to a single-port OC-12 
card (which is not possible unless only one port on the OC12-4 card is being used).

Step 2 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 3.

Onsite/Remote Onsite

Security Level Provisioning or higher
12-18
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



Chapter 12      Upgrade Cards and Spans
NTP-A94 Upgrade Optical Spans Automatically
Note The Span Upgrade option will only be visible and available if the hardware necessary for the 
upgrade is present; for example, no upgrade is possible from an OC48 span unless XC10G cards 
are installed in the nodes at both ends of the span. 

Step 3 Ensure that no alarms or abnormal conditions (regardless of severity), including LOS, LOF, AIS-L, SF, 
SD, and FORCED-REQ-RING are present. See the “DLP-A298 Check the Network for Alarms and 
Conditions” task on page 13-3 for instructions.

Note During the upgrade/downgrade some minor alarms and conditions display and then clear 
automatically. No service-affecting alarms (SA, Major, or Critical) should occur other than 
BLSROSync, which will clear when the upgrade/downgrade of all nodes is complete. If any 
other service-affecting alarms occur, Cisco recommends backing out of the procedure. 
A four-node BLSR can take up to five minutes to clear all of the BLSROSync alarms. Allow 
extra time for a large BLSR to clear all of the BLSROSync alarms.

Step 4 In network view, right-click the span you want to upgrade.

Step 5 Choose Span Upgrade from the pull-down menu (Figure 12-2).

Figure 12-2 Span Upgrade Pull-Down Menu

Step 6 The first Span Upgrade dialog box appears (Figure 12-3). Follow the instructions on the dialog box and 
the wizard will lead you through the rest of the span upgrade.

Note The Back button is only enabled on Step 2 of the wizard; because you cannot back out of an 
upgrade via the wizard, close the wizard and initiate the manual procedure if you need to back 
out of the upgrade at any point beyond Step 2.
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Figure 12-3 Span Upgrade Wizard

Caution As indicated by the wizard, when installing cards you must wait for the cards to boot up and 
become active before proceeding to the next step.

Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Note Remember to attach the fiber after installing the OC-N cards.

Note The span upgrade process resets the line’s CV-L threshold to factory default. The CV-L threshold 
is reset because the threshold is dependent on line rate.

Step 7 Repeat Steps 4 through 6 for additional spans in the ring.

Stop. You have completed this procedure. 
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NTP-A95 Upgrade Optical Spans Manually

Note Optical card transmit and receive levels should be in their acceptable range as shown in the 
specifications section for each card in the Cisco ONS 15454 Reference Manual.

Note In this context the word “span” represents the optical path between two nodes. The words “span 
endpoint” represent the nodes on each end of a span.

Note If any of the cross-connect cards reboot during the span upgrade, you must reset each one when the span 
upgrade procedure is complete for all the nodes in the ring. 

Step 1 Determine the type of span you need to upgrade and make sure you have the necessary cards.Valid span 
upgrades include:

• Four-port OC-3 to eight-port OC-3

• Single-port OC-12 to four-port OC-12

• Single-port OC-12 to OC-48

• Single-port OC-12 to OC-192

• OC-48 to OC-192

Caution You cannot upgrade a four-port OC-12 span. If the ring contains any OC-12-4 cards and you need to 
upgrade all the spans in the ring, you will need to downgrade the OC-12-4 card to a single-port OC-12 
card (which is not possible unless only one port on the OC12-4 card is being used).

Step 2 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 3.

Step 3 Ensure that no alarms or abnormal conditions (regardless of severity), including LOS, LOF, AIS-L, SF, 
SD, and FORCED-REQ-RING are present. See the “DLP-A298 Check the Network for Alarms and 
Conditions” task on page 13-3 for instructions.

Purpose This procedure upgrades OC-N speeds within BLSRs, path protection 
configurations, and 1+1 protection groups by upgrading OC-N cards.

Tools/Equipment Replacement cards

Prerequisite Procedures The manual span upgrade procedure requires at least two technicians 
(one at each end of the span) who can communicate with each other 
during the upgrade. 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note During the upgrade/downgrade some minor alarms and conditions display and then clear 
automatically. No service-affecting alarms (SA, Major, or Critical) should occur other than 
BLSROSYNC, which will clear when the upgrade/downgrade of all nodes is complete. If any 
other service-affecting alarms occur, Cisco recommends backing out of the procedure. 
A four-node BLSR can take up to five minutes to clear all of the BLSROSYNC alarms. Allow 
extra time for a large BLSR to clear all of the BLSROSYNC alarms. Refer to the Cisco ONS 
15454 Troubleshooting Guide for information about alarms.

Step 4 Complete a manual upgrade task if you need to perform error recovery for the Span Upgrade Wizard or 
back out of a span upgrade (downgrade):

• Complete the “DLP-A293 Perform a Manual Span Upgrade on a Two-Fiber BLSR” task on 
page 12-23 to upgrade an optical span manually within a two-fiber BLSR. 

• Complete the “DLP-A294 Perform a Manual Span Upgrade on a Four-Fiber BLSR” task on 
page 12-24 to upgrade an optical span manually within a four-fiber BLSR. 

• Complete the “DLP-A295 Perform a Manual Span Upgrade on a Path Protection Configuration” task 
on page 12-26 to upgrade an optical span manually within a two-fiber path protection configuration. 

• Complete the “DLP-A296 Perform a Manual Span Upgrade on a 1+1 Protection Group” task on 
page 12-27 to upgrade an optical span manually within a 1+1 protection group. 

• Complete the “DLP-A297 Perform a Manual Span Upgrade on an Unprotected Span” task on 
page 12-28 to upgrade an unprotected optical span manually. 

Note The span upgrade process resets the line’s CV-L threshold to factory default. The CV-L 
threshold is reset because the threshold is dependent on line rate.

Note The Span Upgrade option will only be visible and available if the hardware necessary for the 
upgrade is present; for example, no upgrade is possible from an OC48 span unless XC10G cards 
are installed in the nodes at both ends of the span. 

Note An OC-3 to eight-port OC-3 span upgrade, or an OC-12 to four-port OC-12 span upgrade can 
only be performed from multispeed slots (Slots 1 to 4 and 14 to17) because the OC3-8 and 
OC12-4 card can only be installed in multispeed slots. Ensure that the OC-3 and OC-12 cards 
are in multispeed slots before performing a span upgrade to the OC3-8 and OC12-4. The four 
OC-3 ports will be mapped to Ports 1-4 on the eight-port OC-3 card. The OC-12 port will be 
mapped to Port 1 on the four-port OC-12 card.

Stop. You have completed this procedure. 
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DLP-A293 Perform a Manual Span Upgrade on a Two-Fiber BLSR

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Note All spans connecting the nodes in a BLSR must be upgraded before the bandwidth is available.

Note BLSR protection channel access (PCA) circuits, if present, will remain in their existing STSs. Therefore, 
they will be located on the working path of the upgraded span and will have full BLSR protection. To 
route PCA circuits on protection channels in the upgraded span, delete and recreate the circuits after the 
span upgrade. For example, if you upgrade an OC-48 span to an OC-192, PCA circuits on the protection 
STSs (STSs 25 to 48) in the OC-48 BLSR will remain in their existing STSs (STSs 25 to 48) which are 
working, protected STSs in the OC-192 BLSR. Deleting and recreating the OC-48 PCA circuits moves 
the circuits to STSs 96 to 192 in the OC-192 BLSR. To delete circuits, see the “NTP-A152 Delete 
Circuits” procedure on page 9-16. To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

Step 1 Apply a Force switch to both span endpoints (nodes) on the span that you will upgrade first. See the 
“DLP-A303 Initiate a BLSR Force Switch - Ring” task on page 14-7.

Note A Force switch request on a span or card causes CTC to raise a FORCED-REQ condition. It is 
informational only; the condition will clear when the Force switch is cleared.

Step 2 Remove the fiber from both endpoints and ensure that traffic is still running.

Step 3 Remove the OC-N cards from both endpoints.

Step 4 From both endpoints, in node view right-click each OC-N slot and choose Change Card.

Step 5 In the Change Card dialog box, choose the new OC-N card type.

Step 6 Click OK.

Step 7 Before attaching the fiber to the newly installed OC-N cards, check that the transmit signal falls within 
the acceptable range. Install the new OC-N cards in both endpoints and attach the fiber to the cards. Wait 
for the IMPROPRMVL alarm to clear and the cards to become active. 

Purpose This task upgrades a two-fiber BLSR span to a higher optical rate. 

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Step 8 When cards in both endpoint nodes have been successfully upgraded and all the facility alarms (LOS, 
SD or SF) are cleared, remove the forced switch from both endpoints on the upgraded span. Seethe 
“DLP-A194 Clear a BLSR Force Switch - Ring” task on page 14-9.

The Force switch clears and traffic is running. If you have lost traffic, perform a downgrade. Repeat this 
task to downgrade but choose a lower-rate card in Step 5.

Step 9 Repeat this task for each span in the BLSR. When you are done with each span, the upgrade is complete.

Step 10 Return to your originating procedure (NTP).

DLP-A294 Perform a Manual Span Upgrade on a Four-Fiber BLSR

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Note All spans connecting the nodes in a BLSR must be upgraded before the bandwidth is available.

Note BLSR protection channel access (PCA) circuits, if present, will remain in their existing STSs. Therefore, 
they will be located on the working path of the upgraded span and will have full BLSR protection. To 
route PCA circuits on protection channels in the upgraded span, delete and recreate the circuits after the 
span upgrade. For example, if you upgrade an OC-48 span to an OC-192, PCA circuits on the protection 
STSs (STSs 25 to 48) in the OC-48 BLSR will remain in their existing STSs (STSs 25 to 48) which are 
working, protected STSs in the OC-192 BLSR. Deleting and recreating the OC-48 PCA circuits moves 
the circuits to STSs 96 to 192 in the OC-192 BLSR. To delete circuits, see the “NTP-A152 Delete 
Circuits” procedure on page 9-16. To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

Purpose This task upgrades a four-fiber BLSR span to a higher optical rate. 
Repeat the task to upgrade each span to the higher optical rate.

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A95 Upgrade Optical Spans Manually
Step 1 Apply a Force switch to both span endpoints (nodes) on the span that you will upgrade first. See the 
“DLP-A303 Initiate a BLSR Force Switch - Ring” task on page 14-7.

Note A Force switch request on a span or card causes CTC to raise a FORCED-REQ condition. It is 
informational only; the condition will clear when the Force switch command is cleared.

Step 2 Remove the fiber from both working and protect cards at both span endpoints (nodes) and ensure that 
traffic is still running.

Step 3 Remove the OC-N cards from both end points.

Step 4 For both ends of the span endpoints, in node view right-click each OC-N slot and choose Change Card.

Step 5 In the Change Card dialog box, choose the new OC-N card type.

Step 6 Click OK.

Step 7 Before attaching the fiber to the newly installed OC-N cards, check that the transmit signal falls within 
the acceptable range. Install the new OC-N cards in both endpoints and attach the fiber to the cards. Wait 
for the IMPROPRMVL alarm to clear and the cards to become active.

Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Step 8 When cards in both endpoint nodes have been successfully upgraded and all the facility alarms (LOS, 
SD or SF) are cleared, remove the forced switch from both endpoints (nodes) on the upgraded span. See 
“194 Clear a BLSR Force Switch - Ring” section on page 14-9.

The forced switch clears and traffic is running. If you have lost traffic, perform a downgrade. Repeat 
this task to downgrade but choose a lower-rate card in Step 5.

Step 9 Repeat these steps for each span in the BLSR. When all spans in the BLSR have been upgraded, the ring 
is upgraded.

Step 10 Return to your originating procedure (NTP).
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NTP-A95 Upgrade Optical Spans Manually
DLP-A295 Perform a Manual Span Upgrade on a Path Protection Configuration

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Step 1 Complete the “DLP-A197 Initiate a Path Protection Configuration Force Switch” task on page 14-18 to 
apply a Force switch on the span that you will upgrade.

Step 2 Remove the fiber from both endpoint nodes in the span and ensure that traffic is still running.

Step 3 Remove the OC-N cards from both span endpoints.

Step 4 For both ends of the span, in node view right-click each OC-N slot and choose Change Card.

Step 5 In the Change Card dialog box, choose the new OC-N card type.

Step 6 Click OK.

Step 7 Before attaching the fiber to the newly installed OC-N cards, check that the transmit signal falls within 
the acceptable range. Install the new OC-N cards in both endpoints and attach the fiber to the cards. Wait 
for the IMPROPRMVL alarm to clear and the cards to become active.

Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Step 8 Complete the “DLP-A198 Clear a Path Protection Configuration Force Switch” task on page 14-19 when 
cards in both endpoint nodes have been successfully upgraded and all the facility alarms (LOS, SD or 
SF) are cleared.

The forced switch clears and traffic is running. If you have lost traffic, perform a downgrade. Repeat 
this task to downgrade but choose a lower-rate card in Step 5.

Step 9 Return to your originating procedure (NTP).

Purpose This task upgrades path protection configuration spans to a higher 
optical speed. Repeat the task for each span to upgrade the entire ring to 
the higher optical rate.

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A95 Upgrade Optical Spans Manually
DLP-A296 Perform a Manual Span Upgrade on a 1+1 Protection Group

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Step 1 Complete the “DLP-A287 Switch 1+1 Traffic” task on page 12-14 to apply a Force switch to the protect 
port on the span you will upgrade. 

Note If the switching mode is bidirectional in the 1+1 protection group, apply the Force command to 
only one end of the span. If the Force command is applied to both ends when the switching mode 
is bidirectional, it will cause a switch of more than 50 ms in duration.

Step 2 Repeat Step 1 for each port you will upgrade.

Step 3 Remove the fiber from both ends of the span and ensure that traffic is still running.

Step 4 Remove the OC-N cards from both span endpoints.

Step 5 At both ends of the span, in node view, right-click the OC-N slot and choose Change Card.

Step 6 In the Change Card dialog box, choose the new OC-N card type.

Step 7 Click OK.

Step 8 Before attaching the fiber to the newly installed OC-N cards, verify that the transmit signal falls within 
the acceptable range. Install the new OC-N cards in both endpoints and attach the fiber to the cards. Wait 
for the IMPROPRMVL alarm to clear and the cards to become standby.

Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Step 9 When cards on each end of the span have been successfully upgraded and all the facility alarms (LOS, 
SD or SF) are cleared, complete the “DLP-A288 Clear a 1+1 Traffic Switch” task on page 12-15 to 
remove the Force switch.

The Force switch clears and traffic is running. If you have lost traffic, perform a downgrade. Repeat this 
task to downgrade but choose a lower-rate card in Step 6.

Purpose This task upgrades a linear span to a higher optical rate.

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 10 Repeat this task for any other spans in the 1 + 1 linear configuration.

Step 11 Return to your originating procedure (NTP).

DLP-A297 Perform a Manual Span Upgrade on an Unprotected Span

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution Upgrading unprotected spans will cause all traffic running on those spans to be lost.

Caution Do not perform any other maintenance operations or add any circuits during a span upgrade.

Step 1 Remove the fiber from both endpoint nodes in the span.

Caution Removing the fiber will cause all traffic on the unprotected span to be lost.

Step 2 Remove the OC-N cards from both span endpoints.

Step 3 For both ends of the span, in node view, right-click each OC-N slot and choose Change Card.

Step 4 In the Change Card dialog box, choose the new OC-N type.

Step 5 Click OK.

Step 6 When you have finished Steps 2 – 5 for both nodes, install the new OC-N cards in both endpoints and 
attach the fiber to the cards. Wait for the IMPROPRMVL alarm to clear and the cards to become active.

Note If you install OC-192 cards, a disabled OC-192 laser causes an LOS alarm to be reported for 
each OC-192 slot. Enable the OC-192 laser by setting the safety key lock on the OC-192 
faceplate to the ON position (labeled 1).

Step 7 Return to your originating procedure (NTP).

Purpose This task manually upgrades unprotected spans to a higher optical rate.

Tools/Equipment Higher-rate cards

Compatible hardware necessary for the upgrade

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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C H A P T E R 13

Convert Network Configurations

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to convert from one SONET topology to another in an ONS 15454 network. 
For initial network turn up, see Chapter 5, “Turn Up Network.”

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A154 Convert a Point-to-Point to a Linear ADM, page 13-2—Complete as needed.

2. NTP-A155 Convert a Point-to-Point or a Linear ADM to a Two-Fiber BLSR, page 13-4—Complete 
as needed.

3. NTP-A156 Convert a Point-to-Point or Linear ADM to a Path Protection Configuration, page 
13-7—Complete as needed.

4. NTP-A210 Convert a Path Protection Configuration to a Two-Fiber BLSR, page 13-8—Complete as 
needed.

5. NTP-A211 Convert a Two-Fiber BLSR to a Four-Fiber BLSR, page 13-10—Complete as needed. 

6. NTP-A159 Modify a BLSR, page 13-11—Complete as needed.
13-1
Cisco ONS 15454 Procedure Guide, R4.0



Chapter 13      Convert Network Configurations
NTP-A154 Convert a Point-to-Point to a Linear ADM
NTP-A154 Convert a Point-to-Point to a Linear ADM

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in Table 2-3 on page 2-25.

Note In a point-to-point configuration, two OC-N cards are connected to two OC-N cards on a second node. 
Any multispeed slots (Slots 1 to 4 and 14 to 17) or high-speed slots (Slots 5 to 6 and 12 to 13) can be 
used if connections between nodes are consistent. For example, Slot 5 on the first point-to-point node 
connects to Slot 5 on the second point-to-point node for the working path, and Slot 6 connects to Slot 6 
for the protect path. The working OC-N ports have data communications channel (DCC) terminations, 
and the OC-N cards are in a 1+1 protection group.

Step 1 Log into a point-to-point node. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions. If 
you are already logged in, go to Step 2.

Step 2 Complete the “DLP-A298 Check the Network for Alarms and Conditions” task on page 13-3 for 
instructions.

Step 3 Log into the node that will be added to the point-to-point configuration. 

Step 4 Complete the “NTP-A24 Verify Card Installation” procedure on page 4-2 to ensure that the new node 
has two OC-N cards with the same rate as the point-to-point nodes.

Step 5 Complete the “NTP-A35 Verify Node Turn Up” procedure on page 5-2 for the new node.

Step 6 Physically connect the fibers between the point-to-point node and the new node. 

Step 7 On the new node, create a 1+1 protection group for the OC-N cards that will connect to the point-to-point 
node. See the “DLP-A73 Create a 1+1 Protection Group” task on page 4-29 for instructions.

Step 8 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 for the working 
OC-N cards in the new node that will connect to the linear ADM network. Make sure to set the Port State 
in the Create SDCC Termination dialog box to IS. 

Note DCC failure alarms appear until you create DCC terminations in the point-to-point node during 
Step 9.

Step 9 Display the point-to-point node that will connect to the new node in CTC node view.

Step 10 Ensure that the point-to-point node has OC-N cards installed that can connect to the new node. 

Step 11 Create a 1+1 protection group for the OC-N cards that will connect to the new node. See the “DLP-A73 
Create a 1+1 Protection Group” task on page 4-29 for instructions. 

Purpose This procedure upgrades a point-to-point configuration (two nodes) to a 
linear add/drop multiplexer (ADM) configuration (3 or more nodes).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A154 Convert a Point-to-Point to a Linear ADM
Step 12 Create DCC terminations on the working OC-N card that will connect to the new node. See the 
“DLP-A253 Provision SONET DCC Terminations” task on page 5-5. In the Create SDCC Termination 
dialog box, set the port state to IS. 

Step 13 Display the new node in node view.

Step 14 Complete the “NTP-A28 Set Up Timing” task on page 4-21 for the new node. If the new node is using 
line timing, make the working OC-N card the timing source. 

Step 15 Display the network view to verify that the newly created linear ADM configuration is correct. Two 
green span lines should appear between each linear node.

Step 16 Click the Alarms tab. Verify that no unexpected alarms are displayed.

Step 17 Repeat the procedure to add an additional node to the linear ADM.

Stop. You have completed this procedure.

DLP-A298 Check the Network for Alarms and Conditions

Step 1 From the View menu, choose Go to Network View. Verify that all affected spans on the network map 
are green.

Step 2 Verify that the affected spans do not have active switches on the network map. Span ring switches are 
graphically displayed on the span with the letters “L” for lockout ring, “F” for Force ring, “M” for 
Manual ring, and “E” for Exercise ring. 

Step 3 A second verification method can be performed from the Conditions tab. Click Retrieve Conditions and 
verify that no switches are active. Make sure the Filter button is not selected.

Step 4 Click the Alarms tab. Verify that no critical or major alarms are present, nor any facility alarms, such as 
LOS, LOF, AIS-L, AIS-P, SF, and SD. Make sure the Filter button is not selected.

If trouble is indicated (for example, a major alarm exists), resolve the problem before proceeding. See 
Chapter 7, “Manage Alarms,” or, if necessary, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 5 Return to your originating procedure (NTP).

Purpose This task verifies that no alarms or conditions exist on the network.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Remote

Security Level Retrieve or higher
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NTP-A155 Convert a Point-to-Point or a Linear ADM to a 
Two-Fiber BLSR

Caution This procedure is service affecting.

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in the Cisco ONS 15454 Reference Manual.

Step 1 Log into one of the nodes that you want to convert from a point-to-point or ADM to a BLSR. See the 
“DLP-A60 Log into CTC” task on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2 Complete the “DLP-A298 Check the Network for Alarms and Conditions” task on page 13-3 for 
instructions.

Step 3 Right-click a span adjacent to the node you are logged into.

Step 4 From the shortcut menu, click Circuits. The Circuits on Span window appears.

Step 5 Verify that the total number of active STS circuits does not exceed 50 percent of the span bandwidth. In 
the Circuits column there is a block titled “Unused.” This number should exceed 50 percent of the span 
bandwidth.

Note If the span is an OC-48, no more than 24 STSs can be provisioned on the span. If the span is an 
OC-192, no more than 96 STSs can be provisioned on the span. If the span is an OC-12, no more 
than 6 STSs can be provisioned on the span.

Caution If the first half of the capacity is exceeded, this procedure cannot be completed. Bandwidth must be 50 
percent unassigned to convert to BLSR. Refer to local procedures for relocating circuits if these 
requirements are not met.

Step 6 Repeat Steps 3 through 5 for each node in the point-to-point or linear ADM that you will convert to 
BLSR. If all nodes comply with Step 5, proceed to Step 7.

Step 7 Complete the “DLP-A189 Verify that a 1+1 Working Slot is Active” task on page 13-6 for every 1+1 
protection group that supports a span in the point-to-point or linear ADM network. 

Step 8 Complete the “DLP-A155 Delete a Protection Group” task on page 10-18 at each node that supports the 
point-to-point or linear ADM span.

Purpose This procedure upgrades a point-to-point configuration (two nodes) or a 
linear ADM configuration (3 or more nodes) to a two-fiber bidirectional 
line switched ring (BLSR).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A155 Convert a Point-to-Point or a Linear ADM to a Two-Fiber BLSR
Step 9 Complete the “DLP-A214 Change the Service State for a Port” task on page 5-6 to put the protect ports 
out of service at each node that supports the point-to-point or linear ADM span.

Step 10 (Linear ADM only) Physically remove the protect fibers from all nodes in the linear ADM; for example, 
the fiber running from Node 2/Slot 13 to Node 3/Slot 13 (as shown in Figure 13-1) can be removed .

Figure 13-1 Linear ADM to BLSR Conversion

Step 11 Create the ring by connecting the protect fiber from one end node to the protect port on the other end 
node. For example, the fiber between Node 1/Slot 5 and Node 2/Slot 5 (as shown in Figure 13-1) can be 
rerouted to connect Node 1/Slot 5 to Node 3/Slot 13.

Note If you need to physically remove any OC-N cards, do so now. In this example, cards in 
Node 2/Slots 5 and 13 can be removed. See the “NTP-A116 Remove and Replace a Card” 
procedure on page 2-21.

Step 12 From the network view, click the Circuits tabs and complete the “DLP-A139 Export CTC Data” task on 
page 7-4 to save the circuit data to a file on your hard drive.

Step 13 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 at the end nodes; 
provision the slot in each node that is not already in the SDCC Terminations list (in the Figure 13-1 
example, Port 1 of Node 1/Slot 5 and Port 1 of Node 3/Slot 13).

Step 14 For circuits provisioned on an STS that is now part of the protection bandwidth (STSs 7 to 12 for an 
OC-12 BLSR, STSs 25 to 48 for an OC-48 BLSR, and STSs 97 to 192 for an OC-192 BLSR), delete and 
recreate each circuit:

Note Deleting circuits is service affecting.

a. Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 for one circuit.

b. Create the circuit on STSs 1 to 6 for an OC-12 BLSR, 1 to 24 for an OC-48 BLSR, or 1 to 96 for an 
OC-192 BLSR on the fiber that served as the protect fiber in the linear ADM. See the “NTP-A189 
Create a Manually Routed Optical Circuit” procedure on page 6-47 for instructions. 
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c. Repeat Steps a and b for each circuit residing on a BLSR protect STS.

Step 15 Complete the “NTP-A126 Create a BLSR” task on page 5-18 to put the nodes into a BLSR.

Stop. You have completed this procedure.

DLP-A189 Verify that a 1+1 Working Slot is Active

Step 1 In the node view, click the Maintenance > Protection tabs.

Step 2 In the Selected Group pane, verify that the working slot/port is shown as Working/Active. If so, this task 
is complete.

Step 3 If the working slot says Working/Standby, perform a Manual switch on the working slot:

a. In the Selected Group pane, choose the Protect/Active slot.

a. In the Switch Commands field, choose Manual.

b. Click Yes in the confirmation dialog box.

Step 4 Verify that the working slot is carrying traffic (Working/Active). 

Note If the slot is not active, look for conditions or alarms that might be preventing the card from 
carrying working traffic. Refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 5 When the working slot is carrying traffic, clear the Manual switch:

a. In the Switch Commands field, choose Clear.

b. Click Yes in the confirmation dialog box.

Step 6 Verify that the working slot does not revert to Standby, which might indicate a problem on the working 
span.

Step 7 Return to your originating procedure (NTP).

Purpose This task verifies that a working slot in a 1+1 protection scheme is active 
(and that the protect slot is in standby).

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance or higher
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NTP-A156 Convert a Point-to-Point or Linear ADM to a Path 
Protection Configuration

Caution This procedure is service affecting. All circuits are deleted and reprovisioned.

Step 1 Log into a node on the point-to-point or linear ADM. See the “DLP-A60 Log into CTC” task on 
page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-A298 Check the Network for Alarms and Conditions” task on page 13-3 for 
instructions.

Step 3 Complete the “DLP-A189 Verify that a 1+1 Working Slot is Active” task on page 13-6 for each node.

Step 4 Complete the “DLP-A155 Delete a Protection Group” task on page 10-18 for each 1+1 protection group 
that supports the point-to-point or linear ADM span.

Step 5 Complete the “DLP-A253 Provision SONET DCC Terminations” task on page 5-5 at the protect cards 
in all nodes.

Step 6 Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 and the “NTP-A188 Create an 
Automatically Routed Optical Circuit” procedure on page 6-43 to delete and recreate the circuits one at 
a time.

Note Deleting circuits is service affecting.

Stop. You have completed this procedure.

Purpose This procedure upgrades a point-to-point system to a path protection 
configuration.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-A210 Convert a Path Protection Configuration to a 
Two-Fiber BLSR

Caution This procedure is service affecting. All circuits on the ring are deleted and reprovisioned.

Caution Read through this procedure completely before beginning the conversion.

Note Prior to beginning this procedure, you should have a unique ring ID number to identify the new BLSR 
and a unique node ID number for each node on the ring.

Note Prior to beginning this procedure, optical transmit and receive levels should be in their acceptable range 
as shown in the specifications section for each card in the Cisco ONS 15454 Reference Manual.

Step 1 Log into an ONS 15454 on the network where you will begin the ring conversion. See the “DLP-A60 
Log into CTC” task on page 3-23. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-A298 Check the Network for Alarms and Conditions” task on page 13-3 for 
instructions.

Step 3 Click View > Go to Network View.

Step 4 Right-click a span adjacent to the node you are logged into.

Step 5 From the shortcut menu, click Circuits. The Circuits on Span window appears.

Step 6 Verify that the total number of active STS circuits does not exceed 50 percent of the span bandwidth. In 
the Circuits column there is a block titled “Unused.” This number should exceed 50 percent of the span 
bandwidth.

Note If the span is an OC-48, no more than 24 STSs can be provisioned on the span. If the span is an 
OC-192, no more than 96 STSs can be provisioned on the span. If the span is an OC-12, no more 
than 6 STSs can be provisioned on the span.

Purpose This procedure converts a path protection configuration to a two-fiber 
BLSR.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Both

Security Level Provisioning or higher
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Caution If the first half of the capacity is exceeded, this procedure cannot be completed. Bandwidth must be 50 
percent unassigned to convert to BLSR. Refer to local procedures for relocating circuits if these 
requirements are not met.

Step 7 Repeat Steps 1 through 6 for each node in the path protection configuration that you will convert to 
BLSR. If all nodes comply with 
Step 6, proceed to Step 8.

Step 8 Save all circuit information:

a. In network view, click the Provisioning > Circuits tabs.

b. Record the circuit information using one of the following tasks:

– From the File menu, click Print to print the circuits table.

– From the File menu, click Export and choose the data format: HTML, CSV (comma separated 
values), or TSV (tab separated values). Click OK and save the file in a temporary directory.

See the “NTP-A195 Document Existing Provisioning” procedure on page 7-2 for more 
information.

Step 9 Delete the circuits:

Note This method uses the network view. To delete circuits one at a time from each node, see the 
“NTP-A152 Delete Circuits” procedure on page 9-16.

a. From network view, click the Circuits tab. All circuits on the ring appear. 

b. With the Shift key pressed, click each circuit in the display. Each line in the display turns dark blue 
as it is selected. 

c. After all circuits have been selected, click Delete. Allow several minutes for processing; the actual 
length of time depends on the number of circuits in the network.

Step 10 Complete the “NTP-A126 Create a BLSR” procedure on page 5-18 to create the BLSR.

Step 11 Complete the “NTP-A175 Two-Fiber BLSR Acceptance Test” procedure on page 5-20.

Step 12 To recreate the circuits, see Chapter 6, “Create Circuits and VT Tunnels” and choose the applicable 
procedure for the circuit type you want to enter.

Stop. You have completed this procedure.
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NTP-A211 Convert a Two-Fiber BLSR to a Four-Fiber BLSR

Note Two-fiber OC-48 or OC-192 BLSRs can be converted to four-fiber BLSRs. To convert, you install two 
additional OC-48 or OC-192 cards at each two-fiber BLSR node, then log into CTC and convert the 
BLSR from two-fiber to four-fiber. The fibers that were divided into working and protect bandwidths for 
the two-fiber BLSR are now fully allocated for working BLSR traffic. A span upgrade can be performed 
prior to the two-fiber to four-fiber BLSR conversion.

Note Optical transmit and receive levels should be in their acceptable range as shown in the specifications 
section for each card in the Cisco ONS 15454 Reference Manual.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23 to log into one of the two-fiber nodes that 
you want to convert. 

Step 2 Check the BLSR for outstanding alarms and conditions. See the “DLP-A298 Check the Network for 
Alarms and Conditions” task on page 13-3 for instructions.

Step 3 Install two OC-48 or OC-192 cards at each BLSR node. You must install the same OC-N card rate as the 
two-fiber BLSR. See Chapter 2, “Install Cards and Fiber-Optic Cable,” for installation procedures.

Step 4 Connect the fiber to the new cards. Use the same east-west connection scheme that was used to create 
the two-fiber connections.

Step 5 Complete the “DLP-A214 Change the Service State for a Port” procedure on page 5-6 to enable (put in 
service) the ports for each new OC-N card.

Step 6 Test the new fiber connections using procedures standard for your site. 

Step 7 Convert the BLSR:

a. Display the network view and click the Provisioning > BLSR tabs.

b. Choose the two-fiber BLSR you want to convert then click the Upgrade to 4 Fiber button.

c. In the Upgrade BLSR dialog box, set the amount of time that will pass before the traffic reverts to 
the original working path after the condition that caused the switch has been resolved. The default 
is 5 minutes. 

d. Click Next.

e. Assign the east and west protection ports:

• West Protect—Select the west BLSR port that will connect to the west protect fiber from the 
pull-down menu.

Purpose This procedure upgrades a two-fiber BLSR to a four-fiber BLSR. The 
conversion will be easier if the same east and west configuration is used 
on all nodes being upgraded.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• East Protect—Select the east BLSR port that will connect to the east protect fiber from the 
drop-down menu.

f. Click Finish.

Step 8 Click the Alarms tab. Make sure the Filter button is not selected. Verify that no critical or major alarms 
are present, nor any facility alarms, such as LOS, LOF, AIS-L, SF, and SD. If an alarm is present, resolve 
the problem before proceeding to the next step. Refer to the Cisco ONS 15454 Troubleshooting Guide 
for more information about alarms.

Step 9 Complete the “NTP-A176 Four-Fiber BLSR Acceptance Test” procedure on page 5-26.

Stop. You have completed this procedure.

NTP-A159 Modify a BLSR

Step 1 Log into a node in the BLSR you want to modify. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, continue with Step 2.

Step 2 Check the BLSR for outstanding alarms and conditions. See the “DLP-A298 Check the Network for 
Alarms and Conditions” task on page 13-3 for instructions.

Note Some or all of the following alarms display during BLSR setup: E-W MISMATCH, RING 
MISMATCH, APSCIMP, APSDFLTK, and BLSROSYNC. The alarms clear after you configure 
all the nodes in the BLSR. For definitions of these alarms, see the Cisco ONS 15454 
Troubleshooting Guide.

Step 3 To change the BLSR ring ID or the ring or span reversion times, complete the following steps. If you 
want to change a node ID, go to Step 4.

a. In network view, click the Provisioning > BLSR tabs.

b. Click the BLSR you want to modify and click Edit.

c. In the BLSR window, change any of the following:

– Ring ID—If needed, change the BLSR ring ID (a number between 0 and 9999). Do not choose 
a number that is already assigned to another BLSR.

– Reversion time—If needed, change the amount of time that will pass before the traffic reverts 
to the original working path after a ring switch. 

– Span Reversion—(Four-fiber BLSRs only) If needed, change the amount of time that will pass 
before the traffic reverts to the original working path after a span switch.

Purpose Use this procedure to change a BLSR ring ID, node ID, or ring and span 
reversion times.

Tools/Equipment None

Prerequisite Procedures NTP-A126 Create a BLSR, page 5-18

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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d. Click Apply. 

If you changed the ring ID, the BLSR window closes automatically. If you only changed a reversion time, 
close the window by choosing Close from the File menu.

Step 4 To change a BLSR node ID, complete the following steps; otherwise, proceed to Step 5.

a. On the network map, double-click the node with the node ID you want to change.

b. Click the Provisioning > BLSR tabs.

c. Choose a Node ID number. Do not choose a number already assigned to another node in the same 
BLSR.

d. Click Apply.

Step 5 In network view, verify the following:

• A green span line appears between all BLSR nodes.

• All E-W MISMATCH, RING MISMATCH, APSCIMP, DFLTK, BLSROSYNC and Node ID 
Mismatch alarms are cleared.

Note For definitions of these alarms, see the Cisco ONS 15454 Troubleshooting Guide.

Stop. You have completed this procedure.

DLP-A301 Initiate a BLSR Manual Ring Switch

Caution Traffic is not protected during a manual ring protection switch.

Step 1 Display the network view. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Tip To move an icon to a new location, for example, to see BLSR channel (port) information more clearly, 
click an icon and drag and drop it in a new location.

Step 4 Right-click any BLSR node channel (port) and choose Set West Protection Operation (if you chose a 
west channel) or Set East Protection Operation (if you chose an east channel).

Purpose Use this task to perform a BLSR Manual ring switch.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note For two-fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent ports. 
Right-click either working port.

Step 5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose 
MANUAL RING from the drop-down menu. Click OK.

Step 6 Click Yes in the two Confirm BLSR Operation dialog boxes.

Step 7 Verify that the channel (port) displays the letter “M” for Manual ring. Also verify that the span lines 
between the nodes where the Manual switch was invoked turn purple, and that the span lines between all 
other nodes turn green on the network view map. This confirms the Manual switch.

Step 8 From the File menu, choose Close.

Step 9 Return to your originating procedure (NTP).

DLP-A241 Clear a BLSR Manual Ring Switch

Caution Traffic is not protected during a Manual ring switch.

Step 1 Display the network view. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Choose the BLSR and click Edit. 

Tip To move an icon to a new location, for example, to see BLSR channel (port) information more clearly, 
click an icon on the Edit BLSR network graphic and while pressing Ctrl, drag the icon to a new location.

Step 4 Right-click the BLSR node channel (port) where the Manual ring switch was applied and choose 
Set West Protection Operation or Set East Protection Operation, as applicable. 

Step 5 In the dialog box, choose CLEAR from the drop-down menu. Click OK.

Step 6 Click Yes on the Confirm BLSR Operation dialog box. The letter “M” is removed from the channel (port) 
and the span turns green on the network view map.

Step 7 From the File menu, choose Close.

Step 8 Return to your originating procedure (NTP).

Purpose Use this task to clear a Manual ring switch.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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C H A P T E R 14

Add and Remove Nodes

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to add and remove Cisco ONS 15454 nodes from bidirectional line switched 
rings (BLSRs) and path protection configurations. 

Before You Begin
Before performing any of the following procedures, complete the “NTP-A195 Document Existing 
Provisioning” procedure on page 7-2. Also investigate all alarms and clear any trouble conditions. Refer 
to the Cisco ONS 15454 Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A102 Add a BLSR Node, page 14-2—Complete as needed.

2. NTP-A213 Remove a BLSR Node, page 14-10—Complete as needed.

3. NTP-A105 Add a Path Protection Configuration Node, page 14-14—Complete as needed.

4. NTP-A106 Remove a Path Protection Configuration Node, page 14-16—Complete as needed.
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NTP-A102 Add a BLSR Node

Caution Adding a BLSR node can be service affecting and should be performed during a maintenance window.

Step 1 Draw a diagram of the BLSR where you will add the node. In the diagram, identify the east and west 
BLSR OC-N trunk (span) cards that will connect to the new node. This information is essential to 
complete this procedure without error. Figure 14-1 shows a drawing of a three-node, two-fiber BLSR 
that uses Slots 5 and 12 for the BLSR trunk cards. The dashed arrow shows the new fiber connections 
that will be made to add the fourth node to the BLSR.

Figure 14-1 Three-Node, Two-Fiber BLSR Before a Fourth Node Is Added

Purpose Use this procedure to expand a BLSR by adding a node.

Tools/Equipment Fiber for new node connections

Prerequisite Procedures Cards must be installed and node turn-up procedures completed on the 
node that will be added to the BLSR. See Chapter 2, “Install Cards and 
Fiber-Optic Cable,” and Chapter 4, “Turn Up Node.”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 14-2 shows a sample drawing of a four-fiber BLSR. The dashed arrow shows the new fiber 
connections that will be made to add the fourth node. For four-fiber BLSRs, two fiber sets will be 
reconnected, the working fiber and the protect fiber.

Figure 14-2 Three-Node, Four-Fiber BLSR Before a Fourth Node is Added

Step 2 Verify the card installation on the new node using the “NTP-A24 Verify Card Installation” procedure on 
page 4-2. Verify that the OC-N cards that will be the BLSR trunk cards match the BLSR optical rate. For 
example, if the BLSR is OC-48, the new node must have OC-48 cards installed. If the OC-N cards are 
not installed or the optical rates do not match the BLSR, complete the “NTP-A16 Install the Optical 
Cards” procedure on page 2-13.

Step 3 Verify that fiber is available to connect the new node to the existing nodes. Refer to the diagram drawn 
in Step 1.

Step 4 Complete the “NTP-A35 Verify Node Turn Up” procedure on page 5-2. In order to have CTC visibility 
to the new node after it is added, you must be an authorized user on the node and you must have IP 
connectivity to the node.

Step 5 Check to see if the new node IP address is on the same subnet as other nodes in the network. If two or 
more PCs are directly connected to different nodes that belong to the same subnet and Craft Access Only 
is not checked under Gateway Settings, add static routes on the gateway ONS 15454 nodes, using the 
following settings:

• Destination IP address: Local PC IP address

• Net Mask: 255.255.255.255
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• Next Hop: IP address of the Cisco ONS 15454

• Cost: 1

See the “DLP-A65 Create a Static Route” task on page 4-14. To view Gateway Settings, see the 
“DLP-A249 Provision IP Settings” task on page 4-9.

Step 6 Log into a node that is in the BLSR. See the “DLP-A60 Log into CTC” task on page 3-23.

Step 7 Complete the “DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions” task 
on page 14-6 to verify that the BLSR is free of major alarms or problems. If trouble is indicated (for 
example, a major alarm exists), resolve the problem before proceeding. See Chapter 7, “Manage 
Alarms” or, if necessary, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 8 Click the Provisioning > BLSR tabs. 

Step 9 On paper, record the Ring ID, Ring Type, Line Rate, Ring Reversion, and Span Reversion (4 Fiber).

Step 10 From the Node column, record the Node IDs in the BLSR. The Node IDs are the numbers in parenthesis 
next to the node name.

Step 11 Log into the new node:

• If the node has a LAN connection and is displayed on the network map, from the View menu, choose 
Go to Other Node, then enter the new node. 

• If the new node is not connected to the network, log into it using the “DLP-A60 Log into CTC” task 
on page 3-23.

Step 12 Click the Alarms tab. Verify that no critical or major alarms are present, nor any facility alarms, such as 
LOS, LOF, AIS-L, SF, and SD. If trouble is indicated (for example, a major alarm exists), resolve the 
problem before proceeding. See Chapter 7, “Manage Alarms”or, if necessary, refer to the 
Cisco ONS 15454 Troubleshooting Guide.

Step 13 Using the information recorded in Steps 9 and 10 and the diagram created in Step 1, create a BLSR on 
the new node. See the “DLP-A242 Create a BLSR on a Single Node” task on page 14-6.

Step 14 (Optional) Create test circuits, making sure they pass through the BLSR trunk cards, and run test traffic 
through the node to ensure the cards are functioning properly. See the “NTP-A189 Create a Manually 
Routed Optical Circuit” procedure on page 6-47 and the “NTP-A62 Test Optical Circuits” procedure on 
page 6-55 for information.

Step 15 Create the DCC terminations on the new node. See the “DLP-A253 Provision SONET DCC 
Terminations” task on page 5-5. 

Note Creating the DCC terminations causes the SDCC Termination Failure and Loss of Signal alarms 
to appear. These alarms will remain active until you connect the node to the BLSR.

Note If you map the K3 byte to another byte (such as E2), you must remap the line cards on either side 
of the new node to the same byte. See the “DLP-A89 Remap the K3 Byte” task on page 5-17.

Step 16 Log into a BLSR node that will connect to the new node. See “DLP-A60 Log into CTC” task on 
page 3-23.

Step 17 Referring to the diagram created in Step 1, complete the “DLP-A303 Initiate a BLSR Force Switch - 
Ring” task on page 14-7 on the node that will connect to the new node on its west line (port).

Step 18 Referring to the diagram created in Step 1, complete the “DLP-A303 Initiate a BLSR Force Switch - 
Ring” task on page 14-7 on the node that will connect to the new node on its east line (port).
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Step 19 Click the Alarms tab. If unexpected critical or major alarms are displayed, resolve them before you 
continue. If necessary, refer to the alarm troubleshooting procedures in the 
Cisco ONS 15454 Troubleshooting Guide.

Step 20 Following the diagram created in Step 1, remove the fiber connections from the two nodes that will 
connect to the new node.

a. Remove the west fiber from the node that will connect to the east port of the new node. In the 
Figure 14-1 example, this is Node 1/Slot 5, and in Figure 14-2 this is Node 1, Slots 5 and 6.

b. Remove the east fiber from the node that will connect to the west port of the new node. In the 
Figure 14-1 example, this is Node 3/Slot 12, and in Figure 14-2 this is Node 3, Slots 12 and 13.

Step 21 Connect fibers from the adjacent nodes to the new node following the diagram created in Step 1. Connect 
the west port to the east port and the east port to the west port. For 4-fiber BLSRs, connect the protect 
fibers.

Step 22 Display the newly added node in node view. 

Step 23 Click the Provisioning > BLSR tabs. 

Step 24 Click Ring Map. Verify that the new node appears on the Ring Map with the other BLSR nodes, then 
click OK.

Step 25 From the View menu, choose Go to Network View and check the following:

a. Click the Provisioning > BLSR tabs. Verify that the new node is displayed under the Node column. 

b. Click the Alarms tab. Verify that BLSR alarms such as RING MISMATCH, E-W MISMATCH, 
PRC-DUPID (duplicate node ID), and APSCDFLTK (default K) are not displayed. 

If the new node does not appear in the Node column, or if BLSR alarms are displayed, log into the new 
node and verify that the BLSR is provisioned on it correctly with the information from Steps 9 and 10. 
If the node still does not appear, or if alarms persist, refer to the Cisco ONS 15454 Troubleshooting 
Guide.

Step 26 Click the Circuits tab. Wait until all the circuits are discovered. The circuits that pass through the new 
node will be shown as incomplete.

Step 27 In network view, right-click the new node and choose Update Circuits With The New Node from the 
shortcut menu. Verify that the number of updated circuits displayed in the dialog box is correct.

Step 28 If incomplete circuits are still displayed, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 29 Click the History tab. Verify that BLSR_RESYNC conditions are displayed for every node in the BLSR.

Step 30 Complete the “DLP-A194 Clear a BLSR Force Switch - Ring” task on page 14-9 to remove the ring 
switch from the east and west BLSR lines.

Step 31 (Optional) Complete the “NTP-A175 Two-Fiber BLSR Acceptance Test” procedure on page 5-20 or the 
“NTP-A176 Four-Fiber BLSR Acceptance Test” procedure on page 5-26.

 Stop. You have completed this procedure.
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DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions

Step 1 From the View menu, choose Go to Network View. Verify that all BLSR or path protection 
configuration spans on the network map are green.

Step 2 Click the Alarms tab. Verify that no critical or major alarms are present, nor any facility alarms, such as 
LOS, LOF, AIS-L, SF, and SD. In a BLSR, these facility conditions might be reported as minor alarms. 
Make sure the Filter button in the lower right corner of the window is off (not indented).

Step 3 Click the Conditions tab and click Retrieve Conditions. Verify that no ring switches are active. Make 
sure the Filter button in the lower right corner of the window is off (not indented).

Step 4 Return to the originating procedure (NTP).

DLP-A242 Create a BLSR on a Single Node

Step 1 Display the node view. 

Step 2 Click the Maintenance > BLSR tabs.

Step 3 In the Suggestion dialog box, click OK.

Step 4 In the Create BLSR dialog box, enter the BLSR information:

• Ring Type—Enter the ring type (either 2 Fiber or 4 Fiber) of the BLSR.

• Ring ID—Enter the BLSR ring ID. If the node is being added to a BLSR, use the BLSR ring ID.

• Node ID—Enter the node ID. If the node is being added to a BLSR, use an ID that is not used by 
other BLSR nodes.

• Ring Reversion—Enter the ring reversion time of the existing BLSR.

Purpose Use this task to check a BLSR or a path protection configuration for alarms 
and conditions before performing any major administrative change to the 
ring such as adding and removing nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23 

Required/As Needed Required before performing any major change to the ring.

Onsite/Remote Onsite

Security Level Provisioning or higher

Purpose Use this task to create a BLSR on a single node. The task is used when you 
add a node to an existing BLSR or when you delete and then recreate a 
BLSR temporarily on one node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• West Line—Enter the slot on the node that will connect to the existing BLSR via the node’s west 
line (port).

• East Line—Enter the slot on the node that will connect to the existing BLSR via the node’s east line 
(port).

If you are adding the node to a four-fiber BLSR, complete the following for the second set of fibers:

• Span Reversion—Enter the span reversion time of the existing BLSR.

• West Line—Enter the slot on the node that will connect to the existing BLSR via the node’s west 
line.

• East Line—Enter the slot on the node that will connect to the existing BLSR via the node’s east line. 

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

Note Alarms are displayed and the BLSR is displayed as Incomplete until the node is connected to 
other BLSR nodes.

DLP-A303 Initiate a BLSR Force Switch - Ring 

Caution The Force Switch Away command overrides normal protective switching mechanisms. Applying this 
command incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Step 1 Display the network view. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Click Edit. 

Step 4 To apply a Force switch to the west line: 

a. Right-click the west BLSR port where you want to switch the BLSR traffic and choose 
Set West Protection Operation (Figure 14-3). 

Purpose Use this task to perform a BLSR Force protection operation on a BLSR 
port.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Note If node icons overlap, drag and drop the icons to a new location. You can also return to 
network view and change the positions of the network node icons, because BLSR node icons 
are based on the network view node icon positions.

Note For two-fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent 
ports. Right-click either working port.

Figure 14-3 Invoking a Protection Operation on a Three-Node BLSR

b. In the Set West Protection Operation dialog box choose FORCE RING from the pull-down menu. 
Click OK.

c. Click Yes in the two Confirm BLSR Operation dialog boxes that appear.

On the network graphic, an F is displayed on the working BLSR channel where you invoked the 
protection switch. The span lines change color to reflect the forced traffic. Green span lines indicate the 
new BLSR path, and the lines between the protection switch are purple.

Performing a Force switch generates several conditions including FORCED-REQ-RING, 
FORCED-REQ-RING, and WKSWPR. 

Step 5 To apply a Force switch to the east line: 

a. Right-click the east BLSR port and choose Set East Protection Operation. 

Note If node icons overlap, drag and drop the icons to a new location or return to network view 
and change the positions of the network node icons, since BLSR node icons are based on the 
network view node icon positions.

Note For two-fiber BLSRs, the squares on the node icons represent the BLSR working and protect 
channels. You can right-click either channel. For four-fiber BLSRs, the squares represent 
ports. Right-click either working port.
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b. In the Set East Protection Operation dialog box, choose FORCE RING from the pull-down menu. 
Click OK.

c. Click Yes in the two Confirm BLSR Operation dialog boxes that display.

On the network graphic, an F is displayed on the working BLSR channel where you invoked the 
protection switch. The span lines change color to reflect the forced traffic. Green span lines indicate the 
new BLSR path, and the lines between the protection switch are purple.

Performing a Force switch generates several conditions including FORCED-REQ-RING, 
FORCED-REQ-RING, and WKSWPR. 

Step 6 From the File menu, choose Close.

Step 7 Return to your originating procedure (NTP).

DLP-A194 Clear a BLSR Force Switch - Ring

Step 1 Display the network view. 

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Click Edit. 

Step 4 To clear a Force switch on the west line:

a. Right-click the BLSR west port where you want to clear the protection switch and choose Set West 
Protection Operation. Ports with a Force switch applied are marked with an F.

b. In the Set West Protection Operation dialog box, choose CLEAR from the pull-down menu. Click 
OK.

c. In the Confirm BLSR Operation dialog box, click Yes.

Step 5 To clear a Force switch on the east line:

a. Right-click the BLSR east port where you want to clear the protection switch and choose Set East 
Protection Operation. Ports with a Force switch applied are marked with an F.

b. In the Set East Protection Operation dialog box, choose CLEAR from the pull-down menu. Click 
OK.

c. In the Confirm BLSR Operation dialog box, click Yes.

On the BLSR network graphic, a green and a purple span line connects each node. This is the normal 
display for BLSRs when protection operations are not invoked.

Step 6 From the File menu, choose Close.

Purpose Use this task to remove a Force switch from a BLSR port.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 7 Return to your originating procedure (NTP).

NTP-A213 Remove a BLSR Node

Caution The following procedure minimizes traffic outages during node removals. You will delete all circuits that 
originate and terminate on the node that will be removed. In addition, you will verify that circuits passing 
through the node do not enter and exit the node on different STSs and/or VTs. If they do, you will delete 
and recreate the circuits, and traffic will be lost during this time.

Caution If you remove a node that is the only BITS timing source for the ring, you also remove the only source 
of synchronization for all the nodes in that ring. Circuits that leave the ring to connect to other networks 
synchronized to a Stratum 1 clock will experience a high level of pointer adjustments, which might 
adversely affect traffic performance. 

Step 1 Log into a node on the BLSR. Do not log into the node that you will remove. See the “DLP-A60 Log 
into CTC” task on page 3-23 for instructions. 

Step 2 Create a diagram of the BLSR where you will remove the node. You can draw the BLSR manually, or 
print it from CTC by performing the following steps:

a. From the View menu, choose Go to Network View.

b. Click the BLSR tab, click the BLSR, then click Edit.

c. In the BLSR window, verify that all the port information is visible. If not, press Ctrl and drag the 
node icons to a new location so the information can be viewed.

d. From the File menu, choose Print.

e. Close the BLSR window by choosing Close from the File menu.

Step 3 Referring to the BLSR diagram, identify the following:

• The node that is connected via its west port to the target (removal) node. For example, if you were 
removing Node 4 in Figure 14-4, Node 1 is the node connected via its west port to Node 4.

• The node that is connected via its east port to the target (removal) node. In Figure 14-4, Node 3 is 
the node connected via its east port to Node 4.

Purpose Use this procedure to remove a node from a BLSR.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 14-4 Four-Node, Two-Fiber BLSR Before a Node Is Removed

Step 4 Complete the “DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions” task 
on page 14-6 to verify that the BLSR is free of alarms. If trouble is indicated (for example, a major alarm 
exists), resolve the problem before proceeding. See Chapter 7, “Manage Alarms” or, if necessary, refer 
to the Cisco ONS 15454 Troubleshooting Guide.

Step 5 From the View menu, choose Go to Other Node. Choose the node that you will remove and click OK.

Step 6 Click the Circuits tab. If the Scope setting is set to Network, choose Node from the Scope pull-down 
menu. Make sure the Filter button is off (not indented) to ensure that all circuits are visible. 

Step 7 Delete all circuits that originate or terminate on the node. See the “NTP-A152 Delete Circuits” 
procedure on page 9-16.

Step 8 Complete the “DLP-A304 Verify Pass-Through Circuits” task on page 14-12 to verify that circuits 
passing through the target node enter and exit the node on the same STS and/or VT.

Step 9 From the View menu, choose Go to Network View.

Step 10 Referring to the diagram created in Step 1, complete the “DLP-A303 Initiate a BLSR Force Switch - 
Ring” task on page 14-7 at each node that connects to the target (removal) node to force traffic away 
from it. You must perform a Force switch at each port connected to the target node. For example, in 
Figure 14-4, you would perform a Force switch on the east port of Node 3 and the west port of Node 1.

Step 11 Click the Alarms tab. If unexpected critical or major alarms are displayed, resolve them before you 
continue. If necessary, refer to the alarm troubleshooting procedures in the Cisco ONS 15454 
Troubleshooting Guide.

Step 12 Remove the fiber connections between the node being removed and the two neighboring nodes. 

Step 13 Reconnect the fiber of the two neighboring nodes directly, west port to east port. For example in 
Figure 14-4, the east port of Node 3 (Slot 12) connects to the west port of Node 1 (Slot 5).

Step 14 If you do not plan to add the removed node to a BLSR in the future, complete the “DLP-A196 Delete a 
BLSR from a Single Node” task on page 14-14. If you will add the node to a BLSR in the future, go to 
Step 15.
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Step 15 If you delete a node that was in a login node group, you will see incomplete circuits for that node in the 
CTC network view. (Although it is no longer part of the ring, the removed node still reports to CTC until 
it is no longer in a login node group.) Delete the node from the login node group:

a. From the CTC Edit menu, choose Preferences.

b. On the Preferences dialog box, click the Login Node Groups tab.

c. Click the login node group tab containing the node you want to remove. 

d. Click the node you want to remove, then click Remove.

e. Click OK.

Step 16 Click the History tab. Verify that the BLSR_RESYNC condition is displayed for every node in the 
BLSR.

Step 17 Complete the “DLP-A194 Clear a BLSR Force Switch - Ring” task on page 14-9 to remove the Force 
protection switches. 

Step 18 Complete the “DLP-A195 Verify Timing in a Reduced Ring” task on page 14-13.

Step 19 (Optional) Complete the “NTP-A175 Two-Fiber BLSR Acceptance Test” procedure on page 5-20.

 Stop. You have completed this procedure.

DLP-A304 Verify Pass-Through Circuits

Step 1 On the CTC Circuits window, choose a circuit that passes through the BLSR or path protection 
configuration node that will be removed and click Edit.

Step 2 In the Edit Circuits window, check Show Detailed Map.

Step 3 Verify that the STS andVT mapping on the node’s east and west ports are the same. For example, if a 
circuit mapping on the west port s5/p1/S1 (Slot 5, Port 1, STS 1), verify that the mapping is STS 1 on 
the east port. If the circuit displays different STSs and/or VTs on the east and west ports, write down the 
name of the circuit. Figure 14-5 shows a circuit passing through a node (doc-124) on the same STS 
(STS 2).

Purpose Use this task to verify that circuits passing through a node that will be 
removed from a BLSR or path protection configuration enter and exit the 
node on the same STS and/or VT. 

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 14-5 Verifying Pass-Through STSs 

Step 4 Repeat Steps 1 to 3 for each circuit displayed in the Circuits tab.

Step 5 Delete and recreate each circuit recorded in Step 3 that entered/exited the node on different STSs. To 
delete the circuit, see the “NTP-A152 Delete Circuits” procedure on page 9-16. To create the circuit, see 
Chapter 6, “Create Circuits and VT Tunnels.”

Step 6 Return to your originating procedure (NTP).

DLP-A195 Verify Timing in a Reduced Ring

Step 1 Click the Provisioning > Timing tabs. 

Step 2 Observe the Timing Mode field to see the type of timing (Line, External, Mixed) that has been set for 
that node.

Step 3 Scroll down to the Reference Lists and observe the NE Reference fields to see the timing references 
provisioned for that node.

Step 4 If the removed node was the only BITS timing source, perform the following:

a. Look for another node on the ring that can be used as a BITS source and set that node’s Timing Mode 
to External. Choose that node as the primary timing source for all other nodes in the ring. See the 
“DLP-A157 Change the Node Timing Source” task on page 10-19.

b. If no node in the reduced ring can be used as a BITS source, choose one node to be your internal 
timing source. Set that node’s Timing Mode to External, set the BITS 1 and 2 State to OOS, and 
set the NE Reference to Internal. Then, choose line timing for all other nodes in the ring. This forces 
the first node to be their primary timing source. (See the “DLP-A157 Change the Node Timing 
Source” task on page 10-19.)

Note This type of timing conforms to Stratum 3 requirements and is not considered optimal.

Purpose Use this task to verify timing in the ring where you removed a node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite/remote

Security Level Provisioning or higher
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Step 5 If the removed node was not the only BITS timing source, provision the adjacent nodes to line timing 
using SONET links (east and west) as timing sources, traceable to the node with external BITS timing. 
See the “NTP-A28 Set Up Timing” procedure on page 4-21.

Step 6 Return to your originating procedure (NTP).

DLP-A196 Delete a BLSR from a Single Node

Step 1 In node view, display the node that was removed from the BLSR.

Step 2 Click the Provisioning > BLSR tabs.

Step 3 Highlight the ring and click Delete.

Step 4 In the Suggestion dialog box, click OK.

Step 5 In the confirmation message, confirm that this is the ring you want to delete. If so, click Yes.

Step 6 Return to your originating procedure (NTP).

NTP-A105 Add a Path Protection Configuration Node

Step 1 Verify the card installation on the new node. See the “NTP-A24 Verify Card Installation” procedure on 
page 4-2. Check that the OC-N cards that will serve as the path protection configuration trunk (span) 
cards match the path protection configuration optical rate of the trunk cards to which the new node will 
be connected. For example, if the adjacent nodes have OC-48 trunk cards, the new node must have 

Purpose Use this task to delete a BLSR from a node after you remove the node from 
the BLSR.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this procedure to add a node to a path protection configuration.

Tools/Equipment None

Prerequisite Procedures Cards must be installed and node turn-up procedures completed on the 
node that will be added to the path protection configuration. See Chapter 2, 
“Install Cards and Fiber-Optic Cable,” and Chapter 4, “Turn Up Node.”

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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OC-48 cards installed. If the OC-N cards are not installed or the rate does not match the rate of the 
adjacent node trunk cards, complete the “NTP-A16 Install the Optical Cards” procedure on page 2-13 to 
install them.

Step 2 Verify that fiber is available to connect the new node to the existing nodes. 

Step 3 Complete the “NTP-A35 Verify Node Turn Up” procedure on page 5-2.

Step 4 Log into a node in the path protection configuration where you want to add a node. See the “DLP-A60 
Log into CTC” task on page 3-23 for instructions. In order to have CTC visibility to the new node after 
it is added, you must be an authorized user on the node and you must have IP connectivity to the node.

Step 5 Check to see if the new node IP address is on the same subnet as other nodes in the network. If two or 
more PCs are directly connected to different nodes that belong to the same subnet and Craft Access Only 
is not checked under Gateway Settings, add static routes on the gateway ONS 15454 nodes, using the 
following settings:

• Destination IP address: Local PC IP address

• Net Mask: 255.255.255.255

• Next Hop: IP address of the Cisco ONS 15454

• Cost: 1

See the “DLP-A65 Create a Static Route” task on page 4-14. To view Gateway Settings, see the 
“DLP-A249 Provision IP Settings” task on page 4-9.

Step 6 Complete the “DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions” task 
on page 14-6 to verify that the path protection configuration is free of major alarms or problems. If 
trouble is indicated (for example, a major alarm exists), resolve the problem before proceeding. See 
Chapter 7, “Manage Alarms” or, if necessary, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 7 Log into the new node:

• If the node has a LAN connection and is displayed on the network map, from the View menu, choose 
Go to Other Node, then enter the new node. 

• If the new node is not connected to the network, log into it using the “DLP-A60 Log into CTC” task 
on page 3-23.

Step 8 Click the Alarms tab. Verify that no critical or major alarms are present, nor any facility alarms, such as 
LOS, LOF, AIS-L, SF, and SD. If trouble is indicated (for example, a major alarm exists), resolve the 
problem before proceeding. See Chapter 7, “Manage Alarms,” or, if necessary, refer to the 
Cisco ONS 15454 Troubleshooting Guide.

Step 9 (Optional) Create test circuits, making sure they pass through the path protection configuration trunk 
cards, and run test traffic through the node to ensure that the cards are functioning properly. See the 
“NTP-A189 Create a Manually Routed Optical Circuit” procedure on page 6-47 and the “NTP-A62 Test 
Optical Circuits” procedure on page 6-55 for information.

Step 10 Create the DCC terminations on the new node. See the “DLP-A253 Provision SONET DCC 
Terminations” task on page 5-5. 

Step 11 From the View menu, choose Go to Network View.

Step 12 Complete the “DLP-A197 Initiate a Path Protection Configuration Force Switch” task on page 14-18 to 
switch traffic away from the span that will be broken to connect to the new node.

Caution Traffic is not protected during a protection switch.
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Step 13 Two nodes will connect directly to the new node; remove their fiber connections:

a. Remove the east fiber connection from the node that will connect to the west port of the new node.

b. Remove the west fiber connection from the node that will connect to the east port of the new node.

Step 14 Replace the removed fibers with the fibers that are connected to the new node.

Step 15 Log out of CTC and log back into a node in the network.

Step 16 From the View menu, choose Go to Network View to display the path protection configuration nodes. 
The new node should appear in the network map. Wait for a few minutes to allow all the nodes to appear.

Step 17 Click the Circuits tab and wait for all the circuits to appear, including spans. Count the number of 
incomplete circuits.

Step 18 In the network view, right-click the new node and choose Update Circuits With New Node from the 
list of options. Wait for the confirmation dialog box to appear. Verify that the number of updated circuits 
displayed in the dialog box is correct.

Step 19 Click the Circuits tab and verify that no incomplete circuits are displayed.

Step 20 Use the “DLP-A198 Clear a Path Protection Configuration Force Switch” task on page 14-19 to clear 
the protection switch.

Step 21 (Optional) Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33.

 Stop. You have completed this procedure.

NTP-A106 Remove a Path Protection Configuration Node

Caution The following procedure minimizes traffic outages during node removals. 

Caution If you remove a node that is the only BITS timing source for the ring, you also remove the only source 
of synchronization for all the nodes in that ring. Circuits that connect to other networks which are 
synchronized to a Stratum 1 clock will experience a high level of pointer adjustments, which might 
adversely affect customer service. 

Step 1 Draw a diagram of the path protection configuration where you will remove the node. In the diagram, 
identify the following:

• The node that is connected through its west port to the node that will be removed. 

• The node that is connected through its east port to the node that will be removed. 

Purpose Use this procedure to remove a node from a path protection configuration.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 2 Log into a node in the network where you want to remove a path protection configuration node. See the 
“DLP-A60 Log into CTC” task on page 3-23 for instructions.

Step 3 Complete the “DLP-A302 Check BLSR or Path Protection Configuration Alarms and Conditions” task 
on page 14-6 to verify that the path protection configuration is free of alarms. If trouble is indicated (for 
example, a major alarm exists), resolve the problem before proceeding. See Chapter 7, “Manage 
Alarms” or, if necessary, refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 4 Complete the “NTP-A152 Delete Circuits” procedure on page 9-16 for circuits that originate or 
terminate in the node you will remove. (If a circuit has multiple drops, delete only the drops that 
terminate on the node you are deleting.

Step 5 Complete the “DLP-A304 Verify Pass-Through Circuits” task on page 14-12 to verify that circuits 
passing through the target node enter and exit the node on the same STS and/or VT.

Step 6 Complete the “DLP-A197 Initiate a Path Protection Configuration Force Switch” task on page 14-18 for 
all spans connected to the node you are removing.

Caution Traffic is not protected during a forced protection switch.

Step 7 Remove all fiber connections between the node being removed and the two neighboring nodes. 

Step 8 Reconnect the fiber of the two neighboring nodes directly, west port to east port.

Note If you delete a node that was in a login node group, you will see incomplete circuits for that node 
in CTC network view. (Although it is no longer part of the ring, the removed node still reports 
to CTC until it is no longer in a login node group.

Step 9 Exit CTC and log back in. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions.

Step 10 Log into each newly-connected node and click the Alarms tab. Verify that the span cards are free of 
alarms. Resolve any alarms before proceeding. Refer to the Cisco ONS 15454 Troubleshooting Guide.

Step 11 Complete the “DLP-A195 Verify Timing in a Reduced Ring” task on page 14-13.

Step 12 Complete the “DLP-A198 Clear a Path Protection Configuration Force Switch” task on page 14-19 to 
clear the protection switch.

Step 13 Click the Circuits tab and verify that no incomplete circuits are displayed.

Step 14 (Optional) Complete the “NTP-A177 Path Protection Acceptance Test” procedure on page 5-33.

 Stop. You have completed this procedure.
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DLP-A197 Initiate a Path Protection Configuration Force Switch

Caution The Force Switch Away command overrides normal protective switching mechanisms. Applying this 
command incorrectly can cause traffic outages.

Caution Traffic is not protected during a Force protection switch.

Step 1 From the View menu in the node view, choose Go to Network View.

Step 2 Right-click the span where you want to switch path protection configuration traffic away. Choose 
Circuits from the shortcut menu.

Step 3 In the Circuits on Span dialog box, choose FORCE SWITCH AWAY. Click Apply.

Step 4 In the Confirm UPSR Switch dialog box, click Yes.

Step 5 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span window, the Switch State for all circuits is Force. Figure 14-6 shows an example.

Purpose Use this task to switch all circuits on a path protection configuration span 
to another span.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 14-6 Circuits on Span Dialog Box with a Force Switch

Note A Force switch request on a span or card causes CTC to raise a FORCED-REQ condition. The 
condition clears when you clear the Force switch. 

Step 6 Return to your originating procedure (NTP).

DLP-A198 Clear a Path Protection Configuration Force Switch 

Step 1 From the View menu on node view, choose Go to Network View.

Step 2 Right-click the span where you want to clear the switch. Choose Circuits from the shortcut menu.

Step 3 In the Circuits on Span dialog box, choose CLEAR to remove the Force switch. Click Apply.

Step 4 In the Confirm UPSR Switch dialog box, click Yes.

Step 5 In the Protection Switch Result dialog box, click OK.

In the Circuits on Span window, the Switch State for all path protection configuration circuits is CLEAR.

Purpose Use this task to clear a Path Protection Configuration Force switch.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Return to your originating procedure (NTP).
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Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 Troubleshooting Guide as necessary. This section lists the 
chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-A107 Inspect and Maintain the Air Filter, page 15-2—Complete as needed.

2. NTP-A108 Back Up the Database, page 15-8—Complete as needed.

3. NTP-A109 Restore the Database, page 15-9—Complete as needed.

4. NTP-A163 Restore the Node to Factory Configuration, page 15-12—Complete as needed to clear 
the database and upload a blank database and the latest software.

5. NTP-A214 Offload the Security Audit Trail Log, page 15-17—Complete as needed.

6. NTP-A110 Inhibit Protection Switching, page 15-18—Complete as needed.

7. NTP-A111 Revert to an Earlier Software Load, page 15-21—Complete as needed

8. NTP-A112 Clean Fiber Connectors, page 15-23—Complete as needed.

9. NTP-A113 Reset the TCC+/TCC2 Card Using CTC, page 15-26—Complete this procedure as 
needed to reset the TCC2 card and switch the node to the redundant TCC2.

10. NTP-A215 View Ethernet Maintenance Information, page 15-27—Complete this procedure as 
needed to view the Ethernet card maintenance information.

11. NTP-A218 Change the Node Timing Reference, page 15-30—Complete this procedure as needed to 
switch the node timing reference to perform maintenance or return to normal timing operation.
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NTP-A107 Inspect and Maintain the Air Filter

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Note Although the filter can work if it is installed with either side facing up, Cisco recommends that you 
install it with the metal bracing facing up to preserve the surface of the filter. 

Step 1 To maintain the reusable air filter, complete the “DLP-A199 Inspect, Clean, and Replace the Reusable 
Air Filter” task on page 15-2.

Step 2 To maintain the disposable air filter, complete the “DLP-A200 Inspect and Replace the Disposable Air 
Filter” task on page 15-5.

Stop. You have completed this procedure.

DLP-A199 Inspect, Clean, and Replace the Reusable Air Filter

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Step 1 Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell, 
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later 
versions of the ONS 15454 use a reusable air filter. 

Purpose This procedure explains how to inspect and maintain reusable and 
disposable fan tray air filters.

Tools/Equipment Spare air filters

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task ensures that the air filter is free from dirt and dust, which 
allows optimum air flow and prevents dirt and dust from entering the 
shelf.

Tools/Equipment Vacuum or detergent and water faucet, spare filter, pinned hex key tool

Prerequisite Procedures None

Required/As Needed Inspection required every 30 days. Clean as needed.

Onsite/Remote Onsite

Security Level None
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NTP-A107 Inspect and Maintain the Air Filter
Step 2 If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being 
careful not to dislodge any dust that may have collected on the filter and proceed to Step 9. Figure 15-1 
illustrates a reusable fan-tray air filter in an external filter bracket. 

Step 3 If the filter is installed below the fan tray and not in the external filter brackets, open the front door of 
the shelf assembly. If the front door is already open, proceed to Step 4.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 4 Remove the front door (optional). If you do not want to remove the door or it is already removed, proceed 
to Step 5:

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Figure 15-1 Reusable Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Step 5 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 6 Pull the handles and slide the fan-tray assembly one inch out of the shelf assembly and wait until the 
fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 8 Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that may have 
collected on the filter.

Step 9 Visually inspect the air filter material for dirt and dust.

FAN FAIL
CRIT

MAJ
MIN
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7

Fan tray filter
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NTP-A107 Inspect and Maintain the Air Filter
Step 10 If the reusable air filter contains a concentration of dirt and dust, replace the dirty air filter with a clean 
air filter (spare filters should be kept in stock) and re-insert the fan-tray assembly. Then, vacuum or wash 
the dirty air filter under a faucet with a light detergent. 

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive 
heat can damage the ONS 15454 cards.

Note Cleaning should take place outside the operating environment to avoid releasing dirt and dust 
near the equipment.

Step 11 If you washed the filter, allow it to completely air dry for at least eight hours.

Warning Do not put a damp filter back in the ONS 15454.

Step 12 Replace the clean filter:

a. If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back 
of the brackets to complete the procedure.

b. If the filter is installed below the fan-tray assembly, remove the fan-tray assembly and slide the 
dry/clean air filter into the recessed compartment at the bottom of the shelf assembly. Put the front 
edge of the air filter flush against the front edge of the recessed compartment. Push the fan tray back 
into the shelf assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out 
and readjust the position of the reusable filter until the fan tray fits correctly.

Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly 
inserted. 

Step 13 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information.

Step 14 Rotate the retractable handles back into their compartments.

Step 15 If you replace the door, also reattach the ground strap.

Step 16 Close and lock the door.

Step 17 Return to your originating procedure (NTP).
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DLP-A200 Inspect and Replace the Disposable Air Filter

Note The disposable air filter is installed below the fan-tray assembly only, so you must remove the fan-tray 
assembly to inspect and replace the disposable air filter. 

Step 1 Verify that you are replacing a disposable air filter. The disposable filter is made of spun white polyester 
that is flame retardant. NEBS 3E and earlier versions of the ONS 15454 use a disposable air filter.

Step 2 Open the front door of the shelf assembly. If the front door is already open, proceed to Step 4.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 3 Remove the front door (optional). If the door is already removed or you do not want to remove it, Step 4:

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step 4 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 5 Pull the handles and slide the fan-tray assembly one inch out of the shelf assembly and wait until the 
fans stop. 

Step 6 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly 
(Figure 15-2).

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive 
heat can damage the ONS 15454 cards.

Purpose This task ensures that the air filter is free from dirt and dust to allow 
optimum air flow and prevent dirt and dust from entering the ONS 
15454.

Tools/Equipment Extra filters, pinned hex key

Prerequisite Procedures None

Required/As Needed Inspection required every 30 days. Replace as needed.

Onsite/Remote Onsite

Security Level None
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NTP-A107 Inspect and Maintain the Air Filter
Figure 15-2 Inserting or Removing the Fan-Tray Assembly (Front Door Removed)

Step 7 Gently remove the air filter from the shelf assembly (Figure 15-3). Be careful not to dislodge any dust 
that may have collected on the filter.

Step 8 Visually inspect the white filter material for dirt and dust. 

Step 9 If the air filter shows a heavy concentration of dirt and dust, replace it with a new filter by sliding the 
new filter into the bottom of the shelf assembly. Make sure that the front of the filter is flush with the 
front of the shelf assembly and that the air flow indicators on the filter point upwards.

Fan tray filter

Fan tray
assembly Small engraved

direction arrow
71

52
7
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NTP-A107 Inspect and Maintain the Air Filter
Figure 15-3 Inserting or Removing a Disposable Fan-Tray Air Filter (Front Door Removed)

Step 10 Slide the fan-tray assembly into the shelf assembly until the electrical plug at the rear of the tray plugs 
into the corresponding receptacle on the backplane.

Step 11 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information. 

Step 12 Rotate the retractable handles back into their compartments.

Step 13 If you replace the door, also reattach the group strap.

Step 14 Close and lock the door.

Step 15 Return to your originating procedure (NTP).

34
51

1

Fan tray filter
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NTP-A108 Back Up the Database

Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are not backed up and restored: node name, IP address,subnet mask and 
gateway, and IIOP port. If you change the node name and then restore a backed up database with a 
different node name, the circuits map to the new node name. Cisco recommends keeping a record of the 
old and new node names.

Step 1 Log into the node where you are performing the database backup. See the “DLP-A60 Log into CTC” 
task on page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 In node (default) view, click the Maintenance > Database tabs (Figure 15-4).

Purpose This procedure stores a backup version of the TCC+/TCC2 (software) 
database on the workstation running CTC or on a network server.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required. Cisco recommends performing a database backup at 
approximately weekly intervals and prior to and after configuration 
changes.

Onsite/Remote Onsite or remote

Security Level Superuser
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Figure 15-4 Backing up the TCC2 Database

Step 3 Click Backup.

Step 4 Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name 
with the .db file extension; for example, database.db.

Step 5 Click Save.

Step 6 Click OK in the confirmation dialog box.

Stop. You have completed this procedure.

NTP-A109 Restore the Database

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and IIOP port. If you change the node name and then restore a backed up database with a 
different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of 
the old and new node names.

Purpose This procedure restores the TCC+/TCC2 software database.

Tools/Equipment None

Prerequisite Procedures NTP-A108 Back Up the Database, page 15-8

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Caution E1000-2 cards lose traffic for approximately 90 seconds when an ONS 15454 database is restored. 
Traffic is lost during the period of spanning tree reconvergence. The CARLOSS alarm appears and clears 
during this period. 

Caution If you are restoring the database on multiple nodes, wait until the TCC2 reboot has completed on each 
node before proceeding to the next node.

Step 1 Log into the node where you are restoring the database. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 Ensure that there are no ring or span (four-fiber only) switch events; for example, ring-switch east or 
west, and span-switch east or west. In network view, click the Conditions tab and click Retrieve 
Conditions to view a list of conditions.

Step 3 If there are switch events that need to be cleared, in node view click the Maintenance > BLSR tabs and 
view the West Switch and East Switch columns. 

a. If there is a switch event (not caused by a line failure), clear the switch by choosing CLEAR from 
the drop-down menu and click Apply. 

b. If there is a switch event caused by the Wait to Restore (WTR) condition, choose LOCKOUT SPAN 
from the drop-down menu and click Apply. When the LOCKOUT SPAN is applied, choose CLEAR 
from the drop-down menu and click Apply.

Step 4 In node view, click the Maintenance > Database tabs (Figure 15-5).

Figure 15-5 Restoring the TCC2 Database

Step 5 Click Restore.
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NTP-A109 Restore the Database
Step 6 Locate the database file stored on the workstation hard drive or on network storage. 

Note To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 
software CD.

Step 7 Click the database file to highlight it. 

Step 8 Click Open. The DB Restore dialog box appears. Opening a restore file from another node or from an 
earlier backup may affect traffic on the login node (Figure 15-6).

Figure 15-6 Restoring the Database—Traffic Loss Warning

Step 9 Click Yes.

The Restore Database dialog box monitors the file transfer (Figure 15-7).

Figure 15-7 Restoring the Database – In-Process Notification

Step 10 Wait for the file to complete the transfer to the TCC2.

Step 11 Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for 
the node to reconnect.

Step 12 If you cleared a switch in Step 3, reapply the switch as needed.

Stop. You have completed this procedure.
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NTP-A163 Restore the Node to Factory Configuration

Caution If you are restoring the database on multiple nodes, wait until the TCC2 cards have rebooted on each 
node before proceeding to the next node.

Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinit tool chooses the first product-specific software package in the specified directory if you only 
use the Search Path field. You may accidentally copy an incorrect database if multiple databases are kept 
in the specified directory.

Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1 If you need to install or replace one or more TCC2 cards, see the “DLP-A36 Install the TCC+/TCC2 
Cards” task on page 2-7.

Step 2 If you are using Microsoft Windows, complete the “DLP-A244 Use the Reinitialization Tool to Clear the 
Database and Upload Software (Windows)” task on page 15-13.

Step 3 If you are using UNIX, complete the “DLP-A245 Use the Reinitialization Tool to Clear the Database 
and Upload Software (UNIX)” task on page 15-15.

Stop. You have completed this procedure.

Purpose Use this procedure to clear the TCC2 database and restore customer or 
factory defaults. This process involves uploading the most recent 
software package and a blank database. This process is performed by the 
RE-INIT.jar utility, also called the reinitialization (reinit) tool. 

Tools/Equipment Software CD containing Software Release 3.4 or later, the node NE 
defaults, and the reinitialization tool. JRE 1.03_02 must also be installed 
on the computer you use to perform this procedure.

Prerequisite Procedures NTP-A108 Back Up the Database, page 15-8

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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DLP-A244 Use the Reinitialization Tool to Clear the Database and Upload 
Software (Windows)

Note The TCC2 cards reboot several times during this procedure. Wait until they are completely rebooted 
before continuing.

Step 1 Insert the system software CD containing the reinit tool, software, and defaults database into the local 
craft interface PC drive. If the CTC Installation Wizard opens, click Cancel.

Step 2 To find the recovery tool file, go to Start > Run > Browse and select the CD drive.

Step 3 On the CD drive, go to the CISCO15454 folder and choose All Files from the Files of Type drop-down 
menu. 

Step 4 Select the RE-INIT.jar file and click Open to open the reinit tool (Figure 15-8).

Figure 15-8 Reinitialization Tool in Windows

Step 5 If the node you are reinitializing is an external network element (ENE) in a proxy server network, enter 
the IP address of the gateway network element (GNE) in the GNE IP field. If not, leave it blank.

Step 6 Enter the node name or IP address of the node you are reinitializing in the Node IP field (Figure 15-8 on 
page 15-13).

Purpose This procedure describes how to use the reinitialization tool in 
Windows. Use this tool to clear the database on the TCC2, upload 
software, and restore factory or customer defaults.

Tools/Equipment Software CD containing Release 3.4 software, the NE defaults, and the 
reinitialization tool

Straight-through (CAT-5) LAN cable

JRE 1.03_02 must be installed on your PC

Prerequisite Procedures NTP-A108 Back Up the Database, page 15-8

Required/As Needed As needed to clear the existing database from a TCC2 and restore the 
node default settings.

Onsite/Remote Onsite

Security Level Superuser
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Step 7 Verify that the Re-Init Database, Upload Package, and Confirm checkboxes are checked. If one is not 
checked, click the checkbox.

Step 8 In the Search Path field, verify that the path to the CISCO15454 folder on the CD drive is listed.

Caution Cisco strongly recommends that you keep different node databases in separate folders. This 
is because the reinit tool chooses the first product-specific software package in the specified 
directory if you use the Search Path field instead of the Package and Database fields. You may 
accidentally copy an incorrect database if multiple databases are kept in the specified 
directory.

Caution Before you perform the next step, be sure you are uploading the correct database. You cannot 
reverse the upload process after you click Yes.

Step 9 Click Go. 

Step 10 A confirmation dialog box opens (Figure 15-9). Click Yes. 

Step 11 The status bar at the bottom of the screen displays Complete when the node has activated the software 
and uploaded the database. 

Note The Complete message only indicates that the TCC2 successfully uploaded the database, not that 
the database restore was successful. The TCC2 then tries to restore the database after it reboots.

Step 12 If you are logged into CTC, close the browser window and disconnect the straight-through LAN cable 
from the RJ-45 (LAN) port on the TCC2 or on the hub or switch to which the ONS 15454 is physically 
connected. Reconnect your straight-through LAN cable to the LAN port and log back into CTC. See the 
“NTP-A22 Set Up CTC Computer to Connect to the ONS 15454” procedure on page 3-8.

Step 13 Manually set the node name and network configuration to site-specific values. See the “NTP-A25 Set 
Up Name, Date, Time, and Contact Information” procedure on page 4-6 and “NTP-A169 Set Up CTC 
Network Access” procedure on page 4-8 for information on setting the node name, IP address, mask and 
gateway, and IIOP port.

Figure 15-9 Confirming NE Restoration

Step 14 Return to your originating procedure (NTP).
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DLP-A245 Use the Reinitialization Tool to Clear the Database and Upload 
Software (UNIX)

Note The TCC2 cards reboot several times during this procedure. Wait until they are completely rebooted 
before continuing.

Step 1 Insert the system software CD containing the reinit tool, software, and defaults database into the local 
craft interface PC drive. If the CTC Installation Wizard opens, click Cancel.

Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually 
/cdrom/cdrom0/CISCO15454).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file to open the reinit tool (Figure 15-10). 
If you are working with a command line interface, run java -jar RE-INIT.jar.

Figure 15-10 The Reinitialization Tool in UNIX

Step 4 If the node you are reinitializing is an external network element (ENE) in a proxy server network, enter 
the IP address of the gateway network element (GNE) in the GNE IP field. If not, leave it blank.

Step 5 Enter the node name or IP address of the node you are reinitializing in the Node IP field (Figure 15-10 
on page 15-15).

Purpose This procedure describes how to use the reinitialization tool in a UNIX 
environment. Use this tool to clear the database on the TCC2 and restore 
factory or customer defaults.

Tools/Equipment Software CD containing Software R3.4 software, the node NE defaults, 
and the reinitialization tool.

JRE 1.03_02 must also be installed on the computer you use to perform 
this procedure.

Prerequisite Procedures NTP-A108 Back Up the Database, page 15-8

Required/As Needed As needed to clear the existing database from a TCC2 and restore the 
node’s default settings.

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 6 Verify that the Re-Init Database, Upload Package, and Confirm checkboxes are checked. If one is not 
checked, click the checkbox.

Step 7 In the Search Path field, verify that the path to the CISCO15454 folder on the CD drive is listed.

Caution Cisco strongly recommends that you keep different node databases in separate folders. This 
is because the reinit tool chooses the first product-specific software package in the specified 
directory if you use the Search Path field instead of the Package and Database fields. You may 
accidentally copy an incorrect database if multiple databases are kept in the specified 
directory.

Caution Before you perform the next step, be sure you are uploading the correct database. You cannot 
reverse the upload process after you click Yes.

Step 8 Click Go. 

Step 9 A confirmation dialog box opens (Figure 15-9). Click Yes.

Step 10 The status bar at the bottom of the screen displays Complete when the node has activated the software 
and uploaded the database. 

Note The Complete message only indicates that the TCC2 successfully uploaded the database, not that 
the database restore was successful. The TCC2 then tries to restore the database after it reboots.

Step 11 If you are logged into CTC, close the browser window and disconnect the straight-through LAN cable 
from the RJ-45 (LAN) port on the TCC2 or on the hub or switch where the ONS 15454 is physically 
connected. Reconnect your straight-through LAN cable to the LAN port and log back into CTC. See the 
“DLP-A53 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454” task on page 3-17.

Step 12 Set the node name and network configuration to site-specific values. See the “NTP-A81 Change Node 
Management Information” procedure on page 10-2 and the “NTP-A201 Change CTC Network Access” 
procedure on page 10-4 for information on provisioning the node name, IP address, subnet mask and 
gateway, and IIOP port.

Step 13 Return to your originating procedure (NTP).
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NTP-A214 Offload the Security Audit Trail Log

Step 1 Log into the node where you are offloading the audit tail log. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog, navigate to the directory (local or network) where you want to save 
the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save.

The 650 entries are saved in this file. The next entries continue with the next number in the sequence, 
rather than starting over.

Stop. You have completed this procedure.

Purpose This procedure stores up to 650 audit trail log entries in a local or 
network drive file to maintain a record of actions performed for the 
node.If the audit trail log is not offloaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-A110 Inhibit Protection Switching

Step 1 Log into the node where you are offloading the audit tail log. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 To prevent traffic on a working or protect card from switching to the other card in the pair, complete the 
“DLP-A201 Apply a Lock On” task on page 15-19. 

Step 3 To prevent traffic from switching to the protect card, complete the “DLP-A202 Apply a Lock Out” task 
on page 15-20. 

Note A combination of Lock On and Lock Out is allowed in 1:1 and 1:N protection; for example, a 
Lock On on the working card and a Lock Out on the protect card is permissible.

Step 4 To remove a lock on or lock out and return a protection group to its usual switching method, complete 
the “DLP-A203 Clear a Lock On or Lock Out” task on page 15-21.

Note A non-alarmed event (INHSW) is raised when a card is placed in a Lock On or Lock Out state.

Stop. You have completed this procedure.

Purpose This procedure describes how to apply and remove a lock on or lock out 
to a traffic card in a linear protection configuration. For BLSR span 
lockouts, see the “DLP-A299 Initiate a BLSR Span Lockout” task on 
page 12-3 and the “DLP-A300 Clear a BLSR Span Lockout” task on 
page 12-4.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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DLP-A201 Apply a Lock On

Note To apply a Lock On to a protect card in a 1:1 or 1:N protection group, the protect card must be active. If 
the protect card is in standby, the Lock On button is disabled. To make the protect card active, you must 
switch traffic from the working card to the protect card (Step 4). When the protect card is active, you can 
apply the Lock On.

Step 1 Use the following rules to determine if you can apply a lock on:

• For a 1:1 electrical protection group, both the working and protect cards can be placed in the Lock 
On state.

• For a 1:N electrical protection group, both the working and protect cards can be placed in the Lock 
On state.

• For a 1+1 optical protection group, only the working card can be placed in the Lock On state.

Step 2 In node (default) view, click the Maintenance > Protection tabs.

Step 3 In the Protection Groups list, click the protection group where you want to apply a lock on.

Step 4 If you determine that the protect card is in standby and you want to apply the lock on to the protect card, 
make the protect card active:

a. Under Selected Group, click the protect card.

b. Under switch Commands, click Switch.

Step 5 Under Selected Group, click the active card where you want to lock traffic.

Step 6 From Inhibit Switching, click Lock On.

Step 7 Click Yes on the confirmation dialog box.

The Lock On has been applied and traffic cannot be switched to the working card. To clear the Lock On, 
see the “DLP-A203 Clear a Lock On or Lock Out” task on page 15-21.

Step 8 Return to your originating procedure (NTP).

Purpose This task prevents traffic from being switched from one card to another.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance
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NTP-A110 Inhibit Protection Switching
DLP-A202 Apply a Lock Out

Note Multiple Lock Outs in the same protection group are not allowed.

Step 1 Use the following rules to determine if you can put the intended card in a Lock Out state:

• For a 1:1 electrical protection group, you can apply a l lock out to the working and protect cards.

• For a 1:N electrical protection group,you can apply a lock out to the working and protect cards.

• For a 1+1 optical protection group, you can apply a lock out to the protect card.

Step 2 In node view, click the Maintenance > Protection tabs.

Step 3 In the Protection Groups list, click the protection group that contains the card you want to lock out.

Step 4 Under Selected Group, click the card you want to lock traffic out of.

Step 5 From Inhibit Switching, click Lock Out.

Step 6 Click Yes on the confirmation dialog box.

The lock out has been applied and traffic is switched to the opposite card. To clear the lock out, see the 
“DLP-A203 Clear a Lock On or Lock Out” task on page 15-21.

Note Provisioning a lock out causes a LOCKOUT-REQ or an FE-LOCKOUT condition to be raised 
on CTC. Clearing the lockout switch request clears these conditions.

Step 7 Return to your originating procedure (NTP).

Purpose This task switches traffic from one card to another using a lock out, 
which is a switching mechanism that overrides other manual switching 
connections (Force, Manual, and Exercise).

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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DLP-A203 Clear a Lock On or Lock Out

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the protection group that contains the card you want to clear.

Step 3 Under Selected Group, click the card you want to clear.

Step 4 From Inhibit Switching, click Unlock.

Step 5 Click Yes on the confirmation dialog box.

The Lock On or Lock Out is cleared.

Step 6 Return to your originating procedure (NTP).

NTP-A111 Revert to an Earlier Software Load

Note Reverting to a 2.2.1 or later load switches to the older software load and its attendant database without 
affecting traffic or DCC connectivity. This feature requires dual TCC+/TCC2 cards and CTC Software 
R 2.2.1 or later as the protect version.

Tip The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You 
can revert to the standby software load without losing traffic. When the next maintenance window opens, 
complete the upgrade and activate the new software load.

Purpose This task clears a lock on or lock out.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

DLP-A201 Apply a Lock On, page 15-19 or

DLP-A202 Apply a Lock Out, page 15-20

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance

Purpose This procedure reverts the ONS 15454 database to an earlier software 
load.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote On site or remote

Security Level Superuser
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Note A revert to a maintenance release software load uses the current active database; therefore, no 
provisioning is lost. All other reverts do restore the database. (A maintenance release has a three-digit 
release number, e.g. 2.2.2).

Note Circuits created and provisioning performed after a software load is activated (upgraded to a higher 
software release) does not reinstate with a revert. The database configuration at the time of activation is 
reinstated after a revert. This note does not apply to maintenance reverts (e.g. 2.2.2 to 2.2.1), because 
maintenance releases use the same database.

Step 1 Log into the node where you are offloading the audit tail log. See the “DLP-A60 Log into CTC” task on 
page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 Record the IP address of that node; the IP address is displayed on the left side of the node view window.

Note To find the IP address you can also click the Provisioning > Network > General tabs.

Step 3 If you are reverting to a previous software release (not a maintenance release) record any new circuits 
created since the previous software upgrade because these circuits have to be manually recreated (if 
needed) once the software reversion has taken place.

Step 4 Click the Maintenance > Software tabs.

Step 5 Verify that the protect software is Software R2.2.0 or later. If the protect software is not Software R2.2.0 
or later, do not revert.

Step 6 Click Revert. The Revert button activates the protect software load.

Step 7 Click Yes on the revert confirmation dialog box. The ONS 15454 reboots and loses the connection to 
CTC.

Step 8 Wait until the software upgrade finishes. This may take as long as 30 minutes.

Step 9 When the software upgrade is finished, click the Delete CTC Cache button in the browser window.

Step 10 Completely close the browser.

Step 11 Restart the browser and log back into the node using the IP address recorded in Step 2. See the 
“DLP-A60 Log into CTC” task on page 3-23 as needed.

The browser downloads the CTC applet for the standby software load.

Step 12 If needed, recreate the circuits recorded in Step 3. See Chapter 6, “Create Circuits and VT Tunnels” for 
specific circuit creation procedures.

Stop. You have completed this procedure.
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NTP-A112 Clean Fiber Connectors

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments.

Step 1 Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2 Replace any damaged fiber connectors.

Note Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3 Complete the “DLP-A204 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry 
Wipes” task on page 15-24 as necessary.

Step 4 Complete the “DLP-A205 Clean Fiber Connectors with Cletop” task on page 15-25 as necessary.

Step 5 Complete the “DLP-A206 Clean the Fiber Adapters” task on page 15-25 as necessary. 

Caution Do not reuse the optical swabs. Keep unused swabs off of work surfaces.

Stop. You have completed this procedure.

Purpose This procedure cleans the fiber connectors.

Tools/Equipment Inspection microscope

Compressed air/duster

“Type A” Fiber Optic Connector Cleaner (Cletop reel)

Isopropyl alcohol 70% or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-A204 Scope and Clean Fiber Connectors and Adapters with Alcohol and 
Dry Wipes

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments.

Step 1 Remove the dust cap from the fiber connector.

Step 2 Wipe the connector tip with the pre-moistened alcohol wipe.

Step 3 Blow dry using filtered air.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry lint free wipe and the inside of the dust cap 
using a Cletop stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

Purpose This task cleans the fiber connectors and adapters with alcohol and dry 
wipes.

Tools/Equipment Compressed air/duster

Isopropyl alcohol 70% or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-A205 Clean Fiber Connectors with Cletop

Step 1 Remove the dust cap from the fiber connector.

Step 2 Press the lever down to open the shutter door. Each time you press the lever, you expose a clean wiping 
surface.

Step 3 Insert the connector into the Cletop cleaning cassette slot, rotate one quarter turn, and gently swipe 
downwards.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry lint free wipe and the inside of the dust cap 
using a Cletop stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

DLP-A206 Clean the Fiber Adapters

Step 1 Remove the dust plug from the fiber adapter.

Step 2 Insert a Cletop stick swab (14100400) into the adapter opening and rotate the swab.

Step 3 Place dust plugs on the fiber adapters when not in use.

Step 4 Return to your originating procedure (NTP).

Purpose This task cleans the fiber connectors with Cletop.

Tools/Equipment “Type A” Fiber Optic Connector Cleaner (Cletop reel)

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task cleans the fiber adapters.

Tools/Equipment Cletop stick swab

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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NTP-A113 Reset the TCC+/TCC2 Card Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Note Before you reset the TCC2, you should wait at least 60 seconds after the last provisioning change you 
made to avoid losing any changes to the database.

Note When a software reset is performed on an active TCC2, the AIC card goes through an initialization 
process and also resets. The AIC card reset is normal and happens each time an active TCC2 card goes 
through a software-initiated reset.

Step 1 Log into the node where you are performing the software reset. See the “DLP-A60 Log into CTC” task 
on page 3-23 for instructions. If you are already logged in, proceed to Step 2.

Step 2 In node view, right-click the TCC+/TCC2 card to reveal a drop-down menu.

Step 3 Click Reset Card.

Step 4 Click Yes when the “Are You Sure?” dialog box appears.

Step 5 Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note For LED behavior during a TCC2 reboot, see Table 4-1 on page 4-11.

Step 6 Confirm that the TCC+/TCC2 card LED is amber (standby).

Onsite or RemoteStop. You have completed this procedure.

Purpose This procedure resets the TCC+ or TCC2 card and switches the node to 
the redundant card.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-A215 View Ethernet Maintenance Information

Step 1 Complete the “DLP-A60 Log into CTC” task on page 3-23. If you are already logged in, continue with 
Step 2.

Step 2 As needed, use the following tasks to change the display of Ethernet maintenance information:

• DLP-A305 View J1 Path Trace Information, page 15-27

• DLP-A306 View Loopback Status, page 15-28 

• DLP-A307 View Ethernet Bandwidth Utilization, page 15-28

• DLP-A308 View Ethernet Spanning Tree Parameters, page 15-29

• DLP-A309 View the Ethernet MAC Address Table, page 15-29

• DLP-A310 View Ethernet Trunk Utilization, page 15-30

Stop. You have completed this procedure.

DLP-A305 View J1 Path Trace Information

Step 1 In node view, double-click a G-Series Ethernet card. The card view displays.

Step 2 Click the Maintenance > J1 Path Trace tabs.

Step 3 Click the Retrieve button.

Purpose This procedure enables you to view maintenance information on a 
selected Ethernet card.

Tools/Equipment None

Prerequisite Procedures Before you view PMs, be sure you have created the appropriate circuits 
and provisioned the card according to your specifications. For more 
information, see Chapter 6, “Create Circuits and VT Tunnels” and 
Chapter 11, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task changes the screen view to display J1 path trace information 
on a selected G-Series Ethernet card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Retrieve or higher
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Step 4 View the columns to the right for the J1 Path Trace information for each port on the card.

Step 5 Return to your originating procedure (NTP).

DLP-A306 View Loopback Status

Step 1 In node view, double-click a G-Series Ethernet card. The card view displays.

Step 2 Click the Maintenance > Loopback tabs.

The # and State columns identify the port number and current circuit state (IS, OOS, OOS_MT) of each 
port on the card. The Loopback Type column identifies the type of loopback (None or Terminal) applied 
to each port on the card.

Step 3 Return to your originating procedure (NTP).

DLP-A307 View Ethernet Bandwidth Utilization

Step 1 In node view, double-click a G-Series Ethernet card. The card view displays.

Step 2 Click the Maintenance > Bandwidth tabs.

The current STS bandwidth usage information appears.

Step 3 Return to your originating procedure (NTP).

Purpose This task changes the screen view to display loopback status information 
on a selected G-Series Ethernet card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task changes the screen view to display Ethernet bandwidth 
utilization on a selected G-Series Ethernet card.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-A308 View Ethernet Spanning Tree Parameters

Step 1 In node view, click the Maintenance > Ether Bridge > Spanning Trees tabs.

The current spanning tree information is displayed.

Step 2 Return to your originating procedure (NTP).

DLP-A309 View the Ethernet MAC Address Table

Step 1 In node view, click the Maintenance > Ether Bridge > MAC Table tabs.

Step 2 Select the appropriate E-Series Ethernet card in the Layer 2 Domain field.

Step 3 Click the Retrieve button.

The MAC address table information is displayed.

Step 4 Return to your originating procedure (NTP).

Purpose This task changes the screen view to display the Ethernet Spanning Tree 
parameters for any node with one or more E-Series Ethernet cards 
installed.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Retrieve or higher

Purpose This task displays the Ethernet MAC address table for any node with one 
or more E-Series Ethernet cards installed.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Retrieve or higher
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DLP-A310 View Ethernet Trunk Utilization

Step 1 In node view, click the Maintenance > Ether Bridge > Trunk Utilization tabs.

Step 2 Select the desired time interval in the Interval field.

Step 3 Click the Refresh button.

The trunk utilization information for the current and previous time intervals is displayed.

Step 4 Return to your originating procedure (NTP).

NTP-A218 Change the Node Timing Reference

Step 1 Log into CTC at the node that you want to monitor. See the “DLP-A60 Log into CTC” task on page 3-23 
for instructions. If you are already logged in, proceed to Step 2.

Step 2 Complete the “DLP-A322 Manual or Force Switch the Node Timing Reference” task on page 15-31as 
needed.

Step 3 Complete the “DLP-A323 Clear a Manual or Force Switch on a Node Timing Reference” task on 
page 15-31 as needed.

Stop. You have completed this procedure.

Purpose This task displays the Ethernet Trunk bandwidth usage on any node with 
one or more E-Series Ethernet cards installed.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Retrieve or higher

Purpose This procedure enables switching the node timing reference to enable 
maintenance on a timing reference or returning the node timing to 
normal operation.

Tools/Equipment None

Prerequisite Procedures NTP-A28 Set Up Timing, page 4-21

Required/As Needed As needed

Onsite/Remote Onsite or Remote

Security Level Maintenance or higher
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DLP-A322 Manual or Force Switch the Node Timing Reference

Step 1 In node view, click the Maintenance > Timing tabs. The Timing source window appears.

Step 2 From the Reference drop-down menu for the desired Clock choose the desired reference.

Step 3 From the Operation drop-down menu for the desired Clock choose one of the following options:

• Manual—This operation commands the node to switch to the reference you have selected if the SSM 
quality of the reference is not lower than the current timing reference.

• Force—This operation commands the node to switch to the reference you have selected, regardless 
of the SSM quality (if the reference is valid).

Step 4 Click the Apply button.

Step 5 Click Yes in the confirmation dialog. If the selected timing reference is an acceptable valid reference, 
the node switches to the selected timing reference.

Step 6 If the selected timing reference is invalid, a warning dialog appears. Click OK; the node does not revert 
to the normal timing reference. 

Step 7 Return to your originating procedure (NTP).

DLP-A323 Clear a Manual or Force Switch on a Node Timing Reference

Step 1 In node view, click the Maintenance > Timing tabs. The Timing source window appears.

Step 2 Find the Clock reference that is currently set to Manual or Force in the Operation menu.

Step 3 From the Operation drop-down menu choose the desired Clock and choose Clear.

Step 4 Click the Apply button.

Purpose This task commands the NE to switch to the timing reference you have 
selected if the SSM quality of the requested reference is not less than the 
current reference.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task clears a Manual or Force switch on a node timing reference 
and reverts the timing reference to its provisioned reference.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 5 Click Yes in the confirmation dialog. If the normal timing reference is an acceptable valid reference, the 
node switches back to the normal timing reference as defined by the system configuration.

Step 6 If the normal timing reference is invalid or has failed, a warning dialog appears. Click OK; the timing 
reference does not revert.

Step 7 Return to your originating procedure (NTP).
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Power Down the Node

This chapter explains how to power down a node and stop all node activity on the Cisco ONS 15454.

NTP-A114 Power Down the ONS 15454

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution The following procedure is designed to minimize traffic outages when powering down nodes, but traffic 
will be lost if you delete and recreate circuits that passed through a working node.

Note Always use the supplied ESD wristband when working with the Cisco ONS 15454. Plug the wristband 
into the ESD jack located on the fan-tray assembly or on the lower right outside edge of the shelf on the 
NEBS 3 shelf assembly. To access the ESD plug on the NEBS 3 shelf assembly, open the front door of 
the Cisco ONS 15454. The front door is grounded to prevent electrical shock.

Step 1 Identify the node that you want to power down. If no cards are installed, go to Step 12. If cards are 
installed, log into the node. See the “DLP-A60 Log into CTC” task on page 3-23 for instructions.

Step 2 In network view, verify that the node is not connected to a network.

a. If the node is part of a working network, log out of the node and complete the NTP-A“213 Remove 
a BLSR Node” procedure on page 14-10 or the NTP-A“106 Remove a Path Protection Configuration 
Node” procedure on page 14-16. Continue with Step 3.

Purpose This procedure stops all node activity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As Needed

Onsite/Remote Onsite

Security Level For software steps the provisioning level or higher is required. 
For hardware steps any level is allowed.
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b. If the node is not connected to a working network and the current configurations are no longer 
required, proceed to Step 3.

Note Current configurations will be saved if Steps 3–12 are skipped.

Step 3 In node view, click the Circuits tab and verify that no circuits are displayed, then proceed to Step 4. If 
circuits are displayed, delete all the circuits that originate or terminate in the node, as follows:

a. Click the circuits that need to be deleted and click Delete.

b. Click Yes.

Repeat until no circuits are displayed.

Step 4 In node view, click the Provisioning > Protection tabs and delete all protection groups:

a. Click the protection group that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no protection groups are displayed.

Step 5 In node view, click the Provisioning > SONET DCC tabs and delete all SDCC terminations:

a. Click the SDCC Termination that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no SDCC Terminations are displayed.

Step 6 For each installed card, place all ports in Out of Service status:

a. In card view, click the Provisioning > Line tabs.

b. Click under the Status column for each port and choose Out of Service.

Step 7 Remove all fiber connections to the cards.

Step 8 In node view, right-click an installed card and click Delete.

Step 9 Click Yes.

Step 10 After you have deleted the card, open the card ejectors and remove it from the node. 

Step 11 Repeat Step 6 to 10 for each installed card.

Step 12 Shut off the power from the power supply that feeds the node.

Step 13 Disconnect the node from its external fuse source.

Step 14 Store all the cards you removed and update inventory records according to local site practice.
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CTC Information and Shortcuts

This appendix describes how to navigate in the Cisco Transport Controller (CTC), change CTC table 
data displays, and lists menu and tool options for the Cisco ONS 15454. This appendix also describes 
the shelf inventory data presented in CTC. For information about CTC, refer to the Cisco Transport 
Controller Operation chapter in the Cisco ONS 15454 Reference Manual, R4.0.

Displaying Node, Card, and Network Views
The Cisco Transport Controller provides three views of the ONS 15454 and ONS network:

• Node view appears when you first log into an ONS 15454. This view shows a graphic of the 
ONS 15454 shelf and provides access to tabs and subtabs that you use to manage the node.

• Card view provides access to individual ONS 15454 cards. This view provides a graphic of the card 
and provides access to tabs and subtabs that you use to manage the card.

• Network view shows all the nodes in a ring. A Superuser can set up this feature so each user will see 
the same network view, or the user can create a custom view with maps. This view provides access 
to tabs and subtabs that you use to manage the network.

Table A-1 lists different actions for changing CTC views.

Table A-1 Change CTC Views

To display: Perform one of the following:

Node view • Log into a node; node view is the default view.

• In network view, double-click a node icon, or right-click the node and 
select Open Node from the shortcut menu.

• In network view, single-click a node icon, then select Go to Selected 
Object from the View menu.

• From the CTC View menu, select Go to Other Node, then select the node 
you want from the shortcut menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in network view, click a node, then click the down arrow.
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Manage the CTC Window
Different navigational methods are available within the CTC window to access views and perform 
management actions. You can double-click and right-click objects in the graphic area and move the 
mouse over nodes, cards, and ports to view popup status information (Figure A-1).

Figure A-1 CTC Node View With Popup Information

Network view • In node view, click the up arrow or the Network View tool on the CTC 
toolbar.

• From the View menu, select Go To Network View.

Card view • In node view, double-click a card or right-click the card and select 
Open Card.

• In node view, single-click a card icon, then select Go to Selected Object 
from the View menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in node view, click a card, then click the down arrow.

Table A-1 Change CTC Views (continued)

To display: Perform one of the following:
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CTC Menu and Toolbar Options
The CTC window menu bar and toolbar provide primary CTC functions. Table A-2 shows the actions 
that are available from the CTC menu and toolbar.

Table A-2 CTC Menu and Toolbar Options

Menu Menu Option Toolbar Description

File Add Node Adds a node to the current session. See the “DLP-A62 Add a Node to the Current 
Session or Login Group” task on page 3-26.

Delete Selected 
Node

Deletes a node from the current session. 

Lock CTC Locks CTC without closing the CTC session. A user name and password are 
required to open CTC.

Print Prints CTC data. See the “DLP-A138 Print CTC Data” task on page 7-2.

Export Exports CTC data. See the “DLP-A139 Export CTC Data” task on page 7-4.

Exit Closes the CTC session. 

The exit icon only appears in the File menu.

Edit Preferences Displays the Preferences dialog box:

General tab—Allows you to change event defaults and manage preferences.

Login Node Groups tab—Allows you to create login node groups. See the 
“DLP-A61 Create Login Node Groups” task on page 3-25.

Map—Allows you to customize the network view. See the “DLP-A145 Change 
the Network View Background Color” task on page 10-8 and the “DLP-A268 
Apply a Custom Network View Background Map” task on page 10-10.

Circuit—Allows you to change the color of circuit spans. See the “DLP-A232 
Change Active and Standby Span Color” task on page 9-11.

Firewall—Sets the IIOP listener ports for access to the ONS 15454 through a 
firewall. See the “NTP-A27 Set Up the ONS 15454 for Firewall Access” 
procedure on page 4-18.
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CTC Menu and Toolbar Options
View Go to Previous View Displays the previous CTC view.

Go to Next View Displays the next CTC view. Available only after you navigate to a previous 
view. Go to Previous and Go to Next are similar to forward and backward 
navigation in a web browser.

Go to Parent View References the CTC view hierarchy: network view, node view, and card view. In 
card view, this command displays the node view; in node view, the command 
displays network view. Not available in network view.

Go to Selected 
Object View

Displays the object selected in the CTC window.

Go to Home View Displays the login node in node view.

Go to Network View Displays the network view.

Go to Other Node Displays a dialog box allowing you to type in the node name or IP address of a 
a network node that you want to view. 

Show Status Bar — Click this item to display or hide the status bar at the bottom of the CTC window.

Show Tool Bar — Click this item to display or hide the CTC toolbar.

— — Decreases the size of the map area in network view (toolbar only).

— — Increases the size of the map area in network view (toolbar only).

— — Increases the size of a selected area of the map in network view (toolbar only).

Table A-2 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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CTC Menu and Toolbar Options
Tools Circuits — Displays the following options:

• Repair Circuits—Repairs incomplete circuits following replacement of the 
ONS 15454 AIP board. Refer to the Cisco ONS 15454 Troubleshooting 
Guide for more information.

• Set Path Selector Attributes—Allows you to edit path protection 
configuration circuit path selector attributes. See the “DLP-A233 Edit Path 
Protection configuration Circuit Path Selectors” task on page 9-12.

• Set Circuit State—Allows you to change a circuit state. See the “DLP-A230 
Change a Circuit State” task on page 9-9.

• Convert CTC Circuits to TL1 Cross Connects—If a cross-connect in a 
circuit gets deleted, this menu option allows a user to repair a circuit by 
separating an incomplete CTC circuit into TL1 cross-connects. Then, the 
user can replace the missing cross-connect. See the “NTP-A417 Upgrade 
TL1 Cross-Connects to CTC Circuits” procedure on page 9-15.

• Upgrade TL1 Cross Connects to CTC Circuits—Allows you to convert TL1 
cross-connects to CTC circuits. See the “NTP-A416 Convert a CTC Circuit 
to TL1 Cross-Connects” procedure on page 9-14.

• Roll Circuit—Allows you to reroute live traffic without interrupting service. 

Note This feature requires an ONS 15600 on your network. Refer to the 
Cisco ONS 15600 Procedure Guide.

• Delete Rolls —This feature requires an ONS 15600 on your network. Refer 
to the Cisco ONS 15600 Procedure Guide.

Manage VLANs — Displays a list of VLANs that have been created and allows you to delete or 
create new VLANs. See Chapter 6, “Create Circuits and VT Tunnels.”

Open TL1 
Connection

Displays the TL1 session dialog box so you can create a TL1 session to a 
specific node. Refer to the Cisco ONS 15454 and Cisco ONS 15327 TL1 
Command Guide.

Open IOS 
Connection

Displays the IOS command line interface dialog box if an IOS capable card 
(ML1000-2 or ML100T-12) is installed in the node. Refer to the 
Cisco ONS 15454 SONET/SDH ML-Series Multilayer Ethernet Card Software 
Feature and Configuration Guide.

Help Contents and Index — Displays the online help window.

Manage Help — Displays the versions of online help loaded on your computer.

About CTC — Displays the software version and the nodes in the CTC session.

Table A-2 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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CTC Mouse Options
CTC Mouse Options
In addition to the CTC menu bar and toolbar, you can invoke actions by double-clicking CTC window 
items with your mouse, or by right-clicking an item and selecting actions from shortcut menus. 
Table A-3 lists the CTC window mouse shortcuts.

Table A-3 CTC Window Mouse Shortcuts

Technique Description

Double-click • Node in network view—Displays the node view.

• Card in node view—Displays the card view.

• Alarm/Event—Displays the object that raised the alarm or event.

• Circuits—Displays the Edit Circuit window.

Right-click • Network view graphic area—Displays a menu that you can use to create a 
new domain, change the position and zoom level of the graphic image, save 
the map layout (if you have a Superuser security level), reset the default 
layout of the network view, and set, change, or remove the background 
image and color.

• Node in network view—Displays a menu that you can use to open the node, 
reset the node icon position to the longitude and latitude set on the 
Provisioning > General tab, delete the node, fix the node position for auto 
layout, provision circuits, and update circuits with a new node.

• Span in network view—Displays a menu that you can use to view 
information about the span’s source and destination ports, the protection 
scheme, and the optical or electrical level. You can display the Circuits on 
Spans dialog box, which displays additional span information and allows 
you to perform path protection configuration protection switching. You can 
also perform span upgrades from this menu.

• Card in node view—Displays a menu that you can use to open, delete, reset, 
and change cards. The card that is selected determines the commands that 
are displayed.

• Card in card view—Displays a menu that you can use to reset the card, or 
go to the parent view (node view).

• Empty slot in node view—Displays a menu with cards that you can select 
to preprovision the slot.

Move mouse cursor • Over node in network view—Displays a summary of node alarms and 
provides a warning if the node icon has been moved out of the map range.

• Over span in network view—Displays circuit (node, slot, port) bandwidth 
and protection information.

• Over card in node view—Displays card type and card status.

• Over card port in node view—Displays card name, port state, and alarm 
profile status.

• Over card port in card view—Displays port state, protection status (if 
applicable), and alarm profile status.
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Node View Shortcuts
Node View Shortcuts
Table A-4 shows actions on ONS 15454 cards that you can perform by moving your mouse over the CTC 
window.

Network View Tasks
Right-click the network view graphic area or a node, span, or domain to display shortcut menus. 
Table A-5 lists the actions that are available from the network view.

Table A-4  Node View Card-Related Shortcuts

Action Shortcut

Display card 
information

In node view, move your mouse over cards in the graphic to display tooltips 
with the card type, card present or card provisioned but not present, the highest 
level of alarm (if any), and the alarm profile used by the card.

Open, reset, or delete 
a card

In node view, right-click a card. Select Open to display the card in card view, 
Delete to delete it, or Reset to reset the card.

Preprovision a slot In node view, right-click an empty slot. Select the card type that you want to 
provision the slot from the shortcut menu.

Change a card In node view, right-click an OC-N card or a DS3 card, and select 
Change Card. In the Change Card dialog box, select the card type. Change 
card retains all card provisioning, including DCC terminations, protection, 
circuits, and ring.

Table A-5 Network Management Tasks in Network View

Action Task

Open a node Any of the following:

• Double-click a node icon.

• Right-click a node icon and choose Open Node from the shortcut menu.

• Click a node and choose Go to Selected Object View from the CTC View 
menu.

• From the View menu, choose Go To Other Node. Select a node from the 
Select Node dialog box.

• Double-click a node alarm or event in the Alarms or History tab.

Move a node icon Press the Ctrl key and the left mouse button simultaneously and drag the node 
icon to a new location.

Reset node icon 
position

Right-click a node and choose Reset Node Position from the shortcut menu. 
The node icon moves to the position defined by the longitude and latitude fields 
on the Provisioning > General tab in node view.

Provision a circuit Right-click a node. From the shortcut menu, choose Provision Circuit To and 
select the node where you want to provision the circuit. For circuit creation 
procedures, see Chapter 6, “Create Circuits and VT Tunnels.”
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Table Display Options
Table Display Options
Right-clicking a table column displays a menu. Table A-6 shows table display options, which include 
rearranging or hiding CTC table columns and sorting table columns by primary or secondary keys. 
Figure A-2 shows the table shortcut menu.

Update circuits with 
new node

Right-click a node and choose Update Circuits With New Node from the 
shortcut menu. Use this command when you add a new node and want to pass 
circuits through it.

Display a link end 
point

Right-click a span. From the shortcut menu, select Go To [node/slot/port] for 
the drop port you want to view. CTC displays the card in card view.

Display span 
properties

Do any of the following: 

• Move mouse over a span; the properties appear near the span.

• Click a span; the properties appear in the upper left corner of the window.

• Right-click a span; the properties appear at the top of the shortcut menu.

Perform a UPSR 
protection switch for 
an entire span

Right-click a network span and click Circuits. In the Circuits on Span dialog 
box, switch options are displayed in the UPSR Span Switching field.

Upgrade a span Right-click a span and choose Upgrade Span from the shortcut menu. 

Note For detailed span upgrade information and instructions, see 
Chapter 12, “Upgrade Cards and Spans.”

Table A-5 Network Management Tasks in Network View (continued)

Action Task

Table A-6 Table Display Options

Task Click Right-Click Shortcut Menu

Resize column Left-click while dragging the header 
separator to the right or left.

—

Rearrange column order Left-click while dragging the column 
header to the right or left.

—

Reset column order — Choose Reset Columns 
Order/Visibility.

Hide column — Choose Hide Column.

Show column — Choose Show Column > 
column_name.

Display all hidden 
columns

— Choose Reset Columns 
Order/Visibility.

Sort table (primary) Click a column header; each click 
changes sort order (ascending or 
descending).

Choose Sort Column.

Sort table (secondary 
sorting keys)

Press the Shift key and 
simultaneously click the column 
header.

Choose Sort Column 
(incremental).
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Equipment Inventory
Figure A-2 Table Shortcut Menu

Equipment Inventory
In node view, the Inventory tab (Figure A-3) displays information about the ONS 15454 equipment, 
including:

• Delete Button—After highlighting a card with your mouse, use this button to delete the card from 
node view.

• Reset Button—After highlighting a card with your mouse, use this button to reset the card.

• Location—Identifies where the equipment is installed, either chassis or slot number.

• Eqpt Type—Displays the type of equipment but not the specific card name, for example, OC-12 or 
DS-1.

• Actual Eqpt Type—Displays the actual equipment type, for example, OC12 IR/STM4 SH 1310.

• HW Part #—Displays the hardware part number; this number is printed on the top of the card or 
equipment piece.

• HW Rev—Displays the hardware revision number.

• Serial #—Displays the equipment serial number; this number is unique to each card.

Reset sorting — Choose Reset Sorting.

View table row count — View the number listed next to 
“Row Count,” it is the last item on 
the shortcut menu.

Table A-6 Table Display Options (continued)

Task Click Right-Click Shortcut Menu

83
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0
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Equipment Inventory
• CLEI Code—Displays the Common Language Equipment Identifier code.

• Firmware Rev—Displays the revision number of the software used by the ASIC chip installed on 
the ONS 15454 card.

Figure A-3 Cisco ONS 15454 Hardware Information

83
51

3

Inventory tab
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Shelf Assembly Specifications

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This appendix contains hardware and software specifications for the ONS 15454.

Bandwidth
• Total bandwidth: 240 Gbps

• Data plane bandwidth: 160 Gbps

• SONET plane bandwidth: 80 Gbps

Slot Assignments
• Total card slots: 17

• Multispeed slots [any traffic (optical) card except OC48 IR 1310, OC48 LR/ELR 1550, and all 
OC192 cards]: Slots 1–4, 14–17

• High-speed slots [any traffic (optical) card including OC48 IR 1310, OC48 LR/ELR 1550, and all 
OC192 cards]: Slots 5, 6, 12, 13

• TCC+, TCC2 (Timing Communication and Control): Slots 7, 11

• XC/XCVT/XC10G (Cross Connect): Slots 8, 10

• AIC, AIC-I (Alarm Interface Card): Slot 9

Cards
• TCC+

• TCC2
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Cards
• XC

• XCVT

• XC10G

• AIC

• AIC-I

• AEP

• EC1-12

• DS1-14

• DS1N-14

• DS3-12

• DS3N-12

• DS3-12E

• DS3N-12E

• DS3XM-6

• OC3 IR 4/STM1 SH 1310

• OC3 IR/STM1 SH 1310-8

• OC12 IR 1310

• OC12 LR 1310

• OC12 LR 1550

• OC12 IR/STM4 SH 1310-4

• OC48 IR 1310

• OC48 LR 1550

• OC48 IR/STM16 SH AS 1310

• OC48 LR/STM16 LH AS 1550

• OC192 SR/STM64 IO 1310

• OC192 IR/STM64 SH 1550

• OC192 LR 1550

• OC192 LR/STM64 ELH 15xx.xx

• OC48 ELR 200 Ghz ITU

• OC48 ELR 100 Ghz ITU

• 10T-L1-xx.x (10Gbps Transponder)

• 10M-L1-xx.x (2.5Gbps/10Gbps Muxponder)

• E100T-12

• E1000-2

• E100T-G

• E1000-2-G

• G1000-4

• G1K-4
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Configurations
• ML100T-12

• ML1000-2

Note The OC-3, OC-12, OC-48, and E1000-2 cards are Class 1 laser products (IEC 60825-1 2001-01/Class I 
laser product (21CFR 1040.10 and 1040.11).

Note The OC-192 card is a Class 1M laser product ((IEC 60825-1 2001-01)/Class I laser product (21CFR 
1040.10 and 1040.11).

Configurations
• Two-fiber path protection configuration

• Path protected mesh network (PPMN)

• Two-fiber BLSR 

• Four-fiber BLSR

• Add-drop multiplexer

• Terminal mode

• Regenerator mode

Cisco Transport Controller
• 10 Base-T 

• TCC+, TCC2 access: RJ-45 connector

• Backplane access: LAN pin field

External LAN Interface
• 10 Base-T Ethernet

• Backplane access: LAN pin field

TL1 Craft Interface
• Speed: 9600 bps

• TCC+, TCC2 access: RS-232 DB-9 type connector

• Backplane access: CRAFT pin field
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Modem Interface
Modem Interface
• Hardware flow control

• TCC+, TCC2: RS-232 DB-9 type connector

Alarm Interface
• Visual: Critical, Major, Minor, Remote

• Audible: Critical, Major, Minor, Remote

• Alarm contacts: 0.045mm, -48V, 50 mA

• Backplane access: Alarm pin fields

EIA Interface
• SMB: AMP #415504-3 75-Ohm 4 leg connectors

• BNC: Trompeter #UCBJ224 75-Ohm 4 leg connector (King or ITT are also compatible)

• AMP Champ: AMP#552246-1 with #552562-2 bail locks

Nonvolatile Memory
64 MB, 3.0V FLASH memory

BITS Interface
• 2 DS-1 BITS inputs

• 2 derived DS-1 outputs

• Backplane access: BITS pin field

System Timing
• Stratum 3 per Telcordia GR-253-CORE

• Free running accuracy: ± 4.6 ppm

• Holdover stability: 3.7 x10-7/day, including temperature (< 255 slips in first 24 hours)

• Reference: External BITS, line, internal

Power Specifications
• Input power: –48 VDC
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Environmental Specifications
• Power consumption: 55W (fan tray only); 650W (maximum draw w/cards)

• Power requirements: –42 to –57 VDC

• Power terminals: #6 Lug

• ANSI shelf: 100 Amp fuse panel (minimum 30 Amp fuse per shelf)
NEBS3 shelf: 80 Amp fuse panel (minimum 20 Amp fuse per shelf

Environmental Specifications
• Operating Temperature: 0 to +55 degrees Celsius; –40 to +65 degrees Celsius with industrial 

temperature rated cards

• Operating Humidity: 5 – 95%, non-condensing

Dimensions
• Height: 18.5 inches (40.7 cm)

• Width: 19 or 23 inches (41.8 or 50.6 cm) with mounting ears attached

• Depth: 12 inches (26.4 cm) (5 inch or 12.7 cm projection from rack)

• Weight: 55 lbs. (24.947 kg) empty
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Dimensions
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Network Element Defaults

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This appendix describes the factory-configured (default) network element (NE) settings for the Cisco 
ONS 15454. It includes descriptions of card default settings and node default settings and provides 
procedures for importing, exporting and editing the settings. Ethernet card settings are not included in 
the factory-configured settings. 

To change card settings individually (that is, without changing the defaults), see Chapter 11, “Change 
Card Settings.” To change node settings without changing the defaults, see Chapter 10, “Change Node 
Settings.”

Network Element Defaults Description
The NE defaults are pre-installed on each ONS 15454 (on the TCC+/TCC2 cards). They also ship as a 
file called 15454-defaults.txt on the CTC software CD in the event you want to import the defaults onto 
existing TCC+/TCC2 cards. The NE defaults include card-level and node-level defaults.

Changes made manually using Chapter 11, “Change Card Settings” override default settings. If you use 
the Defaults Editor or import a new defaults file that changes the defaults, the changes apply only to 
cards installed subsequently (after the defaults change) or to slots pre-provisioned subsequently. A new 
defaults file will not take effect for cards already installed when the change takes place or for slots 
already pre-provisioned when the change takes place. 

Changes made manually to most node-level default settings (either when you initially turn up a node or 
change node settings later) override the current settings, whether default or provisioned. If you change 
the default settings, using either the Defaults Editor or by importing a new defaults file, the new defaults 
take effect immediately for all settings except those relating to protection (path protection configuration, 
BLSR, 1+1, or Y-Cable). 

Use the following procedures if you need to edit, import, or export NE defaults. 
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Network Element Defaults Description
NTP-A164 Edit Network Element Defaults

Step 1 After logging into the node, click the Provisioning > Defaults Editor tabs. 

Step 2 Under Defaults Selector, choose either a card (if editing card-level defaults) or NODE (if editing 
node-level defaults). Clicking on the node name (at the top of the Defaults Selector column) lists all 
available NE defaults (both node- and card-level) under Property Name. 

Step 3 Locate a default you want to change under Property Name. 

Step 4 Click in the Default Value column for the default property you are changing and either choose a value 
from the drop-down menu (when available), or type in the desired new value.

Note If you click Reset before you click Apply, all values will return to their original settings. 

Step 5 Click Apply (click in the Property Name column to activate the Apply button if it is unavailable). You 
can modify multiple default values before applying the changes. 

Step 6 If you are modifying node-level defaults, a dialog box appears telling you that applying defaults for node 
level attributes overrides current provisioning and asks if you want to continue. Click Yes.

Note Changes to node settings take effect upon clicking Apply. Changes to the IIOP Listener Port 
setting reboots the TCC+/TCC2. Changes made to card settings using the Defaults Editor do not 
change the settings for cards that are currently installed or slots that are pre-provisioned for 
cards. Card settings must be manually changed by opening the cards (or pre-provisioned card 
slot). For procedures to change card settings, see Chapter 11, “Change Card Settings.”

Stop. You have completed this procedure.

Purpose This procedure edits the NE defaults using the NE Defaults Editor. The 
new defaults can either be applied only to the node on which they are edited 
or exported to a file and imported for use on other nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Network Element Defaults Description
NTP-A165 Import Network Element Defaults

Step 1 After logging into the node, click the Provisioning > Defaults Editor tabs. 

Step 2 Click Import.

Step 3 Click Browse and browse to the file you are importing if the correct file name and location of the desired 
file do not appear in the Import Defaults from File dialog box.

Step 4 When the correct file name and location appear in the dialog box (the correct file name is 
15454-defaults.txt if you are importing the factory defaults), click OK.

A pencil icon will appear next to any default value that will be changed as a result of importing the new 
defaults file. 

Step 5 Click Apply. If the imported file fails to pass all edits, you must fix the values listed in the problem fields 
before continuing.

Step 6 If you are modifying node-level defaults, a dialog box appears telling you that applying defaults for node 
level attributes overrides current provisioning and asks if you want to continue. Click Yes.

Note Changes to node settings take effect upon clicking Apply. Changes to the IIOP Listener Port 
setting reboots the TCC+/TCC2. Changes made to card settings using the Defaults Editor do not 
change the settings for cards that are currently installed or slots that are pre-provisioned for 
cards. Card settings must be manually changed by opening the cards (or the pre-provisioned card 
slots). For procedures to change card settings, see Chapter 11, “Change Card Settings.”

Stop. You have completed this procedure.

Purpose This procedure imports the NE defaults using the NE Defaults Editor. The 
defaults can either be imported from the CTC software CD (factory 
defaults) or from a customized file exported and saved from a node.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Card Default Settings
NTP-A166 Export Network Element Defaults

Step 1 After logging into the node, click the Provisioning > Defaults Editor tabs. 

Step 2 Click Export.

Step 3 Click Browse and browse to the location where you want to export the file if it does not appear in the 
Export Defaults to File dialog box. 

Step 4 Change the file name to something easy to remember (the file name has no extension). 

Step 5 Click OK.

Stop. You have completed this procedure.

Card Default Settings
The tables in this section list the default settings for each card. Cisco provides settings that are 
pre-provisioned for the ONS 15454 muxponder, transponder, optical, and electrical cards, including:

• Soak Time (all cards) is the length of time that elapses between an AINS port receiving a valid signal 
and when it automatically changes to in-service status. 

• Line Coding (DS-1 cards) defines the DS-1 transmission coding type that is used. 

• Line Length (DS-1, DS-3, and EC-1 cards) defines the distance (in feet) from the backplane 
connection to the next termination point.

• Line Type (DS-1, DS3E, and DS3XM-6 cards) defines the type of framing used. 

• Port State (all cards) sets the port to one of the four available states (IS, OOS, OOS_MT, or 
OOS_AINS), depending on whether you need ports in or out of service. See the “DLP-A214 Change 
the Service State for a Port” task on page 5-6 for a complete description of the port states.

• SF BER Level (OC-N, N-XP cards) defines the signal fail bit error rate.

• SD BER Level (OC-N, N-XP cards) defines the signal degrade bit error rate.

• Enable Synch Messages (OC-N, N-XP cards) enables synchronization status messages (S1 byte), 
which allow the node to choose the best timing source. 

• PJ Sts Mon (EC-1 card and OC-N cards) sets the STS that will be used for pointer justification. If 
set to 0, no STS is monitored. 

• Rx Equalization (EC-1 card) can be turned off if the line length is short or the environment is 
extremely cold. 

Purpose This procedure exports the NE defaults using the NE Defaults Editor. The 
exported defaults can be imported to other nodes.

Tools/Equipment None

Prerequisite Procedures DLP-A60 Log into CTC, page 3-23

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Card Default Settings
• STS IPPM Enabled (OC-N cards) enables intermediate-path performance monitoring on a node for 
transparent monitoring of a channel that does not terminate on that node. 

• Send Do Not Use (OC-N, N-XP cards) sends a DUS message on the S1 byte when enabled. 

• Far End Inhibit Loopback (DS3E and DS3XM-6 cards) enables DS3E or DS3XM-6 cards to inhibit 
loopbacks on the far end. 

• Create TL1-Like instructs the node to create only cross-connects, allowing the resulting circuits to 
be in an upgradable state.

• Craft Access Only allows CTC connectivity to the node only through the craft access port.

• CTC IP Display Suppression prevents the display of IP addresses in CTC.

• LCD IP Setting

• General Time Settings determines the time zone, daylight saving time policy, and time.

• BLSR Protection Settings determine whether BLSR-protected circuits are revertive, and if so, what 
the reversion time is at both the ring and span levels.

• Y Cable Protection Settings determine whether Y-Cable protected circuits are revertive, and if so, 
what the reversion time is at both the ring and span levels.

• PM Threshold Settings (all cards) set the performance monitoring parameters for gathering 
performance data and detecting problems early. For definitions of the performance monitoring 
parameters, refer to the Cisco ONS 15454 Reference Manual.

Table C-1 lists the DS-1 card default settings.

Table C-1 DS-1 Card Default Settings

Property Name  Default Value

DS1.config.AINSSoakTime 08:00 (hours:mins)

DS1.config.LineCoding AMI

DS1.config.LineLength 0-131 (feet)

DS1.config.LineType D4

DS1.config.State OOS

DS1.pmthresholds.line.nearend.15min.CV 13340 (BPV count)

DS1.pmthresholds.line.nearend.15min.ES 65 (seconds)

DS1.pmthresholds.line.nearend.15min.LOSS 10 (seconds)

DS1.pmthresholds.line.nearend.15min.SES 10 (seconds)

DS1.pmthresholds.line.nearend.1day.CV 133400 (BPV count)

DS1.pmthresholds.line.nearend.1day.ES 648 (seconds)

DS1.pmthresholds.line.nearend.1day.LOSS 10 (seconds)

DS1.pmthresholds.line.nearend.1day.SES 100 (seconds)

DS1.pmthresholds.line.farend.15min.ES 65 (seconds)

DS1.pmthresholds.line.farend.1day.ES 648 (seconds)

DS1.pmthresholds.path.nearend.15min.AISS 10 (seconds)

DS1.pmthresholds.path.nearend.15min.CV 13296 (BIP count)

DS1.pmthresholds.path.nearend.15min.ES 65 (seconds)
C-5
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Appendix C      Network Element Defaults
Card Default Settings
DS1.pmthresholds.path.nearend.15min.SAS 2 (seconds)

DS1.pmthresholds.path.nearend.15min.SES 10 (seconds)

DS1.pmthresholds.path.nearend.15min.UAS 10 (seconds)

DS1.pmthresholds.path.nearend.1day.CV 132960 (BIP count)

DS1.pmthresholds.path.nearend.1day.ES 648 (seconds)

DS1.pmthresholds.path.nearend.1day.SAS 17 (seconds)

DS1.pmthresholds.path.nearend.1day.SES 100 (seconds)

DS1.pmthresholds.path.nearend.1day.UAS 10 (seconds)

DS1.pmthresholds.path.farend.15min.CSS 25 (seconds)

DS1.pmthresholds.path.farend.15min.CV 13296 (BIP count)

DS1.pmthresholds.path.farend.15min.ES 65 (seconds)

DS1.pmthresholds.path.farend.15min.ESA 25 (seconds)

DS1.pmthresholds.path.farend.15min.ESB 25 (seconds)

DS1.pmthresholds.path.farend.15min.SEFS 25 (seconds)

DS1.pmthresholds.path.farend.15min.SES 10 (seconds)

DS1.pmthresholds.path.farend.15min.UAS 10 (seconds)

DS1.pmthresholds.path.farend.15min.CSS 25 (seconds)

DS1.pmthresholds.path.farend.1day.CV 132960 (BIP count)

DS1.pmthresholds.path.farend.1day.ES 648 (seconds)

DS1.pmthresholds.path.farend.1day.ESA 25 (seconds)

DS1.pmthresholds.path.farend.1day.ESB 25 (seconds)

DS1.pmthresholds.path.farend.1day.SEFS 25 (seconds)

DS1.pmthresholds.path.farend.1day.SES 100 (seconds)

DS1.pmthresholds.path.farend.1day.UAS 10 (seconds)

DS1.pmthresholds.sts.farend.15min.CV 15 (B3 count)

DS1.pmthresholds.sts.farend.15min.ES 12 (seconds)

DS1.pmthresholds.sts.farend.15min.FC 10 (count)

DS1.pmthresholds.sts.farend.15min.SES 3 (seconds)

DS1.pmthresholds.sts.farend.15min.UAS 10 (seconds)

DS1.pmthresholds.sts.farend.1day.CV 125 (B3 count)

DS1.pmthresholds.sts.farend.1day.ES 100 (seconds)

DS1.pmthresholds.sts.farend.1day.FC 10 (count)

DS1.pmthresholds.sts.farend.1day.SES 7 (seconds)

DS1.pmthresholds.sts.farend.1day.UAS 10 (seconds)

DS1.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

DS1.pmthresholds.sts.nearend.15min.ES 12 (seconds)

Table C-1 DS-1 Card Default Settings (continued)

Property Name  Default Value
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Table C-2 lists the DS-3 card default settings.

DS1.pmthresholds.sts.nearend.15min.FC 10 (count)

DS1.pmthresholds.sts.nearend.15min.SES 3 (seconds)

DS1.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

DS1.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

DS1.pmthresholds.sts.nearend.1day.ES 100 (seconds)

DS1.pmthresholds.sts.nearend.1day.FC 10 (count)

DS1.pmthresholds.sts.nearend.1day.SES 7 (seconds)

DS1.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

DS1.pmthresholds.vt.farend.15min.CV 15 (BIP8 count)

DS1.pmthresholds.vt.farend.15min.ES 12 (seconds)

DS1.pmthresholds.vt.farend.15min.SES 3 (seconds)

DS1.pmthresholds.vt.farend.15min.UAS 10 (seconds)

DS1.pmthresholds.vt.farend.1day.CV 125 (BIP8 count)

DS1.pmthresholds.vt.farend.1day.ES 100 (seconds)

DS1.pmthresholds.vt.farend.1day.SES 7 (seconds)

DS1.pmthresholds.vt.farend.1day.UAS 10 (seconds)

DS1.pmthresholds.vt.nearend.15min.CV 15 (BIP8 count)

DS1.pmthresholds.vt.nearend.15min.ES 12 (seconds)

DS1.pmthresholds.vt.nearend.15min.SES 3 (seconds)

DS1.pmthresholds.vt.nearend.15min.UAS 10 (seconds)

DS1.pmthresholds.vt.nearend.1day.CV 125 (BIP8 count)

DS1.pmthresholds.vt.nearend.1day.ES 100 (seconds)

DS1.pmthresholds.vt.nearend.1day.SES 7 (seconds)

DS1.pmthresholds.vt.nearend.1day.UAS 10 (seconds)

Table C-1 DS-1 Card Default Settings (continued)

Property Name  Default Value

Table C-2 DS-3 Card Default Settings

Property Name  Default Value

DS3.config.AINSSoakTime 08:00 (hours:mins)

DS3.config.LineLength 0-225 (feet)

DS3.config.State OOS

DS3.pmthresholds.line.nearend.15min.CV 387 (BPV count)

DS3.pmthresholds.line.nearend.15min.ES 25 (seconds)

DS3.pmthresholds.line.nearend.15min.LOSS 10 (seconds)

DS3.pmthresholds.line.nearend.15min.SES 4 (seconds)
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Table C-3 lists the DS3E card default settings.

DS3.pmthresholds.line.nearend.1day.CV 3865 (BPV count)

DS3.pmthresholds.line.nearend.1day.ES 250 (seconds)

DS3.pmthresholds.line.nearend.1day.LOSS 10 (seconds)

DS3.pmthresholds.line.nearend.1day.SES 40 (seconds)

DS3.pmthresholds.sts.farend.15min.CV 15 (G1 count)

DS3.pmthresholds.sts.farend.15min.ES 12 (seconds)

DS3.pmthresholds.sts.farend.15min.FC 10 (count)

DS3.pmthresholds.sts.farend.15min.SES 3 (seconds)

DS3.pmthresholds.sts.farend.15min.UAS 10 (seconds)

DS3.pmthresholds.sts.farend.1day.CV 125 (G1 count)

DS3.pmthresholds.sts.farend.1day.ES 100 (seconds)

DS3.pmthresholds.sts.farend.1day.FC 10 (count)

DS3.pmthresholds.sts.farend.1day.SES 7 (seconds)

DS3.pmthresholds.sts.farend.1day.UAS 10 (seconds)

DS3.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

DS3.pmthresholds.sts.nearend.15min.ES 12 (seconds)

DS3.pmthresholds.sts.nearend.15min.FC 10 (count)

DS3.pmthresholds.sts.nearend.15min.SES 3 (seconds)

DS3.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

DS3.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

DS3.pmthresholds.sts.nearend.1day.ES 100 (seconds)

DS3.pmthresholds.sts.nearend.1day.FC 10 (count)

DS3.pmthresholds.sts.nearend.1day.SES 7 (seconds)

DS3.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-2 DS-3 Card Default Settings (continued)

Property Name  Default Value

Table C-3 DS3E Card Default Settings

Property Name  Default Value

DS3E.config.AINSSoakTime 08:00 (hours:mins)

DS3E.config.FeInhibitLpbk FALSE

DS3E.config.LineLength 0-225 (feet)

DS3E.config.LineType UNFRAMED

DS3E.config.State OOS

DS3E.pmthresholds.cpbitpath.farend.15min.AISS 10 (seconds)

DS3E.pmthresholds.cpbitpath.farend.15min.CV 382 (BIP count)
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DS3E.pmthresholds.cpbitpath.farend.15min.ES 25 (seconds)

DS3E.pmthresholds.cpbitpath.farend.15min.SAS 2 (seconds)

DS3E.pmthresholds.cpbitpath.farend.15min.SES 4 (seconds)

DS3E.pmthresholds.cpbitpath.farend.15min.UAS 10 (seconds)

DS3E.pmthresholds.cpbitpath.farend.1day.AISS 10 (seconds)

DS3E.pmthresholds.cpbitpath.farend.1day.CV 3820 (BIP count)

DS3E.pmthresholds.cpbitpath.farend.1day.ES 250 (seconds)

DS3E.pmthresholds.cpbitpath.farend.1day.SAS 8 (seconds)

DS3E.pmthresholds.cpbitpath.farend.1day.SES 40 (seconds)

DS3E.pmthresholds.cpbitpath.farend.1day.UAS 10 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.15min.AISS 10 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.15min.CV 382 (BIP count)

DS3E.pmthresholds.cpbitpath.nearend.15min.ES 25 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.15min.SAS 2 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.15min.SES 4 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.15min.UAS 10 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.1day.AISS 10 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.1day.CV 3820 (BIP count)

DS3E.pmthresholds.cpbitpath.nearend.1day.ES 250 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.1day.SAS 8 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.1day.SES 40 (seconds)

DS3E.pmthresholds.cpbitpath.nearend.1day.UAS 10 (seconds)

DS3E.pmthresholds.line.nearend.15min.CV 387 (BPV count)

DS3E.pmthresholds.line.nearend.15min.ES 25 (seconds)

DS3E.pmthresholds.line.nearend.15min.LOSS 10 (seconds)

DS3E.pmthresholds.line.nearend.15min.SES 4 (seconds)

DS3E.pmthresholds.line.nearend.1day.CV 3865 (BPV count)

DS3E.pmthresholds.line.nearend.1day.ES 250 (seconds)

DS3E.pmthresholds.line.nearend.1day.LOSS 10 (seconds)

DS3E.pmthresholds.line.nearend.1day.SES 40 (seconds)

DS3E.pmthresholds.pbitpath.nearend.15min.AISS 10 (seconds)

DS3E.pmthresholds.pbitpath.nearend.15min.CV 382 (BIP count)

DS3E.pmthresholds.pbitpath.nearend.15min.ES 25 (seconds)

DS3E.pmthresholds.pbitpath.nearend.15min.SAS 2 (seconds)

DS3E.pmthresholds.pbitpath.nearend.15min.SES 4 (seconds)

DS3E.pmthresholds.pbitpath.nearend.15min.UAS 10 (seconds)

Table C-3 DS3E Card Default Settings (continued)

Property Name  Default Value
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Table C-4 lists the DS3XM-6 card default settings.

 

DS3E.pmthresholds.pbitpath.nearend.1day.AISS 10 (seconds)

DS3E.pmthresholds.pbitpath.nearend.1day.CV 3820 (BIP count)

DS3E.pmthresholds.pbitpath.nearend.1day.ES 250 (seconds)

DS3E.pmthresholds.pbitpath.nearend.1day.SAS 8 (seconds)

DS3E.pmthresholds.pbitpath.nearend.1day.SES 40 (seconds)

DS3E.pmthresholds.pbitpath.nearend.1day.UAS 10 (seconds)

DS3E.pmthresholds.sts.farend.15min.CV 15 (G1 count)

DS3E.pmthresholds.sts.farend.15min.ES 12 (seconds)

DS3E.pmthresholds.sts.farend.15min.FC 10 (count)

DS3E.pmthresholds.sts.farend.15min.SES 3 (seconds)

DS3E.pmthresholds.sts.farend.15min.UAS 10 (seconds)

DS3E.pmthresholds.sts.farend.1day.CV 125 (G1 count)

DS3E.pmthresholds.sts.farend.1day.ES 100 (seconds)

DS3E.pmthresholds.sts.farend.1day.FC 10 (count)

DS3E.pmthresholds.sts.farend.1day.SES 7 (seconds)

DS3E.pmthresholds.sts.farend.1day.UAS 10 (seconds)

DS3E.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

DS3E.pmthresholds.sts.nearend.15min.ES 12 (seconds)

DS3E.pmthresholds.sts.nearend.15min.FC 10 (count)

DS3E.pmthresholds.sts.nearend.15min.SES 3 (seconds)

DS3E.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

DS3E.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

DS3E.pmthresholds.sts.nearend.1day.ES 100 (seconds)

DS3E.pmthresholds.sts.nearend.1day.FC 10 (count)

DS3E.pmthresholds.sts.nearend.1day.SES 7 (seconds)

DS3E.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-3 DS3E Card Default Settings (continued)

Property Name  Default Value

Table C-4 DS3XM-6 Card Default Settings

Property Name Default Value

DS3XM.config.AINSSoakTime 08:00 (hours:mins)

DS3XM.config.FeInhibitLpbk FALSE

DS3XM.config.LineLength 0-225 (feet)

DS3XM.config.LineType M13

DS3XM.config.State OOS
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DS3XM.pmthresholds.cpbitpath.farend.15min.AISS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.15min.CV 382 (BIP count)

DS3XM.pmthresholds.cpbitpath.farend.15min.ES 25 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.15min.SAS 2 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.15min.SES 4 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.1day.AISS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.1day.CV 3820 (BIP count)

DS3XM.pmthresholds.cpbitpath.farend.1day.ES 250 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.1day.SAS 8 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.1day.SES 40 (seconds)

DS3XM.pmthresholds.cpbitpath.farend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.15min.AISS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.15min.CV 382 (BIP count)

DS3XM.pmthresholds.cpbitpath.nearend.15min.ES 25 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.15min.SAS 2 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.15min.SES 4 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.1day.AISS 10 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.1day.CV 3820 (BIP count)

DS3XM.pmthresholds.cpbitpath.nearend.1day.ES 250 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.1day.SAS 8 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.1day.SES 40 (seconds)

DS3XM.pmthresholds.cpbitpath.nearend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.ds1path.nearend.15min.AISS 10 (seconds)

DS3XM.pmthresholds.ds1path.nearend.15min.ES 65 (seconds)

DS3XM.pmthresholds.ds1path.nearend.15min.SAS 2 (seconds)

DS3XM.pmthresholds.ds1path.nearend.15min.SES 10 (seconds)

DS3XM.pmthresholds.ds1path.nearend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.ds1path.nearend.1day.AISS 10 (seconds)

DS3XM.pmthresholds.ds1path.nearend.1day.ES 648 (seconds)

DS3XM.pmthresholds.ds1path.nearend.1day.SAS 17 (seconds)

DS3XM.pmthresholds.ds1path.nearend.1day.SES 100 (seconds)

DS3XM.pmthresholds.ds1path.nearend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.line.nearend.15min.CV 387 (BPV count)

DS3XM.pmthresholds.line.nearend.15min.ES 25 (seconds)

Table C-4 DS3XM-6 Card Default Settings (continued)

Property Name Default Value
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DS3XM.pmthresholds.line.nearend.15min.LOSS 10 (seconds)

DS3XM.pmthresholds.line.nearend.15min.SES 4 (seconds)

DS3XM.pmthresholds.line.nearend.1day.CV 3865 (BPV count)

DS3XM.pmthresholds.line.nearend.1day.ES 250 (seconds)

DS3XM.pmthresholds.line.nearend.1day.LOSS 10 (seconds)

DS3XM.pmthresholds.line.nearend.1day.SES 40 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.15min.AISS 10 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.15min.CV 382 (BIP count)

DS3XM.pmthresholds.pbitpath.nearend.15min.ES 25 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.15min.SAS 2 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.15min.SES 4 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.1day.AISS 10 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.1day.CV 3820 (BIP count)

DS3XM.pmthresholds.pbitpath.nearend.1day.ES 250 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.1day.SAS 8 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.1day.SES 40 (seconds)

DS3XM.pmthresholds.pbitpath.nearend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.sts.farend.15min.CV 15 (B3 count)

DS3XM.pmthresholds.sts.farend.15min.ES 12 (seconds)

DS3XM.pmthresholds.sts.farend.15min.FC 10 (count)

DS3XM.pmthresholds.sts.farend.15min.SES 3 (seconds)

DS3XM.pmthresholds.sts.farend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.sts.farend.1day.CV 125 (B3 count)

DS3XM.pmthresholds.sts.farend.1day.ES 100 (seconds)

DS3XM.pmthresholds.sts.farend.1day.FC 10 (count)

DS3XM.pmthresholds.sts.farend.1day.SES 7 (seconds)

DS3XM.pmthresholds.sts.farend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

DS3XM.pmthresholds.sts.nearend.15min.ES 12 (seconds)

DS3XM.pmthresholds.sts.nearend.15min.FC 10 (count)

DS3XM.pmthresholds.sts.nearend.15min.SES 3 (seconds)

DS3XM.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

DS3XM.pmthresholds.sts.nearend.1day.ES 100 (seconds)

DS3XM.pmthresholds.sts.nearend.1day.FC 10 (count)

Table C-4 DS3XM-6 Card Default Settings (continued)

Property Name Default Value
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Table C-5 lists the EC-1 card default settings. 

DS3XM.pmthresholds.sts.nearend.1day.SES 7 (seconds)

DS3XM.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.vt.farend.15min.CV 15 (BIP8 count)

DS3XM.pmthresholds.vt.farend.15min.ES 12 (seconds)

DS3XM.pmthresholds.vt.farend.15min.SES 3 (seconds)

DS3XM.pmthresholds.vt.farend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.vt.farend.1day.CV 125 (BIP8 count)

DS3XM.pmthresholds.vt.farend.1day.ES 100 (seconds)

DS3XM.pmthresholds.vt.farend.1day.SES 7 (seconds)

DS3XM.pmthresholds.vt.farend.1day.UAS 10 (seconds)

DS3XM.pmthresholds.vt.nearend.15min.CV 15 (BIP8 count)

DS3XM.pmthresholds.vt.nearend.15min.ES 12 (seconds)

DS3XM.pmthresholds.vt.nearend.15min.SES 3 (seconds)

DS3XM.pmthresholds.vt.nearend.15min.UAS 10 (seconds)

DS3XM.pmthresholds.vt.nearend.1day.CV 125 (BIP8 count)

DS3XM.pmthresholds.vt.nearend.1day.ES 100 (seconds)

DS3XM.pmthresholds.vt.nearend.1day.SES 7 (seconds)

DS3XM.pmthresholds.vt.nearend.1day.UAS 10 (seconds)

Table C-4 DS3XM-6 Card Default Settings (continued)

Property Name Default Value

Table C-5 EC-1 Card Default Settings

Property Name Default Value

EC1.config.line.AINSSoakTime 08:00 (hours:mins)

EC1.config.line.LineLength 0-225 (feet)

EC1.config.line.PJStsMon# 0 (STS #)

EC1.config.line.RxEqualization TRUE

EC1.config.line.State OOS

EC1.config.sts.IPPMEnabled FALSE

EC1.pmthresholds.line.farend.15min.CV 1312 (B2 count)

EC1.pmthresholds.line.farend.15min.ES 87 (seconds)

EC1.pmthresholds.line.farend.15min.FC 10 (count)

EC1.pmthresholds.line.farend.15min.SES 1 (seconds)

EC1.pmthresholds.line.farend.15min.UAS 3 (seconds)

EC1.pmthresholds.line.farend.1day.CV 13120 (B2 count)

EC1.pmthresholds.line.farend.1day.ES 864 (seconds)
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EC1.pmthresholds.line.farend.1day.FC 40 (count)

EC1.pmthresholds.line.farend.1day.SES 4 (seconds)

EC1.pmthresholds.line.farend.1day.UAS 10 (seconds)

EC1.pmthresholds.line.nearend.15min.CV 1312 (B2 count)

EC1.pmthresholds.line.nearend.15min.ES 87 (seconds)

EC1.pmthresholds.line.nearend.15min.FC 10 (count)

EC1.pmthresholds.line.nearend.15min.NPJC-PDET 60 (count)

EC1.pmthresholds.line.nearend.15min.NPJC-PGEN 60 (count)

EC1.pmthresholds.line.nearend.15min.PPJC-PDET 60 (count)

EC1.pmthresholds.line.nearend.15min.PPJC-PGEN 60 (count)

EC1.pmthresholds.line.nearend.15min.PSC 1 (count)

EC1.pmthresholds.line.nearend.15min.PSD 300 (seconds)

EC1.pmthresholds.line.nearend.15min.SES 1 (seconds)

EC1.pmthresholds.line.nearend.15min.UAS 3 (seconds)

EC1.pmthresholds.line.nearend.1day.CV 13120 (B2 count)

EC1.pmthresholds.line.nearend.1day.ES 864 (seconds)

EC1.pmthresholds.line.nearend.1day.FC 40 (count)

EC1.pmthresholds.line.nearend.1day.NPJC-PDET 5760 (count)

EC1.pmthresholds.line.nearend.1day.NPJC-PGEN 5760 (count)

EC1.pmthresholds.line.nearend.1day.PPJC-PDET 5760 (count)

EC1.pmthresholds.line.nearend.1day.PPJC-PGEN 5760 (count)

EC1.pmthresholds.line.nearend.1day.PSC 5 (count)

EC1.pmthresholds.line.nearend.1day.PSD 600 (seconds)

EC1.pmthresholds.line.nearend.1day.SES 4 (seconds)

EC1.pmthresholds.line.nearend.1day.UAS 10 (seconds)

EC1.pmthresholds.section.nearend.15min.CV 10000 (B1 count)

EC1.pmthresholds.section.nearend.15min.ES 500 (seconds)

 EC1.pmthresholds.section.nearend.15min.SEFS 500 (seconds)

EC1.pmthresholds.section.nearend.15min.SES 500 (seconds)

EC1.pmthresholds.section.nearend.1day.CV 100000 (B1 count)

EC1.pmthresholds.section.nearend.1day.ES 5000 (seconds)

EC1.pmthresholds.section.nearend.1day.SEFS 5000 (seconds)

EC1.pmthresholds.section.nearend.1day.SES 5000 (seconds)

EC1.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

EC1.pmthresholds.sts.nearend.15min.ES 12 (seconds)

EC1.pmthresholds.sts.nearend.15min.FC 10 (count)

Table C-5 EC-1 Card Default Settings (continued)

Property Name Default Value
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Table C-6 lists the MXP (muxponder) card default settings.

 

EC1.pmthresholds.sts.nearend.15min.SES 3 (seconds)

EC1.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

EC1.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

EC1.pmthresholds.sts.nearend.1day.ES 100 (seconds)

EC1.pmthresholds.sts.nearend.1day.FC 10 (count)

EC1.pmthresholds.sts.nearend.1day.SES 7 (seconds)

EC1.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-5 EC-1 Card Default Settings (continued)

Property Name Default Value

Table C-6 MXP Card Default Settings

Property Name Default Value

MXP_2_5G_10G.config.PayloadType SONET

MXP_2_5G_10G.config.TerminationMode TRANSPARENT

MXP_2_5G_10G.config.line.AINSSoakTime 08:00 (hours:mins) 

MXP_2_5G_10G.config.line.A1sMode Disabled

MXP_2_5G_10G.config.line.A1sRecoveryInterval 100 

MXP_2_5G_10G.config.line.A1sRecoveryPulseWidth 2.0

MXP_2_5G_10G.config.line.State OOS

MXP_2_5G_10G.config.payload.EnableSyncMsgs TRUE

MXP_2_5G_10G.config.payload.SDBER 1E-7

MXP_2_5G_10G.config.payload.SFBER 1E-4

MXP_2_5G_10G.config.payload.SendDoNotUse FALSE

MXP_2_5G_10G.config.trunk.FEC TRUE

MXP_2_5G_10G.config.trunk.G709OTN TRUE

MXP_2_5G_10G.config.trunk.SDBER 1E-7

MXP_2_5G_10G.config.trunk.SFBER 1E-4

MXP_2_5G_10G.config.trunk.TxPower 2.0

MXP_2_5G_10G.fecthresholds.trunk.15min.BitErrorsCorrected 0

MXP_2_5G_10G.fecthresholds.trunk.15min.ByteErrorsCorrected 0

MXP_2_5G_10G.fecthresholds.trunk.15min.OneBitErrorsDetected 0

MXP_2_5G_10G.fecthresholds.trunk.15min.UncorrectableWords 0

MXP_2_5G_10G.fecthresholds.trunk.15min.ZeroBitErrorsDetected 0

MXP_2_5G_10G.fecthresholds.trunk.1day.BitErrorsCorrected 0

MXP_2_5G_10G.fecthresholds.trunk.1day.ByteErrorsCorrected 0

MXP_2_5G_10G.fecthresholds.trunk.1day.OneBitErrorsDetected 0
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MXP_2_5G_10G.fecthresholds.trunk.1day.UncorrectableWords 0

MXP_2_5G_10G.fecthresholds.trunk.1day.ZeroBitErrorsDetected 0

MXP_2_5G_10G.opticalthresholds.client.alarm.HighLaserBias 50.0

MXP_2_5G_10G.opticalthresholds.client.alarm.HighLaserTemp 75.0

MXP_2_5G_10G.opticalthresholds.client.alarm.HighRxPower 2.0

MXP_2_5G_10G.opticalthresholds.client.alarm.HighTxPower 2.0

MXP_2_5G_10G.opticalthresholds.client.alarm.LowLaserBias 50.0

MXP_2_5G_10G.opticalthresholds.client.alarm.LowLaserTemp -10.0

MXP_2_5G_10G.opticalthresholds.client.alarm.LowRxPower -22.0

MXP_2_5G_10G.opticalthresholds.client.alarm.LowTxPower -11.0

MXP_2_5G_10G.opticalthresholds.client.warning.15min.HighLaserBias 37.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.HighLaserTemp 56.25

MXP_2_5G_10G.opticalthresholds.client.warning.15min.HighRxPower 1.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.HighTxPower 1.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.LowLaserBias 37.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.LowLaserTemp -7.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.LowRxPower -16.5

MXP_2_5G_10G.opticalthresholds.client.warning.15min.LowTxPower -8.3

MXP_2_5G_10G.opticalthresholds.client.warning.1day.HighLaserBias 45.0

MXP_2_5G_10G.opticalthresholds.client.warning.1day.HighLaserTemp 67.5

MXP_2_5G_10G.opticalthresholds.client.warning.1day.HighRxPower 1.8

MXP_2_5G_10G.opticalthresholds.client.warning.1day.HighTxPower 1.8

MXP_2_5G_10G.opticalthresholds.client.warning.1day.LowLaserBias 45.0

MXP_2_5G_10G.opticalthresholds.client.warning.1day.LowLaserTemp -9.0

MXP_2_5G_10G.opticalthresholds.client.warning.1day.LowRxPower -19.8

MXP_2_5G_10G.opticalthresholds.client.warning.1day.LowTxPower -9.9

MXP_2_5G_10G.opticalthresholds.trunk.alarm.HighLaserBias 50.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.HighLaserTemp 45.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.HighRxPower -3.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.HighRxTemp 45.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.HighTxPower 3.5

MXP_2_5G_10G.opticalthresholds.trunk.alarm.LowLaserBias 50.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.LowLaserTemp 5.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.LowRxPower -28.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.LowRxTemp -5.0

MXP_2_5G_10G.opticalthresholds.trunk.alarm.LowTxPower -25.0

Table C-6 MXP Card Default Settings (continued)

Property Name Default Value
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MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.HighLaserBias 37.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.HighLaserTemp 33.75

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.HighRxPower -2.3

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.HighRxTemp 67.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.HighTxPower 2.6

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.LowLaserBias 37.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.LowLaserTemp 3.75

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.LowRxPower -21.0

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.LowRxTemp -3.75

MXP_2_5G_10G.opticalthresholds.trunk.warning.15min.LowTxPower -18.8

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.HighLaserBias 45.0

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.HighLaserTemp 40.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.HighRxPower -2.7

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.HighRxTemp 81.0

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.1

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.LowLaserBias 45.0

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.LowLaserTemp 4.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.LowRxPower -25.2

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.LowRxTemp -4.5

MXP_2_5G_10G.opticalthresholds.trunk.warning.1day.LowTxPower -22.5

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.15min.BBE 85040

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.15min.ES 87

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.15min.FC 10

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.15min.SES 1

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.15min.UAS 3

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.1day.BBE 850400

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.1day.ES 864

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.1day.FC 40

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.1day.SES 4

MXP_2_5G_10G.otnthresholds.trunk.pm.farend.1day.UAS 10

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.15min.BBE 85040

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.15min.ES 87

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.15min.FC 10

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.15min.SES 1

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.15min.UAS 3

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.1day.BBE 850400

Table C-6 MXP Card Default Settings (continued)

Property Name Default Value
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MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.1day.ES 864

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.1day.FC 40

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.1day.SES 4

MXP_2_5G_10G.otnthresholds.trunk.pm.nearend.1day.UAS 10

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.15min.BBE 10000

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.15min.ES 500

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.15min.FC 10

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.15min.SES 500

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.15min.UAS 500

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.1day.BBE 100000

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.1day.ES 5000

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.1day.FC 40

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.1day.SES 5000

MXP_2_5G_10G.otnthresholds.trunk.sm.farend.1day.UAS 5000

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.15min.BBE 10000

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.15min.ES 500

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.15min.FC 10

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.15min.SES 500

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.15min.UAS 500

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.1day.BBE 100000

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.1day.ES 5000

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.1day.FC 40

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.1day.SES 5000

MXP_2_5G_10G.otnthresholds.trunk.sm.nearend.1day.UAS 5000

MXP_2_5G_10G.pmthresholds.client.line.farend.15min.CV 21260

MXP_2_5G_10G.pmthresholds.client.line.farend.15min.ES 87

MXP_2_5G_10G.pmthresholds.client.line.farend.15min.FC 10

MXP_2_5G_10G.pmthresholds.client.line.farend.15min.SES 1

MXP_2_5G_10G.pmthresholds.client.line.farend.15min.UAS 3

MXP_2_5G_10G.pmthresholds.client.line.farend.1day.CV 212600

MXP_2_5G_10G.pmthresholds.client.line.farend.1day.ES 864

MXP_2_5G_10G.pmthresholds.client.line.farend.1day.FC 40

MXP_2_5G_10G.pmthresholds.client.line.farend.1day.SES 4

MXP_2_5G_10G.pmthresholds.client.line.farend.1day.UAS 10

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.CV 21260

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.ES 87

Table C-6 MXP Card Default Settings (continued)

Property Name Default Value
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MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.FC 10

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.NPJC-PDET 60

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.NPJC-PGEN 60

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.PPJC-PDET 60

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.PPJC-PGEN 60

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.SES 1

MXP_2_5G_10G.pmthresholds.client.line.nearend.15min.UAS 3

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.CV 212600

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.ES 864

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.FC 40

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.NPJC-PDET 5760

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.NPJC-PGEN 5760

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.PPJC-PDET 5760

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.PPJC-PGEN 5760

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.SES 4

MXP_2_5G_10G.pmthresholds.client.line.nearend.1day.UAS 10

MXP_2_5G_10G.pmthresholds.client.section.nearend.15min.CV 10000

MXP_2_5G_10G.pmthresholds.client.section.nearend.15min.ES 500

MXP_2_5G_10G.pmthresholds.client.section.nearend.15min.SEFS 500

MXP_2_5G_10G.pmthresholds.client.section.nearend.15min.SES 500

MXP_2_5G_10G.pmthresholds.client.section.nearend.1day.CV 100000

MXP_2_5G_10G.pmthresholds.client.section.nearend.1day.ES 5000

MXP_2_5G_10G.pmthresholds.client.section.nearend.1day.SEFS 5000

MXP_2_5G_10G.pmthresholds.client.section.nearend.1day.SES 5000

MXP_2_5G_10G.pmthresholds.trunk.line.farend.15min.CV 85040

MXP_2_5G_10G.pmthresholds.trunk.line.farend.15min.ES 87

MXP_2_5G_10G.pmthresholds.trunk.line.farend.15min.FC 10

MXP_2_5G_10G.pmthresholds.trunk.line.farend.15min.SES 1

MXP_2_5G_10G.pmthresholds.trunk.line.farend.15min.UAS 3

MXP_2_5G_10G.pmthresholds.trunk.line.farend.1day.CV 850400

MXP_2_5G_10G.pmthresholds.trunk.line.farend.1day.ES 864

MXP_2_5G_10G.pmthresholds.trunk.line.farend.1day.FC 40

MXP_2_5G_10G.pmthresholds.trunk.line.farend.1day.SES 4

MXP_2_5G_10G.pmthresholds.trunk.line.farend.1day.UAS 10

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.CV 85040

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.ES 87

Table C-6 MXP Card Default Settings (continued)

Property Name Default Value
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Table C-7 lists the default settings for all OC-3 card types. 

Note The 12-port OC-3 card’s defaults begin with “OC3-12.”

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.FC 10

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.NPJC-PDET 60

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.NPJC-PGEN 60

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.PPJC-PDET 60

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.PPJC-PGEN 60

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.SES 1

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.15min.UAS 3

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.CV 850400

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.ES 864

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.FC 40

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.NPJC-PDET 5760

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.NPJC-PGEN 5760

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.PPJC-PDET 5760

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.PPJC-PGEN 5760

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.SES 4

MXP_2_5G_10G.pmthresholds.trunk.line.nearend.1day.UAS 10

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.15min.CV 10000

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.15min.ES 500

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.15min.SEFS 500

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.15min.SES 500

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.1day.CV 100000

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.1day.ES 5000

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.1day.SEFS 5000

MXP_2_5G_10G.pmthresholds.trunk.section.nearend.1day.SES 5000

Table C-6 MXP Card Default Settings (continued)

Property Name Default Value

Table C-7 OC-3 Card Default Settings

Property Name Default Value

OC3.config.line.AINSSoakTime 08:00 (hours:mins)

OC3.config.line.EnableSyncMsg TRUE

OC3.config.line.PJStsMon# 0 (STS #)

OC3.config.line.SDBER 1E-8

OC3.config.line.SFBER 1E-5
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OC3.config.line.SendDoNotUse FALSE

OC3.config.line.State OOS_AINS

OC3.config.sts.IPPMEnabled FALSE

OC3.pmthresholds.line.farend.15min.CV 49149 (B2 count)

OC3.pmthresholds.line.farend.15min.ES 7 (seconds)

OC3.pmthresholds.line.farend.15min.FC 10 (count)

OC3.pmthresholds.line.farend.15min.SES 3 (seconds)

OC3.pmthresholds.line.farend.15min.UAS 63 (seconds)

OC3.pmthresholds.line.farend.1day.CV 4031082 (B2 count)

OC3.pmthresholds.line.farend.1day.ES 25 (seconds)

OC3.pmthresholds.line.farend.1day.FC 40 (count)

OC3.pmthresholds.line.farend.1day.SES 5 (seconds)

OC3.pmthresholds.line.farend.1day.UAS 4095 (seconds)

OC3.pmthresholds.line.nearend.15min.CV 49149 (B2 count)

OC3.pmthresholds.line.nearend.15min.ES 7 (seconds)

OC3.pmthresholds.line.nearend.15min.FC 10 (count)

OC3.pmthresholds.line.nearend.15min.NPJC-PDET 0 (count)

OC3.pmthresholds.line.nearend.15min.NPJC-PGEN 0 (count)

OC3.pmthresholds.line.nearend.15min.PPJC-PDET 60 (count)

OC3.pmthresholds.line.nearend.15min.PPJC-PGEN 0 (count)

OC3.pmthresholds.line.nearend.15min.PSC 1 (count)

OC3.pmthresholds.line.nearend.15min.PSD 0 (seconds)

OC3.pmthresholds.line.nearend.15min.SES 3 (seconds)

OC3.pmthresholds.line.nearend.15min.UAS 63 (seconds)

OC3.pmthresholds.line.nearend.1day.CV 4031082 (B2 count)

OC3.pmthresholds.line.nearend.1day.ES 25 (seconds)

OC3.pmthresholds.line.nearend.1day.FC 40 (count)

OC3.pmthresholds.line.nearend.1day.NPJC-PDET 0 (count)

OC3.pmthresholds.line.nearend.1day.NPJC-PGEN 0 (count)

OC3.pmthresholds.line.nearend.1day.PPJC-PDET 5760 (count)

OC3.pmthresholds.line.nearend.1day.PPJC-PGEN 0 (count)

OC3.pmthresholds.line.nearend.1day.PSC 1 (count)

OC3.pmthresholds.line.nearend.1day.PSD 0 (seconds)

OC3.pmthresholds.line.nearend.1day.SES 5 (seconds)

OC3.pmthresholds.line.nearend.1day.UAS 4095 (seconds)

OC3.pmthresholds.section.nearend.15min.CV 16383 (B1 count)

Table C-7 OC-3 Card Default Settings (continued)

Property Name Default Value
C-21
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Appendix C      Network Element Defaults
Card Default Settings
Table C-8 lists the default settings for OC-12 cards. The ONS 15454 has four types of OC-12 cards; the 
default settings are the same for each. 

Note The first section of the property names will vary to indicate which OC-12 card you are viewing.

.

OC3.pmthresholds.section.nearend.15min.ES 7 (seconds)

OC3.pmthresholds.section.nearend.15min.SEFS 63 (seconds)

OC3.pmthresholds.section.nearend.15min.SES 3 (seconds)

OC3.pmthresholds.section.nearend.1day.CV 1048575 (B1 count)

OC3.pmthresholds.section.nearend.1day.ES 25 (seconds)

OC3.pmthresholds.section.nearend.1day.SEFS 4095 (seconds)

OC3.pmthresholds.section.nearend.1day.SES 5 (seconds)

OC3.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

OC3.pmthresholds.sts.nearend.15min.ES 12 (seconds)

OC3.pmthresholds.sts.nearend.15min.FC 10 (count)

OC3.pmthresholds.sts.nearend.15min.SES 3 (seconds)

OC3.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

OC3.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

OC3.pmthresholds.sts.nearend.1day.ES 100 (seconds)

OC3.pmthresholds.sts.nearend.1day.FC 10 (count)

OC3.pmthresholds.sts.nearend.1day.SES 7 (seconds)

OC3.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-7 OC-3 Card Default Settings (continued)

Property Name Default Value

Table C-8 OC-12 Card Default Settings

Property Name Default Value

OC12.config.line.AINSSoakTime 08:00 (hours:mins)

OC12.config.line.EnableSyncMsg TRUE

OC12.config.line.PJStsMon# 0 (STS #)

OC12.config.line.SDBER 1E-8

OC12.config.line.SFBER 1E-5

OC12.config.line.SendDoNotUse FALSE

OC12.config.line.State OOS_AINS

OC12.config.sts.IPPMEnabled FALSE

OC12.pmthresholds.line.farend.15min.CV 196598 (B2 count)

OC12.pmthresholds.line.farend.15min.ES 7 (seconds)

OC12.pmthresholds.line.farend.15min.FC 10 (count)
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OC12.pmthresholds.line.farend.15min.SES 3 (seconds)

OC12.pmthresholds.line.farend.15min.UAS 63 (seconds)

OC12.pmthresholds.line.farend.1day.CV 16124328 (B2 count)

OC12.pmthresholds.line.farend.1day.ES 25 (seconds)

OC12.pmthresholds.line.farend.1day.FC 40 (count)

OC12.pmthresholds.line.farend.1day.SES 5 (seconds)

OC12.pmthresholds.line.farend.1day.UAS 4095 (seconds)

OC12.pmthresholds.line.nearend.15min.CV 196598 (B2 count)

OC12.pmthresholds.line.nearend.15min.ES 7 (seconds)

OC12.pmthresholds.line.nearend.15min.FC 10 (count)

OC12.pmthresholds.line.nearend.15min.NPJC-PDET 0 (count)

OC12.pmthresholds.line.nearend.15min.NPJC-PGEN 0 (count)

OC12.pmthresholds.line.nearend.15min.PPJC-PDET 60 (count)

OC12.pmthresholds.line.nearend.15min.PPJC-PGEN 0 (count)

OC12.pmthresholds.line.nearend.15min.PSC 1 (count)

OC12.pmthresholds.line.nearend.15min.PSC-W 1 (count)

OC12.pmthresholds.line.nearend.15min.PSD 0 (seconds)

OC12.pmthresholds.line.nearend.15min.PSD-W 0 (seconds)

OC12.pmthresholds.line.nearend.15min.SES 3 (seconds)

OC12.pmthresholds.line.nearend.15min.UAS 63 (seconds)

OC12.pmthresholds.line.nearend.1day.CV 16124328 (B2 count)

OC12.pmthresholds.line.nearend.1day.ES 25 (seconds)

OC12.pmthresholds.line.nearend.1day.FC 40 (count)

OC12.pmthresholds.line.nearend.1day.NPJC-PDET 0 (count)

OC12.pmthresholds.line.nearend.1day.NPJC-PGEN 0 (count)

OC12.pmthresholds.line.nearend.1day.PPJC-PDET 5760 (count)

OC12.pmthresholds.line.nearend.1day.PPJC-PGEN 0 (count)

OC12.pmthresholds.line.nearend.1day.PSC 1 (count)

OC12.pmthresholds.line.nearend.1day.PSC-W 1 (count)

OC12.pmthresholds.line.nearend.1day.PSD 0 (seconds)

OC12.pmthresholds.line.nearend.1day.PSD-W 0 (seconds)

OC12.pmthresholds.line.nearend.1day.SES 5 (seconds)

OC12.pmthresholds.line.nearend.1day.UAS 4095 (seconds)

OC12.pmthresholds.section.nearend.15min.CV 16383 (B1 count)

OC12.pmthresholds.section.nearend.15min.ES 7 (seconds)

OC12.pmthresholds.section.nearend.15min.SEFS 63 (seconds)

Table C-8 OC-12 Card Default Settings (continued)

Property Name Default Value
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Table C-9 lists the default settings for the OC-48 cards. The ONS 15454 has six types of OC-48 cards; 
the default settings are the same for each.

.. 

OC12.pmthresholds.section.nearend.15min.SES 3 (seconds)

OC12.pmthresholds.section.nearend.1day.CV 1048575 (B1 count)

OC12.pmthresholds.section.nearend.1day.ES 25 (seconds)

OC12.pmthresholds.section.nearend.1day.SEFS 4095 (seconds)

OC12.pmthresholds.section.nearend.1day.SES 5 (seconds)

OC12.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

OC12.pmthresholds.sts.nearend.15min.ES 12 (seconds)

OC12.pmthresholds.sts.nearend.15min.FC 10 (count)

OC12.pmthresholds.sts.nearend.15min.SES 3 (seconds)

OC12.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

OC12.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

OC12.pmthresholds.sts.nearend.1day.ES 100 (seconds)

OC12.pmthresholds.sts.nearend.1day.FC 10 (count)

OC12.pmthresholds.sts.nearend.1day.SES 7 (seconds)

OC12.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-8 OC-12 Card Default Settings (continued)

Property Name Default Value

Table C-9 OC-48 Default Settings

Property Name Default Value

OC48.config.line.AINSSoakTime 08:00 (hours:mins)

OC48.config.line.EnableSyncMsg TRUE

OC48.config.line.PJStsMon# 0 (STS #)

OC48.config.line.SDBER 1E-8

OC48.config.line.SFBER 1E-5

OC48.config.line.SendDoNotUse FALSE

OC48.config.line.State OOS_AINS

OC48.config.sts.IPPMEnabled FALSE

OC48.pmthresholds.line.farend.15min.CV 786375 (B2 count)

OC48.pmthresholds.line.farend.15min.ES 7 (seconds)

OC48.pmthresholds.line.farend.15min.FC 10 (count)

OC48.pmthresholds.line.farend.15min.SES 3 (seconds)

OC48.pmthresholds.line.farend.15min.UAS 63 (seconds)

OC48.pmthresholds.line.farend.1day.CV 50331600 (B2 count)

OC48.pmthresholds.line.farend.1day.ES 25 (seconds)

OC48.pmthresholds.line.farend.1day.FC 40 (count)
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OC48.pmthresholds.line.farend.1day.SES 5 (seconds)

OC48.pmthresholds.line.farend.1day.UAS 4095 (seconds)

OC48.pmthresholds.line.nearend.15min.CV 786375 (B2 count)

OC48.pmthresholds.line.nearend.15min.ES 7 (seconds)

OC48.pmthresholds.line.nearend.15min.FC 10 (count)

OC48.pmthresholds.line.nearend.15min.NPJC-PDET 0 (count)

OC48.pmthresholds.line.nearend.15min.NPJC-PGEN 0 (count)

OC48.pmthresholds.line.nearend.15min.PPJC-PDET 60 (count)

OC48.pmthresholds.line.nearend.15min.PPJC-PGEN 0 (count)

OC48.pmthresholds.line.nearend.15min.PSC 1 (count)

OC48.pmthresholds.line.nearend.15min.PSC-R 1 (count)

OC48.pmthresholds.line.nearend.15min.PSC-S 1 (count)

OC48.pmthresholds.line.nearend.15min.PSC-W 1 (count)

OC48.pmthresholds.line.nearend.15min.PSD 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-R 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-S 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-W 0 (seconds)

OC48.pmthresholds.line.nearend.15min.SES 3 (seconds)

OC48.pmthresholds.line.nearend.15min.UAS 63 (seconds)

OC48.pmthresholds.line.nearend.1day.CV 50331600 (B2 count)

OC48.pmthresholds.line.nearend.1day.ES 25 (seconds)

OC48.pmthresholds.line.nearend.1day.FC 40 (count)

OC48.pmthresholds.line.nearend.1day.NPJC-PDET 0 (count)

OC48.pmthresholds.line.nearend.1day.NPJC-PGEN 0 (count)

OC48.pmthresholds.line.nearend.1day.PPJC-PDET 5760 (count)

OC48.pmthresholds.line.nearend.1day.PPJC-PGEN 0 (count)

OC48.pmthresholds.line.nearend.15min.PSC 1 (count)

OC48.pmthresholds.line.nearend.15min.PSC-R 1 (count)

 OC48.pmthresholds.line.nearend.15min.PSC-S 1 (count)

OC48.pmthresholds.line.nearend.15min.PSC-W 1 (count)

OC48.pmthresholds.line.nearend.15min.PSD 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-R 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-S 0 (seconds)

OC48.pmthresholds.line.nearend.15min.PSD-W 0 (seconds)

OC48.pmthresholds.line.nearend.1day.SES 5 (seconds)

OC48.pmthresholds.line.nearend.1day.UAS 4095 (seconds)

Table C-9 OC-48 Default Settings (continued)

Property Name Default Value
C-25
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Appendix C      Network Element Defaults
Card Default Settings
Table C-10 lists the default settings for the OC-192 card. 

OC48.pmthresholds.section.nearend.15min.CV 16383 (B1 count)

OC48.pmthresholds.section.nearend.15min.ES 7 (seconds)

OC48.pmthresholds.section.nearend.15min.SEFS 63 (seconds)

OC48.pmthresholds.section.nearend.15min.SES 3 (seconds)

OC48.pmthresholds.section.nearend.1day.CV 1048575 (B1 count)

OC48.pmthresholds.section.nearend.1day.ES 25 (seconds)

OC48.pmthresholds.section.nearend.1day.SEFS 4095 (seconds)

OC48.pmthresholds.section.nearend.1day.SES 5 (seconds)

OC48.pmthresholds.sts.nearend.15min.CV 15 (B3 count)

OC48.pmthresholds.sts.nearend.15min.ES 12 (seconds)

OC48.pmthresholds.sts.nearend.15min.FC 10 (count)

OC48.pmthresholds.sts.nearend.15min.SES 3 (seconds)

OC48.pmthresholds.sts.nearend.15min.UAS 10 (seconds)

OC48.pmthresholds.sts.nearend.1day.CV 125 (B3 count)

OC48.pmthresholds.sts.nearend.1day.ES 100 (seconds)

OC48.pmthresholds.sts.nearend.1day.FC 10 (count)

OC48.pmthresholds.sts.nearend.1day.SES 7 (seconds)

OC48.pmthresholds.sts.nearend.1day.UAS 10 (seconds)

Table C-9 OC-48 Default Settings (continued)

Property Name Default Value

Table C-10 OC-192 Card Default Settings

Property Name  Default Value

OC192.config.line.AINSSoakTime 08:00 (hours:mins)

OC192.config.line.EnableSyncMsg TRUE

OC192.config.line.PJStsMon# 0 (STS #)

OC192.config.line.SDBER 1E-7

OC192.config.line.SFBER 1E-4

OC192.config.line.SendDoNotUse FALSE

OC192.config.line.State OOS

OC192.config.sts.IPPMEnabled FALSE

OC192.pmthresholds.line.farend.15min.CV 85040 (B2 count)

OC192.pmthresholds.line.farend.15min.ES 87 (seconds)

OC192.pmthresholds.line.farend.15min.FC 10 (count)

OC192.pmthresholds.line.farend.15min.SES 1 (seconds)

OC192.pmthresholds.line.farend.15min.UAS 3 (seconds)
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OC192.pmthresholds.line.farend.1day.CV 850400 (B2 count)

OC192.pmthresholds.line.farend.1day.ES 864 (seconds)

OC192.pmthresholds.line.farend.1day.FC 40 (count)

OC192.pmthresholds.line.farend.1day.SES 4 (seconds)

OC192.pmthresholds.line.farend.1day.UAS 10 (seconds)

OC192.pmthresholds.line.nearend.15min.CV 85040 (B2 count)

OC192.pmthresholds.line.nearend.15min.ES 87 (seconds)

OC192.pmthresholds.line.nearend.15min.FC 10 (count)

OC192.pmthresholds.line.nearend.15min.NPJC-PDET 60 (count)

OC192.pmthresholds.line.nearend.15min.NPJC-PGEN 60 (count)

OC192.pmthresholds.line.nearend.15min.PPJC-PDET 60 (count)

OC192.pmthresholds.line.nearend.15min.PPJC-PGEN 60 (count)

OC192.pmthresholds.line.nearend.15min.PSC 1 (count)

OC192.pmthresholds.line.nearend.15min.PSC-R 1 (count)

OC192.pmthresholds.line.nearend.15min.PSC-S 1 (count)

OC192.pmthresholds.line.nearend.15min.PSC-W 1 (count)

OC192.pmthresholds.line.nearend.15min.PSD 300 (count)

OC192.pmthresholds.line.nearend.15min.PSD-R 300 (count)

OC192.pmthresholds.line.nearend.15min.PSD-S 300 (seconds)

OC192.pmthresholds.line.nearend.15min.PSD-W 300 (seconds)

OC192.pmthresholds.line.nearend.15min.SES 1 (seconds)

OC192.pmthresholds.line.nearend.15min.UAS 3 (seconds)

OC192.pmthresholds.line.nearend.1day.CV 850400 (seconds)

OC192.pmthresholds.line.nearend.1day.ES 864 (seconds)

OC192.pmthresholds.line.nearend.1day.FC 40 (B2 count)

OC192.pmthresholds.line.nearend.1day.NPJC-PDET 5760 (seconds)

OC192.pmthresholds.line.nearend.1day.NPJC-PGEN 5760 (count)

OC192.pmthresholds.line.nearend.1day.PPJC-PDET 5760 (count)

OC192.pmthresholds.line.nearend.1day.PPJC-PGEN 5760 (count)

OC192.pmthresholds.line.nearend.1day.PSC 1 (count)

OC192.pmthresholds.line.nearend.1day.PSC-R 1 (count)

OC192.pmthresholds.line.nearend.1day.PSC-S 1 (count)

OC192.pmthresholds.line.nearend.1day.PSC-W 1 (count)

OC192.pmthresholds.line.nearend.1day.PSD 0 (count)

OC192.pmthresholds.line.nearend.1day.PSD-R 0 (count)

OC192.pmthresholds.line.nearend.1day.PSD-S 0 (count)

Table C-10 OC-192 Card Default Settings (continued)

Property Name  Default Value
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Table C-11 lists the TXP (transponder) card default settings.

 

OC192.pmthresholds.line.nearend.1day.PSD-W 0 (count)

OC192.pmthresholds.line.nearend.1day.SES 5 (seconds)

OC192.pmthresholds.line.nearend.1day.UAS 4095 (seconds)

OC192.pmthresholds.section.nearend.15min.CV 16383 (seconds)

OC192.pmthresholds.section.nearend.15min.ES 7 (seconds)

OC192.pmthresholds.section.nearend.15min.SEFS 63 (seconds)

OC192.pmthresholds.section.nearend.15min.SES 3 (seconds)

OC192.pmthresholds.section.nearend.1day.CV 1048575 (B1 count)

OC192.pmthresholds.section.nearend.1day.ES 25 (seconds)

OC192.pmthresholds.section.nearend.1day.SEFS 4095 (seconds)

OC192.pmthresholds.section.nearend.1day.SES 5 (seconds)

OC192.pmthresholds.sts.nearend.15min.CV 15 (B1 count)

OC192.pmthresholds.sts.nearend.15min.ES 12 (seconds)

OC192.pmthresholds.sts.nearend.15min.FC 10 (seconds)

OC192.pmthresholds.sts.nearend.15min.SES 3 (seconds)

OC192.pmthresholds.sts.nearend.15min.UAS 10 (B3 count)

OC192.pmthresholds.sts.nearend.1day.CV 125 (seconds)

OC192.pmthresholds.sts.nearend.1day.ES 100 (count)

OC192.pmthresholds.sts.nearend.1day.FC 10 (seconds)

OC192.pmthresholds.sts.nearend.1day.SES 7 (seconds)

OC192.pmthresholds.sts.nearend.1day.UAS 10 (B3 count)

Table C-10 OC-192 Card Default Settings (continued)

Property Name  Default Value

Table C-11 TXP Card Default Settings

Property Name Default Value

TXP_MR_10G.config.PayloadType SONET/10GEWANPhy

TXP_MR_10G.config.TerminationMode TRANSPARENT

TXP_MR_10G.config.line..AINSSoakTime 08:00 (hours:mins)

TXP_MR_10G.config.line.A1sMode Disabled

TXP_MR_10G.config.line.A1sRecoveryInterval 100 

TXP_MR_10G.config.line.A1sRecoveryPulseWidth 2.0

TXP_MR_10G.config.line.State OOS

TXP_MR_10G.config.payload.SDBER 1E-7

TXP_MR_10G.config.payload.SFBER 1E-4

TXP_MR_10G.config.trunk.FEC TRUE
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TXP_MR_10G.config.trunk.G709OTN TRUE

TXP_MR_10G.config.trunk.SDBER 1E-7

TXP_MR_10G.config.trunk.SFBER 1E-4

TXP_MR_10G.config.trunk.TxPower 2.0

TXP_MR_10G.fecthresholds.trunk.15min.BitErrorsCorrected 0

TXP_MR_10G.fecthresholds.trunk.15min.ByteErrorsCorrected 0

TXP_MR_10G.fecthresholds.trunk.15min.OneBitErrorsDetected 0

TXP_MR_10G.fecthresholds.trunk.15min.UncorrectableWords 0

TXP_MR_10G.fecthresholds.trunk.15min.ZeroBitErrorsDetected 0

TXP_MR_10G.fecthresholds.trunk.1day.BitErrorsCorrected 0

TXP_MR_10G.fecthresholds.trunk.1day.ByteErrorsCorrected 0

TXP_MR_10G.fecthresholds.trunk.1day.OneBitErrorsDetected 0

TXP_MR_10G.fecthresholds.trunk.1day.UncorrectableWords 0

TXP_MR_10G.fecthresholds.trunk.1day.ZeroBitErrorsDetected 0

TXP_MR_10G.opticalthresholds.client.alarm.HighLaserBias 50.0

TXP_MR_10G.opticalthresholds.client.alarm.HighLaserTemp 75.0

TXP_MR_10G.opticalthresholds.client.alarm.HighRxPower 2.0

TXP_MR_10G.opticalthresholds.client.alarm.HighTxPower 2.0

TXP_MR_10G.opticalthresholds.client.alarm.LowLaserBias 50.0

TXP_MR_10G.opticalthresholds.client.alarm.LowLaserTemp -5.0

TXP_MR_10G.opticalthresholds.client.alarm.LowRxPower -16.0

TXP_MR_10G.opticalthresholds.client.alarm.LowTxPower -8.0

TXP_MR_10G.opticalthresholds.client.warning.15min.HighLaserBias 37.5

TXP_MR_10G.opticalthresholds.client.warning.15min.HighLaserTemp 56.25

TXP_MR_10G.opticalthresholds.client.warning.15min.HighRxPower 1.5

TXP_MR_10G.opticalthresholds.client.warning.15min.HighTxPower 1.5

TXP_MR_10G.opticalthresholds.client.warning.15min.LowLaserBias 37.5

TXP_MR_10G.opticalthresholds.client.warning.15min.LowLaserTemp -3.75

TXP_MR_10G.opticalthresholds.client.warning.15min.LowRxPower -12.0

TXP_MR_10G.opticalthresholds.client.warning.15min.LowTxPower -6.0

TXP_MR_10G.opticalthresholds.client.warning.1day.HighLaserBias 45.0

TXP_MR_10G.opticalthresholds.client.warning.1day.HighLaserTemp 67.5

TXP_MR_10G.opticalthresholds.client.warning.1day.HighRxPower 1.8

TXP_MR_10G.opticalthresholds.client.warning.1day.HighTxPower 1.8

TXP_MR_10G.opticalthresholds.client.warning.1day.LowLaserBias 45.0

TXP_MR_10G.opticalthresholds.client.warning.1day.LowLaserTemp -4.5

Table C-11 TXP Card Default Settings (continued)

Property Name Default Value
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TXP_MR_10G.opticalthresholds.client.warning.1day.LowRxPower -14.4

TXP_MR_10G.opticalthresholds.client.warning.1day.LowTxPower -7.2

TXP_MR_10G.opticalthresholds.trunk.alarm.HighLaserBias 50.0

TXP_MR_10G.opticalthresholds.trunk.alarm.HighLaserTemp 45.0

TXP_MR_10G.opticalthresholds.trunk.alarm.HighRxPower -3.0

TXP_MR_10G.opticalthresholds.trunk.alarm.HighRxTemp 90.0

TXP_MR_10G.opticalthresholds.trunk.alarm.HighTxPower 3.5

TXP_MR_10G.opticalthresholds.trunk.alarm.LowLaserBias 50.0

TXP_MR_10G.opticalthresholds.trunk.alarm.LowLaserTemp 5.0

TXP_MR_10G.opticalthresholds.trunk.alarm.LowRxPower -28.0

TXP_MR_10G.opticalthresholds.trunk.alarm.LowRxTemp -5.0

TXP_MR_10G.opticalthresholds.trunk.alarm.LowTxPower -25.0

TXP_MR_10G.opticalthresholds.trunk.warning.15min.HighLaserBias 37.5

TXP_MR_10G.opticalthresholds.trunk.warning.15min.HighLaserTemp 33.75

TXP_MR_10G.opticalthresholds.trunk.warning.15min.HighRxPower -2.3

TXP_MR_10G.opticalthresholds.trunk.warning.15min.HighRxTemp 67.5

TXP_MR_10G.opticalthresholds.trunk.warning.15min.HighTxPower 2.6

TXP_MR_10G.opticalthresholds.trunk.warning.15min.LowLaserBias 37.5

TXP_MR_10G.opticalthresholds.trunk.warning.15min.LowLaserTemp 3.75

TXP_MR_10G.opticalthresholds.trunk.warning.15min.LowRxPower -21.0

TXP_MR_10G.opticalthresholds.trunk.warning.15min.LowRxTemp -3.75

TXP_MR_10G.opticalthresholds.trunk.warning.15min.LowTxPower -18.8

TXP_MR_10G.opticalthresholds.trunk.warning.1day.HighLaserBias 45.0

TXP_MR_10G.opticalthresholds.trunk.warning.1day.HighLaserTemp 40.5

TXP_MR_10G.opticalthresholds.trunk.warning.1day.HighRxPower -2.7

TXP_MR_10G.opticalthresholds.trunk.warning.1day.HighRxTemp 81.0

TXP_MR_10G.opticalthresholds.trunk.warning.1day.HighTxPower 3.1

TXP_MR_10G.opticalthresholds.trunk.warning.1day.LowLaserBias 45.0

TXP_MR_10G.opticalthresholds.trunk.warning.1day.LowLaserTemp 4.5

TXP_MR_10G.opticalthresholds.trunk.warning.1day.LowRxPower -25.2

TXP_MR_10G.opticalthresholds.trunk.warning.1day.LowRxTemp -4.5

TXP_MR_10G.opticalthresholds.trunk.warning.1day.LowTxPower -22.5

TXP_MR_10G.otnthresholds.trunk.pm.farend.15min.BBE 85040

TXP_MR_10G.otnthresholds.trunk.pm.farend.15min.ES 87

TXP_MR_10G.otnthresholds.trunk.pm.farend.15min.FC 10

TXP_MR_10G.otnthresholds.trunk.pm.farend.15min.SES 1

Table C-11 TXP Card Default Settings (continued)

Property Name Default Value
C-30
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Appendix C      Network Element Defaults
Card Default Settings
TXP_MR_10G.otnthresholds.trunk.pm.farend.15min.UAS 3

TXP_MR_10G.otnthresholds.trunk.pm.farend.1day.BBE 850400

TXP_MR_10G.otnthresholds.trunk.pm.farend.1day.ES 864

TXP_MR_10G.otnthresholds.trunk.pm.farend.1day.FC 40

TXP_MR_10G.otnthresholds.trunk.pm.farend.1day.SES 4

TXP_MR_10G.otnthresholds.trunk.pm.farend.1day.UAS 10

TXP_MR_10G.otnthresholds.trunk.pm.nearend.15min.BBE 85040

TXP_MR_10G.otnthresholds.trunk.pm.nearend.15min.ES 87

TXP_MR_10G.otnthresholds.trunk.pm.nearend.15min.FC 10

TXP_MR_10G.otnthresholds.trunk.pm.nearend.15min.SES 1

TXP_MR_10G.otnthresholds.trunk.pm.nearend.15min.UAS 3

TXP_MR_10G.otnthresholds.trunk.pm.nearend.1day.BBE 850400

TXP_MR_10G.otnthresholds.trunk.pm.nearend.1day.ES 864

TXP_MR_10G.otnthresholds.trunk.pm.nearend.1day.FC 40

TXP_MR_10G.otnthresholds.trunk.pm.nearend.1day.SES 4

TXP_MR_10G.otnthresholds.trunk.pm.nearend.1day.UAS 10

TXP_MR_10G.otnthresholds.trunk.sm.farend.15min.BBE 10000

TXP_MR_10G.otnthresholds.trunk.sm.farend.15min.ES 500

TXP_MR_10G.otnthresholds.trunk.sm.farend.15min.FC 10

TXP_MR_10G.otnthresholds.trunk.sm.farend.15min.SES 500

TXP_MR_10G.otnthresholds.trunk.sm.farend.15min.UAS 500

TXP_MR_10G.otnthresholds.trunk.sm.farend.1day.BBE 100000

TXP_MR_10G.otnthresholds.trunk.sm.farend.1day.ES 5000

TXP_MR_10G.otnthresholds.trunk.sm.farend.1day.FC 40

TXP_MR_10G.otnthresholds.trunk.sm.farend.1day.SES 5000

TXP_MR_10G.otnthresholds.trunk.sm.farend.1day.UAS 5000

TXP_MR_10G.otnthresholds.trunk.sm.nearend.15min.BBE 10000

TXP_MR_10G.otnthresholds.trunk.sm.nearend.15min.ES 500

TXP_MR_10G.otnthresholds.trunk.sm.nearend.15min.FC 10

TXP_MR_10G.otnthresholds.trunk.sm.nearend.15min.SES 500

TXP_MR_10G.otnthresholds.trunk.sm.nearend.15min.UAS 500

TXP_MR_10G.otnthresholds.trunk.sm.nearend.1day.BBE 100000

TXP_MR_10G.otnthresholds.trunk.sm.nearend.1day.ES 5000

TXP_MR_10G.otnthresholds.trunk.sm.nearend.1day.FC 40

TXP_MR_10G.otnthresholds.trunk.sm.nearend.1day.SES 5000

TXP_MR_10G.otnthresholds.trunk.sm.nearend.1day.UAS 5000

Table C-11 TXP Card Default Settings (continued)

Property Name Default Value
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TXP_MR_10G.pmthresholds.client.line.farend.15min.CV 85040

TXP_MR_10G.pmthresholds.client.line.farend.15min.ES 87

TXP_MR_10G.pmthresholds.client.line.farend.15min.FC 10

TXP_MR_10G.pmthresholds.client.line.farend.15min.SES 1

TXP_MR_10G.pmthresholds.client.line.farend.15min.UAS 3

TXP_MR_10G.pmthresholds.client.line.farend.1day.CV 850400

TXP_MR_10G.pmthresholds.client.line.farend.1day.ES 864

TXP_MR_10G.pmthresholds.client.line.farend.1day.FC 40

TXP_MR_10G.pmthresholds.client.line.farend.1day.SES 4

TXP_MR_10G.pmthresholds.client.line.farend.1day.UAS 10

TXP_MR_10G.pmthresholds.client.line.nearend.15min.CV 85040

TXP_MR_10G.pmthresholds.client.line.nearend.15min.ES 87

TXP_MR_10G.pmthresholds.client.line.nearend.15min.FC 10

TXP_MR_10G.pmthresholds.client.line.nearend.15min.NPJC-PDET 60

TXP_MR_10G.pmthresholds.client.line.nearend.15min.NPJC-PGEN 60

TXP_MR_10G.pmthresholds.client.line.nearend.15min.PPJC-PDET 60

TXP_MR_10G.pmthresholds.client.line.nearend.15min.PPJC-PGEN 60

TXP_MR_10G.pmthresholds.client.line.nearend.15min.SES 1

TXP_MR_10G.pmthresholds.client.line.nearend.15min.UAS 3

TXP_MR_10G.pmthresholds.client.line.nearend.1day.CV 850400

TXP_MR_10G.pmthresholds.client.line.nearend.1day.ES 864

TXP_MR_10G.pmthresholds.client.line.nearend.1day.FC 40

TXP_MR_10G.pmthresholds.client.line.nearend.1day.NPJC-PDET 5760

TXP_MR_10G.pmthresholds.client.line.nearend.1day.NPJC-PGEN 5760

TXP_MR_10G.pmthresholds.client.line.nearend.1day.PPJC-PDET 5760

TXP_MR_10G.pmthresholds.client.line.nearend.1day.PPJC-PGEN 5760

TXP_MR_10G.pmthresholds.client.line.nearend.1day.SES 4

TXP_MR_10G.pmthresholds.client.line.nearend.1day.UAS 10

TXP_MR_10G.pmthresholds.client.section.nearend.15min.CV 10000

TXP_MR_10G.pmthresholds.client.section.nearend.15min.ES 500

TXP_MR_10G.pmthresholds.client.section.nearend.15min.SEFS 500

TXP_MR_10G.pmthresholds.client.section.nearend.15min.SES 500

TXP_MR_10G.pmthresholds.client.section.nearend.1day.CV 100000

TXP_MR_10G.pmthresholds.client.section.nearend.1day.ES 5000

TXP_MR_10G.pmthresholds.client.section.nearend.1day.SEFS 5000

TXP_MR_10G.pmthresholds.client.section.nearend.1day.SES 5000

Table C-11 TXP Card Default Settings (continued)

Property Name Default Value
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TXP_MR_10G.pmthresholds.trunk.line.farend.15min.CV 85040

TXP_MR_10G.pmthresholds.trunk.line.farend.15min.ES 87

TXP_MR_10G.pmthresholds.trunk.line.farend.15min.FC 10

TXP_MR_10G.pmthresholds.trunk.line.farend.15min.SES 1

TXP_MR_10G.pmthresholds.trunk.line.farend.15min.UAS 3

TXP_MR_10G.pmthresholds.trunk.line.farend.1day.CV 850400

TXP_MR_10G.pmthresholds.trunk.line.farend.1day.ES 864

TXP_MR_10G.pmthresholds.trunk.line.farend.1day.FC 40

TXP_MR_10G.pmthresholds.trunk.line.farend.1day.SES 4

TXP_MR_10G.pmthresholds.trunk.line.farend.1day.UAS 10

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.CV 85040

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.ES 87

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.FC 10

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.NPJC-PDET 60

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.NPJC-PGEN 60

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.PPJC-PDET 60

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.PPJC-PGEN 60

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.SES 1

TXP_MR_10G.pmthresholds.trunk.line.nearend.15min.UAS 3

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.CV 850400

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.ES 864

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.FC 40

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.NPJC-PDET 5760

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.NPJC-PGEN 5760

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.PPJC-PDET 5760

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.PPJC-PGEN 5760

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.SES 4

TXP_MR_10G.pmthresholds.trunk.line.nearend.1day.UAS 10

TXP_MR_10G.pmthresholds.trunk.section.nearend.15min.CV 10000

TXP_MR_10G.pmthresholds.trunk.section.nearend.15min.ES 500

TXP_MR_10G.pmthresholds.trunk.section.nearend.15min.SEFS 500

TXP_MR_10G.pmthresholds.trunk.section.nearend.15min.SES 500

TXP_MR_10G.pmthresholds.trunk.section.nearend.1day.CV 100000

TXP_MR_10G.pmthresholds.trunk.section.nearend.1day.ES 5000

TXP_MR_10G.pmthresholds.trunk.section.nearend.1day.SEFS 5000

TXP_MR_10G.pmthresholds.trunk.section.nearend.1day.SES 5000

Table C-11 TXP Card Default Settings (continued)

Property Name Default Value
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Node Default Settings
The table in this section lists the node-level default settings for the Cisco ONS 15454. Cisco provides 
the following types of settings preprovisioned for each ONS 15454 node:

• Path protection configuration reversion settings determine whether path protection configuration 
circuits are revertive and, if so, what the reversion time is. 

• Defaults Description lists the current defaults file on the node.

• BLSR reversion settings determine whether or not BLSR circuits are revertive and, if so, what the 
reversion time is.

• IIOP Listener Port sets the IIOP listener port number.

• Login warning message warns users at the login screen about the possible legal or contractual 
ramifications of accessing equipment, systems, or networks without authorization. 

• 1+1 protection settings determine whether or not 1+1 protected circuits are revertive and, if so, what 
the reversion time is. 

• Timing settings determine the AIS threshold, coding, and framing for BITS1 and BITS2 timing. 

Table C-12 lists the ONS 15454 node default settings.

 
Table C-12 Node Default Settings

Property Name  Default Value

NODE.circuits.CreateLikeTL1 FALSE

NODE.circuits.upsr.ReversionTime 5.0 (minutes)

NODE.circuits.upsr.Revertive TRUE

NODE.circuits.upsr.SDBER 1E-6

NODE.circuits.upsr.SFBER 1E-4

NODE.circuits.upsr.SwitchOnPDIP FALSE

NODE.general.CraftAccessOnly FALSE

NODE.general.CtcIpDisplaySuppression FALSE

NODE.general.DefaultsDescription Factory Defaults

NODE.general.EnableFirewall FALSE

NODE.general.EnableProxy FALSE

NODE.general.IIOPListenerPort (reboots node) 57790 (port #)

NODE.general.LcdIpSetting Allow Configuration

NODE.general.LoginWarningMessage <center><b>WARNING</b></center>This 
system is restricted to authorized users for 
business purposes. Unauthorized<p>access 
is a violation of the law. This service may be 
monitored for administrative<p>and 
security reasons. By proceeding, you 
consent to this monitoring.

NODE.general.NtpSntpServer 0.0.0.0

NODE.general.TimeZone (GMT-08\:00) Los Angeles, Tijuana, 
Vancouver (Pacific)
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NODE.general.UseDST TRUE

NODE.general.UseNtpSntpServer FALSE

NODE.protection.1+1.BidirectionalSwitching FALSE

NODE.protection.1+1.ReversionTime 5.0 (minutes)

NODE.protection.1+1.Revertive FALSE

NODE.protection.blsr.RingReversionTime 5.0 (minutes)

NODE.protection.blsr.RingRevertive TRUE

NODE.protection.blsr.SpanReversionTime 5.0 (minutes)

NODE.protection.blsr.SpanRevertive TRUE

NODE.protection.ycable.BidirectionalSwitching FALSE

NODE.protection.ycable.ReversionTime 5.0

NODE.protection.ycable.Revertive FALSE

NODE.security.policy.FailedLoginsBeforeLockout 5

NODE.security.policy.IdleUserTimeoutPolicy.Maintena
nce

60

NODE.security.policy.IdleUserTimeoutPolicy.Provisioni
ng

30

NODE.security.policy.IdleUserTimeoutPolicy.Retrieve 0

NODE.security.policy.IdleUserTimeoutPolicy.Superuser 15

NODE.security.policy.LockoutDuration 00\:30

NODE.security.policy.ManualUnlockBySuperuser FALSE

NODE.security.policy.PasswordReuseThreshold 1

NODE.security.policy.PasswordReuseTimeout 20

NODE.security.policy.SingleSessionPerUser FALSE

NODE.timing.bits-1.AISThreshold SMC

NODE.timing.bits-1.Coding B8ZS

NODE.timing.bits-1.Framing ESF

NODE.timing.bits-1.LBO 0-133 ft

NODE.timing.bits-1.State IS

NODE.timing.bits-2.Coding B8ZS

NODE.timing.bits-2.Framing ESF

NODE.timing.bits-2.LBO 0-133 ft

NODE.timing.bits-2.State IS

NODE.timing.general.Mode External

NODE.timing.general.QualityOfRES RES=DUS

NODE.timing.general.ReversionTime 5.0 (minutes)

Table C-12 Node Default Settings (continued)

Property Name  Default Value
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NODE.timing.general.Revertive TRUE

NODE.timing.general.SSMMessageSet Generation 1

Table C-12 Node Default Settings (continued)

Property Name  Default Value
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Numerics

1:1 protection

An electrical card protection scheme that pairs a working card with a protect card of the same type in an adjacent slot (DS-1 
and DS-3 speeds). If the working card fails, the traffic from the working card switches to the protect card. When the failure on 
the working card is resolved, traffic reverts to the working card. 

1+1 protection

An optical (OC-N) card protection scheme that pairs a single working port/card with a single dedicated protect port/card. All 
OC-N cards can use this protection type (OC-3, OC-12, OC-48, and OC-192 speeds).

1:N protection

An electrical card protection scheme that allows a single protect card to provide protection for several working cards (DS-1 
and DS-3 speeds). If a working card fails, the traffic from the working card switches to the protect card.When the failure on 
the working card is resolved, traffic reverts to the working card. 

10BaseT

Standard 10 Mbps local area network over unshielded twisted pair copper wire.

100BaseT

Standard 100 Mbps local ethernet network.

100BaseTX

Specification of 100BaseT that supports full duplex operation.

A

Access drop

Points where network devices can access the network.

ACO

Alarm cutoff.

Active card

A card that is working or carrying traffic. A card provisioned as working can be an active card or, after a protection switch, a 
protect card can be an active card.
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ACT/STBY

Active/Standby.

Address mask

Bit combination used to describe the portion of an IP address that refers to the network or subnet and the portion that refers to 
the host. Sometimes referred to as mask. See also subnet mask.

ADM

(Add/drop multiplexers). Linear ADMs allow signals to be added to a SONET span or dropped from a SONET span. An ADM 
has three or more nodes.

Agent

1. 1. Generally, software that processes queries and returns replies on behalf of an application.

2. 2. In a network management system, a process that resides in all managed devices and reports the values of specified 
variables to management stations.

AIC

Alarm Interface Controller.

AID

(Access Identifier). An access code used in TL1 messaging that identifies and addresses specific objects within the ONS 15454. 
These objects include individual pieces of equipment, transport spans, access tributaries, and others. See also TID.

AIP

Alarm Interface Panel.

AIS

Alarm Indication Signal.

AIS-L

Line Alarm Indication Signal.

AMI

(Alternate Mark Inversion). Line-code format used on T1 circuits that transmits ones by alternate positive and negative pulses. 
Zeroes are represented by 01 during each bit cell and ones are represented by 11 or 00, alternately, during each bit cell. AMI 
requires that the sending device maintain ones density. Ones density is not maintained independently of the data stream. 
Sometimes called binary-coded alternate mark inversion.

ANSI

American National Standards Institute.

APS

(Automatic Protection Switching). SONET switching mechanism that routes traffic from working lines to protect lines if a line 
card failure or fiber cut occurs.
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ARP

Address Resolution Protocol.

APSB

Alarm Protection Switching Byte.

ATAG

(Autonomous Message Tag). ATAG is used for TL1 message sequencing. See also CTAG.

ATM

Asynchronous Transfer Mode.

AWG

American Wire Gauge

B

B8ZS

(Binary 8-zero Substitution). A line-code type, used on T1 circuits, that substitutes a special code whenever 8 consecutive zeros 
are sent over the link. This code is then interpreted at the remote end of the connection. This technique guarantees ones density 
independent of the data stream. Sometimes called bipolar 8-zero substitution.

Backbone

The part of the network that carries the heaviest traffic or joins LANs together.

BER

(Bit Error Rate). Ratio of received bits that contain errors.

BIP

Bit Interleaved Parity.

Bit rate

Speed at which bits are transmitted, usually expressed in bits per second.

BITS

(Building Integrated Timing Supply). A single building master timing supply that minimizes the number of synchronization 
links entering an office. Sometimes referred to as a Synchronization Supply Unit.

BLSR

(Bidirectional Line Switched Ring). SONET ring architecture that provides working and protection fibers between nodes. If 
the working fiber between nodes is cut, traffic is automatically routed onto the protection fiber. See also path protection 
configuration.
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Blue band

Dense Wavelength Division Multiplexing (DWDM) wavelengths are broken into two distinct bands: red and blue. DWDM 
cards for the ONS 15454 SDH operate on wavelengths between 1530.33nm and 1542.94nm in the blue band. The blue band is 
the lower frequency band.

BNC

Bayonet Neill-Concelman (coaxial cable bayonet-locking connector).

BPDU

Bridge Protocol Data Unit.

Bridge

Device that connects and passes packets between two network segments that use the same communications protocol. In general, 
a bridge will filter, forward, or flood an incoming frame based on the MAC address of that frame. See also MAC address.

Broadcast 

Data packet that will be sent to all nodes on a network. Broadcasts are identified by a broadcast address. Compare with 
multicast and unicast. See also Broadcast address.

Broadcast address

Special address reserved for sending a message to all stations. Generally, a broadcast address is a MAC destination address of 
all ones. See also MAC address.

Broadcast storm

Undesirable network event in which many broadcasts are sent simultaneously across all network segments. A broadcast storm 
uses substantial network bandwidth and, typically, causes network time-outs.

Bus

Common physical signal path composed of wires or other media across which signals can be sent from one part of a computer 
to another.

C

C2 byte

The C2 byte is the signal label byte in the STS path overhead. This byte tells the equipment what the SONET payload envelope 
contains and how it is constructed. See also SONET.

CAT 5

Category 5 (cabling).

CCITT

Comité Consultatif International Télégraphique et Téléphoniques. (Formerly ITU.)

CEO

Central Office Environment.
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CEV

Controlled Environment Vaults.

CLEI

Common Language Equipment Identifier code.

CLNP

Correctionless Network Protocol.

cm

Centimeter.

CMIP

Common Management Information Protocol.

COE

Central Office Environment.

Collision

In Ethernet, the result of two nodes transmitting simultaneously. The frames from each device impact and are damaged when 
they meet on the physical media.

Concatenation

A mechanism for allocating contiguous bandwidth for payload transport. Through the use of Concatenation Pointers, multiple 
OC-1s can be linked together to provide contiguous bandwidth through the network, from end to end.

CORBA

Common Object Request Broker Architecture.

CPE

Customer Premise Environments.

Crosspoint

A set of physical or logical contacts that operate together to extend the speech and signal channels in a switching network.

CTAG

(Correlation Tag). A unique identifier given to each input command by the TL1 operator. When the ONS 15454 system 
responds to a specific command, it includes the command’s CTAG in the reply. This eliminates discrepancies about which 
response corresponds to which command. See also ATAG.

CTC

(Cisco Transport Controller). A Java-based graphical user interface (GUI) that allows operations, administration, maintenance, 
and provisioning (OAM&P) of the ONS 15454 using an Internet browser.
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CTM

(Cisco Transport Manager). A Java-based network management tool used to support large networks of Cisco 15000-class 

D

DCC

(Data Communications Channel). Used to transport information about operation, administration, maintenance, and 
provisioning (OAM&P) over a SONET interface. DCC can be located in SDCC or LDCC. See also LDCC and SDCC.

DCN

Data Communications Network.

DCS

Distributed Communications System.

Default router

If the ONS 15454 must communicate with a device on a network to which the ONS 15454 is not connected, packets are sent 
to this router to be distributed.

Demultiplex

To separate multiple multiplexed input streams from a common physical signal back into multiple output streams. Compare 
Multiplexing.

Destination

The endpoint where traffic exits an ONS 15454 network. Endpoints can be paths (STS or STS/VT for optical card endpoints), 
ports (for electrical circuits, such as DS1, VT, DS3, STS), or cards (for circuits on DS1 and Ethernet cards). See also STS, and 
VT.

DRAM

Dynamic Random-Access Memory.

Drop

See Destination.

DS-1

Digital Signal Level One.

DS1-14

Digital Signal Level One (14 ports).

DS1N-14

Digital Signal Level One (N-14 ports).
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DS-3

Digital Signal Level Three.

DS3-12

Digital Signal Level Three (12 ports).

DS3N-12

Digital Signal Level Three (N-12 ports).

DS3XM-6

Digital Service, level 3 Trans-Multiplexer 6 ports.

DSX

(Digital Signal Cross-Connect Frame). A manual bay or panel where different electrical signals are wired. A DSX permits 
cross-connections by patch cords and plugs.

DWDM

(Dense Wave Division Multiplexing). A technology that increases the information carrying capacity of existing fiber optic 
infrastructure by transmitting and receiving data on different light wavelengths. Many of these wavelengths can be combined 
on a single strand of fiber.

E

EDFA

(Erbium Doped Fiber Amplifier). A type of fiber optical amplifier that transmits a light signal through a section of 
erbium-doped fiber and amplifies the signal with a laser pump diode. EDFA is used in transmitter booster amplifiers, in-line 
repeating amplifiers, and in receiver preamplifiers.

EFCA

Electrical Facility Connection Assembly.

EFT

Electrical Fast Transient/Burst.

EIA

(Electrical Interface Assemblies). Provides backplane connection points for the DS-1, DS-3, and EC-1 cards.

ELR

Extended Long Reach.

EMC

Electromagnetic compatibility.
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EMI

(Electromagnetic Interference). Interference by electromagnetic signals that can cause reduced data integrity and increased 
error rates on transmission channels.

EML

Element Manager Layer.

EMS

Element Management System.

Envelope

The part of messaging that varies in composition from one transmittal step to another. It identifies the message originator and 
potential recipients, documents its past, directs its subsequent movement by the Message Transfer System (MTS), and 
characterizes its content.

EOW

(Engineered Orderwire). A permanently connected voice circuit between selected stations for technical control purposes.

ERDI

Enhanced Remote Defect Indicator.

ES

Errored Seconds.

ESD

Electrostatic Discharge.

ESF

Extended Super Frame.

Ethernet switch

A type of Ethernet LAN device that increases aggregate LAN bandwidth by allowing simultaneous switching of packets 
between switch ports. Ethernet switches subdivide previously shared LAN segments into multiple networks with fewer stations 
per network.

ETSI

European Telecommunications Standards Institute.

Extended SNCP

(Extended Subnetwork Connection Protection). Extended SNCP extends the protection scheme of a subnetwork connection 
protection ring (SNCP) beyond the basic ring configuration to the meshed architecture of several interconnecting rings. See 
SNCP.
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External timing reference

A timing reference obtained from a source external to the communications system, such as one of the navigation systems. Many 
external timing references are referenced to Coordinated Universal Time (UTC).

F

Falling threshold 

A falling threshold is the counterpart to a rising threshold. When the number of occurrences drops below a falling threshold, 
this triggers an event to reset the rising threshold. See also rising threshold.

FC

Failure count.

FDDI

(Fiber Distributed Data Interface). LAN standard, defined by ANSI X3T9.5, specifying a 100-Mbps token-passing network 
using fiber optic cable, with transmission distances of up to 2 km. FDDI uses a dual-ring architecture to provide redundancy.

FE

Frame Bit Errors.

FG1

Frame Ground #1 (pins are labeled “FG1,” “FG2,” etc.)

FMEC

Front Mount Electrical Connection.

Frame

Logical grouping of information sent as a data link layer unit over a transmission medium. Often refers to the header and trailer, 
used for synchronization and error control that surrounds the user data contained in the unit.

FSB

Field Service Bulletin.

G

Gateway

An electronic repeater device that intercepts and steers electrical signals from one network to another. 

GBIC

(Gigabit Interface Converter). A hot-swappable input/output device that plugs into a Gigabit Ethernet port to link the port with 
the fiber optic network. 

Gbps

Gigabits per second.
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GBps

Gigabytes per second.

GR-153-CORE

General Requirements #253 Council of Registrars.

GR-1089

General Requirements #1089.

GUI

Graphical User Interface.

H

Hard reset

The physical removal and insertion of a TCC+ card, also known as reseating a card or performing a card pull.

HDLC

(High-Level Data Link Control). Bit-oriented, synchronous, data-link layer protocol developed by ISO. HDLC specifies a data 
encapsulation method on synchronous serial links using frame characters and checksums.

Hop

A hop is a way to quantify the 'length' of a network route to decide which redundant route is selected. Typically each path 
segment through a routing network device is considered one hop. For example, if an ENE is connected to a GNE that is 
connected to a router, the ENE has two hops to the router—one from itself to the GNE and a second from the GNE to the router. 
To ensure that a certain route is used only when all other routes are exhausted, assign it an unusually high hop count.

Host number

Part of IP address used to address an individual host within the network or subnetwork.

Hot swap

The process of replacing a failed component while the rest of the system continues to function normally.

I

IEC

1. 1. InterExchange Carrier.

2. 2. International Electrotechnical Commission.

IEEE

Institute of Electrical and Electronics Engineers.

IETF

Internet Engineering Task Force.
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Input alarms

Used for external sensors such as open doors, temperature sensors, flood sensors, and other environmental conditions.

I/O

Input/Output.

IP

(Internet Protocol). Network layer protocol in the TCP/IP stack offering a connectionless internetwork service. IP provides 
features for addressing, type-of-service specification, fragmentation and reassembly, and security.

IPPM

Intermediate-Path Performance Monitoring.

IP address

32-bit address assigned to host using TCP/IP. An IP address belongs to one of five classes (A, B, C, D, or E) and is written as 
4 octets separated by periods (dotted decimal format). Each address consists of a network number, an optional subnetwork 
number, and a host number. 

ITU-T

International Telecommunication Union - Telecommunication Standards Sector.

J

JRE

Java Runtime Environment.

K

K bytes

Automatic protection-switching bytes located in the SONET line overhead and monitored by equipment for an indication to 
switch to protection.

L

LAN

(Local Area Network). High-speed, low error data network covering a relatively small geographic area. LANs connect 
workstations, peripherals, terminals, and other devices in a single building or other geographically limited area. Ethernet, 
FDDI, and Token Ring are widely used LAN technologies.

LCD

(Liquid Crystal Display). An alphanumeric display using liquid crystal sealed between two pieces of glass. LCDs conserve 
electricity.
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LDCC

Line Data Communication Channel.

Line layer

Refers to the segment between two SONET devices in the circuit. The line layer deals with SONET payload transport, and its 
functions include multiplexing and synchronization. Sometimes called a maintenance span.

Line terminating equipment (LTE)

Refers to line cards which terminate the line signal in the ONS 15454.

Line timing mode

A node that derives its clock from the SONET lines.

Link budget

The difference between the output power and receiver power of an optical signal expressed in dB. Link refers to an optical 
connection and all of its component parts (optical transmitters, repeaters, receivers, and cables).

Link integrity

The network communications channel has link integrity if it is intact.

Lock Out

A method of switching traffic from one card to another, or one span to another (BLSRs), that prevents traffic from reverting to 
the card or span with the lock out applied. The lock out overrides other manual switching connections (force, manual, and 
exercise).

LOF

Loss of Frame.

Loopback test

Test that sends signals then directs them back toward their source from some point along the communications path. Loopback 
tests are often used to test network interface usability.

LOP

Loss of Pointer.

LOS

Loss of Signal.

LOW

(Local Orderwire). A communications circuit between a technical control center and selected terminal or repeater locations.

LTE

Line Terminating Equipment.
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LVDS

Low-Voltage Differential Signal.

M

MAC

Media Access Control.

MAC address

Standardized data link layer address that is required for every port or device that connects to a LAN. Other devices in the 
network use these addresses to locate specific ports in the network and to create and update routing tables and data structures. 
MAC addresses are six bytes long and are controlled by the IEEE. Also known as the hardware address, MAC-layer address, 
and physical address.

Maintenance user

A security level that limits user access to maintenance options only. See also Superuser, Provisioning User, and Retrieve User.

Managed device

A network node that contains an SNMP agent and resides on a managed network. Managed devices include routers, access 
servers, switches, bridges, hubs, computer hosts, and printers.

Managed object

In network management, a network device that can be managed by a network management protocol. Sometimes called an MIB 
object.

Mapping 

A logical association between one set of values, such as addresses on one network, with quantities or values of another set, 
such as devices on another network.

Mbps

Megabits per second.

MBps

Megabytes per second.

MHz

Megahertz.

MIB

(Management Information Base). Database of network management information that is used and maintained by a network 
management protocol such as SNMP or CMIP. The value of a MIB object can be changed or retrieved using SNMP or CMIP 
commands, usually through a GUI network management system. MIB objects are organized in a tree structure that includes 
public (standard) and private (proprietary) branches.
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MIME

Multipurpose Internet Mail Extensions.

MS

Multiplex Section.

MS-FERF

Multiplex Section Far-end Receive Failure.

MSP

Multiplex Section Protection.

MS-SPRing

(Multiplex Section Shared Protection Ring.) SDH ring architecture that provides working and protection fibers between nodes. 
If the working fiber between nodes is cut, traffic is automatically rerouted onto the protection fiber.

Multicast

Single packets copied by the network and sent to a specific subset of network addresses.

Multiplex payload

Generates section and line overhead, and converts electrical/optical signals when the electrical/optical card is transmitting.

Multiplexing

Scheme that allows multiple signals to be transmitted simultaneously across a single physical channel. Compare Demultiplex.

Mux/Demux

Multiplexer/Demultiplexer.

Muxed

Multiplexed. See Multiplexing.

N

NE

(Network Element). In an Operations Support System, a single piece of telecommunications equipment used to perform a 
function or service integral to the underlying network.

NEBS

Network Equipment-Building Systems.

NEL

Network Element Layer.
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Network number

Part of an IP address that specifies the network where the host belongs.

NML

Network Management Layer.

NMS

(Network Management System). System that executes applications that monitor and control managed devices. NMSs provide 
the bulk of the processing and memory resources required for network management.

Node

Endpoint of a network connection or a junction common to two or more lines in a network. Nodes can be processors, 
controllers, or workstations. Nodes, which vary in routing and other functional capabilities, can be interconnected by links, and 
serve as control points in the network. Node is sometimes used generically to refer to any entity that can access a network. In 
this manual the term “node” usually refers to an ONS 15454.

O

OAM&P

(Operations, Administration, Maintenance, and Provisioning). Provides the facilities and personnel required to manage a 
network.

OC

Optical carrier.

OOS AS

Out of Service Assigned.

Optical amplifier

A device that amplifies an optical signal without converting the signal from optical to electrical and back again to optical 
energy.

Optical receiver

An opto-electric circuit that detects incoming lightwave signals and converts them to the appropriate signal for processing by 
the receiving device.

Orderwire

Equipment that establishes voice contact between a central office and carrier repeater locations. See Local orderwire.

OSI

Open Systems Interconnection.

OSPF

Open Shortest Path First.
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OSS

Operations Support System.

OSS/NMS

Operations Support System/Network Management System.

Output contacts (controls)

Triggers that drive visual or audible devices such as bells and lights. Output contacts can control other devices such as 
generators, heaters, and fans.

P

Passive devices

Components that do not require external power to manipulate or react to electronic output. Passive devices include capacitors, 
resisters, and coils. 

Path Layer

The segment between the originating equipment and the terminating equipment. This path segment may encompass several 
consecutive line segments or segments between two SONET devices.

Path Protection

Path-switched SONET rings that employ redundant, fiber- optic transmission facilities in a pair configuration. One fiber 
transmits in one direction and the backup fiber transmits in the other. If the primary ring fails, the backup takes over. See also 
BLSR.

Payload

Portion of a cell, frame, or packet that contains upper-layer information (data).

PCM

Pulse Code Modulation.

PCMCIA

Personal Computer Memory Card International Association.

PCN

Product Change Notice(s).

PDI-P

STS Payload Defect Indication - Path.

Ping

(Packet internet grouper). ICMP echo message and its reply. Often used in IP networks to test the reachability of a network 
device.
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Pointer justification

In SONET, the mechanism used to compensate for frequency and phase variations. Pointer justification counts indicate timing 
errors on SONET networks.

POP

Point of Presence.

PM

Performance Monitoring.

PPMN

(Path-Protected Mesh Network). PPMN extends the protection scheme of a path protection configuration beyond the basic ring 
configuration to the meshed architecture of several interconnecting rings.

Priority queuing

Routing feature that divides data packets into two queues: one low-priority and one high-priority.

Protect card

A card in a protection pair or scheme that is provisioned as a protect card to the working card. If the working card fails, the 
protect card becomes active. See also working card.

Provisioning user

A security level that allows the user to access only provisioning and maintenance options in CTC. See also Superuser, 
Maintenance user, and Retrieve user.

PSC

Protection-Switching Count.

PSD

Protection-Switching Duration.

PTE

Path-Terminating Equipment.

Q

Queue

In routing, a backlog of packets waiting to be forwarded over a router interface.

R

RAM

Random Access Memory.
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RDI-L

Remote Defect Indication - Line.

Red band

DWDM wavelengths are broken into two distinct bands: red and blue. The red band is the higher frequency band. The red band 
DWDM cards for the ONS 15454 SDH operate on wavelengths between 1547.72nm and 1560.61nm. 

RES

Reserved.

Retrieve user

A security level that allows the user to retrieve and view CTC information but not set or modify parameters. See also Superuser, 
Maintenance user, and Provisioning user.

Revertive switching

A process that sends electrical interfaces (traffic) back to the original working card after the card comes back online.

Rising threshold

The number of occurrences (collisions) that must be exceeded to trigger an event.

RJ-45

Registered Jack #45 (8-pin).

RMA

Return Materials Authorization.

RMON

(Remote Network Monitoring). Allows network operators to monitor the health of the network with a Network Management 
System (NMS). RMON watches several variables, such as Ethernet collisions, and triggers an event when a variable crosses a 
threshold in the specified time interval.

RS-232

Recommended Standard #232 (ANSI Electrical Interface for Serial Communication).

Rx

Receive.

S

SCI

Serial Communication Interface.

SCL

System Communications Link.
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SDCC

Section Data Communication Channel.

SDH

(Synchronous Digital Hierarchy). European standard that defines a set of rate and format standards that are transmitted using 
optical signals over fiber. SDH is similar to SONET, with a basic SDH rate of 155.52 Mbps. Compare SONET.

SEF

Severely Errored Frame.

SELV

Safety Extra-Low Voltage.

SES

Severely Errored Seconds.

SF

Super Frame.

SML

Service Management Layer.

SMF

Single Mode Fiber.

SNCP

(Subnetwork Connection Protection Ring). Path-switched SDH rings that employ redundant, fiber-optic transmission facilities 
in a pair configuration. One fiber transmits in one direction and the backup fiber transmits in the other. If the primary ring fails, 
the backup takes over. 

SNMP

(Simple Network Management Protocol). Network management protocol used almost exclusively in TCP/IP networks. SNMP 
monitors and controls network devices and manages configurations, statistics collection, performance, and security.

SNTP

(Simple Network Time Protocol). Using an SNTP server ensures that all ONS 15454 network nodes use the same date and time 
reference. The server synchronizes alarm timing during power outages or software upgrades.

Soft reset

A soft reset reloads the operating system, application software, etc., and reboots the TCC+ card. It does not initialize the ONS 
15454 ASIC hardware.

SONET

(Synchronous Optical Network). High-speed synchronous network specification developed by Telcordia Technologies, Inc. and 
designed to run on optical fiber. STS-1 is the basic building block of SONET. Approved as an international standard in 1988.
GL-19
Cisco ONS 15454 Procedure Guide, R4.0

March 2003



 

Glossary
Source

The endpoint where traffic enters an ONS 15454 network. Endpoints can be a path (STS or STS/VT for optical card endpoints), 
port (for electrical circuits, such as DS1, VT, DS3, STS), or card (for circuits on DS1 and Ethernet cards). See also STS and VT.

Span

An optical path between two nodes.

Spanning tree

A loop-free subset of a network topology. See also STA and STP.

SPE

(Synchronous Payload Envelope). A SONET term describing the envelope that carries the user data or payload.

SSM

(Synchronous Status Messaging). A SONET protocol that communicates information about the quality of the timing source 
using the S1 byte of the line overhead.

STA

(Spanning-Tree Algorithm). An algorithm used by the spanning tree protocol to create a spanning tree. See also Spanning tree 
and STP.

Standby card

A card that is not active or carrying traffic. A standby card can be a protect card or, after a protection switch, a working card 
can be a standby card.

Static route

A route that is manually entered into a routing table. Static routes take precedence over routes chosen by all dynamic routing 
protocols.

STP

1. 1. Shielded Twisted Pair.

2. 2. Spanning Tree Protocol. Bridge protocol that uses the spanning-tree algorithm to enable a learning bridge to dynamically 
work around loops in a network topology by creating a spanning tree. See also Spanning tree and STA.

STS

(Synchronous Transport Signal, used generically when speaking of SONET signals.)

STS-1

(Synchronous Transport Signal Level 1). Basic building block signal of SONET, operating at 51.84 Mbps for transmission over 
OC-1 fiber. Faster SONET rates are defined as STS-n, where n is a multiple of 51.84 Mbps. See also SONET.

Subnet mask

32-bit address mask used in IP to indicate the bits of an IP address that are used for the subnet address. Sometimes referred to 
simply as mask. See also IP address mask and IP address.
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Subnetwork

In IP networks, a network confined to a particular subnet address. Subnetworks are networks segmented by a network 
administrator in order to provide a multilevel, hierarchical routing structure while shielding the subnetwork from the addressing 
complexity of attached networks. Sometimes called a subnet.

Subtending rings

SONET rings that incorporate nodes that are also part of an adjacent SONET ring.

Superuser

A security level that can perform all of the functions of the other security levels as well as set names, passwords, and security 
levels for other users. A superuser is usually the network element administrator. See also Retrieve user, Maintenance user, and 
Provisioning user.

Switching, Span

Span switching occurs when a working span fails. Traffic switches to the protect fibers between the nodes and then returns to 
the working fibers. Multiple span switches can occur at the same time.

Switching, Ring

Ring switching occurs when a span switch cannot recover traffic, such as when both the working and protect fibers fail on the 
same span. In a ring switch, traffic is routed to the protect fibers throughout the full ring.

SWS

SONET WAN switch.

SXC

SONET Cross Connect ASIC.

T

T1

T1 transmits DS-1-formatted data at 1.544 Mbps through the telephone-switching network using AMI or B8ZS coding. See 
also AMI, B8ZS, and DS-1.

TAC

Technical Assistance Center.

Tag

Identification information, including a number plus other information.

TBOS

Telemetry Byte-Oriented Serial protocol.

TCA

Threshold Crossing Alert.
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TCC+

Timing Communications and Control + Card

TCP/IP

Transmission Control Protocol/Internet Protocol

TDM

(Time Division Multiplexing). Allocates bandwidth on a single wire for information from multiple channels based on 
preassigned time slots. Bandwidth is allocated to each channel regardless of whether the station has data to transmit.

TDS

Time-Division Switching.

Telcordia

(Telcordia Technologies, Inc., formerly named Bellcore). Eighty percent of the U.S. telecommunications network depends on 
software invented, developed, implemented, or maintained by Telcordia.

TID

(Target Identifier). Identifies the particular network element (in this case, the ONS 15454) where each TL1 command is 
directed. The TID is a unique name given to each system at installation. See also AID.

TL1

Transaction Language 1.

TLS

(Transparent LAN Service). Provides private network service across a SONET backbone. 

TMN

Telecommunications Management Network.

Transponder

Optional devices of a DWDM system providing the conversion of one optical wavelength to a precision narrow band 
wavelength. See also DWDM.

Trap

Message sent by an SNMP agent to an NMS (CTM), console, or terminal to indicate the occurrence of a significant event, such 
as an exceeded threshold. See also CTM.

Tributary

The lower-rate signal directed into a multiplexer for combination (multiplexing) with other low rate signals to form an 
aggregate higher rate level.

Trunk

Network traffic travels across this physical and logical connection between two switches. A backbone is composed of a number 
of trunks. See also Backbone.
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TSA

Time-Slot Assignment.

TSI

Time-Slot Interchange.

Tunneling

Architecture that is designed to provide the services necessary to implement any standard point-to-point encapsulation scheme.

Tx

Transmit.

U

UAS

Unavailable Seconds.

UDP/IP

User Datagram Protocol/Internet Protocol.

UID

User Identifier.

Unicast

The communication of a single source to a single destination.

Upstream

Set of frequencies used to send data from a subscriber to the head end.

UTC

Universal-Time Coordinated.

UTP

Unshielded Twisted Pair.

V

VDC

Volts Direct Current.

Virtual fiber

A fiber that carries signals at different rates and uses the same fiber optic cable.
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Virtual ring

Entity in a source-route bridging (SRB) network that logically connects two or more physical rings together either locally or 
remotely. The concept of virtual rings can be expanded across router boundaries.

Virtual wires

Virtual wires route external alarms to one or more alarm collection centers across the SONET transport network.

VLAN

(Virtual LAN). Group of devices located on a number of different LAN segments that are configured (using management 
software) to communicate as if they were attached to the same wire. Because VLANs are based on logical instead of physical 
connections, they are extremely flexible.

VPN

(Virtual Private Network). Enables IP traffic to travel securely over a public TCP/IP network by encrypting all traffic from one 
network to another. A VPN uses “tunneling” to encrypt all information at the IP level. See also Tunneling.

VT

(Virtual Tributary). A structure designed for the transport and switching of sub-DS3 payloads. See also Tributary.

VT1.5

Virtual Tributary that equals 1.544 Mbps.

VT layer

The VT layer or electrical layer occurs when the SONET signal is broken down into an electrical signal.

VT tunnel

VT tunnels allow electrical circuits to pass through ONS 15454 nodes without using ONS 15454 cross-connect card capacity.

W

W

Watts.

WAN

Wide Area Network.

Working card

A card that is provisioned as an active, primary card. Traffic cards in a protection pair are provisioned as working or protect 
See also Protect card.

X

XC

Cross Connect
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XCVT

Cross Connect Virtual Tributary.

X.25

Protocol providing devices with direct connections to a packet-switched network.
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